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About This E-Book
EPUB is an open, industry-standard format for e-books. However, support for EPUB and
its many features varies across reading devices and applications. Use your device or app
settings to customize the presentation to your liking. Settings that you can customize
often include font, font size, single or double column, landscape or portrait mode, and
figures that you can click or tap to enlarge. For additional information about the settings
and features on your reading device or app, visit the device manufacturer’s Web site.

Many titles include programming code or configuration examples. To optimize the
presentation of these elements, view the e-book in single-column, landscape mode and
adjust the font size to the smallest setting. In addition to presenting code and
configurations in the reflowable text format, we have included images of the code that
mimic the presentation found in the print book; therefore, where the reflowable format
may compromise the presentation of the code listing, you will see a “Click here to view
code image” link. Click the link to view the print-fidelity code image. To return to the
previous page viewed, click the Back button on your device or app.
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Reader Services
Register your copy at www.ciscopress.com/title/9781587206207 for convenient access to
downloads, updates, and corrections as they become available. To start the registration
process, go to www.ciscopress.com/register and log in or create an account*. Enter the
product ISBN 9781587206207 and click Submit. After the process is complete, you will
find any available bonus content under Registered Products.

*Be sure to check the box that you would like to hear from us to receive exclusive
discounts on future editions of this product.
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Icons Used in This Book
Icons Used in This Book

27

||||||||||||||||||||

||||||||||||||||||||

https://technet24.ir
https://technet24.ir


Command Syntax Conventions
The conventions used to present command syntax in this book are the same conventions
used in the IOS Command Reference. The Command Reference describes these
conventions as follows:

Boldface indicates commands and keywords that are entered literally as shown. In
actual configuration examples and output (not general command syntax), boldface
indicates commands that are manually input by the user (such as a show command).

Italic indicates arguments for which you supply actual values.

Vertical bars (|) separate alternative, mutually exclusive elements.

Square brackets ([ ]) indicate an optional element.

Braces ({ }) indicate a required choice.

Braces within brackets ([{ }]) indicate a required choice within an optional element.

Command Syntax Conventions
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Foreword
As I think of an opening for this book, one single thought springs to mind: The wait is
over. That thought puts a big smile on my face. It’s been a long, long time since we last
had a CCIE Wireless book. Back in the year 2012, 802.11n was the prevalent wireless
technology. Since then, nearly 7 years have passed, and our wireless world has evolved
enormously. We now have a ratified 802.11ac and “ax” is almost around the corner, not
to mention WPAv3. Wi-Fi (along with coffee) forms a definitive part of that extremely
important list of basic human needs, and who could argue otherwise? Wi-Fi has long
become the de facto access layer—at home, at the office, and on the move. In an era
where we are constantly connected, wireless is, literally, everywhere.

The CCIE Wireless itself, as a certification, has undergone a couple of updates over the
past few years:

v2.0 was released on November 18, 2011, shortly before the previous CCIEW book
was released (on April 12, 2012).

v3.0 was released on September 14, 2015.

v3.1 release was introduced on November 8, 2017.

The updates reflect the changes that we have seen over the past few years in our
corporate networks, where we no longer work with ACS, WCS, or even Converged
Access, but with ISE, PI, CMX, and APIs, while “Automation,” “Network
Programmability,” “DNA,” and “Intent” are the new buzzwords that we hear every day,
and that we know we will have to become accustomed to working with sooner or later.
All these changes have been and continue to be profound. They put extra pressure on the
wireless professional but they have also been welcomed, because they have enabled us to
build more robust, secure, and sophisticated wireless networks while creating a more
enjoyable and enhanced user experience.

But having a new CCIE Wireless book out is not the only reason why this book puts a big
smile on my face. I had the great, great privilege of hand picking the authors who put
together this content and, knowing who they are, I had great expectations for the book.
To say that the team delivered above and beyond my expectations wouldn’t be enough;
as I read through each chapter, that big smile kept spreading across my face, and I am
sure you will have the very same feeling as you go through the content. I am indebted to
each one of you for your contribution and, indeed, I think that it would be fair to say that

Foreword
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this could be extended to the bigger wireless community.

Last, but certainly not least, I would like to say a big thank you to Sam Clements for
being the technical editor. He is a friend, a key contributor to the CCIE Wireless
program, and a credit to the wireless community.

I hope you enjoy the book and that you find it an excellent first step into your CCIE
Wireless journey!

Santiago Lopez, CCIE Wireless No. 46087

CCIE Wireless Program Manager

Learning@Cisco

August 2018
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Introduction
Welcome to your CCIE Wireless journey. This book aims to be your preparation bible
during that long and challenging (but also rewarding) journey that is the CCIE Wireless.
We, the authors, hope to have put the right balance of content to help you through your
preparation to reach CCIE heaven, and that the book not only helps you through that
journey but also serves as a motivational trigger.

The prestige and respect associated with being a CCIE Wireless will definitely help you
in your career. Still, for those readers who are not yet on that path, we hope to provide
you with a thorough understanding of the Cisco WLAN technologies. Equipped with this
knowledge, you will be able to more effectively overcome challenges in your wireless
deployments and be a better overall wireless professional.

The CCIE Wireless certification assesses and validates wireless expertise. Candidates
who pass the CCIE Wireless certification exams demonstrate broad theoretical and
practical knowledge of wireless networking, as well as a solid understanding of WLAN
technologies from Cisco.

There are no formal prerequisites for CCIE certification. Other professional certifications
or training courses are not required. Instead, candidates must first pass a written
qualification exam and then the corresponding hands-on lab exam. You are expected to
have an in-depth understanding of the exam topics and are strongly encouraged to have
three to five years of job experience before attempting any CCIE certification.

For the latest CCIEW Wireless news and blueprint, visit
https://learningnetwork.cisco.com/community/certifications/ccie_wireless.

Introduction
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Who Should Read This Book?
Undoubtedly, this book’s main audience is composed of students interested in pursuing
the CCIE Wireless. No matter where you are in your CCIE journey, this book should
prove an invaluable asset to your library, and one that you will consult on a day-to-day
basis during your preparation. The book is particularly aimed at the lab exam, but for
completeness, all sections covered by the CCIEW blueprint are covered on the book and,
for this reason, it will also be a great companion during your written exam preparation.

Additionally, wireless professionals (independently of their background as engineers,
administrators, architects, or NOCs) will find this book a primary source of reference
when working with a Cisco Wireless network, because it provides all the necessary
foundations to configure and troubleshoot a Cisco Wireless deployment, independently of
its style and characteristics.

Who Should Read This Book?
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How This Book Is Organized
Chapter 1, “Planning and Designing WLAN Technologies”: This chapter covers the
fundamentals of WLAN design and planning. It provides the key elements to keep in
mind when you are considering a new enterprise-class WLAN, from RF boundaries
between cells, AP positioning, client and AP power levels, to channel plans and AP
density.

Chapter 2, “Network Infrastructure”: This chapter covers the infrastructure
technologies involved in preparing and setting up a wireless network. It is aimed at
refreshing the Layer 2 and Layer 3 knowledge (as well as key network services) required
to configure and optimize a wired network that has to support wireless infrastructure.

Chapter 3, “Autonomous Deployments”: This chapter covers the Cisco IOS
Autonomous WLAN devices, specifically focusing on the technologies and features
involved in wireless bridge links, using these autonomous devices in the appropriate roles.
The purpose is to give you the core knowledge (and main tips) required to deploy,
configure, and troubleshoot these IOS devices for wireless bridging designs.

Chapter 4, “AireOS Appliance, Virtual, and Mobility Express Controllers”: This
chapter describes controller-based wireless architectures, their main components, and
their functionalities. It provides the basics to get started with both theory and practice, as
well as the details on how more advanced features work and how to configure them.
Some of the main topics in this chapter include architectures (centralized, FlexConnect,
Mesh, and so on), security settings (L2/L3 security, rogue AP management, ACLs, and
so on), radio management, and more.

Chapter 5, “Wireless Security and Identity Management with ISE”: Cisco Identity
Services Engine is a key component for deploying a secure wireless network. This
chapter covers the protocols and concepts needed to understand and configure an access
policy using ISE. In addition, it examines the most common use cases, describing
configurations required to implement them.

Chapter 6, “Prime Infrastructure and MSE/CMX”: This chapter focuses on setting up
and optimizing management operations through Cisco Prime Infrastructure and on
integrating it with the MSE/CMX location solutions. It includes basic and advanced
management options, as well as explanations on wireless location techniques and best
practices. Details and clarifications on the more recent Cisco CMX solutions are

How This Book Is Organized
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provided, too, as extra content to the CCIE Wireless blueprint.

Chapter 7, “WLAN Media and Application Services”: This chapter covers the
elements you need to design, configure, operate, and troubleshoot a WLAN with real-
time applications. This chapter covers the fundamentals of QoS and how differentiated
services are applied to wireless traffic. It also explains how differentiated services are
configured for the various WLAN platforms and details what performances you are likely
to expect based on your configuration.

How This Book Is Organized
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Chapter 1

Planning and Designing WLAN Technologies
If you made it to the point where you plan to take the CCIE Wireless exam, you probably have many years of
practice and exposure to WLAN networks. You also probably have taken entry and likely professional
Wireless certifications (if none of the above is true for you, stop and ask yourself: wait, what am I doing?). As
such, most of the elements covered in this first chapter should be familiar to you. However, gaps in your
knowledge may be possible, and some elements may be buried so deep in your instinctive memory that your
neo cortex blanks out when you are asked about them. This chapter is here to ensure that you get a refresher
on elements of design that you should be familiar with. It is organized as follows:

“Describe WLAN Organizations and Regulations” is a short section intended to remind you of the main
actors involved in 802.11, from the regulatory bodies to the IEEE, the WFA, and the WBA.

“802.11 Standards and Protocols” lists the main 802.11 amendments that you are expected to know.
These amendments will be leveraged in the following chapters. This section describes their general
purpose.

“Plan and Design Wireless Solutions Requirements” reminds you of the principle of Wi-Fi design. You
should be able to translate customer use cases and needs into Wireless requirements.

“RF Planning, Design, and Validation” takes a closer look at the RF part of the design to help you keep in
mind the key thresholds and numbers for a data, voice, or location-based design.

Describe WLAN Organizations and Regulations

You should know that WLANs operate in Industrial Scientific and Medical (ISM) bands, which are portions of
the spectrum that are unlicensed. Unlicensed means that you can operate equipment emitting RF signals in
these bands, without having to apply for a license. The International Telecom Union (ITU) is the worldwide
organization that has defined which portion of the spectrum will be adapted to each type of transmission use
case. Interestingly, the 2.4 GHz ISM band was labeled unlicensed because it displayed poor properties for
reliable communication. This ISM (that is, no need for a license) classification is the main factor that pushed
Wi-Fi to be defined in this spectrum, and today more than ten billion devices use this band (and others) to
communicate.

The ITU bases its classification on properties of the various sections of the spectrum (elements such as the
degradation of signal as distance increases, the effect of the atmosphere, the earth’s electromagnetic field, the
solar or stellar radiations on the transmitted signal, and so on). When a section of the spectrum is deemed
usable for human communications, its characteristics make it more adapted to one application or another. For
example, higher frequencies can host more waves per unit of time or distance than lower frequencies and are
therefore more conducive to encode more data per unit (and therefore achieve higher throughput). On the
other hand, higher frequencies and smaller waves have more chances of being degraded by interferences, and
their usable range is likely to be shorter (unless power is increased). However, the ITU does not dictate
country regulations, although the ITU recognizes that different regions of the world have converged to specific
ways of using each segment. A view of such local differentiation is here: https://www.itu.int/en/ITU-
R/terrestrial/broadcast/Pages/Bands.aspx. The ITU defines spectrum segments, names, and assigns
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communication use cases to each segment.

Then, each country has its own regulatory body that decides the rules driving the utilization of each segment.
These rules are not so much about use cases, but about transmission pattern and power. In the United States
and several other countries in the American continent, the Federal Communication Commission (FCC)
determines what frequencies and transmission power levels may be used. These regulations not only dictate
the maximum transmitted power, but also apply rules to the shape of the signal, its modulation, and the
associated use case.

An interesting illustration of how these rules are developed over time is the case of the 5 GHz band, in which
several segments are used for earth-satellite communications. Because these segments fall right in the middle
of the bands used for Wi-Fi communications (between UNII-1 and UNII-2e), a dialog has been ongoing for
years to extend Wi-Fi transmissions into this domain. A group of Wi-Fi equipment vendors dialogued with the
FCC. At the same time, that group dialogued with the IEEE and the Wi-Fi Alliance (see below), who both
expressed intent to develop protocol descriptions and certifications (respectively) if such a band was open.
The same group has also been communicating with other large regulatory bodies, such as the European
Telecommunication Standards Institute (ETSI), that sets the spectrum usage regulations in Europe, or Telec,
the Japanese the Ministry of Communication, that sets the spectrum rules in Japan. This multipartite
exchange’s purpose is to build consensus on possible use of Wi-Fi in this band. One major concern was
interference with existing satellite communications. The Wi-Fi vendor group had to demonstrate that Wi-Fi
could operate in these bands without negatively affecting the already allowed earth-satellite communication
mechanisms. Reaching such consensus takes years, but this case illustrates how the FCC receives requests and
arbitrates the spectrum allocation. The FCC spectrum allocation is located here:
https://transition.fcc.gov/oet/spectrum/table/fcctable.pdf.

The IEEE was involved indirectly in this dialog because the IEEE designs the transmission mechanisms of Wi-
Fi. The current version of the 802.11 Standard contains more than 4000 pages. Many of them describe frames
formats and exchanges for multiple scenarios. However, a considerable portion of the standard also describes
the PHY layer, and includes provisions on wave form, receive sensitivity, modulation, and power. These
provisions were not designed randomly. They combine characteristics of the spectrum segments where Wi-Fi
operates (based on work conducted by the ITU), but also include restrictions intended to limit the range of the
transmissions or their impact on other systems that may be allowed to operate in the same or nearby bands.
This side of the standard makes the statement “Wi-Fi is unlicensed, which means that you don’t need a license
for Wi-Fi communications” inaccurate. To be allowed in a regulatory domain, 802.11 must comply to
transmission rules specified by each regulatory body. With more than 180 countries and tens of regulatory
bodies, an 802.11 set of rules turns out to be incompatible (for a given spectrum segment) with local
regulatory bodies’ rules. In that case, the regulatory body may relax the rules over time to allow
communication that is already allowed elsewhere, or the transmission band and techniques must adapt to the
local limitations (resulting in different rules for different domains). This second option is not ideal, and this is
why the main Wi-Fi vendors try to build regulatory consensus before bringing the conclusion to the IEEE.

The IEEE is a group of individuals (although most of them are sponsored by companies) who design
communication protocols based on the laws of physics but also on what they know will be allowed by each
regulatory body. Sometimes, the design of a new standard and dialogues with regulatory bodies follow parallel
paths. The protocol is modified as regulatory bodies set new rules, and rules sometimes change to allow for the
future standard. A standard is the result of these efforts.

In most cases, regulatory bodies dictate limitations on the PHY part of the standard. At the layer above, the
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MAC Layer, the protocol determines the frame shapes and a choreography of exchanges to enable this or that
function.

It is common that a given problem can be solved by more than one type of exchange. In this case, the protocol
designers either choose the best (most efficient) exchange or allow for more than one exchange type (when
the various forms of exchange solve the same problem, but are each adapted to a different context). The
standard then ends up with different exchanges described to solve the same problem.

A standard is a collection of such scenarios and exchanges. However, some of the problems addressed do not
occur all the time or are not deemed important by all vendors. The standard describes exchanges and frames,
but most vendors do not implement them, or implement only a subset. Even when multiple vendors implement
the same frames for the same scenario, implementation details may change from one vendor to the other. To
help clarify compatibility among vendors, the Wi-Fi Alliance (WFA) was formed. It groups Wi-Fi equipment
vendors (although these vendors are represented by individuals), who discuss and select features of 802.11
that help solve specific use cases. These features, and the way they are implemented, are grouped under a
specification. Vendors that apply that specification can be certified by the Wi-Fi Alliance accordingly. This
mechanism ensures that vendors implementing a certain set of features will be compatible with other vendors
claiming the implementation of the same set of features. Two examples can help clarify this concept:

1. Voice over Wi-Fi is always a concern in enterprise networks. Because this type of traffic is sensitive to
delay, jitter, and loss, an efficient set of features must be present to expedite roaming operations. The
Voice Enterprise certification lists a collection of features about this requirement (for example, 802.11r
for fast key exchange). A single feature would not be enough. From the 802.11 standards, the WFA Voice
Enterprise group selected a series of features that together can help expedite roaming operations. Voice
Enterprise groups those features into a single certification and also describes in detail how they should be
implemented (including timers, exchanges in case of initial failure, and so on). As a result, if your
smartphone is certified Voice Enterprise, you know that it includes fast roaming elements. If it connects to
a network for which APs are also certified Voice Enterprise, you know that the smartphone will be able to
exchange efficiently with the APs to perform fast roaming. Client and AP will understand each other
(speak the same language, and speak it the same way). On the other hand, if your APs are not certified
Voice Enterprise, they may or may not implement the fast roaming features that your phone can leverage.
And when they implement some fast roaming features, you cannot know if they will implement them the
way your phone expects, or if they will implement them with another logic.

2. The preceding sentence forms a segue to a counter example. One feature of 802.11 is described in the
802.11v amendment and is about BSS transition. This feature allows the AP to tell to a client at the edge
of the cell about the next best AP to which the client can connect. Such communication saves on scanning
time, because the client needs to scan only one channel, instead of possibly more than 30. However, what
is the best or even a good AP? Is it better to roam to an AP with 2 clients using 60% of the AP channel, or
to an AP with 60 idle clients? The definition of a good AP depends very much on the client internal logic.
Without a common vendor certification, there is no easy way to implement BSS Transition efficiently. The
AP may send what it thinks is the best AP, when it thinks the client is at the edge of the cell, but the client
may disagree and may end up either ignoring the AP message (sent when the client does not think it needs
to roam) or scanning the entire spectrum (because the AP recommended next best AP did not match the
client’s expectations).

The Wi-Fi Alliance (WFA) should not be confused with the Wireless Broadband Alliance (WBA). The WBA
is an industry association that groups operators offering Wi-Fi functions (large public hotspot providers, for
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example). The WBA builds recommendations and programs to ensure good quality of experience for the user.
With the development of Wi-Fi in public venues, and the fact that roaming has become a strong focus point,
the WBA has been gaining influence in the Wi-Fi world over the past few years.

802.11 Standards and Protocols

This short chapter is not going to describe each protocol in detail, because you are expected to be familiar with
them. However, a short map of the evolution of 802.11 may be useful, because multiple amendments are
described and configured in the following chapters. 802.11 can be divided in two categories: provisions that
increase the protocol speed and provisions that increase the protocol efficiency.

802.11 Amendments for Faster Speed

802.11 was published in 1997 and clarified in 1999, but it is obsolete today. It allowed for features, such as
infrared communications, which were never implemented, and allowed for only 2 Mbps maximum. Since then,
five amendments were passed to increase the speeds allowed in 802.11:

802.11b: The IEEE 802.11b standard, ratified in September 1999, operates in the 2.4 GHz spectrum and
supports data rates of 1 Mbps, 2 Mbps, 5.5 Mbps, and 11 Mbps. The original 802.11-1997 protocol
allowed IR, Frequency Hopping Spread Spectrum (FHSS), and Direct Sequence Spread Spectrum (DSSS),
whereas the 802.11b protocol allows only DSSS, using Barker code or Complementary Code Keying
(CCK).

802.11a: The IEEE 802.11a standard operates in the three 5.0-GHz UNII frequency bands, with data rates
of 6, 9, 12, 18, 24, 36, 48 Mbps, and a maximum data rate of 54 Mbps. The IEEE required only
mandatory support of data rates of 6, 12, and 24 Mbps, because each of these rates used a different
modulation (BPSK, QPSK and QAM). Mandating such support was a way to force vendors to implement
all the modulations. Using the 5 GHz spectrum, 802.11a has up to 25 nonoverlapping frequency channels
(depending on the geographic area), compared to the three nonoverlapping channels of 802.11b/g.

802.11g: The IEEE 802.11g standard, which was ratified in June 2003, operates in the same spectrum as
802.11b and is backward compatible with the 802.11b standard. 802.11g supports the additional data rates
of 6 Mbps, 9 Mbps, 12 Mbps, 18 Mbps, 24 Mbps, 36 Mbps, 48 Mbps, and 54 Mbps. 802.11g delivers the
same 54 Mbps maximum data rate and the same modulations as 802.11a.

802.11n: IEEE 802.11n was ratified in 2009. The 802.11n standard increases the speeds available to
802.11 by increasing the possible channel width, from 20 MHz (802.11g/a) to 40 MHz. 802.11n also uses
spatial multiplexing, which utilizes a concept called multiple input, multiple output (MIMO). By the mid-
2000s, the WI-FI chipset had built a better efficiency to send and receive in noisy environments.
Leveraging these advances, MIMO allows up to 4 antennas and associated radios to transmit (or receive)
at the same time, increasing the Tx/Rx speeds. 802.11n operates in the 2.4 GHz and 5 GHz bandwidths
and is backward compatible with 802.11a and 802.11g (but not with 802.11b).

802.11ac: The IEEE 802.11ac standard was published in 2013 and is designed to operate exclusively in
the 5 GHz band. 802.11ac increases the channel width to 80 and 160 MHz, and also allows for
downstream transmissions to more than one recipient at the time (Downlink Multi User MIMO, DL-MU-
MIMO). This mode also allows for faster transmission because most handheld devices are limited to one
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or two radio chains (antennas and associated radios) to conserve battery. Allowing an AP with 4 (in
theory, up to 8) radio chains to send traffic to up to 4 clients simultaneously increases the downlink
transmission efficiency. 802.11ac also allows for faster modulation (256 QAM, while 802.11n stopped at
64 QAM).

802.11ax: The IEEE 802.11ax amendment will likely be published at the end of 2019. It is an ambiguous
protocol because it combines a lot of efficiency mechanisms (and would therefore fit well in the next
section). However, it also includes provisions for enhanced speed. Among them, Uplink MU-MIMO (UL-
MU-MIMO) allows multiple clients to send at the same time. Additionally, OFDMA transmissions allow
each device to only use a slot (called Resource Unit, RU) in the upstream frame, enabling a single frame to
carry the information from multiple stations. These provisions allow the prediction of up to 4 times faster
transmissions with 802.11ax than with 802.11ac.

802.11 Amendments for Cell Efficiency

More than 30 amendments were published since the original version of 802.11 in 1997. This chapter does not
list them all. However, some of them will be detailed and configured in the next chapters, and you need to
understand what problems they were intended to solve:

802.11d: Also called world mode, 802.11d was published in 2001. This amendment allows the AP and the
station to exchange information on the country of operation (including list of channels and max power).
This is critical when your Wi-Fi client joins Wi-Fi networks in different regulatory domains.

802.11h: Called Spectrum and Transmit Power Management Extensions in the 5 GHz Band in Europe,
802.11h was published in 2003. It was then implemented in most other regulatory domains in 2007 and
later. 802.11h describes how operations in the 5 GHz should avoid collision with airport radar activities.
802.11h is critical for outdoor mesh operations, and for indoor operations in UNII-2 and UNII-2e. A
system is allowed to operate in these bands only if it can detect radar blasts and then vacates the affected
frequency for at least 30 minutes (using a mechanism called Dynamic Frequency Selection, or DFS). A
system should also not use any channel in the affected bands without first checking that no radar is
detected using it. Because of these requirements, roaming efficiency is limited when using these channels.

802.11e: Published in 2005, 802.11e includes provisions for QoS over Wi-Fi. Critical for real-time
applications, 802.11e describes differentiated services for different types of traffic, increasing the
statistical probability of access to the medium (in case of contention) for traffic in categories with higher
priority.

802.11k: Published in 2008, 802.11k describes functions for radio resource management. One of the main
features of this amendment that will be discussed in this book is the neighbor list, which allows an AP to
send to a client a list of neighboring APs that the client can roam to. This short list is intended to save on
scanning time. It is only efficient if the view from the AP is the same as the view from the client.

802.11r: Published in 2008, 802.11r describe provisions for fast key exchange during roaming. This
mechanism is called Fast Transition (FT) and is critical for time-sensitive applications in networks where
encryption is in place.

802.11w: Published in 2010, the Protected Management Frames (PMF) amendment aims at protecting
clients against AP impersonation attacks. This protocol was derived from the Cisco Management Frame
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Protection (MFP) protocol. 802.11w is mandatory in WPA3.

802.11v: Published in 2011, 802.11v is a 400-page document with multiple provisions aimed at facilitating
the life of a client in a cell. The BSS Transition part describes how an AP and a client can exchange
information on the next best AP for the client. The Directed Multicast Service (DMS) and Max Idle
Timeout parts describe how a client can sleep beyond a DTIM interval while the AP buffers multicast or
broadcast traffic for that client.

802.11u: Published in 2011, 802.11 describes internetworking with external networks. In combination
with the WFA Hotspot 2.0 initiative, 802.11u is critical for auto-onboarding functions.

802.11ad: Published in 2012, 802.11ad (often called WiGig) describes 802.11ac-like speeds in the 60
GHz band. The 802.11ay amendment will improve 802.11ad operations.

802.11af: Published in 2013, 802.11af describes operations in the TV whitespace band (500 MHZ range)
for lower throughput but longer-range Wi-Fi.

802.11ah: Published in 2016, 802.11ah focuses on IoT use cases and describes low power and medium
range (1 mile) operations in the sub-1 GHz bands.

802.11ax: The IEEE 802.11ax amendment was listed in the previous section. However, it also includes
major enhancements for cell efficiency, especially in high density. Target Wake Time (TWT) allows a
station to sleep longer. The AP tells the station when it should wake up. By distributing wake times among
stations, the AP can handle a very large number of clients with minimal collisions. IoT is the primary use
case for this feature. For regular stations, coloring allows the station to report when another cell is a
source of collisions by transmitting on the same channel. The local AP can then set a color (a sequence of
bits on each frame header for all stations in the cell). Stations at the edge of the cell ignore any other color
(by reducing their sensitivity level) and transmit even when neighboring noise is detected. This mode
increases the efficiency in high density environments. 802.11ax includes multiple other provisions to
increase the efficiency of cells in high density environments, and for IoT deployments.

Plan and Design Wireless Solutions Requirements

As a wireless expert, you should have experience in evaluating wireless networks for proper coverage and
density. You should also have practiced troubleshooting long enough that you would identify issues that come
from poor design. This knowledge of design principles may not be tested in a lab test if there is no survey or
deployment to conduct. However, this knowledge should implicitly guide your choices and configuration
decisions.

In real life, you should not expect your customer to tell you what type of AP you should recommend or what
data rate at the edge of the cell would be best. Your customer is likely to express needs in terms of coverage
and use case, and you should be the one translating these needs in wireless terms. In doing so, you should keep
in mind the customer business type, identify the intended wireless clients (laptops, phones, tablets, specialized
devices, or other, in the hands of guests, staff, or users paying to access the wireless service), and the type of
area you need to cover (high ceiling, open space, high density areas such as atriums or conference areas, and
the like). Knowing that the trend is to higher densification of users, you should project your design a few years
in the future and assess whether it will still provide satisfactory services. At the time of writing, the average
quantity of Wi-Fi devices per user was about 1.65. With the development of IoT, this number is likely to reach
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3 by 2023, and this is just an average.

By talking with your customer, you should also determine the reasons for the deployment or the upgrade.
“Providing Wi-Fi in this area” is usually not enough to make a proper assessment. Beyond understanding the
user types and quantities, you should also have a clear idea of the applications that are expected to be used,
with their associated bandwidth, jitter, and roaming requirements. These elements will help you determine the
type of antennas to use, the overlap between cells, the throughput to provide at the edge of the cell, and the
configurations required to optimize the Wi-Fi service.

There are entire courses on design and surveys, and this short chapter is by no mean a summary of their
content. It is merely a reminder about the importance of the pre-survey tasks. A longer set of principles can be
found in the Enterprise Mobility Design guide: www.cisco.com/c/en/us/td/docs/wireless/controller/8-
5/Enterprise-Mobility-8-5-Design-Guide/Enterprise_Mobility_8-5_Deployment_Guide.html and in the Real
Time Traffic over WLAN guide:
www.cisco.com/c/en/us/td/docs/solutions/Enterprise/Mobility/RToWLAN/CCVP_BK_R7805F20_00_rtowlan-
srnd.html.

As you read these documents, keep in mind that most wireless deployments do not happen in greenfield
anymore. Most customers already have some Wi-Fi coverage and need to either extend the coverage area or
change its characteristics (for example, support for newer protocols or higher user density). Upgrading APs
should always be accompanied by a clean site survey, because the coverage pattern changes from one AP to
another (even with internal antennas), and the regulations may also have changed since the last deployment
was performed. Such a change may affect EIRP and coverage. The fact that you deploy in the same regulatory
domain should not lure you into thinking that the RF coverage pattern is going to stay identical. New channels
may be allowed or forbidden, and power rules for each channel may also be different. These changes have an
impact on your design and on the clients.

You should verify the type of clients expected to be deployed. Designing a coverage with newly allowed
channels for older clients that do not support these new channels is a sure method of getting support calls (and
losing a customer).

You should also translate the wireless requirements into network requirements. Each AP needs an IP address,
and an increasing number of wireless clients also implies the need for a larger addressing space, with IPv4 or
IPv6. IPv6 also has consequences for wireless. IPv6 was built on the idea of multicast exchanges, and Wi-Fi is
not a space conducive to heavy multicast flows. APs will also connect to switches. Adding APs has
consequences in the number of required switch ports (and PoE). You should design your PoE budget and
evaluate the switching support needed accordingly. You should also estimate the bandwidth consumption on
each AP Ethernet link. This estimation aligns with the number of client estimates and their traffic. Keep in
mind that Wi-Fi is half duplex, but an AP may have two active radios. Some testing may be needed to make
this evaluation. Then you should measure the consequence of this estimated traffic on the access switch
uplink, knowing that all APs are not expected to be transmitting simultaneously all the time. A 20:1
oversubscription is common (that is, the uplink is tailored to support bandwidth corresponding to one every 20
AP communicating at optimal speed at any point in time).

Finally, you should be well aware that APs can be deployed in different modes (local, Flex, Mobility Express,
Bridge). Each mode has advantages but also consequences in term of data path, supported features, and
roaming performances. You should list the deployment requirements and match them against their
consequences for the deployment model you chose.
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RF Planning, Design, and Validation

After you have an idea of the type of coverage your customer is asking from you, a standard next step is to
perform a site survey. This step is necessary to determine the number of APs and their attached antennas,
depending on the type of deployment you are aiming for. When this determination is completed, you will need
to build the RF environment by constructing boundaries for the various RRM functions (power, channel and
other RF profile variables). When the deployment is complete, you should verify whether the result matches
your design.

RF Design and Site Survey

Quite clearly, the complexity of the environment to cover will drive the type of survey you will want to
perform. In simple and small locations, a virtual tool may be enough. “Simple” in this context means an open
floor plan with a limited number of planned access points. However, limiting yourself to a virtual survey by
using a planning tool, without ever going onsite, is a recipe for a disaster, because you cannot account for the
existing RF environment and any source of electromagnetic signal that may potentially interfere with your
setup. These sources can be other Wi-Fi systems, but also any other electronic device that emits energy in the
ISM bands that Wi-Fi also use. This emission is possible even if the sources are not communication devices.
Because the ISM bands are by definition unlicensed, many types of objects may be authorized to emit signals
in these frequencies, as long as the signals respect the local regulations in terms of power and signal structure.
Unless you are onsite, you cannot guess what devices may be interfering with your planned Wi-Fi signals.

Using a Planning Tool

Nevertheless, using a planning tool is useful to prepare for the site survey. As illustrated in Figure 1-1, such a
tool allows you to have a first estimate of the number of access points needed, based on the main application
and the floor layout.

Figure 1-1 Online Planner Example
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This estimate can be used to sketch the type and number of APs and to decide whether you are expecting to
use internal or external antennas at each location. The AP count resulting from the virtual survey is also a
precious indicator of the time you will need to invest in the real site survey. A common site-survey speed is
around 10 APs per day, for an indoor coverage. By using a planning tool, you can evaluate how many days
should be invested in the site survey onsite. The planning tool can also help you get familiar with the building
layout. Onsite, it will be easier for you to determine if several floors or sections are identical. In that case, you
may be able to expedite the survey by attempting to duplicate your design from one area to the next. When
floors are identical, you may even be able to skip the AP-positioning phase and limit the survey to Layer 1 and
Layer 2 sweeps.

Onsite Surveys

After the survey preparation is complete, you should know what type of coverage is intended, how long the
survey is expected to last, and what areas are likely to be more problematic than others to survey and cover.
You should also be ready with a survey kit that includes the APs that you plan to deploy onsite and a set of
antennas that will match all the types of coverage shapes you may need.

Onsite, a traditional approach is to start with a Layer 1 sweep, using tools such as MetaGeek Chanalyzer. This
first sweep will allow you to evaluate the local interferers, locate them, and assess their impact on your
channel plan. At this point, you may have to discuss this with your customer if some interferences cannot be
worked around.

You should also conduct a passive Wi-Fi site survey, which captures the state of the existing Wi-Fi networks.
This is done with a site survey tool (for example, Ekahau Site Survey), without connecting to any particular
SSID, by scanning all channels and mapping the signals detected at each location to a floor plan. Unless the
building is new and isolated, you are likely to find existing Wi-Fi systems, which may limit your choice of
channels and power limits.

The next step is to determine the placement of each intended AP. This is done by performing an active site
survey (where your test device actually associates to the SSID configured on your test AP).

Note

In Cisco courses and exams, the terms “passive” and “active” site surveys are defined as detailed earlier.
However, some survey tools use a different terminology. You should be aware that the industry has not
adopted yet a uniform naming convention for passive and active surveys.

A common method to perform this step is to first place the AP at the edge of the coverage area—for example,
a corner of the building—then determine the coverage boundary for the desired rate and power level. This
principle is illustrated in Figure 1-2.
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Figure 1-2 Initial AP Placement

The logic is that if you get coverage up to point (2) when the AP is at position (1) on the left side of the
illustration, then you should get coverage down to point (1), which is the corner of the building, when the AP
is at position (2). Position 2 is located along the coverage boundary determined when the AP was in position
(1), preferably at equal distances from each building wall, which places the AP toward the center of the
building. After you have determined position 2, move the AP there. This is expected to be the final position of
your AP for this zone. Perform a site survey to determine the zones where the data rate falls to the minimum
acceptable value. This zone represents your coverage boundary. Next, determine the overlap between cells
(how deep inside the local cell the next cell should be allowed to extend its coverage above the minimum data
rate, as detailed further in the next section) and position the next AP until the overlap matches your design.
Repeat this logic until the entire floor is covered.

Deployment Models

The size of each cell and the minimum data rate allowed will depend on the most critical applications expected
in the deployment. In all cases, the expected power of the AP is expected to match the expected power of the
target clients. This recommendation may bring you to limit the upper value of RRM Transmit Power Control
(TPC). For example, most laptops can achieve 20 dBm, but many phones only reach 14 dBm. Even if APs
have a better receive sensitivity than most clients (for which antenna position is constrained by form factor), a
large mismatch between the client and AP power is conducive to losses at the edge of the cell.

In large spaces where only basic data traffic is expected, all rates may be allowed. The cell size in such spaces
may reach or exceed 8000 sq. ft. (750 sq. m.). With low data rates allowed at the edge of the cell, clients will
achieve only low throughput, but the goal of such deployment is coverage, not performance.

As the requirements for throughput increase, the AP power does not change, but the minimum data rate
allowed will increase. The determination of the minimum data rate depends on the throughput required by the
most demanding business-critical application, and the expected quantity of users running that application at
any time from the edge of a cell. For example, if the most critical business application requires 2 Mbps of
bidirectional throughput, and you expect that up to 2 people will always be using the application at the same
time from the cell edge, then the minimum data rate at the edge of the cell should be 2 users × 2 Mbps × 2
directions = 8 Mbps, resulting in a minimum allowed data rate of 9 or 12 Mbps (closest higher match, 12 is
more common because it is one of the initial 802.11a mandatory rates). The legacy data rates (for example, 6
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and 9 Mbps for 802.11a) would be disabled, and the first allowed rate (12 Mbps) would be set to Mandatory,
because the first mandatory rate is used for broadcast transmissions. Low 802.11n/ac rates would not be
disabled, because there is no mandate for clients to learn the allowed 802.11n/ac rates from the AP.

If your deployment provides coverage for real-time voice, a common setup is also to disable low data rates (12
Mbps minimum). However, the reason in this case is not so much throughput requirements (voice traffic
typically consumes 100 to 400 kbps of bandwidth per call, depending on the application used and its codec),
but sensitivity to jitter and delay. To limit the collision space and also let the AP power match the power of
phones, voice cells are often small (4000 sq. ft./370 sq. m. or less), and low data rates are disabled to ensure
that each frame is only going to consume a small amount of airtime, leaving space for the next voice frame.

When real-time video is added to voice, the design is usually even stricter, with data rates often starting at 24
Mbps. As usual, the deciding factor is the bandwidth consumed by the target application and the number of
expected concurrent users at the edge of the cell.

If your design needs to provide location services, throughput is not the only consideration anymore. Each
location on the floor where location should be supported needs to be in range of 3 or more APs, less than 70
feet away. Ideally, 4 APs would be in range, and they should be “around” the location, that is, in each
quadrant, as represented in Figure 1-3.

Figure 1-3 Location-Ready Points

The definition of a "Location-Ready" point is represented as a central circle shown on the four
quadrants. The distance between the central circle and each open circle on the four quadrants are
labeled "lesser than or equal to 70 feet." On the left shows the recommended and not recommended
APs. The first recommended section displays three APs at the top and bottom, and two APs with a
device at the center. The second recommended section displays four APs at the top and bottom with
one device. The first not recommended section displays two APs at the top, three APs at the center,
and one device at the bottom. The second not recommended section displays six APs and a device.

Such requirements typically lead to the conclusion that access points need to be positioned at the perimeter of
the area where location service is provided. In hallways, the APs would be scattered instead of aligned, as
shown in Figure 1.3. In all cases, the AP should have an unobstructed view of the area where location service
is needed. This design often means that the AP quantity will exceed what is required for simple data or real-
time application service. In this case, APs in excess can be put in monitor mode.
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This model is different from the high-density model. The term “high-density” is often misunderstood. It can
mean high client density (number of clients per unit of area), but can also mean high AP density (APs very
close to one another):

High client density brings the requirement for small cells, and often directional antennas, with APs set at
low power and a high minimum data rate. A primary concern in this design is throughput, because client
frames will collide with one another. Therefore, providing high throughput, in the form of high minimum
rates and sometimes rather large channels (for example, 40 MHz) is a common response.

High AP density may be the consequence of high client density, but the reverse is not true (if throughput
is not a concern, high client density may be supported with AP deployed at medium density). High AP
density presents a challenge for RRM, because channel overlap is too high to allow for proper channel
reuse. In this context, setting narrow channels (20 MHz) is often a requirement.

A typical vertical where high density is found is the education space (classroom). A great resource to evaluate
the needs of such environment can be found here:
www.cisco.com/c/dam/en_us/solutions/industries/docs/education/cisco_wlan_design_guide.pdf

RF Operational Models

After the AP locations have been determined, your next step is to design the RF coverage. Most clients will
try to scan for an alternate AP when the current AP power falls below −70 dBm to −75 dBm (depending on
client brand and form factor). This does not mean that your cell edges should be built at that signal level. For
basic data coverage, a cell edge at −72 dBm is common. For location, each detecting AP should read the client
signal at −75 dBm or better (−72 dBm or higher preferable). For real time applications (such as voice), a cell
edge at −67 dBm is common. This value also assumes a low noise floor, and an SNR of 20 dB (data coverage
case) or 25 dB (real-time application case). These requirements come from the 802.11 standard specifications
that dictate the minimum capabilities of clients to demodulate a signal received with a target encoding and
signal level. Figure 1-4 shows an extract of such requirements for 802.11ac.

Figure 1-4 802.11ac Rx Sensitivity

The column header reads MCS, Channel, SS, Data Rate (NGI), RSSI Min, and SNR Min. Row 1
reads: 7, 20 Megahertz, 1 65, 76.5, nad 17.5. Row 2 reads: 7, 40 Megahertz, 1, 135, 74.5, and 19.5.
Row 3 reads: 7, 80 Megahertz, 1, 292.5, 71.5, and 22.5. Row 4 reads: 7, 20 Megahertz, 3, 195, 71, and
23. Row 4 reads: 7, 80 Megahertz, 3 1053, 63, and 31. The text below the table reads: You need 5 dB
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more to read an 80 MHz 1SS signal than to read a 20 MHz 1SS signal. You need 8 dB more to read an
80 MHz 3SS signal than to read a 20 MHz 3SS signal. You need 8.5 dB more to read an 80 MHz 3SS
signal than to read an 80 MHz 1SS signal.

Note that these requirements are different based on the channel size and the number of streams. Therefore,
when measuring a network performance and running sample tests, keep in mind that your tests are valid only
for the number of streams and channel width of the test. Change one of the parameters and your signal will
have different consequences on the network efficiency.

You should also remember that the values provided by the 802.11 are minimums. Some clients achieve those
minimums in one direction (for example, if the AP is toward the back of the phone, but not if the AP is on the
screen side), and some devices exceed these minimums by far. For example, the preceding table shows that
the minimum Rx sensitivity for 802.11ac 20 MHz 1 SS at MCS 7 should at least be −76.5 dBm (which means
that a device should be able to demodulate successfully MCS7 1 SS received over 20 MHz at that signal level,
and with an SNR of at least 17.5). A Cisco AP can demodulate such a signal at −82 dBm, which is a signal
level four times weaker than the 802.11 requirements.

Also keep in mind that the signal level (RSSI) read on your device is only locally significant. There is no
universal method to compute the RSSI number; it is an expression of the ability of your system to convert an
RF signal into 1 and 0 digits. At the same location, one device may read −76 dBm, another −78 dBm or −73
dBm. The value depends on the sensitivity of the system and the method used to compute the RSSI number.
Therefore, when designing your cell edge, you should always take some conservative margin to account for
various systems sensitivities and never assume that performances measured with one client will be valid for all
other clients. A good approach is to use the “worst performing” client as a reference.

The cell edge signal level is the location at which the current and next AP should be heard at similar levels.
For example, a cell edge built at −67 dBm means that when a client moves away from an AP until the AP
signal is detected at −67 dBm, at that location the next AP signal is also detected (likely on another channel)
at −67 dBm. As the client keeps moving, the first AP signal decreases while the next AP signal increases. At
some point, the client internal algorithm will decide to leave the first AP, will scan and discover the next AP
with a strong signal, and will roam there.

This approach focuses on the signal, but you should also remember the minimum data rate approach described
in the previous pages. At the edge of your cell (for example, −67 dBm), your client should still achieve the
minimum data rate you allowed on the WLAN. If the client cannot reach that data rate, your cell edge needs
to be built at a higher signal level. This additional requirement also brings the concept of overlap. When the
client moves away from the AP and reaches the minimum intended data rate, you should still be able to walk
some distance with the client functioning properly at that data rate. When you move in the other direction,
from the next AP, your client, connected to that next AP, should also achieve the same minimum data rate in
that same area. The overlapping zone where the client can achieve that rate when connected to any of the two
neighboring APs is your cell overlap. A common way to measure that overlap is in percentage of the total cell
size, and you will read recommendations around 10% overlap for data and 15 to 20% overlap for real-time
applications. Mentally computing percentages for overlapping circles (or even more complex shapes) is
uselessly complicated. A simple rule is to reach the point where your cell edge is located (based on minimum
rate or signal), then measure the distance to the AP. Your next AP should be about at 1.4 times (or “1.374
times,” if you love accuracy) that distance from the previous AP to achieve the recommended 15–20%
overlap, as shown in Figure 1-5.
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Figure 1-5 20% Cell Overlap

The figure shows three overlapping cells with an access point at the center at radius R. The client
power is transmitted to all three overlapping cells. The distance between the two APs is labeled "X"
where X equals R squared over 2R. The 20 percent overlap: X equals 1.374R.

Your cell overlap depends on the power at which the AP is set. Remember that the AP power should
approximately match your client power. You should then use RRM boundaries in Transmit Power Control
(TPC) to limit the power range. Allowing your AP to increase its power by 3 dBm (or decrease its power by 3
dBm or more, depending on the overlap), is a common practice.

You should also ensure that channel width and overlap are optimized with Dynamic Channel Assignment
(DCA). In many cases, you may want to choose Dynamic Bandwidth Selection (DBS) to let RRM determine
the best channel width based on the AP density and channel availability. You should remember that clients
may have different reactions when faced with APs of different channel widths. Some clients will choose the
AP with the strongest signal (for example, most Android); some other clients will arbitrate by using a
combination of signal strength, channel utilization, and client count (for example, iOS); some clients will
prefer APs with larger channels (such as macOS, provided that APs have a strong signal, that is, higher than
−68 dBm).

In some cases, high density will force you to use DFS channels. In that case, keep in mind that clients
commonly only passively scan these channels, and scan them last (for instance, scan all channels 5 times, then
scan DFS once, because this segment takes longer to scan). This behavior slows down roaming to those
channels. A consequence is that DFS channels are acceptable in high density, when sufficient coverage is not
possible without these channels, but they are not a preferred choice. Some clients also do not support DFS
channels at all.

In most networks, enabling CleanAir to detect non-Wi-Fi interferences is necessary, and configuring Event
Driven RRM to allow an AP to move away quickly from a channel affected by interferences is a good idea.

All these recommendations are general, and you will find more details that, as an expert, you should master, in
the following documents: www.cisco.com/c/en/us/td/docs/wireless/controller/8-1/Enterprise-Mobility-8-1-
Design-Guide/Enterprise_Mobility_8-1_Deployment_Guide/wlanrf.html and
www.cisco.com/c/en/us/td/docs/wireless/controller/technotes/8-3/b_RRM_White_Paper.html.
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As an expert, you should also recognize that automation cannot solve all issues. There may be cases where
you will decide that setting the AP channel, or the AP power, statically offers a better option. A typical case is
an AP on the ground floor, near a street, advertising a well-known SSID. As people walk by the building and
their device automatically associates to the SSID, Coverage Hole Detection and Mitigation (CHDM) can
detect coverage gaps and inflate the power of the AP. TPC may be set to limit such an increase, but there may
be cases where you will decide to instead set that AP power to static value.

Similarly, you will recognize that RF settings that are ideal for some APs are not the best for some other APs
connected to the same WLC. This will bring you to design groups of alike-APs organized in different RF
profiles. Recognizing the particularity of each coverage area and customizing the WLC configuration for each
area are expected to be the core of your expertise.

Deployment Validation

After the APs are installed, your last step is to validate whether the network performances match your design.

A first step in this direction is to walk the entire floor with a site survey tool, running a passive survey to
measure your AP’s signal. At a minimum, you should use “some” device displaying an RSSI value and
verifying your cell edges signal and cell overlap.

In all cases, you should also verify that the protocols you targeted are enabled and functional. For example, if
you designed cells around 40 MHz channels with 802.11n/ac with 2 SS and a minimum data rate of 24 Mbps,
you should walk the floor and assess that no location has any wrong settings (for example, 80 MHz 4 SS, or 6
Mbps allowed). You should pay special attention to difficult areas (high ceilings, reflective surfaces, and so
on.)

Another important area to test is rate shifting, as illustrated in Figure 1-6.

Figure 1-6 Rate Shifting Tests

An illustration shows a man walking over a floor to conduct dynamic rate shifting tests in two cases.
The first case shows an AP below the floor, with data rates of 24, 36, 48, and 54 Megabits per second
being used. There are several retransmissions. The second case shows two access points: one at the
floor level, and the other overhead. Data rates of 24, 36, and 54 Megabits per second are used.

Using the most business-critical and delay-sensitive application, you should test key areas where rates are
expected to shift down, especially when rate shifting down is a prelude to roaming. Typical locations include
corners with heavy walls, areas around elevators, or corridors with fireproof doors. In every location where
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the signal suddenly drops, your client will keep trying the current data rate a few times, then will rate shift
down slowly. The whole process is time consuming. For example, sending a 200-byte frame at 54 Mbps takes
3.7 microseconds. Sending the same frame at 24 Mbps takes 8.3 microseconds (these numbers ignore the
overheads, for simplicity). However, rate shifting from 54 Mbps to 24 Mbps (failing 3 times on each
intermediate rate) can consume 1100 microseconds, 65 times longer than sending the next frame. You should
evaluate this impact on your critical application performances. The entire flow (from the first retry to the full
recovery on the next AP) should be measured and compared to the performance requirements of your design.

Additionally, running throughput tests while roaming is a good way of verifying your coverage characteristics.

Finally, you should also evaluate redundancy—for example, testing the effect of disconnecting an AP. If RRM
is configured properly, you should still be able to achieve connectivity in that area, even if you cannot achieve
the target performances anymore. In most networks, redundancy extends beyond the pure RF coverage and is
built at the WLC levels (with HA), the switches and the services (DHCP/AAA, and so on). These sections of
the network are likely to be under the responsibility of other teams. However, when Wi-Fi connection fails,
you will be the first to be blamed (before the finger is pointed, for example, to the DNS server), so you need to
ensure that redundancy has been thought of everywhere, so that the full network can support your Wi-Fi
coverage.

Summary

Following all these steps ensures that your wireless network is not only expertly configured but also expertly
designed. As the saying goes, good configuration cannot compensate for bad design. Part of your expertise is
to know each option in the AP or WLC and understand the various ways it can be configured. But part of
your expertise is also understanding why an option is there, and what role it plays in the overall landscape of
Wi-Fi deployments. Building such knowledge requires more than reading this short chapter, and you should
make sure to master the various references indicated throughout the preceding pages.

You should also expect that the CCIE Wireless exam tests your expertise. As such, elements of configurations
that are asked from you rely on assumption of expertise in the principles of wireless design. Making sure that
you understand the core design principles is the safest way of guaranteeing that you will understand possible
unspoken requirements behind configuration instructions in the lab.
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Chapter 2

Network Infrastructure
Introduction

More often than not, wireless engineers or any other people interested in wireless tend to focus only on the wireless side of things,
because it is what started their passion for networking in the first place. However, it is precisely because an access point is a device
bridging 802.11 wireless frames to 802.3 Ethernet frames, and vice versa, that a good wireless administrator will need to be
proficient in configuring the wired infrastructure to support the wireless network. The best designed wireless infrastructure will
perform very poorly if there is poor design, planning, or configuring on the wired side of things. In many other cases, certain types
of wireless traffic will simply not work or flow because of misconfigurations on the infrastructure side. Wireless CCIEs are not
required to have the same proficiency in routing or switching as an R&S CCIE but they should be able to discuss effectively with
one another and understand the technologies and challenges.

This chapter covers the technologies that are involved in providing a stable wireless network. Each section provides information on
a specific technology or protocol. This chapter does not cover each of those protocols and technologies in every detail, nor does it
cover each of their settings and darkest tweaks. It also does not cover every type of switch or routing device that you may
encounter in the real world. Instead, it focuses on the devices used in the CCIE Wireless blueprints and will give you the
foundations to adapt to other network devices, if you need to do so. However, it gives an introduction and “deep enough”
understanding for a CCIE Wireless candidate to become proficient in configuring those devices in order to set up a well-performing
wired infrastructure that will support a well-performing wireless network.

At the end of this chapter, you should have a good understanding of the technologies involved in configuring and optimizing a wired
network to support a good wireless infrastructure.

Switching Technologies

We first focus on technologies that revolve around Layer 2 before moving higher up in the OSI model layers.

VLANs

A lot can be said about VLANs, and chances are that if you are reading this, you must have an idea or two about how to use them.
What are the VLANs pros and cons with regard to wireless, though? Are the guidelines the same as for a fully wired network? Let’s
see.

A VLAN, basically, is a (virtual) Layer 2 network or subnet within your physical topology. A VLAN defines a broadcast domain—
that is, all the links where broadcasts emitted in that subnet will be sent through. It is important to realize that clients will broadcast
for ARP in IPv4, for DHCP, but also for a large amount of discovery protocols depending on their operating system. A lot of
services discover compatible devices through same-subnet broadcasts (or multicast, which will also be spread across the VLAN).
This represents a lot of traffic, and VLANs are here to help reduce the size of the domain of those broadcasts. Each VLAN will also
typically require a gateway for hosts to reach out to other subnets. This gateway can be configured on a switch or a router in the
network, where some VLAN interfaces are centralized.

You can configure a switchport to be in access mode; it is then mapped to a specific VLAN statically. No VLAN tags on the frames
are used with this method. You can therefore connect a host or PC (which typically are not VLAN aware) to such a switchport, and
the switch will automatically consider that all traffic coming from this port is mapped to the specified VLAN. It will then be
forwarded accordingly only to ports where that VLAN is configured (until a gateway routes the packet, possibly).

Click here to view code image

Switch1(config)# interface Gig0/1
Switch1(config-if)# switchport mode access
Switch1(config-if)# switchport access vlan 20
The preceding is traditionally used to configure ports where hosts or end devices connect. However, links between infrastructure
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switches will often have to carry several VLANs. This is where the switchport mode trunk kicks in.

Click here to view code image

Switch1(config)# interface Gig0/2
Switch1(config-if)# switchport mode trunk
Switch1(config-if)# switchport allowed vlan 1-10
The previous commands configure the port to trunk mode and allow only VLANs 1 to 10 through it. Other VLANs will not be
allowed to cross the link. If you do not specify the allowed vlan command, all VLANs will be allowed by default (although this
may vary depending on the platform). In the past, there were several ways to implement VLANs and several protocols to achieve
this function, but nowadays the standard 802.1Q is the only way to go. As shown in Figure 2-1, it is a header present (only on trunk
ports) at the Layer 2 level.

Figure 2-1 802.1Q Header Present on Frames on Trunk Ports

The figure shows an Original Ethernet Frame with the following headers: DA, SA, Type/Len, Data, and FCS (crossed-out).
The Ethernet Frame with 802.1q Tag contains: DA, SA, Tag, Type/Len, Data, and FCS. The tag header, of 4 bytes,
includes the headers EtherType (2 bytes, value = 0x8100), PRI (3 bits, 0-7), Token Ring Encapsulation Flag (1 bit, 0-1),
and VLAN ID (12 bits, 0-4095).

It is good practice to always restrict the VLANs of a trunk to the required VLANs, to avoid unneeded broadcasts traveling insane
distances. A trunk port by default will use VLAN 1 as native, which means that all frames in VLAN 1 will not have any 802.1Q
encapsulation header. It also means that the switchport will consider all non-802.1Q tagged traffic it receives to belong to VLAN 1.
This native VLAN can be changed with switchport trunk native vlan <id>. It is important that both ends of a trunk port consider
the same VLAN to be the native; otherwise, you will be bridging two different VLANs together. Indeed, if the first switch sends a
frame in VLAN 5, and VLAN 5 is the native for that switch, the frame will be sent without any 802.1Q tag. If you then imagine that
the connected switch is configured to consider VLAN 1 as the native, and it receives an untagged frame, it will consider it to belong
to VLAN 1 and will bridge it accordingly. So, care needs to be taken when deciding which VLAN will be the native VLAN for your
trunk ports.

For a VLAN to work on a given switch, it must be created first. It is also a typical catch if you create a Switch Virtual Interface
(SVI; that is, a Layer 3 interface) for a given VLAN and the SVI does not come up. Verify the VLAN database (with show vlan)
and, if it’s missing, create it (setting a name is optional):

Click here to view code image

Switch1(config)# vlan 10
Switch1(config-vlan)# name marketingvlan
On the wireless side of things, lightweight access points require an access mode switchport unless FlexConnect local switching is
being used, which typically requires a trunk mode switchport because you are likely to use more than one SSID/VLAN (but it’s not
a hard requirement otherwise). Autonomous access points support both; it all depends on how many VLANs you configure the
access point to support.
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From a design perspective, it is important to understand that a WLC will automatically, by default, stop broadcasts. It acts as an
ARP proxy and DHCP proxy to unicast just the right client and drastically reduces the amount of broadcast traffic in the VLAN.
This allows for much larger subnets for wireless clients. On the other hand, it is important to still be cautious of the number of
broadcasts spreading around your VLANs in case you have many wired devices (including APs) in the same VLAN.

Table 2-1 includes your go-to commands when suspecting a VLAN-related issue on a switch. They will show you which VLANs
exist and which VLANs are allowed on ports.

Table 2-1 show Commands Helpful in Analyzing the VLAN Situation on a Switch

Command Purpose
switch# show interface
trunk Displays all active trunk ports, their native VLANs, and VLANs currently active on them

switch# show vlan Shows the VLAN database with all the VLANs existing on that particular switch, along with the ports
where they are active

Private VLANs

You can configure private VLANs to further isolate subdomains in a given VLAN. When configuring a private VLAN on a
switchport, the devices behind that port will be able to communicate only with the gateway and not spread Layer 2 broadcasts to
other ports on that switch in the same VLAN. It is also possible to carry the private VLAN information between several switches
supporting it, to create a subdomain within a given VLAN where devices can communicate directly at Layer 2 (those devices will
have to use the gateway for outside communication, though). There will be a mapping between a primary VLAN (a VLAN as we
have defined it so far) and secondary VLANs (private VLANs) that will exist within that VLAN on switches supporting this.

There are two types of private VLANs: isolated and community. An isolated secondary private VLAN can only communicate
toward the primary VLAN (and thus its gateway). A community secondary private VLAN can communicate to other hosts in the
same secondary VLAN as well as the primary VLAN, but cannot communicate to other secondary VLANs. A PVLAN port can be
configured in promiscuous mode or host mode. Promiscuous mode ports will allow communication from several (defined)
secondary and primary VLANs. Host mode ports will allow traffic only from specific secondary VLANs to promiscuous ports or
host ports in the same community PVLAN. Figure 2-2 illustrates the host port versus promiscuous ports behavior difference.
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Figure 2-2 A Promiscuous Port for the Uplink and Two Hosts Connected to Host Ports

The figure shows a switch connected to an uplink through a promiscuous port. The port allows unidirectional traffic from
the switch to the uplink. The switch also connects to two remote hosts. The host ports, however, do not allow direct
communication between the hosts.

Private VLANs are useful when you want to segregate devices but still have to use the same VLAN (and therefore subnet and SVI).
In the next example, we are configuring VLAN 10 to be the primary, and within it, we will have secondary VLAN 200 in
community mode and 300 in isolated mode. Port Gig0/1 will be set in promiscuous mode and will allow traffic from both private
VLANs 200 and 300 to flow. Figure 2-3 illustrates the community mode behavior.
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Figure 2-3 Community Host Ports Forward Their Private VLAN Only to Other Members of Their Community or to
Promiscuous Ports but Not to Other Communities

A switch at the center connects to an uplink via an interface Gig0/1. A promiscuous port exists between the switch and the
uplink. Two community hosts (each with VLAN 200 and VLAN 300) are shown connected to the switch. Bidirectional
communication occurs between the VLANs inside the same community, or between one community group and the uplink
(via the promiscuous port). Host ports prohibit communication between the communities.

Example 2-1 Configuring Private VLANs

Click here to view code image

Switch1(config)# vlan 10
Switch1(config-vlan)# private-vlan primary
Switch1(config-vlan)# exit
Switch1(config)# vlan 200
Switch1(config-vlan)# private-vlan community
Switch1(config-vlan)# exit
Switch1(config)# vlan 300
Switch1(config-vlan)# private-vlan isolated
Switch1(config-vlan)# exit
Switch1(config)# vlan 10
Switch1(config-vlan)# private-vlan association add 200,300
Switch1(config-vlan)# exit
Switch1(config)# interface Gig0/1
Switch1(config-if)# switchport mode private-vlan promiscuous
Switch1(config-if)# switchport private-vlan association mapping 10 200,300
Switch1(config-if)# interface Gig0/2
Switch1(config-if)# switchport mode private-vlan host
Switch1(config-if)# switchport private-vlan host-association 10 200
Table 2-2 show Commands Relating to Private VLANs

Command Purpose
switch# show vlan
private Displays all the private VLAN information along with their primary VLAN mapping and active ports

switch# show vlan Shows the VLAN database with all the VLANs existing on that particular switch along with the ports
where they are active

VLAN Trunking Protocol

As we already briefly mentioned, a well-managed network only allows for the needed VLANs on any link, to prevent unrequested
broadcasts from spamming your network unnecessarily. However, VLANs must exist in the VLAN database of all the switches they
will cross. It is easy to envision how painful the addition of a new VLAN or subnet will be. You create a VLAN on a switch, map a
switchport to it, allow it on your uplink trunk, and you think you’re done for the day—only to realize later that traffic is not passing
further down the network because you did not create that same VLAN on another switch that is on the traffic path.

This is where VLAN trunking protocol (VTP) comes to the rescue. The following explanations (unless specifying the particular
version) focus on VTP version 2. We also cover the differences with VTP version 3 right after. One of your switches will function
as a single source of truth and will update other switches in the VTP domain about the VLANs in operation. The domain is a group
of switches sharing VLAN information under a 32-character identifier. The switch operating in server mode can add, delete, or
rename any VLAN, and the configuration will be saved in the NVRAM. In client mode, the switch will receive its VLAN
information from the VTP server and will use this for its VLAN database. The administrator will not be allowed to make
modifications to the client switches VLAN database. One last VTP mode is the transparent mode, in which the switch does not
participate in VTP (that is, does not “install” the VTP information passed in its database) but will allow the propagation of that VTP
information to switches further down the path. In transparent mode, the administrator can make changes to the VLAN database on
that transparent mode switch. These modes are illustrated in Figure 2-4.
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Figure 2-4 VTP Server, Transparent, and Client Mode

Three switches, representing VTP server mode, VTP transparent mode, and VTP client mode are connected via trunk. A
callout pointing to VTP server mode reads "I have just created VLAN 10, so I'll send VTP update to other." A VTP
advertisement from the server mode to the transparent mode is shown. A callout pointing to the VTP transparent mode
reads "I am a VTP transparent mode, so I don't care. I just forward it to other." Similarly, another VTP advertisement is
passed from the transparent mode to the VTP client mode. A callout here reads "I am a VTP client mode, so I'll update my
VLAN database."

To configure VTP, you need to set the VTP version (it must match on all switches) and the VTP domain as well as the switch mode.
It is also a requirement to have a trunk port configured on the switch (VTP only propagates on trunk ports, not access) and for all
VTP switches to be directly adjacent.

Every time the VTP server switch has a new VLAN configuration change, it will increment its configuration revision number
(starting at 0). Client VTP switches will update their database only if the received VTP revision is higher than their current revision
number. This prevents old VTP data from continuing to propagate and corrupt the configuration. This can also prevent the situation
in which a test switch (with low revision count) connects to the production network overriding all the VLAN configuration. This is
also important to keep in mind in case your configuration looks good but you don’t see your VTP clients using any of the server
information; if you have played with the VTP clients before or changed their roles, they might have a higher revision count at that
moment in time (and therefore are not accepting the latest server update). Note that having more than one VTP server in the same
network is also allowed. They will sync their revision numbers, and any new revision caused by a configuration change on one of
the servers will immediately be installed on all the other switches (including servers) and increment their revision number.

VTP has several versions. Version 1 and 2 are similar and support only VLANs from 1 to 1024. VTP version 3 supports 4000
VLANs. VTP version 3 will propagate updates to VTP version 2 clients but not the other way around, so it’s best to match the
versions everywhere as much as possible. Version 3 also supports private VLANs, adding protection from unintended database
override during the insertion of a new switch, configuration options on a per-port basis, and clear-text or hidden password
protection. It also not only transfers the VLAN database, but also the MST (spanning-tree) database. A switch in transparent mode,
even if using VTP version 1 or 2, will properly forward version 3 updates containing all these new features. Example 2-2 shows a
small example of a basic VTP configuration.

Example 2-2 Configuring VTP

Click here to view code image

Switch1(config)# vtp domain CCIE
Configures the VTP domain to the string "CCIE"
Switch1(config)# vtp password topsecretpassword
Optionally configures a password (it can be secret or hidden only in v3)
Switch1(config)# vtp version 2
Configures version 2 of VTP
Switch1(config)# vtp mode server
Configures the mode (server, client or transparent)
Switch1(config)# vtp interface VlanY
By default, vtp uses the lowest-numbered vlan interface to source VTP updates. In
case that vlan is not allowed through to all neighboring switches, you may have to
specify that source interface yourself
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Table 2-3 shows the basic commands that will allow you to verify and validate a VTP configuration.

Table 2-3 show Commands Related to VTP Configuration Verification

Command Purpose
switch# show
vtp interface

Displays all the interfaces of the switch and whether VTP is enabled for those interfaces (enabled by default on
all interfaces; you can do “no vtp” on a given interface to disable it there)

switch# show
vtp status Shows all VTP-related information (domain, version, mode, configuration revision)

switch# show
vtp devices Displays information about all VTP version 3 devices in the domain

Spanning Tree Protocol

If a loop exists in a network in such a way that a frame can be received by a device after it sent that same frame, all hell breaks
loose. This would happen (if there was no spanning tree) as soon as more than one single link exists between two given devices in
the network. It would cause not only duplicated frames and out-of-order packets, but also switches would learn the same MAC
address alternating between different ports (also referred to as “flapping”). The loop would also cause endless traffic as broadcasts
(or frames sent to multiple destination ports) would create traffic that never stops until its time to live (TTL) expires (if there is one;
not all frames have a TTL).

The purpose of the Spanning Tree Protocol (STP) algorithm is to form a tree with the network topology. There is one root node, and
from there, only leaves: there are no more than a single path to any leaf, and all leaves can reach out to each other if going back
through the root and the whole structure is loop free.

This root node, called the root bridge (because switches are bridges originally) is elected based on the Bridge ID (BID), which is a
mix of a 2-byte priority field combined with the MAC address. In STP, the lower value is preferred to become the root bridge. In a
default configuration, the priority field is 32768 and is the same on all switches. The root is therefore chosen solely based on the
lowest MAC address. Interfering with this election process is as simple as lowering the priority value on the switch you want to
become root. Each switch will calculate the path cost to the root through all their possible ports. If only one port leads to the root
bridge, it will be elected the root port for that switch; if more than one port leads to the root, then the one with the shortest (that is,
lowest cost) will be chosen as the root port. A specific cost is associated to each link bandwidth (a 10 Gbps link has much smaller
cost than Fast Ethernet, for example). In case of identical path cost, the lowest port ID is chosen. All other ports leading to the root
(apart from the root port) will be put in blocked state to avoid loops.

Each switch sends STP messages called BPDUs as a Layer 2 multicast. Ports connecting to end devices do not receive BPDUs;
therefore, the switch knows there is no path to the root through those, and they can be in forwarding state.

The various STP states are the following:

Blocking: A port is always in blocking mode when it comes up (to avoid issues), and it stays in blocking state if the switch
detects it leads to the root bridge but is not the most optimal path.

Listening: When a port is in listening state, it listens for other switches or bridges. It does not send anything; it only listens.

Learning: The switch keeps listening for other bridges but can also learn MAC addresses on that port.

Forwarding: Normal operation mode. Data and BPDUs are passed through the port.

The main STP timers are the Hello timer, the Maximum Age, and the Forward Delay. The Hello timer means that the switch will
send a BPDU every 2 seconds by default. The max age of 20 seconds by default determines the time for which the port is kept in a
blocking state before listening. The forward delay of 15 seconds by default means the port will stay for 15 seconds in the listening
state before moving to the learning state, and the same amount of time between the learning state and the forwarding state.
Technically, this means that a port will not be forwarding traffic for 30 seconds after it is brought up.

Similar to the states, there can be three port types that STP will set on a given switch:
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Root: Only one per switch. This port is the most optimal path to the root bridge.

Designated: This port is forwarding; there is a designated port for each LAN segment to reach.

Alternate (non-Designated): This port is blocked. It is a suboptimal path to the root. In case of failure of the root port, one of
the alternate ports will become the root port.

Figure 2-5 illustrates the different STP port types.

Figure 2-5 Designation of Root and Alternate Ports in Spanning Tree

The figure illustrates the three different STP port types: Root port, designated port, and alternate port. The root port from a
switch connects to the root bridge via a designated port. The root bridge connects to the root port of another switch via a
designated port. This switch connects to the root port of another switch. Also, an alternate port exists between this switch
and the first switch. A cross mark indicates that the port is not chosen and should be closed down.

The only device that doesn’t have any of its ports in the root status is the root bridge.

Rather than modifying the priority of the bridge ID to influence the root bridge election, you can use commands to do it for you:

Click here to view code image

Switch1(config)# spanning-tree vlan X root primary
Switch2(config)# spanning-tree vlan X root secondary
These commands influence the priority so that Switch1 will lower its priority to be the root when it is online, and Switch2 will
become the root if Switch1 is not present. They are useful in making sure your backbone, or most powerful switch, is the root rather
than a smaller access switch. In case you want to set priorities manually, you can use spanning-tree vlan <vlan id> priority
<priority value>, but bear in mind the root commands are macros and don’t guarantee the switch will always be root regardless of
what further priorities show up on the network.

There are also situations where a device has two or more uplinks to interconnected backbone switches, and you want to determine
which link will be in the forwarding state and which one will be blocked, rather than letting STP decide.

Click here to view code image

Switch1(config)# interface Gig0/1
Switch1(config-if)# spanning-tree port-priority 0
Switch1(config-if)# interface Gig0/2
Switch1(config-if)# spanning-tree port-priority 240
The lower the port priority, the better. In the previous example, it means that port Gig0/1 will be forwarding rather than Gig0/2 if
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they both were candidates for root port with equal cost until then. Valid priority values are increments of 16: 0, 16, 32, 48, 64, 80,
96, 112, 128, 144, 160, 176, 192, 208, 224, and 240. The default is 128.

STP also allows the configuration of path cost, which is directly tied by default with the interface bandwidth. If port priorities are
the same, the cost is the deciding factor.

Table 2-4 lists show commands that will help you have an overview of the current spanning tree status.

Table 2-4 show Commands Related to Spanning Tree Troubleshooting

Commands Purpose
show spanning-tree active Displays spanning tree information on active interfaces only.
show spanning-tree detail Displays a detailed summary of interface information.
show spanning-tree vlan vlan-id Displays spanning tree information for the specified VLAN.
show spanning-tree interface interface-id Displays spanning tree information for the specified interface.
show spanning-tree interface interface-id
portfast Displays spanning tree portfast information for the specified interface.

show spanning-tree summary [totals] Displays a summary of interface states or displays the total lines of the STP state
section.

show spanning-tree blockedports Displays all the alternate ports that are blocked currently.

We have only covered basic spanning tree in this section so far. Historically, many devices have been running Per-VLAN Spanning
Tree (PVST) or variants of it, such as Rapid PVST. With such a method, one completely separate instance of the Spanning Tree
algorithm runs on each VLAN the switch knows. Therefore, from the command spanning-tree vlan 30,40 root primary, you can
figure out that there can be different root bridges in each VLAN and that a different election and different tree is built for each
VLAN in the network, which can be very resource-consuming if you have many VLANs in your network.

Rapid PVST is a backward-compatible evolution of PVST that allows for a much faster convergence (within 1 second, compared to
30–50 seconds with the standard PVST).

STP Tuning Commands

The first and most important STP optimization command is spanning-tree portfast. This command is to be typed on edge ports
only, where no loop can happen and only client devices connect. A link failure on such a port should definitely not trigger any STP
topology changes. When the command is configured, the port is immediately moved to the forwarding state when it comes up. This
is a best practice to configure on ports (in switchport access mode) where unified access points in central switching are connected.
Access points have only clients connecting to them; they should never receive BPDUs over the air and will not cause any STP
topology changes. Therefore, this command allows AP switchports to immediately come up and into the forwarding state. A
variation of it is spanning-tree portfast trunk. Whereas a trunk typically indicates a connection to another switch, it can also be
used for access points in autonomous modes or FlexConnect local switching. In this case, the spanning-tree portfast command will
have no effect, and you must use spanning-tree portfast trunk instead because the switchport is in trunk mode.

BPDU Guard is a good complementary measure for portfast ports. When enabled, BPDU Guard shuts down the port (technically it
moves it to err-disabled, and you can configure recovery options) when it receives a BPDU. It is a secure response to an invalid and
unexpected event. Always keep in mind that portfast ports are supposed to be connected to end devices and should not be used to
connect a switch, because this would create a loop (since the portfast port is moved to forwarding state instantly). In such a
situation, BPDU Guard will prevent this from happening by shutting down the port, as illustrated in Figure 2-6. When enabled
globally, BPDU Guard will apply to all interfaces with portfast configuration.
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Figure 2-6 BPDU Guard Prevents Receiving BPDUs on Portfast Ports

The figure shows a laptop connected to the root port of a switch labeled Not Root. BPDU Guard is shown between the
laptop and the switch. The switch connects to the designated port of another switch (labeled Root). From a second
designated port, the Root connects to the root port of another switch, Not Root. Blocked/Alternate ports are indicated
between the two "Not Root" switches.

BPDU filtering can be done globally on all portfast ports or on a per-port basis. It will prevent the switch from sending or receiving
BPDUs on those ports. In case a BPDU is received on a regular portfast port, the port loses its portfast status and becomes a normal
STP port. Therefore, BPDU filtering is dangerous and can be a cause for unhandled bridging loops because the port will keep
forwarding even if you plug another switch to it (because it is configured to drop all BPDUs it receives).

EtherChannel guard will detect when interfaces are configured for EtherChannel on the local switch but not on the other end of the
links (or in invalid configuration on the other end). To prevent a loop, it will set the interfaces to err-disabled state.

Root guard prevents a port from becoming root port or alternate blocked port. If a port configured for root guard receives a superior
BPDU, it will immediately go to the root-inconsistent blocked state, as shown in Figure 2-7.

Figure 2-7 Root Guard Prevents Electing a Port as Root

The figure shows a laptop connected to the root port of a switch labeled Not Root. BPDU Guard is shown between the
laptop and the switch. The switch connects to the designated port of another switch (labeled Root). From a second
designated port, the Root connects to the root port of another switch, Not Root. The Root port of the first "Not Root"
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switch shows a priority 32768. The BPDU's priority is 4096. As the priority is lower, the Root guard says No.

Loop guard will help detect unidirectional link failures. As soon as a root or alternate port stops receiving BPDUs from the other
end of the link, it will transition to the loop-inconsistent blocking state, assuming there is an error on the link (it may be up, but we
are not receiving BPDUs anymore from the other side, so something is definitely fishy).

Multiple Spanning Tree

An evolution of Rapid PVST is Multiple Spanning Tree (MST). Having one instance of STP per VLAN is very resource consuming,
and MST solves this by having one MST instance run for several (typically an unlimited amount of) VLANs at a time. MST also
allows for multiple forwarding paths for data traffic and load balancing. MST is backward compatible in a network with devices
doing PVST or Rapid PVST. You can change the spanning tree mode with the command spanning-tree mode mst.

Switches will form an MST region and participate together if they have the same VLAN-to-instance mapping, the same
configuration revision number, and the same name. A VLAN can belong to only one MST instance (to prevent conflicting
decisions).

Click here to view code image

Switch1(config)# spanning-tree mst configuration
Switch1(config-mst)# instance 1 vlan 5,10-20
Switch1(config-mst)# name region1
Switch1(config-mst)# revision 1
Switch1(config-mst)# exit
Switch1(config)# spanning-tree mode mst
Switches will start the MST instance as soon as the spanning-tree mode mst command is entered.

Commands will be similar to PVST; for example, spanning-tree mst 1 root primary will configure the switch to be the root bridge
in all the VLANs covered by instance 1. Similar commands exist to other modes and are preceded by the MST instance ID. You can
also configure several MST instance IDs by using commas or hyphens.

Spanning Tree and Wireless

We already covered that access points should always be on switchports configured with spanning-tree portfast. WLCs don’t
participate in spanning tree or send BPDUs. Because they should never create a loop (whether APs are in local mode or
FlexConnect), and because it is a front end for clients and no other network devices, it is recommended to set the WLC port as a
portfast trunk as well. Note, however, that there may be an exception revolving around Mesh Ethernet bridging or workgroup
bridging where you may end up with a switch being connected behind a wireless client. In this particular instance, it is up to the
administrator to make sure there will not be a loop (that is, the remote bridged site should not have a wired connection to the root
side) and that BPDUs are not sent over the air.

EtherChannel

EtherChannel, also referred to as portchannel, is a widespread technology in wireless networks. It answers several questions:

How can I leverage an existing infrastructure to get more bandwidth on a link between these two devices without upgrading to
the next Ethernet standard? (Two times 1 Gbps links is sometimes cheaper or more easily implemented due to hardware
limitations than a single 10 Gbps link or, similarly, two times 10 Gbps rather than a single 40 Gbps, for example, and might just
fit the need.)

How can I get more reliability in case a link goes down due to port or cable failure?

The now legendary Cisco 4404 WLC had four 1 Gbps ports at a time when 10 Gbps was still expensive and not particularly widely
available on core campus switches. Today, the 8540 WLC has four 10 Gbps ports for the very same reasons. (10 Gbps has become
more affordable and widespread, whereas 40 Gbps is not quite there yet.) On top of the increased bandwidth, EtherChannel also
provides link redundancy: when one of the links forming the EtherChannel goes down, the others keep forwarding, and the only
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impact is decreased overall bandwidth (that faulty link can’t be used anymore until the cable is replaced or other fault fixed). This is
illustrated in Figure 2-8.

Figure 2-8 Advantages of EtherChannel

If you don’t use EtherChannel and set up several physical links between the same two network devices, spanning tree will do its job
and block all but one link to avoid loops, as shown in Figure 2-9. There is no increased bandwidth involved because only one link is
used at a time, and the spanning tree algorithm will be the one deciding which other link will come up after the active link goes
down. The redundancy is, therefore, slightly less real-time because it’s another link that has to come up. With EtherChannel, you
are grouping physical interfaces together, therefore creating a virtual portchannel interface that will represent all the links as a
single one from that point on. This single virtual portchannel interface means that for STP, all links participating in the portchannel
are now seen as a single link and therefore are set to forwarding or blocked all together as one. It also means that you can (and
actually must) from there on configure all those links only through the virtual portchannel interface rather than through the specific
physical interfaces. The portchannel interface configuration will be applied to all ports participating in the portchannel bundle.
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Figure 2-9 If Not Using EtherChannel, One of the Ports Will Always Be Blocked by STP

There are a few restrictions though. EtherChannel can only be configured between a maximum of 8 ports of the same speed and
technology (all GigabitEthernet or all TenGigabitEthernet, but no mix-and-match). Each end of an EtherChannel link must also be
configured in the same way.

A careful reader will immediately ask how loops are prevented, because all the physical links constituting a portchannel are up and
forwarding at the same time, and STP sees them as only one link. The answer is the load balancing algorithm. The switch(es) where
EtherChannel is configured will use a configurable algorithm to make sure packets of the same flow will always go through the
same physical port. This prevents out-of-order packets or fragmentation issues in an easy and practical manner. A classical method
for wireless networks is to declare that all packets from the same source and destination IP pair will go through the same link. This
means that a specific access point will always send its traffic through the same link when sending to the WLC, but another access
point might use another physical link. This is completely transparent to the end devices because only the two devices participating
in the EtherChannel bundle are aware and must agree on this method.

You have three methods of configuring an EtherChannel:

By using PAgP negotiation protocol

By using LACP negotiation protocol

By turning it always on without negotiation

The same method should be used on both ends of an EtherChannel in all cases. PAgP is a Cisco proprietary protocol that will verify
whether the parameters are identical on both ends before enabling the EtherChannel. This is configured with the command
channel-group <etherchannel number> mode desirable (where X is to be replaced with the EtherChannel group number). PAgP
is not supported with WLCs.

LACP is an IEEE specification that allows a switch to negotiate an automatic bundle by sending LACP packets to the other side.
This mode can be enabled by using channel-group <etherchannel number> mode active. It is not supported for use with WLCs
but is supported for use with select 802.11ac Wave 2 access points having an AUX port.

When configuring with channel-group <etherchannel number> mode on, the EtherChannel is established without any form of
negotiation. This mode is the only one that can be used with WLCs.

The configuration guidelines are as follows:

EtherChannel support: All interfaces must support EtherChannel. They can be of different media type and on different
modules but on the same switch, even if virtual, such as in a VSS.

Speed and duplex: All interfaces configured must operate at the same speed and duplex mode.

VLANs: All interfaces configured in the EtherChannel must be assigned to the same VLAN or must be configured as trunk,
before joining an EtherChannel. If trunk, they must support the same range of VLANs.

Example 2-3 shows how to configure interfaces Gig0/1 and Gig0/2 into a LACP portchannel allowing VLANs 1 to 10. After the
portchannel is created, further configuration changes will happen directly in the portchannel interface.

Example 2-3 Configuring LACP-enabled Portchannel Interface

Click here to view code image

Switch1(config)# interface Gig0/1
Switch1(config-if)# switchport mode trunk
Switch1(config-if)# duplex auto
Switch1(config-if)# switchport trunk allowed vlan 1-10
Switch1(config-if)# channel-group 1 mode active
Switch1(config-if)# exit
Switch1(config)# interface Gig0/2
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Switch1(config-if)# switchport mode trunk
Switch1(config-if)# duplex auto
Switch1(config-if)# switchport trunk allowed vlan 1-10
Switch1(config-if)# channel-group 1 mode active
Switch1(config-if)# exit
Switch1(config)#

At this stage, we have created a new virtual interface called Portchannel1. If we want to add a VLAN to the trunk or change any
setting later on, we have to do it only in the Portchannel1 interface, and not in the physical interfaces anymore.

For example, to add VLAN 11:

Click here to view code image

Switch1(config)# interface Portchannel1
Switch1(config-if)# switchport trunk allowed vlan add 11
Don’t forget to configure the same commands on the other switch! The ports could be different on the other switch. We could
decide to put Gig1/2 and Gig 2/5 on switch2 into Portchannel5. As long as they connect to two ports on switch 1 that are on a
portchannel with the same settings, all is well.

Table 2-5 shows some useful commands to verify the EtherChannel settings.

Table 2-5 Commands to Verify EtherChannel Settings

Command Purpose
switch# show interface port-channel channel-number Displays the status of a portchannel interface.
switch# show lacp { counters | interface type slot / port | neighbor
| port-channel | system-identifier } Displays LACP information.

switch# show port-channel compatibility-parameters Displays the parameters that must be the same among the
member ports to join a portchannel.

switch# show port-channel database [ interface port-channel
channel-number]

Displays the aggregation state for one or more portchannel
interfaces.

switch# show port-channel load-balance Displays the type of load balancing in use for portchannels.
switch# show port-channel summary Displays a summary for the portchannel interfaces.

Anticipating further chapters, let’s underline that if you are using LAG on a WLC, you should have only one interface marked for
“Dynamic AP management,” but if you don’t use LAG, you should have one interface with “Dynamic AP management” enabled
on each physical port of the WLC.

It is also possible to configure LAG between a switch and a Wave2 access point (provided it has an AUX port) like the 1850, the
2802, or the 3802 (because they have an AUX port). The problem would be that because all the traffic is tunneled to the WLC
through the CAPWAP data tunnel, it would be hard to load balance anything between the two ports. This is why, when enabling
LAG, those access points establish a second CAPWAP data tunnel to the WLC using another source port. The switch can then use
the command port-channel load-balance src-dst-port as a load-balancing mechanism to load balance the traffic between the two
AP ports. This, however, is not yet supported in FlexConnect local switching. If the switch does not support Layer 4 (port) load-
balancing, there will be redundancy, but all the traffic will go through a single port.

After the AP registers to the WLC, run the following commands from the WLC command line:

Click here to view code image

config ap lag-mode support enable
(This will NOT result in a reboot of the APs that support LAG)

This command enables the support for AP LAG mode globally on the WLC. To check the current status of the AP LAG mode
support on the WLC, run the command show ap lag-mode. To disable support for AP LAG mode, use config ap lag-mode
support disable (this will result in a reboot of all the APs that support LAG).
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Click here to view code image

config ap lag-mode support enable <AP name>
(This will result in a reboot of the AP)

This command enables LAG mode support on the AP itself. When you enable this command, in the show ap config general <AP
name> command you will see that the AP LAG config status has been changed to “enabled” from “disabled”.

Click here to view code image

AP LAG Configuration Status ..................... Enabled

To disable LAG mode on the AP use config ap lag-mode support disable <AP name> (this will result in a reboot of the AP).

Access points support LACP or “mode on.” Because one of the requirements is that all ports of an EtherChannel are of the same
Ethernet type, it is not possible to bundle an mGig port with a GigabitEthernet port in an EtherChannel. The mGig can be
configured to 1 Gbps to make this work.

CDP and LLDP

Cisco Discovery Protocol (CDP) is a Layer 2, media-independent and network-layer independent protocol that runs on Cisco
devices and some third-party devices as well (although it is Cisco proprietary) that allows devices to learn what is directly
connected to them. Each device configured for CDP periodically sends advertisements to the multicast MAC address
01:00:0c:cc:cc:cc. By listening for this MAC address, the device will also learn about CDP-enabled devices that are directly
connected to it. CDP is not forwarded by Cisco devices; therefore it is only point-to-point and does not travel through the network.
CDP information includes the following:

Cisco IOS version running on Cisco devices

Hardware platform of devices

IP addresses of interfaces on devices

Locally connected devices advertising Cisco Discovery Protocol

Interfaces active on Cisco devices, including encapsulation type

Hostname

Duplex setting

VLAN Trunking Protocol (VTP) domain

Native VLAN

CDP allows for detection of native VLAN mismatch on trunk ports and is very helpful in troubleshooting to understand the physical
network topology.

Link Layer Discovery Protocol (LLDP) is a similar standard protocol that will perform the same kind of functions as CDP but will
bring compatibility with third-party devices that are more likely to support LLDP than CDP. LLDP-MED is a Media Endpoint
Device extension for LLDP, which adds more capabilities with regard to power management and network policies.

CDP neighbors can be verified both on the switch or on the AP with the show cdp neighbors command. On a switch, you can
enable CDP globally with the configuration-level command cdp run. It is then enabled by default on all interfaces. You could
disable it on a given interface with no cdp enable under that specific interface. LLDP works in a similar manner and can be
enabled with the global command lldp run. You can then enable it for a specific interface with lldp transmit and lldp receive
commands. show lldp neighbors will give you the LLDP neighbor. Example 2-4 shows the CDP neighbor output showing an
access point along with the power levels it requested (refer to the next section for PoE with CDP):
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Example 2-4 Output of show cdp neighbor details on a Port Where an Access Point Is Connected

Click here to view code image

switch# show cdp nei det
-------------------------Device ID: APd46d.50f3.7a27
Entry address(es):  IPv6 address: FE80::D66D:50FF:FEF3:7A27  (link-local)
Platform: cisco AIR-CAP2602I-E-K9,  Capabilities: Trans-Bridge Source-Route-Bridge IGMP
Interface: GigabitEthernet0/8,  Port ID (outgoing port): GigabitEthernet0Holdtime : 160 sec
Version :Cisco IOS Software, C2600 Software (AP3G2-K9W8-M), Version 15.3(3)JF5,
  RELEASE SOFTWARE (fc2)Technical Support: http://www.cisco.com/techsupportCopyright
  (c) 1986-2018 by Cisco Systems, Inc.Compiled Mon 29-Jan-18 23:21 by prod_rel_
  teamadvertisement version: 2
Duplex: fullPower drawn: 15.400 Watts
Power request id: 8446, Power management id: 12
Power request levels are:15400 13000 0 0 0

We have already hinted that CDP (or LLDP) will be used in providing power to Cisco APs, but it is also very useful for quickly
locating on which port access points are connected (through the CDP neighbor table), identifying what their IP address currently is,
and what model and software version they are running. The WLC supports CDP (but not LLDP) and can provide a list of its CDP
neighbors to verify the switchport connections (see Table 2-6).

Table 2-6 CDP-Related Commands on the WLC

Command Purpose
WLC> show cdp
neighbor Displays the list of WLC CDP neighbors.

WLC> show ap
cdp neighbors all

The WLC also receives information from the APs with regard to their CDP neighbors. This is useful to verify
on which switch(port) an AP is connected, straight from the WLC command line.

Power over Ethernet for Access Points

Power over Ethernet is a very handy technology for powering access points, because it allows you to run only one network cable to
the AP location, instead of an extra power cable (and power supply, which would need to be tied up properly and which might heat,
and so on). Things were a bit more complicated in the past with prestandard technologies, but for the purposes of this book, let’s
focus on the 802.3af PoE standard that allows up to 15 watts and the 802.3at standard (often referred to as PoE+) that allows up to
30 watts to the device. Some outdoor APs require a bit more than 30 watts and have to rely on UPoE, which can provide up to 60
watts, but that is not yet an IEEE standard (at the time of this writing and will be superseded eventually by 802.3bt, which promises
90 watts). In any case, at present, most APs don’t require that much power. Each AP has different power requirements:

A 3600 will operate at full capacity with 15 watts 802.3af PoE.

A 3700 will require PoE+ to fully operate because it consumes up to 16.8 watts. However, it can operate in “medium power”
with a standard 802.3af (15 watts) and will then power off one antenna (3×3 MIMO instead of 4×4).

A 3800 will require 802.3at to operate, with no “medium power” available at all.

Those are just examples of how things differ with each AP model. Some APs will be able to boot when given insufficient power
(802.3af instead of 802.3at, for example) but will keep the radios completely down, allowing you to spot the problem and remediate
it.

PoE is most practical when the switch supports it and can deliver the power to the device connected without any form of particular
intervention. When a cable is plugged in, there is a physical detection mechanism (based on impedance detection) that can figure
out whether the connected device supports PoE. This detection has to happen when the device is still powered off and is required to
prevent the switch to send power to a device not supporting power on the Ethernet port (which would otherwise most probably
burn it). There are predefined watts requirement “steps” that can be detected this way. After the device has booted, it is also
possible for a more granular power negotiation to occur. This can take place through CDP or LLDP (LLDP is not Cisco
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proprietary; neither is the 802.3at standard). The end device may then require the exact amount of wattage it will require through
this more dynamic protocol. Devices exchange TLVs with their capabilities and negotiate the power. After an AP has gone through
this negotiation phase, any change of power provided will make the AP reboot.

When the switch does not support PoE, the alternative is to use a power injector. The injector is a small brick that plugs in to an AC
power socket and has typically 2 RJ45 ports: one that connects to the switch (to provide network connectivity to the AP) and the
other to connect to the AP. The power injector basically sits between the AP and the switch, tries to stay invisible, and just adds
power on the network cable while it forwards the data back and forth. Power injectors also exist with fiber uplinks and other
variations where they may also have other names, but the same basic concept remains. Figure 2-10 shows the AIR-PWRINJ6, the
802.3at-compliant power injector recommended for use with 802.11ac wave2 access points.

Figure 2-10 Power Injector AIR-PWRINJ6

A very important notion in PoE is the Power Sourcing Equipment (PSE) power budget. When the PSE is a power injector, it
typically provides power for only one device, the powered device (PD), and therefore the concept of budget is a bit irrelevant. But
when the switch is the PSE, it becomes apparent that the switch cannot provide an unlimited amount of power through all its ports.
Some switches have a power budget as small as 30 watts (providing PoE+ on one single port, but maybe regular PoE on two ports,
or even more if the devices consume less than 15 watts) and can go up in the hundreds of watts for bigger switches. In any case,
depending on the number of devices connected to the PSE and the power that they are currently consuming, there is only a certain
power budget left for new devices. If the power budget for that switch has already been exhausted by the currently connected APs
or other devices, such as IP phones, the only effect will be that if you plug in a new access point, it will not receive any power and,
therefore, fail to boot.

One last concept to understand in PoE is that providing the power on the Ethernet cable induces some loss. For example, a switch
with PoE+ (802.3at) will be able to provide up to 30 watts of power, per interface. From looking at the Cisco 3800 AP data sheet,
we can see that it will request 30 watts at the PSE when the USB port is enabled, although actually only 25.5 watts will be
consumed by the AP in such a scenario. This is important to keep in mind when reading power draws and numbers advertised.

Here is an example of show ap config general <ap name> for an AP that is not getting enough power out of PoE:

Click here to view code image

Cisco AP Identifier....................... 1
Cisco AP Name........................ .... AP1
...
PoE Pre-Standard Switch................... Enabled
PoE Power Injector MAC Addr............... Disabled
Power Type/Mode........................... PoE/Low Power (degraded mode)
...

To understand whether an AP got enough power and possibly why it did not, it is also a good idea to check the show log of the
access point, and go back to the console output (if still available) when the AP finished booting (this is when the PoE negotiation
took place) to spot any CDP or LLDP mismatch. The following output shows us that the AP negotiated power through CDP and
got 26 watts:

Click here to view code image
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APF80B.CBE4.7F40# show log | include power
Apr 10 05:36:39 brain: CDP PoE negotiation OK, Allocated power 26000
  mWatt Requested power 26000 mWatt
Apr 10 05:36:39 brain: Power mode: Full-Power, power_detection:
  DC_adapter(FALSE), 802.3AF_POE(TRUE)
Apr 10 05:38:16 root: SYS-COND: Retrigger fair condition, 6 power

IP Layer Refresher

After reviewing protocols at the switching layer, we will not move into the routing layer, because not a lot of it is present in the
CCIE Wireless exam. But a refresher of IPv4 and IPv6 is in order because we have both worlds overlapping to support the wireless
network.

IPv4

It would be too ambitious for this book to try to cover all IPv4 and IPv6 right after, so let’s call this a refresher instead. You might
have forgotten or overlooked some points, and we will try to go through the main traps and pitfalls for an expert wireless engineer
who may tend to overlook some IP details.

IPv4 addresses are very limited, and it may be interesting to review the special and reserved address ranges. The private ranges,
which do not route on the Internet, are 10.0.0.0 to 10.255.255.255 (/8 subnet), 172.16.0.0 to 172.131.255.255 (/16), and
192.168.0.0 to 192.168.255.255 (/24). Anything starting with 127 (127.0.0.0 /8) depicts a loopback address and thus never goes on
the network (a loopback is an interface on a device that points back to itself). The range called APIPA is 169.254.0.0/16 and is a
link-local address range, which means those addresses are valid on point-to-point links but do not route. The APIPA range is
famous on client devices when the DHCP process is failing; that is, many client operating systems will automatically pick an IP
address in the APIPA range (but will have no connectivity to the network with that), so if you see this one in the CCIE exam, it
typically means that your client could not obtain a DHCP IP address. 192.0.2.0/24 are 254 special purpose IP addresses where, for
example, we now recommend to use 192.0.2.1 for the virtual IP of a WLC so that it does not route anywhere on the network
outside of the WLC. 224.0.0.0 to 239.255.255.255 are reserved for multicast, and IP addresses above 240.0.0.0 are reserved for
future use. There are a couple more specific ranges, but they are not so useful to remember for the scope of the CCIE Wireless
exam.

For a device to directly talk to another device, they must be in the same subnet range (defined by the network IP address and the
subnet mask combination). The station that wants to transmit will send an Address Resolution Protocol (ARP) request to figure out
the MAC address of the destination device, which, in turn, will send a reply. At this point, the transmitter knows both the IP and
MAC binding of the destination and can then transmit. If the transmitter realizes that the destination IP is not in its subnet, it will
have to send the packet to its gateway for the packet to be routed. If the device hasn’t contacted its gateway yet, it will also have to
ARP for that gateway in its subnet to figure out its MAC address. That gateway will have to consult its routing table to know where
to send the packet (directly to destination or to another router/gateway).

A concept that is critical to understand for the CCIE Wireless exam is whether your switch is Layer 2 or Layer 3; that is, if it is
routing. Nowadays, what is called a Layer 2 switch is a switch with only one IP address (for management) but possibly supporting a
lot of VLANs. That switch will forward traffic only within the same VLANs and will not perform any routing. For a device to
qualify as being a gateway, it needs routing to be activated and, therefore, will typically need at least two IP addresses to be present
in more than one subnet. Be careful because it is also possible that a switch has several IP addresses but still has no routing
activated, although this is a bit unusual.

Some old timers may have the reflex to check the show ip route command output to see if routing is enabled on the switch, but in
recent IOS versions this output can be confusing and show you outputs that look like it is routing even when it’s not (see Example
2-5). Therefore, the only real way of checking whether routing is enabled is to verify whether ip routing has been enabled in the
configuration.

Example 2-5 Routing Table Output When Routing Is Disabled Globally

Click here to view code image

Switch-router# show ip route
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Default gateway is 10.48.39.5

Host               Gateway           Last Use    Total Uses  Interface
ICMP redirect cache is empty
Switch-router#

The switch from the previous output does not have routing enabled. It is, however, configured to use a default gateway. If it didn’t,
we would only be able to manage it from the same subnet, so this gateway is used only by the switch itself (to reply) when it is
being reached out on its IP address. The command to specify the default gateway is

Click here to view code image

Switch(config)# ip default-gateway 10.48.39.5
If you decide to activate IP routing, the show ip route output will differ greatly, as shown in Example 2-6.

Example 2-6 Routing Table Output After Enabling Routing Globally

Click here to view code image

Switch(Config)# ip routing
Switch(config)# exit
switch# show ip route
Codes: C - connected, S - static, R - RIP, M - mobile, B - BGP
       D - EIGRP, EX - EIGRP external, O - OSPF, IA - OSPF inter area
       N1 - OSPF NSSA external type 1, N2 - OSPF NSSA external type 2
       E1 - OSPF external type 1, E2 - OSPF external type 2
       i - IS-IS, su - IS-IS summary, L1 - IS-IS level-1, L2 - IS-IS level-2
       ia - IS-IS inter area, * - candidate default, U - per-user static route
       o - ODR, P - periodic downloaded static route

Gateway of last resort is 192.168.28.1 to network 0.0.0.0

C    192.168.28.0/24 is directly connected, Vlan1428
C    192.168.13.0/24 is directly connected, Vlan1413
C    192.168.14.0/24 is directly connected, Vlan1414
C    192.168.15.0/24 is directly connected, Vlan1415
     10.0.0.0/24 is subnetted, 1 subnets
C       10.48.39.0 is directly connected, Vlan39
C    192.168.68.0/24 is directly connected, Vlan1468
S*   0.0.0.0/0 [254/0] via 192.168.28.1
               [254/0] via 192.168.15.1
               [254/0] via 192.168.14.1rt Gi1/0/20
               [254/0] via 192.168.13.1

We can see in this output that all the connected subnets directly show up. This is because the switch already had IP addresses in
each of those VLAN subnets, so they appear as “directly connected routes.” This means that the switch will not send the packets
destined for those subnets to another routing hop but will immediately ARP and try to reach the destination itself.

We also see that there are four static routes marked with the “S” (the command output is handy because it shows a summary of
what the letters in front of the routes mean; they indicate through which method or routing protocol this route was added to the
table). These static routes were added with the following command:

Click here to view code image

Switch(config)# ip route 0.0.0.0 0.0.0.0 <next gateway hop>
It might seem a bit confusing at first, but there is a real difference between a default static route and a default gateway. The default
gateway is used when ip routing is disabled and is used only by the switch itself to reach distant destinations. For example, you
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ping the switch from another subnet and it needs to reach you back; you are on the switch CLI and try to ping a distant destination;
or you want to manage the switch (SSH or HTTP web interface, it doesn’t matter) from another subnet. All those examples have in
common that the source or the destination of the traffic flow is the switch IP address itself. Static default routes take effect only
when IP routing is enabled. They will kick in after the switch has a packet to forward to another subnet, and it parsed the whole
routing table without finding a match. It will then use the static default route. Notice that the big difference is that they come into
the picture when the switch is trying to route a packet from a client (or anyone else literally) to another destination. We are talking
about a random device in subnet A reaching another device in subnet B and not reaching out to the switch IP address itself.

An eagle eye would have noticed that the output in Example 2-6 has four default routes and an asterisk. This means that the switch
has multiple options to forward the packet, and it will load-balance across all equivalent routes; the asterisk marks the current next
hop for the next packet that will come in. It is not required to know dynamic routing protocols in the current version of the CCIE
Wireless exam. They may be preconfigured, in which case you will see these routes in the routing table and have to trust that they
have been properly configured, or you may be asked to configure static routing in your campus network. Please note that we have
seen static default routes here, but it works for any type of route. You can configure a specific route by using the destination subnet
range rather than 0.0.0.0. You can optionally set a distance metric for the route at the end of the ip route command if you want the
load balancing to stop and use one route over the other.

When configuring routing, it is very important to visualize the whole path. Your transmitter needs to be configured to use a default
gateway. That device (in our case, often a switch) needs to be configured for IP routing and have a routing table containing the
destination IP range (or a default route), and it will then pass it to the next hop specified in that routing table. This must go on until
a hop that knows the destination—that is, a device that has the destination subnet as a “directly connected route” because it has an
IP address in that subnet. And it does not stop there! Don’t forget that for a traffic flow to work, you typically need to have the
other direction working, too, because the end device will have to reply, and the routes in the other direction should be present and
work as well.

With all those notions, we haven’t yet talked about the Switch Virtual Interfaces (SVI). Although routers will typically configure IP
addresses on the ports themselves (they are called routed ports), you cannot configure an IP address on a switchport. Therefore,
you create an Interface Vlan<id> that will be a virtual interface governing that particular VLAN ID. Not only the switch can then
be reachable on that IP address, but it can be configured as the default gateway for clients of that VLAN if IP routing is enabled on
the switch. Having an SVI in a VLAN is required for a switch to have a Layer 3 presence in that particular VLAN, for example, to
configure a DHCP pool for it or function as a DHCP relay in that VLAN. When you configure any protocol on the switch (VTP to
give just one example; RADIUS is another), the switch will have to send packets to neighboring devices and will have to pick a
source address. This is typically configurable for each protocol with a command, but the switch will take one SVI (usually the
smallest/first). It is critical to pay attention to whether that particular VLAN/SVI will be able to reach the other devices, which can
happen often in a campus where you forbid certain VLANs on certain links.

IPv6

IPv6 is like IPv4 but uses 128 bits addressing instead of 32 bits. Well, not quite, but that’s a start to begin describing the
differences. An IPv6 address is written with colons and using hexadecimal characters (to help make it shorter). An example is
2001:0db8:ac10:fabc:0001:0003:0004:0005. Because it clearly looks cumbersome to write, there is a common notation that accepts
that leading 0s are not written. With this in mind, the previous address would become 2001:db8:ac10:fabc:1:3:4:5, which, though
still hard to memorize, is clearly easier on the eye. It is important to underline that we are talking only about leading 0s. If we look,
for example, at the second quartet (hextet) of that IP, here “db8” must translate only to “0db8.” If it was “db80,” we could not
write it “db8” because it would create confusion. The other notation trick to remember is that, once per IP address, you can group a
series of contiguous 0s with “::”. For example, the famous loopback 127.0.0.1 becomes ::1 in IPv6. This means the full IPv6 for it is
0:0:0:0:0:0:0:1 (we saved you the quadruple zeros). More examples of this notation follow in the upcoming paragraphs.

What IP addresses are special in IPv6? Routable Internet unicast IPs are 2000::/3, which is 2000:0:0:0:0:0:0:0 to
3fff:ffff:ffff:ffff:ffff:ffff:ffff:ffff (notice how subnet masks are harder to map if you are not used to them, but because IPv6 uses
hexadecimal, you need to think binary all the way). That makes a lot of routable IP addresses and still leaves a lot of IPs for
reserved special uses. Local addresses are fe80::/10, so will often start with “fe80” but technically, they are “fe80” to “febX”
because the subnet mask stops after 10 bits. The local addresses are a lot like the IPv4 APIPA range, because they are valid only on
the local link and will not be routed. They are used for devices directly connecting to each other and willing to exchange data
without a DHCP server, or at least without caring about what address the DHCP server assigned to them. FC00::/7 depicts unique
local addresses intended for local communications. They are the equivalent of 10.0.0.0 or 192.168.0.0 subnets in IPv4. Multicast
addresses start with ff0X, where X is assigned by the IANA; for example, ff02::9 is the RIP router IP address, ff02::1:2 (which is
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ff02:0:0:0:0:0:1:2 if you’re still uncomfortable with the double colon notation) is the IP for all DHCP agents, while ff05::1:3 is the
IP for all DHCP servers.

So far so good, but IPv6 has a lot more differences compared to IPv4. IPv6 standardizes on the usage of anycast: the lowest address
of each subnet prefix is reserved as the subnet-router anycast address. This means that this address is used to communicate to
anyone who identifies as a router for that subnet. Anycast is different from multicast in the sense that only one target will be hit.
While multicast is “send this packet to everyone who is interested in this stream,” anycast is “send this packet to one (and any)
destination identifying with this stream/service.” This means that there can be multiple router/gateways on the subnet, but only one
will be forwarding the client packet. The 128 upper addresses of major /64 subnets are also reserved for specific anycast usages.

We have talked a lot about subnets so far without mentioning particular differences compared to IPv4 on this topic. Because the
subnet mask notation hasn’t changed, it still depicts the number of bits turned to 1 in the mask, so it ranges from /1 to /128. A /128
will depict one very specific IP address, and anything smaller will depict a range of IP addresses. IPv6 is generously giving a lot of
IP addresses to end customers on the Internet (so that your home router can assign public IPs to every device you own or so that
you can subdivide further the way you like) so that /64 is typically what is assigned as the smallest subnet. ISPs can give large IP
ranges (/32 or such) to their big customers/companies who will subdivide per department or per theater to /48s and smaller. This
concept is called prefix delegation. If you are an end customer and receive a /64 at home from your ISP, you own the full /64
subnet (for the time of the lease) and can decide to subdivide it the way you like and assign any IP you like within that subnet to
your devices. If you purchase a bigger IP range from the ISP, you could also play as a local small ISP and subdivide your /54 (for
example) to several smaller subnets to assign to your customers, or family, and so on. Each person receiving a prefix from a higher
instance is responsible for that prefix and can delegate smaller parts of it to other people.

Another important thing to mention is that contrary to IPv4, an IPv6 NIC can and will have more than one IPv6 address.
Remember the APIPA-equivalent fe80 link-local address? It will also be present on all network cards so that the device can talk to
the directly connected neighbor even if the “main” (or at least routable) IPv6 address is not assigned (yet) or not working. You can
therefore have a whole number of IPv6 addresses on a single network interface without any problem, and they will have different
uses or different scopes.

At this stage, we haven’t talked about the IP address assignment, and that’s a big topic in IPv6 because it also differs greatly. The
possibility for stateful DHCPv6 assignment still exists if the network administrator wants to control the IP addressing in the
network, but it’s far from required or even far from widespread usage. This is because IPv6 brings stateless IP configuration where
the hosts can assign themselves an IP address (and optionally use DHCPv6 to get additional DHCP options, but not an IP
assignment from that DHCP server). We have already mentioned the link-local IPv6 address that starts with fe80, and this is
something all network cards will assign themselves upon the interface coming up. The NIC can then talk with its direct neighbors
and figure out the closest router. This router will then update the client NIC about the current subnet prefix in use at that location of
the network. After the NIC knows the subnet prefix, it can pick an IP address (remember that we typically have /64 subnets, which
contain a TON of IP addresses) and start to roll with it; it just got itself a unicast IPv6 that will function at that location of the
network. What about DHCP options? Major functions (DNS server, for example) can be covered by this local router through the
link-local address; however, it’s still possible to use DHCPv6 to assign many custom DHCP options to provision the client, but it
becomes much less required than with IPv4.

We have skipped important items in this explanation, which we will cover now. How are hosts picking an IP for themselves in the
subnet? They have a /64 subnet, which means they are left with 64 bits to pick a host address. A device MAC address is supposedly
unique in the world and is 48 bits long, so it’s a good base. By adding FF:FE in the middle of the MAC address, we end up with 64
bits, which is called an EUI-64 address. On top of that, the meaning of the universal/local bit (the seventh most significant bit) is
inverted so that 1 now means Universal. This is the modified EUI-64 method for Stateless Address AutoConfiguration (SLAAC),
and it ensures that a host will most likely pick a unique IP address in the right subnet. There is still a duplicate address detection
system, however, but we’ll talk about this after we have seen a few more notions.

The other important item we skipped is how these link-local communications occur. In IPv6, there is no more ARP. IPv6 uses
Neighbor Discovery (ND), which is based on ICMP(v6) messages and multicast addresses to determine the link-layer address of a
neighbor on the same network segment, verify its reachability, and track neighboring devices (kind of like CDP). The first device
will send a Neighbor Solicitation message to the multicast solicitation address equivalent to the IPv6 unicast address of the
destination device, which will respond with a Neighbor Advertisement message and give its MAC address. This Neighbor
Advertisement message means that this process can happen on demand (like ARP), but a device can also spontaneously send an
advertisement message to make itself known on the network segment. A network device is considered reachable when a positive
acknowledgement is returned from the neighbor.
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Routers (or switches doing routing) will have a similar mechanism to advertise their gateway capabilities. They will periodically
send a Router Advertisement (RA) ICMPv6 packet on all their interfaces and destined to the all-nodes multicast address. RAs
include the following:

One or more IPv6 prefix that nodes can use to give themselves an IP address (so yes, an interface can be in several
ranges/subnets at the same time because it can have multiple IPs)

Lifetime information of such prefixes

Flags that indicate whether stateless or stateful IP configuration is required

Additional info for hosts, such as MTU or hop limits

Default router information

Like Neighbor Advertisement, RAs can be sent spontaneously or on demand. This avoids a new host having to wait for the next
cycle to hear about connected routers: it can connect to the network and directly send a Router Solicitation message to the all-
routers multicast address to discover the gateways on the segment.

On the WLC side, clients are supported with up to 8 IPv6 addresses. They can have a link-local address (they always will, actually),
a self-assigned SLAAC address, a DHCPv6 address, and then possibly up to five additional addresses in other subnet prefixes.
Clients can obtain IPv6 addresses if their VLAN is IPv6 enabled on the infrastructure. This was the first thing supported historically
by earlier WLC software versions. In practical terms, it meant that your AP could still obtain only an IPv4 address, build its
CAPWAP tunnel on IPv4, and still provide IPv6 addresses to the clients that were tunneled to the WLC through an IPv6-enabled
interface.

Use the following commands to enable a typical IOS device to provide IPv6 connectivity on a given SVI via SLAAC:

Click here to view code image

Switch1(config)# interface Vlan20
Switch1(config-if)# ip address 192.168.20.1 255.255.255.0
Switch1(config-if)# ipv6 address 2001:db8:0:20::1/64
Switch1(config-if)# ipv6 enable
Mobility works in the same manner as with IPv4; the only difference is that if the client is roaming in an anchor/foreign scenario,
the anchor will have to forward all the RAs and NAs from the client’s original VLAN to the foreign, so that the client keeps
receiving the neighbor and router information from its original VLAN. This happens under the hood without any configuration
required.

The WLC does have specific configuration knobs for IPv6 though. The most critical one is RA Guard: a security feature that will
drop RAs coming from the wireless clients (because you typically will not expect a gateway on the wireless side). They are always
dropped at the WLC, but best practice is to drop them directly on the AP (which provides drop counters per client). This option is
available in the Controller menu on the web interface under Ipv6 > RA Guard, as illustrated in Figure 2-11.

Figure 2-11 RA Guard Page on the WLC
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In the CISCO WLC webpage, the Controller option is selected. On the content pane, the RA guard in the IPv6 is displayed.
The IPV6 RA Guard on WLC is enabled. The IPv6 RA Guard on AP drop-down is set to Enable. The RA dropped per
client to be entered.

A WLC will also implement DHCPv6 Server Guard to drop any DHCPv6 offer coming from the wireless side, as well as IPv6
Source Guard to make sure a client is not spoofing the IPv6 address of another client. Interfaces and WLAN can also use IPv6
ACLs separately from IPv4 ACLs (one will apply to IPv4 traffic and the other to IPv6). It is also possible to dynamically assign an
IPv6 ACL to a client via AAA with the RADIUS attribute Airespace-IPv6-ACL-Name.

The main concern with IPv6 over wireless, beyond security, is efficiency. We have all those RAs and NAs sent as multicast, but
over the air it’s like a broadcast: slow and unreliably delivered. On top of that, the wireless controller typically hosts thousands of
clients, and the temptation is big to use just one IPv6 subnet for all of them. Similar to the way the WLC does proxy ARP resolution
to be more efficient in IPv4, it will do neighbor caching in IPv6. The WLC will intercept all Neighbor Solicit messages from clients
and answer them privately on behalf of the destination. It will also stop the broadcasting of Neighbor Advertisement and add that
entry in its neighbor cache table if needed. This neighbor table on the WLC also keeps track of the reachability status of these
clients.

The RA throttling feature is a way to make sure routers do not spam the wireless clients with RAs. If several routers are configured
to send RAs frequently, the WLC will throttle those to the allowed frequency and will also allow only the first router RA through in
case of multiple routers (which can cause an issue if you have several IPv6 prefixes served by different routers; if so, simply disable
RA throttling).

To preserve client roaming (which would send a Router Solicitation to make sure the router is still there), the WLC allows RS
through and the RA response will be unicasted to the requesting client. This is configured under the RA Throttle Policy page of the
IPv6 configuration menu, as shown in Figure 2-12. That page allows you to say that only a given amount (defined by the Max
Through field) of RA advertisement will be allowed for a certain period (defined by the Throttle Period field). This allows for
tolerating a short burst at the price of all RAs being blocked for the rest of the period. There are safeguards: the Allow at Least field
indicates the minimum number of RAs per router that will be forwarded as multicast before being blocked, and the Allow at Most
field indicates the maximum number of RAs per router that will be forwarded as multicast before being blocked. The Interval
Option field allows to throttle, ignore (and treat as regular RA), or pass-through (without any throttling) RAs with an interval option
matching RFC3775.

Figure 2-12 RA Throttling Page on the WLC

In the CISCO WLC webpage, the Controller option is selected. In the content pane, the Edit within the RA Throttle Policy
is displayed. The list of details as follows, Enable RA Throttle Policy, Throttle Period (10-86400 seconds), Max Through
(0-256), Interval Option, Allow At-least (0-32), and Allow At-most (0-256) are to be entered.

The last major IPv6 configuration page of the WLC is the Neighbor Binding page, which allows tweaking the neighbor table cache
on the WLC. As shown on Figure 2-13, you can adjust the Down Lifetime there, which is the timer specifying for how long the
entry will stay in the table if the interface goes down. There is the Reachable Lifetime setting, which specifies how long an IPv6
address is marked as active after traffic was received from it and after which it will be marked stale. The Stale Lifetime is the
amount of time the address will stay in the cache after no traffic was seen from them during the entire reachable lifetime.
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Figure 2-13 Neighbor Binding Page on the WLC

In the COSCO webpage, the Controller option is selected. Under Neighbor Binding in the content pane, the Down Lifetime
(0-86400 seconds), Reachable Lifetime (0-86400 seconds), Stale Lifetime (0-86400 seconds) are entered. The Unknown
Address Multicast NS Forwarding and NA Multicast Forwarding drop-down box are selected.

With regard to configuring IPv6 addresses on the WLC itself (so far, we explained this is not needed for clients to be IPv6
enabled), the management interface accepts one IPv6 address. Dynamic interfaces cannot be configured with IPv6: only their
VLAN matters (because they will bridge IPv6 traffic to an IPv6-enabled VLAN, which will take care of the address assignment),
and there should not even be a need to configure IPv6 addresses on dynamic interfaces because their main purpose is DHCP relay
in IPv4 (which doesn’t apply anymore for IPv6). The service port can also be configured with an IPv6 address. The management
interface gateway must be configured with the link-local address (the one starting with fe80) of the next-hop router. This is a bit
counterintuitive compared to IPv4, where the interface IP and the gateway have to be in the same subnet, but in IPv6, because
interfaces have multiple addresses, the gateway is expressed with a link-local address, whereas the interface IP is expected to be a
global unicast address.

Access points will use any method to obtain an IP address (IPv4 or IPv6 or both). It is possible to configure a preference to tell the
APs to join the WLC through capwap-on-ipv4 or capwap-on-ipv6: either configured globally on the Controller page of the WLC
web interface or in the specific AP group. This is just a preference, so if you configure IPv6 as CAPWAP preferred mode, the AP
will still join through IPv4 if it cannot obtain an IPv6 address (or vice versa).

A multicast CAPWAP group can also be configured on the WLC to allow it to forward multicast traffic through IPv6 multicast.
Mobility can also happen through IPv6, as well as Syslog, NTP, and RADIUS. This section concludes with Table 2-7, which shows
a few useful commands to look at the IPv6 configuration on the WLC.

Table 2-7 IPv6-Related Troubleshooting Commands on the WLC

Command Purpose
WLC> show ipv6 neighbor-
binding summary Displays the list of IPv6 neighbor bindings (IPv6 Mac address mappings).

WLC> show ipv6 summary Shows the summary of all IPv6 configuration items of the WLC.
WLC> show network
summary

Shows the configuration items of the Controller web GUI page, which includes IPv6 multicast
configuration and CAPWAP prefer mode.

WLC> ping <ipv6 ip> The ping command on the WLC accepts an IPv6 address (contrary to some client OS, where you
may have to use a separate command like ping6).

Multicast

The multicast concept applies to both IPv4 and IPv6—there will be differences in the protocols in use, but the concepts are
identical. Multicast is a vastly underappreciated and misunderstood technology. To make it as clear as possible, let’s mention use
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cases where multicast will apply:

Specific protocols (routing protocols, for example) know that they hear their neighbors (using the same protocol and not any
other protocol) on a defined static multicast IP address that is tied to that protocol. They will listen to that multicast IP to hear
announcements. For example, OSPF uses 224.0.0.5, RIP uses 224.0.0.9, VRRP uses 224.0.0.18, and so on. A common point
with this use case is that those messages are neighbors only, and typically do not need to be routed far away (they won’t require
IGMP or any similar technology that we will soon talk about). You can think of it like a broadcast in the sense that it only
spreads locally, not worldwide, but is targeted to a specific protocol, and therefore specific types of devices supporting it.

A specific source decides to provide an identical service to many endpoints; for example, a TV video streaming. In that case,
the source sends the video stream toward that multicast IP address and trusts that the network will bring this stream to any
endpoint interested in it, even in other subnets (and potentially even worldwide). We clearly start to understand the need for
clients to register their interest in that given stream/multicast IP, because bringing this stream to every endpoint everywhere “in
case it may be interested” will kill bandwidth on the whole network and “annoy” many endpoints that are not interested.

A specific device on the network may want to advertise its capabilities (printing, video streaming, music streaming, and so on),
and/or certain client devices will want to ask if there is any device around that provides certain capabilities. This is in practice
very similar to the first category, but remember, we are talking about use cases; all these examples use multicast at the end of
the day. To name a few examples, this is the case of UPnP or mDNS, which are getting very popular for service advertisement.
These deserve their special paragraph because they use multicast to advertise their capabilities and/or to find devices in the
same network with certain capabilities. After this service discovery is done, the client device learns the unicast IP of the service
provider (an Apple TV or a UPnP video camera) and will typically stream unicast to that device. The only part where multicast
kicks in is in the service discovery. However, just like the first category, these protocols don’t require the use of IGMP because
there is no specific stream to register to, and spontaneous advertisements are the only thing being sent.

Chapter 7, “WLAN Media and Application Services,” covers multicast implementation of the WLC more in detail, but we’ll touch
on the basics here. Because a multicast frame cannot be acknowledged, it is not realistic to expect all clients to fight for medium
access to send an ACK each, especially since the AP will not be retransmitting the multicast, which would be retransmitted to
everyone who would have to ACK again. This is why the WLC has to send the multicast frame at the highest mandatory data rate,
to make sure that all clients in the cell will support and hopefully receive it.

The source IP address of a multicast stream will always be the IP of the sender, and only the destination IP will be a multicast IP
address. The multicast range for private-use multicast streams is 239.0.0.0/8; anything between 224.0.0.0 and 239.0.0.0 represents
statically reserved multicast IPs for specific protocols.

It is important to understand that the WLC will block multicast by default (to preserve medium efficiency). If you enable it,
multicast is sent everywhere to all APs and clients, and this is not very efficient. The protocols taking care of the “registration
mechanism” we touched upon earlier in this chapter are IGMP, Internet Group Management Protocol (for IPv4), and MLD,
Multicast Listener Discovery (for IPv6). When the WLC has to forward a single multicast packet to several access points at the
same time (as will often be the case when we want to reach multiple destinations at the same time), it will be inefficient for the
WLC to unicast this packet to each concerned AP. This is why, when using multicast, it is recommended to configure a multicast
group for access points (as shown in Figure 2-14). By using a dedicated (239.x.y.z) multicast IP for communications between the
WLC and its own access points (do not configure the same multicast IP on different WLCs), the WLC will be able to encapsulate a
multicast packet and send only one copy to all the APs at the same time. The switches on the path will take care of duplicating the
packet for each AP switchport.
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Figure 2-14 CAPWAP Multicast on the WLC

In the Unicast mechanism, one multicast packet enters the Wireless LAN Controller. From the WLC, three CAPWAP
Unicast Packets are sent out to three different Lightweight Radio Access Points via CAPWAP tunnels. In the Multicast
mechanism, one multicast packet enters a WLC. From here, only one CAPWAP multicast packet is sent out to a
CAPWAP multicast group. The network replicates the packet as needed to different Lightweight Radio Access Points.

That multicast IP defined on the WLC will be used only for the IP header of the CAPWAP encapsulation and has nothing to do
with whatever is carried inside it (typically another multicast packet of whatever stream you are requesting). The WLC also offers
the possibility of configuring another multicast IP for mobility messaging, which will only be used to reach out to all other mobility
peers with a single packet when it comes to announcements that should be sent to all mobility peers anyway. That is unrelated to
whether you are allowing multicast traffic on your wireless clients and is a matter of efficiency when you have more than three
WLCs in a mobility relationship.

Let’s leave the wireless side a bit aside and talk about multicast in general. Imagine a Layer 2 segment where, by default, multicast
packets will be sent across all ports to all stations on that Layer 2 segment. This can be very aggressive in a network. Therefore,
IGMP is a way for clients or devices to request receiving a specific multicast stream. If we just rely on the clients sending these
IGMP registration packets, not much will change. If network devices implement what is called IGMP snooping, they will block
multicast packets from spreading to all ports and will take notes of which client is interested in which multicast stream. The network
device will then forward the multicast packets only to the ports leading toward clients that are interested in the specific stream. This
is where the efficiency kicks in. Before we dig further into IGMP, it is important to understand that IGMP will not play a role in
service discovery protocols. IGMP itself is using multicast with an IP range in the 224.x.y.z area, which will be forwarded even if
IGMP snooping is enabled (because those are announcement-based protocols and need to go through).

IGMP is a protocol that enables end hosts (receivers) to inform a multicast router (IGMP querier) of the end host intention to
receive a particular multicast traffic. So, this is a protocol that runs between a router and end hosts (it stays limited within a Layer 2
subnet and does not get routed) and allows the following:

Routers to ask end hosts if they need a particular multicast stream (IGMP query)

End hosts to tell or respond to the router if they seek a particular multicast stream (IGMP reports)

There are three versions of IGMP. IGMPv1 uses a query-response model where queries are sent to 224.0.0.1 (all-hosts) and
membership reports are sent to the group multicast address. IGMPv2 improves by adding the capability for a host to leave a
multicast group without having to time out. Leave-group messages are sent to 224.0.0.2 (all-routers) and group-specific queries are
introduced. IGMPv3 introduces source-specific multicast (the possibility to subscribe to a multicast group but only with selected
source IPs) and membership reports are then sent to 224.0.0.22. IGMP is carried directly over IP (IP protocol 2) kind of like ICMP
is. There are very few types of IGMP messages:

Membership queries are sent by hosts, and they specify within the IGMP packet which group IP they want to join, but that
multicast packet is sent to 224.0.0.1 (or .22 in IGMPv3) to hit the multicast router for the network (typically the device where
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you do IGMP snooping).

Leave-group messages allow a request to stop receiving the multicast traffic immediately (and not after a timeout for not
responding to queries three times).

Membership reports define current membership to a group.

The IGMP querier is the device that will regularly (every few seconds or minutes as configured) query the registered hosts to see if
they are still interested in the multicast stream (otherwise, if they are brutally disconnected, we don’t want to keep sending the
multicast stream forever). Only one multicast router per network does multicast routing typically. From the switch point of view,
the port leading toward the multicast router is called the mrouter port. Each switch can have IGMP snooping enabled and will listen
to IGMP exchanges to know which port is interested in which stream and let multicast flow on that port, but one mrouter per
VLAN will take care of forwarding extra-subnet multicast into this VLAN.

The techniques listed allow you to optimize multicast forwarding in a Layer 2 segment, thanks to IGMP snooping. However, that
leaves the concern of across Layer 3 segments. If you want to register to a TV stream for example, you may be telling your local
router that you are interested in that multicast stream IP, but if your router is not receiving it currently, it will not be able to send
that stream to you. We therefore need an extra protocol, Protocol-Independent Multicast (PIM). Your router will then be able to go
back to the source and request this stream to be sent across all in-between hops to your local multicast router (you just need to
make sure that multicast routing/PIM is configured in every hop along the path).

For every multicast stream, we can build a routing tree (like a spanning tree to avoid loops) that starts from the source (it differs
from unicast routing where we typically route depending on the destination). Another technique is to use a rendezvous point that
can be used by several or all streams and that will act as the tree root. The advantage of source trees is that the resources are
optimally used, because the stream is cascaded toward all interested branches. The problem is that a different tree will be calculated
for each stream, which can be a problem in case of many streams. The shared tree, with its rendezvous point, is much simpler from
an administrative point of view.

PIM helps in multicast routing by using existing unicast routing protocols; OSPF, EIGRP, static routes, and so on. To receive a
multicast stream, a device must be connected to the stream and therefore must have requested it. When a router receives a PIM
join, it will use the unicast routing table to forward it to the source of the multicast stream. PIM will then look in the unicast routing
table for the destination IPs that are interested in the multicast stream and build the multicast tree “away from the source” toward
those interested branches. PIM has several modes:

PIM Dense mode floods multicast traffic domain wide and waits for branch routers to prune back traffic (that is, screaming
“not interested”). This generally does not scale very well due to the flood of “not interested” messages, unless a lot of
destinations in the network are indeed interested.

PIM Sparse mode builds a unidirectional shared tree rooted at a rendezvous point per group. Sparse mode is a “pull” model that
requires interested branches to subscribe to a multicast stream. It therefore requires the configuration of a rendezvous point to
centralize all the requests (the router where the multicast source is will register that it has the source, and interested routers will
mark their interest).

Configuring dense mode is simple:

Click here to view code image

Switch(config)# ip multicast-routing
Switch(config)# Interface Vlan X
Switch(config-if)# ip pim dense-mode
To get multicast flowing in a CUWN, you should configure PIM on each interacting Layer 3 interface: PIM in the multicast source
VLAN, in the wireless clients VLAN(s) where receivers are expected, in any intermediate VLAN or Layer 3 link (between the
source and receivers VLAN[s]), and if you configure the recommended Multicast-Multicast Mode at the WLC but the APs are on
different VLAN(s) than the WLC’s management interface, you also need PIM at the WLC’s management VLAN, at the AP’s
VLAN(s), and in any intermediate VLAN or Layer 3 link between them.

Sparse mode is the same, with the exception of ip pim sparse-mode instead of Dense mode on the interfaces, with the addition of
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Click here to view code image

Switch(config)# ip rp-address a.b.c.d
Let’s conclude the multicast IPv4 section with Table 2-8, which summarizes all the commands you will typically use on switches to
make sure the infrastructure is ready for multicast.

Table 2-8 Multicast Troubleshooting Commands on the Infrastructure Switches

Command Purpose
L3switch# show ip pim neighbor Displays the list of PIM neighbors discovered by IOS.
L3switch# show ip mroute Shows the multicast routing table.
L3switch# show ip rpf a.b.c.d Shows how multicast routing does the Reverse Path Forwarding for a given IP address.
L3switch# show ip pim interface Displays information about interfaces configured for PIM.
L3switch# show ip igmp snooping group Displays the IGMP groups.

All this explains how multicast works in an IPv4 network. Things are similar in IPv6 networks with the exception of IGMP, which
is too IPv4-specific. IPv6 relies on Multicast Listener Discovery (MLD), which is based on ICMPv6. MLDv1 has similar features
to IGMPv2, whereas MLDv2 is similar to IGMPv3. MLD is automatically enabled on IOS after you enable PIM6.

MLD has a “Multicast Done” message format that is sent when the multicast receiver stops listening to the mentioned IPv6
multicast stream (like IGMP Leave). It has a Multicast Listener query message type, issued by routers to discover whether anyone
is subscribed to a particular multicast address in the local-link network or a more general query to ask listeners what multicast
groups they are currently registered to. Finally, an unsolicited Multicast report message is sent by a node when it starts listening to a
particular multicast address. Reports are also sent in response to query messages.

Click here to view code image

Router(config)# ipv6 mld snooping
This command enables MLD snooping globally, but you also must enable it on the specific SVIs to operate at Layer 3 with the
following:

Click here to view code image

Router(config)# interface Vlan10
Router(config-if)# ipv6 mld snooping
Bonjour is an Apple service discovery protocol that locates devices and the services they offer on a local network with the use of
multicast DNS (mDNS) service records. The protocol works based on queries (“Who provides AirPrint service around here?”) and
advertisement (“Hey everyone, I’m an AppleTV, and I provide AirPlay services at this IP address with this name”). All those
packets are sent on multicast IP 224.0.0.251 or IPv6 FF02::FB on UDP port 5353.

As typically is the case with IPs in the 224.x.y.z range, the time-to-live (TTL) is set to 1 to make sure that routers will not route this
traffic globally (no point in the Internet knowing about your printer). Although this works great in home networks, it does not scale
well in enterprise networks, where multiple VLANs and subnets are used within the same building.

The WLC (more on this in Chapter 7) has a Bonjour gateway feature where the WLC will take note of all the services advertised in
all the VLANs that the WLC controls and will respond to queries coming in the same and/or other VLANs on behalf of the service
providers for the services that it has cached and are queried. This means that the multicast packets are not routed between VLANs,
but the WLC responds to queries in his VLANs and listens to advertisements too. This allows services to be available and
discoverable across VLANs without the multicast packets to route everywhere. Responses to service queries are unicasted back to
clients, and clients reach out to the service provider via unicast as well. This is why there is little multicast involved in this protocol
apart from the service discovery.

Services have very specific name strings in Bonjour. A few examples are the screen sharing using _airplay._tcp.local., Apple
printers using _printer._tcp.local., and universal printers using _universal._sub._ipp._tcp.local.
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Switches, such as the 3850, have a similar feature called Service Discovery Gateway (SDG). They will learn mDNS services from
all their connected subnets and answer client queries in all their connected subnets as well. This means no routing of the mDNS
packets between VLANs, but a “proxy” service for all the subnets present on the switch.

Click here to view code image

Switch(config)# service-list mdns-sd sl1 permit 3
Switch(config-mdns-sd-sl)# match message-type announcement
Switch(config-mdns-sd-sl)# match service-instance servInst 1
Switch(config-mdns-sd-sl)# match service-type _ipp._tcp
The first command listed creates a service list on which we can apply a filter according to the permit or deny option applied to the
sequence number. The sequence number sets the priority of the rule. A rule with a lower sequence number is selected first, and the
service announcement or query is allowed or denied accordingly. The match message-type command can match on any
announcement or query. The rule will apply only to the message type selected. The match service-instance command is optional
and configures the parameters of the service list name defined two lines before. The match service-type command defines the
exact service string to match for the filtering. After this is in place, you can proceed with the redistribution:

Click here to view code image

Switch(config)# service-routing mdns-sd
Switch(config-mdns)# service-policy <filterlistname> IN
Switch(config-mdns)# redistribute mdns-sd
Switch(config-mdns)# end
The previous commands define a redistribute policy in the “IN” direction.

Infrastructure Security for Access Points

There are several ways to make sure an authorized access point is connected to the network. The WLC itself can enforce it when
an AP tries to join, but here we will focus on infrastructure-side validation. The best security is to prevent network connectivity
completely if the device connected is not what we expect it to be. Some methods are transparent to the device (here, we will focus
on an AP) and some require a configuration on the device itself. The first transparent method would be to configure switchport
security. Port security allows you to configure a maximum amount of MAC addresses seen on a port and, optionally, to specify
those specifically allowed MAC addresses. If the AP is in local mode (that is, the clients will be seen behind the WLC ports and not
behind the switchport where the AP is plugged), you could therefore restrict the port to just the AP MAC address. Although this is
very granular (specific AP to port mapping), it really does not scale well because each switch will have to be statically configured
with the right AP MAC address, and problems will arise when you need to replace an AP or install more. MAC Authentication
Bypass (MAB) is a more centralized way of authenticating AP MAC addresses using a central RADIUS server.

MAC Authentication Bypass

MAB is named that way because it started as a “bypass” of 802.1X authentication for devices that don’t support that protocol.
However, it is really something separate nowadays. The idea behind MAB is that the administrator configures specific ports for
MAB authentication, and those ports will not pass traffic when they come up until the device is authenticated. When the port
receives traffic from the device MAC address, it then asks the central RADIUS server (more on RADIUS in Chapter 5, “Wireless
Security and Identity Management with ISE”) it is configured for whether this MAC address is authorized.

The following configures a switch to enable the authentication process required for MAB:

Click here to view code image

Switch1(config)# dot1x system-auth-control
Switch1(config)# aaa new-model
Switch1(config)# ip device tracking
The following configures a switchport to do MAB for any device connecting to it:
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Click here to view code image

Switch1(config)# interface Gig0/1
Switch1(config-if)# authentication port-control auto
Switch1(config-if)# mab
Switch1(config-if)# authentication order mab
Configuring the mab command enables MAB on that port, but nothing happens until you configure authentication port-control
auto, which enables authentication (whether it is MAB or dot1x) on the port; that is, the port will not forward traffic until
whichever method is configured has authenticated successfully. The authentication order mab command is a bit trivial when only
one method exists but makes full sense if you have both MAB and dot1x as an option on the port. It then defines which method is
attempted first (combinable with authentication priority, which will define which method has priority over the other, if they
occurred one after the other).

Along with access-accept, the RADIUS server can return various attributes, such as an access list to be applied on the AP port or a
VLAN in which to place the AP. Using MAB implies that you need to configure all your AP MAC addresses as endpoints (or users)
in your RADIUS server for authentications to be successful. In this manner, APs can be moved between switchports because they
are centrally authenticated regardless of where they are connected. However, they can be connected only on known and managed
network switches, because the RADIUS configuration requires a shared secret and requires the RADIUS server to know and trust
the network device where the AP will be plugged. In case of FlexConnect local switching, because all the AP clients’ MAC
addresses will be seen on the switchport where the AP is connected, it is not recommended to use MAB.

For MAB to work, you need to also define a AAA authentication method, as well as RADIUS server details.

Click here to view code image

Switch1(config)# aaa authentication dot1x default group radius
Switch1(config)# radius host <ip address> key <shared secret>

802.1X

802.1X (or dot1x as it’s regularly called) is a two-way authentication method that requires both the end devices (the RADIUS
server and the AP in our case) to authenticate and trust each other. The client (an AP in our case) will typically either use
credentials (username/password) or a certificate to authenticate itself.

Configuring the Access Point for Authenticating

If the AP has already joined the WLC and you want to configure dot1x authentication from then on (which implies that at this point
the switchport is not enforcing authentication yet), you can do so from the WLC web GUI. In the Global Configuration section of
the Wireless tab (as shown in Figure 2-15), you can configure a common set of username and password for every AP joined to that
WLC under 802.1x supplicant credentials. You can also make the credentials AP-specific by configuring them under the
Credentials tab of the specific AP configuration page, as shown in Figure 2-16.
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Figure 2-15 Configuring Global AP dot1x Credentials

In the screenshot, the Wireless tab is selected. On the left pane, All APs is selected under Access Points of Wireless
options. On the right pane, the Credentials tab is selected under All APs. The Credentials tab displays Over-ride Global
credentials checkbox under Login credentials. Over-ride Global credentials checkbox is selected with the username entered
as dot1xusername and eight digit password is entered for password and confirm password.
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Figure 2-16 Configuring AP-Specific dot1x Credentials

In the screenshot, the Wireless tab is selected. On the left pane, the Global configuration option is selected under Access
Points. Under the Global configuration, the LED State check box with Disable is shown in the drop-down under General
section. Under the CDP section, the CDP State check box is selected for Ethernet interface numbered from 0 to 4 and
Radio slot numbered from 0 to 2. Under Login credentials, the Username, Password, and Enable password textboxes are
shown. Under 802.1x Supplicant Credentials, the 802.1x Authentication check box is selected, the dot1xusername is
entered as Username with an eight-digit password is entered for Password and Confirm Password.

If your switchports are already configured for authentication, your new APs will not be able to obtain an IP address or join the
WLC at all until they are manually configured for credentials. You can do so with the following command:

Click here to view code image

LAP# capwap ap dot1x username <username> password <password>
IOS-based APs (802.11ac Wave 1 and before) require you to first type debug capwap console cli to configure the credentials.

Configuring the Switch

Here is the global configuration required on the switch:

Click here to view code image

Switch1(config)# dot1x system-auth-control
Switch1(config)# aaa new-model
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Switch1(config)# aaa authentication dot1x default group radius
Switch1(config)# radius server ISE
Switch1(config-radius)# address ipv4 <ISE ip> auth-port 1645 acct-port 1646
Switch1(config-key)# key 0 <shared secret>
Then on the switchport where the AP connects:

Click here to view code image

Switch1(config)# interface Gig0/1
Switch1(config-if)# dot1x pae authenticator
Switch1(config-if)# authentication order dot1x
Switch1(config-if)# authentication port-control auto
The vast majority of these commands are common with the previous MAB section, with the exception of dot1x pae authenticator
enabling the switchport to be the dot1x initiator (that is, it will send an EAPOL start frame when the link goes up).

The port will then be blocked and the AP will be requested to provide its credentials and start an authentication method. When
configured to do dot1x authentication for themselves, APs use EAP-FAST to authenticate.

Configuring ISE

More explanations will be given in Chapter 5 to configure ISE for dot1x or MAC authentication, but here are a few illustrations of
an ISE policy that will authenticate an AP using dot1x. We are configuring the switch as a AAA client in ISE on Figure 2-17,
configuring the authentication and authorization policies in Figure 2-18 and 2-20, verifying that EAP-FAST is allowed in Figure 2-
19, creating a user for the APs to use in Figure 2-21, and verifying that the authentication works successfully in Figure 2-22.

Figure 2-17 Configuring the Switch as a Network Device in ISE
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The Network Resources tab is selected under the Administration tab. Under the network devices on the right pane, the
name and description box are shown. The IP Address with the subnet is entered in the IP Address box. The Device Profile,
Model Name, and Software Version drop-down box are shown. Under Network Device Group, the Device Type and
Location drop-down box with Set To Default button is shown beside. The checkbox is enabled for RADIUS Authentication
settings. The Enable Authentication Settings includes Protocol, the five-digit password for Shared Secret with Show button
beside, and Enable KeyWrap checkbox are shown.

Figure 2-18 Authentication Policy Pointing Wired dot1x Authentication to the Default Policy and All Identity Stores

The Authentication tab is selected under the Policy options. The Authentication Policy displays the path for policy export
page. The Rule-Based radio button is selected within Policy Type. The MAB and Default checkbox is selected, the Dot1X
and Default checkbox is selected and highlighted, and the Default Rule (if no match) checkbox is selected.

Figure 2-19 Make Sure That the Default Network Access Allows for EAP-FAST Authentication

The Network Devices tab is selected under the Network Resources of Administration in ISE is shown. Under the Network
Devices in the content pane, the Name (mandatory), Description, IP Address (mandatory) are entered, Device Profile,
Model Name, Software Version drop-down boxes are selected. Under the Network Device Group, the Device Type and
Location are selected from a drop-down with Set to Default button shown beside. The checkbox for RADIUS
Authentication Settings is selected that enable authentication settings as Protocol, Shared Secret (mandatory) with Show
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button beside, and Enable KeyWrap checkbox shown beside.

Figure 2-20 Authorization Policy Permits Access in Case the Identity Belongs to Identity Group AP

A screenshot shows the Policy tab selected in the Identity Services Engine. Under this, the Authorization tab is selected to
display the Authorization Policy. Several rule names, with their status, conditions, and permissions are shown. A specific
AP (APs_dot1.x) is set to PermitAccess if the condition is "APs and Wired_802.1X."

Figure 2-21 Create a User in the Identity Store with the Credentials Configured for the AP on the WLC

In the screenshot, on the Administration page, the path, Identity Management, Groups is selected and displayed. The left
pane lists the Identity Groups, as collapsible sections. Two sections are listed: Endpoint Identity Groups and User Identity
Groups (selected). The content pane shows the User Identity Groups of AP. It has two text fields: Name and Description,
along with Save and Reset buttons. Below this, is a table titled Member Users, with column headers Status, Email,
Username, First Name, and Last Name. Each row in the table has an individual checkbox for selecting that particular row.
The table has options to add, delete, and filter data.
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Figure 2-22 A Successful AP dot1x Authentication as Seen in the ISE Live Logs

In the screenshot, on the Operations page, the path, RADIUS, Live logs is displayed. The content pane shows a summary of
the number of cases with Misconfigured Supplicants, Misconfigured Network Devices, RADIUS Drops, Client Stopped
Responding, and Repeat counter. Below is a table with column headers Time, Status, Details, Repeat, Identity, Endpoint
ID, and so on. A few of the fields in the table are hyperlinks. The table has options to Refresh, Reset Repeat Counts,
Export, and Filter.

Table 2-9 is useful for troubleshooting dot1x authentication on a port but also for MAB use cases (such as we covered in the
previous section) because both are authentication methods for switchports.

Table 2-9 Useful Switch-Side Troubleshooting Commands for Use in Troubleshooting Authenticated Switchports

Command Purpose
switch# show
authentication
session [interface
int-number]

Displays the list of authentications that are taking or have taken place (and are still active) on all switchports.
When specified for a MAC address or interface, the command lists all the authentication details of that session
(which method was used, client MAC address, current status, and attributes being applied, such as ACL or
VLAN).

switch# show
access-session
[interface int-
number]

This command is nearly identical to the previous, but on some switch platforms or depending on configuration
show access-session is used instead of show authentication session.

switch# show dot1x
interface [int-
number] details

Displays the list of clients connected to that interface, their current status, and the method used to
authenticate, as well as the interface timers and settings pertaining to dot1x.

switch# debug
dot1x all Starts a debug of the dot1x process.

switch# debug mab Starts a debug of the MAB process.
switch# debug
authentication all Starts a debug of the overall authentication process.

Advanced Settings and Special Cases

When a switch is configured for authentication port-control auto, it will start authenticating when a MAC address is seen on the
port, but what if multiple devices and MAC addresses are connected?

In single-host mode (command authentication host-mode single-host on the switchport), the switch will tolerate only one MAC
address to be present. If the client is replaced with another client (new MAC address), a new authentication will have to take place
for that new MAC address, but only one at a time is tolerated.

Multi-domain authentication is used (authentication host-mode multi-domain) when an IP phone is connected to the same
switchport as a data client. The RADIUS server will then return particular vendor-specific attributes (VSA) to place the IP phone in
the voice VLAN after a successful authentication; this then leaves room for one more MAC address (typically a PC) in the data
VLAN. This mode allows for only two MAC addresses to be present, and one of them must be identified as a voice VLAN type by
the RADIUS server (through the policies configured). Both devices (phone and PC) will have to go through authentication.

Multi-host authentication (authentication host-mode multi-host) is used when several data clients are connected to the same port.
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The switch will authenticate only the first MAC address to appear on the switchport and will apply the authorization results to all
other MAC addresses to connect on the port after the first one. This means that this first host will indirectly authorize or block all
other hosts depending on its authorization result. If it is assigned to a specific VLAN and ACL, all other MAC addresses will be
assigned the same attributes.

Multi-authentication mode (authentication host-mode multi-auth) is similar to multihost but will authenticate every single MAC
address on the port. Every client (voice or data) will go through an authentication phase. Depending on the platform, there might be
restrictions with regard to applying different RADIUS authorization results to each MAC address.

These modes can enable you to configure security on a port where a FlexConnect local switching AP is connected.

Securing FlexConnect APs

We already covered one particularity of FlexConnect APs operating in local switching; that is, client MAC addresses will appear on
the switchport where the AP is connected and will create many authentication sessions. In this case, multi-host mode could be a
workaround, because if the AP successfully authenticates, all client MAC addresses will be automatically approved as well. But this
does not cover another problem: FlexConnect APs in local switching typically operate on trunk ports when they service WLANs in
different VLANs and, by default, dot1x authentication occurs only on access mode ports. There is, however, a solution: if the
RADIUS server returns the Cisco VSA device-traffic-class=switch, then the switchport will automatically be configured as trunk.
This is automatically done when selecting “NEAT” in the ISE authorization result. The switch configuration does not differ a lot
but, in this case, aaa authorization network needs to be configured to apply the attribute returned by ISE. The debug debug
authentication feature autocfg all is specific to this scenario and will show that the authorization result makes the switch enforce
a trunk port configuration, as shown in Example 2-7.

Example 2-7 Debugging Output of a Trunk Switchport Configured for dot1x NEAT

Click here to view code image

Feb 20 12:38:11.113: AUTH-FEAT-AUTOCFG-EVENT: In dot1x AutoCfg start_fn, epm_handle:
  3372220456
Feb 20 12:38:11.113: AUTH-FEAT-AUTOCFG-EVENT: [588d.0997.061d, Gi0/4] Device
  Type = Switch
Feb 20 12:38:11.113: AUTH-FEAT-AUTOCFG-EVENT: [588d.0997.061d, Gi0/4] new client
Feb 20 12:38:11.113: AUTH-FEAT-AUTOCFG-EVENT: [Gi0/4] Internal Autocfg Macro
  Application Status : 1
Feb 20 12:38:11.113: AUTH-FEAT-AUTOCFG-EVENT: [Gi0/4] Device type : 2
Feb 20 12:38:11.113: AUTH-FEAT-AUTOCFG-EVENT: [Gi0/4] Auto-config: stp has port_
  config 0x85777D8
Feb 20 12:38:11.113: AUTH-FEAT-AUTOCFG-EVENT: [Gi0/4] Auto-config: stp port_config
  has bpdu guard_config 2
Feb 20 12:38:11.116: AUTH-FEAT-AUTOCFG-EVENT: [Gi0/4] Applying auto-cfg on the port.
Feb 20 12:38:11.116: AUTH-FEAT-AUTOCFG-EVENT: [Gi0/4] Vlan: 231 Vlan-Str: 231
Feb 20 12:38:11.116: AUTH-FEAT-AUTOCFG-EVENT: [Gi0/4] Applying dot1x_autocfg_supp
  macro
Feb 20 12:38:11.116: Applying command... 'no switchport access vlan 231' at Gi0/4
Feb 20 12:38:11.127: Applying command... 'no switchport nonegotiate' at Gi0/4
Feb 20 12:38:11.127: Applying command... 'switchport mode trunk' at Gi0/4
Feb 20 12:38:11.134: Applying command... 'switchport trunk native vlan 231' at Gi0/4
Feb 20 12:38:11.134: Applying command... 'spanning-tree portfast trunk' at Gi0/4
Feb 20 12:38:12.120: %LINEPROTO-5-UPDOWN: Line protocol on Interface
  GigabitEthernet0/4, changed state to down
Feb 20 12:38:15.139: %LINEPROTO-5-UPDOWN: Line protocol on Interface
  GigabitEthernet0/4, changed state to up

Figure 2-23 illustrates how the authorization result is configured on ISE to return attributes for NEAT authentication.
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Figure 2-23 ISE Authorization Policy Returns NEAT Attribute for APs on Trunk Port

In the screenshot, on the Policy page of the Cisco web interface, the path Policy Elements, Results is selected and
displayed. From the navigation pane along the left, Authorization Profiles from the section Authorization is selected. The
content pane shows the fields required to add a new authorization profile. The fields are Name - a text field, Description - a
text field, Access Type - a drop-down field, Network device profile - a drop-down field, and three checkboxes for Service
Template, Track Movement, and Passive Identity Tracking. Below this, is a collapsible section titled Common Tasks. It has
a list of four checkboxes to select among Assess Vulnerabilities, Reauthentication, MACSec Policy, and NEAT. NEAT is
selected.

This feature works best with multi-host mode for wireless clients to not retrigger authentications on the switch.

Other Protocols Supporting Wireless

After Layer 2 and Layer 3, a couple of application-level protocols come in handy when setting up a wireless network.

SNMP

Simple Network Management Protocol (SNMP) is the standard in network management (although many protocols, such as
NETCONF/Yang, are knocking at the door to replace and complete it). SNMP exists in three versions. There are virtually no
reasons to use v1, so we will focus on v2 and v3, which are the most widely used. SNMP is the protocol, running on UDP, used to
poll a remote device about its current status, configuration, and/or health. This data (status, configuration, and so on) is stored on
the device in a standardized database called the Management Information Base (MIB). Basically, for every configuration line you
enter, the configuration part of the MIB gets written accordingly. For every statistic or counter that the device is measuring, the
relevant part of the MIB is also updated, and as such the MIB becomes the real-time database of the device. We first need to
understand how this MIB works before trying to understand how to poll it via SNMP.

The MIB is made up of objects, which are referred to by Object Identifier (OID) numbers. Those objects can be any counter,
statistic, or configuration knob managed by the device. These OIDs are a series of integers separated by dots and forming a tree. It’s
much more obvious when looking at it in graphic form, such as Figure 2-24.
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Figure 2-24 OID Tree Example

The Root flows as iso (1), org (3), dod (3), and Internet (1). The Internet (1) is classified as directory (1), management (2),
experimental (3), private (4). The directory (1) is subclassified as mib-2 (1) that are further subclassified as system (1),
interfaces (2), and ip (4). The private (4) is subclassified as enterprise (1) that is further subclassified as cisco (9), microsoft
(311), and juniperMIB (2636).

The MIB OIDs are standardized, which means that common objects like interfaces, IP addresses, and system uptime will be using
the same OIDs regardless of the device. Fortunately, there is room for proprietary sub-MIBs to take care of all the platform-specific
objects. Anything related to a Cisco-specific feature will be starting with .1.3.6.1.4.1.9, which translates to
.iso.org.dod.internet.private.enterprise.cisco. The WLC, which is based on AireOS (which is a Cisco acquisition), has MIB OIDs
starting with .1.3.6.1.4.1.14179 for all its Airespace-specific objects (which is the majority of the MIB). For example, the Load
utilization in the receive direction of an access point is object .1.3.6.1.4.1.14179.2.2.13.1.1
(iso.org.dod.internet.private.enterprises.airespace.bsnWireless.bsnAP.bsnAPIfLoadParametersTable.BsnAPifloadRxUtilization). Of
course, it is not possible to remember all this by heart. The names—in parentheses here—are there to help you make sense of the
hierarchy, but devices use only the numbers when communicating. There are many tools online that will allow you to browse a MIB
and find out the specific item you want to configure/monitor via SNMP. Most applications like Prime Infrastructure will not require
you to know any SNMP OID; they will allow you to configure features in their GUI and will use the appropriate SNMP OID in the
background to configure it on the remote device without you having to care about the details.

SNMPv2 allows Get and Set operations. The management station, the SNMP Server, can send an SNMP Get to a certain device
accompanied with a SNMP OID (the long digit sequence .1.3.6.1.xxx) to request the remote managed device to send the value
contained in that OID in its MIB (whether it’s a configuration item or some counter or statistic). The Set operation will allow the
SNMP server to set a specific value in the remote device SNMP MIB, but this works only with configuration items (counters and
other statistic objects can’t be set). Because OIDs have a structure and are sequential numbers (but are not necessarily contiguous),
there is also a getNext method that will return the next value after the previously requested OID. This is useful when you want to
get a list of all interfaces without knowing how many there are in advance, for example, or basically anytime you want to poll a
specific sublist of the MIB without knowing each sub-OIDs in advance by heart. SNMPv2 also brings a GetBulk function (not
existing in v1) that allows you to request a larger amount of OIDs in one go without having to send a “Getnext” for each item
(which would be very costly if you wanted to get a lot of data). All this happens over UDP port 161.

SNMP also has a real-time notification system. You sometimes don’t want to wait for the management station to poll a remote
device to figure out that something went wrong. The managed device itself can decide (based on configurable triggers typically) to
send notifications to the SNMP server dynamically. These are called SNMP traps and use UDP port 162. The notification type sent
in the trap also uses an OID number.

From a security standpoint, it’s better to say that there is none. SNMPv2 uses a “community name,” which some would relate to as
a preshared key, but this couldn’t be more wrong. Each SNMP request needs to specify the community name, which is a string, for
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the remote device to answer. Since the packets are sent in clear-text over the network, this is no security at all because it can easily
be sniffed. However, the real purpose of communities is to provide different “views” of the MIB. The managed device can specify
several community names, each of them with a read-only or read-write privilege on the MIB and can sometimes specify only a
subset of the whole MIB to be accessible by the SNMP server, which will use that community name. Autonomous access points
support this view concept, but WLCs do not. WLCs will allow you to bind read-only or read-write privileges to community names,
though.

SNMPv3 adds real security to the whole concept. The biggest difference is that v3 does not rely on community names anymore but
requires a username and password. Packet contents are encrypted, and each transaction is authenticated and integrity validated.

On the WLC side of things, the SNMP General page under the Management tab (illustrated in Figure 2-25) enables you to
configure the main OIDs (name, location, contact person) as well as enable or disable certain SNMP versions. You can usually
forget about SNMPv1 but typically have to decide whether to enable v2 or v3 or both. If you are using v3 mostly, it is best to
disable v2 for security reasons, because it has no good security measures. It is advised to reboot the WLC if disabling/enabling
SNMP versions.

Figure 2-25 SNMP General Configuration Page on WLC

In the CISCO web page, the Management tab is selected. The General options of SNMP are selected within the Summary
option. In the content pane, the SNMP system summary displays the details of Name, Location, Contact, System
Description, System Object ID, SNMP Port Number, Trap Port Number, SNMP v1 Mode, SNMP v2c Mode, and SNMP v3
Mode.

The SNMP V3 Users page (shown in Figure 2-26) allows you to configure SNMPv3 users along with their authentication protocol
and encryption protocol (you need to remember what you set there because it will be required to configure the same protocols on
the SNMP server for that user profile). Be aware that there is a default user (called “default”), which you should be removing in
accordance with security best practices.
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Figure 2-26 SNMP v3 User Configuration Page

In the CISCO web page, the Management tab is selected. The SNMP V3 Users option of SNMP is selected within the
Summary option. In the content pane, the SNMP V3 Users displays the details of User Name, Access Level, Authentication
Protocol, and Privacy Protocol.

A Community page, shown in Figure 2-27, enables you to configure SNMPv2 communities, set them as read-only or read-write,
and enable or disable them. Be aware here as well that there is a default read-only community called “public,” and a default read-
write community called “private.” Any read-write community name will be replaced with asterisks in the GUI, but the name will
show if you click it. One more security measure (that doesn’t make it really bulletproof compared to v3) in v2 is that you can
configure an IP and subnet mask associated to a community. This restricts the IP address(es) that can source requests to the WLC
using this community. You typically will use a /32 mask and specify the SNMP server IP address, but it is also possible to specify
an IP range using a different mask.

Figure 2-27 SNMP Community Configuration Page

In the CISCO web page, the Management tab is selected. The Communities of SNMP is selected within the Summary
option. In the content pane, the SNMP v1/v2 Community displays the IP Address (Ipv4/Ipv6) of public and other two
communities. The IPSec checkbox is shown under IPSec Parameters.

Below these pages, you can see all SNMP traps that were sent since the last reboot (the Trap Logs page) of the WLC. You can see
and modify the list of devices toward which the WLC will send SNMP traps (the Trap Receivers page), and you can select which
traps will be sent in which situation in the Trap Controls page, as shown in Figure 2-28. This trap control page has many traps
enabled by default, but you may want to enable more to optimize some Prime Infrastructure features. Be aware that there may be
additional traps you can enable from the WLC command line compared to what is available in the GUI, depending on the WLC
version you are using.
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Figure 2-28 SNMP Trap Control Configuration Page

At the top of CISCO WLC webpage, the Management option is selected. On the left pane, the Trap controls are selected
within the SNMP options under the Summary of Management. The right pane displays the SNMP trap controls with the
Client tab selected. Under the Client tab, the Exclusion, MaxClients Limited Reached of Threshold set to 90, and Nac Alert
checkboxes are selected.

Many great tools exist to test SNMP from your laptop to understand better how it works (many UNIX-based platforms even have it
in the terminal by default, but Windows requires libraries to be installed). A great concept is the snmpwalk, which basically will do
SNMP GETs on the whole MIB of the device, allowing you to see all the OIDs in the device and their hierarchy. It’s also great for
verifying SNMP connectivity without having to remember a specific OID. For example, the command snmpwalk -v 2c -c public
10.10.20.30 will run a walk on the MIB of device 10.10.20.30 with the community “public” on version 2. Most tools will translate
the long integer-based OIDs to their textual meaning (or at least parts of the OID). Example 2-8 provides a short example (the total
output was thousands of lines).

Example 2-8 Example Output of an SNMP Walk

Click here to view code image

SNMPv2-MIB::sysDescr.0 = STRING: Cisco Controller
SNMPv2-MIB::sysObjectID.0 = OID: SNMPv2-SMI::enterprises.9.1.2427
DISMAN-EVENT-MIB::sysUpTimeInstance = Timeticks: (286397400) 33 days, 3:32:54.00
SNMPv2-MIB::sysContact.0 = STRING:
SNMPv2-MIB::sysName.0 = STRING: AIR-3504-1
SNMPv2-MIB::sysLocation.0 = STRING:
SNMPv2-MIB::sysServices.0 = INTEGER: 2
IF-MIB::ifNumber.0 = INTEGER: 6
IF-MIB::ifIndex.1 = INTEGER: 1
IF-MIB::ifIndex.2 = INTEGER: 2
(…)

DHCPv4
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Dynamic Host Configuration Protocol (DHCP) is the successor of BOOTP (which is why Wireshark still uses BOOTP as display
filter for it) and allows you to give IP addresses to hosts connecting to the network. This section focuses on DHCP in use with IPv4.
DHCP had a lot of success because it centralized IP address management and is also very flexible; it contains an impressive amount
of “options” that it can return to the host to give it more details about the network it is connecting to (domain name, DNS server,
and so on).

When the host connects, it sends a DHCP DISCOVER broadcast toward UDP port 67, as shown in Figure 2-29. This UDP
datagram contains the client MAC address among other details. Clients can also add options like their hostname (option 12, it
can help the DHCP server pick the right IP address) but also vendor details (option 60), which would be the specific Aironet
AP model in case of Cisco access points, or “Microsoft workstation” in case of a Windows laptop, for example.

Figure 2-29 DHCP Message 1: DISCOVER

Any DHCP server receiving this can reply with a DHCP OFFER targeted to the client MAC address on UDP port 68, as
illustrated in Figure 2-30. This offer is accompanied with the DHCP server IP address as well as basic options like subnet mask
and default router, but also a SYSLOG server IP address, a DNS server IP address, a TFTP server IP address, or a Cisco WLC
IP address, to just give a few examples.

Figure 2-30 DHCP Message 2: OFFER

The client, which may have received several offers, will choose one and will send a DHCP REQUEST toward the specific
DHCP server IP address, specifying again the IP address that was offered, as shown in Figure 2-31.

Figure 2-31 DHCP Message 3: REQUEST

The server will reply with a final DHCP ACK (or NACK in case it does not agree) to validate the address assignment, as shown
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in Figure 2-32.

Figure 2-32 DHCP Message 4: ACK/NACK

There are a few particularities worth mentioning. The IP address is leased for a certain time (which is mentioned as a field in the
DHCP exchange) decided by the server. The client will typically try to extend its IP lease (usually when it reaches half of the lease
time) by sending a DHCP REQUEST for the same IP address again. The server can then choose to extend it or not.

Clients, when connecting to a network (wired or wireless), might have the “reflex” to start by sending a DHCP REQUEST (instead
of the DISCOVER broadcast you would expect) and requesting the IP address they previously had in their last connection. If still
available, the DHCP server may very well grant the client to reuse that address.

So far, it would seem that the DHCP server must be present in the same subnet as the client because broadcasts are used, and this is
correct. However, it does not seem practical to have one DHCP server in each VLAN and subnet for the whole network because it
defeats the centralization purpose of DHCP. The way around this is to configure proxies—that is, devices that will take the DHCP
broadcast sent by the client and unicast it toward the DHCP server and also forward the DHCP reply back to the client. Both the
WLC and network switches (having an SVI in the subnet) can do this task. The DHCP server knows for which subnet the request is
by looking at the DHCP relay IP address, which will be the WLC dynamic interface in the subnet or the switch SVI in the same
subnet as the client. This becomes very practical because it restricts the need of broadcasts spreading long distances and allows you
to have one centralized DHCP server, present on a single VLAN but handing out IP addresses in many different subnets. The
DHCP server can have reservations (based on MAC addresses or hostnames, specific clients will always receive a reserved IP
address for themselves) or also exclusions (a specific subset of IP addresses in the subnet range are not handed out to clients
because they are used for some servers with static IP mappings).

Focusing on wireless clients behind a Cisco WLC, there are two modes of operation from a DHCP standpoint. In the first one, the
WLC has DHCP proxy disabled for that client interface and will then let the client DHCP broadcast through in the hope that there
is either a DHCP server present on that subnet or a switch SVI is configured to relay the request to a DHCP server. The second one
is when DHCP proxy is enabled, the WLC dynamic interface will then proxy the request to the configured DHCP server(s). Each
dynamic interface can be configured with two DHCP server IP addresses, which will both be used to forward DHCP DISCOVER
messages. The WLC also hides the real DHCP server IP address to the client and pretends that the DHCP server is whatever IP
address is configured on the virtual interface of the WLC. This allows the client to believe that a single DHCP server is present in
the whole network, no matter toward which other WLC it roams to (provided that they use the same virtual interface IP address),
while in reality it may be a different DHCP server replying to the client.

For access points to learn the IP address of the WLC, the network administrator can configure DHCP option 43. Option 43 is a
hexadecimal string that contains the IP address of one or more WLCs that the AP can try to join. In the case of one WLC, the
format will be F104.<ip in hex>, while in the case of two WLCs it will be F108.<ip in hex of first WLC><ip in hex of second
WLC>, and for three WLCs it will be F10C followed by the hex IP addresses. So, you can understand from these examples that
the prefix must be F1 followed by the amount of WLC IP addresses that follow multiplied by 4 (technically it represents the length
of the field in bytes, and since an IP address will take 4 bytes…). For example, providing the IP address 192.168.1.10 in option 43
will be f104.c0a8.010a. Providing IP addresses 192.168.1.10, 192.168.17.10, and 10.10.20.40 will be
f10c.c0a8.010a.c0a8.110a.0a0a.1428.

Many documents online combine the option 43 (WLC IP address) with the option 60 (vendor class) despite the two options not
being directly linked. Option 60 is sent by the access points in the DHCP discover where they specify their model in a text string. It
is possible for the DHCP server to restrict certain pools or return the option 43 only for specific client types. Translated for Cisco
APs, this means that you could have a DHCP pool that returns only option 43 when the AP requesting an IP is of a particular
model. This does not really scale well if you have APs of various models. Option 60 is not mandatory at all to have option 43
working fine. Example 2-9 provides a simple example of a DHCP pool configuration in IOS to return option 43 for access points.
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Example 2-9 Configuring a DHCP Pool on IOS and Returning Three WLC IP Address Through Option 43

Click here to view code image

Switch1(config)# ip dhcp pool MyAPs
Switch1(dhcp-config)# network 192.168.2.0 255.255.255.0
Switch1(dhcp-config)# default-router 192.168.2.1
Switch1(dhcp-config)# domain-name ccielab.com
Switch1(dhcp-config)# dns-server 192.168.1.20
Switch1(dhcp-config)# option 43 hex f10c.c0a8.010a.c0a8.110a.0a0a.1428
Switch1(dhcp-config)# exit
Switch1(config)# ip dhcp excluded-address 192.168.2.1 192.168.2.10
The previous switch configuration will create a DHCP pool serving the subnet 192.168.2.0/24 and will provide a domain name and
DNS server IP along with a WLC IP address to the AP connecting to that VLAN. For the DHCP pool to work, IP routing needs to
be enabled on the switch, and an SVI must exist in the specific subnet range of the DHCP pool. The switch is also excluding the
first 10 IP addresses of the subnet from the client allocations.

It is important to note that IOS DHCP servers do not exchange information with regard to leased IP addresses, which means that if
you have redundant gateways, they need to have DHCP pools covering nonoverlapping ranges of the subnet.

Configuring the proxying of DHCP request on an IOS switch is easily done with the ip helper-address command:

Click here to view code image

Switch1(config)# interface Vlan<SVI number>
Switch1(config-if)# ip helper-address <DHCP server ip>
This command can be repeated several times if you want to forward requests to multiple servers. The switch will forward the
request simultaneously to all configured servers. It is interesting to note as well that the ip helper-address command does not only
forward DHCP broadcasts but other UDP broadcasts (like DNS or TFTP for example), and can also forward CAPWAP UDP
broadcasts (with the command ip forward-protocol udp 5246) to the given unicast address.

Although it is documented online and this knowledge should be acquired at CCNA level certification, let’s quickly review the AP
join process because this section talks about various ways to tweak it.

The AP first does a DHCPv4 discover, unless it was previously configured for a static IP address (but bear in mind that it will
fallback to DHCP if it is not able to join with a static IP). It tries at the same time to obtain an IPv6 IP address as well.

If the AP receives a WLC management IP address through DHCPv4 option 43 or DHCPv6 option 52, it will send a discovery
request to that IP address.

The AP will simultaneously send a DNS request for CISCO-CAPWAP-CONTROLLER.localdomain to a broadcast address. If
you specified a DNS server IP in the DHCP options, it will use that IP to unicast the DNS request. If you specified a domain
name in the DHCP options, it will also look for CISCO-CAPWAP-CONTROLLER.<assigned domain> more precisely. It will
send discovery requests to all WLC IP addresses it receives this way.

It will try, at the same time, to send discovery requests again to WLC IP addresses it previously joined and that it saved in its
NVRAM. Even if it joined only one WLC in the past, it will have learned about the IP addresses of any WLCs present in the
mobility group as well, and it will try those, too.

It will send a broadcast CAPWAP discovery request in the current subnet.

It will send a unicast CAPWAP discovery request to a possibly statically configured WLC IP (if you configured one through
the AP command line).

Then, from all the answers it receives, it will give highest priority to the answer of the WLC that it has configured as “primary
controller,” And the same for the secondary and tertiary controller. If there was a Primary WLC or Secondary WLC setting
configured globally for all APs on the previously joined WLC, they will take priority 4 and 5 (after the AP-specific settings, as
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usual). The controller name in the response must match 100% (case-sensitive) to the configured name in the
primary/secondary/tertiary controller field; otherwise it will not try to join it. If none of these are an option, it will join a WLC that
has the option Master Controller configured, and if that is not the case either, it will join the least loaded WLC.

DHCPv6

IPv6 can very well function without DHCP because hosts can figure out their neighbor routers and assign themselves an IPv6
address. However, there is still the whole “configuration” and “DHCP options” side of things: the network administrator might still
want to assign specific server and subnet configuration to the hosts. Example 2-10 provides a small example of a DHCPv6 pool on
IOS.

Example 2-10 Example of a DHCPv6 IP Pool Configuration on IOS

Click here to view code image

Switch1(config)# ipv6 dhcp pool vlan-10clients
Switch1(config-dhcpv6)# address prefix FD09:9:5:10::/64
Switch1(config-dhcpv6)# address prefix 2001:9:5:10::/64
Switch1(config-dhcpv6)# dns-server 2001:0:5:10::33
Switch1(config-dhcpv6)# domain-name ccie.com
Switch1(config-dhcpv6)# information refresh 1
Switch1(config-dhcpv6)# exit
Switch1(config)# interface VlanX
Switch1(config-if)# ipv6 dhcp server vlan-10cients [rapid-commit] [allow-hint]
Independently, whether your IOS switch is running as the DHCP server or not, you may want to configure the DHCP relay
function, because ip helper-address will not do the trick anymore:

Click here to view code image

Switch1(config)# interface VlanX
Switch1(config-if)# ipv6 dhcp relay destination <ipv6 address>
The WLC will not do DHCP proxy for IPv6, so a DHCP relay or server must exist on the VLAN where the clients are.

For access points to join and discover a WLC using IPv6, we cannot rely on option 43 anymore, which was tailored for IPv4.
Option 52 is now used to provide up to three WLC IPv6 addresses. APs will support both stateless and stateful address assignment,
but will require the WLC to always be provided through DHCPv6 option 52 in both cases. Without option 52, DNS or direct AP
priming are still possible options.

APs will send a DHCPv6 Solicit packet (as shown in Figure 2-33) to a fixed multicast IPv6 address, which will include the list of
options the AP is requesting from the server; option 23 (DNS server IP); option 24 (Domain search list); and option 52 (WLC IP).
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Figure 2-33 DHCPv6 Solicit Packet

In the top section of the window, the column header reads: No, Time, source, destination, protocol, and Info. In the bottom
section, the line "Frame 1: 112 bytes on wire (896 bits), 112 bytes captured (896 bits) on interface 0. The "Request Option
code and Identify Association for Non-temporary Address" are highlighted.

If the DHCP server is configured with those options, it will return an Advertise packet (as shown in Figure 2-34) with up to three
WLC IPv6 addresses in order of preference.
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Figure 2-34 DHCPv6 Advertise Packet

The DHCP v6 advertise packet shows the table data at the top with the headers time, source, destination, protocol, and
info; the second row for advertise is selected. Followed by the CAPWAP access controller (highlighted) shows the value
for option, length, value, and two CAPWAP access controller address.

These packets will be followed by Request and Reply packets, similar to the DHCPv4 REQUEST and ACK to confirm the
transaction.

To configure option 52 on a Windows Server 2008/2012, go to the DHCP manager and expand the DHCP tree. Right-click the
IPv6 section and choose Set Predefined Options (because the option 52 does not exist by default, we need to add it). This is
illustrated in Figure 2-35.
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Figure 2-35 Opening v6 Options Window

In the DHCP window, "Set Predefined Options" under IPv6 is selected in the navigation pane. The content displays the
column headers "Option name, vendor, value, and class." In the left pane, "Scope options" is selected under Actions.

The Predefined Options and Values for v6 window will pop up. Choose DHCP Standard Options in the option class drop-down and
click Add. The result is illustrated in Figure 2-36.

Figure 2-36 Creating a Custom Option

In the "Predefined Options and Values for v6" dialog box, the DHCP Standard Options is selected within Option class
drop-down, the option name is selected from a drop-down box with three buttons, Add, Edit, and Delete. The option class
and option name drop-down boxes are highlighted. The Description text box is shown below. The Value console box with
Edit Array button is shown. The OK (selected) and Cancel buttons are shown at the bottom.
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Enter a name for the new option (just for reference, you can select how to call it) and set the Data Type to IPv6 Address. For APs
to properly accept the option, the WLC addresses object needs to be an array of IPv6 addresses, and this is the way to achieve this
in Windows Server. Check the Array check box and set the Code to 52. This is illustrated in Figure 2-37. Click OK twice and the
new option should now be assignable to IPv6 scopes.

Figure 2-37 Windows Server Creating the Option 52 Value

Now expand the scope that you want to use for your APs IPv6 assignment. Right-click Scope Options, and then select Configure
Options. This is shown in Figure 2-38.

Figure 2-38 Configuring Options for the Specific Scope for APs

In the DHCP window, the Scope Options folder within IPv6 in the DHCP is selected. In the content pane, the two rows of
Options Name, Vendor, Value, and Class are listed. Below that, the Configure Options in a dialog box is selected. The
Scope Options in the Actions pane is selected.

You can now choose the option 52 in the list of available options, and you can see it wears the name you gave it. In the New IPv6
Address field, enter the management IP of the primary WLC and click Add. You can then also add secondary and tertiary if you
like. This is illustrated in Figure 2-39.
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Figure 2-39 Configuring Options for the Specific Scope for APs

In the Scope Options dialog box, the General tab is selected that displays the Available Options and its Description is a
console box with one of the options is highlighted. In the Data entry section, the New IPv6 address box with Add button is
highlighted. The Current IPv6 Address text box with three buttons are shown beside. The OK (selected), Cancel, and
Apply buttons are shown at the bottom.

You can then verify this assignment on the AP itself (see Example 2-11; the output has been trimmed to show only the relevant
lines for your understanding).

Example 2-11 Verification of the DHCPv6 Status of the AP

Click here to view code image

MyAP# show ipv6 dhcp interface
BVI1 is in client mode
Prefix State is IDLE
Address state is OPEN
Renew for address will be sent in 1d
List of known servers :
   Reachable via address: FE80::3E0E:24BB:FE2A:E123
   Configuration parameters:
      Address : 2001:1234:1234:1234:1234:1234::1/128
      Expires at Apr 11 2018 02:32 PM
   DNS server : 2001:1:2::1
   Domain name : ccie.com
   Capwap access controller : 2001:470:52C5:14::16
Capwap access controller : 2001:470:52C5:14::17

DNS

Domain Name System (DNS) is a name resolution method used to translate Internet domain names to IP addresses (but not
necessarily only in that direction). DNS works on a hierarchy of domain levels. If we use the very famous Internet domains as an
example, you have one (technically more, but still a very limited amount) root name server for the .com domain. That root server
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will be aware of cisco.com and will be able to return IP addresses tied to that domain. However, if I ask for the IP address of
software.cisco.com, we start to picture that it’s not scalable for the root domain server to know all the subdomains and specific
server IP addresses for all the domains under its authority. It can therefore redirect the request to the DNS server authoritative for
the cisco.com subdomain. That one will definitely have the responsibility to know about software.cisco.com.

For the example, resolving this with the nslookup tool (present in all main laptops OS), the command line gives the following:

Click here to view code image

Nslookup software.cisco.com
Server :      <DNS server IP used by this laptop>

Software.cisco.com
Name: origin-software.cisco.com
Addresses: 2a02:a000:1:386:ac5
       23.218.189.151
Aliases : software.cisco.com

We can already picture how flexible this system is, because it allows you to return different IP addresses (v4 or v6) as well as name
aliases. The whole domain name structure is also very scalable, because you could have server-
name.department.continent.company.extension and can offload the administration of all the servers of that small team to the local
continent-specific department of your company. Other parts of the company could manage their own DNS server responsible for
their own subdomains without having to argue with you. It is important to note that what a DNS server returns to you will not
necessarily be the same as what it will return to another requestor. A DNS server can very well give different replies to load-
balance the load to several IP addresses or simply hand out a different IP mapping, depending where you are located on the globe.

There is also the concept of reverse DNS lookup, where you look up an IP address and the DNS server will let you know what
name is linked to it, which can be practical in many situations.

There are several types of DNS records:

A (for Address) record: These are the “main” records and contain a host IPv4 address.

AAAA record: Contains a host of IPv6 addresses.

CNAME record: Allows you to redirect one name to another.

PTR: Points to a hostname (used therefore in reverse lookups).

MX record: Defines the mail server IP for the domain.

SRV record: Extension of the MX record for various services belonging to the domain (used by Active Directory to point to
the domain controller and specific services in use for the domain).

NS record: Defines the DNS servers for the domain.

Cisco access points can discover the WLC using DNS. However, this also means that, before they can do so, the access points need
to be configured with an IP address, know which domain they belong to, and know the DNS server IP address. This technically
means that they need to obtain an IP address via DHCP. They will then try to resolve (as soon as they obtained their IP address and
tested their gateway reachability) CISCO-CAPWAP-CONTROLLER.localdomain. The localdomain part will be replaced with
the actual domain name, if you assigned one as part of the DHCP options. If there is an A-record for this in the local DNS server,
the AP should receive the list of WLC IP addresses attached to it, and then try to join it.

SYSLOG

Syslog is a message logging system that started on UNIX but spread to most networking products because it is independent of the
client and server types in use. The whole concept is about the syslog device sending messages (that don’t need any form of
acknowledgement) to a server that will record all of them. Server software differs in the way they allow the administrator to browse
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and search through the mountain of logs received by all the devices using it as a syslog server, but the concept will remain the same.
A syslog message is a combination of three things: severity level, facility (kind of like “syslog type”), and the actual message.

Facility clearly has a UNIX inspiration with types like kern, user, mail, auth, new, and so on. However there are eight custom
facilities, local0, local1, all the way up to local7, which can be used for your own purposes. It’s then up to the network
administrator to configure some devices to log to a given facility and other devices to other facilities.

Severities range from 0 to 7 and each one has guidelines for usage.

0. Emergency: Panic condition. Nearly never used apart from when a system might crash badly.

1. Alert: Major corruption requiring immediate action.

2. Critical: Critical errors (bad hardware, things going south real quick).

3. Error: This is the default logging level of many devices. It will log anything that is not a normal behavior.

4. Warning: Displays warning conditions that may not cause problems but shows possibly unexpected behavior.

5. Notice: Displays normal but significant conditions.

6. Informational: Informational messages.

7. Debug: Debug-level messages.

When you set the logging level to be 3 or Error, it means that the device will display all messages that are Error-level or more
severe (so severity 2, 1, and 0 as well). Logging at debug level means that all severities of messages will be displayed and sent, and
so on.

The Management > Logs > Config page is an easy go-to for syslog configuration on the controller. You can configure the IP of the
syslog server the WLC will use for its logging, as well as the logging level (remember it will be that level and above) and the
facility. In the Msg Log configuration section, you can choose the severity of logs to keep in the memory buffer (show msglog) and
the severity that will be displayed on console session (that is disabled by default; historically, AireOS was not logging syslog to
console). One trick is that this web page is only about the WLC syslogs. On the WLC command line you can also configure the
syslog parameters for access points. It is best practice to configure syslog for your APs so that you can review their console output
without having to plug an actual console cable to one whenever you suddenly have trouble with one (or more APs). Another way to
achieve this is to return DHCP option 7 in the AP DHCP pool so that APs start to syslog their output as soon as they obtain
network connectivity (which is helpful when you troubleshoot an AP not joining a WLC, and you don’t have console access to the
AP).

While syslog messages and SNMP traps are two different things, there also are options to enable the sending of syslog messages
when a given SNMP trap is sent. This section closes with a summary table of useful commands for syslog configuration and
verification on the WLC and also on autonomous IOS APs (see Table 2-10), as well as a screenshot of a Kiwi Syslog server that
received a couple of syslog message from APs and WLCs (see Figure 2-40).

Table 2-10 Summary of the Syslog-related Commands on the WLC

Command Purpose
WLC> config logging syslog
host <ip> Configures the IP address of the syslog server where WLC will send its log messages

WLC> show msglog Will display all the buffered message logs sent and logged by the WLC (unless you choose a
different severity for syslog level and for “buffered log level”)

WLC> config ap syslog host
global/<apname> <ip> Configures the syslog server for APs to directly syslog their messages to it

WLC> config ap logging level
<level> Configures the AP syslog logging level

WLC> config ap logging facility
<name> Configures the AP syslog facility
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aIOS(config)# logging host
<server ip> Sets the IP address of syslog server on autonomous IOS APs

aIOS(config)# logging facility
<facility name> Sets the syslog facility on autonomous IOS APs

Figure 2-40 Kiwi Syslog Server Output When Receiving Syslog Messages

NTP

Despite being more and more critical, Network Time Protocol (NTP) is still not heavily used by network administrators. NTP allows
network devices to periodically resynchronize with a trusted time source and opens the doors to the amazing feeling of having the
logs of all your network devices synchronized to the millisecond, allowing you to cross-check what happened during a particular
event in the logs of multiple devices.

A very common NTP version is NTPv3 (and is the one used in the lab), but newer WLC software supports NTPv4. They are,
however, all compatible with each other. The configuration is pretty straightforward on the WLC, in the web interface Controller
page under the NTP > Server menu. You can add several NTP servers there, as well as configure the NTP polling interval. After
your network device got the right time, it’s very unlikely that it needs to keep polling it frequently, so very long NTP polling
intervals are fine. However, because network devices don’t use atomic ultra-high-precision clocks, it might start to slide a few
seconds after weeks or months of uptime. Therefore, an NTP polling interval of a few hours is fine and ensures your device’s time
is always as accurate as possible.

NTP also provides some form of authentication security with configurable keys.

While the inner workings of NTP are a bit beyond the scope of the CCIE exam, it is interesting to note that the NTP server will give
the time in UTC format (without any time zone skew). It is thus acceptable to have an NTP server in another time zone. What about
network latency then? Well, the NTP protocol also measures the network delay and adjusts the time received from the NTP server
with the estimated delay it took the packet to arrive to the device, making sure the latency does not affect the time synchronization
to a relevant extent. All that is pretty neat, but how do you set up an NTP server and how does a device decide which NTP is most
reliable?

NTP uses the concept of stratum. A stratum-0 server is a reference clock and is not available on the network, but it will be
connected to an NTP server that will be defined as a stratum-1 server (because it is one hop away from the reference clock). Any
server that uses this stratum-1 server will be defined as a stratum-2 server, and so on. NTP only tolerates up to 16 stratum levels. If
you set up one of your device as NTP server, its stratum will be S+1, S being the stratum of the reference NTP server used by your
NTP server to get its time. If you decide to not have a reference server and set the time manually on your device, the stratum will
be automatically set as 16. This is how NTP clients will know which server is the most reliable.

Configuring a router as NTP server is quite quick:

Click here to view code image

Router# config term
Router(config)# ntp master 4
Router(config)# ntp source Vlan1
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Router(config)# interface Vlan1
Router(config-if)ntp broadcast

These commands will set the router to advertise its internal clock as a stratum 4 reference and will be a time server in VLAN1,
using that SVI IP as source. Verifying all NTP details on the WLC is quite simple with the show time command (see Example 2-
12).

Example 2-12 Example Output of NTP Details on a WLC

Click here to view code image

(Cisco Controller) >show timeTime.............................................
Wed May  9 13:39:47 2018Timezone delta................................... 0:0Timezone
  location................................NTP Servers    NTP Polling
  Interval.........................     3600     Index     NTP Key Index
  NTP Server                Status          NTP Msg Auth Status    -------  ----------
  ------------------------------------------------------------------------------------
  1              0                                192.168.1.11     In Sync
AUTH DISABLED(Cisco Controller) >

Let’s conclude with a summary of NTP-related commands on the WLC (see Table 2-11).

Table 2-11 NTP Configuration and Verification Commands on the WLC

Command Purpose

WLC> show time Shows the current time and time zone as well as NTP settings and sync
status

WLC> config time ntp server <index> <ip> Configures a given IP address as NTP server (of index 1 to 3 if you want to
have several sources)

WLC> config time ntp interval <seconds> Configures the interval at which the WLC will resync its clock
WLC> config time ntp key-auth add <key index>
md5 ascii <key> Configures the NTP key (optional)

WLC> config time ntp auth enable <server index>
<key index>

Configures authentication on NTP server index X by using the keys of key
index Y

Summary

This wraps up the infrastructure chapter of this book. As you can see, a CCIE Wireless does not need to know all the tiny details of
those protocols. You can, however, expect that some of these protocols will appear as configuration tasks in the CCIE Wireless lab
exam or will be required to bring the connectivity up. To declare yourself ready for the exam, all the knowledge of this chapter
must be natural and common knowledge to you as you make sure the infrastructure network is ready before you configure anything
wireless related. You can also expect this chapter to be a good source for troubleshooting actions, when you receive the
preconfigured topology in the exam and some items were intentionally misconfigured (or simply missing sometimes) for you to
troubleshoot. There is no point in trying to configure advanced wireless features (multicast or FlexConnect setups) if your
infrastructure has dodgy VLAN configuration or suspicious multicast forwarding. Be sure to master this chapter before moving on
to the next ones!
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Chapter 3

Autonomous Deployments
A lot of WLAN deployments still use autonomous/standalone access points (AP) or bridges. In fact, the Internet of
Things is keeping the workgroup bridge (WGB) very busy in different types of environments. So yes, wireless CCIEs
still need to deal with scenarios using autonomous WLAN devices. Because WGBs are specialized devices, CCIEs are
usually expected to know “at least something” and have enough expertise to deal with some devices/topologies that
many other WLAN engineers have never worked with.

The Cisco IOS autonomous WLAN devices (sometimes called aIOS, for autonomous IOS) encompass multiple models
of hardware indoor and outdoor APs (or bridges) that could be used as lightweight/CAPWAP APs managed by WLCs,
but where you can install instead a Cisco IOS Autonomous AP image, so you can manage the unit as a standalone
device, just like many other Cisco IOS devices (same core OS and CLI look and feel that you get in the well-known
Cisco IOS routers and switches).

Although autonomous APs can be used in many roles, their main use case has become to perform wireless bridge links,
which specifically translates to the following deployment models:

Point-to-Point Bridging: One device acting as the root bridge and another device acting as the non-root bridge,
simply extending a Layer 2 Ethernet link over wireless.

Point-to-Multipoint Bridging: One device acting as the root bridge and two or more devices acting as non-root
bridges. The root bridge is at a central location (normally the main LAN), and all the non-root bridges establish
point-to-point Layer 2 links with the root to wirelessly provide an uplink for the remote locations behind them.

Workgroup Bridge (WGB) deployments: The WGB connects to 802.11 access points acting in their regular root
AP role for Wi-Fi clients (and can also connect to root bridges). WGB connects to the root as a wireless “regular”
client or “infrastructure” client and can host and relay traffic to and from one or more wired clients. The wired
device(s) or network behind the WGB connects to the main network infrastructure over the wireless link between
the WGB and its root (AP, bridge, or even WLC port).

The purpose of this chapter is to give you the core knowledge (and main tips) required to deploy, configure, and
troubleshoot Cisco IOS Autonomous WLAN devices implemented in the deployment models described previously.

The Role in the Deployment

As previously introduced, three main deployment models will be discussed in this chapter, and for each model, the
autonomous WLAN device plays a different role based on its position (and purpose) in the network. This role is
specifically configured in one of its radio interfaces, as you can see in Example 3-1.

Example 3-1 Radio Interface station-role ? Command Output

Click here to view code image

aIOSAP(config)# interface dot11Radio 1
aIOSAP(config-if)# station-role ?
  non-root          Non-root (bridge)
  root              Root access point or bridge
  workgroup-bridge  Workgroup Bridge
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Depending on which radio band is used for this wireless link, you will configure the 2.4 GHz radio or the 5 GHz radio
(interface Dot11Radio 0 or Dot11Radio 1, respectively). The remaining radio interface is not used, so the
recommendation is to shut it down (mainly because using the remaining radio with the same role or other roles is not
supported or recommended).

Before getting further into the details of these configurations, it is important to remember that wireless bridge links are
not clearly defined by the 802.11 standard. The standard mainly defines communications between stations (STA), one
of which could act as an access point. In 802.11, the AP is the only one that can “bridge” traffic between the wireless
network and the wired infrastructure, from one MAC address (could be a client STA) to another MAC address (for
example, the client’s default gateway). Hence, vendors deploying WGBs and bridges implement proprietary features
that make the client bridge act and be treated as an “infrastructure” device (more on this later in the chapter), which lets
them bridge traffic similar to an AP but acting as a client associated to a root. Transmissions also take advantage of
elements available in 802.11 frames’ headers: They support up to 4 MAC addresses, known as Source Address (SA),
Transmitter Address (TA), Receiver Address (RA), and Destination Address (DA). For example, the 802.11 header has
the following fields available for addresses:

Address 1 = Receiver Address (RA)

Address 2 = Transmitter Address (TA)

Address 3 = Destination Address (DA)

Address 4 = Source Address (SA)

In a standard 802.11/Wi-Fi communication, only 3 MAC addresses are used in those headers: one for the original
source, one for the final destination, and the MAC of the AP where the client is associated (known as the BSSID). So if
a wireless client is transmitting a frame to the default gateway, the transmitter address (TA) is the client (which is also
the source address, SA, because the original frame source is the same as the device transmitting the frame over the air),
the destination address (DA) is the final destination (the gateway), and the receiver address (RA) is the AP BSSID
(which is like a Layer 2 bridge receiving the frame over the air to bridge it to the true final destination). Based on the
available address fields in the 802.11 header, this example will be something like the following:

Address 1 = Receiver Address (RA) = AP BSSID

Address 2 = Transmitter Address (TA) = Client

Address 3 = Destination Address (DA) = Gateway

Address 4 = Source Address (SA) = Not used, because it is the same already in Address 2

If the default gateway is now transmitting back to the wireless client, the frame looks as follows over the air from the
AP to the client: the source address (SA) is the gateway, the transmitter address (TA) is the AP, and the
receiver/destination addresses (RA and DA) are a single MAC (wireless client). In this case, the frame header will be

Address 1 = Receiver Address (RA) = Client

Address 2 = Transmitter Address (TA) = AP BSSID

Address 3 = Destination Address (DA) = Not used, because it is the same already in Address 1

Address 4 = Source Address (SA) = Gateway

When doing the so-called “wireless bridge links” based on 802.11 frames, not only is the root (AP or bridge) allowing a
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wireless client to send frames on behalf of other MAC addresses (not allowed by standard 802.11 communications) but
the client bridge is also receiving and bridging frames intended for other MAC addresses (the wired clients attached to
the WGB or behind the bridge). In these cases, four different MAC addresses are truly used in the four MAC address
fields of 802.11 headers:

If a device behind the infrastructure client (non-root or workgroup bridge) is transmitting a frame to the default
gateway (final Layer 2 destination address, so gateway = DA), the source address (SA) is the client/MAC behind
the client bridge at the origin of that traffic, but the transmitter address (TA—the device transmitting the frame over
the air) is the client bridge and the receiver address (RA) is the root BSSID. The header will have the following:

Address 1 = Receiver Address (RA) = Root BSSID

Address 2 = Transmitter Address (TA) = Client Bridge (Non-root or WGB)

Address 3 = Destination Address (DA) = Gateway

Address 4 = Source Address (SA) = Client

If the default gateway is now transmitting back to the device behind the infrastructure client bridge, the frame looks
as follows over the air from the root: the source address (SA) is the gateway, the transmitter address (TA) is the
root, the receiver address (RA) is the client bridge, and the destination address (DA) is the final destination (the
MAC of the device behind the client bridge). In this case, the header is as follows:

Address 1 = Receiver Address (RA) = Client Bridge (Non-root or WGB)

Address 2 = Transmitter Address (TA) = Root BSSID

Address 3 = Destination Address (DA) = Client

Address 4 = Source Address (SA) = Gateway

Root and Non-Root Bridges

Figure 3-1 shows the roles for point-to-point and point-to-multipoint bridging:
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Figure 3-1 Point-to-Point and Point-to-Multipoint Bridging

In the Point-to-Point connection, the building on the left labeled "Root" is connected to another building on the
right labeled "Non-Root" via an Ethernet link. In the Point-to-Multipoint, the building on the left labeled "Root"
is connected to three buildings on the right labeled "Non-Root 1, Non-Root 2, and Non-Root 3."

This type of wireless bridging is used to extend Layer 2 links; basically an Ethernet link is extended between two
devices, but instead of using a large cable you use a wireless bridge link (for example, because you cannot deploy a
physical cable between two buildings).

The Cisco autonomous wireless devices (any Cisco AP model that supports autonomous IOS images) act as Layer 2
bridges, similar to switches. You could connect two computers, one to each Ethernet port of a pair of wireless bridges,
and once the non-root bridge establishes wireless association with the root bridge, the computers would be able to
communicate (again, just like connecting an Ethernet cable between them).

Hence, you could also connect two routers’ Layer 3 interfaces to the Ethernet ports of the bridges (one behind the root
and another behind the non-root), and the routers will communicate with each other as if they were connected over a
cable; the wireless bridge link is totally transparent to them. The router interfaces configuration would be identical,
irrespective of the physical link between them (cable or wireless).

However, the main use of these bridge links is to interconnect two switches to extend the LAN at a location where
cabling is not possible (or wireless is just the best option). When this is done, two switchports in access mode can be
connected by the wireless bridge link to transport traffic for a single VLAN between the switches. Even better, two
switchports in 802.1Q trunk mode can be connected so that traffic from more than one VLAN can be transported over
the wireless link. In this case, the VLANs to be allowed/used between the switches need to be configured in the wireless
bridges. Figure 3-2 illustrates the possibilities when bridging between switches.
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Figure 3-2 Bridging VLANs Wirelessly

In the VLAN 5-10, the core backbone is connected to Bridge 1 via a switch. The Bridge 1 is connected to the
native VLAN: 7 as the connection of Bridge 2 and Switch enclosed in a dashed circle at the top then the switch
is further connected to a laptop enclosed in a VLAN 5. The connection of Bridge 3 and Switch enclosed in a
dashed circle at the bottom then the switch is further connected to a laptop enclosed in a VLAN 8.

To achieve such design or similar (such as one where all VLANs 5–10 are supported in all switches), you need to make
sure that the LAN infrastructure and switches involved are properly configured to allow/use the VLANs you want, with
proper trunks (including the switchports where the bridges directly connect) and all the VLANs with working
connectivity. After you insert the wireless bridges between switches, you just need to have the required VLANs
configured on the bridges; this is done by using subinterfaces with bridge-groups.

Subinterfaces are used to segregate VLANs just like in other Cisco IOS devices. The reason behind using bridge-groups
is that the IOS autonomous APs/bridges are Layer 2 devices (so they don’t route) that use these bridge-groups to bridge
and convert traffic between two physical interfaces working with different Layer 2 protocols. They bridge 802.11
wireless frames from a radio interface to 802.3 frames in the Ethernet interface, and vice versa. They can also bridge
traffic between radio interfaces.

By default, these devices have one virtual interface (called the bridge virtual interface, or BVI1) linking all those
physical interfaces. This BVI1 is the actual interface “mastering” bridge-group 1, bridging Ethernet and radio(s)
together via bridge-group 1, and is the only Layer 3 interface that should have an IP address. You use the BVI1 IP
address to connect to the bridge over an IP network (for management purposes, for example). This BVI1 will never
mark traffic with a VLAN ID (no 802.1Q tag). Therefore, the BVI subnet is always considered the 802.1Q native
VLAN when configuring multiple VLANs on the device. This means that the AP/bridge will always have its IP address,
manually configured or obtained via DHCP, assigned to the BVI1 interface and located within the subnet of the
native/untagged VLAN configured at the Ethernet port where the bridge is connected.

Example 3-2 is a basic bridge-group 1 setup, which is enough to bridge those interfaces and carry traffic for a single
VLAN (all within the same subnet mastered by BVI1 and without VLAN tagging).

Example 3-2 Bridge-Group 1 Setup Without VLANs

Click here to view code image
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Bridge(config)# interface Dot11Radio0
Bridge(config-if)# bridge-group 1
Bridge(config-if)# interface Dot11Radio1
Bridge(config-if)# bridge-group 1
Bridge(config-if)# interface GigabitEthernet0
Bridge(config-if)# bridge-group 1
Bridge(config-if)# interface BVI1
Bridge(config-if)# ip address <IP-ADDRESS> (manually configured or DHCP)
Such bridge-group 1 configuration is already by default in these autonomous IOS APs/bridges, and all you normally
need to do is to assign the IP address to the BVI1 interface. Some other bridge-group commands/subcommands could
come by default (or simply when you enable the bridge-group <1-255> command at each interface), and there is no
need to modify those default bridge-group settings, so if you want to try specific bridging behaviors by modifying the
defaults, the recommendation is to research for the specific purpose of each command by checking the Cisco IOS
bridging/bridge-group documentation (not covered in this book).

Example 3-2 is enough to pass traffic from one site to the other in one VLAN; you do not need to configure any VLAN
at the APs/bridges. For example, if you want to pass traffic for VLAN-10, configure the bridges as shown in Example 3-
2 and make sure that the APs/bridges at both ends connect to ports configured for that VLAN (no trunk, no tagging).
Example 3-3 illustrates a Cisco IOS switchport in access mode configured for this purpose.

Example 3-3 Bridge’s Switchport Configuration for One VLAN

Click here to view code image

Switch(config)# interface GigabitEthernet 0
Switch(config-if)# description **to the bridge**
Switch(config-if)# switchport mode access
Switch(config-if)# switchport access vlan 10
If the purpose is to connect VLAN 12, for example, then there is nothing to do in the APs/bridges, just connect them to
ports in that VLAN (switchport access vlan 12).

Now, if you want to pass traffic over this wireless bridge-link for more than one VLAN, or even just have the
APs/bridges in one separate management VLAN and then pass user/data traffic through other VLANs, here is where
you need to configure VLANs using subinterfaces with bridge-groups.

You will always have the management VLAN of the APs/bridges (the one where the BVI1 interface will have its IP
address) as the native VLAN; this is how the configuration looks if that native VLAN is VLAN 10 at the switchports
where the bridges connect. Example 3-4 supposes that you use the 5 GHz interface Dot11Radio1 for the wireless bridge
link.

Example 3-4 Bridge-Group 1 Setup with Native VLAN

Click here to view code image

Bridge(config)# interface Dot11Radio1.10
Bridge(config-if)# encapsulation dot1Q 10 native
Bridge(config-if)# bridge-group 1
Bridge(config-if)# interface GigabitEthernet0.10
Bridge(config-if)# encapsulation dot1Q 10 native
Bridge(config-if)# bridge-group 1
Bridge(config-if)# interface BVI1
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Bridge(config-if)# ip address <IP-ADDRESS> (in VLAN-10 subnet range)
In addition, the SSID configuration should have that native VLAN ID assigned, as follows:

Click here to view code image

Bridge(config)# dot11 ssid Bridges
Bridge(config-ssid)# vlan 10
Then you create other radio and Ethernet subinterfaces with matching bridge-groups bridging them together, using one
different bridge-group number per VLAN (anything from 2 to 255), passing all the VLANs you need (only required
VLANs as recommended), being the maximum number of VLANs limited by the amount of bridge-groups supported by
these devices (255). Regardless of the number of subinterfaces, you will still have only a single BVI interface, with a
single IP address (an extra BVI interface should never be configured). Interface BVI1 is enough as the only Layer 3
interface required. Any group other than bridge-group 1 (where the BVI1, native/untagged VLAN resides) is simply a
Layer 2 802.1Q tagged VLAN (without BVI interface) that bridges two or more subinterfaces created for that new
VLAN. Example 3-5 is the extra configuration required if you were passing two more VLANs (20 and 30) over this link
other than the native VLAN 10 previously configured for bridge-group 1 (the first section is the bridges’ configuration,
and the second section is the configuration of the switchports where they connect).

Example 3-5 Bridge-Groups for Extra VLANs and Switchports Configuration

Click here to view code image

Bridge(config)# interface Dot11Radio1.20
Bridge(config-if)# encapsulation dot1Q 20
Bridge(config-if)# bridge-group 20
Bridge(config-if)# interface Dot11Radio1.30
Bridge(config-if)# encapsulation dot1Q 30
Bridge(config-if)# bridge-group 30
Bridge(config-if)# interface GigabitEthernet0.20
Bridge(config-if)# encapsulation dot1Q 20
Bridge(config-if)# bridge-group 20
Bridge(config-if)# interface GigabitEthernet0.30
Bridge(config-if)# encapsulation dot1Q 30
Bridge(config-if)# bridge-group 30
************************
Switch(config)# interface GigabitEthernet 0
Switch(config-if)# description **to the bridge**
Switch(config-if)# switchport mode trunk
Switch(config-if)# switchport trunk native vlan 10
Switch(config-if)# switchport trunk allowed vlan 10,20,30
Note

The bridge-group ID and VLAN ID don’t need to match; it is just recommended for administrative purposes. In fact,
because the bridge-group IDs’ limit is 255, if you have VLAN ID 256 or above in your network, you won’t be able to
match them (and this is fine).

All that really matters is that you use the proper VLAN ID as configured in the switching LAN infrastructure, that this
VLAN is allowed in the trunk where the APs/bridges connect and is tagged with the 802.1Q standard, and that the
bridge-group ID matches between the subinterfaces you are trying to bridge together, like in Example 3-5.

The subinterface ID after the dot (for example, GigabitEthernet0.30) doesn’t need to match either—no match between
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subinterfaces, and no match with VLAN or bridge-group IDs. Using the same number, however, is simpler for
administrative purposes.

This configuration with the required VLANs is done the same way at the root AP/bridge and the non-root bridge(s).
VLAN information is shared over the wireless link between these devices by using the Cisco version of Inter Access
Point Protocol (IAPP) developed for proprietary communication between its Cisco WLAN infrastructure devices, and
also named Cisco Wireless LAN Context Control Protocol (WLCCP). Figure 3-3 shows a Wireshark capture where two
bridges share (over the air) information about the underlying VLANs.

Figure 3-3 IAPP/WLCCP with VLAN Information

At the top, one of the rows is selected under the tabulation of No., Time, Time Delta, Source, Description, Ch.,
Rate (Mb/s), Signal dB, Protocol, Length, and Info. The five lines in the code are highlighted.

The main difference between the roles root access-point and root bridge is that the root AP is normally used to connect
regular 802.11 wireless clients (could also be WGBs), just like lightweight APs, whereas a root bridge is normally used
for the designs in Figure 3-1 and will not allow an association attempt from a regular wireless client but only from
another Cisco infrastructure wireless device acting as client (like a non-root bridge or a WGB). Root bridge will deny
the association to a regular wireless client trying to associate by sending an association response with invalid status
code, while sending association responses with successful status code to Cisco infrastructure devices. They recognize
each other because, besides Cisco WLCCP, they use Cisco Aironet IE (Information Elements) during the association
handshake, as the ones you can see from the packet capture in Figure 3-4, where the association request from a non-
root bridge is selected to display the Cisco Information Elements it supports (also known as Cisco Aironet Extensions,
or CCX).
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Figure 3-4 Cisco Non-Root Bridge Association Request

The following are highlighted on the output frame: 802.11 radio information, 802.1Q virtual LAN, PRI:0, DEI:
0, ID: 3, 0000 0000 0011  ID: 3, Cisco wireless LAN context control protocol, station MAC, and association
VLAN ID: 3.

When configuring the bridge role at the interface level, you can use the command station-role root bridge to limit the
connections to non-root bridges and WGBs only. If you need to allow regular clients to connect on that root bridge you
can configure the role as station-role root bridge wireless-clients. Adding the “wireless-clients” keyword configures
the root bridge to perform wireless bridge links with Cisco infrastructure clients as explained before, but at the same
time also allows regular wireless clients to associate as if the root bridge were a normal 802.11 access point. The same
logic is possible with the non-root bridge role. Use the command station-role non-root wireless-clients to configure
the non-root bridge as an infrastructure client that will associate with a root bridge and establish the bridge link, but also
as an access point to allow associations from regular wireless clients. Just be aware that, in these cases, the same radio is
sharing the medium/air-time (and transmit opportunity, performing contention, scanning, etc.) between the two roles, so
we can say it is literally sometimes bridging to the other side and sometimes acting as AP for clients.

Workgroup Bridge

Widely used in different designs, the WGB is a versatile wireless client that associates to a root bridge or an AP (Cisco
autonomous or lightweight, or even third-party AP) to pass traffic for one or multiple devices connected to its Ethernet
interface (connecting those remote devices back to the infrastructure where it wirelessly associates). This is a powerful
wireless client that could be static or mobile, using internal antennas or external antennas that better fit the requirements
(such as when directional antennas are used to point directly to the root and better align/focus the RF signal for long
distances).

Because this WGB role is not defined by the 802.11 standard, its Wi-Fi implementation is proprietary, and this is why
you normally can’t connect a WGB (or similar type of device) from a given brand to a root wireless device of a
different brand; in the end, the WGB is not really an 802.11 STA normal client. The WGB is truly a proprietary
infrastructure client (where its infrastructure behavior is defined by the vendor, in this case, Cisco).

Cisco also developed for its IOS Autonomous WGBs the Universal mode (radio role: station-role workgroup-bridge
universal), where the WGB basically acts as a regular 802.11 wireless client (normal client) using the MAC address of
the device directly connected to its Ethernet interface as the Wi-Fi and only MAC address that the root AP will see.
This limits the capabilities of a WGB but allows normal associations with any 802.11 access point (from any vendor),
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because it basically follows the standard rules acting as an external Wi-Fi NIC for the device directly connected to its
Ethernet interface.

If the radio role is instead station-role workgroup-bridge (not Universal mode but implicit Cisco mode, which is the
typical and most used WGB mode), the WGB behaves as an infrastructure client. There, the rules change, and thanks to
the capabilities of a Cisco IOS WGB, more options are available. You can now have multiple devices (and hence MAC
addresses) behind the WGB by connecting a switch to the WGB’s Ethernet interface. You can connect a router and
have several devices/MACs behind that router’s MAC. You can also have the wired clients use different VLANs. You
also have the flexibility of treating multicast traffic in different ways (more on this topic later in a separate section),
enhancements for mobile environments, and more. Such capabilities are advertised by Cisco Aironet IE and use
IAPP/WLCCP packets, just like root/non-root bridges, as explained before; this is the reason why Aironet IE must be
configured/enabled in the SSID of the root side when connecting these WGBs, even when connecting them to
lightweight APs/WLCs.

In this role (Cisco mode WGB), you often have multiple devices behind the WGB, which are usually connected to a
switch that is directly connected to the WGB’s Ethernet port (similar topology as the one in Figure 3-2). By using a
switch that supports 802.1Q VLAN tagging and trunks, you could have WGB clients in separate VLANs, and the
switchport where the WGB directly connects will be a trunk allowing all those needed VLANs (VLANs should
obviously exist and be allowed as well at the root side where the WGB wirelessly associates). You configure VLANs in
these Cisco IOS WGBs the same way as explained before in the bridges section, with subinterfaces and bridge-groups,
but there are some variants that deserve further explanation:

No VLANs required: If your wired clients are all in the same VLAN, you can keep the default WGB
configuration, with the physical interfaces (Ethernet, radio) linked by bridge-group 1. Your BVI1 interface will also
have an IP address in the subnet associated to that VLAN. The WGB and its clients will then all be in the VLAN
assigned to the SSID on the root bridge or AP.

VLANs when connecting to an IOS Autonomous Root: If your wired clients are in different VLANs and the
WGB connects to an autonomous AP, configure the WGB with VLANs as explained previously in the bridges
section; configure in the WGB the VLANs required by using subinterfaces and bridge-groups, leaving the WGB
management (BVI1) interface in the native VLAN (and assigning this VLAN ID to the SSID configuration). The
autonomous root (can be root AP or root bridge) should have at least the same VLANs configured, but the root
could also have other extra VLANs configured that could be used for other SSIDs (if root AP) or for other bridge
links, and not necessarily for that specific WGB link.

VLANs when connecting to an AireOS lightweight AP/WLC: If your wired clients are in different VLANs and
the WGB associates to an AP connected to a WLC, configure the WGB with the needed VLANs by using
subinterfaces and bridge-groups as shown previously. You also need to do the following:

Configure the WGB with the global config command workgroup-bridge unified-vlan-client so the WGB can
advertise to the WLC the VLANs to be used for the wired clients (the WGB native VLAN/BVI1 interface will
be in the VLAN assigned by the SSID).

Configure the WLC with the command config wgb vlan enable so the controller can support the VLANs
advertised by the WGB.

Just one extra VLAN for clients behind the WGB not using VLAN tagging: If you want to have the WGB
(BVI1) IP address in its own management subnet/VLAN and put all the devices behind in a separate VLAN by
connecting to the WGB’s Ethernet port a hub or switch that is not capable of doing 802.1Q tagging/trunk (or even
just directly connecting to the WGB a PC or client device that can’t do VLAN tagging), you do something similar
by configuring the VLANs required using subinterfaces and bridge-groups, leaving the WGB management (BVI1)
interface in the native VLAN (and assigning this VLAN ID to the SSID configuration). The root side should allow
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both VLANs, and its SSID VLAN should be the WGB’s native VLAN (the one where you want the WGB to get its
IP address, just like in the previous scenarios). Then, all you have to do is specify the client VLAN at the WGB
with the command workgroup-bridge client-vlan <VLAN-ID>, and with this, the WGB will use that one VLAN
only for its Ethernet interface without tagging (leaving all the devices behind in this VLAN), but 802.1Q tagging
with this VLAN ID over the air (radio interface) to let the root side know that the WGB clients should belong to
that VLAN.

Note

When connecting the WGB to a Cisco IOS autonomous root AP, the radio interface command infrastructure-client is
required at the root to support VLANs with the WGBs connected to it. This command/feature will allow the
autonomous root to treat (and trust) a Cisco mode WGB as an infrastructure client, because it will speak IAPP/WLCCP
and 802.1Q VLAN tagging only with trusted infrastructure clients (not with devices that the root AP considers normal
clients).

Note that this command is required only in the root AP side, not the WGB side; the WGB simply needs to be in the
implicit Cisco mode (not universal) and have the VLANs properly configured.

You can see the devices learned by the WGBs (similar for root and non-root bridges) and their assigned bridge-group
(hence VLAN) by using the command show bridge. Example 3-6 shows an output of this command.

Example 3-6 show bridge Command Output

Click here to view code image

WGB# show bridge
Total of 300 station blocks, 294 free
Codes: P - permanent, S - self

Bridge Group 1:
    Address       Action   Interface       Age   RX count   TX count
34db.fd22.f1d0   forward   Vi0.2             0          0          0
f09e.6342.32f7   forward   Vi0.2             0          1          0

Bridge Group 3:
101f.7469.fffd   forward   Gi0.3             0       1618       1065           
f09e.6342.32e7   forward   Vi0.3             0       1066       1292

As you can see, these IOS autonomous WLAN devices have their bridge table populated with all the MAC addresses
that they have learned (like a switch MAC-address table), segregated by bridge-groups, based on the VLAN where the
device is located, along with the interface each MAC address was learned from. You can see if the address was learned
over the GigabitEthernet interface (like the entry highlighted in Example 3-6, which is for a wired client behind the
WGB, heard and classified through the subinterface known as Gi0.3) or over a radio interface via the wireless link (such
as all the other MAC addresses in the output, which are learned by this WGB in the example via the wireless/radio
interfaces identified as Vi—for Virtual, classified based on their VLAN/subinterface/bridge-group. These are MAC
addresses coming from the root side; they can be other wired devices behind the root or wireless clients associated to
the root). As can be concluded, two MAC addresses were learned over the native VLAN (Bridge Group 1) and two
other MAC addresses were learned over the VLAN/subinterfaces created for Bridge Group 3.

Something important to consider with WGBs and the bridge table they create is the behavior of the wired devices
behind the WGB; specifically, the so-called passive client behavior. If a wired client behind the WGB doesn’t transmit
traffic for an extended period of time, the WGB will remove the device from its bridge table (or if the wired client never
starts some traffic when coming up for the first time or after getting deleted, the WGB will never populate its bridge
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table with the MAC address of that wired client). Consequently, traffic destined to a wired client (behind the WGB)
that is not in the WGB’s bridge table will be lost.

Hence, to avoid traffic loss for such passive wired devices, you can do the following:

Increase the aging-out timer: This will prevent early deletions from the bridge table by configuring the aging time
in seconds (between 10 and 1,000,000 seconds), which is the amount of time the WGB will wait before removing a
client that has been idle/inactive (from the last moment it sent traffic) in a specific bridge-group. This is mainly
helpful for devices that are not completely passive but are not very active or that just send some traffic in between
long periods of time. The global configuration mode command to modify this timer (in seconds) is bridge <1-255>
aging-time <10-1000000>.

Add static/manual MAC address entries to the bridge table: By doing this, the devices’ MAC addresses
configured manually will always be present in the bridge table, without aging (so will not get deleted). Just use the
global configuration mode command bridge <1-255> address H.H.H forward gigabitEthernet 0.

Mobile WGB

Used in a mobile deployment—for example, in transportation (such as connecting trains to Wi-Fi in subways) or health
care (medical equipment carts that use the WGB as their Wi-Fi NIC to be always connected anywhere there is WLAN
coverage), the WGB needs to meet requirements that are normally expected from a regular mobile client; that is, make
appropriate decisions about when and where to roam, perform Fast-Secure roaming if EAP authentication is used,
implement smart scanning, and others. The Cisco IOS autonomous WGBs let you set up some settings that help with
such mobile requirements.

For Fast-Secure roaming (methods used to perform fast roaming when secure Wi-Fi authentication is used, by avoiding
the reauthentication when moving between APs using caching techniques), as of this writing in early 2018, Cisco WGBs
only support CCKM as a Fast-Secure roaming method, which means that the infrastructure WLAN/SSID where the
WGB connects should also be configured to allow CCKM for this Fast-Secure roaming to occur. All you need in the
WGB setup is the following SSID configuration command option for the key management method, and the rest of the
SSID configuration is the same as for WPA/WPA2 enterprise (more about security later in this chapter): authentication
key-management cckm.

By default, when looking for the best root (for initial association or to roam), the WGB scans all country channels
supported in its regulatory domain, so you can imagine that it takes some time for the WGB to finish scanning all
channels (a lot more channels exist in the 5 GHz band than in 2.4 GHz, and if there’s a DFS channel, scanning takes
even longer because it must be done via passive scanning—waiting to hear beacons instead of actively probing). So to
accelerate roaming, it is recommended to configure the WGB to scan only the channels that are used by the WLAN
infrastructure; for example, if you’re using the 2.4 GHz band and the infrastructure root APs are configured only for
channels 1, 6, and 11 (as they should), then configure the WGB radio interface command mobile station scan 1 6 11 to
scan only those three channels.

But when is the WGB going to start the roaming? Because no specific 802.11 rules force/trigger a Wi-Fi roaming, each
client vendor relies on multiple factors to trigger a roaming decision, such as current root beacon loss, current signal
quality going down (and if available, other roots around heard with better signal quality), shifting down to low data rate,
packet retries and loss, and others. WGBs work with most of the typical triggers for a roaming event, but the following
three can be manipulated:

Packet retries: By default, if the WGB (or non-root bridge) reaches the maximum packet retries because it never
received an ACK for a data frame that is trying to transmit to the root parent, it will start roaming and disassociate
from the current root. One single packet that was never confirmed to be received by the root will trigger this event,
so you can not only manipulate the amount of retries required to take this decision but can tell the WGB to better
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drop the actual frame that has not been ACK (give up the transmission) instead of deliberately giving up to current
association. This behavior is modified with the WGB (or non-root bridge) radio interface command packet retries
<number of max retries> [drop].

RSSI monitoring: With the radio interface command mobile station period <seconds> threshold <RSSI>,
WGBs can proactively scan their current root signal quality every “period <seconds>”, and if the signal perceived
at that time is below the “threshold <RSSI>” value (configured as positive integer, but truly meaning a normal
−dBm measured signal), then roaming will be triggered. Ideally, you should do enough testing in the environment
(roaming between APs) to confirm what the best values are for your deployment, because this could cause the
WGB to never roam when you expect it or to roam too frequently (which could be too aggressive). In general
terms, the time period value should not be lower than what it takes for the WGB to complete full association and
secure authentication to avoid a roaming loop, so 2–4 seconds is recommended, depending on the
setup/environment. The threshold RSSI value highly depends on the design and the expected signal quality at the
root APs’ cell edges; that is, if the WLAN infrastructure is designed for the APs to provide coverage at a minimum
of −70 dBm, you would normally expect the clients to roam to a nearby AP, perceived with better signal, when they
reach their current cell edge (−70 dBm). Hence, this should be the RSSI value configured in the command for the
WGB to trigger roaming to the next AP by the time it reaches the current edge (assuming the design is good enough
for the WGB to find another good candidate root parent with a better signal; otherwise, this will trigger constant
roaming in a very aggressive behavior, without truly finding another good option to roam and stay). The cells’ edge
RSSI is supposed to be derived based on your wireless clients’ applications/services requirements, which is normally
also tied up to the minimum data-rate speed required to support the app/service. Therefore, you should not only
consider the minimum RSSI of the connection but also the minimum data rate, and in fact, using this command can
also trigger a “roaming by data-rate change,” even if the new data rate is still good enough (which is too
aggressive). This is why the RSSI monitoring feature should always be used together with the following feature,
minimum data rate.

Minimum Data Rate: Used together with the previous feature/command, the radio interface command mobile
station minimum-rate <data-rate> will prevent the WGB from triggering a roaming event unless the current
connection has dropped below the configured data rate. If the current connection data rate is good enough to
support the clients’ applications/services, why roam to another AP and go over another association/authentication
handshake that could disrupt current services? Remember that the data rate will definitely drop if the current signal
quality—RSSI and SNR—drops to a level where the current data rate can’t be sustained. After the connection data
rate drops below the minimum required for your design, and the current RSSI is below your cell edge, it is a good
time to trigger roaming, and this will happen in a smart and controlled way thanks to these last two
features/commands.

Workgroup Bridges for High-Speed Roaming

In some deployments, the WGB could be moving (and hence roaming) at high speeds, much faster than regular mobile
clients; for example, when the WGB is installed in high-speed rail coaches to provide them with connectivity. As the
train moves, the WGB in the coach roams from one root AP to the next one installed along the railway track.

In such scenarios, train speed could be about 100 km/h, with the root APs placed about 200–300 meters apart along the
track. The only way for the WGB to support roaming between those APs while moving at such high speeds is by
configuring some required settings for high-speed roaming in the entire WLAN deployment.

First, as of this writing in early 2018, this is supported only by Cisco Aironet 3600 and 3700 series APs acting as WGBs,
and they must associate to a WLAN infrastructure that supports 802.11v BSS Transition. So if the root APs along the
railway track are lightweight APs managed by a WLC, the WLAN/SSID at the controller must have 802.11v BSS
Transition enabled. This allows for the WGB to receive (and request) neighbor list information, which is provided by the
current root AP, and helps the WGB to identify possible next root APs to roam to (and their channels). Knowing their
channels helps the WGB perform a more efficient and faster scan when roaming.
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Then, using the radio interface drssi commands, you can get the 3600/3700 WGBs to perform high-speed roaming. For
example, using the radio interface command drssi roaming threshold 67 period 1 packet 20, you can do the
following:

When the current root AP is perceived with an RSSI level below the threshold configured (which represents the real
RSSI of a connection, so value 67 is truly −67 dBm), the WGB will start scanning to roam to a better root AP. It is
recommended to set this threshold about 2 to 3 dBm below the average RSSI level in the middle point between two
APs on the track.

The period value controls how often the WGB decides to evaluate the quality of the link with the current parent. It
is the minimum time (in seconds) between scans. So if the train is moving very fast, you want the evaluation to
happen more frequently (short period value), but if the speed is slow, it is better to avoid frequent scans (where
WGB needs to go off channel constantly) by configuring a longer period.

The packet value is the number of sample data packets from the current root AP that the WGB uses to keep track
of the current link quality. The WGB maintains an RSSI average from the last data packets (last 20 per our sample
command drssi roaming threshold 67 period 1 packet 20), and if this average RSSI falls below the RSSI threshold
configured in this command, the WGB will initiate a roam. Hence, if the train is moving very fast, the
recommendation is to use a small number of packet samples to calculate this average RSSI.

This specific configuration, drssi roaming threshold 67 period 1 packet 20, works well up to a speed of 100 km/h;
this configuration has been tested and is recommended under those circumstances. Depending on the speed, design, and
requirements, you will need to calculate and fully test the appropriate values for the specific environment.

The other helpful radio interface drssi command is drssi scan-only current-neighbor-list. With this configured, the
WGB scans only the neighbors list that is received (thanks to 802.11v BSS) from the last associated AP. You can also
disable this command (no drssi scan-only current-neighbor-list) so that the WGB ages out the neighbors list gradually
(the age-out factor is reduced by 1 for every roam).

Cisco IOS Autonomous Security

Several security settings and protocols are supported in the Cisco IOS autonomous APs, bridges, and WGBs. Some are
implemented by default, and others can be modified or depend on the configuration/setup/design. Some of them are
ported from the core of Cisco IOS and are not even wireless related but are security features that could apply to
multiple Cisco IOS networking devices, like routers and switches (for example, IOS device’s SSH and crypto
implementations).

This section of the book covers only the most specific wireless security settings applicable to the wireless autonomous
deployments covered so far, which are based on the CCIE blueprint.

Layer 2 Wireless Security

The Cisco IOS autonomous WLAN devices support all the Layer 2 security methods defined by the 802.11 standard as
of the writing of this book, from open system authentication (without encryption and with static WEP or even dynamic
WEP using 802.1X/EAP) to shared key authentication, as well as all flavors of WPA (versions 1 and 2) as summarized
in Table 3-1.

Table 3-1 WPA/WPA2 Layer 2 Security Frameworks

 WPA (or WPAv1) WPA2 (or WPAv2)

Personal
Authentication: PSK (Preshared Key) Authentication: PSK (Preshared Key)
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Personal
Encryption: TKIP Encryption: AES-CCMP

Enterprise
Authentication: 802.1X/EAP

Encryption: TKIP

Authentication: 802.1X/EAP

Encryption: AES-CCMP

You can even do MAC address authentication (against a local list or against a RADIUS server), which is not really a
security authentication method defined by the standard (there’s nothing to configure on the client side, just validation of
its MAC address at the root side), and even combine MAC address authentication and/or EAP authentication. We do
not cover all those security methods in this chapter but will share some important guidelines for deploying WPA/WPA2
methods in Cisco IOS autonomous APs and bridges/WGBs.

Remember that when doing WPA/WPA2 Enterprise with an 802.1X/EAP authentication method, the specifics of the
actual EAP method to be deployed are implemented/configured at the authentication server and the client supplicant,
not at the authenticator, which is the role of a root AP or root bridge when authenticating wireless clients. Therefore,
the basic configuration in IOS autonomous WLAN devices is as general and simple as described in Table 3-1; you don’t
need to specify the EAP method to be used or add credentials or certificates or any other details. The base setup is
divided into two sections:

SSID configuration: At the SSID configuration level, you define the authentication method (open system
authentication + EAP or PSK) and the key management method (whether it is the certified WPA/WPA2 key
management or the Cisco version for Fast-Secure roaming known as CCKM, which is used a lot for WGB mobile
deployments as explained earlier).

Radio encryption: At the radio interface configuration level, you define the encryption cipher (TKIP or AES-
CCMP) to be used for the SSID (or for the SSIDs if configuring a root with multiple SSIDs for different VLANs, in
which case the encryption is specified per VLAN).

So if you want to configure WPA2 Personal, Example 3-7 gives you the security commands required for the
configuration of the SSID settings.

Example 3-7 WPA2 Personal SSID Configuration

Click here to view code image

Bridge(config)# dot11 ssid WPA2-PSK
Bridge(config-ssid)# authentication open
Bridge(config-ssid)# authentication key-management wpa version 2
Bridge(config-ssid)# wpa-psk ascii <YOUR-PSK>
But if you want to configure WPA2 Enterprise, the configuration is similar to Example 3-8.

Example 3-8 WPA2 Enterprise SSID Configuration

Click here to view code image

Bridge(config)# dot11 ssid WPA2-EAP
Bridge(config-ssid)# authentication open eap eap_methods
Bridge(config-ssid)# authentication network-eap eap_methods
Bridge(config-ssid)# authentication key-management wpa version 2
If CCKM will be used for Fast-Secure roaming, the only change needed is on the key-management command, using the
following instead: authentication key-management cckm.

Note
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There has always been confusion about the use of Open with EAP (authentication open eap) versus Network-EAP
(authentication network-eap), or both together.

In summary, the Network-EAP authentication option was developed for Aironet/CCX products to negotiate LEAP
authentication during the initial 802.11 authentication request/response handshake, back in the days when there was no
WPA or 802.11 standard security other than open system authentication (without encryption or with insecure WEP
encryption) or shared key authentication. This was one of the first attempts to implement 802.1X/EAP over Wi-Fi in
order to add some type of security with client-credentials authentication, other than basically nothing (Open System) or
a WEP key validation.

That was achieved (or initially negotiated to then perform LEAP authentication with 802.1X) by getting the
Aironet/CCX products to modify the 802.11 authentication type value during the initial 802.11 authentication
request/response. If the Cisco AP is configured to use Network EAP as the only accept authentication type, then the
LEAP-enabled client must use a value of 0x80 for the authentication type or the AP will ignore the client. If the Cisco
AP is configured to use both Open and Network EAP, the client can use either 0x00 or 0x80 for the accept
authentication type, where Open (or 0x00) means open system authentication and Network EAP (or 0x80) basically
means LEAP.

In the end, after the proper usage of 802.1X/EAP methods was introduced to Wi-Fi in a certified way (WPA/WPA2
Enterprise), that Cisco version was completely deprecated, and 802.1X/EAP is basically negotiated during the
association request/response handshake, when open system authentication (or 0x00) is successful, and just to let the
client know that it has to start any type of 802.1X/EAP method with a RADIUS server after the association handshake
is successful.

Therefore, to perform any EAP method (other than LEAP) when using a root AP/bridge in IOS Autonomous mode, the
SSID must be configured using Open with EAP (authentication open eap), but it is important to note that Network-
EAP (authentication network-eap) is still recommended if the client is a Cisco Aironet device (such as a non-root
bridge or WGB), because they still use this value of 0x80 for the authentication type to confirm that any form of EAP
will follow after this initial authentication request/response.

After the authentication method and key management are defined at the SSID level, you specify the encryption cipher
for WPA (TKIP) or WPA2 (AES-CCMP) at the radio interface level using one of the options highlighted in the help
command output of Example 3-9.

Example 3-9 Radio Interface Encryption Command Output

Click here to view code image

Bridge(config)# interface Dot11Radio0 (or Dot11Radio1)
Bridge(config-if)# encryption mode ciphers ?
  aes-ccm    WPA AES CCMP                                                        
  ckip       Cisco Per packet key hashing
  ckip-cmic  Cisco Per packet key hashing and MIC (MMH)
  cmic       Cisco MIC (MMH)
  tkip       WPA Temporal Key encryption                                         
  wep128     128 bit key
  wep40      40 bit key

Note

When using VLANs in IOS autonomous devices, you could configure multiple SSIDs and assign each SSID to a
different VLAN, but this is done in the autonomous devices with the role of root AP to segregate wireless clients in
separate SSIDs/VLANs (each SSID with its own security method). The behavior and setup is just like that of a
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lightweight AP managed by a WLC.

However, when doing a wireless bridge link, such as the ones in the deployment models described in this chapter (with
non-roots or WGBs connecting to roots), you need only one single SSID configured with the native VLAN assigned, as
explained earlier. This unique SSID is used to establish the bridge-link/association between bridges, and it will “trunk”
all the other VLANs configured/allowed in the devices. The bridge-link is secured with whatever security method you
want to implement for the SSID, such as the methods discussed in this section, but the recommendation is always to use
WPA2 Enterprise with a secure EAP method (such as EAP-TLS, EAP-FAST, or even PEAP-MSCHAPv2, as long as
your RADIUS server supports the specific EAP method).

Therefore, if VLANs are configured and assigned to the SSID(s), and the SSID security method requires encryption, you
need to specify, for the cipher option, the VLAN ID that is assigned to the SSID that will be using this encryption. So if
the SSID is doing WPA2 and is assigned to VLAN 10, the radio interface command will be encryption vlan 10 mode
ciphers aes-ccm.

Those SSID and radio interface configuration settings are required on both sides, root and client (non-root or WGB).
Remember that you also need to link the SSID to the radio interface that will be using it (whether you use this security
or not; this is required even for open system authentication), by configuring the SSID at the radio interface
configuration level on both sides, something like the following:

Click here to view code image

Bridge(config)# interface dot11Radio 1
Bridge(config-if)# ssid WPA2-EAP
Then, at the root (only here, at the authenticator), if doing 802.1X/EAP, you have to specify what the RADIUS server is
(which will be performing the actual EAP authentication). This is accomplished with the IOS AAA commands
(remember that in IOS, you need to first configure the command aaa new-model to support the AAA commands, such
as the ones that we will be explaining here).

Note that the SSID configuration-level authentication commands authentication open eap eap_methods or
authentication network-eap eap_methods are in fact calling a list that you can name as you want. In this example, it is
called “eap_methods” (which is also the default name if you happen to use the GUI for this configuration). This list
name is used to link the SSID authentication method with the AAA commands that define the type of authentication
login that will be performed (and if used or needed, even for authorization or accounting commands), which is basically
represented with the following single global configuration command when we want to do simple network login
authentication for users with 802.1X/EAP: aaa authentication login eap_methods group rad_eap.

That AAA authentication login command ends with the “rad_eap” name, which points to a group of servers (each group
could have one or more servers) that will be acting as the authentication server(s) for the EAP method to be deployed;
the group is named like that—rad_eap. Therefore, you still need to have that server group configured somewhere,
specifying that the server group will be used for RADIUS authentication, and within the group configuration, calling out
the actual servers. This is done with the global configuration commands in Example 3-10.

Example 3-10 Radius Server Group Configuration

Click here to view code image

Root(config)# aaa group server radius rad_eap
Root(config-sg-radius)# server name MYSERVERNAME
In this RADIUS server group with the name rad_eap (also the default name if you use the GUI to configure this setup),
you could configure multiple servers in the priority order for failover. You can check (and test as many as you can
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during your exam preparation) the several options that IOS offers for these AAA services. Now the RADIUS server(s)
to be called out in the server groups must exist at the global configuration level, and that is where you specify the server
details, such as port numbers and shared-secret key. The RADIUS servers are added through the CLI in the latest IOS
codes by giving them names (locally significant names, not hostnames or real server names), which can be called out
somewhere else in the configuration, such as in the server groups, as demonstrated in Example 3-10. Example 3-11
shows this configuration.

Example 3-11 Adding a RADIUS Server

Click here to view code image

Root(config)# radius server MYSERVERNAME
Root(config-radius-server)# address ipv4 192.168.2.11 auth-port 1812 acct-port 1813
Root(config-radius-server)# key MYRADIUS-SHAREDSECRET
However, if you’re doing EAP, that is not the only difference between the root and the clients. Remember that the
clients are acting as EAP supplicants, so you need to set up further details at the client side, as explained in the next
topic.

802.1X Supplicant at the Non-Root/WGB

When the SSID is configured to authenticate the clients with 802.1X/EAP, doing some type of EAP authentication
method, the client side (non-root bridge or WGB in our examples) is acting as the 802.1X/EAP supplicant.
Consequently, the client needs to be configured with the specific EAP method settings required to be 802.1X/EAP
authenticated by the RADIUS server based on the EAP method selected (each EAP method has its own requirements
and options) and valid credentials.

The Cisco IOS autonomous WLAN devices acting as 802.1X/EAP supplicant clients support most of the commonly
used EAP methods in wireless, such as EAP-TLS, EAP-FAST/MSCHAPv2, and PEAP-MSCHAPv2. We do not cover
in this book all the different setups for each EAP method supported; several documents and configuration examples are
already available at Cisco.com and share the steps on how to configure each method when these devices are acting as
clients, such as the following:

How to Use aIOS WGB with EAP-TLS Authentication in a Cisco Unified Wireless Network:
https://www.cisco.com/c/en/us/support/docs/wireless/4400-series-wireless-lan-controllers/100864-wgb-eap-tls-
cuwn.html

Workgroup Bridges with PEAP Authentication Configuration Example:
https://www.cisco.com/c/en/us/support/docs/wireless/virtual-wireless-controller/115736-wgb-peap-00.html

We suggest that you check such documents and practice in your own lab as many methods as you can, especially the
ones that involve certificate management, such as EAP-TLS with client and root CA certificate or PEAP with root CA
certificate, because it would be good for you to get familiar with certificate management in these devices. This is
handled with very typical IOS certificate management/crypto PKI commands, so you can also find some good
documents related to this topic on other Cisco IOS products and technologies. Obviously, even if a configuration
example is using an old RADIUS server like ACS, you look for documentation on how to deploy the specific server
settings in your applicable RADIUS server, like ISE nowadays; remember that the configuration in the 802.1X/EAP
supplicant side is basically the same for each EAP method regardless of the RADIUS server used.

In this section, we use EAP-FAST/MSCHAPv2 as the EAP method for example purposes, which is highly
recommended because it is very secure, doesn’t involve certificate setup (so it is simple to deploy), and is supported by
the local RADIUS server that is covered in the next section. It is normally used in isolated autonomous deployments,

Chapter 3 Autonomous Deployments

124

Technet24
||||||||||||||||||||

||||||||||||||||||||

file:///C:/Users/MERRELL/Documents/eBook Converter/Oreilly Downloader/tmp/9780135162095/ch03.xhtml#ch03ex010
file:///C:/Users/MERRELL/Documents/eBook Converter/Oreilly Downloader/tmp/9780135162095/ch03.xhtml#ch03ex011
file:///C:/Users/MERRELL/Documents/eBook Converter/Oreilly Downloader/tmp/9780135162095/ch03_images.xhtml#p03ex11a
https://www.cisco.com/c/en/us/support/docs/wireless/4400-series-wireless-lan-controllers/100864-wgb-eap-tls-cuwn.html
https://www.cisco.com/c/en/us/support/docs/wireless/virtual-wireless-controller/115736-wgb-peap-00.html
https://technet24.ir
https://technet24.ir
https://technet24.ir


like the point-to-point or multipoint bridge links covered in this chapter, to do the full setup with a secure EAP method
by using only the autonomous WLAN devices involved in the bridge link(s) without the need of an extra server.

As mentioned earlier, we can divide the 802.1X/EAP supplicant configuration in two sections: the EAP method and the
credentials.

To define the EAP method, we configure an EAP profile. Example 3-12 shows how to set up such a profile for this
EAP-FAST example.

Example 3-12 EAP Profile for EAP-FAST

Click here to view code image

WGB(config)# eap profile EAP-METHOD
WGB(config-eap-profile)# method fast
Because this is EAP-FAST/MSCHAPv2 with automatic PAC provisioning, there is really nothing else to configure in
the profile—no EAP-FAST settings or anything special. The configuration shown in Example 3-12 is enough to specify
the EAP method and its settings. The next step is to define the credentials that will be used so that the client can be
authenticated by the server.

As we know, EAP clients need to provide some type of credentials to be validated by the authentication server; these
credentials could be certificates, tokens, or the typical username/password recipe, and so on. Even a combination of
some of them can be used as the client credentials—for example, for dual-factor authentication (that is, something you
know and something you have). For this flavor of EAP-FAST (with MSCHAPv2), the client receives a PAC
automatically provisioned by the server the first time it tries to authenticate (or every time the client needs to be
authenticated and its last PAC has already expired). This PAC is used to do some initial validation and to basically build
a TLS tunnel between the client supplicant and the authentication server to secure the actual client credentials
exchange/validation (similar to PEAP), validation that happens in this EAP method by using username/password
credentials doing MSCHAPv2 within that secure tunnel. This final client credentials validation is known as EAP-FAST
Phase Two.

You define these client credentials at the supplicant side of these IOS autonomous devices by configuring a dot1x
credentials profile, such as in Example 3-13.

Example 3-13 Dot1x Credentials Profile

Click here to view code image

WGB(config)# dot1x credentials EAP-CREDENTIALS
WGB(config-dot1x-creden)# username CLIENT-USERNAME
WGB(config-dot1x-creden)# password CLIENT-PASSWORD
A username and password are enough for this EAP-FAST/MSCHAPv2 authentication method, so all we have to do at
this point is to assign/enable the two profiles that we have created: the EAP profile and the dot1x credentials profile.

You enable, link, and utilize these profiles by assigning both profiles to the SSID that will be used for the wireless link,
and this basically builds up the 802.1X/EAP supplicant required to authenticate one of these IOS autonomous devices
as an EAP client. This is done at the SSID configuration level, as you can see in Example 3-14.

Example 3-14 Supplicant Profiles Assigned to SSID

Click here to view code image
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WGB(config)# dot11 ssid Bridging
WGB(config-ssid)# dot1x credentials EAP-CREDENTIALS
WGB(config-ssid)# dot1x eap profile EAP-METHOD
Again, the configuration of the profiles and this 802.1X/EAP supplicant setup can vary based on the EAP method
selected and its own requirements (for which you are supposed to be familiar, at least with the most common EAP
methods used in wireless), so make sure you test all the possible options for all the different EAP types, even if you
have to rely on an external RADIUS server and root CA to validate the EAP method you are testing.

Local RADIUS Server at the Root

When doing 802.1X/EAP authentication, you need a RADIUS server. The authenticator (in our case the root AP or root
bridge) should be configured to communicate with a RADIUS server to authenticate the clients with the specific EAP
method to be used. This is achieved with the configuration explained previously, which covered an example of how to
point the authenticator to RADIUS server(s), which could also be external servers (such as Cisco ISE).

The Cisco IOS autonomous root APs/bridges support a local RADIUS server feature, which let you enable the RADIUS
service in the AP/bridge itself, so the device can also play the role of the authentication server (which is already acting
as authenticator) and even for other authenticators (for other root APs/bridges using this device as their external
RADIUS server). This is helpful for deployments where you don’t have external RADIUS servers available but you still
want to configure a secure EAP method for the authentication. In this case, when you define the RADIUS server at the
global configuration level of the root acting as authenticator (as explained in a previous section with Example 3-11),
you configure it with the IP address of the AP/bridge that will have this local RADIUS server feature enabled (its BVI1
interface IP address). This obviously means that the root AP/bridge playing this RADIUS/authentication server role will
point to itself. (The RADIUS server still needs to be added globally but is configured with its own IP address.)

The local RADIUS server supports three authentication methods: MAC authentication and two Cisco developed EAP
authentication methods, LEAP and EAP-FAST. All three authentication methods are enabled/allowed by default when
the local RADIUS server feature is enabled, so as a good security practice, it is recommended to disable the methods
that won’t be used. For example, if the most secure and recommended method of the three is to be used (EAP-FAST),
then MAC and LEAP should be disabled, as in Example 3-15.

Example 3-15 Disable Authentication Methods in Local Server

Click here to view code image

Root(config)# radius-server local
Root(config-radsrv)# no authentication leap
Root(config-radsrv)# no authentication mac
Within that radius-server local configuration mode/section, you can also set up and modify other RADIUS server
settings, such as the following:

Add the AAA clients (NAS): The AAA client or Network Access Server (NAS) is basically the authenticator(s)
that will be using this RADIUS server to authenticate clients. So if you have a point-to-point bridge link, the root
bridge is acting as the authenticator, but if you configure this root with the local RADIUS server feature, this unit is
also acting as the authentication server. Hence, the NAS is itself, so you will be adding its own IP address as the
NAS within the local RADIUS server section and using a shared secret key that matches the one configured when
the RADIUS server to be used by this NAS/authenticator was globally added using the radius server configuration
settings (configured within the configuration mode Root(config-radius-server), as demonstrated in Example 3-11).

Configure specific EAP-FAST settings: EAP-FAST is a very good and secure EAP method with multiple variants
and options that we do not cover in this book. Still, it is important to mention that you can modify some of its
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settings at the server side when using the local RADIUS server feature (such as you would in Cisco ISE). For the
deployment models explained in this chapter (to authenticate non-root and workgroup bridges), you don’t normally
need to modify any of its default parameters in order to use the local RADIUS server with EAP-FAST, because the
default EAP-FAST settings that come with enabling the local RADIUS server will allow automatic PAC
provisioning and EAP-FAST with MSCHAPv2, which is basically the EAP-FAST flavor that the client (WGB/non-
root) supplicant supports to be authenticated with username/password credentials in a very simple and still secure
way.

Add users and groups: The local RADIUS server has its own internal database where you can add users (with their
corresponding passwords) and even create groups to group users together with specific settings/attributes (for
VLAN assignment based on group, for example, just like with AAA attributes coming from an external RADIUS
server to perform dynamic VLAN assignment based on identity/group). You can configure users, groups, and some
specific settings for them the same as in external RADIUS servers, like ISE, which are normally linked to an
external database (such as Active Directory) but that also have their own local database of users and groups, which
can be validated and get some policies applied, and so on.

As you can see, some good and typical basic options are available when using the local RADIUS server feature/service
in the IOS autonomous WLAN devices, which is obviously very limited when compared to external servers dedicated to
AAA services (an important limitation to note is that it can use only its internal local database to authenticate users; it
can’t point to an external database like Active Directory), but that is good enough for bridge links deployments as the
ones covered in this chapter.

You can troubleshoot the authentication attempts from the clients by running some association, dot11, aaa, and radius
debug commands at the root (authenticator) side, and even some radius local-server debugs if this unit is also acting as
the authentication server with the local RADIUS server service enabled (at the WGB/non-root client side, debug dot11
dot11radio 0/1 trace print uplink is normally the best to start with some troubleshooting). You can also easily check
whether any authentication attempts are happening and what is happening with them, helping to guide you on what or
where to check next, by just checking the server statistics in the device acting as the local RADIUS server, as
demonstrated with the output in Example 3-16.

Example 3-16 Local RADIUS Server Statistics

Click here to view code image

Root# show radius local-server statistics
Successes              : 1           Unknown usernames      : 0
Client blocks          : 0           Invalid passwords      : 0
Unknown NAS            : 0           Invalid packet from NAS: 4

NAS : 192.168.2.11
Successes              : 1           Unknown usernames      : 0
Client blocks          : 0           Invalid passwords      : 0
Corrupted packet       : 0           Unknown RADIUS message : 0
No username attribute  : 0           Missing auth attribute : 0
Shared key mismatch    : 0           Invalid state attribute: 0
Unknown EAP message    : 0           Unknown EAP auth type  : 2
Auto provision success : 1           Auto provision failure : 0
PAC refresh            : 0           Invalid PAC received   : 0

Username                  Successes  Failures  Blocks
bridge                            1         0       0

Filters
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When working with Cisco IOS autonomous WLAN devices, you can implement various types of filters, such as address
filters (Layer 2 MAC address and Layer 3 IP address filters), protocol filters (IP protocol/port and EtherType), and
even wireless association filters, in order to allow and/or deny certain traffic/devices through the APs/bridges. The way
to set up these filters is by using the very well-known Cisco IOS ACLs, where you create an ACL first (adding the
required lists to be permitted or denied), and then apply the ACLs somewhere. (If applied to an interface, you also need
to specify direction, so remember to refresh the ACL direction concepts when configuring them for these WLAN
devices.)

Let’s begin with the example of Layer 2 MAC address filters/ACLs. These types of filters are normally used when you
want to restrict one or very few MAC addresses, either because you want only those specific MAC addresses to be
allowed through the AP/bridge or you actually want those MAC addresses to be the only ones blocked (and any other
should work as normal). So if we want to block traffic through a root AP/bridge to the wired infrastructure for just one
MAC address (0123.1111.2222) coming from the wireless side (it could be the MAC from a bridge client, like a WGB
or non-root or from a client behind a bridge client), we create an ACL as in Example 3-17.

Example 3-17 Layer 2 MAC Address ACL

Click here to view code image

Root(config)# access-list ?
  <1-99>            IP standard access list
  <100-199>         IP extended access list
  <1100-1199>       Extended 48-bit MAC address access list
  <1300-1999>       IP standard access list (expanded range)
  <200-299>         Protocol type-code access list
  <2000-2699>       IP extended access list (expanded range)
  <700-799>         48-bit MAC address access list
  dynamic-extended  Extend the dynamic ACL absolute timer
Root(config)# access-list 700 deny 0123.1111.2222 0000.0000.0000
Root(config)# access-list 700 permit 0000.0000.0000 ffff.ffff.ffff
As you can see from the output of the first command with the help option, the reason why ACL number 700 is used for
this access list is because of the way access list numbering is organized in IOS, as you have probably learned in other
ACL studies: There is a range for standard ACLs, for extended ACL, or in this case, for Layer 2/MAC address ACLs.

At this point, the ACL needs to be applied somewhere, and if it is applied to an interface, we also need to specify its
direction, just like in other IOS devices, where you have to make sure the ACL is applied to the incoming traffic, the
outgoing traffic, or both, and depending on that, you select the interface that is receiving the traffic in or transmitting
the traffic out. As a good security (and efficiency) practice, you apply the ACL on the first interface that receives this
traffic, so the filtering decision can be applied as soon as the packet hits the device. Because we want to block traffic
coming from the wireless side to the network (wired infrastructure), we apply this ACL at the radio interface level in the
inbound direction, as in Example 3-18.

Example 3-18 Layer 2 ACL Applied on Radio Interface

Click here to view code image

Root(config)# interface Dot11Radio 1
Root(config-if)# l2-filter bridge-group-acl
Root(config-if)# bridge-group 1 input-address-list 700
If you’re using VLANs and the filter is for a specific VLAN, the ACL needs to be applied within the subinterface of the
VLAN, but only the application of the bridge-group command (with the ACL direction) happens at this subinterface
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level. The first command (l2-filter bridge-group-acl), which confirms the radio interface will be using a Layer 2 filter
somewhere in a bridge-group, is always applied at the physical interface level (not subinterface). Did you notice that the
ACL was applied to a bridge-group using a “not very familiar” command? This is specific for Layer 2 ACLs. They are
applied to bridge-groups in these APs/bridges, not the way most people apply IP ACLs (as we will see later). So, if you
would like to apply that ACL to VLAN 20, in subinterface Dot11Radio1.20, you would do it as in Example 3-19.

Example 3-19 Layer 2 ACL Applied to Subinterface

Click here to view code image

Root(config)# interface Dot11Radio 1
Root(config-if)# l2-filter bridge-group-acl
Root(config-if)# interface Dot11Radio1.20
Root(config-if)# bridge-group 20 input-address-list 700
When using these MAC address filters, all you are really doing is allowing or blocking traffic from those specific
addresses; so in our example, the MAC address could be from a wireless client that is associated (successfully
authenticated to the WLAN and ready to pass traffic, and therefore, utilizing an association ID in the root association
table and further resources). However, if instead of applying the MAC filter to an interface, you apply it as an
association filter, you can basically use that filter to allow wireless associations only from those MAC addresses in the
filter (and the rest of the MAC addresses will get their association denied). For example, if you have a point-to-point
bridge link and you want to use an association filter to allow association from only one specific non-root bridge with the
radio MAC address 0123.2222.3333, you create the filter ACL for that address, and then apply it with the global
configuration command dot11 association mac-list <700-799>, as in Example 3-20.

Example 3-20 Layer 2 Association Filter

Click here to view code image

Root(config)# access-list 701 permit 0123.2222.3333 0000.0000.0000
Root(config)# access-list 701 deny 0000.0000.0000 ffff.ffff.ffff
! Then apply it as an association filter
Root(config)# dot11 association mac-list 701
Alternatively, if you want to create filters to only permit or deny traffic to or from specific IP addresses, or for specific
protocols, as mentioned before, you create a typical Cisco IOS ACL (standard or extended and named ACLs are
supported). For example, if we have a point-to-point wireless bridge link and we want to block specific devices and
traffic coming from the main LAN infrastructure over the wireless link to the remote site, we can apply the ACL to
incoming traffic in the Ethernet interface (or subinterfaces if using VLANs) of the root bridge. So if the purpose is to
stop traffic from a specific server farm subnet (10.10.10.0/24) from reaching any device at the remote sites behind the
non-root bridges, and also deny traffic destined to TCP port 80 (for instance, if you don’t want to allow—from the main
location—access to HTTP web servers that could be located in the remote site), you could configure an ACL and apply
it as in Example 3-21.

Example 3-21 TCP/IP IOS ACL

Click here to view code image

Root(config)# access-list 101 deny   ip 10.10.10.0 0.0.0.255 any
Root(config)# access-list 101 deny   tcp any any eq www
Root(config)# access-list 101 permit ip any any
! Apply the ACL to the proper interface and applicable direction:
Root(config)# interface gigabitEthernet 0
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Root(config-if)# ip access-group 101 in
You can even configure time-based ACLs, which can be enabled or disabled for specific periods of time—for example,
if you want to have an ACL enabled during weekdays and not weekends. For this, you would create a global
configuration time-range specifying the weekdays/time, and then apply this time-range to the ACL you want to have
enabled only during that period of time.

It is important to note that you can apply ACLs at any of the two ends, the root or the client bridge (WGB or non-root),
depending on what is more efficient, required, expected, or simply requested. So make sure you understand and test all
different types of ACLs scenarios during your lab testing/preparation.

Radio Settings

So far, we have covered some features and configuration settings that are handled at the radio interface level, such as
the roles, the encryption, VLANs, applying ACLs, and others, which can be considered radio settings. This next section
is specifically about some of the wireless radio settings that are important to consider not only for the wireless CCIE but
also for live autonomous deployments.

Channels

For bridge links, the channel is defined only at the root, because the clients (non-root and workgroup bridges) are acting
as wireless clients and have to scan the channels available in the regulatory domain of the radio band selected until they
find the channel on which the root operates. This client scan can be passive scanning, listening for beacons, or active
scanning, proactively probing. In any case, the purpose is to find a root (on any supported channel) that is configured
with the same SSID, so the client can select it and start the association process. In the end, just like for regular wireless
associations, the client aligns to the channel used by the root parent selected, and this is the reason why you can’t even
configure channel settings or restrictions at the non-root or workgroup bridge clients level (other than the exception
already explained earlier in this chapter about the mobile station scan command that restricts the WGB to scan only
specific channels for faster roaming decisions).

At the root AP or bridge, you can leave the default channel setting for the root to select the “least-congested” channel,
which is a decision based on some initial scanning that the root performs in all country channels (allowed by the
regulatory domain of the AP/bridge model) to figure out what channel seems to be the best (least busy) when the device
decides to assign a specific channel to its radio interface. However, your root may end up with a non-optimal channel
with this technique. For example, if both channels 1 and 6 are busy, the root may choose channel 3 as the quietest. As
an RF expert, you know that choosing channel 1 and 6 (and sharing with another cell) is better than choosing channel 3
(and being sure to interfere with both channels 1 and 6). Alternatively, you can use the radio interface command
channel to specify a static channel number, or to let the radio interface dynamically select the channel it considers
(perceives) as the best by using the default commands channel least-congested for the 2.4 GHz radio or channel dfs
for the 5 GHz radio.

When configuring the 5 GHz radio of the root APs/bridges, you can not only specify channel width (for example, do 40
MHz channel bonding), but you can also block some specific 5 GHz bands so their channels are not selected by DFS
(dynamic frequency selection). For example, using the radio interface command dfs band 2 block, if the radio is
configured for dynamic channel assignment instead of static channel, the AP will never select (auto-assign) a channel
from the 5 GHz UNII-2 band. This example is a very good idea because remember that the UNII-2 band has some
restrictions and specific rules that can cause the radio to jump from the channels due to DFS events (like radar
detection), causing disruptions and even outages if, for example, your only root bridge connecting some remote
buildings is affected by such events.

Parents
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At the client level (non-root and workgroup bridges), you can’t configure the channel but you can specify the parent(s)
that it should look for when trying to associate, by using the radio interface command parent. You can configure up to
four parents (configuring the parent’s MAC addresses), and this is a way to tell the client that it should give priority to
those parents when looking for association, in the priority order that they were configured, insisting on a parent until it
gives up after the parent timeout period in case it can’t find it. After the timeout, it will look for another parent in the
list, and so on, until the list is finished. Then the client will try to associate with any other parent available.

Transmitter Power

Regarding the radio transmitter power-level settings, the default is always the maximum supported by the radio, but you
can use the radio interface power local command to specify the power level in case it needs to be decreased due to
design requirements. In addition, you can use the power client radio interface commands at the root, so it can tell the
client (using CCX messaging during the association phase) what transmitter power level to use; it could let the client use
its maximum transmitter power supported, tell it to use a specific power level (in dBm), or even tell the client to use the
same transmitter power as the one used by the root (with the command power client local). This last option, forcing the
clients to use the same power level as the root, is helpful in avoiding asymmetric RF links that could cause, for example,
the root to hear the client with a strong signal strength (because the client is using its maximum transmitter power) while
the client can’t hear the root very well if it is using a lower power. This kind of asymmetry could cause packet drops
and retransmissions, disconnects, and the like.

Antennas

Another important setting to consider is about the antennas, mainly when using external antennas, which is typical in
bridge links. The antennas are passive hardware devices attached to the AP/bridge connectors, but the radio can’t
recognize the antenna type/model or specs, so you need to specify the antenna gain with the radio interface command
antenna gain. The antenna will still propagate RF signals with its actual gain regardless of this command (again,
because it is a “passive” piece of hardware that can’t be configured, so its behavior can’t be modified), but the
importance of this command is that the AP/bridge can properly calculate transmitter power levels and adjust to
regulations depending on the channel used, helping you to avoid breaking the law when using an antenna that you
probably shouldn’t be using, mainly because these bridge links with external antennas are normally used in outdoor
environments, which could be more restricted.

Data Rates

The last key radio interface setting we want to cover is about the speed command, used for the data rates configuration.
Both radio interfaces have defaults allowing all supported data rates on each band, and the recommendation is usually
to disable the lowest data rates. This configuration not only applies to the well-known recommendation about disabling
the 802.11b (DSSS and HR-DSSS) data rates 1 Mbps, 2 Mbps, 5.5 Mbps, and 11 Mbps in the 2.4 GHz radio to avoid the
performance impact of using these rates (due to ERP protection, slow transmissions with 802.11b rates and with clients
connected far away from a good coverage area, and so on). It also helps design your coverage cell or bridge-link “edge”
looking for the minimum data rate that you expect to support for the type of traffic and applications that will be using
the wireless link (regardless of the radio band used). For example, if the requirements of a point-to-point bridge link for
a remote location is to keep a connection of at least 24 Mbps, this data rate will be your lowest rate enabled, and all the
ones below should be disabled; if the wireless link connection is not good enough to stay at or above this data rate, you
should not enable lower data rates. You should improve the wireless link with a better design (different position,
antennas, coverage, and so on) and use the lowest data rate to help you establish your coverage edge (clients out of that
“edge” just won’t associate or will have to drop or roam). The same logic applies to application services behind a WGB.
If their requirements demand keeping the connection above 12 Mbps, for example, you should disable all data rates
below 12 Mbps and leave at least this one as the required data rate.

Mandatory or required data rates are configured in the IOS autonomous WLAN devices using the “basic” word in the

Chapter 3 Autonomous Deployments

131

||||||||||||||||||||

||||||||||||||||||||

https://technet24.ir
https://technet24.ir


speed command; the following is an example of a data rate configuration that has rates 12 and 24 Mbps as the
required/mandatory rates, with 12 Mbps as the lowest allowed (all rates above also allowed):

Click here to view code image

WGB(config-if)# speed  basic-12.0 18.0 basic-24.0 36.0 48.0 54.0 m0-7 m10.
  m11. m12. m13. m14. m15. m8. m9.
Besides the fact that “basic” rates are required to be supported by clients to establish an association, these required
(basic) data rates have two very important functions:

First, the lowest required rate is used for important management frames, which conditions beacons, probes, and
association frames and therefore truly defines the coverage edge. This is why the lowest data rate allowed should
always be required/mandatory (basic). For example, you don’t want to allow a device to connect and try to work at
a rate of 6 Mbps when 12 Mbps is the lowest required data rate (assuming that you modify the configuration to also
allow 6 Mbps, but where 12 Mbps and 24 Mbps are still the only required/basic data rates). This is because even
when this configuration might allow the client to try to communicate (transmit data) with a signal quality that
permits only 6 Mbps, the client at this point can’t even demodulate beacons and other management frames, so in
the end it will give up the association looking for a better option if available. (If not available, it won’t even be able
to try to associate back with a root that is only transmitting management frames at rates that it can’t demodulate.)

In these Cisco IOS autonomous WLAN devices, multicast (and some broadcast) traffic is transmitted at the highest
required data rate. So in the previous command example where rates 12 and 24 Mbps are configured as required,
data rate 24 Mbps will be used as the one to transmit this type of traffic. This is very important to consider because,
using the same previous configuration, if you have, for example, application services behind a WGB that receive
multicast traffic, the WGB is mobile and sometimes moves around areas that keep the connection at rates lower
than 24 Mbps (which is allowed; remember it could stay connected at 12 or 18 Mbps per your root configuration),
then the WGB will be missing all the multicast traffic that it can’t demodulate because the root is transmitting it at
24 Mbps. This translates to WGB client applications not receiving their expected multicast traffic, even when the
WGB is properly associated and passing unicast traffic just fine.

Note

Remember that data rates used for Wi-Fi connections are not equal to real data throughput, meaning that you can’t
expect TCP/UDP upload and download transfer rates at 24 Mbps if this is the wireless data rate of the connection. Wi-
Fi is half-duplex in a medium contention environment using CSMA/CA techniques to contend for the wireless channel,
which is in the end shared not only with other Wi-Fi devices using the same channel but even with possible interferer
devices.

Because of the half-duplex, shared medium nature of 802.11, with CSMA/CA techniques, retransmissions, ACKs, and
so on, the real data throughput will always be around half or less than the actual 802.11 data rate, varying due to
environmental and multiple other factors that affect the wireless connection. Hence, make sure you clearly understand
the actual deployment (or application) requirements when dealing with these wireless data rates in the design and setup.

Multicast on Autonomous

As explained previously, multicast traffic is transmitted using the highest mandatory data rate configured in IOS
autonomous devices, but there are a few other important details to consider when dealing with both multicast and
broadcast traffic over the air.

Multicast and broadcast frames are not acknowledged (unlike unicast frames) as per 802.11. Hence, the transmitter of
the frame (say the AP transmitting a multicast frame to a WGB, where the final destination is an application on a client
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behind the WGB) has no idea if the frame was properly received and processed by the receiver/WGB. This decreases
reliability because if the frame couldn’t be processed by the receiver (due to a collision, for example), the transmitter
will not retransmit but simply assume that it was received and forget about it, or just transmit the next frame if there is
more.

So, why are multicast and broadcast frames not acknowledged if this affects reliability? Imagine one AP with 30
wireless clients, and one of them is a WGB that has some client machines that rely on multicast advertisements to
discover a service. The AP is transmitting one of those advertisements in a multicast frame down to the clients, and
because this is multicast, all clients associated to this BSSID receive the frame. Imagine the collision if all 30 clients
acknowledge the same frame! If somehow the AP receives some ACKs, it will have to retransmit because the ACK is
missing for some clients, but then their ACKs experience another collision, and so on. You can see the possible never-
ending cycle that could even eat up channel utilization, and so on, and conclude why it is not a good idea to
acknowledge multicast and broadcast frames.

But what if I want some reliability at least for the multicast advertisements of that application service in the previous
example, which is only required by the clients behind the WGB?

When the WGB is connected to autonomous IOS root APs (which also allow other regular clients), you can configure
the radio interface command infrastructure-client at the root AP for reliable multicast with WGBs only. With this
feature enabled, the AP treats the WGBs as infrastructure devices, as explained earlier in this chapter. (Remember that
root APs by default treat the WGB as another regular wireless client, a Cisco mode WGB, but still treated as a regular
client, unless the infrastructure-client feature is enabled at the root AP.) When the WGBs are treated as infrastructure
clients, they start exchanging ACKs for multicast data frames because the root AP will unicast a copy of each multicast
frame to every WGB associated. For example, if we have now one root AP with 30 clients, and 10 of them are WGBs,
the root AP will transmit the original multicast frame over the air, plus 10 copies transmitted as unicast frames, one to
each WGB (each one generating its own ACK). This extra load over the air is why the amount of infrastructure clients
supported by an autonomous IOS root AP (when this feature is enabled) is limited to 20 (therefore, make sure you
design properly if reliability is required).

So how are those multicast frames transmitted as unicast copies to each WGB? As explained at the beginning of this
chapter, Cisco IOS autonomous WLAN devices can communicate with each other as infrastructure devices using four
MAC addresses in the frame headers instead of three MAC addresses, so they can relay/bridge traffic that is truly
destined for others. In this case, now that the infrastructure-client feature is enabled at the root AP, and this root is
treating the 10 WGBs as infrastructure devices, it will transmit the multicast frame as unicast copies as follows:

The source address (SA) is the multicast source of the packet reaching the root AP Ethernet port; the transmitter
address (TA) is the root AP transmitting the frame over the air to the WGB; the receiver address (RA) is the specific
WGB receiving this unicast copy, and the destination address (DA) is the multicast address.

The 10 WGBs will receive their unicast copy (and ACK it) and will also receive the original multicast frame. To avoid
having the WGBs waste resources processing and transmitting two frames that are the same (copies), the WGB role
supports either of two modes shown in Example 3-22.

Example 3-22 WGB Multicast Modes

Click here to view code image

WGB(config)# interface d0 (or d1)
WGB(config-if)# station-role workgroup-bridge multicast mode ?
  client          Client-mode accepts only 3-MAC address header multicast
                  packets
  infrastructure  Infrastructure-mode accepts only 4-MAC address header
                  multicast packets
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As explained by the IOS command help, when configuring the multicast mode client, the WGB will accept and process
only the multicast packets received with the 3-MAC address header, which are the original multicast frames (and will
therefore ignore 4-address multicast frames sent in unicast containers). When configuring the WGB role with multicast
mode “infrastructure,” the WGB will accept and process only the multicast packets received with the 4-MAC address
header (the unicast copies of the multicast frames with the receiver address as that of the WGB) and will ignore the
general multicast frame. Based on this configuration, only one frame is transmitted by the WGB over its Ethernet port,
as a multicast packet simply bridged in the right VLAN where it arrived (in case multiple VLANs are configured in the
WGB).

It is important to note that multicast and broadcast traffic was previously not supported over multiple VLANs when the
WGB connected to lightweight APs in Local or Bridge/Mesh mode in a CUWN. Multicast and broadcast traffic could
be forwarded only over the native VLAN. However, starting in CUWN AireOS 8.3102.0 and Cisco IOS Autonomous
15.3(3)JD releases, you can now pass multicast and broadcast traffic over multiple VLANs when WGBs connect to
lightweight APs in Local or Bridge/Mesh mode. You still need to configure the support of this feature at both ends, the
WLC and WGB.

Note

The infrastructure-client feature is enabled at the root AP when the root is an autonomous IOS AP; there is no similar
option for lightweight APs, not even at the WLC level. Hence, there is no special reliable multicast in CUWN
specifically for autonomous IOS WGBs.

If reliable multicast is required in a CUWN WLAN, the option is the VideoStream feature (covered later in this book),
but this feature does not apply to WGBs only, like in autonomous IOS (other wireless clients could also be part of
reliable multicasts in that WLAN using VideoStream).

Assuming that multicast/broadcast forwarding is enabled at the WLC (as you will learn in Chapter 4, “AireOS
Appliance, Virtual, and Mobility Express Controllers”), you will also need to configure the WLAN used by the WGB
with the following command:

Click here to view code image

(Cisco Controller) >config wlan wgb broadcast-tagging {enable | disable}
   <wlan-id>
If the WGB already has the VLANs configured, you need to configure the following global configuration command:

Click here to view code image

WGB(config)# workgroup-bridge unified-vlan-client broadcast-replicate
Note

People tend to confuse the feature and command infrastructure-ssid with infrastructure-client explained so far, but
they are not the same. The infrastructure-ssid command is not even configured at the radio interface level but at the
SSID configuration level.

The infrastructure-ssid command can only be configured in an SSID assigned to the native VLAN at the root. When
the root is a Cisco IOS autonomous AP, you can have multiple SSIDs configured and assigned to different VLANs, and
WGBs can still connect to any of the SSIDs, even if the SSID is not in the root AP’s native VLAN and is not configured
as infrastructure-ssid. The WGB will simply pass traffic only in the VLAN assigned for that SSID (like other regular
wireless clients that connect to this SSID). So, for example, the WGB won’t be able to support multiple VLANs in that
case—only if it is connected to an infrastructure-ssid.
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For devices acting as root APs with multiple SSIDs configured, the restriction/validation is like this:

The SSID assigned to the native VLAN is the only one that can be configured as infrastructure-ssid.

If the other feature infrastructure-client is configured in the root radio interface and infrastructure-ssid is
configured in the SSID of the native VLAN, then WGBs will only be allowed to connect to the infrastructure-ssid
assigned to the native VLAN. Association will fail for the WGB if it tries to connect to other SSIDs.

If any of the two features is not configured (infrastructure-ssid or infrastructure-client), the root AP won’t apply
restrictions for the WGBs to associate so they will be allowed to connect to any of the SSIDs. The downside is that
you can’t support multiple VLANs at the WGB if it doesn’t associate to the SSID assigned to the native VLAN in
the root AP.

Root APs will still allow regular wireless clients to connect (as well as Cisco infrastructure devices) to an SSID
configured with the infrastructure-ssid; this is not to restrict regular clients from connecting but to restrict WGBs
to connecting only to this infrastructure-ssid when required.

Finally, when the Cisco IOS autonomous role is Root Bridge (for bridge links, as the ones explained at the beginning of
this chapter), the root always treats the Cisco non-root and workgroup bridge clients as infrastructure clients (with
reliable multicast/broadcast behavior, VLANs support, and so on), so there is no need to configure infrastructure-
client at the radio interface of a root bridge. In addition, besides the fact that you normally won’t configure more than
one SSID at a root bridge (just one SSID is enough for bridge links to non-root and workgroup bridges, and if you want
to allow regular clients, you can use the same SSID with the role “root bridge with wireless clients”), this role already
enforces the restriction that the SSID is only for infrastructure devices. (It will not allow regular clients but only
infrastructure Cisco clients, regardless of having infrastructure-ssid configured or not.)

Other than that, there is nothing else that you need to configure or set up in the Cisco IOS autonomous APs and bridges
to handle multicast traffic; all the multicast traffic that these devices receive is simply bridged as any other packet from
the received interface to the other(s). The only exceptions in behavior with multicast handling are the ones covered in
this section.

QoS for Bridging

Chapter 7, “WLAN Media and Application Services,” covers a lot of important details that you must understand about
QoS before even trying to implement it, and the chapter includes a specific section with best practices for the Cisco IOS
autonomous WLAN devices. Therefore, in this chapter we cover only a specific topic regarding QoS for bridge links.

As you learn in Chapter 7, there are some known QoS mappings to handle traffic between different protocols that might
use or support different QoS markings. For example, voice traffic is normally marked with value CoS (Class of Service)
5 by Layer 2 802.1 QoS marking on the Ethernet side, whereas the same voice traffic is normally marked with value UP
(User Priority) 6 by 802.11 Layer 2 QoS marking on the wireless side. You will also learn that the QoS techniques are
specific to the devices and their links with other devices in the network, so we can set up network devices in the path
between source and destination to treat and mark (or remark) traffic in a specific way when received, processed, and
transmitted.

Therefore, if we have, for example, a wireless bridge link that will be passing data and voice traffic, and we want to
apply some type of QoS to prioritize the voice traffic over the data traffic in this link, we need to consider the following
points:

Wireless bridges can only give priority to a packet when it is about to be transmitted over the air. So if a data packet
and a voice packet arrive at a bridge’s Ethernet interface at the same time, and we want the bridge to give some
priority to the voice packet when transmitting to the other bridge, what we really want (and can do) is to have the
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bridge put that voice packet into the Voice AC (access category) of the radio interface.

This access category is basically one of the four WMM queues that WLAN radios use to queue packets before
transmitting the frame over the air, each category with its own wireless medium access rules. The Voice access
category is the one that has better chances to transmit first over the air according to those rules (again, more details
on these topics and even QoS configurations in Chapter 7).

We can configure the bridge with a Cisco IOS policy-map (applied in the incoming direction of the Ethernet
interface) to set (remark) voice traffic with the 802.11 Layer 2 QoS value 6, so the packet can make it into the
voice access category (after it is converted from Ethernet frame to 802.11 frame) to be transmitted over the air with
some priority. Voice traffic can be identified based on Layer 2 or Layer 3 QoS marking (already in the voice
packet) using a Cisco IOS class-map, so it can be remarked by the policy-map.

You could configure another policy-map in the radio incoming direction, so once it receives the voice traffic from
the other bridge with 802.11 Layer 2 QoS value 6, it can remark the Layer 2 CoS value to 5 to be transmitted in the
Ethernet interface where Layer 2 802.1 QoS marking is used. This is actually needed if you trust CoS values at the
switchport where the bridges connect, but if you trust DSCP values at the switchports, this is not really needed
because the bridges will not modify the Layer 3 QoS marking of DSCP values. (A voice packet will keep the
original Layer 3 DSCP marking EF from the phone, for example, when packets pass through the wireless bridges.)

Instead of a policy-map, we could also configure at both ends/bridges the global configuration command dot11
priority-map avvid. This configuration setting recognizes and respects packets coming into the Ethernet interface
with a Layer 2 802.1 QoS value of 5 and automatically converts it to 802.11 Layer 2 QoS value 6, putting the voice
packets into the Voice access category.

Chapter 7 covers more details and configuration examples of Cisco IOS policy-maps and class-maps, but we
recommend that during your CCIE preparation you test multiple scenarios and options available for these settings in the
IOS autonomous devices, because during the lab exam you might need to configure some settings based on
requirements, and not just based on the typical scenarios. The idea is that you get familiar with how these settings can
be configured in these access points and bridges/WGBs, and keep in mind the specific limitations and behavior because
there are some differences when compared to Cisco IOS router or switch QoS settings. (It is recommended to check the
“Configuring QoS” chapter of the Cisco IOS Configuration Guides for Autonomous Aironet Access Points.)

Summary

Even when the autonomous WLAN devices almost “stopped” their evolution some time ago, they are still widely
deployed in multiple WLAN and IoT environments, mainly in designs where wireless bridges are required, such as the
ones discussed in this chapter.

All the topics and features required for you to understand and successfully deploy and troubleshoot Cisco IOS
autonomous bridges and WGBs were covered, not only for your CCIE journey but also for real-life environments where
an expert is expected to be involved. Make sure you practice all these topics and the many variants around them; check
all the options for every topic from configuration guides, command reference guides, examples or tech notes, from your
lab equipment (testing in one way or another, breaking things and making them work again after some troubleshooting),
and always use the current CCIE blueprint as your reference while you are getting ready for the exam.
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Chapter 4

AireOS Appliance, Virtual, and Mobility Express Controllers
The wireless LAN controller (WLC) is one of the core components of the Cisco Wi-Fi solutions and the main focus of
this chapter. In the next pages we will also refer to the term “AireOS” for a WLC, for Airespace (the former wireless
solutions vendor acquired by Cisco) operating system.

A WLC communicates with an access point (AP) through the Control and Provisioning of Wireless Access Points
(CAPWAP) protocol, specified in IETF RFC 5415, as well as IETF RFC 5416 for dedicated applications to 802.11-
based networks. CAPWAP is based on the former Lightweight Access Point Protocol (LWAPP), which Cisco replaced
with CAPWAP starting from the AireOS version 5.2.

Although you can find all the details for the CAPWAP protocol in the corresponding IETF RFCs, we would still like to
highlight some of its main features:

Split MAC and local MAC architectures. As already supported with LWAPP, CAPWAP allows 802.11 MAC
operations either to be split between the WLC and the AP or to stay almost completely localized at the AP’s level.

As also shown in Figure 4-1, the split MAC model is equivalent to the “classic” centralized mode, where traffic
from/to wireless clients flows inside the CAPWAP data tunnel and through the WLC. Real-time functions, such as
beacons and probes, are handled by the AP and non-real time functions are concentrated on the WLC, like 802.11
authentication and association frames.

Figure 4-1 Central Switching (Split MAC) and Local Switching (Local MAC)

The first illustration shows a client transferring data over the air to an AP, followed by the AP transferring
the data over the CAPWAP data tunnel to a WLC. The WLC transfers the data via 802.3 to the cloud. The
second illustration shows a client transferring data over the air to an AP, followed by an AP transferring the
data to a cloud via 802.3. After the cloud, WLC and another cloud are present.

With local MAC, all 802.11 MAC functions are performed at the AP level. Technically, this mode allows the
client’s traffic to be either locally switched at the AP level or tunneled in 802.3 frames to the WLC. The latter is not
supported by Cisco WLCs, and we can compare local MAC to FlexConnect local switching (and local
authentication too, if enabled).

An AP communicates with its WLC through two CAPWAP tunnels: a control tunnel on UDP port 5246 and a data
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tunnel on UDP port 5247. The CAPWAP control tunnel is always SSL/TLS secured, and we refer to SSL/TLS over
UDP as Datagram Transport Layer Security (DTLS). The CAPWAP data tunnel is not encrypted by default, but
you can optionally enable DTLS security on a per-AP basis or also globally for all APs.

The CAPWAP protocol integrates Path MTU (PMTU) discovery, which allows the AP and the WLC to
automatically discover and adjust the MTU supported on the link between them.

Among different WLC models we can distinguish between three main categories: appliance based, virtual, and Mobility
Express. Appliance-based controllers are the more common and “classic” models, supporting all the software features; a
typical example of an appliance-based WLC is the AIR-CT5508-K9. A virtual WLC (vWLC), although very close to an
appliance-based WLC in terms of supported features, is mainly recommended for FlexConnect deployments with local
switching. FlexConnect central switching is also supported on a vWLC, but it’s generally not recommended because of
its maximum throughput of 500 Mbps, which may limit future growth possibilities of the deployment itself. A vWLC
does not support some features for centrally switched architectures, such as APs in mesh (that is, Bridge) mode
(although Flex+Bridge is still supported), the mobility anchor role (although you can still deploy a vWLC as mobility
foreign), AVC profiles and NetFlow records for centrally switched WLANs, and others. More details on nonsupported
features for the vWLC can be found in the official release notes of each AireOS version (for example, “Release Notes
for Cisco Wireless Controllers and Lightweight Access Points for Cisco Wireless Release 8.3.130, 8.3.132.0, and
8.3.133.0”).

Central and FlexConnect locally switched architectures have been deployed for many years. You can find more details
on these operational modes in the official “Enterprise Mobility 8.1 Design Guide.” (More recent versions of this guide
are already available at the time of this book’s writing, but the current CCIE Wireless blueprint v3.1 is based on AireOS
8.3.) Nevertheless, we will still spend some time describing them to introduce some terms and conventions that we will
reuse in the next sections.

The centralized mode is the most classic deployment option, where wireless clients’ traffic is carried between the APs
and the WLC in the CAPWAP data tunnel. The WLC (or more precisely, its interface/VLAN, where clients are
switched) becomes the point of presence for wireless clients on the network.

Sometime this deployment option is also referred to as central switching, or centrally switched, although these naming
conventions are more used for FlexConnect local and central switching.

To make things easier to remember, when an AP is in the so called default “local” mode, as shown in Figure 4-2, the
traffic for all wireless clients is centrally switched through the WLC. Another option for switching traffic centrally is the
Bridge mode on the APs, which is used for mesh deployments (more on this in the dedicated section).
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Figure 4-2 Local Mode Configuration Under the AP’s Settings on the WLC GUI

The screenshot shows the Wireless menu selected from the main menu tabs at the top. Access Points section
under Wireless menu is expanded to reveal: All APs, Radios, and Global configuration. Radios is expanded to
list: 802.11a/n/ac, 802.11b/g/n, and Dual-Band Radios. FlexConnect Groups section lists: FlexConnect ACLs,
FlexConnect VLAN, and Templates. A page titled Details for AP-3702I.fcc4 shows six tabs from which
General is selected. The general tab shows three sections: General, Versions, and IP Config. The general section
lists the following: AP Name field box reading AP-3702I.fcc4, Location field box, AP MAC Address, Base
Radio MAC, Admin Status spin box set to Enable, AP Mode spin box set to local, AP Sub Mode spin box set to
None, Operational Status, Port Number, Venue Group spin box (Unspecified), and Venue Type spin box
(Unspecified). Three buttons, Add New Venue, Venue, and Language Name are shown. Under versions section,
the following information is listed: Primary Software Version, Backup Software Version, Predownload Status,
Predownloaded Version, Predownload Next Retry Time, Predownload Retry Count, Boot Version, IOS
Version, and Mini IOS Version. Under IP Config, CAPWAP Preferred Mode, DHCP Ipv4 Address, and Static
IP (Ipv4/Ipv6) checkbox are listed.

FlexConnect is the deployment mode that allows mixing and matching options for switching traffic centrally or locally.
The FlexConnect name was introduced as of AireOS 7.2 to replace the former Hybrid Remote Edge Access Point (H-
REAP). We describe FlexConnect architectures and options more in detail in a later section of this chapter, but a brief
introduction is still needed to clarify some terms and concepts used in the following paragraphs.

We use the expression local switching when a wireless client’s traffic is switched locally on a VLAN of the switch port
where the AP is connected, instead of centrally switched through the WLC.

The AP itself obtains its IP address from either the access VLAN of a port in access mode or the native VLAN of a
trunk port. Wireless clients can be locally switched on the same VLAN as the AP, or on a different VLAN if available
on the trunk port.

For wireless clients’ traffic from a specific WLAN to be locally switched, at least two conditions must be met: the AP
mode must be FlexConnect and the option for FlexConnect Local Switching must be checked under the FlexConnect
settings of the WLAN’s Advanced tab options, as shown in Figure 4-3.
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Figure 4-3 FlexConnect Local Switching Enabled Under the WLAN’s Advanced Tab

The snapshot shows the following options with a checkbox to enable: FlexConnect Local Switching, (enabled)
FlexConnect Local Auth, Learn Client IP Address (enabled), Vlan based Central Switching, Central DHCP
Processing, Override DNS, NAT-PAT, and Central Assoc.

If the AP is in FlexConnect mode but FlexConnect Local Switching is not enabled under the WLAN, data traffic is
centrally switched through the WLC, just as if the AP was in local mode. We can also refer to this scenario as
(FlexConnect) central switching.

On top of central and local switching modes, we can also distinguish two options for authenticating wireless clients. We
speak about central authentication when the WLC itself handles authentications, either through the internal database or
more commonly by communicating with an external RADIUS server. Conversely, local authentication refers to the AP
managing authentications against its local database, or acting as a NAD/AAA client for an external RADIUS server.

Central authentication is the most commonly used option and the only one supported for APs in local or Bridge mode.
For FlexConnect (or even Flex+Bridge) APs, you can deploy both, although central authentication is still the
recommended one, while keeping local authentication as a fallback.

Mobility Express

Although an official “Cisco Mobility Express Deployment Guide” exists, we want to spend few paragraphs
reintroducing this more recent architecture, because we think that additional clarifications on this topic could still
benefit CCIE Wireless candidates.

Mobility Express, sometimes abbreviated ME, is the newest deployment type, and you can think of it as a vWLC
running on an AP. Well, almost. The main goals for ME are simplicity and ease of use, so compared to a vWLC, some
menus and features are not supported and not displayed on purpose. The general rules with ME are that whatever is
available through the GUI is supported, and features listed in the official command reference guide are supported too:

https://www.cisco.com/c/en/us/td/docs/wireless/access_point/mob_exp/83/cmd-ref/me_cr_book.html
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Any other WLC feature that is neither available through the GUI nor mentioned in the command references, although
maybe still visible via the CLI, should be treated as not supported for ME.

The 1800/2800/3800 series APs (that is, all APs supporting the 802.11ac Wave 2 certification, except the 1810 series
APs) are the models supporting the ME controller function (the Master AP role, described in the next paragraphs),
which enable customers to easily deploy wireless networks for small and midsize businesses (SMB), branches, or any
other installation requiring up to 25 APs. Although not part of the current CCIE Wireless exam, at the time of this
book’s writing, the 1815, 1540, and 1560 series APs also support the role of Master AP, and as of AireOS version 8.4 or
later, a Mobility Express deployment can scale beyond 25 APs.

One 1800, 2800, or 3800 AP acts as a virtual controller to configure and monitor all the wireless networks of the
Mobility Express deployment: such an AP is called the Master AP. The full list of AP models that can support the
Master AP role in AireOS version 8.3 is the 1832, 1852, 2802, and 3802.

Note

The 1810 series AP cannot act as a Master AP or its backup, but can still be registered as a standard AP to a Mobility
Express deployment.

The Master AP is the central point of configuration and management for any other AP that registers to the Master AP,
as in any other classic WLC-based architecture.

Only one 1800/2800/3800 AP can act as the Master AP at any given time. Any other 1800/2800/3800 series AP
registered to the Master AP can automatically take over the role of Master AP (except the 1810 series AP), in case the
originally designated one becomes unreachable.

Access points from other series (700, 1600, 1700, 2600, 2700, 3600, 3700, and 1810) can be registered to an
1800/2800/3800 series Master AP, although they do not support the Master AP role. Figure 4-4 shows an example of
the Mobility Express architecture.

Figure 4-4 Mobility Express Architecture Example

For all the configuration and monitoring tasks, the Master AP communicates with other APs of the same Mobility
Express deployment through the standard CAPWAP control tunnel. Data traffic for wireless clients is locally switched
directly on the switch port behind each AP, the Master AP’s one included. This corresponds exactly to the same
behavior as for FlexConnect local switching when deploying a dedicated physical/ virtual WLC.
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Note

We refer to the Master AP as the controller component/service running on an 1800/2800/3800 series AP. On top of
that, a “standard” AP component is also present, which registers to the Master AP running on the same AP. For such a
reason, the same AP “box” consumes two different IP addresses on the same VLAN/subnet: one for the WLC service
and one for the AP itself.

The Master AP is also the point of contact for other external Cisco and third-party resources, such as Cisco Prime
Infrastructure, Cisco Identity Services Engine (ISE) or any other RADIUS server, Cisco Connected Mobile Experiences
(CMX), SYSLOG or SNMP servers, and so on. Other APs of the Mobility Express deployment registered to the Master
AP do not necessarily need to communicate directly with such external resources.

An 1800/2800/3800 series AP can be ordered with the Mobility Express mode already enabled in the preinstalled
image. The reference, or stock keeping unit (SKU), to choose when placing the order should end with K9C, C standing
for “configurable.” For example, to order an 1852 AP with internal antennas for the -E (ETSI, European
Telecommunications Standards Institute) radio regulatory domain, you should choose the reference AIR-AP1852I-E-
K9C. Under the options for Software, you should verify that SW1850-MECPWP-K9 for “Cisco 1850 Series Mobility
Express software image” is also selected. This should be the default option for AP SKUs ending with K9C.

An out-of-the-box Mobility Express enabled AP, configured with factory defaults, if connected to a network where no
other Master AP or WLC can be discovered, automatically starts broadcasting a wireless network (or Service Set
Identifier [SSID]) called CiscoAirProvision, on which you can connect to start configuring the ME solution through an
initial setup wizard. You can also change the operational mode of an 1800/2800/3800 series AP from standard
CAPWAP mode to Mobility Express, for example, if it was previously registered to another WLC or ordered without
the K9C SKU.

The first device to configure when deploying the Mobility Express solution is the Master AP. After the Master AP is
operational, you can expand your ME deployment by automatically registering additional APs.

An out-of-the-box 1800/2800/3800 series AP, with the K9C SKU, or a newly CAPWAP-to-Mobility-Express converted
1800/2800/3800 series AP will boot up with factory defaults, ready to be configured as a Master AP.

The deployment model being the same as for FlexConnect local switching, before connecting the designated Master AP
to a switch, a common practice is to preconfigure the switch port as a trunk. The Master AP, or any other AP of the
Mobility Express solutions, will get its management IP from the native VLAN of the trunk port. A trunk port would also
allow you to switch client’s data traffic on different VLANs, to separate your management network from your client’s
data networks. If you cannot or don’t want to configure the switch port as a trunk and keep it as an access port,
management traffic will be switched on the access VLAN, as well as any other client’s data traffic.

After booting, the AP attempts to obtain an IP address through DHCP first. If this phase is successful, it then tries to
perform an L2 broadcast discovery for any other potential Master AP on the same VLAN, which would be the native
VLAN of the trunk port or the access VLAN. If no other Master AP is available, the 1800/2800/3800 series AP
autodeclares itself as the Master AP and starts broadcasting the SSID CiscoAirProvision. Similarly, in case the AP
cannot initially get an IP via DHCP, it activates the graphical interface for initial setup on the management IP
192.168.1.1 (reachable over Wi-Fi only), then autodeclares itself as the Master AP and starts broadcasting the SSID
CiscoAirProvision. Figure 4-5 shows a more graphic workflow of the Master AP’s state machine during the initial boot.
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Figure 4-5 Master AP’s State Machine for Initial Boot and Configuration

The flowchart begins with a decision symbol, Can I get an IP via DHCP? If yes, it leads to another decision
symbol, Can I discover a Master AP/WLC and register? If yes, the second decision leads to a process symbol
Register to the already available WLC or Master AP. If no, both the decision symbols lead to a process symbol
SSID CiscoAirProvision enabled and management IP 192.168.1.1 available over the wireless only.

The SSID CiscoAirProvision is protected with WPA2 PSK and the passphrase is “password”.

After entering the “password” password (apologies for the wording joke) and getting connected to the SSID
CiscoAirProvision, your machine should obtain an IP address in the 192.168.1.0/24 network; as part of the initial
configuration process, in fact, the Master AP automatically enabled an internal DHCP server too.

If you open a web browser and try to access any website, you should automatically be redirected to the following URL:
http://mobilityexpress.cisco/screens/day0-config.html. If you are not automatically redirected (web browsers may cache
already visited pages or may not accept untrusted certificates redirections), you can always access the initial setup
wizard directly at http://192.168.1.1. From here, the initial configuration steps are intuitive and easy to complete.

Note

The setup wizard proposes to configure WLANs with corresponding DHCP pools and servers, which could run locally
on the Master AP or on external DHCP servers. A mix of DHCP pools from the Master AP’s internal DHCP server and
pools from external DHCP servers is not supported. If you enable an internal DHCP pool for the Management Network,
for example, you must keep using internal DHCP pools for your WLANs too.

After setting up the Master AP, additional access points can discover and register to it. As compared to a “standard”
(v)WLC, the only discovery process supported with Mobility Express is through L2 broadcast requests on the same
subnet, where the AP obtains an IP address. For such a reason, new APs should be connected to the same management
VLAN as the one where you originally connected the Master AP.

A new AP registering to the Master AP, if it is not already running the same version, needs to download the same image
version as the Master AP. The Master AP does not store AP images in its flash memory. As shown in Figure 4-6, when
a new AP needs to update its image, the Master AP first downloads the new AP’s image via TFTP and then provisions
the newly registered AP with such an image. These two phases run almost in parallel.
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Figure 4-6 The Master AP Provisions Newly Registered APs with Updated Images  via TFTP

The illustration shows a 2800 Master AP connected to a T F T P server and 3702 AP (new AP) via a parallel
connection. The newly registered AP downloads the image via the master AP. The Master AP downloads the
new APs image via T F T P and it pushes the image to the new A P.

As of version 8.3, if the Master AP can join Cisco.com, you can also push software updates directly from Cisco.com to
all the 1800/2800/3800 APs of your Mobility Express deployment. Other AP models, if deployed, would still need to go
through the TFTP procedure.

If the originally designated Master AP is not reachable anymore, its role can be taken over at any time by another
1800/2800/3800 series AP of the same Mobility Express deployment, except for the 1810 series APs.

The Master AP and its backup(s) do not need to be of the same model; they can be any mix of 1800/2800/3800 APs,
but it is generally recommended to keep the same model for consistency.

Note

Up to AireOS 8.3, Mobility Express is limited to 25 APs, so any 1800/2800/3800 series AP will support the Master AP
role with the same scaling numbers. Starting from AireOS 8.4, and as of 8.5, 1540, and 1800 series APs acting as a
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Master AP support up to 50 registered APs; 1560, 2800, and 3800 series APs acting as a Master AP support up to 100
registered APs. The Mobility Express deployment’s scale can go as high as the Master AP allows (that is, 50 or 100
APs). In such a scenario, if deploying a 1560/2800/3800 series AP as the Master AP, you may want to use APs from the
same series (or at least with the same scaling numbers) as backups for the Master AP role.

Newly registered 1800/2800/3800 APs automatically detect the current Master AP and synchronize through Virtual
Router Redundancy Protocol (VRRP). Such a protocol allows all the 1800/2800/3800 series APs in the same Mobility
Express deployment to detect whether the Master AP is not reachable anymore and to automatically elect a new Master
AP.

Because VRRP is supported only between devices on the same subnet, it is fundamental that all the APs of the same
Mobility Express deployment are connected to the same management VLAN. During the election process of a new
Master AP, the traffic of wireless clients already connected to other APs is not impacted, because it is locally switched
at each AP’s level and does not need to flow centrally through the Master AP.

Mobility Express is mainly targeted for small, simple, and isolated deployments. As such, there are some scenarios and
features that could not be supported on ME or where ME could present some advantages compared to a standard WLC:

Mobility tunnels between one Master AP and another, or between a Master AP and a physical/virtual WLC, are not
supported. As a consequence, inter-controller roaming or guest anchoring are not supported either with Mobility
Express.

Radio Resource Management (RRM) RF grouping between Master APs of different Mobility Express deployments,
or between a Master AP and another “standard” WLC, is not officially recommended or supported.

ME does not support customization of the RF Group name, which is set automatically to the system name that you
configure through the initial setup wizard of the Master AP. Although you could technically install two or more ME
deployments with the same Master AP’s system name to have the same RF Group everywhere, this would not be
recommended or officially supported, because it could still create other conflicts and confusion.

Location and aWIPS services are not compatible with Mobility Express, but Presence with CMX is supported
(more on all these solutions in Chapter 6, “Prime Infrastructure and MSE/CMX”).

Because we could technically think of the Master AP as a WLC and an AP all in one box, in some situations you
could use Mobility Express for site surveys instead of deploying a dedicated WLC. More details on this are
available in the chapter “Configuring Mobility Express for Site Survey” of the official Cisco Mobility Express
Deployment Guide.

For the CCIE Wireless exam purpose, in the next sections of this chapter we refer to solutions and features applicable
to a “standard” dedicated WLC only. Mobility Express may or may not support some of them, and you can find further
detail on this solution in its official deployment guide:

https://www.cisco.com/c/en/us/td/docs/wireless/controller/technotes/8-
3/b_Cisco_Mobility_Express_Deployment_Guide.html

Securing Management Access and Control Plane

Following from the very first installation and setup of a WLC, a good practice is to configure security options to secure
management access. The options could go from admin user authenticated access, to traffic restrictions to/from the WLC
through CPU ACLs, to disabling specific options for wireless and wired access. Before detailing these common
practices, we want to say a few words on SNMP settings, usually relevant when integrating the WLC with Cisco Prime
Infrastructure or other external management and monitoring tools in general.
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A WLC by default has SNMPv1 disabled, and it is a good practice to keep it that way, whereas SNMPv2c and SNMPv3
are enabled. Always by default, SNMPv2 communities are “public” for read operations and “private” for read-write
operations, and access is allowed from any network. It would be a secure practice either to disable SNMPv2c and use
SNMPv3 or to change communities and restrict access to/from needed resources and networks only, by trying to be as
specific as possible. SNMPv3’s default read-write user and password are all set to “default”: you may want to either
disable SNMPv3 if not used or change the default values to more secure ones. You probably already guessed the
philosophy behind, not necessarily just for security, but for best practices in general and simplicity purposes: if a feature
is neither needed nor used by other components, keep it disabled.

Admin User Authentication and Authorization

You can authenticate WLC administrators against the WLC’s internal database or even through an external
authentication server. Accounts created in the internal database can have read or read-write access to all of the WLC’s
tasks.

Note

To align with the jargon sometime used in the configuration examples, as shown in Figure 4-7, we refer here to the
WLC’s “tasks” as the main menu tabs on top of the graphical user interface (GUI): MONITOR, WLANs,
CONTROLLER, WIRELESS, SECURITY, MANAGEMENT, COMMANDS.

Figure 4-7 Menu Tabs on a WLC Also Known as “Tasks” for Admin User Authorization

If instead of the WLC’s internal database you would like to authenticate management users through an external
database, you can configure admin access through a RADIUS or a TACACS+ authentication server.

When authenticating admin users via RADIUS, the types of privileges you can assign them are the same as for users
from the WLC’s internal database: you can distinguish between read-only or read-write access. The authentication
server can assign read privileges by returning the IETF RADIUS attribute “[6] Service-Type” with a value of 7 for NAS
Prompt in the final Access-Accept response. For read-write privileges, a value of 6 for Administrative should be passed
back in the same RADIUS attribute.

Additional configuration details can be found in the “RADIUS Server Authentication of Management Users on Wireless
LAN Controller (WLC) Configuration Example”:

https://www.cisco.com/c/en/us/support/docs/wireless-mobility/wlan-security/71989-manage-wlc-users-radius.html

When authenticating admin users via TACACS+, on top of read-only or read-write access privileges, you can also
specify which “tasks,” or main menus, the admin user has write access to. The authentication server can pass back
TACACS+ custom attributes in the form of role1, role2, role3, and so on, with values corresponding to the equivalent
tasks the user should have access to: MONITOR, WLANs, CONTROLLER, WIRELESS, SECURITY,
MANAGEMENT, COMMANDS, ALL, and LOBBY. For example, if you would like to grant write access to the
WLANs and SECURITY tasks, the TACACS+ server should pass back the following attributes:

role1=WLAN
role2=SECURITY

Note

There is no mistake in the example; for the WLANs task on the WLC, the TACACS+ attribute should contain the value
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WLAN without the “s.”

If you would like to grant write access to all tasks, the TACACS+ server can pass back the custom attribute role1=ALL.
The value LOBBY should be used to authenticate lobby ambassador users only.

To grant read-only access, no custom role attributes are needed: if the TACACS+ server successfully authenticates an
admin user, that user automatically has read access to all the tasks. Read access privileges cannot be limited to some
specific tasks only. This also implies that an admin user successfully authenticated with write privileges to a specific
task, for example, still has read privileges to all other tasks.

An example of TACACS+ management access to the WLC with Cisco ISE as the authentication server can be found at
the following URL:

https://communities.cisco.com/docs/DOC-68196

TACACS+ authorization for WLC’s admin users does not allow being more granular than the aforementioned tasks. If a
user has read-only or read-write access to a specific task, he/she has read-only or read-write access to all the menus and
features supported under that task too. This is different from Cisco IOS-based switches, for example, where you can
implement authorization for single commands.

In large deployments, a common management need for some customers is to have different WLC administrators from
different offices with access to configure just the SSID(s) corresponding to their respective sites. We cannot address
such a need on the WLC directly, or with just one single WLC for that matter. An option could be to deploy one
(v)WLC or even one Mobility Express setup per site, with its corresponding admin user(s) and SSID(s). Each site and
controller could also be part of a dedicated virtual domain in Cisco Prime Infrastructure, for additional separation of
admin access and monitoring features through a centralized management solution.

As shown in Figure 4-8, on the WLC you can specify the priority of the three different admin user authentication
options under SECURITY > Priority Order > Management User. For example, the WLC can first attempt
TACACS+ servers to authenticate an admin user and then fall back to the local database if no TACACS+ server replies.
Be aware that if a RADIUS/TACACS+ server replies by rejecting the admin user, that still counts as a valid response
and the WLC does not fall back to the next option in the priority list. If by accident you cut yourself out of the WLC by
configuring RADIUS/TACACS+ as higher priority options than the LOCAL one (as this writer already experienced
back in the early days), to work that around you could always deny WLC’s traffic to/from those RADIUS/TACACS+
servers through an ACL on the wired infrastructure, to force the WLC to fall back to the local database.
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Figure 4-8 Priority Order for Management User Authentication

The screenshot shows the security menu selected from the main menu tabs at the top. The Management User
option under Priority Order is selected from the Security menu. The Management User page displays a section
titled Authentication. Two subsections: Not Used and Order Used for Authentication are shown. The first
section shows an empty field beside which greater than and lesser than symbols are present. The second section
shows a field that lists RADIUS, TACACS+, and LOCAL. Beside the field, up and down are shown. A note
reads, If LOCAL is selected as second priority then user will be authenticated against LOCAL only if first
priority is unreachable.

CPU Access Control Lists

To filter control plane traffic to/from specific networks or even IP addresses, you can additionally configure CPU
ACLs. The WLC’s CPU handles protocols for management access, CAPWAP control traffic, RADIUS, DHCP, and so
on, and traffic to the CPU is defined as all traffic destined to any of the WLC’s interfaces (management, ap-manager,
dynamic and virtual), as well as to the service port. Traffic between wireless clients or between wireless and wired
clients is not handled by the WLC’s CPU but by the data plane, and should be filtered through ACLs applied to the
dynamic interface, the WLAN, dynamically assigned via RADIUS or through a local policy too.

Note

Traffic between wireless clients tunneled to an anchor WLC and the rest of the wired network behind that anchor is
carried through an Ethernet over IP (EoIP) tunnel from the foreign WLC to the anchor WLC. The EoIP tunnel is
established between the management interfaces of the two WLCs; therefore, although we are talking about traffic
between wireless and wired clients, a CPU ACL not allowing EoIP tunnels between the two WLCs would automatically
block traffic between wireless and wired clients too.

To configure a CPU ACL, you first need to create an ACL under SECURITY > Access Control Lists > Access
Control Lists and then apply that ACL to the CPU itself under SECURITY > Access Control Lists > CPU Access
Control Lists.

The direction of an ACL’s rule (inbound or outbound) is not taken into account when applied to the CPU: for example,
to block traffic from the 192.168.1.0/24 network, in the ACL’s rule you can configure that network as the source, leave
all other options (for example, destination, protocol, direction) to any, and set it to deny.
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Before getting your hands dirty with so-called strict ACLs (with a “deny all” rule at the end), it is generally
recommended that you practice CPU ACLs with a “permit all” rule at the end, not to risk blocking yourself out of the
WLC (in which case, only console access or a WLC’s hard reboot may save your day, by causing the controller to
reload without the latest nonsaved changes, including the CPU ACL itself). You can always check the currently
allowed/denied control plane services by using the show rules command.

Even if you can block wireless users from managing the WLC by disabling the Management Via Wireless option (more
on this in the next section), those users will still be able to test and see management protocol ports for SSH, HTTPS, and
so on. To prevent this, you may want to configure a CPU ACL to block traffic from wireless users’ networks. An
exception could apply to wireless users authenticating with Local Web Authentication (LWA). This authentication
technique requires wireless users to get redirected via HTTP(S) to the WLC’s virtual interface, which should then be
permitted if a CPU ACL is in place.

On top of using CPU ACLs for security goals, you might also want to configure them to optimize the WLC’s
performances overall. By selectively limiting which protocols and resources can be handled by the WLC’s CPU, in
large networks you can avoid unneeded traffic to hit the WLC’s interfaces and be processed by the CPU.

You can find a useful configuration guide for CPU ACLs at the following link:

https://www.cisco.com/c/en/us/support/docs/wireless/4400-series-wireless-lan-controllers/109669-secure-wlc.html

Management via Wireless and via Dynamic Interface

Even before configuring CPU ACLs, you may want to consider options to allow or block management access for
wireless users or even for managing the WLC through one of its dynamic interfaces’ networks.

Management Via Wireless is disabled by default and can be configured under MANAGEMENT > Mgmt Via Wireless
> Management Via Wireless. Even when disabled, wireless clients connected through the WLC can open connections
for management protocols (for example, SSH, HTTPS, and so on) enabled on that WLC, and also get to the SSH login
prompt, for example (the session will anyway be blocked when attempting to log in). For such a reason, when blocking
management access for wireless users, a CPU ACL should also be deployed on top.

For ease of management, however, sometime you may want to have a dedicated WLAN or subnet through which you
can access the WLC while being connected to your APs and verify your wireless deployment, for example. In such a
case, you could enable Management Via Wireless, assign your management users to a dedicated subnet, and then allow
that subnet on a CPU ACL, while denying traffic for other wireless users’ networks on that very same ACL.

Note

Management Via Wireless is a global setting. When enabled, and without a CPU ACL, any wireless user with the right
admin credentials can gain management access to the WLC through the management interface or the service port
(assuming that the needed switching and routing infrastructure is configured accordingly). Through a CPU ACL you can
filter management access through specific networks only. A wireless management user could connect through a
dedicated WLAN associated to that specific network. Alternatively, while connecting through the same 802.1X-enabled
WLAN as for other users, for example, through RADIUS attributes you can dynamically assign management users to
the management VLAN/subnet allowed on the CPU ACL.

Management Via Dynamic Interface is also disabled by default and can be configured via command line interface (CLI)
only, through the following command:

Click here to view code image

config network mgmt-via-dynamic-interface [enable | disable]

Chapter 4 AireOS Appliance, Virtual, and Mobility Express Controllers

149

||||||||||||||||||||

||||||||||||||||||||

https://www.cisco.com/c/en/us/support/docs/wireless/4400-series-wireless-lan-controllers/109669-secure-wlc.html
file:///C:/Users/MERRELL/Documents/eBook Converter/Oreilly Downloader/tmp/9780135162095/ch04_images.xhtml#p0141-01a
https://technet24.ir
https://technet24.ir


When enabled, this feature allows users on the same VLAN/subnet as one of the WLC’s dynamic interfaces to gain
management access through the dynamic interface’s IP of the WLC on that very same VLAN/subnet. Access through
the management interface is permitted too.

Working with WLC Interfaces

Configuring and preparing interfaces is another prerequisite for successfully deploying your wireless infrastructure with
a WLC. Each interface can be assigned to a specific physical port, or all interfaces can be assigned to the same port, or
they can also all be aggregated through Link AGgregation (LAG).

If you assign different interfaces to different physical ports, each port must have an AP-manager interface. Using
different ports for different interfaces was originally introduced to have multiple AP-manager interfaces on multiple
ports and load balance LWAPP traffic for the APs, back when WLC hardware models supported only two Gigabit
Ethernet interfaces with no aggregation options. That heritage is still there: when multiple ports are used for different
interfaces with no LAG, the WLC expects an AP-manager interface dedicated to each of those ports.

The two most common scenarios as of today are either to use a single port for all interfaces or to use LAG. Both these
options often imply that the WLC is connected to a switch port or a port-channel in trunk mode, to support multiple
VLANs.

Management and AP-Manager Interfaces

The management interface is the first one you need to configure when installing a WLC. As the name says, it provides
management access to the WLC but also CAPWAP discovery responses to the APs, as well as communication with
other WLCs and external resources.

Before trying to register to a WLC, an AP needs to discover that WLC through its management IP. The AP learns a
WLC’s management IP in many ways: via DHCP option 43, through DNS resolution, trying a L2 broadcast discovery,
and others. The WLC replies to a discovery request on its management IP by sending back a response with the
information of the AP-manager interface’s IP, which is the one the APs will use to register and exchange CAPWAP
traffic with.

This separation between management and AP-manager interfaces was probably more intuitive in the past, when the
WLC required configuring one management interface and one separate AP-manager interface. Since some years and
some AireOS versions, the management interface carries the role of AP-manager too, so this separation between the
two interfaces is less explicit, although logically still present. By default we were using the same physical port (or just all
ports in case of LAG) for both the manager and AP-manager interfaces, but other ports could be used under the
condition of creating a new dedicated AP-manager interface for each of those ports. Nowadays we tend to keep just one
AP-manager interface, corresponding to the management one, and to use either just one port or LAG.

If you want to assign one or more (dynamic) interfaces to other ports than the management interface’s port, each one of
those other ports must have a dynamic interface enabled for Dynamic AP Management (that is, with an AP-manager
role). Figure 4-9 shows the option to enable the AP-manager role on a dynamic interface.
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Figure 4-9 The AP-Manager Role Enabled for a Dynamic Interface

The screenshot shows the Controller menu selected from the main menu tabs at the top. Interfaces option under
the controller menu is selected. The Interfaces Edit page shows the following sections: General Information,
Configuration, NAT Address, Physical Information, and Interface Address. Under General Information,
Interface Name and MAC Address details are present. Under Configuration, Guest Lan checkbox and NAS-ID
field box are present. Under NAT address, Enable NAT Address checkbox is present. Under Physical
Information, Port Number field box (1) Backup Port field box (0), Active Port field box (1), and Enable
Dynamic AP Management checkbox (selected) are present. Under Interface Address, VLAN Identifier and IP
Address field boxes are present.

The management interface has the option Dynamic AP Management enabled by default. If you configure LAG, only
one interface can act as the AP-manager, and that will be the management interface by default.

When using an interface as an AP-manager with Dynamic AP Management enabled, you should not configure any
backup port. Backup for AP-manager interfaces on multiple ports should be implemented implicitly by the requirement
to have an AP-manager per port already.

In your daily job as a wireless expert you might encounter organizations asking for the APs to communicate with the
WLC through a dedicated IP on a dedicated port only, which should be physically separated from the management
interface and port. This is not completely possible: APs must be able to initially reach the WLC’s management IP, at
least for the very first discovery phase, so at that point going through an AP-manager on a different port might not make
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too much of a difference in terms of segmentation. The common recommendation would be to keep using the
management interface as the AP-manager, too, and maybe apply additional filtering and security options on its
VLAN/subnet.

To further address some security needs, as well as APs’ registration over a public IP, the management interface supports
NAT configuration. When you configure the NAT option and the corresponding public IP under the management’s
interface settings, the WLC replies back to discovery requests with the public IP from the NAT option as the IP for the
AP-manager, which APs should register to. This NAT IP could then translate to any interface with Dynamic AP
Management enabled.

Note

When NAT is configured, by default the WLC will communicate only the NAT IP in discovery responses. If you need
to register APs across both NAT and the internal network, for example, you may want the WLC to reply with both the
NAT IP and its internal IP. In such a case, you could use the following command to enable/disable the NAT IP only in
discovery responses:

Click here to view code image

config network ap-discovery nat-ip-only [enable | disable]

The management interface is also by default the dedicated one for communications with external resources, such as
SNMP trap receivers, MSE and CMX, as well as RADIUS/TACACS+ servers, SYSLOG servers, and so on. For
RADIUS traffic, you can change the default behavior on a per WLAN basis, to have this particular traffic sourced from
the dynamic interface associated to that WLAN instead. For WLC models supporting an internal DHCP server, if you
need to use such a capability (although generally not recommended for production environments), under the settings of
the interface associated to the WLAN, you should configure the DHCP server’s field with the management IP itself.

Multicast traffic for centrally switched wireless clients is also delivered from the management interface to the APs. This
is slightly different from the standard mode of operations, where the WLC’s AP-manager interface (although commonly
corresponding to the management one) usually communicates with the APs via CAPWAP for the data tunnel.

Inter-WLC communications also flow through the management interfaces. This includes EoIP tunnels for clients’ traffic
and the Mobility protocol for control messages, as well as synchronization between WLCs for RF management with
RRM.

Last but not least, although you may not associate the management interface with any WLAN, it is still a good practice
to tag the management interface on a specific VLAN for Quality of Service (QoS) optimization. Without an 802.1q tag
there is no support for Class of Service (CoS) markings. Even if not used for wireless clients, you could still need this for
prioritizing CAPWAP control traffic, inter-WLC communications, and any other traffic to/from the management/AP-
manager interface in general.

Service Port

If the service port is supported by the WLC model in use, it is another interface that the initial WLC’s setup wizard asks
you to configure. If you don’t plan to use any, you can simply define a bogus IP (on a completely different super-net
from the management interface) and keep the option for a DHCP assigned address disabled.

The service port was originally designed to provide out-of-band management to the WLC’s GUI or CLI. Since AireOS
8.2, the service port also supports SNMP and SYSLOG traffic, as well as download and upload operations. The IP
address of the service port should always be on a different super-net from the management interface’s IP. For example,
if the management IP is configured as 10.10.0.250 in the 10.10.0.0/24 network, the service port’s IP could be something
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like 172.16.0.250 in the 172.16.0.0/24 network.

When configuring the service port, you may notice that there is no option to configure its default gateway. For such a
reason, some WLC models support configuring static network routes, to specify out-of-band management traffic
routing.

Virtual Interface

The virtual interface is another interface that the WLC’s installation script asks you to configure during the initial setup.
A common convention in the past was to use odd enough, nonrouted IP addresses such as 1.1.1.1, 2.2.2.2, 3.3.3.3, and
so on. Since then, address ranges in networks such as 1.0.0.0/8, 2.0.0.0/8, and 3.0.0.0/8 have been allocated by IANA to
specific organizations. Following the RFC 5737, the current recommended best practice is to use an IP from blocks used
for documentation, such as the IP 192.0.2.1 from the 192.0.2.0/24 network.

Controllers verify whether they have the same virtual IP in order to successfully exchange mobility messages. This is
one first prerequisite if you plan to deploy WLCs in the same mobility domain or mobility group.

Another usage of the virtual IP is to host the WLC’s internal web server for all web redirection scenarios based on
Local Web Authentication (LWA). With a web redirect enabled WLAN, no matter if for web authentication or simply
web passthrough, users go through the WLC’s internal web server hosted on the virtual interface. When using HTTPS
for web redirections, enabled by default under MANAGEMENT > HTTP-HTTPS > WebAuth SecureWeb, the WLC
presents a dedicated certificate tied to the virtual IP or FQDN (if configured). This plays an important role when
deploying a publicly signed certificate for the virtual interface. Such a certificate should be issued with the virtual IP in
the certificate’s common name, or else with the virtual interface’s FQDN (if configured) in the common name plus the
virtual IP in the subject alternative name (SAN) IP and DNS options.

Note

When using a publicly signed certificate for this purpose and using a FQDN in a certificate’s CN (also configuring it at
the WLC for the virtual interface), the wireless clients are redirected to the WLC’s internal web server by the WLC
giving the URL of the virtual interface using the FQDN instead of the IP address. Hence, clients should be able to
perform DNS resolution for the virtual IP with their DNS server(s), even though that may mean adding a public DNS
entry pointed to a private address, which can be counterintuitive to some enterprises.

If not publicly signed, such a certificate is automatically generated as a self-signed one during the initial WLC’s
installation, with the first virtual IP that you specify through the setup wizard as the common name of that certificate.
You can of course modify the virtual IP and FQDN later on (you need to reboot the WLC for the new virtual IP/FQDN
to be applied), but the self-signed certificate will keep the initially configured virtual IP in the common name until you
regenerate such a certificate under SECURITY > Web Auth > Certificate (a WLC’s reboot is needed for the new
certificate to take effect).

One more function of the virtual interface is as a placeholder for the DHCP server IP when DHCP proxy is enabled
(globally or at the dynamic interface level).

Dynamic Interfaces

Although you can associate a WLAN with the management interface, you usually may want to assign your wireless
clients to a different VLAN. This is the main purpose of a dynamic interface: switching traffic of a specific WLAN or
client on the corresponding VLAN. Even if the WLC is not a routing device and simply switches client traffic on
different VLANs, you still need to reserve an IP for the WLC on the needed VLAN when configuring the corresponding
dynamic interface. A dynamic interface can be assigned to a specific port, or to all ports through LAG. If DHCP proxy
is enabled on the WLC, DHCP requests from clients assigned to a dynamic interface are proxied through that dynamic
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interface’s IP.

Note

You can enable DHCP proxy at a global level, for management and dynamic interfaces, and at a local level, too, for
each interface. The specific interface’s DHCP proxy configuration under the interface options overrides the global
DHCP proxy settings.

If the subnet of a single dynamic interface does not allow you to allocate enough IP addresses to wireless clients of a
WLAN, you can also bundle more dynamic interfaces together through an Interface Group (a.k.a., VLAN Select or
VLAN Pool[ing], when the feature was originally introduced). When a client associates to the WLAN linked to an
interface group, an index is calculated based on a hashing of the client’s MAC and the number of dynamic interfaces in
the interface group. This index is used to decide which interface of the group the client should be assigned to. Such a
hashing technique guarantees that the same client is always assigned to the same interface of the group, as long as the
interface group’s configuration does not change (for example, you do not add/remove interfaces to the group). It also
avoids IP addresses exhaustion if the client would have been assigned to a different interface of the group at each
reconnection. If a DHCP timeout occurs for clients on an interface, or if three unsuccessful DHCP attempts happen
three times on that interface, the interface is marked as “dirty,” a new random index is chosen, and the client is assigned
to the first “non-dirty” interface starting from that random index and trying other interfaces in a round-robin fashion.

Although written at the time of AireOS 7.2, a good reference for understanding how interface groups work is still the
“WLC 7.2 VLAN Select and Multicast Optimization Features Deployment Guide”:

https://www.cisco.com/c/en/us/support/docs/wireless/5500-series-wireless-controllers/113465-vlan-select-dg-
00.html

When you create a WLAN and assign a dynamic interface to it, by default wireless clients associated to the WLAN will
be switched on that dynamic interface’s VLAN. You can override this behavior by dynamically assigning a different
dynamic interface and VLAN with RADIUS attributes, at the end of the client’s authentication process (802.1X, MAB,
etc.), or through local policies.

For dynamic VLAN assignment via RADIUS attributes, you have two options:

Using the Cisco Vendor Specific Attribute (VSA) “Airespace-Interface-Name” with the name of the dynamic
interface, which a wireless client should be assigned to.

Using the standard RADIUS IETF attributes:

Click here to view code image

Tunnel-Type=13 (VLAN)
Tunnel-Medium-Type=6 (802)
Tunnel-Private-Group-ID=<VLAN ID/Name>

Where <VLAN ID/Name> could be either the VLAN number of the dynamic interface that you want to assign or
the dynamic interface’s name itself.

For a FlexConnect locally switched WLAN, wireless clients are automatically locally switched with the same VLAN ID
as the one configured under the dynamic interface associated to the WLAN, so you should make sure that the correct
VLAN IDs are also configured on those switches, where FlexConnect APs are connected.

For FlexConnect locally switched clients to be on a different VLAN, you can “remap” the WLAN to a different VLAN
under each AP’s FlexConnect settings, or through the WLAN-to-VLAN mappings of a FlexConnect Group, to which
you can assign your FlexConnect APs. In this case you do not need to create a dynamic interface for each VLAN on
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which you want to assign FlexConnect locally switched clients.

Although maybe not needed anymore thanks to the FlexConnect Group options to map a WLAN to a VLAN for a full
set of APs at once, a more common technique in the past to remap a WLAN to a VLAN was to assign APs to an AP
Group and to remap the WLAN in the AP Group to a dynamic interface on the needed VLAN. The dynamic interface
IP didn’t necessarily need to be a “real” one, and even the VLAN didn’t need to exist on the trunk behind the WLC
(only behind the FlexConnect APs of course). By having the WLAN mapped to a specific dynamic interface in the AP
Group, the VLAN of the dynamic interface itself is automatically used to locally switch clients of that WLAN for the
APs in the same AP Group.

When authenticating wireless clients of a WLAN through an external RADIUS server, by default the WLC
communicates with RADIUS servers through the management interface. You can modify such a behavior on a per
WLAN basis, under the WLAN’s Security > AAA Servers settings, by enabling the option RADIUS Server Overwrite
Interface. This will make the WLC source RADIUS traffic for that WLAN from the dynamic interface associated to
that WLAN. In your RADIUS server, you need to add the dynamic interface’s IP as a valid AAA client or network
access device (NAD).

Note

Although not generally recommended, back in the days in some network designs the RADIUS server was configured
with an IP in the same subnet as of a dynamic interface. In such a case, for the WLC to accept RADIUS traffic usually
destined to the CPU we had to turn on management via dynamic interface.

LAG: Link Aggregation

For higher bandwidth capacity and interfaces availability, you can aggregate ports of a WLC to a single logical link. The
WLC partially implements some of the features from the IEEE 802.3ad standard for Link Aggregation Control Protocol
(LACP); however, it does not completely implement the full standard: some features, such as dynamic link negotiation,
are not supported. When you configure the interfaces of a Cisco switch for participating to the port-channel, where the
WLC is connected, you should force the EtherChannel mode with the command channel-group <id> mode on. Since
the WLC also relies on the switch for the traffic’s load-balancing technique, the recommended option for load balancing
is based on source and destination IP: on a Cisco Catalyst switch you can configure this with the global command port-
channel load-balance src-dst-ip. You can also use LAG with Virtual Switching System (VSS) and Nexus virtual Port-
Channel (vPC).

When you enable LAG on the WLC, a reboot is required for changes to take effect; after that, all interfaces will be
mapped to a single logical port, ephemerally numbered 29 on the WLC itself.

As previously mentioned when describing the AP-manager interface, if LAG is enabled there can be only one interface
carrying the AP-manager role, and by default the management interface is the one. On top of increased bandwidth, you
may usually want to implement LAG for ports redundancy. This may not apply if you need to connect the WLC ports to
different, nonstacked switches, for example.

Deploying Lightweight Access Points

Following the logical steps of a wireless infrastructure deployment, after choosing your deployment model (centralized
or FlexConnect/Mobility Express), configuring your controller, and connecting it to the network, the next phase would
be to connect your access points.

Sometimes we still use the adjective “lightweight” to designate APs controlled by a WLC, hence carrying less “weight”
on them in terms of configuration and operational tasks. Access points working in standalone mode are often referred to
as autonomous. Cisco Internetwork Operating System (IOS) is the operating system used since the introduction of
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wireless access points in the Cisco portfolio (only APs from initial acquisitions were running different OSes). Both types
of APs, lightweight and autonomous, operate on IOS. Lightweight APs are controlled by an AireOS-based WLC,
whereas autonomous APs are not controlled by any other network device, except probably a management system via
SNMP/SSH/telnet/etc. if you decide to deploy one. Sometime autonomous APs are also designated as IOS-based APs,
but that wouldn’t be 100% accurate because lightweight APs are IOS-based too.

The most recent generations of Cisco APs, at least at the time of this book’s writing, are access points supporting the
802.11ac Wave 2 certification, such as the 1800/2800/3800 series or the very latest 1560 and 1540 outdoor series.
Starting from these models, Cisco introduced a new operating system referred to as Cisco OS (COS), which was
necessary to support the additional performances and options of the 802.11ac Wave 2 certification and other features.

COS-based APs do not support the IOS-based, autonomous deployment model anymore. Well, sort of. COS APs do not
support configuring the access point component itself, with its own SSID and radio parameters, for example, in the same
way as we were used to with autonomous IOS APs. COS APs can work only in lightweight mode, controlled by a WLC.
This means that COS APs can work either with a “standard” WLC (for example, in local or FlexConnect mode), or also
in FlexConnect local switching mode with Mobility Express, by registering to the “virtual” WLC (that is, the Master
AP) hosted on a COS AP (except for the 1810 series). Mobility Express is therefore the new standalone mode for COS
APs. By setting up the WLC hosted on a COS AP and registering that COS AP itself to its own WLC, you can deploy a
COS AP as standalone/autonomous and additionally benefit from some WLC-related features, such as Radio Resource
Management (RRM), which are not available with autonomous IOS APs.

Both options, autonomous IOS APs and Mobility Express with COS APs, are currently valid and supported for installing
a standalone AP. The choice between one and the other may vary according to the final deployment’s needs.

Through the following section and subsections we refer to lightweight APs as controlled through a standard, dedicated
WLC.

Authenticating and Authorizing APs on the Network

When connecting an access point to a switch port, you may want to configure additional options to authenticate the AP
on the network and/or even at the WLC level during/after the join process.

One first level of authentication could be directly through 802.1X on the access switch, where the AP is connected.
IOS-based APs support an 802.1X supplicant for the wired/uplink interface. The Extensible Authentication Protocol
(EAP) method is EAP-FAST as the tunneling technique, with MS-CHAPv2 as the inner method. The authentication is
therefore based on username and password, which you can configure either via CLI on the AP (through the command
capwap ap dot1x username [USER] password [PWD] in enable mode, on IOS APs) or through the WLC’s CLI/GUI,
for all APs at once, or AP by AP, as shown in Figure 4-10.
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Figure 4-10 Example for Configuring 802.1X Credentials at a Single AP Level Through the WLC’s GUI

The screenshot shows the Wireless menu selected from the main menu tabs at the top. Access Points section
under Wireless menu is expanded to reveal: All APs, Radios, and Global configuration. Radios is expanded to
list: 802.11a/n/ac, 802.11b/g/n, and Dual-Band Radios. FlexConnect Groups section lists: FlexConnect ACLs,
FlexConnect VLAN, and Templates. A page titled Details for AP-3702I.fcc4 shows six tabs from which
Credentials is selected. The Credentials tab shows two sections: Login Credentials and 802.1x Supplicant
Credentials. Under Login Credentials, Over-ride Global Credentials checkbox is present. Under 802.1x
Supplicant Credentials, Over-ride Global Credentials checkbox and the following field boxes are present:
Username, Password, and Confirm password.

Pushing the 802.1X credentials through the WLC implies that the AP must register to the WLC first. The AP should use
802.1X to authenticate to the network even before registering to the WLC, but you could also consider pushing the
802.1X credentials to your APs as a prestaging operation, before activating 802.1X on your switch ports in closed
mode, for example.

Note

Unlike IOS APs, COS APs did not support the 802.1X supplicant for wired authentication before AireOS 8.6.

802.1X credentials are stored in the AP itself and encrypted with a type 7 password hash. Because this encryption
option is relatively easy to decrypt, someone with physical access to the AP’s console port and with the right login
credentials could potentially retrieve the 802.1X username and password.

Common best practices to prevent and mitigate this risk include changing the AP’s login credentials to something more
secure than the default “Cisco/Cisco/Cisco” (for login user/password/enable). Another option is to make sure that the
network (for example, the VLAN, subnet, VRF, and so on) where APs are deployed restricts communications to the
WLC and other minimum required resources but filters access to any other unneeded resource. If someone manages to
use the same AP’s 802.1X credentials on other devices, he or she would be limited to CAPWAP traffic to or from the
WLC, for example, where additional filtering and authorization techniques could be applied on top. To exploit a feature
seen at the beginning of this chapter, you can also configure CPU ACLs for extra control on CAPWAP traffic from the
AP’s network to the WLC.

When an AP discovers and tries joining a WLC, you can also enable authorization options for the AP’s certificate type
or its MAC address. On the WLC, under Security > AAA > AP Policies, you have the choice of authorizing APs
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through Self-Signed Certificate (SSC), Manufacturer Installed Certificate (MIC), Local Significant Certificate (LSC), or
even by verifying their MAC addresses against a local list or external AAA servers.

Support for self-signed certificates was needed for APs manufactured before July 18, 2005, and converted from
autonomous to lightweight. Older models were manufactured before Cisco introduced wireless LAN controllers on the
market, so they didn’t have any MIC, for example, because it was not needed for the APs to work in autonomous mode.
Those APs were from the 1200, 1130, and 1240 series, which are not supported anymore after AireOS version 8.0 (the
1200 series since even before).

MIC certificates are those preinstalled by Cisco when APs are manufactured, and they are used by default to set up the
DTLS communication of the CAPWAP tunnel with the WLC. If an AP can communicate with a WLC, with no other
authentication measures in place, it can join with its MIC. For such a reason, some organizations may want to deploy
their own certificates, or local significant certificates. It is not a common option, because of the configuration and
management overhead that certificates would require, but you can enable APs to download and use new certificates
through Simple Certificate Enrollment Protocol (SCEP). The WLC plays the role of a proxy SCEP in this case, by
relaying requests for certificates from the APs to the certification authority, and then passing back newly generated
certificates to the APs. To validate the new APs’ certificates, the WLC also downloads the root certification authority
(CA) certificate from that same authority. All the configuration details for LSC certificates are available in the official
“Locally Significant Certificates on Wireless LAN Controllers Configuration Example”:

https://www.cisco.com/c/en/us/support/docs/wireless/4400-series-wireless-lan-controllers/110141-loc-sig-cert.html

As you may have already guessed, an LSC certificate can be pushed only after an AP has already joined the WLC, and
this could appear a bit as a chicken-and-egg challenge. Enabling both options for MIC and LSC certificates could defy
the principle of using LSC certificates to avoid generic APs registering to the WLC. On the other side, MIC certificates
support is needed at least during the first phase, to be able to push LSC certificates. At a second stage, after having
deployed all your APs with their corresponding LSC certificates, you may want to disable support for MIC certificates,
to block other potentially unknown APs that managed to communicate with the WLC and tried to join it. However, you
could also use a staging WLC (which allows MIC) to let new APs join for the first time in your network, onboard the
APs with their LSC certificates from this staging WLC, and then get them to join the proper production WLCs.

A simpler option to authorize an AP trying to join a WLC is through its MAC address. The AP’s Ethernet MAC address
can be verified against a local list on the WLC itself. Another option is to configure the WLC to send a Password
Authentication Protocol (PAP) authentication to external RADIUS servers, with the AP’s Ethernet MAC as both the
username and password. MAC addresses can easily be spoofed, so a simple MAC address authentication is not the
ultimate security measure. However, even if we could spoof the AP’s Ethernet MAC on another device, we would still
not have the required MIC certificate, for example, to negotiate the DTLS-based CAPWAP tunnel(s) with the WLC.

Note

For APs in Bridge mode (that is, mesh APs), you must always add their MAC addresses to the AP Authorization List for
the WLC to accept them. Another equivalent option is to add their MAC addresses in the Local MAC Filters list under
Security > AAA > MAC Filtering: mesh APs are still authorized when their MACs are in this list, but this option is a
bit less intuitive because Local MAC Filters are usually configured for wireless clients.

On top of all these official options, you could also exploit a combination of AP Groups and WLANs with indexes
greater than 16, to set up some sort of “approval” process for new APs joining a WLC.

A WLAN with an ID of 17 or above is by default not associated to any AP Group. Also, the default AP Group supports
only WLANs with an ID of 16 or below. This means that, always by default, no AP is serving WLANs with an ID of 17
or above until you move the AP to an AP Group under which you specified those WLANs. Any new AP joining a WLC
gets associated to the default AP Group. With this technique, even if an unwanted AP managed to join the WLC, that
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AP would not be able to serve any SSID. For that AP to be fully operational, you would need to manually “approve” it
by moving it to the AP Group, where you listed the WLANs to be served.

This process has been used as a common security practice for many years now and it is still a valid technique for
authorizing new APs joining a WLC. A more native option to achieve the same result has been introduced as of AireOS
7.3 with the Out-Of-Box AP group, which you can configure under WIRELESS > RF Profile. When this feature is
enabled, an AP group called Out-Of-Box is automatically created. New APs joining the WLC are also automatically
assigned to the Out-Of-Box AP group. APs already in the default AP group stay in that group, unless they rejoin the
WLC, in which case they are also automatically assigned to the Out-Of-Box AP group. APs already in a nondefault AP
group keep staying in that group. Even when they need to rejoin the WLC they are always assigned to their previous
nondefault AP group. So, why go through all the burden of understanding and activating the Out-Of-Box AP group? By
default, the Out-Of-Box AP group is not associated to any WLAN, and APs belonging to this group have their radios
administratively disabled. This is similar to the aforementioned process with WLAN IDs greater than 16 and standard
AP groups, plus the benefit of having radios from “not yet approved” APs completely disabled (and without having to
configure or reconfigure the WLANs to use IDs greater than 16).

Pushing the same concepts one step further, you could also make use of the AP PnP (Plug-n-Play) solution embedded
in Cisco APIC-EM:

https://www.cisco.com/c/en/us/td/docs/wireless/technology/mesh/8-2/b_APIC-EM-PNP-deployment-guide.html

As shown in the workflow of Figure 4-11, instead of the “classic” WLC discovery and join process through DHCP
option 43 or DNS resolution, APs could also discover and join the APIC-EM server instead. An AP declared in APIC-
EM through its serial number and model can download an associated configuration file, which contains the WLC’s IP
for the standard registration process, but also other parameters, such as the AP Group, secondary and tertiary WLC’s
information, the FlexConnect Group, and so on. The goal of this solution is to automate the deployment of some AP’s
parameters instead of waiting for the AP to join the WLC before configuring them. As a side option, this workflow
allows you to define a list of APs and associate them with a configuration file, which among other things is used to
discover and join the WLC. APs not declared in APIC-EM and still able to discover it are put in a claim list, where they
stay until moved to a different one. The claim list is not associated to any configuration file, so APs in that list will not
be able to download any setting to join a WLC. Although not necessarily the primary use case for which APIC-EM PnP
was designed, this feature could be used as an approval or authorization process for APs.

Figure 4-11 AP PnP with APIC-EM

The illustration shows a WLC, an AP  (SN #123) CCIE AP Group, and APIC-EM (AP SN #123> config.File
(WLC IP, CCIE AP Group, etc). An An arrow labeled 1. APIC-EM IP in DHCP option 43 or DNS resolution
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for pnpserver.,dhcp-domain-option from AP points to APIC-EM. An arrow labeled 2. WLC IP, CL AP Group,
etc from APIC-EM points to AP. A dashed line representing 3 exists between AP and WLC.

AP Modes of Operations

After connecting successfully to the network, lightweight APs can automatically discover and register to a WLC
through different options, such as broadcast, DHCP, DNS, or other discovery techniques. Although this is a
fundamental process, we will not cover it in this book in depth because a very well detailed description is already
available in the official “Enterprise Mobility 8.1 Design Guide”:

https://www.cisco.com/c/en/us/td/docs/wireless/controller/8-1/Enterprise-Mobility-8-1-Design-
Guide/Enterprise_Mobility_8-1_Deployment_Guide/cuwn.html#pgfId-1259523

An out-of-the-box AP by default will join a WLC in the so called “local” mode. As discussed at the beginning of this
chapter, the local mode allows the AP to switch all the wireless clients’ traffic centrally through the WLC, which will
bridge this very same traffic to specific VLANs if needed. As a general rule, the local mode is the one that supports the
broadest spectrum of features. To change the AP mode you have the following options:

After the AP joins the WLC: This is the most classic approach, and you can modify the AP mode either through
the WLC’s GUI/CLI or even with an external management tool for multiple APs at the same time, such as with
Cisco Prime Infrastructure, via SNMP.

To change the AP mode through the WLC’s GUI, as shown in Figure 4-12, you can browse under WIRELESS >
Access Points > All APs and click the AP of your choice.
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Figure 4-12 AP Mode Configuration Example Through the WLC’s GUI

The general tab is selected and it shows a section titled General. Under the section, the AP Mode spin box
is clicked to reveal a list: local, FlexConnect (selected), monitor, Rogue Detector, Sniffer, Bridge,
Flex+Bridge, SE-Connect, and Sensor.

Before the AP joins the WLC: Through the APIC-EM PnP solution described in the previous section, an AP could
download a configuration file with its operating mode before joining the WLC. In this case, the AP mode you can
push beforehand is the FlexConnect one.

Automatically, when the AP joins the WLC: You can configure the WLC to automatically convert APs joining it
to either FlexConnect or Monitor mode, through the following command line:
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Click here to view code image

config ap autoconvert [disable | FlexConnect | monitor]

This option is not available via GUI and is supported on the following controller models: 7510, 8510, 5520, 8540,
vWLC.

FlexConnect is the mode to switch traffic locally, at the AP’s level, and bridge it directly on a VLAN of the switch port,
where the AP is connected. This mode also adds some “survivability” options to the AP: if connectivity to the WLC is
lost, locally switched clients already connected to a WLAN can stay connected, at least until the next (re)association,
and new clients can connect under some conditions. To switch clients locally, on top of the AP in FlexConnect mode,
you need to enable FlexConnect Local Switching on the wanted WLAN too.

Since AireOS 8.2, when changing the AP mode from local to FlexConnect, the AP does not need to reboot anymore.
Other changes in the AP mode, for example from FlexConnect back to local or any other combination, require the AP
to reboot.

Monitor mode is another option that has been available for many years to set the AP in a “listening” operational status.
An AP in monitor mode does not serve any wireless client and keeps cycling through different wireless channels to scan
for rogue APs, attacks, RRM stats (such as Channel Utilization), and interferences (if supported by the AP model).

Channels, which a monitor mode AP should cycle through, can be just those allowed for Dynamic Channel Assignment
(DCA), those allowed by the Country code configured for the AP, or all channels. As shown in Figure 4-13, you can
configure this for the 2.4 GHz or 5 GHz band under WIRELESS > 802.11a/n/ac or 802.11b/g/n > RRM > General.
This setting applies to all AP operational modes, not just to monitor mode APs.

Figure 4-13 Example of Monitoring Channels Configuration for the 5 GHz Band

The screenshot shows General option, under RRM sub-section of 802.11a/n/ac section, under Wireless menu
selected. Under Profile Threshold for Traps, the following fields are listed: Interference (0 to 100 percent),
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Clients (1 to 200), Noise (negative 127 to 0 dBm), and Utilization (0 to 100 percent). Under
Noise/Interference/Rogue/CleanAir Monitoring Channels shows Channel List spin box set to Country
Channels. Under Monitor Intervals (60 to 3600 secs) shows three field boxes: Channel Scan Interval, Neighbor
Packet Frequency, and Neighbor Timeout Factor (5 to 60). Under Factory Default, Set to Factory Default
button is present. Foot Notes read, CleanAir monitoring is done on these channels only when the AP is in
monitor mode.

Saying that monitor mode APs are solely for monitoring purposes would not be 100% accurate: they also support
containment actions when rogue APs are detected (more on this in the next sections).

To detect whether a rogue AP is connected to a specific subnet/VLAN on your wired network, you can deploy APs in
Rogue Detector mode. A rogue detector AP has its radios disabled, and through its Ethernet interface it listens for ARP
messages from rogue APs or rogue clients. If a MAC address from a rogue AP/client, plus or minus 1 in the last right-
most byte, is seen in ARP messages on the wired network, it means that the specific rogue AP has access to one of the
VLANs monitored by the rogue detector AP. More details on rogue detection techniques and options are available in
one of the next subsections of this chapter.

The rogue detector mode is not supported on COS APs.

Mainly for troubleshooting purposes, an AP can also act as a remote sniffer, from which you can collect a wireless trace
directly on your machine. This is the purpose of the Sniffer mode. After changing the AP mode to Sniffer and waiting
for the AP to reboot, under the configuration of each AP’s radio you will see an option for Sniffer Channel Assignment
(WIRELESS > Access Points > Radios > 802.11a/n/ac or 802.11b/g/n and then by selecting the sniffer AP). Here you
can specify the main channel (for channel widths greater than 20 MHz) to sniff for taking the wireless trace, as well as
the server IP address, which is the IP of your machine, where tools such as Wireshark or OmniPeek should be running.
The trace is collected by the AP and centrally forwarded to the WLC, which will in turn send it to the configured server
IP address. You will receive the trace on your machine sourced from the WLC’s management IP, as UDP traffic from
port 5555 and with UDP port 5000 as destination. All the details on how to configure an AP in Sniffer mode and capture
a trace through Wireshark or OmniPeek are available in the official document “Fundamentals of 802.11 Wireless
Sniffing”:

https://www.cisco.com/c/en/us/support/docs/wireless-mobility/80211/200527-Fundamentals-of-802-11-Wireless-
Sniffing.html

Note

If Air Time Fairness (ATF) is enabled, trying to change the AP mode to Sniffer (or some other modes too) might fail. On
the WLC’s GUI you may see no warning/error messages and on the CLI you should see a message similar to the
following:

Click here to view code image

(Cisco Controller) >config ap mode sniffer <AP_Name>

Changing the AP's mode will cause the AP to reboot.
Are you sure you want to continue? (y/n) y
Unable to set AP in this mode. Air Time Fairness needs to be disabled.

To prevent this, you can disable ATF globally through the following commands:

Click here to view code image

(Cisco Controller) >config atf 802.11a mode disable
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(Cisco Controller) >config atf 802.11b mode disable

For mesh deployments, the dedicated AP mode is Bridge. When you configure the Bridge mode, the AP by default
reboots as a Mesh AP (MAP) and tries to register to the WLC via the radio backhaul or the wired backhaul, if its
Ethernet interface is connected. You can modify the mesh mode to Root AP (RAP), for example, under the Mesh tab
settings of the AP, as shown in Figure 4-14, which become available after configuring the Bridge mode itself.

Figure 4-14 Example of the Mesh Settings Activated After Configuring the Bridge Mode on the AP

The following tabs are present at the top: General, Credentials, Interfaces, High Availability, Inventory, Mesh
(selected), and Advanced. The settings of the mesh tab are as follows: AP Role spin box is set to MeshAP,
Bridge Type, Bridge Group Name field box, Strict Matching BGN checkbox, Ethernet Bridging checkbox
(selected), Preferred Parent field box reading none, Backhaul Interface, Bridge Data Rate (Mbps) spin box is
set to auto, Ethernet Link Status, PSK Key TimeStamp, VLAN Support checkbox. Delete PSK button is
present. Mesh RAP Downlink Backhaul section shows RAP Downlink Backhaul option set to the radio button,
5 GHz. Enable button is present.

Mesh is used to interconnect APs through a wireless backhaul instead of a standard wired Ethernet one. At least one
AP, called the Root AP, must have wired connectivity to forward traffic to the uplink backend network. Other APs
without wired connectivity can associate to the Root AP (or between them) via either the 5 GHz band (the default
behavior) or the 2.4 GHz one, and use this radio link as their uplink to the rest of the network. These APs are referred to
as Mesh APs in the WLC. Although technically all APs can communicate with each other for calculating and building
the mesh backhaul, at any specific point in time an AP won’t be communicating with all other APs at the same time.
Mesh APs negotiate an optimized “path” to the Root AP, and recalculate such a path dynamically if conditions change
(for instance, a MAP becomes unavailable, a DFS event is triggered, an interference occurs, and so on). Because of this
capacity of all APs communicating with one another, the term mesh is used.
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Although mesh deployments are often associated with APs installed outdoors, wireless mesh networks are used indoors,
too, where Ethernet cables cannot be pulled to provide wired backhaul connectivity (warehouses, storage depots,
manufacturing facilities, and so on). The Bridge mode is supported on indoor/outdoor IOS APs and on outdoor COS
APs (for example, the 1540 and 1560 series APs). At the time of this book’s writing and for AireOS 8.3, the Bridge
mode and mesh options are not supported on indoor COS APs (1800/2800/3800 series APs).

Traffic from wireless clients associated to mesh APs in Bridge mode is centrally switched through the WLC.
Communications between MAPs, as well as between MAPs and RAPs, are encrypted through AES. Client’s data traffic
is encapsulated in CAPWAP and carried over the air within the mesh header. After reaching the RAP, the CAPWAP-
encapsulated client’s data traffic is carried all the way up to the WLC, as for a standard AP in local mode, for example.
The WLC then bridges the client’s traffic on the VLAN of the corresponding dynamic interface.

Note

Although detailed in one of the next sections focusing on mesh architectures, we prefer to already quickly distinguish
the switching model for wireless clients from the one for wired clients connected behind a RAP/MAP. Some AP models
in Bridge mode (or Flex+Bridge) support connecting wired clients to a dedicated, auxiliary Ethernet port on the AP.
This feature is also referred to as Ethernet Bridging. Wired clients behind a MAP/RAP are locally switched at the
RAP’s level, on a VLAN of the switch port’s trunk, where the RAP is connected; these wired clients are not centrally
switched all the way up through the WLC.

Quite close to the FlexConnect, mesh APs can also be deployed in Flex+Bridge mode. With this option, wireless clients’
traffic is locally switched at the RAP’s level, on a VLAN of the switch port’s trunk, where the RAP itself is connected.
As with FlexConnect, the Flex+Bridge mode provides some additional survivability features: If the uplink connectivity
with the WLC is lost, clients associated to Flex+Bridge mesh APs, and to a FlexConnect Local Switching enabled
WLAN, keep being locally switched at the RAP’s level, without losing connectivity. All other mesh principles for
communications between MAPs, and between MAPs and RAPs, stay the same, as for the more “classic” Bridge mode.

For spectrum monitoring and troubleshooting purposes, the Spectrum Expert Connect (SE-Connect) mode configures an
AP into some sort of remote antenna, supporting physical layer visibility of wireless frequencies through a spectrum
analysis tool installed on your PC. You can configure the SE-Connect mode only on APs supporting the CleanAir
technology (2700, 3700, 2800, 3800 series APs), which is based on a dedicated radio chipset for inline monitoring of
802.11 frequencies, as well as interference detection and classification. CleanAir is the Cisco rebranding of the former
Cognio solution, acquired in 2007 and integrated in the APs portfolio since 2010. Cognio Spectrum Expert was the
original name of the tool used to connect to Cognio antennas for spectrum analysis: Cisco still provides a similar tool,
under the name of Cisco Spectrum Expert, available for up to Windows 7 operating systems:

https://software.cisco.com/download/release.html?
mdfid=281783245&flowid=7035&softwareid=281789927&release=4.1.11

For machines with newer Windows operating systems, you would need to use the Metageek Chanalyzer tool to connect
to an AP in SE-Connect mode:

https://support.metageek.com/hc/en-us/articles/200591105-Connecting-Chanalyzer-to-a-Cisco-CleanAir-Access-
Point

An SE-Connect AP does not serve wireless clients and monitors the full spectrum of 802.11 frequencies, both in the 2.4
GHz and 5 GHz bands. To communicate with an SE-Connect AP, the Cisco Spectrum Expert or the Metageek
Chanalyzer tools need the AP’s IP and a key, which is visible under the AP’s general details, as shown in Figure 4-15.
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Figure 4-15 Example of an SE-Connect AP’s General Details, with the Key for  Analysis Tools

The general tab shows three sections: General, and GPS Location. The general section lists the following: AP
Name field box reading AP-2702I.e7f0, Location field box reading default location, AP MAC Address, Base
Radio MAC, Admin Status spin box set to Enable, AP Mode spin box set to SE-Connect, AP Sub Mode spin
box set to None, Operational Status, Port Number, Venue Group spin box is set to Unspecified, and Venue
Type spin box is set to Unspecified. Three buttons, Add New Venue, Venue, and Language Name are shown.
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Below the buttons, Network Spectrum Interface Key reads, Ec0826AA899406950DA8ACC1523FCCF. Under
GPS Location section, GPS Present (No) option is present.

If you already worked with APs in local or Monitor mode before, you may have noticed that such a key is available
under these modes too. Local or Monitor mode APs integrating the CleanAir technology also support spectrum visibility
and analysis through the Cisco Spectrum Expert or Metageek Chanalyzer tools. Local mode APs provide spectrum
visibility just for the channel where they are serving clients. Monitor mode APs support spectrum visibility for all
802.11 frequencies.

So what are the differences between Monitor mode and SE-Connect mode for spectrum analysis purposes? Technically,
not too many. SE-Connect was originally developed as the only mode to allow connectivity to a CleanAir-capable AP
with a remote spectrum analysis tool, and at that time local and Monitor modes didn’t support such a feature.
Subsequent AireOS versions implemented support for connecting to a CleanAir-capable AP with a remote spectrum
analysis tool even with an AP in local or Monitor mode. The Monitor mode scans all frequencies and supports spectrum
analysis; it technically does not differ too much from the SE-Connect mode. However, SE-Connect, having been
designed from the beginning for the sole purpose of spectrum analysis with a remote tool, goes through some slightly
more scanning periods (that is, dwells) as compared to the Monitor mode. For the best troubleshooting options, it is still
recommended to use the SE-Connect mode.

Accessing Configuration Settings and Logging Options for APs

Lightweight APs are mainly managed through the WLC, which is the device pushing the vast majority of the
configuration parameters. You can still configure some settings on the APs directly via CLI, mainly for options such as
a static IP, or even primary, secondary, and tertiary WLC IPs. As seen in the previous subsection, 802.1X credentials
can also be configured via CLI on the AP directly. To generalize these concepts a bit more, we could say that the AP’s
CLI provides you with the needed commands to manually connect an AP to the network and register it to the WLC.

All the details on other useful commands for a lightweight AP’s CLI are documented in the official “Cisco Wireless
Controller Command Reference”:

https://www.cisco.com/c/en/us/td/docs/wireless/controller/8-3/command-reference/b-
cr83/miscellaneous_commands_2.html

IOS-based lightweight APs still allow you to access all the CLI commands available for autonomous APs. You can
achieve this through the command debug capwap console cli in enable mode (the command is hidden, so autocomplete
through the tab key does not apply). From here, you could theoretically use any other command available for
autonomous IOS APs. On top of not being officially recommended or supported, commands for the autonomous mode
applied in lightweight mode through this technique do not survive a hardware reset of the AP. Thanks to this option you
can still force some operations, such as a reimage, an upgrade, or even a conversion of the AP from lightweight to
autonomous. The following command sequence shows an example of how to push a new image file for these use cases:

Click here to view code image

ap# debug capwap console cli
ap# archive download-sw /force-reload /overwrite tftp://TFTP_Server_
  IP/Image_File_Path
Note

COS APs do not support the debug capwap console cli command because there are no IOS commands or autonomous
mode for these APs.

The WLC pushes all other AP’s parameters for nominal wireless operations. All features that you can configure through
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the WLC’s GUI are available via CLI too. The reverse is not always true, because some CLI commands do not have an
equivalent in the WLC’s GUI (for example, the management via the dynamic interface setting that we saw in one of the
previous sections).

The main menus and commands affecting the AP’s settings and behavior are under the WLANs and the WIRELESS
tabs. Under WLANs you can create wireless networks but also assign APs to AP groups. Under the WIRELESS tab you
have access to even more specific options, on a per-AP basis, as well as on a more global level.

By browsing to the details of an AP under WIRELESS > Access Points > All APs and clicking the wanted AP, you
can access different tabs to set the operational mode (for example, local, FlexConnect, Bridge, and so on), the
credentials, primary/secondary/tertiary controllers’ coordinates, FlexConnect/Mesh related parameters (if the AP is in
FlexConnect/Bridge mode), and so on. Settings applied through these tabs, directly at the AP level, override those that
you could push through FlexConnect groups, or other logical groups, for example. The WIRELESS section also
provides access to all the radio settings, again either on a per-AP basis, at the AP group level through RF profiles, or
even at a more global level for all APs. Other main features available under the WIRELESS tab include advanced RF
management (for example, Flexible Radio Assignment, Rx SOP, optimized roaming), Mesh, Application Visibility and
Control (AVC), or even QoS. Because this book is more focused on theory of operations, and because configuration
details are reserved to the Wireless CCIE lab, we explicitly decided to leave those to the official “Cisco Wireless
Controller Configuration Guide”:

https://www.cisco.com/c/en/us/td/docs/wireless/controller/8-3/config-guide/b_cg83/b_cg83_chapter_011111.html

and the “Enterprise Mobility 8.1 Design Guide”:

https://www.cisco.com/c/en/us/td/docs/wireless/controller/8-1/Enterprise-Mobility-8-1-Design-
Guide/Enterprise_Mobility_8-1_Deployment_Guide.html

On top of configuring AP’s features, you may want to consider additional logging options for sending syslog messages.
An AP not yet registered to a WLC by default sends syslog messages to the broadcast IP 255.255.255.255. It is usually
a good practice to dynamically assign a syslog server to your APs through the DHCP option 7. This could, for example,
prevent an overload of broadcast messages if many APs are deployed on the same subnet/VLAN. When an AP joins the
WLC, the syslog configuration on the WLC, if any, overrides the one received via DHCP option on the AP. On the
WLC you can configure a syslog server, for all APs or for a specific AP, with the following commands:

Click here to view code image

config ap logging syslog facility {facility name}
config ap logging syslog level {syslog level}
config ap syslog host global {server IP} (for all APs)
config ap syslog host specific {AP name} {server IP} (for a specific AP)

Facilities are used in syslog messages to identify which process generated the corresponding messages. For the purpose
of simply sending logs from a device, there is technically no wrong choice among the many facilities. You could think of
the facility as a “tag” or additional information in the syslog message to recognize the source process, or the device,
sending that message. Their main goal is therefore to allow you better organizing messages on the syslog server itself, so
that you can, for example, filter all logs from the same source/process/device thanks to a specific facility level.

Through the syslog level, on the other hand, you decide which categories of syslog messages are sent (Critical,
Warnings, Informational, Debugging, and so on). When you set a specific level, messages belonging to all other lower
levels are automatically sent too. For example, the Warnings level will also cause logs in the Critical level to be sent. If
for troubleshooting purposes you had to enable the Debugging level, for example, it is usually recommended to lower
the level back to a less verbose one after the troubleshooting phase, so as not to overflow your syslog server with
additional messages when not needed anymore.
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From the WLC, you can also view the event logs from an AP directly with the command show ap eventlog {AP
name}.

For logs from the WLC itself, you can access similar settings directly through the GUI, under MANAGEMENT > Logs
> Config, or else through the CLI with the config logging [...] command options.

High Availability and Redundancy

Along with planning and deploying your wireless network, as a Wi-Fi expert you may often be questioned about how to
make that network redundant. We could approach high availability needs from different sides and through different
options: on the radios, on the APs, on the controllers, and so on.

As a first option, and because this is most likely happening during the initial radio design phase, you could consider
planning for a redundant radio frequency (RF) coverage/capacity. When simulating and verifying your site survey with
tools, such as Ekahau or Airmagnet, you could plan coverage areas and APs placements, so that at each point on the
map the second loudest AP should still be heard with a signal strength powerful enough to keep serving clients, if the
main loudest AP at that same point of the map would fail. Figure 4-16 shows an example of the options for displaying
the coverage of the second strongest APs in Ekahau.
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Figure 4-16 Example of Options for Displaying the Second-Strongest APs Coverage on a Map with Ekahau

The snapshot shows an option visualization mode: smooth or detailed; a scale set to 2m; a slider set to very;
signal prediction with five options: off, current floor, plus or minus floor, plus or minus 2 floors, and all floors;
adapter spin box set to Raw Measurements; Show the spin box set to second strongest; and signal at spin box
set to all channels.

Cisco provides software-based features in the WLC, through Radio Resource Management (RRM) algorithms, to allow
APs to increase their transmit power levels when they identify a coverage hole. The rules under which a coverage hole
event is triggered depend on many factors, and the WLC might not necessarily always increase the transmit power of an
AP, if that would cause co-channel interferences with other APs, for example. For such reasons, on top of relying on
RRM’s coverage hole detection in software, you may want to consider planning for radio redundancy right from the
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beginning, during the initial site survey phase.

At the AP’s level itself, some models present an auxiliary Ethernet port. However, such an additional interface can be
used for increased bandwidth but not for uplink high availability. On the 1850/2800/3800 series APs you can configure
link aggregation when these APs are in local mode:

https://www.cisco.com/c/en/us/support/docs/wireless/aironet-3800-series-access-points/200898-Link-aggregation-
on-1800-2800-3800-AP.html

The goal of the auxiliary port on these latest AP models addresses the additional bandwidth requirements introduced by
the 802.11ac Wave 2 certification. Nevertheless, for uplink connectivity and PoE+ powering options, the “standard”
primary Ethernet port must always be connected anyway.

Note

Previous AP generations (1700 and 2700 series) have an auxiliary Ethernet port, although not for increased bandwidth
purposes. The auxiliary port for 1700/2700 APs is supported to bridge a wired client on the same subnet/VLAN as for
the uplink Ethernet interface of the AP.

Redundancy when planning for RF coverage during the site survey, as described in the aforementioned paragraphs,
could be seen as some kind of high availability for APs, where one AP can cover another AP’s cell in case of failure.

We already detailed redundancy for the WLC’s ports when describing its interfaces and link aggregation options. In the
following paragraphs we address high availability options more in terms of primary, secondary, and tertiary WLCs, or
active and standby controllers.

For pure FlexConnect deployments, APs already provide some survivability in case the WLC is unavailable. Although
you could lose the possibility to push configuration changes, already connected clients in FlexConnect local switching
are not affected by the loss of the WLC. Sometimes this is acceptable for some deployments, for which WLCs
redundancy might become less structural than for centrally switched wireless networks, for instance.

N+1 and N+N High Availability

The more legacy high availability (HA) model for WLCs is what has often been referred to as N+1, or even also N+N.
We could generalize it as N+X, with X greater than or equal to 1 (and usually less than or equal to N, although
technically not necessary). The first N refers to your primary WLCs, among which you distribute your lightweight APs.
The second digit after the plus sign (1, N, or another X) represents the number of secondary controllers ready to take
over the APs from one or more of the primary WLC(s) in case of failure.

This notation is mainly used to indicate the number of backup controllers, and sometimes we just keep the first N as is,
without necessarily specifying the number of primary controllers. We could, for example, state that we deployed 3+2
controllers to say that there are 3 primary and 2 secondary WLCs. Or we could also say that we deployed 3 controllers
with an N+2 HA model, as a “synonym” to describe that there are 2 secondary controllers for backup.

You may want to achieve redundancy with an N+1, an N+2, or an N+3 or more HA model. There is not necessarily a
fixed rule for how many secondary controllers you should deploy. To push this concept a bit further, we could, for
instance, have just one 5508 WLC as primary with four 2504s as secondary WLCs, and we would talk about a 1+4 HA
model. Point taken, this might not be one of the most common scenarios; we just used an exception as a further example
of the theory.

Sometimes, if tertiary controllers are deployed, we could even start using the N+X+Y notation: for example, N+1+1
would indicate that we deployed a secondary and a tertiary WLC, N+3+2 would describe a deployment with three
secondary and two tertiary WLCs, and so on.
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The two most common N+X HA models are the N+1 and N+N. The former indicate that we have just one WLC as
secondary for all the other primary WLCs. The latter is used for deployments, where we have as many secondary
WLCs as the number of primary ones. With N+1 HA, because there is just one secondary WLC, you might need to
“sacrifice” some APs in case all your primary WLCs fail and the secondary one does not scale enough to take over all
APs. However, if you deployed one, big, fat WLC as secondary for one or more “smaller” WLCs, the N+1 HA model
could still provide full redundancy. An example is a deployment with four 5508s as primary WLCs and an 8510 or an
8540 as secondary, in an N+1 HA model. An 8510 or an 8540 WLC can support up to 6000 APs, hence scaling high
enough to take over the full load from four 5508s (or even more).

In an N+1 or N+N HA deployment all WLCs are active. Originally, you didn’t have to enable a specific feature to tell a
WLC that it was primary, secondary, or tertiary. It’s at the AP’s level that we point the AP to one WLC or another.
More recently this notion changed a little bit at the WLC’s level, and we will see how in the next paragraphs, because
this also involves a more recent licensing model.

APs are configured with primary, secondary, and even tertiary WLCs if needed. A primary WLC for some APs could
be the secondary or the tertiary for some others. Take, for instance, two primary WLCs with just one backup WLC, as
in an N+1 HA deployment; we’ll call WLC-1 and WLC-2 the primary WLCs and WLC-3 the backup one. Some APs
could point to WLC-1 as primary, WLC-2 as secondary, and WLC-3 as tertiary. Some other APs could point to WLC-2
as primary, WLC-1 as secondary, and WLC-3 as tertiary. This example works under the assumption that WLC-1 and
WLC-2 would both have enough licenses to support at least some or even all the APs from one another. But this is
actually not 100% true if we take into account the Smart Licensing feature introduced as of AireOS 8.2, although for
5520 and 8540 WLCs only (and the 3504 WLC too, starting from the even more recent AireOS 8.5):

https://www.cisco.com/c/en/us/td/docs/wireless/technology/mesh/8-2/b_Smart_Licensing_Deployment_Guide.html

By activating the Smart Licensing solution, you configure the WLC to communicate with servers hosted on the Cisco
cloud, which keep track of the licenses you bought, to use them in some kind of license pool fashion. Each WLC using
Smart Licensing will communicate with your account on the Cisco cloud and update the license counter when an AP
registers or deregisters. If your WLCs start asking for more licenses than what are allocated, Smart Licensing does not
block any new AP from registering. By default, an AP is always accepted by a WLC up to its HW limit (1500 APs for
the 5520 WLC and 6000 APs for the 8540 WLC), and the license counter is updated accordingly. If your WLCs have
more APs than the number of licenses bought and available on your Smart Licensing account, a warning message is
displayed, but again, APs won’t be denied from registering to a WLC. This solution allows buying licenses for the exact
number of APs you are deploying, and configure primary, secondary, and tertiary controllers without worrying about
installing extra licenses, which might not be used all the time.

Even before the release of Smart Licensing on more recent WLC generations, as of AireOS 7.4, Cisco introduced the
AP and then the Client Stateful Switch Over (SSO) feature, as well as high availability controller models (or HA stock
keeping units [SKU]) for their appliance-based WLCs. SSO is detailed in the next section, but if we focus on N+1 HA
for now, we can already see how HA WLC models play a role as secondary or tertiary controllers too. An HA SKU
controller (for example, AIR-CT5508-HA-K9, AIR-CT8510-HA-K9, AIR-CT7510-HA-K9, and AIR-CT2504-HA-K9)
accepts any number of APs up to its HW limit, without the need to install any AP license. This means that you can
deploy an HA SKU controller as secondary (or even tertiary) WLC at no additional license cost. It also turns out that
any “standard” WLC model can be used as an HA SKU, because high availability features are in the end purely based
on a software configuration and not necessarily tied to specific hardware models. An HA SKU controller is shipped
ready to accept APs up to its HW limit; a regular WLC can be configured to accept APs up to its HW limit through the
SSO redundancy options under CONTROLLER > Redundancy > Global Configuration, as shown in Figure 4-17, by
setting the option Redundant Unit to Secondary (the option SSO should stay Disabled).
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Figure 4-17 Configuration Example to Convert a Standard Controller into an  HA WLC

The screenshot shows Global Configuration under Redundancy section of Controller menu is selected. The
Global Configuration page lists the following: Redundancy Mgmt Ip field box reading 0.0.0.0, Peer Redundancy
Mgmt Ip field box reading 0.0.0.0, Redundancy port Ip (169.254.10.31), Peer Redundancy Port Ip
(169.254.10.33), Redundant Unit spin box is set to Secondary (highlighted), Mobility Mac Address field box
reading 84:B2:61:18:AC:5D, Keep Alive Timer (100  1000) field box reading 100 milliseconds, Keep Alive
Retries (3  10) field box reading 3, Peer Search Timer (60  300) field box reading 120 seconds, Management
Gateway Failover spin box is set to Disabled, and SSO spin box is set to Disabled. Foot Notes read, redundancy
management and peer redundancy management are mandatory parameters for SSO enable, configure the keep-
alive timer in milli seconds between 100 and 1000 in multiple of 50, configuring keep alive parameters when
HA enabled might cause failover if RP link latency is high, and peer service port IP address and the netmask
will be pushed to the Peer only if the connection is established.

Note

A standard 5508 WLC must have at least 50 AP licenses to be converted into an HA controller. Similarly, a 2504 WLC
must have at least 25 AP licenses.

An HA SKU controller, or a standard WLC converted to HA, is ready to accept as many APs as its HW limit, but that
should not last longer than 90 days. After 90 days, no feature ceases to work. All WLC functionalities keep running and
APs can still register. The WLC, however, starts logging console and syslog messages about the fact that the 90-day
period has expired. An HA WLC should be used as a secondary/tertiary controller, not as a primary one: the assumption
is that after those 90 days the APs should have reverted back to their primary WLC(s), for example, because
reachability has been reestablished or because a replacement has been provided in case of an HW failure. An HA WLC
does not know whether it is being used as secondary or tertiary, so you can point APs to HA WLCs as either secondary
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or tertiary. Although technically possible because no features are blocked, you should not use an HA WLC as primary;
otherwise, you would be running an officially unsupported scenario, and Cisco might refuse to provide technical
assistance. As a further note, an HA SKU controller can be turned into a standard WLC, under CONTROLLER >
General, by setting the option HA SKU Secondary Unit to Disabled. From this point you can use the HA SKU WLC as
any other standard WLC, keeping in mind that by default it will have no AP licenses.

If we now consider again an N+1 deployment, we could, for example, have the N primary controllers either running
local licenses or using the Smart Licensing pooling solution, while the one secondary controller could be an HA WLC
accepting as many APs as its HW limit up to a period of 90 days. The same would apply to an N+N deployment, with N
secondary HA WLCs.

In the past, for APs to switch between primary, secondary, and tertiary controllers, all WLCs needed to share the same
virtual interface IP address and the same mobility group name. More precisely, every WLC must be declared in each
other’s mobility domain, with the same mobility group name, under CONTROLLER > Mobility Management >
Mobility Groups. On top of that option, nowadays you can also just configure APs with the controllers’ names and IPs
under each AP’s High Availability options to support failover even without having those WLCs in the same mobility
group.

To clarify the terminology, the mobility domain of a WLC is the list of its other WLC peers under CONTROLLER >
Mobility Management > Mobility Groups, with or without the same value for the mobility group under the column
Group Name. The mobility group is a string value, a name, identifying precisely the mobility group of a WLC. Again, to
support APs’ failover between WLCs without configuring those WLCs’ IPs under the APs’ High Availability options,
those WLCs must all be declared in each other’s mobility domain, with the same mobility group name. The same holds
true for key reuse of clients roaming between different controllers (inter-controller roaming): WLCs must be in each
other’s mobility domain, with the same mobility group name. For other scenarios, such as guest anchoring, for a foreign
WLC to tunnel traffic for a specific WLAN to an anchor WLC, WLCs must be in each other’s mobility domain, but
they do not need to share the same mobility group name.

Note

The WLC’s GUI, under CONTROLLER > General, allows you to configure what it calls the Default Mobility Domain
Name. Although this may seem confusing, this field sets the WLC’s mobility group name.

You can configure primary, secondary, and tertiary WLCs for an AP through the WLC GUI, under WIRELESS >
Access Points > All APs, by clicking the wanted AP and browsing to its High Availability tab. To industrialize the
process, you can also push high availability settings to multiple APs at once through Cisco Prime Infrastructure. One
more option could also be the Plug-and-Play solution with APIC-EM, as described in a previous section.

One of the main advantages of the N+1/N+N HA model is that controllers can be separated across L3 boundaries;
hence their management IPs do not need to reside on the same subnet/VLAN. On the other side, when an AP switches
from one WLC to another, it needs to reregister to the new WLC. One of the main consequences is that the clients are
disconnected and need to go through a full association again with the new WLC (in fact, there is a period of downtime
between primary WLC failure and the time it takes for the AP to reregister with the backup WLC).

For any additional configuration details on N+1 HA, you can also refer to the official “N+1 High Availability
Deployment Guide”:

https://www.cisco.com/c/en/us/td/docs/wireless/technology/hi_avail/N1_High_Availability_Deployment_Guide.html

Note that N+1 or N+N redundancy (and AP/Client SSO) is not supported with vWLCs until AireOS 8.4.

Mobility Express does not support mobility groups, hence no notion of N+1/N+N or SSO redundancy. However, as
mentioned in the previous section introducing Mobility Express, VRRP is used to ensure high availability for this type of
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deployment.

AP and Client Stateful Switch Over

Cisco was the first vendor on the market to introduce full stateful redundancy features for both APs and clients. AireOS
7.3 supported the initial version of stateful switch over (SSO) for APs, and AireOS 7.5 started supporting SSO for clients
too.

SSO is configured between two controllers only, one acting as primary/active and the other as secondary/standby. The
term stateful points to the fact that an AP’s or client’s session is fully replicated from the active to the standby WLC. In
case of failover, the standby WLC is ready to seamlessly take over APs and clients with almost no interruption in their
communications. We carefully use the adverb “almost” here, because clients may experience some minor latency for
some traffic categories. Nevertheless, no connectivity is lost: APs do not need to register again and clients must not
reassociate, reauthenticate, or go through DHCP again to obtain a new IP address. This solution presents major benefits
for APs and wireless clients, but it also contributes to not overload network services behind the WLCs in case of a
failover. Because APs and clients do not need to go through registration, authentication, or even DHCP again, for
example, those network services do not risk being called into play all of a sudden and for many APs/clients
concurrently. For instance, RADIUS servers do not need to reauthenticate all wireless clients at once because a WLC
failed and those clients had to reconnect altogether.

Sometime we also refer to the active and standby WLCs as a “pair.” When configured for SSO, the two controllers
share the same management IP and are seen by the rest of the network as one single device.

AP/Client SSO has been enhanced with additional features through different AireOS versions; you can find all the
details of such functionalities in the official “High Availability (SSO) Deployment Guide”:

https://www.cisco.com/c/en/us/td/docs/wireless/controller/technotes/8-1/HA_SSO_DG/High_Availability_DG.html

We will hereafter list some of the main characteristics of AP/Client SSO, while leaving all other configuration details to
the aforementioned official guide:

Controllers of an SSO pair need to be of the same HW models among the following: 5500, 7500, 8500, and WiSM2
series WLCs. The more recent 3504 series WLC supports AP/Client SSO too.

Round trip time (RTT) latency between management IPs of the active and standby WLC should not exceed 80
milliseconds by default.

The bandwidth between the two controllers should be of at least 60 Mbps.

Only sessions for connected clients in the RUN state are synchronized between active and standby WLCs, and as of
AireOS 8.0, the sleeping client cache is replicated too. Clients in other states (for example, 802.1X_REQD,
DHCP_REQD) have to go through a new association in case of failover.

You must configure the management IPs from both the active and standby WLC on the same subnet/VLAN for
SSO to be supported.

The choice between keeping the controllers on the same Layer 2 or separating them across Layer 3 boundaries
could sometimes be one of the main decision factors when evaluating the N+1 HA model or SSO.

SSO requires the two controllers to communicate through an additional dedicated port, called the Redundancy Port
(RP), as well as to create another logical interface, called the Redundancy Management Interface (RMI), on the
same subnet/VLAN as the regular management interface.
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For SSO to work, you must reserve four IP addresses in the management subnet/VLAN: two IPs for each WLC’s
management interface and two IPs for their corresponding RMIs. The SSO configuration process assigns
autogenerated IPs in the 169.254.X.Y format to the redundancy ports, which also have to be connected on the same
VLAN (when using switches between RPs; normally, they are directly connected without switches in between).
This VLAN associated to the RPs, however, needs to exist just to allow the RPs from the two WLCs to
communicate and does not have to be propagated anywhere else: it must not be the same VLAN as the management
and RMI interfaces, and should be pruned from their corresponding ports if possible.

AP/Client SSO represents nowadays the most common high availability model, with even more deployments than the
“legacy” N+1 HA. New installations, where the requirement for WLCs on the same subnet/VLAN can be introduced
from the beginning, implement AP/Client SSO more often because of the reduced downtime in case of failover.

Segmenting Your Wireless Network

The term segmentation can have several applications, but in this specific section we will use it in the context of
separating radio settings, network parameters, and features between different groups of APs.

RF Profiles

The first tool you may consider to assign different radio settings to different sets of APs are RF profiles. They were
introduced as of AireOS 7.2 with the purpose of differentiating RRM parameters on a per AP Group basis.

You can configure RF profiles under WIRELESS > RF Profiles, where you might already see that some default
profiles are already automatically created for low, typical, or high client density.

When creating a new RF profile, you first need to choose whether it applies to the 2.4 GHz or the 5 GHz radio, and then
you can optionally make it inherit settings from one of those pre-canned profiles. Each profile allows customizing
parameters for data rates, RRM algorithms, high density features, and client load balancing options, as shown in Figure
4-18.
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Figure 4-18 Example of Configuration Tabs from an RF Profile

The screenshot shows RF Profiles under Wireless menu selected. The Edit CCIE-RF-Profile-5GHz page shows
the following tabs: General, 802.11 (selected), RRM, High Density, and Client Distribution. The following data
rates along with the spin boxes are listed on the left: 6 Mbps (disabled), 9 Mbps (disabled), 12 Mbps
(mandatory), 18 Mbps (supported), 24 Mbps (supported), 36 Mbps (supported), 48 Mbps (supported), and 54
Mbps (supported). The MSC settings along with checkboxes are listed on the right.

By assigning an RF profile with all data rates disabled for a specific 802.11 band, for example, you can kind of
“disable” that band on a distinct set of APs. In a similar way, you could influence throughput, coverage zones, or even
roaming behaviors for clients of a specific area or site. A typical use case for segmenting RRM configuration by AP
groups could be to assign different sets of channels to some other areas of your deployment. This may be required if
those zones cannot operate on specific frequencies, or if some channels need to be reserved for particular devices and
use cases. In other situations you might have to tweak settings for transmit power control (TPC) calculations so that
certain APs do not lower their power level below a given threshold. This could be the case for APs installed on higher
ceilings, which should keep a minimum signal stronger than APs mounted at more standard heights.

High-density options under an RF profile, such as the Receiver Start of Packet (Rx SOP) threshold, let you push the
configuration for customized receiver “sensitivity” to some APs only.

After creating an RF profile, you need to assign it to an AP group for its settings to take effect on the wanted APs. Each
AP group’s configuration menu has a dedicated RF Profile tab, as shown in Figure 4-19, where you can assign a profile
for the 802.11a (that is, the 5 GHz) band and/or another profile for the 802.11b (that is, the 2.4 GHz) band.
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Figure 4-19 Tab for Assigning RF Profiles Under an AP Group

The screenshot shows WLANs tab selected from the main menu tabs at the top. AP Groups option from
Advanced section under WLANs. The Edit CCIE-AP-Group page displays the following tabs: General,
WLANs, RF Profile (selected), APs, 802.11u, Location, and Ports/Module. The RF Profile tab shows 802.11a
spin box set to CCIE-RF-Profile-5GHz and 802.11b spin box set to none. Apply button is present at the top-
right corner.

AP Groups

As seen in the previous paragraphs, AP groups are tightly related to RF profiles because you apply those profiles under
the AP groups’ configuration directly. However, AP groups were originally introduced to customize some WLAN
settings for specific sets of APs. You can access them under WLANs > Advanced > AP Groups in the WLC’s GUI.

A default AP group is always present in the WLC’s configuration: all APs are assigned to this group by default, unless
you configure the Out-Of-Box AP group or push the AP group settings through APIC-EM PnP before the AP joins the
WLC. Through an AP group, you can configure which SSIDs are served by which APs, and optionally remap those
SSIDs to different dynamic interfaces from those configured under the WLANs settings themselves. Other tabs of an
AP group allow you to customize details for 802.11u, hyperlocation and ports/modules, for APs supporting them.
However, the main use case of an AP group is to define which APs are serving which WLANs and, optionally, to
reassign those WLANs to specific dynamic interfaces.

Only WLANs with an ID of 16 or lower are assigned to the default AP group and cannot be unassigned from it. Other
WLANs with a higher ID cannot be assigned to the default AP group. Also, any other new AP group that you create
will not have any WLAN or any AP assigned to it by default.

By creating WLANs with an ID of 17 or higher, you can therefore prevent unwanted APs from automatically starting to
serve those WLANs when they first join the WLC. If all your WLANs have an ID of 17 or higher, you need to assign
those WLANs to a specific, nondefault AP group, for them to be served by your APs; your APs need to be manually
assigned to that same AP group too. We already mentioned this technique when describing options for AP authorization
through one of the previous sections, but you could find it useful for SSID planning too. Different zones or sites
exploiting the same wireless infrastructure might have separate needs for which SSIDs should be served in which area,
and AP groups could help you achieve this kind of goals.

In a similar way, you may want to map clients of the same SSID to different VLANs according to the zone they connect
from. Although you could support such a scenario with dynamic VLAN mapping via RADIUS attributes, a more
“static” option would be precisely through AP groups, as shown in Figure 4-20, especially if there is no RADIUS
authentication involved for clients of that SSID.
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Figure 4-20 WLAN and Dynamic Interface Assignment Example Under an AP Group

The screenshot shows WLANs tab selected from the main menu tabs at the top. AP Groups option from
Advanced section under WLANs is selected. The Edit CCIE-AP-Group page displays the following tabs:
General, WLANs (selected), RF Profile, APs, 802.11u, Location, and Ports/Module. Add New button is present
at the top-right corner. A section titled Add New shows WLAN SSID spin box set to CCIE-SSID(20),
Interface/Interface Group (G) spin box set to vlan-111, and SNMP NAC State checkbox. Two buttons, Add
and Cancel are shown at the bottom. Below the section, the following tabs are present: WLAN ID, WLAN
SSID, Interface/Interface Group (G), and SNMP NAC State.

Previously, you could also remap a WLAN to a dynamic interface through an AP group to locally switch clients to the
dynamic interface’s corresponding VLAN if the WLAN (and the APs serving it) were set for FlexConnect. In this case
the dynamic interface’s VLAN didn’t necessarily have to exist centrally, behind the WLC, and the dynamic interface’s
IP could even be a bogus one. This dynamic interface mapping had the main goal of communicating to the FlexConnect
APs of the AP group the VLAN, on which to locally switch clients of that WLAN. Such a behavior originates by the
fact that, without any other “overriding” options, a FlexConnect locally switched WLAN by default bridges clients on
the same VLAN as the one from the dynamic interface assigned under the WLAN’s settings.

You can create multiple WLANs with the same SSID name, as long as they have different IDs (equal to or greater than
17) and profile names. Although today you can rely on standard IETF RADIUS attributes, such as the [32] NAS-
Identifier or the [30] Called-Station-Id, to determine from which AP group or WLAN the client is connecting, in the
past the only available option was the Cisco Vendor Specific Attribute (VSA) Airespace-Wlan-Id. By looking at the
WLAN ID number from the Airespace-Wlan-Id attribute in RADIUS requests from the WLC, you could build
authentication and authorization rules on your RADIUS server based on the client’s location. The client’s location in
such a scenario would be the AP group, to which you could map a WLAN with the same SSID name as other WLANs
but a different WLAN ID and profile name. Based on the location (or AP group) the client was connecting from, you
might have wanted to dynamically assign different VLANs, ACLs, QoS parameters, and so on via RADIUS attributes.
As of today things got a bit easier thanks to options to include the AP group name directly in the RADIUS attribute [30]
Called-Station-Id, for example, but the technique we just described through WLAN IDs and AP groups was and still is a
valid one to support such use cases.

Although the following may not be some very common examples, we still prefer to clarify the behavior of AP groups for
some specific cases, because they could be less evident to troubleshoot if you find yourself in such scenarios:
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If a client roams between APs assigned to different AP groups, where the same WLAN is mapped to different
dynamic interfaces, the WLC keeps the client assigned to the same dynamic interface of the AP group from the
initial association so not to disrupt the IP connectivity. This is similar to a Layer 3 roaming, although it is not a
common scenario to have different physically adjacent AP groups, because APs covering adjacent areas, among
which clients could roam, should usually be assigned to the same AP group.

If you need to support AP’s mobility between WLCs, we recommend always keeping the AP groups’ configuration
the same. Not only should you configure AP groups with the same names and the same settings (for example,
WLANs list, dynamic interfaces mapping, and so on), you should also keep the AP groups list identical on all
WLCs by creating/deleting AP groups in the very same order. This should prevent any possible conflict when APs
move from one WLC to another, to correctly inherit and preserve all AP groups’ configurations.

Not necessarily related to AP groups only, but having two WLANs with ID equal to or greater than 17, the same
SSID name and tunneled to the same anchor WLC is not a supported scenario. You may want to deploy this
combination to tunnel clients from the same SSID to different VLANs based on the AP group (for example, the
location) they are connecting from. However, the piece of code determining to which WLAN the anchor WLC
should tunnel clients is determining the WLAN on the SSID name base, and this could definitely cause conflicts
when having multiple WLANs with the same SSID name. The enhancement CSCub68067 for improving such a
behavior is currently open at the time of this book’s writing:

https://bst.cloudapps.cisco.com/bugsearch/bug/CSCub68067

As an alternative, you could achieve the same goal by using the same WLAN on different AP groups and relying on
the RADIUS attribute [30] Called-Station-Id to include the AP group name in RADIUS requests from the WLC. If
the WLAN is configured for 802.1X, for example, the RADIUS attribute [30] Called-Station-Id is automatically
sent, and you can use it on the RADIUS server to decide which VLAN to dynamically assign.

Dynamic VLAN assignment is supported with an anchor WLC: the foreign WLC talking to the RADIUS server
receives the VLAN through RADIUS attributes and communicates it to the anchor WLC via EoIP/CAPWAP so
that the anchor WLC can assign the client to the dynamic interface corresponding to that VLAN.

If the WLAN is not configured for 802.1X, but just for simple PSK, for example, you could still enable MAC
filtering to trigger RADIUS requests from the WLC and be able to assign VLANs based on the AP group value of
the RADIUS attribute [30] Called-Station-Id. Even if this means that the WLC performs authentication for every
client’s MAC from this moment on, on your RADIUS server you can configure rules to accept any MAC address.
The additional goal here is to assign VLANs based on the AP group/location, because the WLAN was originally
meant for PSK only and not to authenticate clients based on their MACs.

Figure 4-21 shows an example of such a technique, assuming a WLAN configured for WPA/WPA2 PSK with MAC
filtering. The WLC is configured to send a column-separated concatenation of the AP’s MAC address, the WLAN’s
name (for example, CCIE-SSID) and the AP group name (for example, CCIE-AP-Group) in the RADIUS attribute [30]
Called-Station-Id. Cisco Identity Services Engine (ISE) has an authentication rule configured to match MAC
authentication requests from the WLC for the WLAN CCIE-SSID, with the option to continue if a MAC address is not
found in the internal endpoints database. This means that ISE basically accepts any MAC authentication from the WLC
on that specific SSID. It does not matter whether the MAC address can be verified. The authorization rule is configured
to check the AP group’s name, always included in the very same RADIUS attribute [30] Called-Station-Id, on which the
authentication rule is based to match the WLAN’s name. Through these settings you could automatically assign
endpoints connecting on your WPA/WPA2 PSK enabled WLAN to a specific VLAN, for example, simply based on the
AP group where they are connecting from.
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Figure 4-21 Example of Configuration of the RADIUS Attribute [30] Called-Station-Id on the WLC and
Policies on Identity Services Engine (ISE)

The screenshot shows WLANs option under WLANs section of WLANs menu is selected. The Edit CCIE-
SSID page shows the following tabs: General, Security (selected), QoS, Policy-Mapping, and Advanced. The
sub-tabs are Layer 2 (selected), Layer 3, AAA Servers. The settings are as follows: Layer 2 Security spin box
set to WPA+WPA2 and MAC Filtering checkbox. Four sections are displayed: Fast Transition, Protected
Management Frame, WPA+WPA2 Parameters, and Authentication Key Management. The first section shows
Fast Transition spin box set to Adaptive, Over the DS checkbox (Selected), and Reassociation Timeout field
reading 20 seconds. The second section shows the PMF spin box set to disabled. The third section shows WPA
Policy checkbox, WPA2 Policy checkbox (selected), WPA2 Encryption option set to AES checkbox, and
OSEN Policy checkbox.

FlexConnect Groups

As the name already suggests, a FlexConnect group is mainly used to push FlexConnect parameters to a set of
FlexConnect APs at once. FlexConnect groups do not modify any radio configuration, which is reserved to AP groups
and RF profiles, if needed. The same AP can be a member of an AP group and a FlexConnect group; the two group
categories are independent.

The FlexConnect group’s settings override the WLAN’s configuration, for example, for mapping a WLAN to a different
VLAN from one of the dynamic interfaces assigned to the WLAN. By default, parameters under the FlexConnect tab of
a single AP directly override the FlexConnect group’s configuration. For the native VLAN ID and WLAN-to-VLAN
mappings of a FlexConnect AP, you can configure the FlexConnect group to take precedence by enabling the option
Override VLAN on AP under the WLAN VLAN Mapping tab of the FlexConnect group itself.

Other settings that you can dynamically push via RADIUS attributes (for example, VLANs, ACLs, and so on) have the
highest priority and override the configuration at the single AP’s level too.
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Note

Usually, all settings applied through a FlexConnect group are available in each AP’s specific configuration, under the
FlexConnect tab. The main exceptions are FlexConnect AVC Profiles and FlexConnect VLAN Templates. To deploy
these features you must assign FlexConnect APs to a FlexConnect group, under which you select the AVC profiles and
VLAN templates to push to those APs.

Along with pushing FlexConnect options to multiple APs concurrently, a FlexConnect group plays a fundamental role
for keys reuse in roaming scenarios. FlexConnect APs with local switching support the following main roaming
techniques: Cisco Centralized Key Management (CCKM), Opportunistic Key Caching (OKC), and Fast BSS Transition
with 802.11r. For key caches to be shared and for such roaming options to be supported within a set of FlexConnect
APs, those FlexConnect APs must be in the same FlexConnect group. Even if at the very beginning of a multisite
FlexConnect deployment you may not need to group APs, support a specific roaming technique, or push multiple
common settings in parallel, we still recommend to group APs from the start, both through AP and FlexConnect groups.
You might have to spend some extra time planning those groups, but such an initial effort could be much smaller than
the one required during the production phase, for example, in case new needs are raised at a later stage.

Wireless Security Policies

Security is a pervasive topic, specifically on wireless networks, where we sometimes take it even more for granted than
on wired networks. Because wireless is not something we can actually “see,” like Ethernet cables, and because we
cannot always fully control the range of a Wi-Fi signal, there is often a bigger focus on how to secure something for
which we already have less physical visibility. Through the next sections we will try to address all security options from
different perspectives: the WLAN, the client, the radio infrastructure, and so on.

To Layer 2 or To Layer 3?

When creating a WLAN, one of the first decisions you probably need to make is whether that SSID will be an open or a
secure one. We can define an open SSID as having no encryption. Although still supported, because WEP is nowadays
not recommended whatsoever, we could simplify this reasoning a step further and think of “open vs. secure” as “open
vs. WPA/WPA2 encrypted.” This first distinction determines the level of Layer 2 security of your SSID; it does not,
however, define the authentication method yet.

A very important point we should clarify from the beginning is that a secure SSID cannot fall back to open. For
instance, if an SSID is configured for WPA/WPA2 with 802.1X authentication, a client cannot connect anyway through
MAC authentication in case it doesn’t support any EAP method. For 802.1X on wired networks you may sometimes
have options on the switch allowing authenticating clients through MAC authentication bypass (MAB) if they don’t
support 802.1X. This is possible because on wired networks we don’t encrypt the wired communication between the
client and the switch. (Well, historically we didn’t, at least not before the introduction of IEEE 802.1AE with MACsec.)
On wireless networks, if we configure a secure WLAN with WPA/WPA2, the client must support encryption too. More
precisely, it must install a Pairwise Master Key (PMK) from which to derive other encryption keys. The PMK is
installed in two ways, either statically because it is derived from a passphrase (that is, a pre-shared key, or PSK), or
dynamically because it is assigned by a RADIUS server at the end of an EAP authentication. Without a PMK to derive
encryption keys from, a client cannot complete the association to a WPA/WPA2 secured SSID. On a WPA/WPA2
secured SSID configured for 802.1X, if the client didn’t support 802.1X, it could not obtain the PMK at the end of the
EAP authentication process and derive the encryption keys to connect. On wireless networks, there is no option to fall
back to open.

Another fundamental concept to keep in mind is that when you configure a secure SSID for WPA/WPA2, you can
choose either a PSK-based or an 802.1X-based Authentication Key Management mechanism, but not both under the
same WLAN. This means that you can support either statically assigned keys (through a passphrase, PSK) or
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dynamically assigned keys (through 802.1X), but both cannot coexist on the same SSID.

Open and secure are the two options for the Layer 2 security level. On top of these, we should be aware of the
differences between Layer 2 and Layer 3 authentication techniques. Although it may sound self-explanatory, we could
think of Layer 2 authentication as the authentication process at the end of which a client gains access to the network’s
Layer 2. This could translate in the client’s traffic being authorized on a specific VLAN, for example. A Layer 3
authentication, on the other hand, takes place when the client already has access to Layer 2 and allows authorizing
further access to Layer 3 services or above (for example, communication with a VPN gateway or HTTP(S) access to
certain web pages). A Layer 3 authentication is usually performed after a client already obtained an IP address.

If we had to translate Layer 2 versus Layer 3 authentication techniques to a WLAN’s configuration, we could say that
Layer 2 authentication options are those related to MAC filtering or 802.1X, and that Layer 3 authentication options are
all those related to web authentication. MAC filtering and/or 802.1X are performed before authorizing the client’s
traffic through the AP; hence they are part of the Layer 2 authentication process.

Again, for the sake of simplicity and because WEP is not recommended anymore, we will use 802.1X to refer to a
WLAN configured for WPA+WPA2 as Layer 2 Security, and with 802.1X, CCKM or FT 802.1X under the
Authentication Key Management parameters. 802.1X, CCKM, and FT 802.1X refer more to the key management
options for roaming, correspondingly with OKC, CCKM, and 802.11r. All these options are based on 802.1X
authentication and can all coexist for the same WLAN. Figure 4-22 shows an example of Layer 2 security options for a
WLAN.

Figure 4-22 Example of Layer 2 Security Options Under a WLAN’s Configuration

The following tabs are present at the top: Monitor, WLANs, Controller, Wireless, Security (selected),
Management, Commands, Help, and Feedback. Rogue Rules option, under Rogue Policies sub-section of
Wireless Protection Policies section, under Security menu is selected. The settings of the Rogue Rule Edit page
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are as follows: Rule Name, Type spin box set to Malicious, Notify spin box set to All, State spin box set to
Alert, Match Operation set to the radio button, Match Any, and Enable Rule checkbox (selected). A section
titled Conditions shows Managed SSID option along with a checkbox and a drop-down menu. Another section
titled Add Condition shows a spin box set to SSID along with Add Condition button.

802.1X automatically implies that the SSID is secure. Although MAC filtering is a Layer 2 authentication technique, it
applies to both open and secure SSIDs. When applied to a PSK secured SSID, for example, the WLC tries to
authenticate MAC addresses, either against the internal MAC filtering list under SECURITY > AAA > MAC Filtering
or against an external RADIUS server. On top of that, the client must go through the encryption keys derivation process,
too, before traffic can start being forwarded.

Applying MAC filtering on top of an 802.1X secured SSID is technically possible and supported, but it does not make
too much sense in the majority of scenarios. First, because of its very nature, MAC filtering would not add any security
advantage on top of 802.1X. Also, the WLC sends the client’s MAC address in the RADIUS attribute [31] Calling-
Station-Id when performing 802.1X authentications. By adding checks in your RADIUS server’s rules for the Calling-
Station-Id attribute sent during 802.1X authentications, you can perform MAC authentications in parallel too. If, on top
of an 802.1X-based Authentication Key Management option under the WLAN’s Layer 2 security tab, you also checked
the option for MAC Filtering, the WLC would perform an additional, distinct MAC authentication. Although negligible
sometimes, this could still introduce some extra delay in the client’s overall association workflow.

When configuring an open SSID, you can either apply MAC filtering as the only authentication technique or deploy it
on top of Layer 3 authentication. The Layer 3 authentication options that you can configure under a WLAN are all
translating into web authentication techniques with the Local Web Authentication (LWA) method (more on this in
Chapter 5, “Wireless Security and Identity Management with ISE”). To enable Layer 3 authentication you need to
change Layer 3 Security from None to Web Policy under the WLAN’s Layer 3 subtab of the main Security tab.
Enabling the Web Policy option automatically enables the WLC to allow DNS traffic for clients associated to the
WLAN, even when they are still redirected to the web portal (that is, in the WEBAUTH_REQD state).

Note

Although the WLC automatically permits certain categories of traffic for web authentication, you may still want to
explicitly permit DHCP and DNS at the beginning of a pre-web authentication ACL. In this way you will have access to
specific counters of the ACL, also for permitted DHCP and DNS traffic. Such a technique could provide some more
visibility in case of troubleshooting and let you confirm whether clients can successfully obtain IP addresses via DHCP
and perform DNS resolutions, for example.

MAC filtering and web authentication can both coexist on the same WLAN, or you can configure web authentication as
a fallback mechanism if MAC filtering fails. A use case for this option could be to authenticate specific devices against
a MAC addresses database and, still on the same SSID, to provide guest access too.

For a secure SSID, you can also combine Layer 2 and Layer 3 authentication methods. In such a case, you cannot use
web authentication as a fallback mechanism: a device must first pass the Layer 2 security and authentication phase, if
configured, before going through web authentication. We explicitly used the words “if configured” for Layer 2
authentication because you could, for example, have a WLAN with WPA/WPA2 PSK before web authentication, in
which case there would be no Layer 2 authentication. Clients connecting to such a WLAN still need to go through the
WPA/WPA2 six/four-way handshake before they can get redirected to a web portal. If you decide to configure a secure
SSID and chain 802.1X with web authentication, which is a supported combination, too, clients need to successfully
authenticate via 802.1X before being able to go through a web portal. Chaining 802.1X and web authentication with
LWA is supported only if the web authentication option is for a portal asking for login and password. A passthrough
portal, for example, is not supported if LWA is chained with 802.1X. This combination of 802.1X plus LWA was
introduced to support some sort of machine and user authentication for those devices, usually non-Windows-based
ones, which are not supporting distinct machine and user identities. You could, for example, authenticate a tablet
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through 802.1X with a certificate issued for the machine name, and then users behind that tablet through a web portal
and their Active Directory credentials.

Some organizations, however, may decide to use 802.1X to authenticate guest users, while still redirecting to a web
portal after that authentication, to display terms and conditions through an acceptable use policy (AUP) page. Some of
the main reasons for using 802.1X authentication for guest users are the following:

It is more secure than an open SSID, with encrypted traffic.

Users without any credentials cannot even associate to the WLAN to get redirected to a web portal. In this way,
they cannot consume network resources, such as IP addresses, either.

Devices tend to cache 802.1X credentials, for example for PEAP MS-CHAPv2, so end users might not need to
enter them multiple times.

As mentioned earlier, 802.1X chained with LWA supports only a web login page as a guest portal. To chain 802.1X
with a web passthrough portal, you can instead use Central Web Authentication (CWA) with Identity Services Engine
(ISE). 802.1X plus CWA allows you to redirect guest users to a passthrough web portal (that is, a “hotspot” portal in the
ISE’s jargon) after 802.1X authentication.

WLAN Security Options

To configure L2 and L3 security and authentication options of an SSID, you can browse under the corresponding
Security tab of your WLAN. As the menus present themselves, the Layer 2 subtab lists all the Layer 2 security and
authentication features, and the Layer 3 subtab contains the options to implement LWA.

Layer 2 security options allow choosing between an open and a secure SSID. For a secure SSID, probably the most used
encryption method is WPA+WPA2. As of today, the Wi-Fi Alliance is deprecating the use of WEP, and also of WPA
TKIP as the only cipher option for a WLAN. If you need support for WPA TKIP on an SSID, you need to enable
WPA2 AES too, for example.

AireOS 8.3 introduced the support for some security and QoS features co-developed with Apple, and more specifically
for Adaptive 802.11r. Roaming and key management techniques, such as 802.11r, are explained later in this chapter.

When you enable Adaptive 802.11r, sometime also referred to as Adaptive Fast Transition (FT), APs will include an
optional CCX Information Element (IE) in their beacons with a specific bit set to indicate support for 802.11r. This
CCX IE is understood by Apple devices only, which can then negotiate support for 802.11r in the association phase.
Other non-Apple devices not understanding such a CCX IE will not detect that the WLAN supports 802.11r, and they
will complete the association process without negotiating 802.11r. When choosing WPA+WPA2 as the Layer 2 security
option for your SSID and enabling at least a WPA2 cipher suite, Adaptive 802.11r is also automatically enabled by
default.

On top of cipher suite and Fast Transition options, in the same Layer 2 security subtab you can find settings to enable
different authentication key management methods for roaming, which are also covered later, along with some
documentation.

Through the Layer 3 security subtab you can configure Local Web Authentication (LWA) scenarios. By selecting Web
Policy in the Layer 3 Security drop-down menu, you have the option of selecting among several web portal redirection
flavors. You can find all the details on these different techniques, and how to configure them, in the following official
guide:

https://www.cisco.com/c/en/us/support/docs/wireless-mobility/wlan-security/115951-web-auth-wlc-guide-00.html
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On top of the main options we just discussed, you can enable additional security features on a WLAN that can be
applied to both Layer 2 and Layer 3 authentication methods. You can find these additional options under the Advanced
tab of a WLAN’s configuration in the controller’s GUI. The following list describes some often used ones:

AAA Override: When you enable this option you are basically telling the WLC to accept RADIUS attributes to
dynamically assign L2/L3 policies that might override those statically configured under the WLAN. The most
common example is dynamic VLAN assignment. With AAA override enabled, if the RADIUS server passes back
the needed attributes to the WLC for assigning a VLAN, the client is switched to the dynamic interface
corresponding to that VLAN instead of the interface “statically” configured on the WLAN (under the WLAN’s
General tab). Other examples of dynamically overridden options through RADIUS attributes are ACLs, the session
timeout, QoS profiles, AVC profiles, and so on.

Peer to Peer (P2P) Blocking: This feature allows you to block traffic between clients connected to the same
WLAN. When you configure the P2P blocking action to Drop, traffic between clients of the same WLAN is
blocked at the WLC level. With the Forward-UpStream action, the WLC does not directly bridge traffic between
two clients, but it forwards it to the upstream network device for it to apply any potential blocking action.

For centrally switched clients, P2P blocking applies to clients of the same WLAN and same VLAN, even if they are
connected to different APs. For locally switched clients, P2P blocking applies to clients of the same WLAN, the
same VLAN, and connected to the same FlexConnect AP. COS APs support P2P blocking for locally switched
clients starting only from AireOS 8.7. You may want to keep P2P blocking disabled for enterprise or voice networks
and enable it for guest networks, for example.

Client Exclusion: With this feature enabled by default with a timeout of 60 seconds, clients failing 802.11
association or 802.11 authentication five consecutive times, or also 802.1X authentication or web authentication
three consecutive times, are put in an exclusion list for 60 seconds. During this time they will be denied access to
the WLAN based on MAC address “blacklist.” A client using an IP address already assigned to another device is
also excluded, if Client Exclusion is enabled. You can customize which client exclusion policies to keep enabled
through the WLC’s GUI, under SECURITY > Wireless Protection Policies > Client Exclusion Policies.

Because it may help to prevent brute force attacks, for example, it is generally a common practice to keep client
exclusion policies enabled; in some specific scenarios or for testing purposes, however, you might need to disable
them.

DHCP Address Assignment: Through this function you can block clients from getting to the RUN state if they do
not complete IP assignment via DHCP. Clients with static IPs (printers or similar) cannot transition to the RUN
state when DHCP Address Assignment is set to Required. This is a setting that you might often see recommended
for guest networks, or more generally for WLANs not having specific needs for static IPs support.

Under the WLAN’s options you can definitely find more settings than those just listed, although the ones mentioned
here are probably considered some of the most common ones. Additional details on all other parameters can be found in
the official configuration guide:

https://www.cisco.com/c/en/us/td/docs/wireless/controller/8-3/config-guide/b_cg83/b_cg83_chapter_0100111.html

Rogue Policies

On top of specific options in the WLAN’s configuration, you can add further security measures to your wireless
network by deploying policies to detect and mitigate rogue access points. The very definition of a rogue AP is an access
point not known by any WLC in the same RF group or mobility group. APs from your deployment forward information
about other detected APs to the WLC, and the WLC checks whether those newly detected APs are known through
another WLC in the same mobility group, or else because their RF neighbor messages heard by your APs included the
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same RF group name. If none of these checks succeeds, the newly detected AP is flagged as a rogue, and rogue policies
configured on the WLC may apply. Some official guides mention three distinct phases for rogue AP operations:
detection, classification, and mitigation. The detection phase consists of the steps just mentioned: an AP of your
deployment and its WLC flagging an external AP as unknown, or rogue. Classification and mitigation are the results of
rogue rules that you configure on the WLC.

You can find rogue policies and rules under the WLC’s menu SECURITY > Wireless Protection Policies > Rogue
Policies. Among the general settings are three pre-canned configuration models corresponding to the level of
“aggressiveness” with which the WLC detects rogue APs, keeps them in the corresponding list as such, attempts to
determine whether they are connected to your LAN, and so on.

A common practice is to set the Rogue Detection Security Level to Low as a starting point. This level is generally used
for plain detection: the Rogue Detection Minimum RSSI at −80 dBm, for example, is often enough to filter out rogue
APs that could be too far away. If needed, you can always switch to the Custom mode, to modify some parameters after
having started from one of the other three templates.

General settings for rogue policies define the main criteria, based on which the WLC performs detection, as well as
some other mitigation actions. For more specific rogue APs classification, you can add rules and conditions under the
dedicated Rogue Rules menu.

Results of a rogue rule are a classification and an action. Classifications can vary among Friendly, Malicious, or
Custom, and an action (or State, in the WLC’s GUI) can be a containment, an alert, a further classification as
internal/external (in case of Friendly classification), or else the deletion of the rogue AP’s MAC from the WLC’s tables.
It’s quite common to configure rogue rules for alerting, which the WLC triggers through messages directly on its
interface and through SNMP traps, for integration with external monitoring tools. The containment action is performed
by one or more of your infrastructure’s APs by sending deauthentication frames to clients associated to the rogue AP,
hence “containing” it from connecting users or devices. You may not always want to configure such an action,
however; while busy containing rogue APs, infrastructure APs are not able to serve clients as usual, so your wireless
network’s overall performance is slightly impacted. Also, containing another wireless network might be considered
illegal in some countries. A more commonly adopted approach is to configure rogue rules for alerting actions only, while
completing such functions with rogue AP location tracking through Prime Infrastructure and MSE, to then physically
check a specific location for rogue APs and try to understand why they might be present and how to act (or not) on
them. Although less automated and more dependent on physically checking the zone of impact of a rogue AP, this
combination is a bit more careful in not disrupting other wireless networks without a final human confirmation.

Note

Rogue location on CMX is supported starting from version 10.4. Although by the time of this book’s writing you can
integrate rogue location with Prime Infrastructure and CMX, for the purpose of the CCIE Wireless exam based on
CMX 10.3, rogue location would still need the former MSE solution.

Conditions from a rogue rule can be based on different information seen from the rogue AP, such as the SSID name (or
a substring of it), the maximum RSSI, whether the rogue AP is serving an SSID with the same name as one of the SSIDs
managed by your WLC, and so on. A very common example of classifying rogue APs as malicious, just for alerting
purposes to start with, can be a rule matching the condition for a Managed SSID, as shown in Figure 4-23.
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Figure 4-23 Example of Conditions Under a Rogue Rule

The screenshot shows Local Policies option under Security menu selected. The settings of the Policy Edit page
are as follows: Policy Name and Policy Id. Three sections are shown: Match Criteria, Device List, and Action.
The first section shows Match Role String field box reading user-01 and Match EAP Type spin box is set to
PEAP. The second section shows Device Type spin box set to Android. Add button is present. The third section
shows IPv4 ACL spin box set to none, URL ACL spin box set to none, VLAN ID field reading 112, QoS Policy
spin box set to Silver (best effort), Average Data Rate field reading 0, Average Real Time Data Rate field
reading 0, Burst Data Rate field reading 0, Burst Real Time Data Rate field reading 0, Session Timeout
(seconds) field reading 1800, Sleeping Client Timeout (min) field reading 720, Flexconnect ACL spin box set to
none, AVC Profile spin box set to none, and mDNS Profile spin box set to none.

On top of the WLC’s rules to classify rogue APs, you can also implement additional options to try to determine whether
a detected rogue AP is connected to your wired network infrastructure:

Rogue Location Discovery Protocol (RLDP): When this feature is enabled, an infrastructure AP having detected
a rogue AP tries to associate to that rogue AP as a standard client. If it succeeds and obtains an IP address, it then
tries to send a specific discovery message to the WLC’s management interface on the UDP port 6352. If such a
message reaches the WLC, the rogue is additionally classified as “on wired,” meaning connected to your LAN.
RLDP has of course some limitations, such as being supported only if the rogue AP’s SSID is open and not secured.
Additionally, while trying to associate to the rogue AP, the RLDP enabled infrastructure AP may stop serving
clients for up to 30 seconds. Finally, if the rogue AP is configured with options to filter out those UDP messages to
the WLC (or if there is no routing from there to the WLC), RLDP might fail. You should also be aware that RLDP
is nowadays deprecated on COS APs (for example, 1800/2800/3800 series and any other 802.11ac Wave 2 AP
model).

Rogue Detector mode: This is a specific operational mode that you can configure on one or more infrastructure
APs, similarly as for Local or FlexConnect modes. When you configure an AP in Rogue Detector mode, radios are
disabled and on its Ethernet port the AP listens for ARP messages from the rogue AP’s MAC itself or a rogue
client’s MAC (these MAC addresses being known, thanks to other infrastructure APs having detected them). On
the wired side, the Rogue Detector AP should be connected to a dedicated switchport, usually in trunk mode, where
you allow all necessary VLANs to be monitored. If an AP in Rogue Detector mode receives an ARP message from
a rogue AP’s MAC or one of its rogue clients’ MAC detected over the wireless by other infrastructure APs, the
specific rogue AP might be connected to your LAN on one of the monitored VLANs. Rogue Detector APs support
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detection of up to 500 rogue MACs and may not correctly detect a rogue on wired if that rogue AP applies network
address translation (NAT) or similar for MACs. As for the previous option, Rogue Detector mode is deprecated for
COS APs.

Switch Port Tracing (SPT): Although not a WLC feature, this option allows you to detect rogue APs connected to
one of your switches through Prime Infrastructure. Because it is more specific to the management solution, we
detailed SPT in Chapter 6, “Prime Infrastructure and MSE/CMX.”

CleanAir: Even if CleanAir is usually presented as the Cisco solution for interferences detection, in some corner
cases it could be beneficial for “rogues” too. We explicitly used the word “rogues” between quotes here because,
although technically speaking these are still interferences and not rogues, devices acting as Invalid Channel or
Inverted Wi-Fi may still connect older legacy clients that would “see” them as standard Wi-Fi APs. By using these
interferences as some sort of APs, a malicious user might be able to set up his/her own rogue network in kind of a
“stealth” mode, because APs not supporting interference detection wouldn’t be able to catch it. Again, it’s a very
specific and less likely corner case, but to push the exercise a bit further, we could think of CleanAir as an
additional “rogue” detection feature.

For the sake of not duplicating resources, we leave additional details on rogue management to its dedicated white paper
on Cisco.com:

https://www.cisco.com/c/en/us/td/docs/wireless/technology/roguedetection_deploy/Rogue_Detection.html

Local EAP, Local Profiling, and Local Policies

In the vast majority of production deployments, you might encounter a dedicated AAA/RADIUS server solution for
authenticating users and devices, classifying them, and applying specific policies. Generally speaking this is also the
recommended approach, because a full-blown AAA/RADIUS server supports all the needed features to integrate with
external databases, private key infrastructures (PKI), monitor authentications, and the like. However, for some
situations, where an external AAA/RADIUS server may not be available, the WLC offers some local options to
authenticate users or devices, classify those devices, and enforce policies.

For 802.1X authentications, the WLC supports login-based EAP methods, such as LEAP, EAP-FAST, and PEAP, with
user accounts from its local database. Local EAP settings are available under SECURITY > Local EAP > Profiles.

You can create and manage the list of user accounts under SECURITY > AAA > Local Net Users.

On top of login-based EAP methods, the WLC supports EAP-TLS as a certificate-based authentication technique.
Login, or more precisely tunnel-based, authentication methods and EAP-TLS require a server certificate and, for EAP-
TLS, a root certification authority certificate to trust the clients’ certificates. Both the WLC’s server certificate and the
root CA certificate can be uploaded under COMMANDS > Download File, respectively with the options for Vendor
Device Certificate and Vendor CA Certificate under the File Type drop-down menu. To generate a WLC’s server
certificate for EAP-TLS, you can follow the same procedure as for the web authentication certificate, although the CN
should differ from the IP or the FQDN of the virtual interface in this case:

https://www.cisco.com/c/en/us/support/docs/wireless/4400-series-wireless-lan-controllers/109597-csr-chained-
certificates-wlc-00.html

The workflow to enable local EAP for an SSID consists in first creating a local EAP profile with the supported EAP
methods, and then in linking that profile to the WLAN, under its Security > AAA Servers tab. Before starting using it,
you should also make sure that the needed user accounts are created or that the right WLC’s certificates have been
uploaded.
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You can find additional configuration details on local EAP in its dedicated section of the configuration guide:

https://www.cisco.com/c/en/us/td/docs/wireless/controller/8-3/config-
guide/b_cg83/b_cg83_chapter_0100111.html#d40408e2455a1635

On top of local authentication features, you can also enable devices’ classification options on the WLC, either to reuse
those classifications for local policies or just for monitoring purposes. Devices classification on the WLC is derived from
Cisco Identity Services Engine (ISE), and we refer to this function as local profiling.

When you enable local profiling for a WLAN, under Advanced > Local Client Profiling, APs serving that WLAN
communicate to the WLC the following information that they can monitor from the clients’ traffic: the MAC address,
the DHCP attributes for hostname and class identifier (if DHCP Profiling is checked), and the HTTP user agent (if
HTTP Profiling is checked). With these data and their values, the WLC can match a specific client (that is, its MAC
address) to one of the pre-canned profiles among those in the list visible through the command show profiling policy
summary.

The rules to match a client to a profile are the same as you could find in the profiling policies in Cisco ISE. Although the
WLC does not support modifying its local profiling policies, it supports importing new versions of them. Under
COMMANDS > Download File and through the Device Profile file type, you can import new versions of profiling
rules, which you could have previously exported from ISE, for example. To update the OUI database, you can follow
the same procedure by using the file type OUI Update instead.

As a further extension of local AAA features on the WLC, you can also use 802.1X/EAP methods and device profiles
as conditions to match and apply local policies to users or devices of a specific SSID.

You can create and modify local policies on the WLC under SECURITY > Local Policies, as shown in Figure 4-24. A
local policy is matched based on the role string, the EAP method (both through local EAP or when authenticating
through an external RADIUS server), or the device type from the local profiling. When a client matches a local policy,
different types of settings can be assigned to it. The most common ones are a VLAN, an ACL, and a QoS profile, but
you can also implement more advanced options, such as an AVC profile or an mDNS service.
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Figure 4-24 Example of a Local Policy Configuration

The screenshot shows Access Control Lists option under Access Control Lists section of Security menu
selected. The Access Control Lists page displays a section titled Enable Counters along with a checkbox
(selected). The section shows a table of three rows and two columns. The column headers read, name and type.
At the end of each row, a drop-down menu is present. The drop-down menu of the last row is clicked to reveal
a list: remove, clear counters, and add-remove URL (selected). A pop-up window overlapping the screen titled
ACL>CMX_WEBAUTH_ACL>URL List shows URL String Name field along with Add button and URL
Name field. An arrow from Add-Remove URL option points to the pop-up window.

You can link multiple local policies to a WLAN, under its Policy-Mapping tab, where they will be processed according
to the order assigned in that list. As a further option, you can dynamically assign a local policy to a user or a device via
RADIUS attributes. When authenticating a client through an external RADIUS server, the WLC supports dynamic
assignment of local policies through the role string, communicated to the WLC in the vendor specific attribute (VSA)
cisco-av-pair=role=<role_string>. All the settings that you can assign within a local policy (VLAN, ACL, QoS profile,
AVC profile, and so on) can be assigned one by one through corresponding RADIUS attributes. The purpose of
assigning them all together through a local policy’s name would be the simplicity of configuring and sending just one
RADIUS attribute in the final access-accept. However, for monitoring and tracking purposes, you may still want to
dynamically assign settings one by one, through multiple RADIUS attributes in the final access-accept.
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The full configuration guide for local profiling and policies is available here:

https://www.cisco.com/c/en/us/td/docs/wireless/controller/technotes/7-5/NativeProfiling75.html

ACLs and Certificates

Access control lists and certificates are some more “classic” security options, which you can find extensively detailed in
the configuration guides. We will briefly go through some of their uses, while leaving all the other already available
information to the online guides.

ACLs on a WLC are historically Layer 3 or Layer 4 ACLs and you can configure them under SECURITY > Access
Control Lists. An ACL allows filtering based on IPs or subnets, both as source and destination, but also based on
protocols, ports, and DSCP values. You can also specify in which direction an ACL should apply; inbound or outbound.
Inbound means traffic coming in from the wireless clients, and outbound means traffic going out to the wireless clients.

You can statically apply ACLs to a dynamic interface or to a WLAN, or you can dynamically assign them through the
RADIUS vendor-specific attribute Airespace-ACL-Name. ACLs also serve as pre-web authentication ACLs, again
either statically configured under a WLAN for Local Web Authentication (LWA) or dynamically assigned via the
RADIUS attribute cisco-av-pair=url-redirect-acl=<ACL_NAME> for Central Web Authentication (CWA).

Under an ACL you can configure permit statements for fully qualified domain names (FQDN) too, as shown in Figure
4-25. These statements apply to clients in the WEBAUTH_REQD state, or any other state for web redirection, hence
only if the ACL is used as a pre-web authentication ACL.

Figure 4-25 Example of FQDN Filtering Options for a Pre-Web Authentication ACL

The screenshot shows the WLANs menu selected from the main menu tabs at the top. The Edit cisco page
displays five tabs from which Advanced tab is selected. The settings of the tab are as follows: Scan Defer
Policy option shows checkboxes ranging from 0 to 7 (4, 5, and 6 are selected) and Scan Defer Time (msecs)
field reading 100. A section titled Flexconnect shows the following options with a checkbox to enable the
options: FlexConnect Local Switching, FlexConnect Local Auth, Learn Client IP Address, Vlan based Central
Switching, Central DHCP Processing, Override DNS, NAT-PAT, and Central Assoc.

As of AireOS 8.4 you also have the option to configure FQDN ACLs for clients in the RUN state. These can be found
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under SECURITY > Access Control Lists > URL ACLs, and in the corresponding configuration guide they are
sometimes referred to as URL ACLs:

https://www.cisco.com/c/en/us/td/docs/wireless/controller/technotes/8-
4/b_URL_ACL_Enhanced_Deployment_Guide.html

A more accurate technical definition would be FQDN ACLs. They do not allow you to configure full URLs and sub-
URLs, for example, but just FQDNs. For example, “acme.com” is a supported entry, but “acme.com/licensing” is not.

As an additional option for ACLs, the WLC supports L2 ACLs too:

https://www.cisco.com/c/en/us/td/docs/wireless/controller/8-3/config-
guide/b_cg83/b_cg83_chapter_01110.html#d190324e1127a1635

On the WLC there are different types of certificates for different uses, all of which you can download to the WLC
under COMMANDS > Download File. We can distinguish three main certificates:

Web management: This is the certificate used for the web graphical user interface of the WLC, when accessed via
HTTPS, and you can download it to the WLC by selecting the file type WebAdmin Certificate. Although used for a
different purpose, you can generate such a certificate in the very same way as for the web authentication portal’s
certificate, by generating a certificate signing request (CSR) and then requesting and installing the certificate on the
WLC:

https://www.cisco.com/c/en/us/support/docs/wireless/4400-series-wireless-lan-controllers/109597-csr-chained-
certificates-wlc-00.html

In case of the web admin certificate, you should specify the management IP of the WLC or its FQDN in the
certificate’s common name, and not the virtual interface’s IP or FQDN as for the web authentication portal’s
certificate. As an additional method, you can generate the CSR for this certificate through the command config
certificate generate csr-webadmin and its options.

Web authentication portal: This is the certificate presented when being redirected to the web portal hosted on the
virtual interface, and its common name should be the virtual interface’s IP or FQDN. In the same way as for the
web admin certificate, you can generate the CSR for the web authentication certificate through OpenSSL, or even
through the WLC’s command config certificate generate csr-webauth and its options. All the configuration
details are the same as in the aforementioned URL.

EAP certificate: This is the authentication server certificate for the WLC when using local EAP profiles. Under the
GUI, you can download such a certificate under COMMANDS > Download File by choosing Vendor Device
Certificate as a file type; this corresponds to the data type option eapdevcert when using the transfer download
command line. Although usually recommended for ease of use, the common name for the EAP device certificate
does not necessarily need to match the WLC’s management IP or FQDN, because during an EAP authentication a
client does not/cannot reach that IP/FQDN to verify it. Along with the EAP certificate for the WLC itself, you also
must download the certification authority’s certificate to trust clients’ certificates for EAP-TLS, for example. You
can follow the same procedure as for the device certificate, by choosing Vendor CA Certificate as a file type in the
GUI, or eapcacert as a data type via CLI.

On top of these main use cases, the WLC also supports the download of other types of certificates, such as the CA
server certificate for LSC certificates installation on APs, which we discussed in the previous sections.

FlexConnect Deployments

FlexConnect is a special mode in which you can set mostly any access points (there have been some restrictions on the
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AP model in the past, but all AP models from the exam support it). We have mentioned it many times already in this
book, but let’s cover its specifics.

What Problem Are We Trying to Solve?

The FlexConnect mode doesn’t do or change anything per se (that is, if it’s the only thing you enable) apart from
adapting the AP state machine, behaviors, and timers to act properly considering there is a WAN link between it and the
WLC. Moving an AP to FlexConnect mode does not require a reboot and is close to instantaneous, but moving an AP
back to local mode requires a reboot.

The requirements for FlexConnect mode are the following: less than 100ms latency between AP and WLC (if only
doing data, up to 300ms can be tolerated), 128kbps of bandwidth per group of 8 APs, and at least an MTU of 500. The
AP itself is very delay tolerant, but the client does not necessarily realize that the AP needs to consult with a WLC
behind a WAN link, and issues may arise if latency is longer than 100ms because of the client growing impatient. There
are CAPWAP heartbeats every 30 seconds and if one is lost, five (one per second) are sent consecutively. If they fail,
the connectivity is declared lost, and the AP moves to standalone mode; therefore, there is some small tolerance to
packet drop but it shouldn’t be abused.

FlexConnect Modes and States

There are two traffic switching modes in FlexConnect: central and local switching. With a default WLAN configuration,
FlexConnect mode APs will centrally switch client traffic, which means that they will send all the client traffic in a
CAPWAP tunnel to the WLC. There is no change of behavior (from a traffic switching perspective) compared to a non-
FlexConnect AP (that is, local mode). However, if the WLAN has the check box for FlexConnect Local Switching, this
WLAN will be locally switched on all the APs that are in FlexConnect mode (local mode APs will still behave as they
always do). This means that the AP gives the client traffic directly to the connected switch without any encapsulation.
The AP still has a CAPWAP tunnel for control traffic: AP configuration, WLC statistics and monitoring, but also client
authentication. But as soon as the client is in RUN state (fully forwarding the client traffic), the AP converts the 802.11
frame to an 802.3 frame and sends it on its connected switch (much like autonomous IOS APs did). APs can support
several VLAN tags in such a mode and have some WLANs centrally switched while others will be locally switched on
the connected switch at the branch. Figure 4-26 illustrates the WLAN settings that will allow you to configure some
WLANs as locally switched while others will stay centrally switched:
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Figure 4-26 FlexConnect Settings in the WLAN Advanced Section

The screenshot shows the WLANs menu selected from the main menu tabs at the top. The Edit cisco page
displays five tabs from which Advanced tab is selected. The settings of the tab are as follows: Scan Defer
Policy option shows checkboxes ranging from 0 to 7 (4, 5, and 6 are selected) and Scan Defer Time (msecs)
field reading 100. A section titled Flexconnect shows the following options with a checkbox to enable the
options: FlexConnect Local Switching, FlexConnect Local Auth, Learn Client IP Address, Vlan based Central
Switching, Central DHCP Processing, Override DNS, NAT-PAT, and Central Assoc.

There is a small catch to the previous paragraph though. We already hinted that the client authentication will still be
sent in the CAPWAP tunnel as control traffic to the WLC (although there’s a feature to have this taken care of by the
AP, but one thing at a time), so you might be tempted to say that all traffic before the RUN client state is sent to the
WLC, and locally switched at the remote branched afterwards, but this is wrong because of DHCP. Because the client
traffic will be switched at the branch, we expect the client to have a gateway defined at the remote branch office (for
efficiency reasons) and therefore, the client should obtain its IP address from the remote branch as well. This means
that DHCP traffic from the client will also be switched at the remote branch. A good summarization is to say that locally
switched WLANs do not require a dynamic interface configuration on the WLC (and will not care which interface you
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configured on the WLAN settings) but only require you to specify a VLAN ID in which they will be switched at the
remote office, while centrally switched WLANs do not care about the remote office VLAN configurations because
everything is tunneled to the WLC in the AP native VLAN (and therefore WLC dynamic interfaces are critical to
switch client traffic).

The FlexConnect AP can be in any of the following two situations (they are called modes, but they are more like
situations than modes you can enable):

Connected: This means that the AP has full connectivity to the WLC. It is in full working condition and works as
you probably expect it to.

Standalone: The connectivity got lost to the WLC and the AP, while actively trying to find the WLC again, will
still try to service some WLANs under some conditions. This is definitely a situation that you do not choose, that
you suffer from, and that everyone should remediate as quickly as possible (by regaining WLC connectivity).

FlexConnect APs can end up in any of the following states for each WLAN they service:

Authentication central/switching central: This is the state of a FlexConnect AP when it is connected to the WLC
and when the WLAN is not configured for local switching. All traffic is forwarded to the WLC, and the WLAN
works only when the AP is connected to the WLC.

Authentication down/switching down: This is the state the AP will end up in when it loses the WLC connectivity
in the previous example (FlexConnect central switching SSID). All current clients are deauthenticated by the AP
and it stops beaconing. The only way out of this state is to regain connectivity to the WLC.

Authentication central/switching local: This is the state of the AP when you enable FlexConnect Local Switching
on the WLAN configuration page. All traffic (except authentication) is switched locally at the remote branch. This
works only when the AP is connected to the WLC. This state is illustrated in Figure 4-27.

Figure 4-27 Authentication Central/Switching Local

The illustration shows two sections: Branch and Corporate Central. The Branch section shows a user
connected to CAPWAP (FlexConnect) via a wireless connection. This, in turn, is connected to a switch
(via dot1q) followed by a router for transmitting user data. An arrow representing local switched user data
from the router points to the branch servers and to the corporate central section. A double-headed arrow
representing local switched user data exists between CAPWAP and the router. The corporate central
section shows cisco prime infrastructure: A router is connected to a centralized WLAN controller for
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transmitting user data. A double-headed arrow representing 802.1x exists between AAA and centralized
WLAN controller. A private network cloud is also shown. The router of branch section and corporate
central are connected via serial cable. A double-headed arrow representing CAPWAP control exists
between CAPWAP and centralized WLAN controller.

Authentication down/switching local: If connectivity is lost from the previous example (authentication
central/switching local), we cannot authenticate or accept new clients on the SSID because WLC is not available.
Client traffic keeps being forwarded until the session timeout, and the WLAN stays up until the last client leaves
(then the WLAN will be down because it can’t accept new clients). This state is found only in standalone mode, as
illustrated in Figure 4-28.

Figure 4-28 Authentication Down/Switching Local

The illustration shows two sections: Branch and Corporate Central. The Branch section shows a existing
user and a new user connected to CAPWAP (FlexConnect) via a wireless connection. A cancel icon is
shown over the wireless connection between new user and CAPWAP. This, in turn, is connected to a
switch (via dot1q) followed by a router for transmitting user data. An arrow representing local switched
user data from the router points to the branch servers and to the corporate central section. A double-headed
arrow representing local switched user data exists between CAPWAP and the router. The corporate central
section shows cisco prime infrastructure: A router is connected to a centralized WLAN controller for
transmitting user data. The router of branch section and corporate central are connected via serial cable
with a cancel icon over it. A double-headed arrow representing 802.1x exists between AAA and centralized
WLAN controller with a cancel icon over it. A private network cloud is also shown. A double-headed
arrow representing CAPWAP control from CAPWAP points to corporate central with a cancel icon. An
arrow labeled OR points to the connection of routers and AAA and Centralized WLAN controller.

Authentication local/switching local: If you manually configure local authentication on top of local switching, the
AP is as resilient as it can be for this WLAN. Even if WLC connectivity is lost, the AP will continue to function
and fully operate on this WLAN. There are, however, some limitations with regard to authentication types that the
AP can handle (mainly regarding EAP authentications, while some other methods, like Open authentication or
WPA/WPA2-PSK, can be handled at the AP for new clients without any local authentication configuration but
when the AP is in standalone mode after losing connection with the WLC).

It is important to note that FlexConnect brings some limitations to certain features: sometimes only in local switching
mode, sometimes across the board. Take a look at the “FlexConnect Feature Matrix” online for a list of what is
supported in what mode.
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FlexConnect Specific Features

The WLAN Advanced tab contains a few more FlexConnect specific features:

FlexConnect local switching: When enabled, this WLAN will be locally switched on all FlexConnect APs.

FlexConnect local auth: This enables FlexConnect APs to take care of the authentication as well locally. They will
fallback to local authentication in standalone mode. Note that you will have to enable local auth as well in the
FlexConnect group options to have the AP always using local authentication (even in connected mode).

Learn Client IP address: Because the DHCP traffic is switched at the remote office, the WLC doesn’t have the
opportunity to track the client IP address. If you enable this feature, the AP will send a copy of the DHCP packets
inside the CAPWAP tunnel for the WLC to learn the client IP address.

VLAN-based central switching: When enabled, this feature allows having some clients centrally switched and
other clients locally switched on the same WLAN on the same FlexConnect AP. With this feature disabled, you can
assign a dynamic VLAN in the AAA attributes after the client authentication, and if the VLAN exists on the AP,
the client will be switched locally on that VLAN. However, if the VLAN does not exist on the AP, the client is
unable to connect. With this feature enabled, if the AAA server returns a VLAN that does not exist on the AP, the
client will be centrally switched on the WLC with the interface that corresponds to that VLAN (if it exists; if that
VLAN is also not present on the WLC, then the WLAN default interface is chosen).

Central DHCP Processing: In some cases, you might want FlexConnect locally switched clients to still obtain
their IP from a central DHCP. A great configuration example is available online if you search for “FlexConnect
Central DHCP configuration example.”

NAT-PAT: If you enable Central DHCP Processing, but the subnet used by the dynamic interface on the WLC
does not exist on the remote office site, you must enable NAT-PAT for the AP to do NAT on the client traffic so
that the client can talk to the remote resources.

Central Assoc: In a FlexConnect local switching SSID, all the 802.11 functions are handled at the AP level.
However, if the AP responds with “association response” by itself (for latency reasons), it still sends the association
request to the WLC and checks the WLC answer as well. When the Central Assoc check box is enabled, the Flex
AP will not send the association response by itself and will wait on the WLC to handle it and answer the client with
the WLC answer only.

FlexConnect Group Specific Features

We have already talked about FlexConnect groups earlier in this chapter, but let’s focus on some features that are very
specific to FlexConnect and that we haven’t talked about yet. In the General tab of the FlexConnect group, you can
enable AP local authentication. This is the check box, which on top of the WLAN local auth enablement, will make the
FlexConnect AP do local auth on a permanent basis (not only when it is in standalone mode). It will then be able to do
PSK locally, or act as a dot1x authenticator and forward RADIUS authentications directly to a RADIUS server (which
means having each and every FlexConnect AP where local auth is turned on, configured as AAA clients on the
RADIUS server), or even do EAP authentication itself (acting as Local RADIUS Server) with a limited user database
size and limited EAP methods available. More details on that in the Local Authentication tab right next to the General
tab. In the Image Upgrade tab, you can enable the AP upgrade feature and designate Master APs in the group. This
means that in case of software upgrade (on the WLC), rather than downloading their new image from the WLC, which
is potentially behind a slow WAN link, the APs can download it from a master AP directly (which got its image first
from the WLC and will redistribute it then locally at the remote site). This needs to happen between AP models using
the same software image.
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The AAA VLAN-ACL Mapping tab allows you to configure ACLs on VLANs. This sounds obvious, but let’s analyze
what this means: we are not assigning ACLs to WLANs but to VLANs (so potentially only to some clients of a given
WLAN, or to clients from several WLANs, depending on the VLAN configuration). A weird side use of this feature is
also to create VLANs on the AP itself. Imagine that you have only one FlexConnect SSID: this means you can map it to
only one given VLAN on each AP. But what about AAA VLAN override, that is, assigning a dynamic VLAN depending
on the username of the client? This is supported, and the RADIUS server can return any VLAN as long as it was
precreated on the AP. Therefore, if you enter a VLAN ID and no ACL and click Add on this feature, it will create a
new VLAN on the AP without any particular ACL. This is the easiest way to create VLANs on APs to facilitate
RADIUS VLAN assignments.

WLAN-ACL mapping allows assigning webauth ACLs (in case of local webauth) for given WLANs on the AP, as well
as assigning Local Split ACLs. We’ll touch on this in a minute. The last ACL-related tab is Policies, which allows you to
pre-load ACLs on the APs belonging to the FlexConnect group. They are loaded (so will appear in the AP
configuration) but not applied anywhere (yet). The purpose of this is to allow the RADIUS server to return ACL names
dynamically and make sure the AP has the ACL already when this happens. Central Webauth is an example where this
is required (to preload the redirect ACL that the RADIUS server will return).

FlexConnect Local Split is a feature targeted for FlexConnect centrally switched SSIDs where you have a couple of
resources on the remote branch like printers or local servers of any sort that you want to access directly without going
through the WAN link. The situation is that your client got an IP address from the WLC headquarters, and it is trying to
access a resource sitting, for example, on the switch where its AP is connected. We can directly understand the IP
addressing problem and the fact that this will not work if we have ACLs determining which traffic is switched locally
and which traffic is centrally switched. When Local Split is enabled, the FlexConnect APs enable NAT on their
management IP address. All traffic that is targeted to the local split ACL will be NATed to the local resource (because
the AP is in the right subnet to reach out to the local resource), and the reply will be NATed back to the wireless client.
This is to be used cautiously and only for selected resources (if you need access to many remote branch resource, it
might be time to consider local switching rather than central).

The WLAN VLAN Mapping tab allows specifying the APs native VLAN and the VLAN mapping for each WLAN that
is locally switched. By default, an AP-specific VLAN mapping will override the mapping configured in the FlexConnect
group mapping page, but the Override VLAN on AP check box allows you to invert this priority and make sure that the
FlexConnect group settings will always be the ones that apply. The last tab is the WLAN AVC Mapping and allows you
to set Flex AVC profiles for each WLAN.

FlexConnect ACLs are different from regular WLC ACLs and can apply only on FlexConnect APs and WLANs.
FlexConnect VLAN templates allow you to define VLAN IDs and give them names. It allows for easy creation of
VLANs for a given FlexConnect group as well as returning a VLAN name identifier instead of ID from the RADIUS
server (which allows having the same VLAN name mapping to different VLAN IDs, depending on site).

OfficeExtend

OfficeExtend is similar to FlexConnect in some ways and is a kind of extension of it, but with differences. OfficeExtend
targets remote workers typically having a home (or office-provided) router with their own ISP connection and looking
to connect a Cisco AP behind all that so that it connects to the company HQ WLC, as illustrated in Figure 4-29.
OfficeExtend therefore expects NAT to happen between the AP and the WLC, and OfficeExtend by default (and this is
not configurable) will enable DTLS data encryption on traffic tunneled to the WLC.
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Figure 4-29 Office-Extend Topology

The "Office-Extend" topology shows a network at the center that is connected to Home network on the left and
Office network on the right. The "Corporate SSID (a mobile and a laptop)" is connected to an "OfficeExtend
Access point" through the "Wireless Connectivity." The access point is further connected to a router that is in
turn connected to a "DSL/Cable modem" and is connected to the network. In the office network, the outer
network is connected to a router that is connected to a Firewall and in turn, it is connected to a
"Controller/CC."

Setting an AP to OfficeExtend mode happens in the FlexConnect tab of the AP settings (the AP must be in FlexConnect
mode already). You can then have a few options, like Enable Least Latency Controller, which will allow the AP to join
the WLC with the lowest latency. Table 4-1 details some of the more common FlexConnect-related show commands.

Table 4-1 FlexConnect-Related show Commands

Command Purpose
IOS-AP# show capwap reap
assoc

Displays all serviced WLANs on each radio  with their VLAN and profile
configuration

IOS-AP# show capwap reap
saved Shows saved FlexConnect configuration on the  AP side

IOS-AP# show run Shows the AP config in the style of an autonomous IOS config (allows you to verify
VLAN assignments and access list)

IOS-AP# show ip access-list Shows the access lists loaded on the AP
Wave2AP# show Flexconnect
wlan Shows the FlexConnect configuration and  status of each WLAN on the AP

Wave2AP# show Flexconnect
vlan-acl Shows the VLAN and ACL mapping  configuration on the AP

WLC> show ap config
general  <Apname> Displays the current configuration of  the given AP

Another specificity of the OfficeExtend mode AP is that clients at the remote site will be able to reach out to the AP IP
address (typically a local LAN IP) and get a web UI for the AP. This web UI shows the AP console logs (for onsite
troubleshooting), allows you to set a WLC IP address (for easy provisioning), to monitor some metrics on the AP, but
also to configure a personal SSID. This personal SSID will be available only on that AP and therefore is not seen on the
WLC anywhere. That SSID will be locally switched at the remote site and is offered for convenience; it will not give
access to corporate resources. In the Wireless > Global Configuration Settings page, you have an OfficeExtend (in the
OEAP config section) specific option to prevent this local access to the AP if you don’t want remote site users to access
it. There are certain AP models that will come in OfficeExtend mode and are sometimes locked to that mode
(600OEAP, 700OEAP, 1810-OEAP, or 1815T); this gives the ability to order the APs, ship them to an employee’s
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house, and have them provision it easily by accessing the AP GUI.

Configuring and Troubleshooting Mesh

As a CCIE candidate, you are probably already familiar with mesh principles. This section can be used as a reminder of
the essential concepts you need to master to face the exam. Although you are not mandated to have expertise in specific
outdoor mesh AP models, you should be comfortable with setting up and troubleshooting mesh networks.

AWPP and Mesh Formation

In a Cisco network, mesh access points can have either of two roles:

Root access points (RAP) are configured to connect to the WLC using only their Ethernet connection. When
deployed in the field, RAPs are used by the other mesh APs as relays to reach the wire, and through the wire, the
WLC.

Mesh access points (MAP) are configured to use their Ethernet connection to reach the WLC. When such an
attempt fails, the MAP uses its radio interface (5 GHz unless configured specifically to use the 2.4 GHz radio) to
find a RAP (directly, or through another MAP) and reach the WLC that way.

Mesh Topologies

A consequence of this role structure is that Cisco mesh networks form trees, where the RAP is the trunk or the root, and
the MAPs branches. All APs in a tree are on the same 5 GHz channel (called the backhaul), unless APs have more than
one 5 GHz radio (in which case the uplink and downlink radio may be on different channel), as shown in Figure 4-30.

Figure 4-30 Mesh Network Topology

In the Mesh Network topology, "Layer 3 switch" at the center is connected to a "Dual-band access point" that
is further connected to three "Dual-band access point" through the channel 149 and they are further connected
to five dual-band access points and in turn, they are connected to five laptops. The "Layer 3 switch" points to
an internal, Apps, and Internet at the top. In the "Dual 5GHz Radio Mesh Network" an "Layer 3 switch" is
connected to an Internal, Apps, and Internet at the top and a dual-band access point at the bottom that is
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connected to three dual-band access points bidirectionally in through the channel 149. The first dual-band
access point, points toward two dual-band access point through the channel 157, the center dual-band access
point points to another dual-band access point through Channel 161, and the third dual-band access point,
points to two dual-band access point through the channel 157. All the five dual-band access points are
connected to five laptops.

Any AP allowing another AP to pass traffic through to reach the wire is called a parent for that AP. The AP using
another AP to get to the wire is the child. For example, suppose that MAP1 sends traffic through RAP1 to reach the
wire. MAP1 is RAP1’s child, and RAP1 is MAP1’s parent.

If a second MAP, MAP2, goes through MAP1 then RAP1 to reach the wire, MAP2 is MAP1’s child, and MAP1 is
MAP2’s parent. The relationship stops there (RAP1 is not described as “grandparent”). The network is said to have a
depth of two hops (RAP1–MAP1, then MAP1–MAP2). If another AP, MAP3, also uses MAP1 as its parent, then
MAP2 and MAP3 are neighbors (not “brothers” or “sisters”). In fact, any other mesh AP that can be detected and that
is neither a parent nor a child is a neighbor.

In such a network, traffic flows from the MAP to the RAP first, then may be sent back to other MAPs in the tree.
Traffic is never transversal. This is different from the structure described in the 802.11s amendment (dedicated to mesh
networks). In 802.11s, traffic can be transversal; there can be multiple RAP equivalents (called gateways) in a given
network. The 802.11s amendment was published years after most large vendors had already designed and implemented
their solution, which explains why most solutions do not follow the 802.11s structure.

AWPP and Mesh Formation

When a MAP boots, it first tries to join the WLC using its Ethernet interface (if it is detected as connected). If this
discovery fails, the MAP turns to its 5 GHz radio and scans all channels to discover a MAP or a RAP.

Each mesh AP connected to the WLC (as a RAP, or as a MAP through other APs) sends a status message on its 5 GHz
channel every 500 ms. This message informs possible other MAPs about the link availability to the WLC, along with a
value (the adjusted ease detailed later in this section) that expresses the quality of that link to the WLC. If more than
one AP is detected offering such a link, the MAP will use the Adaptive Wireless Path Protocol (AWPP), a Cisco
proprietary algorithm, to determine which AP offers the best path to the wire. The metric used for this protocol is a
combination of hop counts and SNR between APs on the path. The result of this metric computation for each hop is
called the ease value. A larger ease value typically reflects a better link. When multiple hops are combined, the adjusted
ease value reflects the link for the entire path (through all the hops needed to reach the wire). The highest adjusted ease
value represents the path with the best signal on each hop, for the least number of hops overall. In AireOS code releases
8.3 and later, the ease computation also includes link load values, and timers (frame travel time).

This discovery is efficient. As a CCIE, you should know how to force an AP through a specific path. However, in real
life, the adjusted ease represents the best path. Forcing your AP through another path should be done only if you have
good reasons to do so; a path does not become “acceptable” (from an RF standpoint) just because you force an AP to
use it.

After a MAP has scanned and discovered multiple possible paths, it will choose the link offering the best adjusted ease.
Once the MAP has joined the WLC, that chosen path receives an additional 20% “active path bonus” that is added to
its computed ease. This mechanism prevents jumpiness, where an AP jumps back and forth between two parents of
approximately the same ease value as the RF conditions change.

In a higher density network, there may be more than one mesh network in place in the same RF space. To resolve this
issue, you can configure your APs, after they have joined a WLC, with a group value called the Bridge Group Name
(BGN). The default value is Default.

Chapter 4 AireOS Appliance, Virtual, and Mobility Express Controllers

202

Technet24
||||||||||||||||||||

||||||||||||||||||||

https://technet24.ir
https://technet24.ir
https://technet24.ir


Mesh Configuration

Configuring mesh networks is straightforward because this configuration always consist of the same steps. Advanced
configurations may contain more possibilities, so make sure you master the basics before attempting nondefaults.

Mesh Basic Configuration

Your AP may already be in mesh (called Bridge) mode—you can order APs already set in that mode. When using APs
in standard mode, you need to switch them to mesh mode. This mode is called on the WLC Bridge mode (we’ll use this
correct terminology from now on), as shown in Figure 4-31. It is performed from Wireless > Select AP > General (CLI
config ap mode bridge <ap>). Setting the AP to Bridge mode requires that the AP 5 GHz radio channel and power be
set to Custom (CLI config 802.11a channel ap <ap> <any channel> and config 802.11a txPower ap <ap> 1).

Figure 4-31 Bridge Mode Configuration

In the Cisco window, "Wireless" tab is selected that displays a list in the navigation pane where "All APs" is
selected. Under All APs, "detailed for AP7cad.74ff.36d2" window is displayed. In the content pane "general"
tab is selected that displays the following sections: General, versions, language venue name, IP Config, Time
statics, hardware reset, and set to factory defaults. The "Admin Status" mode is set to enable. The "AP mode"
shows a list where "Bridge" is selected.

To prevent someone from attempting to have their AP join your WLC, you must authorize mesh APs on WLCs. This
authorization is by default a simple MAC address filter. From the screen shown in Figure 4-32, copy the AP MAC
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address (which is the Ethernet interface MAC address, not the base radio MAC address). Then, navigate to Security >
AAA MAC Filter and add the AP MAC address to a new filter, as shown in Figure 4-32 (CLI macfilter add <MAC,
e.g. 002a10605e78> 0 none none).

Figure 4-32 Mac Filter

In the Cisco window, "Security" tab is selected that displays a list in the navigation list where "MAC filters" is
selected. The "MAC filters" shows a new window in the content pane with the fields "MAC address, profile
name, description, IP address, and Interface Name." At the top right "Back and Apply" buttons are displayed.

For Bridge APs, you do not need to specify a profile (keep Any WLAN). The interface name should be management. If
your MAP has a static IP address, you can also use the IP address as a filter. Leave the field empty if the AP uses
DHCP.

When an AP is in Bridge mode, a new Mesh tab appears in the Wireless > Select AP configuration page. All APs come
by default as MAPs. To set the AP to RAP, change the mode from MeshAP to RootAP, as shown in Figure 4-33 (CLI
config ap role rootAP/meshAP <ap>).
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Figure 4-33 MAP vs. RAP Roles

In the Cisco window, "Wireless" tab is selected that displays a list in the navigation pane where "details for
RAP1" under "All APs" are selected. In the content pane, "Mesh" tab is selected that displays the following
sections "AP role: MeshAP (selected from a spin box), Bridge type, bridge group name, strict m,matching BGN,
Ethernet Bridging, preferred parent, backhaul interface, bridge data rate (Mbps): auto, Ethernet link status, PSK
key timestamp, and VLAN support with "Delete PSK" button. In the "Mesh RAP downlink Backhaul" section
"5 GHz" is selected for "RAP download backhaul" with Enable button. Footnotes at the bottom of the screen
read: 1(a) DNS server IP Address and the Domain name can to set 0nly after a valid static IP is pushed to the
AP. (b) Whenever Static IP version gets changed i.e. Ipv4 to 1pv6 or Ipv6 to Ipv4, the DAS server IP Address
and the Domain name displayed in the configuration in configuration page are rot valid. Needs to re-configure
DNS IP and Domain name after newly assigned stack 1P pushed to AP. 1(C) whenever Static IP version gets
changed i.e. lpv4 to lpv6 or Ipv6 to lpv4, The values given for DNS server IP and Domain name won't be set.
Needs to configure DNS IP and Domain name after newly assigned static IP pushed to AP. 2. Telnet/SSH can
be enabled In APs with non-default credentials only. 5. Hyperlocation Admin status is configurable for AP
specific configuration only. 5. Applies only to Mesh wireless Mesh Authentication to remove the PSK key and
set default on the Access Point. 6 External logging applies IOS AP with country code is CN only,
AP702/1530/1550/1570/1600/1700/2700/3500/3700.

In the same tab, you can configure the BGN, which is an ASCII string of up to 10 characters (CLI config ap
bridgegroupname <string>). If you configure a BGN, you can also set the AP to use only that BGN (strict matching
BGN, CLI config ap bridgegroupname strictmatching) or fall back to the default BGN if no AP is found with the
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right BGN (no strict matching). You can also configure the backhaul radio for that AP (configure this feature only on
the RAP) and set a preferred parent and the backhaul data rate. These last two elements should be configured only if
you are attempting to solve a specific issue (for example, load balancing between two equally valid parents). By default,
the AP chooses the best parent. If you force the AP to another parent, you may want to review your design instead, to
make sure that the parent you want is also the best parent. Similarly, the AP chooses the best rate for the backhaul; if
you force a specific rate, make sure that this rate is possible on that AP uplink.

Mesh Page Optional Configurations

Beyond the options relative to the AP itself, you may be asked to configure general options for the mesh network itself
(in the CLI, starting with config mesh keyword). Many of these options are in the Wireless > Mesh menu, as displayed
in Figure 4-34:

Figure 4-34 Wireless > Mesh

In the Cisco window, "Wireless" tab is selected that displays a list in the navigation pane where "Mesh" under
Advanced is selected. In the content pane, the sections of the Mesh reads: General, Mesh RAP Download link,
Convergence, Ethernet bridging, Security, and a table at the bottom with the headers "Server ID, Server
Address (Ipv4/Ipv6), port, and Enabled." In the Mesh RAP Download link, "5GHz" radio button is selected for
RAP Download Backhaul. In the "Ethernet Bridging" section "Enabled" checkbox is selected for VLAN
Transport.

Range: In the general section, the range is useful in determining the timeout (how long after ending a message does
an AP decide that the target AP is not going to respond). In a real deployment, if this value is too low, your local
AP may give up before the answer has a chance to reach that local AP.
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IDS is applicable only for outdoor APs. Indoor APs always perform rogue attack signature detection (just like APs
in local mode). By default, this function is disabled on outdoor APs and can be enabled.

Backhaul Client Access: By default, the 5 GHz radio is used for the backhaul (AP to AP communication), and
clients are on the 2.4 GHz radio. You can allow clients to also join the SSIDs on the 5 GHz radio by enabling
Backhaul Client Access. A consequence of such feature is that individual clients can clog the radio that is used for
multiple APs. Notice that, in the same configuration page, you can also set the backhaul to 2.4 GHz. This is useful
when 5 GHz signals do not reach the MAPs properly (for example, because of foliage). If you set the RAP backhaul
link to 2.4 GHz, the client backhaul access becomes 2.4 GHz as well.

Mesh DCA Channels: For indoor APs, the backhaul radio is chosen by RRM with the list built from WIRELESS >
802.11a > RRM > DCA. DFS channels are always a concern, especially in outdoor networks. This concern results
in several configuration elements that seem to partially overlap:

In the DCA page, you can check the Avoid Check for non-DFS Channel option. The logic behind this option is
that DCA configuration enables you to choose the channels you want to use for 5 GHz, but at least one of these
channels must be non-DFS. If you choose only DFS channels, you will get a warning from the WLC. However,
some countries allow DFS channels only for outdoor links. In these countries, you can check the Avoid Check
for non-DFS Channel option to remove the WLC warning about non-DFS channel. You can then select only
DFS channels.

Back on the Mesh tab, Mesh DCA Channel enables you to refine the channel change behavior, but only for
outdoor mesh APs with dual 5 GHz radios. In case of a radar (DFS) event, RRM can change the channel. But
what happens if none of the channels you selected in the DCA page are available (for example, because you
selected only DFS channels and they are all hit by radar)? By default, RRM will forcefully assign another
channel, even if it was not in your DCA channel list (RRM chooses this option only when it has no other
choice). When selecting the Mesh DCA Channel option, you tell RRM to never choose channels outside the
DCA list (again, only for dual radio outdoor APs, like the Aironet 1524SB). RRM will then rather shut down
the radio than assign to a channel outside of your DCA list. This option is useful if you set a mesh link between
indoor and outdoor APs. You can set the list of channels in the DCA page, and check the Mesh DCA channel
option to make sure that your outdoor dual 5 GHz radio APs will not choose a channel outside that list.

Mesh Backhaul RRM: By default, mesh APs do not participate in RRM. Their channel is configured statically
from the AP 5 GHz radio page, and mesh APs do not attempt to detect power optimizations of coverage holes. To
enable RRM on the backhaul, check the Mesh Backhaul RRM option. This will enable the RAP (and only the RAP)
to perform RRM. MAPs down the link will change their channel as the RAP changes its own channel. Note that the
CLI offers additional options to the Web UI. In the CLI, config mesh backhaul rrm enable is the equivalent to the
Mesh Backhaul RRM check box in the UI. However, the CLI also allows you to configure config mesh backhaul
rrm <auto-rf global / off> to only activate or deactivate the DCA function of RRM for your backhaul.

Global Public Safety: This feature is useful in the FCC regulatory domains to activate the 4.9 GHz safety bands.

Outdoor Ext. UNII B Domain Channels: The FCC regulatory domain allows new channels for outdoor usage
(UNII 1 channels 36, 40, 44, 48, and UNII 2 extended channel 144). UNII1 was allowed only for indoor use in the
prior rules (called A domain). The FCC allows UNII1 outdoor, and a new UNII2e channel with the B domain rules.
You can enable the B rules by checking this Outdoor Ext. UNII B Domain Channels option.

Convergence mode: This option is valid on AireOS code 8.3 and later. Each AP keeps track of its neighbors. When
a parent is lost, detecting the loss takes time (nonresponse to a certain number of keepalive messages). Then,
scanning all channels for a new parent also takes time. To expedite the process, in case of a parent loss, you can
choose a different convergence set of timers. With the standard mode, an AP takes 21 seconds to detect a parent
loss, then scans all channels to find a better parent. With the Fast mode, the AP waits only 7 seconds to decide that
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a parent is lost (1 second after sending the third keepalive at a 3-second interval). The AP then scans only the
channels for which it detected neighbors in its own BGN. With the very fast mode, keepalives are sent at 1.5
second intervals, and the AP detects the parent lost within 4 seconds. The AP also scans only the channels for
which it detected neighbors in its own BGN. With the Noise Tolerant fast, the AP operates as in the very fast mode,
but waits longer after each keepalive before deciding that it received no answer and retries each keepalive. In a lab
environment, the decision is about speed or stability. A faster mode allows for faster convergence, but the next
parent chosen may not be the best, resulting in a potentially unstable uplink (and the risk of losing that new parent).

Background Scanning: How would an AP know its neighbors? By default, the AP learns about them during the
initial scanning phase. By the time the parent is lost, which may be days after the initial join phase, these neighbors
may have changed channels or have disappeared. If you want your AP to maintain a fresh list of neighbors, check
the Background Scanning option. In this mode, the AP will leave its backhaul channel every 5 seconds to go scan to
neighbor channel information refresh. The advantage is to maintain a fresh list of neighbors, but the downside is that
you may be disrupting the traffic on the backhaul, because the AP is away at regular intervals.

Channel Change Notification: By default, a mesh AP changes its channel silently. The other APs that may depend
on that channel will have to scan and discover the AP again. If you enable mesh backhaul RRM, or if you change
the AP channels often, you may want to enable the Channel Change Notification feature. When the AP changes
channel, it informs its children and parents through CAPWAP.

Mesh Security Configurations

Authorizing your mesh APs to join the WLC is a key component of the deployment task. During the discovery phase, a
MAP will scan channels, discover the AP with the best Ease value in its Neighbor Update messages, and then
authenticate to the RAP. This phase is used to ensure that the backhaul link is encrypted. This authentication can be
done using EAP-FAST, leveraging the AP’s certificates (default). However, you may want to use PSK instead. This is
useful if your AP is an old model with LSC certificates, or an expired certificate, or if you are unable to provide a
proper clock synchronization to your system. You can change the authentication to PSK from the Wireless > Mesh >
Security section (CLI config mesh security psk). You then have to set the PSK. You should be aware that your APs
first must join the WLC so that they can be provisioned with the PSK. They will then use PSK on their next join
attempt. If new APs join a PSK-based system, authentication will fail, as the new AP does not know the PSK. To
prevent this issue, choose the Default PSK option, allowing the new AP to use a factory-built value for the PSK and join
successfully, even if the PSK you configured on the WLC is unknown to the new AP. In that case, you may also want
to choose PSK provisioning, to push the new PSK value to the joining AP. Using these two options allows any Cisco AP
to join your WLC. You would enable them only when new APs are expected to join the mesh.

One confusing aspect of this authentication to the RAP is that the goal is to encrypt the mesh backhaul. However, the
RAP is not an authentication server. During the authentication phase, the RAP relays the query to the WLC, and the
WLC is the entity performing the authentication validation. However, at this point, the WLC is not authenticating the
MAP directly; it is merely validating the requests from the RAP so as to enable backhaul link encryption. The MAP has
not joined the WLC yet.

After encryption to the RAP is achieved, the MAP uses the backhaul link to send CAPWAP messages to the WLC. At
this point, the WLC needs to authenticate the MAP. The authentication can use a MAC address filter configured on the
WLC, as described earlier in this section. In some cases, it may not be practical to use such a MAC filter. A typical
example is mining operations where APs are moved between sites, and a single AP may end up on any number of local
controllers. Entering all the MAC addresses of all possible APs on all WLCs is inefficient in this context. In this
environment, you can set the MAP to authenticate using only its certificate, by checking the LSC only MAP
Authentication (CLI config mesh security lsc-only-auth). The WLC will then validate the AP certificate but ignore the
MAC address filter.

Note
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Using LSC on a mesh network implies deploying local certificates to your mesh AP; it is not an expected default option
in most networks. Refer to the following document for more details on LSC configuration for mesh APs:

https://www.cisco.com/c/en/us/td/docs/wireless/technology/mesh/8-
0/design/guide/mesh80/mesh80_chapter_0101.html#task_7F382C8D84E544F8A92D684F9F7B74BC

You can also use an external RADIUS server to authenticate your mesh APs. This is achieved by checking the option
External MAC Filter Authorization. In that mode, the WLC relays the AP authentication query to a RADIUS server
configured on the WLC (from the global RADIUS Servers list). The RADIUS server must be configured to use EAP-
FAST with certificates to accept the AP queries.

For each AP, you also need to add a new user to the RADIUS database, with the name being the AP MAC address (for
example, aa-bb-cc-dd-ee-ff) and the password being the same MAC address value. Additionally, for IOS APs, you must
add a second user entry, with the name being the platform and Ethernet MAC address (for example, c1520-
aabbccddeeff) and the password cisco.

When a mesh AP attempts to join the WLC, the local MAC address filter list is checked. If the mesh AP MAC address
is not found, the WLC relays the query to the RADIUS server. The mesh AP is then authenticated there using EAP-
FAST and the mesh AP certificate. This mode mandates that you use EAP as a security mode.

If you want to completely bypass the local WLC MAC filter list, you can also check the Force External Authentication
option. In that case, the WLC local list is completely ignored.

Mesh Local Bridging Configurations

Local bridging has long been a salient feature of mesh networks, allowing devices connected to your MAP to send
traffic through the backhaul. The original use case was about street cameras, but many deployments ended up
connecting switches and entire networks to these MAPs. The requirements of local bridging became so close to
FlexConnect local switching that both modes were merged for Mesh networks in WLC code AireOS 8.0. The result is
that both modes are often confused.

Without Flex configuration (that is, when your APs are configured in regular Bridging mode), you can enable Local
Bridging on the AP. For each AP on the link, enable Ethernet Bridging in the AP Mesh configuration tab. This must be
done on all APs on the link (if MAP2 uses MAP1 to reach RAP1 and you need to relay traffic from a camera connected
to MAP2 Ethernet interface, you need to enable Ethernet bridging on MAP2, MAP1, and RAP1). This function is
disabled by default to prevent anyone from connecting something to your mesh APs and sending traffic over the
backhaul.

If your APs connect to switches on a trunk port, you also need to enable VLAN support for these APs. Check the
VLAN support option and click Apply. When you come back to that same page, you can decide the native VLAN
value, and also click the Ethernet interface at the bottom of the screen to configure the VLANs you need supported
across the AP interfaces (radio and Ethernet). This configuration is not always needed on the MAP if it connects to an
access port; however, it is often needed on the RAP. You should also keep in mind that enabling Local Bridging does
exactly what the name implies: when traffic coming from the backhaul reaches the RAP, it is bridged locally (that is, not
forwarded to the WLC).

In addition to this regular local Bridging function, you can enable the AP to operate in Flex+Bridge mode. The main
features of this mode are represented in Figure 4-35.
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Figure 4-35 Flex+Bridge Mode

The Flex+bridge mode shows a WAN that is connected to a Central Site and a remote office. The Central site
consists of two WLCs, a printer, router, and six routers that are connected in two rows from top to bottom. The
Remote office consists of two routers that are connected to each other, connected to dual routers at the bottom.
The signal from the device (mobile and a laptop) is connected to a Local traffic that is further connected to
another Local traffic. The second Local traffic points to the printer in the Central Site through the set of
routers. The Centralized traffic from the laptop points to the right end of the Central site through the Local
traffic, dual routers, and WLCs. At the bottom, the signal from the local data WLAN points to the printer
through the local traffic and the central data WLAN from the Laptop points to the Centralized traffic at the top
through the routers in the remote office and two WLCs. A dotted line connects the local traffic to the WLCs.
The points to the left of the figure reads "Control Plane Supports: Connected (WLC Is Reachable) and
Standalone (WLC Not Reachable); Data Plane Supports: Centralized (Split MAC) and Local (Local MAC);
FlexConnect Groups; Max 8 Mesh Hops, Max 32 MAPs per RAP; Local AAA Support; A WLC Can Have a
Mix of Bridge and Flex+Bridge; MAPs Inherit VLANs from the Connected RAP.

In this mode, local bridging is also allowed but for the wireless clients connecting to the RAPs and MAPs (in the local
Bridging feature previously explained, the local bridging was only for wired devices connected behind MAPs’ Ethernet
ports). In addition, a new FlexConnect tab appears that includes the VLAN support option (moved from the Mesh tab).
In this Flex+Bridge mode, you can decide whether your VLAN configurations are local to the AP or are global. If the
VLAN configuration is expected to be global, you should check the Install mapping on radio backhaul to apply that
mapping to the other APs and the backhaul. In that case, you only need to configure the mapping on the RAP.

You can also configure from the same tab FlexConnect features such as WLAN to VLAN mapping (including local
switching for WLANs), local split ACLs, and so on.

An advantage of the Flex+Bridge mode is that the AP now supports loss of connectivity to the WLC. In standard
bridging mode, the loss of connectivity to the WLC is a major issue that stops the mesh operation. In Flex+Bridge
mode, loss of connectivity to the WLC pushes the AP to a standalone mode similar to FlexConnect. RAPs continue to
bridge traffic. A MAP maintains its link to a parent and continues to bridge traffic until the parent link is lost. However,
an AP cannot establish a new parent or child link until it reconnects to the WLC. Existing wireless clients on the locally
switching WLAN can stay connected with their AP in this mode. Their traffic will continue to flow through the Mesh
and wired network. No new or disconnected wireless client can associate to the Mesh AP until the WLC connectivity is
back.
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Troubleshooting Mesh

Proper mesh operations can be verified from the WLC UI, from the Neighbor Information option, found in the blue
chevron of an AP line in Wireless > All APs. The neighbor information is shown in Figure 4-36. You can get the same
information from the CLI (using show mesh family of commands).

Figure 4-36 Mesh Verification

In the Mesh verification, two screenshots overlap the first window. A cisco window is shown where the
"Wireless" tab is selected that displays a list in the navigation pane where "FlexConnect Groups" is selected.
The column headers in the content pane read "AP Mode, Certificate type, OEAP, Primary SW version, Backup
SW version, AP sub-mode, Download status, Upgrade Role (Master/slave), mDNS status, Universal AP,
Hyperlocation, and Fabric status. The drop-down in the second row of Fabric status shows a small list where
"Neighbor" is selected that displays the details of "Neighbor info" in a Cisco window. In the first overlapping
window, "Wireless" tab is selected that displays a list in the navigation pane where "RAP1" is selected under
"All Apps." The column headers of the "Neighbor Info" are "Mesh type, AP name/Mac, Neighbor backhaul
MAC, Source Backhaul NAC, Slot ID, Neighbor channel, and Source Channel." In the first row, a drop-down is
shown at the end that displays a list where "details" is selected. The second overlapping Cisco Window where
the "Wireless" tab is selected that displays a list in the navigation pane where "All APs" is selected. The "Link
details" of the RAP1 are listed as follows: Neighbor AP name/MAC, Neighbor base radio MAC, Neighbor
Type, channel, Backhaul Data rate, Link SNR, and Time of last hello.

From these pages, you should be able to verify neighbor relationships, parent-children links along with transmitted
frames, and signal quality. In most cases where issues affect APs that have already joined, these pages will help you
determine why an AP did not choose the path you designed, or why APs form a different relationship from the one you
expected.

In real life, multiple issues may affect your mesh network. In the lab, beyond link and RF problems, the most common
issue for mesh is an AP failing to join. You should be aware that mesh convergence takes time. It is not uncommon for
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an AP to need 5 to 10 minutes to join the mesh network in a noisy environment. While you wait, the first verification
should be about AP authentication.

You should use the debug mesh family of command for any mesh issue. Example 4-1 focuses on the join issue and
shows the commands you can use and a typical output.

Example 4-1 Debugging Mesh Events

Click here to view code image

(Cisco Controller) >debug mesh ?
alarms         Configures the Mesh Alarms debug options.
astools        Configures debug of mesh astools.
message        Configures the Mesh Message debug options.
security       Configures the Mesh Security debug options.

(Cisco Controller) >debug mesh security ?
all            Configures debug of all mesh security messages.
errors         Configures debug of mesh security error messages.
events         Configures debug of mesh security event messages.

(Cisco Controller) >debug mesh security events enable
(Cisco Controller) >*spamApTask4: Jan 01 16:20:17.673:  08:CC:68:B4:2F:80
  Request MAC authorization for AP Child Addr:  08:cc:68:b4:46:cf AP Identity:
  7c:ad:74:ff:36:d2 AWPP Identity: 08:cc:68:b4:2f:8f
*spamApTask4: Jan 01 16:24:04.095:  08:CC:68:B4:2F:80 MESH_ASSOC_REQUEST_PAYLOAD in
  Association Request for AP 08:CC:68:B4:46:CF
*spamApTask4: Jan 01 16:24:04.095:  08:CC:68:B4:2F:80 Mesh assoc request for known
  AP 08:cc:68:b4:46:cf
*spamApTask4: Jan 01 16:24:04.095:  08:CC:68:B4:2F:80 Mesh assoc request :child :
  08:cc:68:b4:46:cf NextHop : 7c:ad:74:ff:36:1a  LradIp 172.31.255.113  vlanid: 31
  mwarPort: 5246  lradPort: 62306
*spamApTask4: Jan 01 16:24:04.095:  08:CC:68:B4:2F:80 Request MAC authorization for
  AP Child Addr:  08:cc:68:b4:46:cf AP Identity: 7c:ad:74:ff:36:d2 AWPP Identity:
  08:cc:68:b4:2f:8f
*spamReceiveTask: Jan 01 16:24:04.097: MAC Validation of Mesh Assoc Request
  for08:cc:68:b4:46:cf is -9, Mode is : 0

In Example 4-1, the MAC address of the MAP was removed from the WLC MAC filter. The same effect would appear
if the AP was removed from the RADIUS (but you would also see RADIUS logs). As a result, the MAP is known, but its
association request shows −9 (which is a “no”). In the WLC SNMP traps, you also see the following:

Click here to view code image

AAA Authentication Failure for Client MAC: 08:cc:68:b4:46:cf
  UserName:7cad74ff36d2  User Type: WLAN USER Reason: unknown error

What you should see instead is the following:

Click here to view code image

(Cisco Controller) >debug mesh security events enable
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*spamApTask4: Jan 01 16:31:36.938:  08:CC:68:B4:2F:80 MESH_ASSOC_
  REQUEST_PAYLOAD in Association Request for AP 08:CC:68:B4:46:CF
*spamApTask4: Jan 01 16:31:36.938:  08:CC:68:B4:2F:80 Mesh assoc
  request for known AP 08:cc:68:b4:46:cf
*spamApTask4: Jan 01 16:31:36.939:  08:CC:68:B4:2F:80 Mesh assoc
  request :child : 08:cc:68:b4:46:cf NextHop : 7c:ad:74:ff:36:1a
  LradIp 172.31.255.113  vlanid: 31  mwarPort: 5246  lradPort: 62306
*spamApTask4: Jan 01 16:31:36.939:  08:CC:68:B4:2F:80 Request MAC
  authorization for AP Child Addr:  08:cc:68:b4:46:cf AP Identity:
  7c:ad:74:ff:36:d2 AWPP Identity: 08:cc:68:b4:2f:8f
*spamReceiveTask: Jan 01 16:31:36.940: MAC Validation of Mesh Assoc
  Request for08:cc:68:b4:46:cf is 0, Mode is : 0

Validation is 0, meaning that the AP successfully passes the association phase (0=success) and moves to the PMK
exchange phase.

A second possible key issue is about IP addressing. APs join a mesh network based on RF links. This may result in an
AP using a backhaul path different from the one you designed, using a different RAP. This can be a problem if the RAP
is in a different subnet than in your design, and if the MAP has a static IP address (that may end up in the wrong
subnet). By default, the AP will revert to DHCP if it can’t join using its static address. Remember that the MAP does
not need any IP connection to establish a secure link to the RAP, but will need IP connectivity to join the WLC
successfully. If APs are very slow to join, verifying the IP addressing scheme should be one of your troubleshooting
steps.

In real life, there may be many options that would need to be enabled for a mesh network. In the lab, however, the main
purpose of the configuration is to verify your understanding of the central issues, and the elements covered in this
section of the chapter should help you make your way through the mesh section.

Radio Frequency Management

This section encompasses all the settings on the WLC pertaining to radio frequency parameters—whether they are
static or managed through the Radio Resource Management (RRM) algorithm.

What Problem Are We Trying to Solve?

Without getting back too much into the RF Layer 1 theory again, two main things can be tweaked to optimize a wireless
deployment: transmit power and channels used. Of course, the most important is the physical placement of APs and
antennas and overall design, but that is not part of the CCIE wireless lab exam. After a network is up, it mostly boils
down to changing the power and the channel of APs to achieve the best efficiency possible depending on your
requirements and current deployment.

The 2.4 GHz band is typically straightforward, despite the availability of 11 (or 13 or 14, depending on country)
channels, you can only use 3 because we definitely want to use non-overlapping channels to avoid adjacent-channel
interference. There is a global agreement that channels 1, 6, and 11 are the best to use. (Although some people try a 4-
channel plan with 1, 5, 9, and 13, this is not recommended for all deployments and is anyway restricted to countries
where more than 11 channels are available.) The 5 GHz band doesn’t have such restriction, and you can basically pick
any channel you like because they do not overlap. However, 802.11n brought 40 MHz channels and 802.11ac brought
80 MHz channels, which adds a layer of complexity to the channel plan. 40 MHz channels include a “primary 20 MHz
channel,” which means that if an AP declares to be on (36, 40), all management and control frames are sent at 20 MHz
width on channel 36, for example, and clients are allowed to send 40 MHz wide data frames on both 36 and 40. So 36
serves as primary channel for all the nondata frames as well as clients who might not support 40 MHz. The concept is
the same with 80 MHz, where there is a primary 20 MHz channel (for all nondata frames) and a primary 40 MHz
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channel (for clients who might not support 80 MHz). For example, an AP declaring to be on (40, 36, 44, 48) has the
primary 20 MHz channel on 36, the primary 40 MHz on 36 and 40, and the 80 MHz spanning from 36 to 48. The
concept is illustrated in Figure 4-37.

Figure 4-37 Example of Channel Width with Primary and Secondary Channels

The sample shows eight channels where the first two channels represent Secondary 40, the third channel
represents the Primary, and the remaining channels represent Secondary 80. The width of the channels are as
follows: Primary and the second secondary channel: 40MHz; First secondary40, primary, and second
secondary4o channel: 80MHz and all other channels 160MHz or 80+80MHz.

This means that the primary 20 MHz must not necessarily be the first channel in ascending order, which in turn means
that you could imagine an AP on “(40,36)”, which would have its primary channel on 40 and another AP close by on
“(36,40)”, which would have its primary channel on 36. Both would have to share medium when sending 40 MHz data
frames but could send 20 MHz management frames at the same time because they would then be on different channels.
This is not optimal (it’s best to have them fully on separate channels) but this is something that can be done. Secondary
channels have different Clear Channel Assessment (CCA), depending on the client standard (802.11n or 802.11ac),
which changes the received signal strength value at which a station can consider the medium to be free to transmit. All
of this makes it harder and harder to fully design a channel plan statically in a mixed real-life environment.

Because the 2.4 GHz wavelength tends to cover a greater distance for an equal modulation, and because designs are
typically made with 5 GHz in mind, newer deployments typically have too many 2.4 GHz radios and with only three
available non-overlapping channels (that are possibly sharing the air with Bluetooth, microwaves, or any other IoT kind
of device), it has become a “best effort” band. There are still single band wireless clients, so it might still be desirable to
provide 2.4 GHz coverage for those, at least in specific areas, but no one talks about high density with 2.4 GHz because
this is impossible due to the lack of channels. The 2.4 GHz band is still very useful for RFID and tags location tracking
as well as other IoT usage, though, but 5 GHz will take most of the requirement with regard to video and audio
streaming, real-time applications, and bandwidth-intensive applications.

The 5 GHz band still has a few tricks to clarify, though. Only channels 36 to 48 are strictly non-DFS channels in every
country. Most (and often all) of the others are DFS regulated channels (in most countries, with exceptions), which
means that an AP arriving on that channel will have to wait one minute to make sure there is no radar on that channel; it
can then transmit beacons. Clients don’t need to do this check if there is an access point already beaconing on that DFS
channel. The DFS regulation enforces 10 minutes wait time on channel 120 to 128 before an AP can beacon, rendering
these three channels very impractical, and many APs do not support them for this reason. Support on the client side also
differs greatly; more and more clients support more and more of the UNII-2 extended channels, but it’s unrealistic to
hope that all your clients will support all the channels that your AP might support. Over the years, more channels
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become available in some countries (like channel 144 currently) but it will take many more years for clients to support
these channels.

Static Assignment

The WLC allows you to configure each radio of each AP in a static manner or to leave it managed by the RRM
algorithm (as illustrated in Figure 4-38). When the radio has static assignments, the little asterisk next to it disappears,
meaning that the radio assignment is not managed by RRM anymore. The channel, channel width (20, 40, 80, 160), and
transmit power can be assigned manually (as shown in Figure 4-39).

Figure 4-38 Asterisk Means the Channel or Tx Power Is Set Globally by RRM

In the Cisco window, "Wireless" tab is selected that displays a list in the navigation pane where "802.11a/n/ac"
is selected under Radios. In the content pane, the column header reads: AP name, radio slot, Base radio MAC,
Sub-band, Admin status, operational status, channel, CleanAir/SI admin status, CleanAir/SI Operation Status,
Mesh Radio Role, Radio Role, and Power level.
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Figure 4-39 It Is Possible to Manually Configure Channel or Tx Power or Both

In the RF Channel assignment, the "Current channel" is set to 100 and the "Channel width" is set to 20MHz
(from a spin box). A radio button is selected for "Global" under the "Assignment method." The "Radar
Information section" shows the column headers "Channel and Last Header (Seconds)." Under "Tx (Transmit)
power level assignment," the "Current transmit power level" is set to 1 and the "Global" radio button is selected
for "Assignment method." The "Performance Profile" shows the "Performance Profile" button.
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Global Assignment (RRM)

The RRM algorithm is actually several separate and mostly unrelated algorithms, each taking care of one specific
functionality:

Transmit Power Control (TPC) is in charge of decreasing the transmit power of specific AP radios in case there are
several APs very close to each other (which would then interfere with each other).

Coverage Hole Detection algorithm (CHD or CHDM) is in charge of increasing the power of radios (so the
complete opposite of TPC) if there are several clients that stick to that radio at a poor signal strength.

Dynamic Channel Assignment (DCA) is in charge of choosing the best channel for each AP radio, taking all
surrounding radio channels as well to come up with the most optimal channel plan.

Flexible Radio Assignment (FRA) is a newer addition to RRM and takes care of APs with flexible XOR radios
(2800, 3800, 4800 at the time of this writing). It will decide whether there are too many 2.4 GHz radios providing
client coverage and either turn some into monitoring radios or 5 GHz clients serving.

But before diving into these algorithms, it is important to understand based on what metrics all those algorithms make
their decisions. APs are involved in some data collections activities regardless of the algorithms that are enabled or
configured, and it’s with these data that the RRM algorithms will make their decisions.

Off-Channel Scanning

In a nutshell, APs will go off their client-serving channel to scan very briefly other channels and will also send a
neighboring packet to help neighboring APs discover and learn about them. In the Wireless> 802.11a/b > RRM page
(shown in Figure 4-40), we can set the channel list for monitoring channels (for noise, interference, rogue, and
CleanAir).

If set to Country Channels, the APs will scan and send discovery neighboring packets on all the channels supported
officially in the country (regardless of whether you restricted the channel list for DCA).

If set to All Channels, the APs will scan on all the channels that their hardware supports. This includes channels not
supported in the configured country; however, the AP will only passively scan (that is, listen) there and cannot
transmit on those channels (to avoid violating laws).

If set to DCA Channel List, the AP will only scan and send discovery neighboring packets on channels configured
in the DCA list (that is, the list of channels we configured the AP to pick from). This typically would restrict the AP
scanning channels 1, 6, and 11 on 2.4 GHz because it’s common to have only those three enabled for the AP to pick
from. The result is that your APs will not detect any rogue that would be present on channels 3 or 9, for example.
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Figure 4-40 RRM Settings Page

In the settings page, "Wireless" tab is selected that displays a list in the navigation pane where, 802.11a is
selected under the access point. RRM is selected under the 802.11a that displays the general settings in the
content pane. The "Profile Threshold for traps" section shows the fields "Interface, clients, noise, and
utilization." The "Noise/Interface/Rogue/CleanAir" of the monitoring channels section shows the "Channel
list" that is set to "Country Channels (selected from a spin box)" and are section is highlighted. The
"Monitor Intervals (60 to 3600 seconds)" section shows the fields "Channel scan interval, neighbor packet
frequency, and Neighbor timeout factor (5 to 6)" and is shown inside a box. The "Factory default" shows
the "Se to factory default" button.

The same page allows you to set the timers for those scanning activities in the Monitor Intervals section. The Channel
Scan Interval field refers to the passive dwell activity. We already hinted a bit in the previous paragraph, but this
defines in which interval the AP must complete its passive scanning of all the configured channels (DCA, country, or all
channels). The radio will spend 50ms on that channel to passively listen for rogues, collect noise, and interference
metrics. This means that for a bit more than 50ms (because the radio must change channel and this takes a few ms) the
AP is outside of its channel (unavailable) without any means to warn clients about it. This time is usually small enough
for clients to try to retransmit their frames and not go crazy about the AP not responding anymore. To give two
examples, if we configured APs to scan the DCA channel list on 2.4 GHz, which would mean channels 1, 6, and 11,
then the AP has 180 seconds (because the monitoring interval is set to 180 seconds by default) to scan those three
channels. This implies that the AP will leave its channel every 60 seconds to scan another channel. If on 5 GHz, there
are 22 channels to scan in most countries, which means that the AP will scan another channel every 8.18 seconds in
order to be done within 180 seconds.
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Right under the monitoring interval is the Neighbor Packet Frequency option, which is similar. It defines the interval of
time in which the AP must be done sending a Neighbor Discovery Packet (NDP) on each of the monitoring channels
(provided they are allowed in the country; otherwise it cannot transmit there).

NDP packets are sent to a multicast destination address for all other APs to hear. They are sent at the highest power
allowed for the channel and band (regardless of any configuration you may do) and at the lowest data rate supported in
the band (regardless of what you configured as well). They allow each AP to build a list of Rx Neighbors (how they
hear other APs) and Tx Neighbors (how other APs hear that one). The Neighbor Timeout factor setting in the RRM
page allows you to define after how many Neighbor packet frequency (180 seconds by default), the AP must delete a
neighbor AP if it didn’t hear it anymore. For example, if you choose 5, it means that the neighbor AP has 5
opportunities (5 times 180 seconds) to send an NDP on “your” channel before you delete it as a neighbor. What is the
purpose of this feature? There might be reasons for an NDP packet to be postponed: maybe the medium is busy, but if
there is a voice SSID on that neighbor AP and because Off Channel Scan Defer is enabled by default for UP 4, 5, and 6
on the WLAN settings, it means that the AP will postpone NDP transmission (and even scanning activity) until voice
calls are over, which may definitely take some time. We do not want to prematurely delete APs from an RF
neighborhood just because they were prevented from sending an NDP packet. It is interesting to note that NDPs will not
be sent on DFS channels where no APs have been heard, because DFS regulations normally require an AP to monitor
the channel for 1 minute before sending something on it.

When the AP has an extra monitoring radio (3600, 3700 with the monitoring module, or a 4800), that third radio is
doing all the off-channel scanning activities (including transmitting and listening for NDP packets).

RF Grouping

The NDP packets allow APs to hear each other over the air and identify other APs channel and transmit power settings,
but there must be some kind of grouping. It is not because two APs are Cisco models and hear each other that they
necessarily belong to the same deployment.

The RF group settings in the general controller settings allow for some administrative grouping: your APs will not try to
discuss with your neighbor company’s APs. You can decide whether to configure the same RF group on the various
WLCs you own, depending on whether you want APs from each WLC to take others into consideration. Inside each RF
group, there is also a concept of RF neighborhood. Indeed, there is little point for APs that are in separate buildings and
incapable of hearing each other to work together on a channel plan. An RF neighborhood determines a group of APs
that hear each other at −80dBm at least (they don’t necessarily need to hear each of the APs in the RF neighborhood,
but there should always be a way to relate all APs in the neighborhood through other neighbor APs belonging to the
group). This allows for an algorithm to run on smaller groups of APs that should care about each other, as shown on
Figure 4-41.
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Figure 4-41 RF Neighborhood

The RF neighborhood shows three figures. The "RF Group Bob" is connected to four "Lightweight double radio
access point" labeled "RF Neighborhood-1, RF Neighborhood-2, RF Neighborhood-3, and RF Neighborhood-
4." The signal strength between RF Neighborhood-1 and RF Neighborhood-4 is "less than negative 85 dBm." In
the second figure, the "RF group Bob" points to four "Lightweight double radio access point (two at the top and
two at the bottom) labeled "RF Neighborhood-1 and RF Neighborhood-2." The signal strength between RF
Neighborhood-1 is "greater than 80 dBm" and in the Neighborhood-2 is "greater than negative 80 dBm." The
signal strength between RF Neighborhood-1 and RF Neighborhood-2 is "lesser than negative 85 dBm." The
third figure shows "RF Neighborhood-1" consisting of an LWAPP that points to three "RF Group Bob." The
first Bob points to an LWAPP of the "RF Neighborhood-2" with signal strength "lesser than negative 85 dBm."
The second bob points to an LWAPP of "RF Neighborhood-2" with signal strength "greater than 80 dBm" and
to an LWAPP in the "RF Neighborhood-3." The third Bob points to another LWAPP of the "RF
Neighborhood-3" with signal strength "greater than 80 dBm."

Each RF group (which can span, or not, through multiple WLCs) must elect an RF group leader, which will be the WLC
responsible for the RF configuration, running the RRM algorithms, and collecting and storing the RF data and metrics.
There is an RF group leader per frequency band. It can be the same WLC, but not necessarily (some APs can hear each
other on 2.4 GHz but not on 5 GHz, so even the RF neighborhoods might not be the same). The RF leader is elected
based on a combination of the WLC model (the higher the model/capacity, the higher the priority) and the IP address.
The first condition for this to happen is that APs of different WLCs must hear each other over the air; then the WLCs
must be reachable via the wired network (UDP 12134->12124).

It is critical to understand that the RF leader will make the RF decisions; therefore, it is on the RF leader that the
settings will definitely matter. The RF grouping page, illustrated in Figure 4-42, lets you know who the RF leader for
each band is and how many APs are part of it, and lets you override the RF leader selection manually if desired.
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Figure 4-42 RF Grouping Page

The RF grouping page shows the fields of the "RF Grouping algorithm." The "Group mode" is set to "Auto
(selected from a spin box)" with a restart button. The field "Maximum and Current number of member" is set to
20/1 and the "Maximum and Current number of AP" is set to 500/5" and are highlighted. The other fields are
"group role, group update interval, group leader, group name, protocol version, packet header version, and last
group update." At the bottom, the "Controller Name" is shown with the IP address.

Flexible Radio Assignment

2800, 3800, and 4800 APs have a flexible XOR “slot 0” radio. It starts as a classical 2.4 GHz radio but can switch to 5
GHz or monitor both bands. Flexible radio assignment (FRA) first measures the coverage overlap factor (COF); that is,
the amount of superfluous 2.4 GHz radios that could be turned off without impacting coverage. It then manages the
radio roles of those APs with high COF, to either switch them to 5 GHz client serving or full dual-band monitoring.
Finally, it also takes care of the load balancing of clients between the two 5 GHz radios in a micro/macro cell scenario.

FRA runs with the same RRM metrics (mostly NDP packets) as other algorithms, and it takes all previous (non-XOR)
AP models into account to determine the 2.4 GHz coverage overlap factor. However, for now only the 2800/3800/4800
AP radios can be marked as superfluous and their role changed. The COF is the percentage of the analyzed cell that is
covered at −67dBm by other existing radios in service. So, if the COF of an AP is 100%, it means its 2.4 GHz radio can
be disabled without any loss of coverage (in fact, it will even lower same-channel interference and will improve your
airtime availability). The FRA page (illustrated in Figure 4-43) allows you to configure the COF threshold. At Low, it
will mark as redundant radios with a 100% COF; at Medium, it will mark as redundant radios with a 95% COF, and it
will be 90% for the High setting.
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Figure 4-43 FRA Settings Page

In the Cisco window, "Wireless" tab is selected that displays a list in the navigation pane where "Advanced"
menu is selected that displays the "Flexible Radio Assignment Configuration" in the content pane. Under
"Flexible Radio Assignment" in the content pane "Enable" radio button is selected. The "Sensitivity" fields
display a list where "low" is selected.

When a radio is redundant, FRA will try to make it a 5 GHz client serving radio unless DCA determines there are
already too many 5 GHz channels used. If DCA considers there is already enough 5 GHz coverage, it will switch the
radio to dual-band monitoring. It is interesting to note that when a radio was switched to 5 GHz client serving, it does
not participate anymore in COF calculation (it does not scan or send NDP packets on the 2.4 GHz band anymore), so
this role change cannot happen back and forth—once it moves to 5 GHz it does not come back. This is improved in 8.5
or later software, with a threshold determining at how many 2.4 GHz clients we consider we need a radio back in the
2.4 GHz. The AP settings page will allow you to select the automatic FRA or manual assignment as shown in Figure 4-
44.
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Figure 4-44 AP Settings: Auto FRA or Manual Role Assignment

In the AP settings page, the "Radio Role Assignment" shows radio buttons where "Manual and Client Serving"
is selected with the band that is set to "2.4Ghz (selected from a spin box)." The "RF Channel Assignment"
section shows the fields "Current Channel, Channel width, and Assignment method" where the "Global" radio
button is selected under the Assignment Method. The "Transmit Power Level Assignment" shows the fields
"Current Transmission Power Level and the Assignment Method" where the "Global" radio button is selected
under the Assignment Method.

Out of the box (that is, without a DART connector), the 2800 and 3800 APs can have only one set of dual-band
antennas (internal or external). This presents some limits to what is achievable: that is, set two radios on the same
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frequency band using the same physical antennas. In this case, the AP forms what we call a macro/micro cell: one radio
transmits at a high transmit power and the other radio at the smallest transmit power. They also pick channels with a
separation of at least 100 MHz to prevent signal interference. The name macro/micro means one of the 5 GHz radios
will have a large coverage and the other a small coverage area. 2800 and 3800 APs have a DART connector that allows
plugging in another set of external antennas. In that scenario, because each radio can use a different set of antennas,
they can both perform at any power level. This setup is called a macro/macro cell: the two radios then act independently
as usual.

In the micro/macro cell, the macro cell is where clients connect first when they arrive in the coverage area, and if there
was no special mechanism, there is a good chance many clients would stay connected to that macro cell because it has
the strongest signal. Instead, the macro radio will use 802.11v to direct clients that are very close to the AP to the micro
cell radio. This has many advantages: the micro cell is used only by clients with a strong signal that can use high
modulations and will most likely not have a lot of retries. When clients move further away again, they can be handed
over to the macro cell again. The parameters of the steering of clients between the micro and macro cell can be verified
and changed as illustrated in Example 4-2, along with FRA-related commands shown in Table 4-2.

Example 4-2 Client Steering-Related Commands

Click here to view code image

(Cisco Controller) >show advanced client-steering
Client Steering Configuration Information
1  Macro to micro transition threshold............ -55 dBm
2  micro to Macro transition threshold............ -65 dBm
3  micro-Macro transition minimum client count.... 3
4  micro-Macro transition client balancing win.... 3

(Cisco Controller) >config advanced client-steering transition-threshold ?
balancing-window Configures micro-Macro client load balancing window
macro-to-micro Configures Macro to micro transition RSSI
micro-to-macro Configures micro to Macro transition RSSI
min-client-count Configures micro-Macro minimum client count for transition
802.11v BSS Transition – enabled by default

Table 4-2 FRA-Related Configuration and Verification Commands

Command Purpose
WLC> show advanced FRA Displays all the FRA settings
WLC> show advanced client-steering Shows all the macro/micro cell client-steering  settings
WLC> config advanced fra revert  all auto Reverts all APs to auto FRA configuration
WLC> config advanced fra enable Enables FRA globally

Dynamic Channel Assignment

Dynamic channel assignment (DCA) will adjust the channels of APs in an RF group to optimize performance. It uses an
RSSI-based metric, but its calculation function is not publicly disclosed. A subcomponent of DCA is Dynamic
Bandwidth Selection (DBS), which can select the best bandwidth (20, 40, 80, 160) for each AP if the bandwidth setting
is set to Best, as illustrated in Figure 4-45.
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Figure 4-45 DCA Tries to Optimize the Overall Channel Plan

In the Dynamic Channel Assignment, a WISM at the bottom points to two LWAPP in the RF channel 6 and RF
Channel 1. The node further points to another LWAPP in the RF channel "1" and that node further points to
LWAPP in the RF channel "1." In the "System optimizes channel assignments to decrease Interface" the WiSm
points to two LWAPP in the RF Channels "6" and RF Channel "11" that further points to another LWAPP at
the top in the RF channel "1." An LWAPP is shown at the right in the RF Channel "1" that points to all other
channels.

The DCA page in the controller (Wireless > 802.11a/b > RRM > DCA) allows you to enable or disable certain
contributors to the calculated RSSI metric.

Foreign AP interference: DCA will include the interference caused by APs not belonging to the RF group (i.e.,
rogues).

Non Wi-Fi noise: This includes CleanAir-captured interferers in the channel decision.

Cisco AP load: This includes the load caused by APs on the same channel belonging to the RF group (non rogues).

Persistent non-Wi-Fi interference: This also depicts interferers detected by CleanAir but only targets persistent
ones; that is, interferers that may not be present at any given time but were identified to be recurring enough to
cause a problem.

The same page also allows you to enable which channels DCA will pick from to assign to the APs. The algorithm will
run when set to Automatic; you can then set an interval and anchor time. It will run every <interval> minutes starting
from the anchor time. You can, for example, make it run every 6 hours starting from midnight (which would be the
same as setting it anchored at 6 a.m. or noon; it will run at midnight, 6 a.m., noon, and 6 p.m.). If set to Freeze, the
algorithm will not update channels anymore unless you click the update button next to it, but the NDP packets and off-
channel scanning will continue to happen (to collect metrics). If set to Off, it will not run, and metrics collection
activities will stop. You can see who the RF leader is, when the algorithm last ran, and set the sensitivity of the
algorithm in dB (the calculated nondisclosed RSSI-based metric). If you chose a channel width, that same width will be
used on all APs, but if set to Best, the width can be different on all APs.

When a WLC reboots, even if it is not the RF leader, the DCA algorithm will switch to startup mode in the RF group. In
startup mode, the DCA algorithm runs every 10 minutes for 100 minutes, regardless of what the configuration is. When
an AP reboots, it starts using its last saved channel setting, or if it’s a new AP it will start on the first available channel
(1 and 36).
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ED-RRM is often associated to CleanAir but it’s truly event-driven RRM regardless of CleanAir. It will decide channel
changes outside the normal DCA interval if there is a sudden event (and typically based on CleanAir interferers) that
changes the metrics. If you enable rogue contribution, the EDRRM can also make these sudden decisions based on
rogue presence (which is not a CleanAir-based metric). The last option in EDRRM is the rogue duty cycle that enables
the channel change if an existing rogue suddenly uses more air time than the percentage configured.

Coverage Hole Detection and Mitigation (CHDM)

The coverage hole function is the only one to run on every WLC (regardless of RF leader). This is because it does not
need to take many factors into account: The idea is that if several clients stick to one AP at a low signal strength, and
this AP is not already at the maximum power, we should then increase its power level. A precoverage hole event
happens if a single client stays for 5 seconds under the configured RSSI at the AP level. However, the precoverage hole
event is only for tracking purposes, and only an SNMP trap is sent. If the configured number of clients stay under this
threshold RSSI for more than 90 seconds, an actual coverage hole happens and actions are taken.

The default values are that you need at least three clients (the Min Failed Client Count Per AP setting) and they must
represent 25% of the client count of the AP (coverage exception level per AP) for a coverage hole to be declared. This
means that on default settings, the AP will only declare a coverage hole if it has, say, 12 clients, out of which 3 or more
are under the RSSI threshold for more than 90 seconds. This threshold is configurable but is −80dBm by default for data
and −75dBm for voice. Note that these RSSI settings are also used for optimized roaming features as explained later in
this chapter.

Coverage hole can be enabled on a per-WLAN basis. However, it is the detection that is enabled or not for a given
WLAN; the mitigation (that is, increasing AP power level by one) will affect all WLANs. The purpose is, for example,
to disable coverage hole detection on a given SSID (like the guest SSID) where we know we will have poor or sticky
clients, and we do not want those to trigger a coverage hole event.

CleanAir

CleanAir is a hardware spectrum analyzer chipset built in to the APs and present on all the 2000 and 3000 series of APs
as well as on high-end outdoors (such as 1570 or 1560). The CleanAir chip has a resolution of 78 KHz, which is much
less than what any Wi-Fi chipset can come down to. This allows the AP to have the capacity to identify non-Wi-Fi
signals. For non-CleanAir APs, any nondecodable signal is either non-Wi-Fi noise or even possibly a Wi-Fi signal that
was in too bad a condition (low SNR) to be decoded. CleanAir can identify the signal and figure out whether it’s a
microwave oven, a Bluetooth transmitter, and so on. On top of this device identification, it can also precisely analyze
the influence level and not rely only on the interferer RSSI. For example, it can calculate the duty cycle (the percentage
of air time used by this interferer) and therefore really differentiate important interferers from the ones you could live
with. In the Wireless > 802.11a(or b) > CleanAir page (as shown in Figure 4-46), you will have a few configuration
items.
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Figure 4-46 CleanAir Configuration Page

In the Cisco window, "Wireless" tab is selected that displays a list in the navigation pane where the "Access
point: 802.11a" is selected. The 802.11a displays the fields of the CleanAir in the content pane. The
"CleanAir/Spectrum Intelligence Parameters" section shows the fields "CleanAir, Spectrum Intelligence, Report
Interface, and Persistent Device Propagation" where "Enable" checkbox for Report Interface is selected. The
"Trap Configurations" section shows the fields "Enable AQI trap, AQI Alarm threshold, enable trap, threshold
for unclassified category trap, and enable Interface for security alarm" where "Enabled" checkboxes are
selected for "Enabled AQI and Enable Interface for security alarm."

The CleanAir box enables CleanAir globally for that band. There is close to no impact when enabling CleanAir. You
can then enable the reporting of interferers as well as persistent device propagation, which will make the CleanAir APs
tell the non-CleanAir APs of the same WLC about persistent interferer so that they apply a bias in their DCA and try to
avoid those persistent devices.

Below, you can choose which interferer type to detect or ignore. Be aware that BLE beacon detection does cause some
packet loss on 2.4 GHz. All the other types have no impact on performance. CleanAir is a separate chipset from the Wi-
Fi radio (so no impact there) but it still has to use the same antennas as the Wi-Fi chipset and therefore can listen to the
medium only when the AP is not transmitting. This means that CleanAir is active only for the current channel on a
client serving AP, but on all channels on monitor mode APs.

On the Monitor tab of the WLC web interface, you will find a CleanAir page that will list interferers by bands, as well
as air quality report. Air quality is a metric evaluating the impact of non-Wi-Fi interferers to the current channel: 100
being the perfect clean channel and 0 the worst unusable one.

Transmit Power Control
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The role of transmit power control (TPC) is to limit the transmit power of the APs to limit co-channel interference. The
idea is to keep an optimal coverage and have a reasonable overlap between APs’ coverage cells, but not have too much
overlap, which would harm channel reuse capabilities and could cause clients to stick to the AP when a closer AP
would be a better choice. Like DCA, TPC runs on the RF leader at regular configurable intervals or on demand (freeze),
or not at all. There exist two versions of the TPC algorithms that have slightly different objectives. Both algorithms
work based on the Rx and Tx neighbors of the APs.

TPCv1 checks the third loudest Tx neighbor of an AP and will take actions if it is louder than the configured TPC
threshold (−70dBm by default), along with a few other considerations. This setting should be configured identically on
all the WLCs.

TPCv2 calculates the cell boundaries and optimizes the coverage so that the overlap is the minimum while still making
sure there is no coverage hole. The formula is therefore much harder to track and verify manually for the administrator.

It is also possible to configure upper and lower limits—the minimum and maximum transmit power, as shown on Figure
4-47. These fields are in dBm, which requires you to translate the AP power level to actual dBm. The purpose is when
the APs are mounted close to each other but far away from targeted clients (when the ceiling is very high, for example).
In such a case, APs will hear each other loudly and will have a tendency to reduce their power, but since clients are far
away below, this is a bad idea. Limiting the Tx power boundaries in those cases allows you to set safety guards when
you know that having the power above or below a certain limit is an absolute no-go. It is interesting to know that power
level 1 represents the maximum Tx power allowed for that channel in the configured country at a data rate of 6 Mbps
(that is, without beam forming, for example.)

Figure 4-47 TPC Settings Page

In the TCP settings page, "Transmit Power Control (TPC)" is selected under RRM of the 802.11a with an
"Apply" button. In the "TPC version" section "Interference Optimal Mode (TPCv2)" radio button is selected.
The "Transmit Power Level Assignment Algorithm" section shows the fields "power Level Assignment Method
radio button is set to Automatic, Maximum Power Level Assignment, Minimum Power Level Assignment,
Power Assignment Leader, Last power level Assignment, and Power Threshold."

RF Profiles
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RF profiles can be tied to AP groups and allow you to configure a number of RRM settings (as illustrated in Figure 4-
48) that will override the global configuration just for the APs in the group where the RF profile is applied. It does not
allow you to enable or disable major features (like DCA or TPC) per AP group, so the feature should be enabled
globally, but a lot of settings can be overridden. A few examples are DCA channels, channel width, TPC thresholds,
coverage hole detection settings, and profile threshold for traps. For best consistency, the RF profiles you plan to use
should also exist on the RF leader (which is the one that will make the decisions in a lot of RRM-related cases). This
means that the AP groups should also exist on the RF leader, even if the APs are not registered to it. To prevent any
kind of mismatch where the settings you want are not actually applied to the specific APs you targeted, it’s best to push
all these settings to all controllers at the same time, possibly with Prime Infrastructure.

Figure 4-48 RF Profile

In the RF profile window, "RRM" tab is selected that displays the sections "TPC, Coverage Hole to Detection,
DCA, Profile Threshold For Traps, High-Speed Roam, and DCA Channel list." Under DCA, "Enabled"
checkbox is selected for "Avoid Foreign AP interface" and "Best" radio button is selected. In the "DCA
Channel list," a list of channels are shown with the checkboxes selected for the channels "36, 40, 44, 48, 52,
etc." "Enabled" checkbox is selected for "Extended UNIT-2 Channels."

Data Rates

Wireless clients can send each frame at a different data rate. A data rate was originally something easier to remember
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and visualize than a modulation with error coding capabilities. In 802.11a, all data rates are based on OFDM
modulations. However in 2.4 GHz, some rates are not based on OFDM (1 Mbps, 2 Mbps, 5.5 Mbps, and 11 Mbps)
because they come from 802.11b, whereas 6 Mbps and 9 Mbps are OFDM based and are therefore restricted to 802.11g
clients and later. By disabling certain data rates, we can decide to exclude certain client types (like 802.11b by
removing all their modulations), but this is not the only purpose. Data rates are not only enabled or disabled, they can be
supported (which basically means they are allowed and enabled) or mandatory (which means the associating clients
must support them). You must configure at least one mandatory data rate because this is the data rate at which beacons
will be sent to make sure all clients hear the beacon because they are all supposed to support that data rate. If several
rates are defined as mandatory, the beacons will be sent at the lowest mandatory rate. Therefore, setting a higher data
rate as mandatory has the effect of increasing the speed of beacons and pretty much all the management frames, which
definitely speeds up the management overhead and increases medium efficiency. However, it also drastically reduces
the effective cell size. The signal still propagates up to the same distance, but it’s not decodable as far away as before (a
higher modulation becomes undecodable noise when SNR gets too low). Another particularity of mandatory data rates
is that multicast is sent at the highest available mandatory rate (to combine efficiency as well as making sure all clients
support it). The High Throughput page allows you to configure supported data rates for 802.11n and 802.11ac
standards, as shown in Figure 4-49.

Figure 4-49 Data Rates

The data rates along with spin boxes are listed: 6 Mbps, disabled; 9 Mbps, disabled; 12 Mbps, mandatory; 18
Mbps, supported; 24 Mbps, mandatory; 36 Mbps, supported; 48 Mbps, supported; and 54 Mbps, supported.

Apart from being called “MCS X” rather than using data rates in Mbps, those data rates cannot be mandatory and
therefore have zero effect on management frames. Most people just leave all the 11n and 11ac rates enabled, but you
could, for example, decide to remove support for the highest modulations (like MCS8 and MCS9) so that clients will not
even try these risky modulations and will be less likely to lose frames trying them. This prevents data rate downshifting,
but it is not common practice.

RX-SoP

The strange name RX-SoP stands for Receive (often shortened as Rx) Start of Packet. This feature also does something
that might seem strange at first: reducing the receiver sensitivity of the radio. The idea is that in a dense environment,
we know that there are many roaming candidates for the clients, but sometimes clients will stick to an access point for a
very long time even if the signal is bad. Depending on the Rx-SoP threshold chosen (as illustrated in Figure 4-50), the
AP will choose to ignore packets that come under the corresponding RSSI threshold (which is different on a per-band
basis). In fact, it will not even decode them and will simply consider them as non-Wi-Fi energy.
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Figure 4-50 RX-SoP Thresholds

The large-sized cell shows negative 85 dBm/negative 80 dBm that indicates low threshold having 2.4 GHz/5
GHz, the medium-sized cell shows negative 82 dBm/negative 78 dBm that indicates medium threshold having
2.4 GHz/ 5 GHz, and the small-sized cell shows negative 79 dBm/ negative 76 dBm that indicates high
threshold having 2.4 GHz/ 5 GHz. A note reads, for HD, smaller cell size is better!

The effect is that the coverage cell size is reduced effectively on the Rx (from the AP perspective) side. Faraway clients
will send frames that the AP will not acknowledge, and those clients will get the message and move to another AP.
However, frames sent by the AP will still travel the same distance, but if you disable the lowest data rates on the AP,
that will have a similar effect and send frames that will not be decodable by clients far away (if they can’t decode the
beacon, it’s as if they don’t hear the AP anymore). RxSoP is configurable globally as well as in RF profiles.

AirTime Fairness

In an attempt to ensure that some less important SSIDs or client types do not abuse the overall bandwidth, many
administrators have the reflex of configuring data rate limiting (also called bandwidth contract). The problem with
bandwidth rate limiting is that it is defined in Mbps usually and does not take into account the amount of clients present
(why restrict speed if there is no one else on the network?) or the usage made by other clients or SSIDs. The lack of
efficiency is particularly in the upstream direction because the client already sent the frame over the air (the critical and
slower part usually), and we would drop it on the AP or WLC because the client already sent “too much,” which
preserves the WAN maybe but not the AP air time. Moreover, in wireless, a slow client using very low data rates (even
if not transmitting huge files) is more annoying to other clients than a client sending a large file but at high data rates,
meaning the transfer will be over quickly.

AirTime Fairness (ATF) focuses on limiting air time rather than specifying a given bandwidth. It is applied only in the
downstream direction (from AP to client) because we cannot honestly control when and if clients can transmit. Each
time the AP has to send traffic on a given WLAN, it will count the airtime consumed by data frames, and when the
“bucket” is full, it can either defer the traffic to send (in a limited buffer) or drop it (which also happens if the buffer
gets full). ATF can be disabled, or enabled in monitor mode (that is, it only counts statistics and does not defer/drop
traffic) or in enforcement mode.

In the Wireless > ATF > Monitoring page (as shown on Figure 4-51), you can configure a specific AP, AP group, or
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the whole 2.4 GHz/5 GHz network to start monitoring ATF statistics.

Figure 4-51 ATF Monitoring Page

The monitor configuration under the ATF option from the wireless menu got selected. This displays the ATF
monitor mode configuration page that includes options like AP name, AP group name, network, radio type,
mode that includes enable and disable buttons, and delete radio slot button.

After statistics have been collected, you can consult them in the statistics page in the same menu, as shown in Figure 4-
52.
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Figure 4-52 ATF Statistics

The ATF statistics page under the ATF menu shows fields like AP name, instantaneous values, and
accumulated values. The instantaneous values include the values of measurement interval that reads 180 sec,
instantaneous radio uptime that reads 802.11a: 178 sec and 802.11b: 178 sec, slot number, type, Wlan Id
(Name), airtime, used airtime, sent KBytes, dropped KBytes, sent frames, and dropped frames. The
accumulated values also include the same entities as of instantaneous values. Besides, a note reads 802.11b
monitor and 802.11a monitor.

To enforce, you first need to create policies. An ATF policy is basically a weight (in percentage) or the air time you
want to allow. You can then go to the Enforcement SSID Configuration page and apply these policies to specific
WLANs on a per AP, per AP group, or whole network basis. The idea is to define a percentage of air time a WLAN can
get over another. There is a strict mode, where the WLAN will be limited to the policy no matter what, and an
optimized mode, where more air time will be given if the other WLANs are not using their share of air time. ATF
guarantees air time for given WLANs regardless of the amount of clients connected. The Client Fair Sharing check box
in the ATF policy page is an additional option that means, when enabled, all clients of that WLAN will be treated
equally. Without that feature, if you configured the guest SSID to be limited to 20% of the air time, the whole guest
SSID will be following that limit. But one guest may be downloading more traffic than other guests and starving them.
Client fair sharing takes the configured maximum air time for the WLAN and divides it per client, making sure one
client does not have priority over another one.

Configuring and Troubleshooting Mobility

Mobility is at the core of 802.11. Freedom of movement has been the reason why Wi-Fi adoption has steadily grown
over the past decade. However, seamless roaming is still an issue, and you can expect that your troubleshooting skills
will often be solicited for issues around mobility. In most cases, a deep understanding of RF will bring the solution.
However, you should also be deeply familiar with the roaming mechanisms between APs and between WLCs, and
understand the exchanges and the expected states. This section will provide these tools.

Layer 2 and Layer 3 Roaming
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The Layer 2 versus Layer 3 concept comes from the early days of AireOS, when WLAN controllers were strictly
switching (an SSID in a WLC could be associated to only one subnet and VLAN). With AAA override and multiple
types of grouping possibilities within the same WLAN, the concept has evolved over the years. Fundamentally, the
notion of roaming “layer” refers to the relationship between the VLAN and subnet to which the user belongs before the
roam, and the VLAN and subnet to which the user belongs after the roam. If the VLAN and subnets are the same before
and after, the roam is Layer 2. If they are different, the roam is Layer 3.

In the documentation, intra-WLC roam (that is, mobility between APs connected to the same WLC) is always described
as Layer 2, because the user is expected to be sent to the same VLAN and subnet. However, with AP groups,
Flexgroups, and multiple other types of configuration structures, a user may be sent to a different VLAN and subnet
while roaming between APs on the same WLC and SSID. In this context, troubleshooting is usually related to
understanding the new client context.

Intercontroller roaming presents a different challenge. WLCs need to know about each other so as to exchange mobility
messages. If the WLAN to VLAN and subnet mapping are the same in the initial (the Anchor) WLC and the new (the
Foreign) WLC, roaming is said to operate at Layer 2. The client database entry (also called client context) is moved
from the anchor to the foreign WLC, then is deleted from the anchor, and traffic entirely flows through the foreign
WLC. If the WLAN to VLAN and subnet mapping are different, the client entry is copied from the anchor to the
foreign, stays on the anchor, and traffic flows from the client, through the foreign, then through the anchor and back, as
shown in Figure 4-53.

Figure 4-53 Layer 3 Mobility

The figure shows a controller-1 having the client database entry, client A: MAC, IP address, AP, QoS, Security
with anchor tag flows to controller-2 having the client database entry, client A: MAC, IP address, AP, QoS,
Security with foreign tag, which represents client entry moved to new controller, anchor and foreign tags
created. Below that, a cloud shows a WLAN controller 1 (left), WLAN controller 2 (right), AP1 (bottom left),
AP2 (bottom right), a laptop below AP1, and another one below Ap2. The flow from WLAN controller 1 to
WLAN controller 2 via IP tunnel with ethernet connection represents the exchange of mobility messages.
Further, the flow from WLAN controller 1 to AP1 via CAPWAP tunnel and to the left laptop indicates pre-
roam data path that represents data traffic bridged from or to VLAN x, the flow from WLAN controller 2 to
AP2 via CAPWAP tunnel and to the right laptop indicates post-roam data path that represents data traffic
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bridged from or to VLAN y, and the flow from the left to right laptop indicates client A roams from AP1 to
AP2.

The key elements to ensure seamless intercontroller roaming are SSID configuration and WLC communication. On both
WLCs, the SSID configuration must be identical on most points. When WLCs establish a communication channel to
handle the roaming event, they compare the WLAN configuration. If the configuration is different, the WLCs will
decide that the SSIDs are not the same (even if the SSID name is the same), and roaming may become a simple
disassociation from the anchor WLC and new association to the new WLC. This event may be caused by the client
inability to maintain the parameters from the previous WLC. As much as possible, you should ensure that parameters
are the same for the SSID between WLCs.

This failure may come from the client rejecting parameters and disconnecting, or the WLC (rejecting client requests that
do not match the WLAN). However, during the handoff event, the criteria used by the WLC to decide about a Layer 2
or Layer 3 roaming or disconnection are the SSID name and the VLAN. If they are the same, roaming is Layer 2. If the
SSID is the same but the VLAN value is different, roaming is Layer 3. If SSID is different, the event is a disconnection
followed by a new association.

Mobility Lists and Groups

A prerequisite to roaming is that WLCs know each other, so they can exchange information about clients. This
prerequisite also means that the WLCs must be in the same mobility group, or mobility domain (the two terms mean the
same thing). A mobility group is a set of controllers, identified by the same mobility group name, that defines the realm
of seamless roaming for wireless clients. Controllers in the same mobility group can share the context and state of client
devices, as well as their list of access points, so that they do not consider the access points of each other as rogue
devices.

To make two controllers members of the same mobility group, you need two steps:

1. Input the same string in the Controller > General > Mobility Domain Name field, so that both controllers have
the same mobility group/domain value (CLI config mobility group domain).

2. Inform each controller about the other in Controller > Mobility Management > Mobility group. Each controller
needs to know the other controller’s management IP address and built-in MAC address (CLI config mobility group
member add <MAC> <IP> <group>).

As a side effect of roaming, if you want roaming to occur smoothly, you should run the same code on both controllers
(so that they speak the same language and understand the same options). Without this precaution, one WLC may share
information about an option that the other WLC does not understand. You can verify the compatibility between WLC
codes on this page:

https://www.cisco.com/c/en/us/td/docs/wireless/compatibility/matrix/compatibility-matrix.html

However, compatibility does not mean that all features will be the same.

Additionally, you should also configure the same virtual gateway IP address (this address is used as a “virtual address”
to make the client think that it connects to one big virtual controller instead of several physical controllers).

Mobility groups can contain up to 24 WLCs. However, a WLC can know about other WLCs with a different mobility
group name configuration. As WLCs know one another, they are in each other’s mobility list. However, as their
mobility group value is different, they are in different mobility groups. Figure 4-54 shows such an example, where a
WLC in mobility group Mygroup is connected to two other WLCs, one in the same mobility group and one in another
mobility group (none). Both 172.31.255.30 and 172.31.255.19 are in 172.31.255.40’s mobility list, but only

Chapter 4 AireOS Appliance, Virtual, and Mobility Express Controllers

235

||||||||||||||||||||

||||||||||||||||||||

https://www.cisco.com/c/en/us/td/docs/wireless/compatibility/matrix/compatibility-matrix.html
file:///C:/Users/MERRELL/Documents/eBook Converter/Oreilly Downloader/tmp/9780135162095/ch04.xhtml#ch04fig54
https://technet24.ir
https://technet24.ir


172.31.255.30 is also in 172.31.255.40’s mobility group.

Figure 4-54 WLC Mobility List

The mobility groups under the mobility management option from the controller menu are selected. This displays
the static mobility group members page which shows local mobility group and mygroup. Below that shows a
table that includes fields like MAC address, IP address (Ipv4/Ipv6), group name, multicast Ip, status, and hash
key. In that, two groups with IP address 172.31.255.40 and 172.31.255.30 having the same group name
(Mygroup) and one group with IP address 172.31.255.19 having a different group name (none).

From a roaming standpoint, there is an important difference between mobility group and mobility list: Cisco Centralized
Key Management (CCKM), 802.11r, and Proactive Key Caching (PKC) do NOT work across mobility groups. This
means that if an STA roams to a controller that has a mobility group value different from that of the local WLC, a full
reauthentication will be needed if the STA uses 802.11r (FT) or CCKM, or if your design needs to leverage PKC. The
IP session will not be broken if roaming is Layer 2. In Layer 3 mode, a new IP address will be required. Therefore, this
configuration has an important effect on roaming, especially if the STA uses a real-time application (VoIP or other).

Mobility Messaging

When an STA joins an SSID on an AP, the associated WLC tries to discover whether the client is roaming. For that
purpose, the new (foreign) WLC checks whether the STA is known locally (entry in the WLC client database). If the
STA is not known, the WLC sends a mobile announce message to all WLCs in its mobility list (same mobility group or
not). The mobile announce includes the STA MAC address. A WLC that knows the client (prior, or anchor controller)
responds with a mobile handoff message that passes the STA context to the new WLC. The WLCs use a mobility
control tunnel to exchange this information, running on port UDP 16666. In the case of a Layer 3 roaming, the STA
data will continue to flow through the WLCs using an EoIP tunnel. The choreography is displayed in Figure 4-55.
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Figure 4-55 WLC Mobility Exchanges

The layer 2 roaming exchange shows a client sends a request to the old controller which in turn sends DATA to
the client. Step 1 shows the client sends the association request to the new controller. Step 2 shows the new
controller sends the association response to the client. Step 3 shows the new controller sends mmMobile
announce to old controller. Step 4 shows the old controller sends mmMobile handoff to the new controller. At
last, the client sends the request to local which in turn sends DATA to the client. The layer 3 roaming exchange
involves the same steps but at last the client sends the request to foreign which in turn sends the request to
anchor, where the anchor sends back (EOIP) DATA to foreign which in turn sends DATA to the client.

You should note that a new mobility mode, using CAPWAP encapsulation instead of EoIP, is available since AireOS
code 7.3. This type of mobility creates a hierarchical structure (with mobility agents and mobility controllers). This
mode is not functionally very different from the traditional (or flat) mode described here. In the context of the CCIE lab
exam, this new mobility is not covered anymore, and in real life, the traditional mode is more common.

This mobile announce occurs for each new STA. By default, an individual message is sent to each other WLC. Such
exchanges can create a lot of traffic on active networks. To simplify the flow, you can configure multicast messaging
between WLCs from Controller > Mobility Management > Multicast messaging (CLI config mobility multicast
enable family of commands). This configuration supposes that your wired network is also configured to support
multicast communications. By default, multicast is not forwarded across subnets.

With multicast messaging, your WLC sends one mobile announce to the multicast address. The other WLCs have
subscribed to the same multicast group and receive the message. The process creates fewer strains on the wired part of
your network.

You can configure a different multicast address for each mobility group known by the WLC. In Figure 4-56, the WLC
has two different multicast addresses configured, one for each mobility group (239.5.5.5 for the local Mygroup mobility
group and 239.5.5.6 for the none mobility group).
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Figure 4-56 WLC Mobility Multicast Addresses

The multicast address can be the same for more than one (or all) mobility groups. The decision depends on your
mobility design. For example, if your network has two mobility groups, and WLCs for each group are in different areas
of your network, you may want to configure different multicast addresses. If WLCs are in the same area (same group of
subnets), a single multicast address is likely sufficient to reach them all while avoiding duplicates.

All the WLCs in the same mobility group should be configured with the same mobility multicast settings. The address
you configure is used to send mobile announce messages, but the WLC will also subscribe to the traffic sent to that
address, so as to receive the mobile announce from the other WLCs.

Mobility Anchors

There are cases where you always want traffic to be sent to a specific WLC. A common scenario is guest networking,
where a WLC is in the DMZ, and all client traffic for the guest SSID should be forwarded there, to avoid guest traffic to
stay in the corporate network. To achieve this goal, you need to configure a mobility anchor information from the
WLAN main page, for the target WLAN, as shown in Figure 4-57 (CLI config mobility group anchor family of
commands).

Figure 4-57 Mobility Anchor Configuration

The WLAN options from the WLANs menu is selected. This displays the WLAN main page that includes
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WLAN id, type, profile name, WLAN SSID, admin status, and security policies. The listed WLAN SSID reads,
none, tt, publicWifi, mynet, and guest, in which the security policies of the guest profile shows a drop-down
that includes mobility anchors option which is selected.

The DMZ (anchor) and the foreign controllers should be in each other’s mobility list. They should in most cases be in
different mobility groups, because you do not expect roaming in this case (all traffic is terminated on the anchor, never
on the foreign, and the anchor probably does not even manage APs).

The SSID should exist on all the WLCs (foreign and anchor). Here again, the SSID configuration should be the same on
both ends. However, three parameters can be different: the PSK, if any (only the PSK on the foreign WLC matters), the
RADIUS server, and the DHCP server for the SSID (only the DMZ configuration matters).

To configure such anchoring, in all the corporate WLCs where the guest SSID is configured, select the DMZ controller
as the mobility anchor. In the DMZ controller, choose the local (DMZ) controller as the mobility anchor (itself). This
second step is critical, to let the DMZ WLC know that it is supposed to terminate requests coming from the other
WLCs. In the corporate WLCs, you can send the traffic to be terminated to more than one DMZ WLC. In that case,
you can decide which DMZ WLC is primary (has the highest priority). The DMZ WLC with a lower priority will be
selected if the DMZ with a higher priority stops responding.

After WLCs within the corporate network and anchor (DMZ) WLCs are connected, they will send keepalive messages,
even when no client is connected. From the Controller > Mobility Management > Mobility Anchor Config, you can
configure the periodicity of these keepalives (CLI config mobility group keepalive), along with the retry count (before
deciding that the other side is not responding anymore) and the DSCP marking of these messages.

Troubleshooting Mobility

The most common issue affecting inter-WLC mobility (Layer 2 or Layer 3 roaming, and auto-anchoring) is a mismatch
in configuration that causes the mobility tunnel to fail. The debug mobility handoff enable command (along with
debug client <MAC> to filter the output to only the client of interest) will show everything you need to know. For
example:

Click here to view code image

(Cisco Controller) >debug mobility handoff enable
*mmListen: Jun 07 10:00:21.405: 40:55:39:a5:ef:20 Adding mobile on
  Remote AP 00:00:00:00:00:00(0)
*mmListen: Jun 07 10:00:21.405: 40:55:39:a5:ef:20 mmAnchorExportRcv:,
  Mobility role is Unassoc
*mmListen: Jun 07 10:00:21.405: 40:55:39:a5:ef:20 mmAnchorExportRcv
  Ssid=webauth Security Policy=0x2050
*mmListen: Jun 07 10:00:21.405: 40:55:39:a5:ef:20 mmAnchorExportRcv:
  WLAN guest policy mismatch between controllers, WLAN guest not
  found, or WLAN disabled. Ignore ExportAnchor mobility msg. Delete
  client.

(Cisco Controller) >

In this case, the policy for guest is not found, which indicates that there is a policy mismatch. You should verify and
carefully review the SSID configuration on each WLC.

When a client roams, mobility exchanges will flow, starting with the mobile announce and handoff messages, and when
anchoring happens, to establish the tunnel for the first client (next clients will use the same tunnel). You should see the
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anchor and foreign IP addresses clearly. Show client summary should also display the anchor state. On the anchor, the
AP name is the foreign WLC IP address.

Another, less common, issue is the mobility tunnel not coming up between WLCs. You should ensure that EoIP and
UDP 16666 are allowed on the path, and also be aware that the tunnel may take a few minutes to come up. The control
and data path come up successively. debug mobility peer-ip <IP> and debug mobility packet enable can help you
observe the exchanges. In most cases, a mobility group string value, IP, or MAC address error is to blame. Observe
carefully to catch the probable typo.

Wireless Client Roaming Optimization

Always keep this in mind: 802.11 Wi-Fi roaming is a client decision. The wireless client is the one that decides why to
roam, when, how, and where to roam. In addition, this behavior is not the same for all wireless clients, because there are
no specific 802.11 standard rules that must be followed for the roaming process, so each client vendor relies on multiple
factors to trigger a roaming decision, as mentioned in Chapter 3, “Autonomous Deployments,” such as current AP
beacon loss, current signal quality going down, availability of other APs around, shifting down to low data rate, packet
retries and loss, channel utilization, current activity (on an active call or not, for example), and others. However, it is
also important to clearly understand the many possible options and methods that exist to improve the wireless client
roaming behavior. Some of the options available are merely WLAN infrastructure features; others rely on the client or
require client support (some methods are based on a standard, others are not).

In this section we cover the most important and widely implemented options that you can manipulate in AireOS WLAN
infrastructures to optimize the wireless clients’ roaming events.

Band Select

When wireless clients start an association or a roaming (reassociation) event, they scan for APs around, looking for the
best connection quality, with preference to current SSID (or the SSID selected if it was initial association) or to known
SSIDs, and sometimes preference to current radio bands. This client scanning in its most basic form is passive (by just
hearing APs’ beacons in supported channels while scanning them, with each radio if dual-band client) and active (by
proactively transmitting 802.11 probe requests on supported channels waiting for probe responses from APs).

802.11 beacons and probe responses from APs (along with the signal quality in which they are perceived) are the
minimum information that 802.11 wireless clients use from that scanning activity to decide what AP to select when
associating or reassociating.

The purpose of the Band Select or Band Selection feature in AireOS is to manipulate AP’s probe responses in an
abnormal, out of the standard way, trying to influence the clients to select the AP in the 5 GHz band instead of the 2.4
GHz band (no need to discuss in this section of the book why the 5 GHz band, if available with similar or higher signal,
is a better option than 2.4 GHz). This is why the feature is not based on a standard and doesn’t rely on the client
“supporting” the feature. It is actually a WLAN infrastructure (WLC/AP) feature based on a specific algorithm
performed to change the behavior of the 802.11 probe responses.

In summary, the way it works is that probe responses in the 2.4 GHz band are suppressed, while the ones in the 5 GHz
band are transmitted normally by the APs in response to probe requests, hoping that the client will prefer the 5 GHz
band in the absence of probe responses in the 2.4 GHz band. Nowadays, latest dual-band wireless clients normally
prefer the 5 GHz band, but there are still many clients that sometimes prefer the 2.4 GHz connection, even when the
availability of 5 GHz APs/BSSIDs is still a good option. Therefore, with this feature enabled at the WLAN/SSID level in
the WLC with the command config wlan band-select allow enable wlan_ID, wireless clients will hopefully choose the
5 GHz band.

The specific behavior of the feature depends mainly on whether the client is dual-band and its RSSI (the client’s signal
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quality perceived by the AP, which can be checked at the AP CLI using the command show controllers d0 | begin
RSSI for the 2.4 GHz and show controllers d1 | begin RSSI for the 5 GHz). There are also some variables that can be
configured to modify the algorithm of this feature, with options available at a global level in the WLC (not per WLAN),
as you can see in Example 4-3.

Example 4-3 Global config band-select ? Command Output

Click here to view code image

(WLC) >config band-select ?
client-mid-rssi Sets the client mid RSSI threshold.
client-rssi    Sets the client RSSI threshold.
cycle-count    Sets the Band Select probe cycle count.
cycle-threshold Sets the time threshold for a new scanning cycle.
expire         Sets the entry expire.

We will explain the options based on the possible scenarios, but first, it is important to understand that the APs built a
list of the probing clients to recognize single-band and dual-band clients that already went through this “probe
suppression,” but because this list needs to be limited and up to date, such clients will expire from this list (age out
suppression) after the period of time values in the expire options of the command (configured in seconds). The
following are the two scenarios for Band Select that can help you to understand the rest of the command options:

1. Client RSSI is higher than both Mid-RSSI and Acceptable Client-RSSI.

Dual-band clients: 2.4 GHz probe responses are not transmitted at any time for dual-band clients, whereas 5
GHz probe responses are transmitted for all 5 GHz probe requests received (as it should, per 802.11 standard).

Single-band (2.4 GHz) clients: 2.4 GHz probe responses are sent only after the probe suppression cycle-
count; if the cycle-count value is 2, probe responses will be transmitted after this counter reaches 2. How does
this counter increment? The cycle-count becomes 1 after the AP receives the first probe request from the client
(first time coming client, or a client that was already aged out with the expire timer), and will increment with
the next probe request from the client only if the time difference between the successive probe requests is
greater than the cycle-threshold value (milliseconds).

2. Client RSSI lies between Mid-RSSI and Acceptable Client-RSSI.

All 2.4 GHz and 5 GHz probe requests are responded to appropriately without restrictions. This is similar to
having Band Select disabled for the WLAN.

The command in Example 4-4 is used to confirm the values configured for this feature (the ones in the example are the
recommended and also default values in AireOS 8.3).

Example 4-4 show band-select Command Output

Click here to view code image

(WLC) >show band-select
Band Select Probe Response....................... per WLAN enabling
   Cycle Count................................... 2 cycles
   Cycle Threshold............................... 200 milliseconds
   Age Out Suppression........................... 20 seconds
   Age Out Dual Band............................. 60 seconds
   Client RSSI................................... -80 dBm
   Client Mid RSSI............................... -60 dBm
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APs will trigger Band Select for a client only when they have both 2.4 GHz and 5 GHz radios enabled, and with the
WLAN/SSID working for the two bands. It is not recommended to use this feature if the 5 GHz band coverage is poor
or simply smaller than the 2.4 GHz coverage, because in those scenarios there will be areas where the 2.4 GHz
connection might be the only option for the client, and suppressing it is obviously not a good idea. You should not use
this feature if the WLAN is used to support time-sensitive applications (voice, video, or other real-time services)
because it can affect the real-time performance during roaming due to delays caused by the suppression.

Load Balancing

Formerly known as aggressive load balancing, this is another WLAN infrastructure proprietary feature that doesn’t
require any type of client support or configuration; however, it relies on specific 802.11 frames with the expectation
that the client will understand that it should make a better decision (look for another AP that is less busy). The main
purpose of the feature is to prevent clients from associating or roaming to busy APs if there are other APs around the
area that are not as busy, trying to forcefully balance (by denying (re)associations) the load of wireless clients in
coverage areas where more than one AP is available for the client to associate or roam. The way the WLAN
infrastructure achieves this purpose is different depending on the AP mode:

Local mode AP: When the wireless client sends the 802.11 Association Request to the AP it decided to associate
or roam to, but the WLC considers that this AP is busier than another AP available for this client (based on the
feature logic, which we cover later), the AP will reply with an 802.11 Association Response using status code 17,
which basically indicates that the AP is busy, and literally denies the client’s association attempt to this specific AP,
hoping that it will immediately reattempt the (re)association with another AP.

FlexConnect mode AP: When the APs are in FlexConnect mode, they handle some decisions locally, such as the
802.11 (re)association handshake, which happens at the AP level instead of sending requests up to the WLC and
waiting for the responses, because this could cause, for example, severe failures due to possible latency (or drops)
in the path between the FlexConnect AP and the WLC. Hence, FlexConnect APs initially send a (re)association
response with status code 0 (success) to the client while sharing the association attempt with the WLC and waiting
for it to calculate the load-balancing decision (this happens at the WLC level in order to consider the current load of
all the APs that this client can hear during that attempt). After calculations, if the WLC considers that this client
should be denied in that specific AP trying to balance the load to another AP, then an 802.11 deauthentication
frame with reason 5 is sent to the client, again, hoping that the client will attempt its next (re)association with a less
loaded AP.

The load balancing algorithm denies clients, in any of the two ways explained previously, if it considers that an AP is
busy. You can manipulate why an AP is considered busy based on two modes:

Client count: With the command config load-balancing window <client_count>, you configure the load-
balancing “window size,” which is used to derive the actual threshold that determines, in each association attempt,
whether an AP is busy due to client load when compared with other APs available for the client to also
associate/roam. The amount of clients in the less loaded AP available for that client is the base of the equation, and
the window value is the ratio with the threshold (APs with more clients than the threshold are considered busy). For
example, if the config load-balancing window value configured is 5, and a client is trying to associate to AP1
(currently with 16 clients), but AP2 (with 13 clients) and AP3 (with 10 clients) are also available for that client, the
less loaded AP available is AP3. Hence, with base client-count from AP3 as 10 + window 5, the threshold is 15.
Based on this threshold, AP1 is busy, so the association is denied, expecting the client to make a better decision
trying to associate to AP3 or at least AP2, because these APs are not considered busy in this area (at least not busy
based on client count).

AP Uplink usage: When this mode is used, an AP is considered busy if the uplink interface of an AP is reporting
utilization (in percentage) equal or higher than the one configured with the command config load-balancing
uplink-threshold <traffic threshold>. The default value of the threshold is 50, so if the utilization of an AP uplink
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interface is 50% or higher than the interface’s capacity, and a client tries to associate with this AP, the association
will be denied.

The desired load balancing mode is applied at the WLAN level using the command config wlan load-balance mode
{client-count | uplink-usage} <wlan-id>.

This load-balancing method definitely affects roaming behavior, and that’s why we are covering the feature in this
section of the book. Imagine a client trying to roam to a busy AP, where the reassociation is always denied, and the
client is unfortunately not smart enough to attempt an association with a less loaded available AP, so it keeps trying and
failing at a level that completely disrupts the roaming. When such persistent devices (or devices that can’t process
appropriately responses with status code 17) are critical clients in your WLAN, or there are critical mobile devices using
real-time services, it is not recommended to use this feature (disable it at the WLAN where those clients connect).

For very persistent devices, (re)association still needs to happen at some point, even if they are not critical clients.
Hence, you can configure the maximum denial count with the command config load-balancing denial
<denial_count>. With the default value of 3, the client experiences three association failures when trying to connect to
a busy AP, but the next association attempt will be allowed.

Optimized Roaming

This is another Cisco proprietary feature that doesn’t require anything at the client side, but simple configuration at the
WLC level. It is a wireless LAN controller global setting that can be applied per band (not per WLAN), and affects all
types of clients as long as they meet the criteria to get optimized roaming applied.

This feature is similar to the load balancing feature, but their main difference is that load balancing affects client
(re)association based on current AP load of clients, whereas optimized roaming affects client (re)association based on
the client’s signal quality (RSSI, but data rate can optionally be considered). Another important difference is that the
optimized roaming intention is to affect mainly wireless clients that have the “sticky” behavior of staying connected
with current AP, even when the signal quality with that AP is going bad and other better APs are available (which is bad
not only for this specific client but for the entire channel, because a client with bad performance, collisions,
retransmissions, low data-rates, and so on also affects the performance of all other clients/APs using that channel).

How does that happen? How does optimized roaming affect client (re)association when a client’s signal quality is
considered poor? There are two ways to achieve this:

Disassociations: In this scenario, the client is already associated; it is actually passing traffic and not trying to roam
even when it should (due to current signal quality). Hence, WLC forces the client to roam to a better AP by
proactively sending an 802.11 Deauthentication frame with reason code 7, such as the one shown in the packet
capture of Figure 4-58.
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Figure 4-58 Deauthentication Frame

The screenshot reads, frame 14785, radiotap header v0, length 18, 802.11 radio information, IEEE 802.11
deauthentication with flag information (expanded), IEEE 802.11 wireless LAN (expanded). In which, the
IEEE 802.11 deauthentication with flags shows the type that reads deauthentication (0x000c), frame
control field, receiver address, destination address, transmitter address, source address, frame check
sequence. The IEEE 802.11 wireless LAN shows fixed parameters that include reason code that reads class
3 frame received from nonassociated STA (0x0007).

Rejections: When attempting a new connection, during brand new association or roaming (reassociation) events, if
the client tries to (re)associate to an AP with poor RSSI perceived by the AP, its association will be rejected with an
802.11 association response with status code 34, such as the one of the packet capture in Figure 4-59. This is
exactly what will happen if the client tries to rejoin the same AP after getting proactively removed by the AP, as
explained in the previous scenario (“Disassociations”). In fact, this type of association rejection will continue if the
client keeps trying to rejoin the same AP, unless the client’s RSSI increases (per AP perception) 6dBm or more
above the RSSI threshold.

Figure 4-59 Association Response Rejecting Client
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The screenshot reads, frame 14785, radiotap header v0, length 18, 802.11 radio information, IEEE 802.11
association response with flag information (expanded), IEEE 802.11 wireless LAN (expanded). In which,
the IEEE 802.11 association response with flags shows the type that reads deauthentication (0x0001),
frame control field, receiver address, destination address, transmitter address, source address, frame check
sequence. The IEEE 802.11 wireless LAN shows fixed parameters and target parameters where the fixed
parameters include capabilities information and status code, that reads, association denied due to excessive
frame loss rates and/or poor conditions on current operating channel (0x0022).

The optimized roaming algorithm disassociates or rejects the client as previously explained (another big difference with
the load balancing feature, which only rejects; it doesn’t proactively disassociate clients already connected), triggered
by the following conditions that you can configure:

Data RSSI value: This is the threshold that defines the RSSI limit; the client’s frames received at or below this
RSSI value are considered of “bad signal quality.” Therefore, the client is applicable for optimized roaming. This
threshold, as well as the next two thresholds to be explained, are used from the RRM feature known as Coverage
Hole Detection (CHD), which already monitors clients for similar purpose. Hence, this threshold is configured
under the coverage settings, with this data RSSI value configurable using the command config advanced
802.11<a/b> coverage data rssi-threshold <dBm>. This is considered for both disassociations (we explain later in
this section how this applies to disassociations, because it relies on other values we are about to explain) and
rejections (if a client tries to (re)associate with an RSSI at or below this threshold, it will be rejected).

Coverage Exception Level Percentage: Another CHD threshold, this is used by optimized roaming in
disassociations to define the maximum percentage of data packets that can be received below the data RSSI value
from an associated client. If this percentage is exceeded, the flag is raised for this threshold to trigger client
disassociation by optimized roaming. This can be configured with the CHD command config advanced
802.11<a/b> coverage data fail-percentage <percent>.

Number of Data Packets Received: This is the minimum number of packets that must be received from the client
(at any RSSI level, good or bad) to trigger client disassociation if previous conditions are met. This is also a CHD
threshold, and the command to configure this value is config advanced 802.11<a/b> coverage packet-count
<num-packets>.

Roaming Data-Rate Threshold: This one is optional and is disabled by default. When used, optimized roaming
will apply disassociations only to clients connected at this data rate or lower. It is a good option if low or legacy
rates are enabled, and some sticky clients stay connected at those low data rates far away from the AP. When
disabled, optimized roaming applies to all clients meeting the criteria to be disassociated regardless of its data rate.
This can be configured with the optimized-roaming command config advanced 802.11<a/b> optimized-roaming
datarate <mbps>.

Optimized Roaming Interval: This is the time interval at which each AP reports the client statistics to WLC so it
can calculate with the optimized roaming algorithm (using previously explained thresholds) if a client disassociation
must be triggered or not. This is also configurable with an optimized-roaming command config advanced
802.11<a/b> optimized-roaming interval <seconds>.

Let’s use the example with the default values to better explain when exactly an optimized roaming disassociation will be
triggered:

If optimized roaming is enabled and more than 25% (coverage data fail-percentage) of at least 50 packets (coverage
packet-count) in a fixed 5 second period were received at −80dBm of RSSI or lower (coverage data rssi-threshold)
from a client already associated, the AP will disassociate the client when the reporting interval of 90 seconds expires
(optimized-roaming interval).
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Note

As previously explained, optimized roaming is a global feature that doesn’t require activation or configuration at the
WLAN level. However, because this feature relies on CHD parameters as previously explained, per-WLAN coverage
hole detection must be enabled (config wlan chd <WLAN id> enable) on all WLANs that participate in optimized
roaming.

As best practice, this feature is not recommended nowadays, mainly because it is too aggressive and could cause a lot of
unexpected disconnections specifically in areas with poor coverage. So if you have a very good RF design with full
coverage and still notice some specific devices acting as “sticky clients” with poor roaming behavior, you could enable
and test this feature to check if it helps; otherwise, you had better keep this disabled and rely on standard methods such
as 802.11k and 802.11v to suggest clients looking for a better AP.

802.11k and 802.11v

These are two IEEE 802.11 standard amendments that help to optimize client roaming. They are implemented by
AireOS, which has them enabled by default when creating a WLAN/SSID, so wireless clients connecting to such a
WLAN and officially supporting these standards will take advantage of their benefits. Using 802.11k and 802.11v is a
recommended best practice and is suggested instead of proprietary methods like the load balancing and optimized
roaming explained before, mainly as AireOS implements 11k and 11v with similar behaviors to those other features.

The way these two methods are implemented in AireOS is explained deeper in Chapter 7, “WLAN Media and
Application Services,” so we are not covering all the details in this chapter; we just wanted to mention both in this
section so it is clear to you that these are two very important methods to optimize client roaming decisions, specifically
by suggesting better APs. Refer to Chapter 7 for more details, and for now, we will share a summary of how they work,
mainly when compared to the methods already explained in this section.

As explained earlier, wireless clients spend some time and effort (including battery usage, for example) scanning for the
best AP to (re)associate, based on active and passive scanning. This scanning and AP selection can be greatly improved
if the client is suggested with specific APs (and their channels) as its best options to roam to, not only suggesting the
best next option but also reducing the time-effort it takes for a client to make this decision while scanning. This
improves a lot the performance during the roaming process for mobile devices, mainly with real-time applications; for
example, instead of scanning all channels looking for the best option to roam to (remember that, while scanning, the
client is perhaps on a live voice call moving away from its current AP cell at the speed of the user walking, and while
this is happening, the signal quality of the current AP connection is getting worse, so call quality is probably getting
affected), the client might only scan the three channels of the three specific APs suggested by the WLC.

The main purpose of these two standard methods in optimizing client roaming decisions is to suggest the client with the
best candidates of APs where it could roam to when necessary, so the client can finally make a smarter and more
efficient decision.

This is achieved with 802.11k by having the client proactively sending a neighbor report request to its current AP, and
the AP replying back with a neighbor report response suggesting the best APs (a list of APs that is built by a complex
algorithm at the WLC that can consider multiple factors and technologies, such as RRM neighbor information, signal
between APs in the area, current AP location, floor information from Prime Infrastructure, and roaming history). After
that exchange, the 802.11k client will look for the best AP from that list when it is time to roam.

Note

AireOS implements an optional variant known as Assisted Roaming for Non-802.11k Clients or Assisted Roaming
Prediction Optimization, which is the option for clients that don’t support the standard 802.11k. This one is explained in
Chapter 7.
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In the other hand, the 802.11v amendment actually covers multiple features, one of which is specific to this method of
suggesting APs to the client for smart roaming, and is known as 802.11v BSS Transition Management. AireOS
implements 802.11v BSS Transition in four scenarios:

Solicited Request: The wireless client considers that it might roam soon, so it sends an 802.11v BSS Transition
Management Query to its current AP, asking for a list of recommended neighbor APs to roam to (this query from
the client has a reason code, such as reason 16, which means “due to Low RSSI”; other reason codes can be found
in the 802.11 standard). In this case, the AP will reply back with a BSS Transition Management Request, sharing
with the client the AP candidate(s) list.

Unsolicited Load Balance Request: If this 802.11v BSS Transition feature is enabled at the WLAN along with the
load balancing feature, the AP will proactively transmit a BSS Transition Management Request to clients
(suggesting less loaded APs) when the load criteria is met per load balancing (as explained earlier in this section).

Unsolicited Optimized Roaming Request: If this 802.11v BSS Transition feature is enabled at the WLAN and
Optimized Roaming is also enabled, the AP no longer disassociates a client when optimized roaming is triggered (as
explained previously when this topic was covered); instead, it will proactively transmit a BSS Transition
Management Request to the client (suggesting APs with better RSSI).

Unsolicited Request by FRA AP with Dual 5GHz: APs that support Flexible Radio Assignment (FRA) have the
opportunity to have two radio interfaces working in the 5 GHz band, one acting as micro cell and another as macro
cell. If a wireless client associates to a FRA AP in this dual 5 GHz condition but joins the less ideal radio (that is,
joins the macro cell when the micro cell is more optimal), the AP will proactively transmit a BSS Transition
Management Request to the client suggesting the best radio (micro cell in this case).

As you can see, in all those scenarios the AP suggests to the client the best AP(s) it could roam to, but doesn’t
disconnect the client; it is just a suggestion. However, 802.11v has the option to disassociate the client if it doesn’t move
to a suggested AP after a period of time (only triggered if Disassociation Imminent is enabled; this option is further
explained in Chapter 7).

Fast-Secure Roaming

802.11 wireless roaming events happen every time a wireless client moves from one AP to another AP, and every time
such roaming happens, the wireless client needs to perform full new association and authentication with the WLAN
infrastructure. The new association is actually a reassociation event (an exchange with the AP/WLC of reassociation
request and reassociation response frames), and if the SSID is configured with WPA/WPA2 security, the WPA level
authentication needs to happen again, as well as the WPA 4-way handshake required to derive new encryption keys (so
encryption can happen with the new AP).

You can imagine the overload of authentication events happening in a secure mobile environment where wireless clients
are constantly roaming (with a high amount of hits in the RADIUS server). In addition, there is something very critical
happening while roaming: a period of time in which the wireless client cannot pass any traffic (data frames) at all. This
is because it needs to go again through that mentioned process, as soon as it sends the reassociation request to the
selected AP it is roaming to, before it can transmit or receive again any other data frame. It reassociates, then performs
EAP authentication again with the RADIUS server, and finally completes the WPA 4-way handshake to derive new
keys. Figure 4-60 demonstrates all the frames exchanged between the client and AP/WLC on a roaming event with
WPA2/EAP authentication, before the client can continue passing data frames.
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Figure 4-60 802.11 Roaming with WPA2/EAP Handshake

The screenshot shows the set of twenty frames that includes information like frame number, time, source,
destination, BSSid, protocol, channel frequency, and info. In which, the frame 19 reeds, 1.125063, Cisco_f0:
2a: 98, Aironet_b7: ab: 5c, 84: 78: ac: f0: 2a: 98, 802.11, 2437, and QoS Data, SN=76, FN=0, flags= .p . . .F. C.
It concludes this frame is the first data frame after roaming.

As you can see in Figure 4-60, the first data frame after the roaming event is frame number 19, and the amount of
authentication frames during the EAP exchange could be higher depending on the EAP method and its settings. The fact
is that several frames are required before the client can continue passing traffic, and this takes some time, which could
be longer if there are big delays between AP and WLC, for example, and/or WLC and RADIUS server, or drops and
retransmissions, or server not responding, and many other variables. The behavior just explained is normal and the way
this WPA2/EAP security works; wireless clients must be “validated” again when moving to a new AP, and new
encryption keys are required for security reasons. However, this can heavily impact the wireless user experience during
roaming, mainly if running a sensitive application/service at the mobile device where timeouts can happen or traffic
could be lost (for example, some audio missing during a voice call).

Fast-Secure roaming methods were invented to accelerate this normal process explained and shown in Figure 4-60.
When a wireless client and AP/WLC apply a supported Fast-Secure roaming method, a secure roaming (with
WPA2/EAP, for example) can be faster, using caching techniques to avoid a new EAP authentication handshake
against a RADIUS server (hence also reducing server and network load), and sometimes even avoid the WPA 4-way
handshake (while still deriving new encryption keys).

This topic is one of the roaming optimization features that require support in both the client side and the AP/WLC side.
There are multiple Fast-Secure roaming methods available, and the Cisco WLAN infrastructure (AP/WLC) supports
most of them, but most wireless clients support only one method (and some clients don’t even support one, so you need
to confirm what your client devices support if you are trying to implement or troubleshoot Fast-Secure roaming). Some
of the methods are not really a standard (so few devices support it), some are proprietary (like CCKM from Cisco), and
there is one official standard method defined by the 802.11r amendment that looks for massive adoption (officially
named Fast BSS Transition and known as FT or just 802.11r).

We are not covering all the Fast-Secure roaming methods supported by AireOS, but just briefly the two methods widely
used in Cisco WLAN infrastructures (and that you must fully understand for the CCIE exam): CCKM and 802.11r/FT.

Note

There is a complete Cisco article that covers in depth all of the Fast-Secure roaming methods; it explains the working
details and variants of each method, pros and cons, differences, and more. It demonstrates with wireless packet captures
and WLC debugs the flow and handshake for every single method, explaining the meaning of the debugs and important
frames/fields found in the wireless captures, to help you not only implementing a Fast-Secure roaming method when
applicable, but to also understand and troubleshoot deeply any roaming or Fast-Secure roaming event.
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We highly recommend that you study this article to get more details about this topic and mainly the methods covered in
this book and the exam. You can find it at Cisco.com with the name “802.11 WLAN Roaming and Fast-Secure
Roaming on CUWN,” and the following is its current URL:

https://www.cisco.com/c/en/us/support/docs/wireless-mobility/wireless-lan-wlan/116493-technote-technology-00.html

CCKM

Cisco developed Cisco Centralized Key Management (CCKM) as the first Fast-Secure roaming method that could avoid
EAP authentication and key management handshake during roaming events on an 802.11 WLAN using security with
802.1X. Only Cisco wireless clients (such as the IOS Autonomous WGBs and older Cisco VoIP phones) and some third-
party clients that are Cisco Compatible Extensions (CCX)-compatible support CCKM.

CCKM works on top of an 802.1X/EAP authentication method to cache the secured session at the client and a
centralized WLAN device (in this case, the AireOS WLC) during the client’s first association/authentication. With this
caching technique, the client avoids EAP authentication when it reassociates (roams) to another AP managed by that
centralized device, because the session is still valid (cached).

In addition, remember that when EAP authentication is used in Wi-Fi, some type of encryption is required to secure the
data frames of the authenticated session, so CCKM also deals with the encryption by performing special key-
management techniques that help to derive encryption keys for all known encryption types (WEP, TKIP, and AES-
CCMP). That means that you configure CCKM to use it when EAP authentication is implemented with WEP
encryption, with WPA/TKIP, or with WPA2/AES. Today, most wireless clients that still use CCKM support it with
WPA2/AES, which is the most secure, and is configured (using the GUI) in the AireOS WLC WLANs/SSIDs, as shown
in Figure 4-61.

Figure 4-61 CCKM Configuration with WPA2/AES
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The WPA2/AES CCKM Configuration shows the WLANs selected from the main menu at the top. The right
pane shows the navigation at the top Edit CCKM selected from the WLANs; followed by the tab, security is
selected and the sub-tab layer 2 is selected. Two sections are shown WPA+WPA2 parameters and
authentication key management. The WPA2 encryption of first section selects the A E S checkbox and the
CCKM of the second section selects the enable checkbox.

With that WLAN configuration, only wireless clients that support CCKM will be able to associate to this SSID. If you
want to take advantage of CCKM for wireless clients that support it, but still allow associations of wireless clients that
don’t support CCKM (but still support WPA2/AES with the EAP method used), then the only extra configuration that
you need to add is to enable 802.1X (mark its check box, so the configuration will be 802.1X + CCKM).

Some wireless clients do not need any special WLAN configuration for this and will negotiate CCKM after they notice
that the WLAN infrastructure (WLC/AP) advertises CCKM support during association. Other clients will require
manual configuration, but it is normally as simple as selecting the combination of CCKM+EAP+WPA2/AES. Chapter 3
covers the configuration of a Cisco IOS Autonomous WGB for CCKM with WPA2/AES Enterprise.

Avoiding EAP (and even the handshake to derive new encryption keys) in each roaming event is achieved by using the
already cached information and negotiating the rest with CCKM techniques during the reassociation exchange
(reassociation request from the client and reassociation response from the AP). Figure 4-62 shows the frames
exchanged between client and AP/WLC during a roaming event with CCKM.

Figure 4-62 Reassociation/Roaming with CCKM

The screenshot shows the set of six data frames that includes information like frame number, time, source,
destination, BSSid, protocol, channel frequency, and info. In which, the data frame 5 reeds, 0.843240,
Aironet_b7: ab: 5c, broadcast, 84: 78: ac: f0: 2a: 93, 802.11, 2437, and QoS Data, SN=2717, FN=0, flags= .p . .
.TC. It concludes, after roaming this data frame continues in the network for the client.

As you can see in Figure 4-62, after the wireless client and AP/WLC exchange those initial four 802.11 management
frames, 802.11 data frames can continue in the network for this client. This is very fast because those four management
frames are always required to join an AP and happen quickly (Open System Authentication from the client, another
back from the AP, then (re)association request, and (re)association response), so the client is immediately passing data
frames without much delay as soon as it moves to the new AP.

802.11r/FT

This is the actual 802.11 standard amendment that provides the guidelines to perform Fast BSS Transitions (fast
roaming) when a WLAN is using security. Enterprise WLANs had implemented a few other Fast-Secure roaming
methods (such as CCKM) before FT was officially ratified in 2008, so it had a slow adoption, but it is nowadays the
embraced method for mobile devices, and the recommended one (unless CCKM is required for clients that do not
support 802.11r).

802.11r performs a job similar to CCKM, because it avoids both the EAP authentication and the key-management
handshakes, but it works only for WPA2/AES because this standard is for 802.11i RSN (Robust Security Networks).
Because of the way its key caching techniques and key hierarchies are implemented (out of the scope of this book),
802.11r also takes advantage of Fast-Secure roaming for WPA2-Personal (PSK) and not just WPA2-Enterprise (EAP),
making WPA2-Personal roaming even faster by avoiding the WPA2 4-Way handshake.
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It also works by caching the client session and seed key material from initial association/authentication with the WLAN,
at both the client and AP/WLC levels. The WLAN infrastructure advertises FT support; hence, client and AP/WLC
negotiate FT during the initial 802.11 Association Request and Response exchange. Once associated (and after initial
EAP authentication with RADIUS if using 802.1X), the client and AP/WLC perform key-management during the initial
FT 4-way handshake (which is similar to the WPA2 4-way handshake, with four EAPOL messages exchanged between
client and AP/WLC; just slightly different in content due to specifics in the FT key hierarchy). Figure 4-63 shows the
beacon from an AP advertising FT support.

Figure 4-63 FT Information from AP Beacon

The screenshot shows a set of frames that includes information like time delta, source, destination, ch. freq,
rate, signal dB, protocol, length, and info. In which, the frame 22 reads, 0.002388, Cisco_f0: 68: d6, broadcast,
2462, 1, negative 10 dBm, 802.11, 287 Beacon frame, SN=2638, FN=0, flags=. . . . . . C, BI=102, and
SSID=FT-EAP-OTA. Below that reads, frame, radiotap header v0, length 18, 802.11 radio information, IEEE
802.11 wireless LAN (expanded). The IEEE 802.11 wireless LAN highlights few fields such as tag: RSN
information, type: FT over IEEE 802.1X, tag: mobility domain, and fst BSS transition over DS: 0X0.

As you can see from the highlighted sections of the beacon frame, this AP is advertising required support for FT within
the RSN Information Element; specifically saying that the Authentication Key Management (AKM) type supported
requires FT with 802.1X (doing an EAP method). There is also a Mobility Domain Information Element with further
details and capabilities used by FT in this BSS (as 802.11r supports multiple variants).

In summary, the following are the FT variants supported by Cisco WLCs, and the way you can configure them using
CLI commands:

Chapter 4 AireOS Appliance, Virtual, and Mobility Express Controllers

251

||||||||||||||||||||

||||||||||||||||||||

file:///C:/Users/MERRELL/Documents/eBook Converter/Oreilly Downloader/tmp/9780135162095/ch04.xhtml#ch04fig63
https://technet24.ir
https://technet24.ir


First, it is configured at the WLAN level, and you can enable it, disable it, or leave it in Adaptive mode (special
option for Apple iOS clients, which is further explained in Chapter 7), with the following command: config wlan
security ft {adaptive | enable | disable} wlan-id.

During a roaming event, wireless clients can perform Fast BSS Transitions in two ways: the most used and
recommended method is known as “Over-the-Air.” With this method, the client starts FT roaming against the target
AP it is roaming to, by exchanging with this new AP the typical 802.11 Open System Authentication frames but that
this time contain FT information used to perform the Fast-Secure roaming (based on initial FT association exchange
and cached session that happened when the client first joined the WLAN).

The other method is to perform FT “Over-the-DS” (Distribution System). In this case, the client sends an FT Action
Request frame to its currently associated AP containing FT information (which has the target AP it is roaming to),
so its current AP can send this request to the target AP over the distribution system (in this case, through the WLC),
which sends back to the client an FT action response frame. After that exchange (which achieves basically the same
purpose as the Open System Authentication exchanged when doing Over-the-Air), the client can initiate the Fast-
Secure roaming with the target AP by exchanging reassociation frames (now over the air, as usual). Only one of the
two methods is allowed per SSID, and they are configured with the command config wlan security ft over-the-ds
{enable | disable} wlan-id. When using the disable version of the command, you configure the method Over-the-
Air.

FT for SSIDs with WPA2 Enterprise (with 802.1X/EAP), configured with the command config wlan security wpa
akm ft 802.1X enable wlan-id.

FT for an SSID doing WPA2 Personal (with PSK). In this case the command is config wlan security wpa akm ft
psk enable wlan-id.

FT can also be optional for the clients connecting to the SSID, also known as “mixed mode” (or “hybrid mode”),
where clients are supposed to connect doing the WPA2 method configured, even if they don’t support 802.11r.
Clients that support 802.11r will negotiate it during the association, but clients that do not support it are supposed to
do regular WPA2/EAP. Unfortunately, some old clients don’t behave as expected and might fail to associate to an
SSID configured in this “mixed mode” advertising both methods (this is why it is not recommended to use mixed
mode, and the reason why FT in adaptive mode was developed with Apple). For example, in this mixed mode,
regular 802.1X/EAP is advertised and allowed (configured in the SSID with the command config wlan security
wpa akm 802.1x enable wlan-id), while 802.1X/EAP with FT is also advertised and allowed (configured with the
command previously explained, config wlan security wpa akm ft 802.1X enable wlan-id). The same can be done
for PSK.

Figure 4-64 is a wireless packet capture example of a Fast BSS Transition happening Over-the-Air for an RSN
association with WPA2 Enterprise (802.1X/EAP) in an SSID that allows only clients that support FT in this mode (so no
mixed mode configured).
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Figure 4-64 Fast BSS Transition Over-the-Air with 802.1X

The screenshot shows a set of frames that includes information like time delta, source, destination, ch. freq,
rate, signal dB, protocol, length, and info. In which, the frame 4 reads, 0.006901, Cisco_f0: 2a: 96, Apple_15:
39: 32, 2437, 1, negative 30 dBm, 802.11, 326 reassociation response, SN=793, FN=0, flags=. . . . . . C. Below
that reads, frame 4, radiotap header v0, length 18, 802.11 radio information, IEEE 802.11 Reassociation
response with flag information, and IEEE 802.11 wireless LAN (expanded). The IEEE 802.11 wireless LAN
highlights few fields such as tag: RSN information, tag: mobility domain, and tag: fast BSS transition.

As you can see from Figure 4-64, just like in CCKM, only the four (always required) initial management
authentication/reassociation frames are exchanged with the AP before the client can continue passing data frames,
avoiding both the EAP handshake and also the key-management handshake. FT Authentication and AKM happen
during the exchange of those four frames, because all those four frames contain FT material that help to validate the
cached FT session and derive the new encryption keys. In fact, the first two Authentication frames are not regular Open
System Authentication frames but Fast BSS Transition Authentication frames, where the FT handshake starts.

In Figure 4-64, the Reassociation Response frame from the AP (which confirms that the Fast BSS Transition was
successful and finishes the FT handshake) is selected from the packets captured to show the highlighted three
Information Elements (IE), which are the ones that contain the FT details exchanged within those four management
frames during the roaming event. The first two IE are the ones explained earlier (advertising the FT mobility domain
details and capabilities, as well as the support for Over-the-Air with 801.X), and the third is the Fast BSS Transition IE,
which contains most of the information of this client’s FT session and the key material used to derive the new
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encryption keys.

Summary

This chapter is likely one of the longer and more critical for your exam preparation. Because the WLC is at the core of
the wireless expert daily activity, you are expected to know each of its functions in detail. You should understand and
be able to explain in simple terms each option present in the WLC GUI and each CLI command. You should also be
aware that some advanced functions are not available in the GUI. This limitation does not mean that you should ignore
the GUI and focus solely on the CLI (although this is definitely a possible path). However, you should be comfortable
enough with the CLI to “survive” the requirement to configure a function without the assistance of the GUI.

Additionally, keep in mind that experts are not commonly called to perform simple or common configuration tasks. In
most cases, experts are needed to realize uncommon combinations or troubleshoot issues that less-skilled professionals
could not solve. These requirements mean that you should be able to use debug commands to observe the effect of your
configurations. You should know what messages are expected when your configuration is activated, and what messages
appear when things go wrong. A good way to prepare is to voluntarily misconfigure items (the WLC or the client side)
and observe the resulting debug messages. Investing the time needed to acquire this understanding will save you time
later. In most troubleshooting scenarios, whether in the lab or in real life, pressure is high to fix the issue as fast as
possible, and familiarity with the debug outputs is often a key to troubleshooting efficiency.
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Chapter 5

Wireless Security and Identity Management with ISE
Due to the inherent open nature of Wireless LANs, an increasingly mobile workforce, and the explosion of new and
diverse wireless devices, it has become imperative for organizations to implement the right mechanisms that allow
monitoring and controlling network access.

Cisco Identity Services Engine (ISE) is an identity and access control policy management platform that at the most
fundamental level enables organizations to enforce wireless access controls by implementing 802.1X, MAC authentication,
and web-based authentication. But before diving into how to deploy and configure the most common ISE policies for
wireless, in this chapter we focus first on understanding the underlying protocols and architecture.

Identity Management Building Blocks

Network Authentication, Authorization and Accounting (AAA) provide the fundamental security building blocks to answer
the questions of “who/what are you?,” “what do you get access to?,” and finally, “when and what did you do?” AAA has
been in use for so long that we tend to take for granted all the protocols that need to come into play to provide secure
access, and thus we’ll spend some time talking about them.

802.1X

IEEE STD 802.1X-2010 is a protocol framework for Layer 2 access control that offers the capability to permit or deny
network connectivity based on the identity of the end user or device. It uses a controlled/uncontrolled virtual port model,
shown in Figure 5-1, to block general data over the controlled port before authentication completes successfully over the
uncontrolled port that only allows EAP authentication traffic. After the controlled port is authorized, it unblocks to allow
passing data.

Figure 5-1 Port Behavior with 802.1X

Two figures are shown for the port behavior, before authentication and after authentication. The before
authentication figure shows the laptop user is unknown and so the DHCP, TFTP, KRB5, and HTTP are blocked by
the protocol framework and only the EAPoL is allowed. The after authentication figure shows the laptop user
named George is allowed through the protocol framework to reach the DHCP, TFTP, KRB5, HTTP, and EAPoL.

On a wireless LAN, each association between a client and the access point creates a unique pair of 802.1X virtual ports.
After authentication has completed, not only the flow of frames is permitted but cryptographic keys are generated to
protect the frame transfer.

802.1X Components

As specified in the standard and shown in Figure 5-2, 802.1X defines the following three required components:1
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1 IEEE 802.1X-2010 - IEEE Standard for Local and metropolitan area networks—Port-Based Network Access Control,
2010

Supplicant: A client that requests access to network resources and submits credentials for authentication.

Authenticator: The network device that controls access to the network and facilitates the authentication process by
relaying the credentials of the supplicant to the authentication server.

Authentication server: A server responsible for validating the credentials sent by the supplicant and determining the
network access level that it should receive.

Figure 5-2 802.1X Components

The components include a supplicant, authenticator, and an authentication server. The supplicant (client)
sends a request to authenticator through the wireless connection which in turn sends the request to the
authentication server. Both the authenticator and authentication server placed in a secured network.

EAP

The Extensible Authentication Protocol (EAP), described in IETF RFC 3748, provides a flexible authentication framework
which supports multiple methods that are negotiated and used to mutually authenticate the supplicant and the
authentication server. EAP messages between the supplicant and the authenticator run directly over the data link layer
using EAP over LAN (EAPoL) encapsulation as defined by the 802.1X standard. The authenticator will then extract the
EAP payload from the EAPoL frame and relay the message to the authentication server by encapsulating it inside a
RADIUS packet. This message exchange using different transport protocols is represented in Figure 5-3.

Figure 5-3 EAP Transport Protocols

The supplicant sends an EAP message to authenticator through EAP transport protocol over LAN labeled
"EAPoL" which in turn sends the message to the authentication server by encapsulating it inside a RADIUS
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packet. Further, the authenticator sends EAP packet as a request to the supplicant which in turn sends the
response to the authenticator.

EAP is a request-response protocol in which the authenticator sends the request and the supplicant provides the response.
This communication exchange uses four EAP type packets:

Request: This packet is sent by the authenticator to the supplicant and uses the type field to indicate what is being
requested (that is, the identity of the supplicant or the EAP method to use).

Response: This packet is sent by the supplicant in response to a valid request from the authenticator.

Success: This packet is sent by the authenticator to the supplicant after successful completion of an EAP
authentication method.

Failure: The authenticator will use this packet if it cannot authenticate the supplicant.

EAP Methods

EAP provides the flexibility to support different methods that define the type of credentials and how they are submitted
from the supplicant to the authentication server using the EAP framework. Although multiple EAP methods are available,
we will cover at a high level the three that are more commonly deployed.

EAP-FAST (EAP—Flexible Authentication via Secure Tunneling): Developed by Cisco and published as an
informational document in IETF RFC 4851, EAP-FAST enables mutual authentication by using a shared secret, called
Protected Access Credential (PAC), to establish a TLS tunnel that will secure the exchange of user authentication
messages. As shown in Figure 5-4, EAP-FAST has three phases. During Phase 0 (which is optional and prevents
manual out-of-band distribution of PACs), the PAC is automatically provisioned in-band on the supplicant using either
an anonymous TLS handshake (using the Authenticated Diffie-Hellman Protocol) or via an authenticated tunnel using
the server certificate. During Phase 1, the PAC is used to perform mutual device authentication, and a TLS tunnel is
established. Finally, in Phase 2, user authentication credentials are passed securely within the TLS tunnel created in
Phase 1. Several inner methods (MS-CHAPv2 for credentials or EAP-TLS for certificates) are available for EAP-
FAST, which makes it very flexible.

Figure 5-4 High-Level EAP-FAST Functionality

The supplicant sends the user credentials to authenticator through the wireless connection which in turn sends
the credentials to the authentication server. Below that shows the exchange of user authentication messages
through three phases: Phase 0 (optional) includes an A-ID secure key that represents Protected Access
Credentials (PAC) shows, Diffie-Hellman exchange or via TLS server-side authentication, Phase 1 shows the
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server sends EAP-FAST start (Authority-Id) to client which in turn sends PAC-opaque to the server that
indicates TLS channel established, and Phase 2 shows authentication between client and server.

PEAP (Protected EAP): This method, shown in Figure 5-5, relies on server-side TLS authentication to create an
encrypted tunnel using a valid certificate that the authentication server sends to the supplicant at the beginning of the
PEAP exchange. After the supplicant validates the certificate and the identity of the server has been authenticated, the
TLS tunnel is established. Inside this tunnel, a new EAP negotiation takes place to authenticate the client using
methods such as EAP-GTC, MS-CHAPv2, or EAP-TLS. PEAP is widely available on many client operating systems
and is popular mainly because it does not require a client-side certificate (unless you do EAP-TLS inside the PEAP
tunnel). It is even possible, in some operating systems, to skip the validation of the server-side certificate, which is a
big security concern.

Figure 5-5 High-Level PEAP Functionality

The supplicant sends the certificate signed by Certificate Authority (CA) to authenticator through the wireless
connection which in turn sends the certificate to the authentication server. Below that shows, the server sends
its certificate to the client for validation, that indicates TLS channel established for authentication. A checklist
about server certificate indicates, signed by trusted CA and allowed server.

EAP-TLS (EAP—Transport Layer Security): Described in IETF RFC 5216, this method offers mutual
authentication between the supplicant and the authentication server through the exchange and verification of X.509
certificates. This authentication process relies on not only the supplicant and authentication server having their own
certificate, they each need to have a copy of the root certificate from the certificate authority (CA) that signed their
peer’s certificate. During the EAP-TLS exchange, illustrated in Figure 5-6, the authentication server first submits its
certificate to the supplicant to be validated. After the identity of the authentication server has been verified, the
supplicant submits its certificate and the authentication server validates it, completing the process of mutual
authentication. EAP-TLS is available as a standalone method, and also as an inner method for PEAP, which makes it
even more secure because there is first an anonymous PEAP tunnel for encryption, and the full EAP-TLS exchange
that follows is fully encrypted. That’s a TLS tunnel inside another TLS tunnel.
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Figure 5-6 High-Level EAP-TLS Functionality

The supplicant sends the certificate signed by Certificate Authority (CA) to authenticator through the wireless
connection which in turn sends the certificate to the authentication server. Below that shows, the server sends
its certificate to the client for validation and the client sends its certificate to the server for validation. A
checklist about server certificate indicates, signed by trusted CA and allowed server whereas the checklist
about client certificate indicates, signed by trusted CA and valid.

RADIUS

The Remote Authentication Dial-In User Service (RADIUS) is a protocol used to control network access defined in IETF
RFC 2865 (authentication and authorization) and RFC 2866 (accounting).

RADIUS operates in a client/server model with the following entities:

Network Access Server (NAS): Responsible for passing user information to the RADIUS server and acting upon the
response that is returned.

RADIUS Server: Responsible for processing the access request and returning all required parameters for the NAS to
provide access to the user.

The transactions between the NAS and the RADIUS server are protected by the use of a shared secret and are transported
over UDP on port 1812 (authentication) and 1813 (accounting). This communication takes place using six main packet
types:

Access-Request: The NAS sends these packets to provide the server with the information required to assess whether
the user will be granted access.

Access-Accept: The RADIUS server sends these packets to provide the NAS with the information required to allow
access to the user.

Access-Reject: The RADIUS server uses these packets to notify the NAS that the information provided via the
request is not acceptable.

Access-Challenge: The RADIUS server uses these packets to send the user a challenge requiring a response to obtain
additional information.

Accounting-Request: The NAS sends these packets to deliver information about the user session for accounting
purposes.

Accounting-Response: These packets help the RADIUS server notify the NAS that the Accounting-Request has been
received and processed successfully.
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RADIUS Attributes

RADIUS Attribute-Value Pairs (AVP) are used to exchange information between the NAS and the authentication server to
support the AAA process. They provide useful information about the access request being made, as well as a way for the
authentication server to inform the NAS about the different parameters that need to be enforced.

These containers of information include a type, a length, and a value that defines them. Because the type field is an octet,
up to 255 attributes can be used; some of them are already predefined and well known. One of these attributes, Vendor-
Specific Attribute (attribute 26), enables vendors to communicate vendor-specific information by encapsulating their own
extended attributes inside it, as illustrated in Figure 5-7.

Figure 5-7 VSA Encapsulated Inside Attribute 26

The IETF attribute 26 at the top includes fields like type that reads <1 octet> 26 equals vendor specific, length
that reads <1 octet> greater than equal to 7, and vendor ID that reads <high-order octets> 0, <low order octet> 0,
and <string>, vendor type <1 octet>. The Vendor Specific Attribute (VSA) at the bottom includes fields like
vendor type < 1 octet> VSA number, vendor length <1 octet>, and vendor attribute strikng AVP.

CoA

In a standard RADIUS session, the NAS is required to initiate the exchange and does not support unsolicited messages. To
provide more flexibility, the IETF RFC 5176 informational document defines enhancements that allow the authentication
server to dynamically modify the authorization of a user session via Change-of-Authorization (CoA) messages.

CoA messages sent by the CoA client (RADIUS server) are transported over UDP using 3799 as the destination port.
(Cisco implementation uses port 1700.) The NAS will reply with a CoA Acknowledgment (CoA-ACK) if it can
successfully change the authorization for the user session, or a CoA Non-Acknowledgement (CoA-NAK) if the request is
unsuccessful.

To target a CoA request to a particular session, the RADIUS server includes one or more of the following attributes:

Acct-Session-Id (IETF attribute 44)

Audit-Session-Id (Cisco vendor-specific attribute)

Calling-Station-Id (IETF attribute 31, which contains the host MAC address)

AAA Sequence

Now that we have covered the protocols that are used during the AAA process, let’s examine at a high level the
operational sequence displayed in Figure 5-8, which shows how the components and protocols of 802.1X work together.
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Figure 5-8 IEEE 802.1X EAP

The components of 802.1X include a supplicant, authenticator, and an authentication server. The supplicant
(client) sends EAP messages to authenticator through the wireless connection which in turn sends the message to
the authentication server through the enterprise network with the aid of CAPWAP protocol. Both the
authenticator and authentication server placed in a secured network. Below that shows, the supplicant sends
EAPoL- start request to authenticator which in turn sends EAP request - identity to the supplicant, again the
supplicant sends EAP response - identity to the authenticator which then sends RADIUS access request - identity
to the authentication server which shows EAP authentication protocol exchange (authentication conservation
between supplicant and authentication server). This represents authentication. Further, the authentication server
sends RADIUS access accept to the authenticator which in turn sends EAP success to the supplicant, which
represents authorization. At last, the authenticator sends RADIUS accounting request - start to the authentication
server which in turn sends RADIUS accounting response to the authenticator, which represents accounting.

1. (Optional) The supplicant can initiate the authentication process by sending an EAPoL-Start message to the
authenticator.

2. The authenticator, either replying to the supplicant start message or initiating the authentication exchange itself, sends
an EAP-Request-Identity frame asking for the client’s identity.

3. The supplicant submits its identity (commonly referred as “outer identity”) to the authenticator, which forwards it to
the authenticator server using RADIUS. For privacy, some devices will send “Anonymous” as the outer identity and
will exchange their real username only inside the EAP tunnel. This outer identity is often the only thing authenticators
(such as a WLC) will be able to use to refer to the user; they cannot read the true identity because the EAP tunnel is
often encrypted between the supplicant and the RADIUS server.

4. The rest of the authentication exchange is defined by the specific EAP method (covered previously) that is negotiated
between the supplicant and the authentication server. The actual method depends on the EAP types that are offered to
the client based on how the RADIUS server is configured: the server suggests methods and the client chooses.

5. After the supplicant credentials are validated, the authentication server sends back a RADIUS Access-Accept message
(if the credentials are invalid, it will reply with a RADIUS Access-Reject) that might contain additional attributes to
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further define the type of access that will be granted. The authenticator relays this message as an EAP Success frame
to signal the supplicant that it has successfully completed the authentication and authorization process.

6. After the supplicant has been authorized and the policy has been applied, the authenticator sends information about
the session to the authentication server via RADIUS Accounting-Request packets. Any future changes to the session
will be communicated via interim updates.

In this exchange, the authenticator is responsible for relaying the EAP messages between the supplicant and the
authentication server. It will process and copy the information contained in the EAPoL frame to an AVP (as suggested by
IETF RFC 3850) in a RADIUS packet, and vice versa. The overall message mapping can be summarized as follows:

EAPoL-Response → RADIUS-Access Request

RADIUS-Access Challenge → EAPoL-Request

RADIUS-Access {Accept|Deny} → EAP {Success|Failure}

Identity Services Engine Deployment and Configuration

The Cisco ISE provides identity-based network access services that are organized into personas that are responsible for
different functions. Depending on the scale of the deployment, these personas can be co-located on a single node
(standalone deployment), where a node represents an instance of the ISE software, or distributed across a multi-node
deployment (distributed deployment).

Three main personas are responsible for a specific set of services within the Cisco ISE architecture. Each ISE node can
assume any or all of the following personas:

Policy Administration Node (PAN): This persona provides the main interface for handling all administrative tasks in
the ISE deployment. It is responsible for managing and distributing all system and policy configuration to all other
nodes. In a distributed deployment, you can have a maximum of two nodes that are assigned the Administration
persona; one will be configured as primary active and the other as secondary standby. If the primary Administration
node goes down, the secondary node needs to be manually promoted to take over.

Monitoring Node (MnT): This persona acts as a central repository for collecting and storing log messages from all the
ISE nodes in the deployment. It correlates all this log information and provides capabilities for generating reports and
alarms. There can be a maximum of two nodes with this persona taking on the primary and secondary role. In the case
of the primary node going down, the secondary will automatically become the new primary node for the deployment.

Policy Service Node (PSN): This persona is responsible for assessing and making real-time policy decisions for
network access, posture, client provisioning, profiling, guess access, and device administration services. In a
distributed deployment you will typically have more than one PSN. High availability is achieved by placing multiple
PSNs behind a load balancer or by allowing the NAS to make the decision to fall back to a different PSN in case the
one in use goes down.

Figure 5-9 shows how the different personas communicate with each other.
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Figure 5-9 Cisco ISE Communication Model

The CISCO ISE communication model shows the user PAN logging into the MnT to view logs and reports. The
PAN and PSN are bi-directionally connected to each other to view and configure policies. The PSN is also login to
the MnT. The PSN and external identity source is bi-directionally connected to each other by query attributes. The
PSN and NAD are bi-directionally connected to each other for request or response context. The NAD is also login
to the MnT. The NAD and endpoint are bi-directionally connected to each other by the access request. The NAD
and resource are bi-directionally connected to each other by resource access.

Note

For the latest deployment size and scaling recommendations, refer to the most recent release of the Cisco Identity Services
Engine Installation Guide at https://www.cisco.com/c/en/us/support/security/identity-services-engine/products-
installation-guides-list.html.

To edit the current personas and services assigned to a specific node, navigate to Administration > System >
Deployment. From there, click the name (or check the check box next to the node you want to change and click Edit) to
bring up the screen similar to the one shown in Figure 5-10 that will enable you to make the changes for the node.
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Figure 5-10 Cisco ISE Node Configuration

The deployment option under the system tab from the administration menu got selected. This displays the edit
node page that includes options like general settings and profiling configuration. In which, the general settings
shows hostname, FQDN, IP address, and node type that reads Identity Services Engine (ISE), administration,
monitoring, policy service that includes enable session services, enable profiling service, enable threat centric
NAC service, enable SXP service, enable device admin service, enable passive identity service, and pxGrid. Here
the administration option includes role option, which is set to STANDALONE.

If you’re working on a distributed deployment, the first step is to promote the node from Standalone to Primary to be
allowed to add any additional nodes. After the role is changed, you can go back and click Register to start the process of
adding nodes by providing the required information as displayed in Figure 5-11. Keep in mind that the PAN will need to
validate the certificates of the nodes that will be added, so before starting the registration process make sure that you have
completed all the certificate provisioning tasks.
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Figure 5-11 Cisco ISE—Register Node

The deployment option under the system tab from the administration menu got selected. This displays the
deployment nodes page which includes menu like edit, register, and syncup. In which, the register menu includes
two checkboxes named hostname that reads node type and ise that reads ISE. Further, it shows a pop up that reads
register ISE node - step 1: specify node host FQDN (hostname.domain-name) and credentials, which includes
three text boxes for host FQDN, username, and password and at the bottom shows next and cancel buttons.

ISE Certificates

The Cisco ISE relies on a Public Key Infrastructure (PKI) to be able to perform authentication and to secure
communications. There are two types of certificates in ISE:

System certificates: These certificates enable ISE to be identified and authenticated by other entities. Each node in
the deployment holds its own system certificates, and by default they have a self-signed certificate that is created
during installation. System certificates can be used for the following:

Admin: To authenticate the ISE Admin portal and secure inter-node communication.

EAP: For EAP authentication that uses SSL/TLS tunneling.

RADIUS DTLS: For RADIUS DTLS authentication (RADSec).

Portal: For securing communication with ISE portals.

pxGrid: For communicating with the pxGRID controller.

Trusted certificates: These certificates enable ISE to validate and authenticate the certificates received from users,
devices, and other ISE nodes.

Certificates can be centrally managed via the Admin node. Three high-level steps must be completed to deploy certificates
on ISE:

Step 1. Create a Certificate Signing Request (CSR) by navigating to Administration > System > Certificates >
Certificate Signing Requests and entering the required values for the different certificate fields, as shown in Figure 5-12.
You can generate a request per each ISE node, or alternatively you can request a wildcard certificate (a certificate that
uses a * character in the left-most section of the Common Name or Subject Alternative Name) that would enable you to
share it across multiple nodes. After the CSR is generated, it must be submitted and digitally signed by a certificate
authority.
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Figure 5-12 Cisco ISE CSR

The certificate signing requests under the certificates option, which is under the system tab from the administration
menu got selected. This displays the certificate signing requests page that includes a generate certificate signing
requests (CSR) option, which shows a pop up that includes entities like ISE identity certificates, ISE certificate
authority certificates, usage, node (s), subject, subject alternative name, key length, digest to sign with, and
certificate policies and the bottom shows generate and cancel buttons.

Step 2. Import the CA and sub-CA certificates into the Trusted Certificate Store by navigating to Administration >
System > Certificates > Trusted Certificates as shown in Figure 5-13. Make sure that you check the Trust for Client
Authentication and Syslog check box if the certificate will be used for client EAP authentication. Trusted certificates are
managed and replicated automatically by the PAN to every node in the deployment.

Figure 5-13 Cisco ISE Trusted Certificates

The trusted certificates under the certificates option, which is under the system tab from the administration menu
got selected. This displays the trusted certificates page that includes menus like edit, import, and export. In which,
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the import menu shows a pop up that reads import a new certificate into the certificate store, which includes fields
like certificate file with an option to choose file having the extension certnew.cer, friendly name, trusted for with
checkboxes namely trust for authentication within ISE (selected), trust for client authentication and syslog
(selected), trust for authentication of Cisco services, validate certificate extensions, and description and at the
bottom shows submit and cancel buttons.

Step 3. Bind the CA signed certificate to the pending CSR by going to Administration > System > Certificates >
Certificate Signing Requests and selecting Bind Certificate as shown in Figure 5-14. You will need to select the CA
signed certificate file and specify the services for which this certificate will be used.

Figure 5-14 Cisco ISE Bind Certificate

The certificate signing requests under the certificates option, which is under the system tab from the administration
menu got selected. This displays the certificate signing requests page that includes generate certificate signing
requests (CSR), view, export, delete, and bind certificate options. The bind certificate option shows a pop up that
reads bind CA signed certificate which includes fields like certificate file with an option to choose file having the
extension certnew.cer, friendly name, validate certificate extensions, usage with checkboxes namely admin
(selected), EAP authentication (selected), RADIUS DTLS, pxGrid, portal and at the bottom shows submit and
cancel buttons.

Network Access Policies

Cisco ISE provides network access services using a policy-based approach. Policies are built using rules that contain
conditions. Cisco ISE will evaluate sequentially the rules within the policy, and if the conditions are satisfied it will apply
the configured result actions.

Authentication Policy

Authentication policies define the rules that will be used to determine how to authenticate users and endpoints. These rules
dictate what protocols will be allowed and what identity sources will be used for authentication. A rule-based
authentication policy flow is represented in Figure 5-15.
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Figure 5-15 Authentication Policy

The Authentication Rule #1 flow starts with the decision that reads, Rule conditions met? If Yes, it leads to
Allowed Protocols and RADIUS Proxy and if No, it leads to Authentication Rule #n which further leads to Default
Authentication Rule, where the Allowed Protocols leads to the decision that reads, Identity rule met? of the
Identity Rule #1. If yes, it leads to Identity Source and if No, it leads to Identity Rule #n, which flows to Default.
The RADIUS Proxy and the Default Authentication Rule leads to a decision that reads, Authentication result?. If
PERMIT CONTINUE, it leads to Authorization Policy and if REJECT DROP, it leads to Deny Access.

During the evaluation of the policy, rules are processed from top to bottom. When the conditions of a rule are met,
processing stops, and the matching network access service and identity source are used.

You can configure the authentication policy by going to Policy > Authentication. This policy includes the elements
highlighted in Figure 5-16.
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Figure 5-16 Authentication Policy Elements

The authentication tab under the policy menu got selected. This displays the authentication policy page that
includes elements like conditions, allowed protocols, failover options, and identity source. Here wireless_802.1X
indicates conditions, default network access indicates allowed protocols, All_user_ID_Stores indicates identity
source, and the options like if authentication failed (reject), if user not found (reject), and if process failed (drop)
indicates failover options.

Conditions: Determine the attributes that need to be matched to process a particular rule. There are simple conditions
that consist of a single attribute/operator/value set, and compound conditions that are made up of one or more simple
conditions tied with an AND/OR operator. When adding conditions to a rule, you will be able to select between
conditions from the existing library or create a new conditions, as shown in Figure 5-17.
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Figure 5-17 Authentication Rule Conditions

The authentication tab under the policy menu got selected. This displays the authentication policy page that
shows conditions which includes select existing condition from the library and create new condition options.
In which, the select existing condition from library option shows a pop up that includes fields like condition
name, description, and compound condition with a search option to search conditions from the library whereas
the create new condition option shows a pop up that includes fields like condition name and description to
enter the details of the new condition.

Allowed protocols: Defines the protocols that ISE can use to communicate with endpoints requesting access to the
network. You can customize the protocols allowed by going to Policy > Policy Elements > Results > Authentication
> Allowed Protocol Services and creating a new service or leveraging the default network access service that is
predefined and shown in Figure 5-18.
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Figure 5-18 Allowed Protocols

The allowed protocols services under the authentication of the results option, which is under the policy
elements tab from the policy menu got selected. This displays the allowed protocols page that includes fields
like name, description, and allowed protocols. The allowed protocols further include checkboxes for process
host lookup (selected), allow PAP/ASCII (selected), allow CHAP, allow MS-CHAPv1, allow MS-CHAPv2,
allow EAP-MD5 (selected), allow EAP-TLS (selected), allow LEAP, and allow PEAP (selected).

Identity Source: An identity source or an identity source sequence determines the user or endpoint repositories that
will be used for authentication. This can include internal or external sources. To configure identity sources, navigate to
Administration > Identity Management. Figure 5-19 shows a sample of external identity sources that could be
referenced within an authentication policy.
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Figure 5-19 Identity Sources

The certificate authentication profile under the external identity sources option, which is under the identity
management tab from the administration menu got selected. This displays the certificate authentication profile
page that includes menu like edit (hidden), add, duplicate (hidden), and delete (hidden) options, which shows
two checkboxes for name and preloaded_certfificate_profile with its description.

Failover Options: Define what action to take if authentication fails, if the user is not found, or if the process fails.
One of the main use cases when we use these failover option is to implement MAC Authentication Bypass (MAB): if
the MAC address is unknown, authentication can still succeed and the session will move to authorization. Note that the
option to continue if the user is unknown doesn’t work well with wireless dot1x: wireless dynamic encryption keys
won’t be able to be derived without the proper keying material.

After Cisco ISE concludes processing the authentication policy and the result is not an access reject, it moves to evaluate
the rules in the authorization policy.

Authorization Policy

The authorization service in Cisco ISE is defined via a rule-based policy that allows controlling user access to the network
and its resources. Within the authorization policy are two sets of rules that you can configure:

Standard: Meant to be used as the main set of rules for normal operation.

Exceptions: Intended to be used in the short term to meet a specific exception requirement.

Similar to authentication rules, authorization rules are processed from the top down. Exception rules, if defined, will be
processed first before moving to the standard rules. Additionally, ISE can be directed to use either the first matched rule or
to match and apply the results of multiple rules. The high-level authorization policy flow is shown in Figure 5-20.
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Figure 5-20 Authorization Policy

The flow starts with the decision that reads, Exceptions? If Yes, it leads to the Exception Rules as Exception Rule
#n. If No, it flows to the Standard Rules. In the Standard Rules, the authorization rule number 1 as the Rule
conditions met? If Yes it flows to the process of Permission (Authorization Profile) and If No, it flows to the
authorization rule #n that leads to the default authorization rule. From the Permission (Authorization Profile) flows
to the decision symbol that reads, Policy option? If it is a first match or multiple matches for authorization rule #n
and default authorization rule it sends results to the network device.

You can configure the authorization policy by going to Policy > Authentication. It contains rules that contain conditions
and permissions, as shown in Figure 5-21.

Conditions: Enable you to set the identity group and additional attributes that need to match in order to process the
rule.

Permissions: Enforced by authorization profiles. Authorization profiles act as containers that let you choose the
attributes to be returned when a RADIUS request is accepted. These authorization profiles are defined by going to
Policy > Policy Elements > Results > Authorization > Authorization Profiles. A sample is displayed in Figure 5-22.
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Figure 5-21 Authorization Policy Configuration

The authorization option under the policy menu got selected. This displays the authorization policy page which
contains a set of rules with the attributes like status, rule name, conditions, and permissions. Here, one of the
rules named Wi-fi_Employee_Access reads any and wireless_802.1X that indicates conditions and
permitAccess that indicates permissions.
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Figure 5-22 Authorization Profile

The authorization profiles under the results option, which is under the policy elements tab from the policy
menu got selected. This displays the authorization profile page which includes fields like name that reads
Cisco_WebAuth, description, access type that reads ACCESS_ACCEPT, network device profile, service
template, track movement, passive identity tracking. Further, it includes three sections namely common tasks,
advanced attribute settings, and attributes details where the common tasks show checkboxes for web
redirection (selected), display certificates renewal message, and static IP/hostname/FQDN.

Profiling Policy

Profiling in Cisco ISE is implemented via profiling policies and is a key service that helps identify, locate, and determine
the capabilities of endpoints that connect to the network. The profiling service is enabled by default on the PSNs along
with some of the basic probes (RADIUS, DHCP, NMAP) that are responsible for collecting the endpoint attributes. This
can be viewed or edited by going to Administration > System > Deployment and selecting the desired PSN.

To profile a device, Cisco ISE uses the various collected attributes for each endpoint and tries to determine the device type
by matching them to built-in or user-defined profiling policies that can be configured by going to Policy > Profiling. These
profiling policies, shown in Figure 5-23, contain one or more rules that if matched will increase the certainty factor; the
profile for which the endpoint has the highest cumulative factor is the one that will be assigned. The conditions that are
used in the rules are available by navigating to Policy > Policy Elements > Conditions > Profiling.
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Figure 5-23 Profiling Policies

The profiling tab under the policy menu got selected. This displays the profiler policy page which includes fields
such as name, policy enabled, minimum certainty factor, exception action, network scan, associated CoA type. At
the bottom it includes rules which read if condition: AndroidRule1Check2 then: certainty factor increases, and if
condition: AndroidRule1Check1 then: certainty factor increases. Both the if conditions show the pop-up that
includes name, description, type, attribute name, operator, attribute value, system value, and system type fields.

Although different types of attributes are collected, the most common ones used for profiling clients are based on
RADIUS, MAC OUI, DHCP, and HTTP.

The profiling service plays an important supporting role for the authorization process. Authorization rules can leverage the
profiling policy applied to an endpoint as an additional condition to match. This can be done in two ways:

Creating a matching identity group, as shown in Figure 5-24, where endpoints will be placed after they are profiled.
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Figure 5-24 Profiling Policy with Matching Identity Group

The profiling tab under the policy menu got selected. This displays the profiler policy page which includes
create an identity group for the policy field that shows two radio buttons namely yes, create matching identity
group and no, use existing identity group hierarchy. Here, the create matching identity group option shows a
pop up that contains the endpoint identity groups, where one of the groups named android points to a rule that
shows android_devices (rule name), If Android AND wireless_access (conditions), and then PermitAccess
(permissions). This indicates the endpoints will be placed after the matching identity groups are profiled.

Using logical profiles that act as containers for multiple profiling policies, as displayed in Figure 5-25.

Figure 5-25 Profiling Policy Leveraging Logical Profiles
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The mobile devices option under the logical profiles folder, which is under the profiling tab from the policy
menu got selected. This displays the logical profile page which includes name, description, and policy
assignments fields. Here, the name field reads mobile devices points to a rule that shows mobile_devices (rule
name), if Endpoints: LogicalProfile EQUALS Mobile Devices (conditions), and then PermitAccess
(Permissions).

Guest Access

Cisco ISE has the capability to provide guest access to users, such as visitors, contractors, and customers, by allowing them
to perform web authentication using a guest portal. Two main services cover the full life cycle of guest access: guest
services, which focus on the customizable portals and guest types, and sponsor services, which deal with sponsor portals
and sponsor groups.

Guest Services

Cisco ISE guest services allow hosting multiple customizable portals. Three types of portals, for which the high level flow
is shown in Figure 5-26, can be created:

Hotspot Guest Portal: Guests can access the network without requiring credentials, but you can add a welcome
message and an Acceptable Usage Policy (AUP).

Sponsored Guest Portal: The guest portal requires guests to have credentials to gain access. Sponsors will be
responsible for creating the guest accounts because guests cannot create their own accounts.

Self-Registered Guest Portal: Guests are allowed to provide information to automatically create their own account,
which they will use to log in to the portal. Having sponsor approval can be added as an optional requirement.

Figure 5-26 Guest Portal Types

The guest portal types are classified as hotspot guest portal, sponsored guest portal, and self-registered guest
portal. In the hotspot guest portal, the AUP leads to Success. The sponsored guest portal flows downward as
follows: Login, AUP, Max Devices Reached, Post Login Banner, and Success. The Self-Registered guest
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portal flows downward as follows: Login, AUP, Max Devices Reached, Post Login Banner, and Success. The
Self Registration Success points to Login and the Login points to Self Registration. The bidirectional arrow
points between Self Registration Success and Login via Self Registration.

When implementing the sponsored or self-registered guest portal options, the guest accounts that will be created need to be
associated with a guest type. You can configure guest types by going to Work Centers > Guest Access > Portals &
Components > Guest Types, and they allow you to specify different access privileges such as maximum access time,
logon options, and account expiration notifications. One thing to keep in mind is that the guest portal is not exclusive for
guest users; it can be configured to use multiple internal or external identity sources to validate the credentials that are
submitted via the portal. Both of these settings for the guest portal are shown in Figure 5-27.

Figure 5-27 Guest Portal Settings

The portal and components option under the guest access tab from the work centers menu got selected. This
displays the portal settings page which includes authentication method field that includes a drop-down set to
Guest_Portal_Sequence and the employees using this portal as guests inherit login options field that includes a
drop-down set to daily (default). The authentication method field shows a pop up that includes three sections
namely identity source sequence, certificate-based authentication, and authentication search list whereas the
employees using this portal as guests inherit login options field shows a pop up that includes guest type name,
description, collect additional data, maximum access time, login options, and account expiration notification fields.

Sponsor Services

The Cisco ISE sponsor portal enables you to create, edit, suspend, and reinstate guest user accounts. Configuration of the
sponsor portal is done through the Work Centers > Guest Access > Portals & Components > Sponsor Portals section.

To control access to the sponsor portal, different levels of sponsor responsibility can be added and assigned to internal
employees who create accounts for guests. These sponsor groups control the guest types that can be created by members
of the group, as well as which accounts they can view and edit. Access to sponsor groups is assigned by adding members,
which can be internal or external user groups. The configurable settings for a sponsor group are shown in Figure 5-28.
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Figure 5-28 Sponsor Groups

The sponsor groups under the portal and components option, which is under the guest access tab from the work
centers menu got selected. This displays the sponsor group page which includes disable sponsor group checkbox.
Below that shows sponsor group name, description, match criteria fields. A note reads, this sponsor group can
create accounts using these guest types such as contractor (default), daily (default), and weekly (default).

ISE Integration with Active Directory

Active Directory (AD) is leveraged by most organizations as their main identity source. By allowing you to integrate AD
with ISE, objects such as groups and directory attributes become elements that can be used in the authorization policy
rules.

To integrate with Active Directory, on Cisco ISE navigate to Administration > Identity Management > External
Identity Sources > Active Directory. From there you need to add a new AD connection by specifying the domain name.
Then, each relevant Cisco ISE node must be selected to request the join process, as shown in Figure 5-29. It is not
mandatory to be a domain administrator to perform the join process; the account just needs to be able to search the
domain, create the machine accounts for the ISE nodes, and set their attributes.
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Figure 5-29 Active Directory Integration

The active directory folder under the external identity sources option, which is under the identity management tab
from the administration menu got selected. The connection menu shows fields like joint point name that reads
wireless and active directory domain that reads wireless.local. The join domain pop up shows AD username,
password, specify organizational unit, and store credentials fields with ok and cancel buttons.

After you have joined the domain, you can retrieve and configure AD groups, making them available to be used as
additional attributes in conditions inside the authorization policy rules, as shown in Figure 5-30.

Figure 5-30 Active Directory Groups

The active directory folder under the external identity sources option, which is under the identity management tab
from the administration menu got selected. The groups menu shows edit (hidden), add, delete group, and update
SID values (hidden) tabs. Below that shows the added group names such as wireless.local/users/domain
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computers, wireless.local/users/domain users, wireless.local/users/group1, and wireless.local/users/group2. In
which wireless.local/users/group1 shows a pop up that includes the authorization policy of rules that includes
attributes like status, rule name that reads wireless_Dot1X, conditions that contains condition name with the
description, and permissions with save and reset buttons.

Note

Further details on the key features and configuration of Active Directory in Cisco ISE 2.x can be found at
https://www.cisco.com/c/en/us/td/docs/security/ise/2-3/ise_active_directory_integration/b_ISE_AD_integration_2x.pdf.

Device Administration Policies

Cisco ISE can provide Device Administration services (TACACS+) allowing administrators to securely log in to network
devices to perform configuration and maintenance tasks.

One way to enable TACACS+ is to navigate to Work Centers > Device Administration > Overview > Deployment, and
from there select the nodes that will provide the service, as shown in Figure 5-31. The alternative method is to go to
Administration > System > Deployment, and from there select the desired PSNs and enable the Device Admin Service
under the General Settings for the node.

Figure 5-31 Enabling Device Administration Service

Enabling the device administration services shows the work centers menu selected from the menus at the top; the
sub-menu device administration is selected followed by the tab overview is selected. The deployment option is
selected from the left pane; the right pane shows the device administration deployment at the right pane shows
three radio buttons where specific nodes button is selected. A space for ise.wireless.local is given and the
checkbox is checked. The TACACS ports (mandatory field) is entered as 49; finally, the buttons save (selected)
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and reset are placed at the bottom.

After the device admin service is enabled, you will have to configure the device admin policy, which is structured with the
components that are shown in Figure 5-32.

Figure 5-32 Device Administration Policy

The device administration policy shows the work centers menu selected from the menus at the top; the sub-menu
device administration is selected followed by the tab device admin policy sets is selected. The left pane displays
the policy sets, which includes summary of policies, global exceptions, wireless, and default; the right pane shows
three sections, proxy server sequence, authentication policy, and authorization policy. The authentication policy
section shows a tick mark to the default rule and the exceptions under the authorization policy displays a tick mark
to the following five rule name WLC_RO, WLC_RW, PI_RO, PI_RW, and Tacacs_Default with its respective
conditions, command sets, and shell profiles. The areas of policy sets, authentication policy, and authorization
policy are highlighted.

Policy Sets

Policy sets are enabled by default for the Device Administration service. They act as hierarchical containers to logically
group the authentication and authorization policies. Each policy set will have conditions, as shown in Figure 5-33, that are
evaluated to determine whether there is a match. If the conditions are met, the authentication and authorization policies
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within that set are used.

Figure 5-33 Policy Set Conditions

The policy set condition shows the work centers menu selected from the menus at the top; the sub-menu device
administration is selected followed by the tab device admin policy sets is selected. The left pane displays the
policy sets, which includes summary of policies, global exceptions, wireless, and default; the right pane reads the
header device admin policy sets that reads the text, summary of the defined policy sets, for policy export navigate
to the links Administration, system, backup and restore, and policy export page. The two statuses with tick marks,
Wireless and Default are shown with the description and conditions (highlighted.)

Authentication Policy

Authentication policies follow the same logic as their counterpart for network access authentication. As shown in Figure 5-
34, they include rules that determine which protocols will be allowed and the identity source to use to validate the
credentials provided.

Figure 5-34 Device Administration Authentication Policy

Authorization Policy

Although the authorization policy, such as the one displayed in Figure 5-35, follows the same common structure using rules
and conditions to determine the access that will be granted, there are two elements that are unique to the Device
Administration service:

Command Sets: Enforce a specific list of commands that can be executed by a device administrator (not used by
WLCs or Prime Infrastructure).

TACACS+ Profiles (Shell Profile): Control the session of the device administrator by sending back a set of attributes
that limits the actions that may be performed on the network device. To configure TACACS+ Profiles, navigate to
Work Centers > Device Administration > Policy Results > TACACS Profiles.
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Figure 5-35 Device Administration Authorization Policy

The exceptions under the device administration authorization policy displays a tick mark to the following five
rule name WLC_RO, WLC_RW, PI_RO, PI_RW, and Tacacs_Default with its respective conditions,
command sets, and shell profiles. The shell profile of WLC_RW reads WLC ALL, this points to the window
WLC ALL of TACACS profile. The TACACS profile window shows the name and description to be entered;
followed by two views are shown, task attribute view (selected) and raw view. The common task section
displays a drop-down for common task type and the all radio button is selected.

Configuring ISE for Wireless

Now that we have covered some of the basics, it is time to go through some of the most common wireless flows that can be
implemented using Cisco Identity Services Engine. This should serve as a foundation to build on and give you an idea of
how to later generate more advanced security policies.

Keep in mind that so many options and combinations exist that it will be hard to cover them all in this chapter. We will
focus on the base configuration that is critical for making things work. Additionally, several components are preconfigured
to simplify the initial deployment process that we will highlight where relevant.

Common Configuration

One of the first things that needs to be configured is to enable communication between the WLC and Cisco ISE. This must
be completed on both sides.

To configure ISE, go to Administration > Network Resources > Network Devices and add the WLC as a new network
device. The name and IP address, and enabling RADIUS and TACACS+ with a shared secret is the minimum configuration
to be entered, as depicted in Figure 5-36. Optionally, other attributes, such as Network Device Group membership (that is,
Device Type or Location), although not mandatory, could become useful in building more complex conditions in the
different types of policies.
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Figure 5-36 Adding Network Device

The network device is added to the list. The navigation at the top displays new network device, selected from the
network devices list. The title reads Network Devices; the name box (mandatory) is entered as WLC-1 is
highlighted; the description box is left empty; the two fields for IP Address (mandatory) entered as 19.168.100.11
/ 32 is highlighted. Two mandatory groups device profile and network device group are shown. The device profile
drop-down selects CISCO with its logo; the model name and software version drop-down box are left empty. The
network device group includes three drop-down with a set to default button at each of its right; the device type
selects WLCs; IP SEC selects Is IPSEC device, and the location selects CentralOffice. The RADIUS
authentication Settings (drop-down) window is shown after a checkbox is being selected. The RADIUS UDP
settings section of this window shows the mandatory field shared secret Protocol (highlighted) enters the CCIE
WIRELESS RADIUS; the hide button is placed near it. The CoA port protocol field enters the 1700 RADIUS and
set to default button shown beside.

On the WLC, Cisco ISE must be defined in multiple places, but the steps are fundamentally the same. You can configure
ISE as a RADIUS Authentication and Accounting server by going to SECURITY > RADIUS > {Authentication |
Accounting} as shown in Figure 5-37, and as a TACACS+ AAA server by going to SECURITY > TACACS+ >
{Authentication | Authorization | Accounting}.
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Figure 5-37 Adding RADIUS Authentication Server

The new authentication server is added by the Security menu, selected from the top horizontal menu options. The
left pane reads the navigations. The authentication is selected within AAA option and then the RADIUS option on
the left pane. The right pane displays the navigation at the top, 'New' is selected from RADIUS Authentication
Servers. The Server Index (Priority) reads 1 from the drop-down; server IP Address (IPv4 / IPv6) (highlighted)
field reads 198.162.100.6; the shared secret format reads ASCII from the drop-down; both the Shared secret and
Confirm shared secret fields are highlighted and read an encrypted asterisk; key wrap checkbox is unchecked; port
number field reads 1812; server status drop-down reads enabled; support for CoA (highlighted) drop-down reads
enabled; server timeout (highlighted) field reads 5 seconds; network user (highlighted) checkbox checks the
enable; management, tunnel proxy, and IP Sec checkboxes are unchecked; and the management retransmit
timeout field reads 2 seconds.

Note

Certain flows in ISE require you to issue a Change of Authorization (CoA) to the WLC to force the user to reauthenticate.
Make sure that you enable Support for CoA (Support for RFC 3576 in older versions of code) to allow the WLC to process
the CoA packet received from ISE.

Optionally, some recommended configuration settings should be considered when integrating the WLC with ISE:

Note

Additional information regarding best practices that are applicable to configuring ISE as a RADIUS server can be accessed
at Cisco Wireless LAN Controller (WLC) Configuration Best Practices,
https://www.cisco.com/c/en/us/td/docs/wireless/controller/technotes/8-
6/b_Cisco_Wireless_LAN_Controller_Configuration_Best_Practices.html.

The Server Timeout by default is 2 seconds; this may be short for a large enterprise, especially if doing authentication
and membership lookups against external identities such as Active Directory. A minimum value of 5 seconds is
recommended to prevent the authentication process from timing out.

Configure RADIUS Fallback Mode so that the primary RADIUS server is used when it is back online. Without this
option, when the WLC flags a RADIUS server as down, it will failover to the next active backup RADIUS server and
will continue to use it, even if the primary server becomes available. There are two modes for fallback: Selecting
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Active, which is shown in Figure 5-38, causes the WLC to periodically send probe authentication requests to the
RADIUS server and mark the server alive only when it receives a response. When configuring Passive, the WLC
reverts to the primary server after a predefined interval of time.

Figure 5-38 WLC RADIUS Fallback Mode

The WLC RADIUS fallback mode is shown by the Security menu, selected from the top horizontal menu
options. The left pane reads the navigations. The fallback is selected by expanding the AAA and then the
RADIUS option on the left pane. The right pane displays the navigation at the top, fallback parameters is
selected from RADIUS. The fallback mode drop-down box selects active; the username field is entered as
probe-user, and the interval in seconds field is entered as 300.

By default, RADIUS Aggressive Failover is enabled, which causes the WLC to flag the server as not responding if it
fails to get a response back for a single client (which could be due to the server doing a silent discard). By disabling
this setting, the WLC will failover to the next server only if there are three consecutive clients that fail to receive a
response from the RADIUS server. This change can be performed only via the CLI with the config radius aggressive-
failover disable command.

On a WLAN, the Session Timeout by default is 1800 seconds, which is the interval before client reauthentication is
enforced. This short interval could create an unnecessary load on the ISE server, so it is recommended, depending on
the deployment requirements, to consider changing this timer to at least 7200 seconds, as shown in Figure 5-39.

Figure 5-39 WLAN Session Timeout
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The WLAN session timeout mode is shown by the WLANs menu, selected from the top horizontal menu
options. The left pane reads the navigations. The right pane displays the navigation at the top, 'Edit test 4 is
selected from WLANs. The Advanced tab is selected from the five given tabs; the allow AAA override
checkbox is unchecked for enabled; the coverage hole detection checkbox is checked for enabled; the enable
session timeout (highlighted) is checked for session timeout in seconds and entered as 7200. The Aironet IE
checkbox is checked for enabled and the Diagnostic channel superscript 18 checkbox is unchecked for
enabled.

It is worth mentioning that it is possible to test and troubleshoot RADIUS connectivity and WLAN authentication issues
without the need of an actual wireless client by issuing the test aaa radius username username password password wlan-
id wlan-id [ apgroup apgroupname server-index server-index ] command. This command will send an access request to
the RADIUS server for client authentication, and the response to the test can be displayed by entering the test aaa show
radius command. Note that this test uses PAP as an authentication method and not an EAP method (to avoid dealing with
certificates during your simple test), and PAP might not be allowed by your authentication policy on ISE. Example 5-1
shows how these commands can be executed and how they display the associated AVPs that are sent or received from the
AAA server.

Example 5-1 Test AAA RADIUS Command

Click here to view code image

(WLC) >test aaa radius username testuser password testpwd wlan-id 1
Radius Test Request
  Wlan-id........................................ 1
  ApGroup Name................................... none

  Attributes                      Values
  ----------                      ------
  User-Name                       testuser
  Called-Station-Id               00-00-00-00-00-00:8021Xssid
  Calling-Station-Id              00-11-22-33-44-55
  Nas-Port                        0x00000001 (1)
  Nas-Ip-Address                  100.127.100.10
  NAS-Identifier                  0x574c4331 (1464615729)
  Airespace / WLAN-Identifier     0x00000001 (1)
  User-Password                   testpwd
  Service-Type                    0x00000008 (8)
  Framed-MTU                      0x00000514 (1300)
  Nas-Port-Type                   0x00000013 (19)
  Tunnel-Type                     0x0000000d (13)
  Tunnel-Medium-Type              0x00000006 (6)
  Tunnel-Group-Id                 0x00000064 (100)
  Cisco / Audit-Session-Id        647f640a000000175b7debc8
  Acct-Session-Id                 5b7debc8/00:11:22:33:44:55/1271

test radius auth request successfully sent. Execute 'test aaa show radius' for
  response

(WLC1) >test aaa show radius
Radius Test Request
  Wlan-id........................................ 1
  ApGroup Name................................... none
Radius Test Response
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Radius Server            Retry Status
-------------            ----- ------
192.168.100.6            1     Success

Authentication Response:
  Result Code: Success

  Attributes                      Values
  ----------                      ------
  User-Name                       testuser
  State                           ReauthSession:647f640a000000175b7debc8
  Class                           CACS:647f640a000000175b7debc8:ise/323248099/95
  Tunnel-Type                     0x0000000d (13)
  Tunnel-Medium-Type              0x00000006 (6)
  Tunnel-Group-Id                 0x000000c8 (200)

Wireless RADIUS Attributes

In a wireless network, specific RADIUS attributes can be used to exchange information between the WLC and ISE in
regard to the users or endpoints that are trying to gain access. In addition to this section or the configuration guides, one
good place to review these attributes is to go to Policy > Policy Elements > Dictionaries in ISE.

Table 5-1 identifies a subset of the most common RADIUS attributes that are sent by the WLC to ISE as part of the
access-requests. These attributes would be used to help build our compound conditions for rules in the authentication and
authorization policies.

Table 5-1 Authentication Attributes Sent in Access-Request Packets

 Attribute
ID

Attribute
Name Description

IETF 1 User-
Name

Indicates the name of the user to be authenticated. It could be either an actual username
or the MAC address of the device.

Example:

Radius:NAS-IP-Address CONTAINS DomainName

This condition can match on request from users for which their username is part of a
specific domain.

 4 NAS-IP-
Address

This attribute indicates the IP address of the WLC that is requesting authentication of the
user.

Example:

Radius:NAS-IP-Address EQUALS 100.127.100.10

This condition can be used to match by IP address requests coming from specific WLCs

Service-

Indicates the type of service the user has requested. The values used typically by the
WLC are the following:

Login (1): Used for local web authentication

Framed (2): Used when performing 802.1X
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 6 Service-
Type

Call Check (10): Used when doing MAC authentication

Example:

Radius:NAS-Port-Type EQUALS Framed

This condition will match on 802.1X requests.

 30 Called-
Station-ID

This attribute will normally store the AP MAC address appending the SSID (<xx-xx-xx-
xx-xx-xx>:<ssid>). The behavior can be modified via configuration on the WLC.

Example:

Radius:Called-Station-ID ENDS WITH ssid1

This condition will match on request of users connecting to and specific SSID.

 31 Calling-
Station-ID This attribute contains the MAC address of the client.

 32 NAS-
Identifier

This attribute contains a string identifying the WLC originating the Access-Request,
typically being the WLC hostname. The value can be modified at the AP Group or
WLAN level.

Example:

Radius:NAS-Identifier EQUALS WLC1

This condition can be used to match by hostname request coming from specific WLCs.

 61 NAS-Port-
Type

Indicates the type of the physical port of the NAS authenticating the user. For a WLC this
value will always be Wireless - IEEE 802.11 (19).

Example:

Radius:NAS-Port-Type EQUALS Wireless - IEEE 802.11

This condition will match on request initiated by a WLC.

Airespace 1 Airespace-
Wlan-Id

Every WLAN created on the WLC has a numeric WLAN ID. This attribute sends the ID
value matching the WLAN that the client is connecting to.

Example:

Airespace:Airespace-Wlan-Id EQUALS 2

This condition will match on request for users connecting to a specific WLAN. One
disadvantage to this attribute is if the WLAN ID does not match on an SSID spread across
multiple controllers.

In Figure 5-40 we can see an example of how we can use a combination of these attributes to hone in to a particular access
request. In this particular case it would be for wireless users connecting using 802.1X to SSID1.
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Figure 5-40 Condition Matching on Multiple AVPs

The matching conditions of AVPs are shown by the menu 'Policy,' selected from the menus at the top; the sub-
menu, Policy elements (drop-down) tab is selected. The Conditions (drop-down) is selected from the left pane and
it shows the navigations. The compound conditions is selected by expanding the Authorization. The right pane
displays the navigation at the top, the Authorization compound condition list is selected from the sample condition.
The name (mandatory field) reads SampleCondition, and the description box is left empty. The condition
expression (mandatory) section includes the columns for condition name, description, equals or ends with and a
AND drop-down. The save button (highlighted) and the reset button are placed at the bottom.

In contrast, the attributes shown in Table 5-2 are sent by ISE and honored by the WLC in the access-accept packets. These
attributes can be used to build the authorization profiles (permissions) that will determine the type of access that will be
granted. There are three main groups of these attributes.

Table 5-2 Authentication Attributes Honored in Access-Accept Packets

 Attribute
ID Attribute Name Description

IETF 27 Session-Timeout Overrides the session timeout configured on the WLAN.

 4 NAS-IP-Address

This attribute indicates the IP address of the WLC that is requesting
authentication of the user.

Example:

Radius:NAS-IP-Address EQUALS 100.127.100.10

This condition can be used to match by IP address request coming from
specific WLCs.

Airespace
(14179) 1 Airespace-Wlan-Id

In case of web authentication, if the WLC receives a WLAN-ID attribute in
the authentication response, and it does not match the ID of the WLAN,
authentication is rejected.

 2
Airespace-QOS-
Level

The QoS-Level value (Platinum, Gold, Silver, Bronze) overrides the QoS value
specified in the WLAN.

 3 Airespace-DSCP
The DSCP value overrides the default specified in the QoS profile associated to
the WLAN.
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 4 Airespace-8021p-Tag The 802.1p value overrides the default specified in the QoS profile associated
to the WLAN.

 5 Airespace-Interface-
Name Indicates the interface or interface group that a client is to be associated to.

 6 Airespace-ACL-
Name Indicates the ACL name to be applied to the client after it authenticates.

 

7–10

&

13–16

Aire-Data-
Bandwidth-Average-
DownStream-
Contract

Aire-Real-Time-
Bandwidth-Average-
DownStream-
Contract

Aire-Data-
Bandwidth-Burst-
DownStream-
Contract

Aire-Real-Time-
Bandwidth-Burst-
DownStream-
Contract

Aire-Data-
Bandwidth-Average-
UpStream-Contract

Aire-Real-Time-
Bandwidth-Average-
UpStream-Contract

Aire-Data-
Bandwidth-Burst-
UpStream-Contract

Aire-Real-Time-
Bandwidth-Burst-
UpStream-Contract

This set of attributes indicate the rate-limiting bandwidth contract that will be
applied for a client. When present in a RADIUS Access-Accept, the values
override the configuration present in the WLAN or QoS profile.

Cisco (9) 1 cisco-av-pair

This attribute implementation supports the inclusion of many nested AV pairs
by using the following format:

attribute=value

Relevant to wireless, these are the AVPs that we can embed:

url-redirect-acl: Assists with triggering the redirect of the user and allowing
access to the server hosting redirect page.

url-redirect: Specifies the URL to where the user will be redirected.

mDNS-profile-name: Overrides for the user the mDNS profile associated to
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the WLAN.

avc-profile-name: Overrides for the user the AVC profile associated to the
WLAN.

role: Overrides/assigns the local policy (role) for the user.

Figure 5-41 shows how we can leverage the attributes listed previously to configure authorization profiles that will send
this value to the requesting NAS device. In this example the authorization profile will send back a URL to redirect the user
and an ALC to trigger the redirect and limit the access that the user will be given.

Figure 5-41 Authorization Profile Leveraging Additional Attributes

The authorization profile leveraging the additional attributes shows the menu 'Policy,' selected from the menus at
the top; the sub-menu, Policy elements (drop-down) tab is selected. The result is selected from the left pane. The
authorization profile is selected by expanding the Authorization options. The right pane displays the navigation at
the top, 'Blackhole_Wireless_Access is selected from authorization profiles. The name (mandatory field) reads
Blackhole_Wireless_Access, and the description box reads Default profile used to blacklist wireless devices.
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Ensure that you configure a BLACKHOLE ACL on the wireless LAN controller.' The access type (mandatory)
drop-down reads ACCESS_ACCEPT. The network device profile drop-down selects CISCO with its logo; three
checkboxes, service templates, track movement, and passive identity tracking are left unchecked. The common
tasks section includes three checkboxes web authentication, airespace ACL name, and ASA VPN are left
unchecked. The Advanced attributes settings (highlighted) shows two equal pairs of drop-downs with a decrement
button. The Cisco:cisco-av-pair equals url-redirect=https://ip:port/black and so on; and the Cisco:cisco-av-pair
equals url-redirect-ad=BLACKHOLE with a decrement and increment buttons are placed to its right. The
attributes details (highlighted) are shown at the bottom.

802.1X

Unarguably, 802.1X is the preferred method for securing wireless network access, with PEAP and EAP-TLS being the
EAP methods more widely deployed. Most large organizations will also tend to use Active Directory as the back-end
identity repository where employee accounts reside.

The steps required to implement this scenario on the WLC are fairly simple. In addition to the common configuration
previously discussed, a new WLAN needs to be created with the following parameters that are also shown in Figure 5-42:

Layer 2 Security should be set to WPA2 with AES Encryption and using 802.1X for authentication key management.
Optionally, FT 802.1X can be enabled if implementing 802.11r.

AAA Servers can optionally be configured if you want to override the order of the global RADIUS servers list.

For the Advanced settings, it is recommended to enable AAA Override to allow ISE to send attribute-value pairs to
dynamically override any existing client policy that was statically assigned via the WLAN configuration. Additionally,
NAC state should be configured as ISE NAC to allow ISE to send CoA requests.

Figure 5-42 802.1X WLAN Settings

The WLAN 802.1 X WLAN setting is shown by the W LANs menu, selected from the top horizontal menu
options. The left pane reads the navigations. The right pane displays the navigation at the top, Edit dot1X is

Chapter 5 Wireless Security and Identity Management with ISE

295

||||||||||||||||||||

||||||||||||||||||||

file:///C:/Users/MERRELL/Documents/eBook Converter/Oreilly Downloader/tmp/9780135162095/ch05.xhtml#ch05fig42
https://technet24.ir
https://technet24.ir


selected from W LANs. The Security tab is selected from the five given tabs; the layer2 security tab is
selected from security; the Layer 2 security reads WPA plus WPA2 from the drop-down. The WPA plus
WPA2 parameter shows the WPA2 policy check box is checked; for the WPA2 encryption, the AES check
box is checked. Under the Authentication key management, the enable checkboxes for 802.1X and FT 802.1X
are checked. Now the Advanced tab is selected from the W LANs. The Allow A A A override checkbox is
checked for enable; Under the N A C section, the N A C state is selected ISE N A C from the drop-down.

From a Cisco ISE perspective, we’ll start from the assumption that both the certificate configuration and the integration to
AD already exist and was completed following the steps from the previous sections. The next step is to configure the
authentication policy for 802.1X; one option on how to do it is shown in Figure 5-43.

Figure 5-43 802.1X Authentication Policy

The authentication policy of 802.1X shows the Policy tab selected from the menu at the top; and the sub-menu
authentication is selected. The Authentication policy in the content pane displays the text, for policy export
navigate to the link Administration, system, backup and restore, and policy export page. The radio button for
policy type shows simple and rule-based (selected). The policy for four checkboxes Wireless_Dot1X,
Wireless_EAP-TLS, Wireless_PEAP, and Default are selected and details are shown.

The authentication rule is configured with the Wireless_802.1X compound condition that is predefined in the library. This
condition matches on wireless 802.1X-based authentication requests from the WLC by evaluating the AVPs using these
expressions:

Radius:Service-Type Equals Framed (2)

Radius:NAS-Port-Type Equals Wireless—IEEE 802.11 (19)

In Example 5-2, we can see from the debug output on the WLC that the authentication request being sent for an 802.1X
client includes AVPs (12 and 14 in this case) with values that match the Wireless_802.1X compound condition in ISE.

Example 5-2 debug aaa events enable—802.1X Authentication Request

Click here to view code image

*aaaQueueReader: Aug 24 22:42:32.259: AuthenticationRequest: 0xffebe69ce8
*aaaQueueReader: Aug 24 22:42:32.259:
  Callback.....................................0x1079c450
*aaaQueueReader: Aug 24 22:42:32.259:
  protocolType.................................0x00140001
*aaaQueueReader: Aug 24 22:42:32.259:
  proxyState...................................68:7F:74:FC:8C:0F-02:00
*aaaQueueReader: Aug 24 22:42:32.259:   Packet contains 19 AVPs:
*aaaQueueReader: Aug 24 22:42:32.259:       AVP[01] User-
  Name................................user1@wireless.local (20 bytes)
*aaaQueueReader: Aug 24 22:42:32.259:       AVP[02] Chargeable-User-

Chapter 5 Wireless Security and Identity Management with ISE

296

Technet24
||||||||||||||||||||

||||||||||||||||||||

file:///C:/Users/MERRELL/Documents/eBook Converter/Oreilly Downloader/tmp/9780135162095/ch05.xhtml#ch05fig43
file:///C:/Users/MERRELL/Documents/eBook Converter/Oreilly Downloader/tmp/9780135162095/ch05.xhtml#ch05ex02
file:///C:/Users/MERRELL/Documents/eBook Converter/Oreilly Downloader/tmp/9780135162095/ch05_images.xhtml#p05ex02a
https://technet24.ir
https://technet24.ir
https://technet24.ir


  Identity.................0x64 (100) 'd' (1 byte)
*aaaQueueReader: Aug 24 22:42:32.259:       AVP[03] Location-
  Capable.........................0x00000001 (1) (4 bytes)
*aaaQueueReader: Aug 24 22:42:32.259:       AVP[05] Called-Station-
  Id........................cc-16-7e-5f-ca-10:8021Xssid (27 bytes)
*aaaQueueReader: Aug 24 22:42:32.259:       AVP[06] Nas-
  Port.................................0x00000001 (1) (4 bytes)
*aaaQueueReader: Aug 24 22:42:32.259:       AVP[07] Cisco / Audit-Session-
  Id.................647f640a000000195b80d028 (24 bytes)
*aaaQueueReader: Aug 24 22:42:32.259:       AVP[08] Acct-Session-
  Id..........................5b80d028/68:7f:74:fc:8c:0f/1402 (31 bytes)
*aaaQueueReader: Aug 24 22:42:32.259:       AVP[09] Nas-Ip-
  Address...........................0x647f640a (1686070282) (4 bytes)
*aaaQueueReader: Aug 24 22:42:32.259:       AVP[10] NAS-
  Identifier...........................0x574c4331 (1464615729) (4 bytes)
*aaaQueueReader: Aug 24 22:42:32.259:       AVP[11] Airespace / WLAN-
  Identifier..............0x00000001 (1) (4 bytes)
*aaaQueueReader: Aug 24 22:42:32.259:       AVP[12] Service-
  Type.............................0x00000002 (2) (4 bytes)
*aaaQueueReader: Aug 24 22:42:32.259:       AVP[13] Framed-
  MTU...............................0x00000514 (1300) (4 bytes)
*aaaQueueReader: Aug 24 22:42:32.259:       AVP[14] Nas-Port-
  Type............................0x00000013 (19) (4 bytes)
*aaaQueueReader: Aug 24 22:42:32.259:       AVP[15] Tunnel-
  Type..............................0x0000000d (13) (4 bytes)
*aaaQueueReader: Aug 24 22:42:32.259:       AVP[16] Tunnel-Medium-
  Type.......................0x00000006 (6) (4 bytes)
*aaaQueueReader: Aug 24 22:42:32.259:       AVP[17] Tunnel-Group-
  Id..........................100 (3 bytes)
*aaaQueueReader: Aug 24 22:42:32.259:       AVP[18] EAP-
  Message..............................DATA (25 bytes)
*aaaQueueReader: Aug 24 22:42:32.259:       AVP[19] Message-
  Authenticator....................DATA (16 bytes)

If the conditions are satisfied for this rule, the Default Network Access (preconfigured) allowed protocols services list
shown in Figure 5-44 will be used. This list includes EAP-TLS and PEAP by default and could be modified (or another
protocol service list can be created and used) to allow only the protocols that are needed.
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Figure 5-44 Allowed Protocol Services List

The allowed protocol services list shows the Policy tab selected from the menu at the top; and the sub-menu policy
elements is selected. The results are selected from the left pane and it shows the navigations. The allowed protocol
is selected by expanding the Authentication on the left pane. The right pane displays the navigation at the top,
Default Network Access is selected from allowed protocols services list. The name (mandatory field) reads Default
Network Access (uneditable), and the description box reads Default allowed protocol service. The allowed
protocols section includes two segments authentication bypass and authentication protocols. The Allow E A P  T L
S checkbox is checked in the authentication protocols. Then the Allow PEAP checkbox is also checked.

The next step is to move to the identity rules, which define the identity source to be used by each rule. It is possible to
leverage the Default identity rule and use an identity source sequence that encompasses the required sources for different
protocols, but to show how it can be leveraged, we will use a separate rule for EAP-TLS and PEAP.
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EAP-TLS will make use of the Preloaded_Certificate_Profile (preconfigured) that is shown in Figure 5-45. The
certificate authentication profiles, among other things, can be used to determine which attribute in the certificate will
be used as the identity of the user or device because there is no specific username field, and there are various fields on
the certificate that could serve as the username.

Figure 5-45 Certificate Authentication Profile

The certificate authentication profile selects the Administration tab from the menu at the top; and the sub-
menu Identity management is selected. The external identity source is selected from the left pane. The
preloaded_certificate_profile is selected by expanding the certificate authentication profiles file on the left
pane. The right pane displays the name (mandatory field) reads preloaded_certificate_profile, and the
description box reads Precreated certificate authorization profile. The identity store drop-down is selected as
not applicable. The certificate attribute radio button is selected for the use identity from. Never radio button is
selected for the Match client certificate against certificate in identity store.

PEAP, on the other hand, will use Active Directory (join point named AD_WIRELESS) to validate the credentials.

After we conclude the authentication process, ISE will move to evaluating the authorization policy. In the example
represented in Figure 5-46, we have two authorization rules to show how to provide different network access to users.
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Figure 5-46 802.1X Authorization Policy

The authorization policy of 802.1X shows the Policy tab selected from the menu at the top; and the sub-menu
authorization is selected. The authorization policy in the content pane displays the text, define the authorization
policy by configuring rules based on identity groups and/or other conditions. For policy export navigate to the link
Administration, system, backup and restore, and policy export page. The first matched rule applies drop-down is
selected. Under Exceptions, the standard three checkboxes Wireless_EAP-TLS, Wireless_PEAP, and Default are
checked and its conditions and permissions are displayed.

The first rule looks for wireless users (leveraging the Wireless_802.1X previously described) using EAP-TLS. This is a
typical use case for internal users that have been provisioned with a valid certificate (such as employees). If meeting
the criteria of the conditions for this rule, ISE will assign the EAP-TLS_user authorization profile that is shown in
Figure 5-47 and that is configured to override the VLAN assigned by the WLC to the user.
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Figure 5-47 802.1X Authorization Profile – EAP-TLS Users

Under the authorization profiles, the name (mandatory field) is entered as E A P  T L S_user, and the
description box is entered as Sample authorization profile for E A P  T L S_users. The access type
(mandatory) drop-down is set to ACCESS_ACCEPT. The network device profile drop-down selects CISCO
with its logo; three checkboxes, service templates, track movement, and passive identity tracking are
unchecked. The common tasks section includes three checkboxes VLAN (checked) with Tag ID 1, an Edit tag
button and ID/Name 200; the ACL and voice domain permission checkboxes are unchecked. The Advanced
attributes settings show a pair of drop-down that equals each other. A decrement and increment buttons are
placed to its right. The attributes details are shown at the bottom.

As we look in Example 5-3, the Access-Accept received by the WLC, we can see the attributes that match those
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defined as part of the authorization profile.

Example 5-3 debug aaa events enable—Authorization Response EAP-TLS User

Click here to view code image

*radiusTransportThread: Aug 24 22:42:32.823: 68:7f:74:fc:8c:0f Access-Accept
  received from RADIUS server 192.168.100.6 (qid:15) with port:1812, pktId:60
*radiusTransportThread: Aug 24 22:42:32.823: AuthorizationResponse: 0x169505b0
*radiusTransportThread: Aug 24 22:42:32.823:
  structureSize................................554
*radiusTransportThread: Aug 24 22:42:32.823:
  resultCode...................................0
*radiusTransportThread: Aug 24 22:42:32.823:
  protocolUsed.................................0x00000001
*radiusTransportThread: Aug 24 22:42:32.823:
  proxyState...................................68:7F:74:FC:8C:0F-02:05
*radiusTransportThread: Aug 24 22:42:32.823:    Packet contains 10 AVPs:
*radiusTransportThread: Aug 24 22:42:32.823:        AVP[01] User-
  Name................................user1 (5 bytes)
*radiusTransportThread: Aug 24 22:42:32.823:        AVP[02]
  State..........................ReauthSession:647f640a000000195b80d028 (38 bytes)
*radiusTransportThread: Aug 24 22:42:32.823:        AVP[03]
  Class....................................CACS:647f640a000000195b80d028:
  ise/323248099/313 (47 bytes)
*radiusTransportThread: Aug 24 22:42:32.823:        AVP[04] Tunnel-
  Type..............................0x0100000d (16777229) (4 bytes)
*radiusTransportThread: Aug 24 22:42:32.823:        AVP[05] Tunnel-Medium-
  Type.......................0x01000006 (16777222) (4 bytes)
*radiusTransportThread: Aug 24 22:42:32.823:        AVP[06] EAP-
  Message..............................0x03820004 (58851332) (4 bytes)
*radiusTransportThread: Aug 24 22:42:32.823:        AVP[07] Message-
  Authenticator....................DATA (16 bytes)
*radiusTransportThread: Aug 24 22:42:32.823:        AVP[08] Tunnel-Group-
  Id..........................0x01323030 (20066352) (4 bytes)
*radiusTransportThread: Aug 24 22:42:32.823:        AVP[09] Microsoft / MPPE-
  Send-Key................DATA (32 bytes)
*radiusTransportThread: Aug 24 22:42:32.823:        AVP[10] Microsoft / MPPE-
  Recv-Key................DATA (32 bytes)

The second rule not only looks for wireless users using PEAP but also checks whether they belong to the right Active
Directory user group. This use case is common in certain BYOD scenarios or when giving access to contractors or
other users that have valid AD accounts. Matching this rule will assign the PEAP_user authorization profile as shown
in Figure 5-48, for which ISE will send back the ACL name that the WLC will need to apply to the user session.
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Figure 5-48 802.1X Authorization Profile—PEAP Users

The authorization profiles for PEAP users shows the navigation PEAP_user, selected from the authorization
profiles. The name (mandatory field) is entered as PEAP_user, and the description box is entered as Sample
authorization profile for PEAP users. The access type (mandatory) drop-down is set to ACCESS_ACCEPT.
The network device profile drop-down selects CISCO with its logo; three checkboxes, service templates, track
movement, and passive identity tracking are unchecked. The common tasks section includes four checkboxes
Airespace ACL name (checked) with a field reads ACL_Restricted; the web authentication, ASS VPN, and
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AVC profile name checkboxes are unchecked. The Advanced attributes settings show a pair of drop-down
that equals each other. A decrement and increment buttons are placed to its right. The attributes details are
shown at the bottom.

Now from the WLC perspective, we have Example 5-4 that shows the Access-Accept containing the ACL name as
part of one of the AVPs received from ISE.

Example 5-4 debug aaa events enable—Authorization Response PEAP User

Click here to view code image

*radiusTransportThread: Aug 24 23:39:01.550: 68:7f:74:fc:8c:0f Access-Accept received
  from RADIUS server 192.168.100.6 (qid:15) with port:1812, pktId:72
*radiusTransportThread: Aug 24 23:39:01.550: AuthorizationResponse: 0x169505b0
*radiusTransportThread: Aug 24 23:39:01.550:    structure-
  Size................................508
*radiusTransportThread: Aug 24 23:39:01.550:    result-
  Code...................................0
*radiusTransportThread: Aug 24 23:39:01.550:
  protocolUsed.................................0x00000001
*radiusTransportThread: Aug 24 23:39:01.550:
  proxyState...................................68:7F:74:FC:8C:0F-02:05
*radiusTransportThread: Aug 24 23:39:01.550:    Packet contains 8 AVPs:
*radiusTransportThread: Aug 24 23:39:01.550:        AVP[01] User-
  Name................................user1 (5 bytes)
*radiusTransportThread: Aug 24 23:39:01.550:        AVP[02]
  State.............................ReauthSession:647f640a0000001a5b80dd65
  (38 bytes)
*radiusTransportThread: Aug 24 23:39:01.550:        AVP[03]
  Class....................................CACS:647f640a0000001a5b80dd65:
  ise/323248099/318 (47 bytes)
*radiusTransportThread: Aug 24 23:39:01.550:        AVP[04] EAP-
  Message..............................0x03260004 (52822020) (4 bytes)
*radiusTransportThread: Aug 24 23:39:01.550:        AVP[05] Message-
  Authenticator....................DATA (16 bytes)
*radiusTransportThread: Aug 24 23:39:01.550:        AVP[06] Microsoft / MPPE-
  Send-Key................DATA (32 bytes)
*radiusTransportThread: Aug 24 23:39:01.550:        AVP[07] Microsoft / MPPE-
  Recv-Key................DATA (32 bytes)
*radiusTransportThread: Aug 24 23:39:01.550:        AVP[08] Airespace / ACL-
  Name.....................ACL_Restricted (14 bytes)

MAC Filtering and MAC Authentication Bypass (MAB)

MAC Filtering, and its variation MAC Authentication Bypass, would typically be configured on an open or PSK WLAN
and allows the use of the MAC address of an endpoint to determine what type of network access to provide, depending on
whether it is a known or unknown device.

Configuration on the WLC requires creating a WLAN with the following settings that are also represented in Figure 5-49:

Layer 2 Security can either be none (open) or using WPA2 with AES Encryption and PSK for authentication key
management. MAC filtering needs to be enabled.

AAA Servers and Advanced settings should be configured following the same guidelines mentioned on the 802.1X
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configuration section.

Figure 5-49 MAB WLAN Settings

The MAB WLAN setting is shown by the WLANs menu, selected from the top horizontal menu options. The
left pane reads the navigation WLANs selected from the WLANs option. The right pane displays the
navigation at the top; the security tab is selected from the five given tabs; the Layer 2 subtab is selected from
the three given subtabs. In the content pane, the Layer 2 security reads WPA+WPA2 from the drop-down,
and the checkbox MAC Filtering is selected and highlighted.

The Authentication Policy on ISE would need to have a rule configured, such as the one shown in Figure 5-50.

Figure 5-50 MAB Authentication Policy

The authentication policy of MAB shows the Policy tab selected from the menu at the top; and the sub-menu
authentication is selected. The authentication policy in the content pane displays the text, define the authentication
policy by selecting the protocols that ISE should use to communicate with the network devices. For policy export
navigate to the link Administration, system, backup and restore, and policy export page. The radio button for
policy type shows simple and rule-based (selected). The checkboxes MAB, Default (uneditable), Dot1X, and
Default are checked. The options under the uneditable default checkbox display the constraint If authentication
failed - if user not found (highlighted); a drop-down displays three options, reject, continue (selected), and drop.

This rule for MAB will make use of the Wireless_MAB compound condition from the library. This condition matches on
MAC authentication requests from the WLC by using the following expressions:
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Radius:Service-Type Equals Call Check (10)

Radius:NAS-Port-Type Equals Wireless—IEEE 802.11 (19)

Example 5-5 shows the debug output from the WLC where we can see the AVPs (9 and 11 in this example) that will be
sent as part of the MAC authentication request and that will match in the configured condition in ISE.

Example 5-5 debug aaa events enable—MAC Authentication Request

Click here to view code image

*aaaQueueReader: Aug 28 21:10:13.342: AuthenticationRequest: 0xffebe7b250
*aaaQueueReader: Aug 28 21:10:13.342:
  Callback.....................................0x105d6df0
*aaaQueueReader: Aug 28 21:10:13.342:
  protocolType.................................0x40000001
*aaaQueueReader: Aug 28 21:10:13.342:
  proxyState...................................68:7F:74:FC:8C:0F-00:00
*aaaQueueReader: Aug 28 21:10:13.342:   Packet contains 16 AVPs:
*aaaQueueReader: Aug 28 21:10:13.342:       AVP[01] User-
  Name................................687f74fc8c0f (12 bytes)
*aaaQueueReader: Aug 28 21:10:13.342:       AVP[02] Called-Station-
  Id........................cc-16-7e-30-6b-50:MACauthssid (29 bytes)
*aaaQueueReader: Aug 28 21:10:13.342:       AVP[03] Calling-Station-
  Id.......................68-7f-74-fc-8c-0f (17 bytes)
*aaaQueueReader: Aug 28 21:10:13.342:       AVP[04] Nas-
  Port.................................0x00000001 (1) (4 bytes)
*aaaQueueReader: Aug 28 21:10:13.342:       AVP[05] Nas-Ip-
  Address...........................0x647f640a (1686070282) (4 bytes)
*aaaQueueReader: Aug 28 21:10:13.342:       AVP[06] NAS-
  Identifier...........................0x574c4331 (1464615729) (4 bytes)
*aaaQueueReader: Aug 28 21:10:13.342:       AVP[07] Airespace / WLAN-
  Identifier..............0x00000002 (2) (4 bytes)
*aaaQueueReader: Aug 28 21:10:13.342:       AVP[08] User-
  Password............................[...]
*aaaQueueReader: Aug 28 21:10:13.342:       AVP[09] Service-
  Type.............................0x0000000a (10) (4 bytes)
*aaaQueueReader: Aug 28 21:10:13.342:       AVP[10] Framed-
  MTU...............................0x00000514 (1300) (4 bytes)
*aaaQueueReader: Aug 28 21:10:13.342:       AVP[11] Nas-Port-
  Type............................0x00000013 (19) (4 bytes)
*aaaQueueReader: Aug 28 21:10:13.342:       AVP[12] Tunnel-
  Type..............................0x0000000d (13) (4 bytes)
*aaaQueueReader: Aug 28 21:10:13.342:       AVP[13] Tunnel-Medium-
  Type.......................0x00000006 (6) (4 bytes)
*aaaQueueReader: Aug 28 21:10:13.342:       AVP[14] Tunnel-Group-
  Id..........................100 (3 bytes)
*aaaQueueReader: Aug 28 21:10:13.342:       AVP[15] Cisco / Audit-Session-
  Id.................647f640a000000265b860085 (24 bytes)
*aaaQueueReader: Aug 28 21:10:13.342:       AVP[16] Acct-Session-
  Id..........................5b860085/68:7f:74:fc:8c:0f/1642 (31 bytes)

A critical part of the configuration for MAB is to change the If User Not Found option to Continue. This will allow ISE to
complete the authentication host lookup process moving to the authorization policy even if dealing with an unknown
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device.

After moving the Authorization Policy, there are multiple ways to provide differentiated network access to a known versus
unknown device. Figure 5-51 shows one possible way it can be implemented and how it can be implemented.

The first and more specific rule looks for wireless MAC authentication requests where the endpoints belong to the
RegisteredDevices identity group, and it permits access to those devices.

The second rule is left generic enough to act as a catch-all rule for MAB, and it looks only for wireless MAC
authentication requests. In this scenario, the rule will assign RestrictedAccess to unknown devices, which, for
example, could be used to apply an ACL or VLAN while the device gets registered or profiled.

Figure 5-51 MAB Authorization Policy

The MAB authorization policy shows the Policy tab selected from the menu at the top; and the sub-menu
authorization is selected. The authorization policy in the content pane displays the text, define the
authorization policy by configuring rules based on identity groups and/or other conditions. For policy export
navigate to the link Administration, system, backup and restore, and policy export page. The first matched rule
applies drop-down is selected. Under Exceptions, the standard three checkboxes Wireless_MAB_Registered,
Wireless_MAB_Unknown, and Default are checked and its conditions and permissions are shown.

Local Web Authentication

Web authentication (WebAuth) is a Layer 3 security mechanism that allows users, typically guests, to easily gain access to
the network by providing credentials through a web browser.

Two deployment modes are available for WebAuth with ISE: Local Web Authentication (LWA) and Central Web
Authentication (CWA). Although Cisco recommends the use of CWA with ISE, there are some scenarios where LWA is
preferred due to its simplicity or because it is the only viable option for the network environment.

In LWA, the WLC is “locally” configured to redirect the user to the web authentication portal and will be responsible for
receiving the user credentials that need to be submitted to ISE for authentication.

When a user connects to a WLAN configured for LWA, it will go through the flow shown in Figure 5-52.

1. The user will connect to an open (although less common, PSK security is also supported) SSID that is configured for
WebAuth.
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2. The WLC will apply and enforce an access control list that will typically allow access only to DHCP and DNS, and
access to the authentication web portal.

3. After the client acquires an IP address, the controller will move the user to WebAuth_reqd state.

4. The user will open a browser trying to fetch a web page and the WLC will intercept the HTTP request (HTTPS is not
intercepted by default) and redirect the user to either an internal WebAuth page or to ISE.

5. The user is presented with the guest login page where he or she will enter the username and password. The login page
will take the user credentials input and submit them to the WLC. (It is the client browser that submits the credentials to
the WLC, not the external portal if there is one.)

6. The WLC uses RADIUS to authenticate the username and password against ISE.

7. ISE authenticates and authorizes the user.

8. If the credentials are valid, ISE will notify the WLC to change to a new access policy to allow the user access to the
network. The client then moves to RUN state with either full access or possibly with a post-authentication ACL
applied if ISE returned an Airespace-ACL RADIUS attribute.

Figure 5-52 Local Web Authentication

The MAB authorization policy shows the Policy tab selected from the menu at the top; and the sub-menu
authorization is selected. The authorization policy in the content pane displays the text, define the
authorization policy by configuring rules based on identity groups and/or other conditions. For policy export
navigate to the link Administration, system, backup and restore, and policy export page. The first matched rule
applies drop-down is selected. Under Exceptions, the standard three checkboxes Wireless_MAB_Registered,
Wireless_MAB_Unknown, and Default are checked and its conditions and permissions are shown.

Configuration of LWA on the WLC will typically start by defining the preauthentication ACL as the one shown in Figure
5-53. This ACL will be used to provide limited network access and trigger the redirection process. Here are a couple of
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consideration to keep in mind regarding the ACL:

If you’re using the internal WebAuth portal, it is not required to define an ACL unless there is some specific traffic
that needs to be allowed before the user authenticates.

The ACL needs to permit traffic to where the WebAuth portal is hosted, in this example ISE.

If deploying FlexConnect, a FlexConnect ACL will need to be configured instead of a regular controller ACL.

By default, DHCP and DNS are allowed by the preauthentication ACL. If configuring an explicit deny statement in the
ACL, you need to make sure that you have a rule that allows DNS traffic, or else it will get blocked.

Figure 5-53 LWA Redirect ACL

The pre-authentication ACL defined for LWA configuration shows the Security menu selected from the top
horizontal menu options. The left pane displays various options with navigations. The general is selected by
expanding the AAA option on the left pane. On the right pane, the Edit is selected from the access control list.
The general tab in content pane shows the values for access list name and deny counters. The table below
reads the column headers, sequence, action, source IP/mask, destination IP/mask, protocol, source port,
destination port, DSCP, direction, and number of hits in table wise data.

As it relates to the WLAN, the following settings need to be configured:

Layer 2 Security will typically be none (open) to provide a simpler user experience; however, if needed, it can be
implemented with PSK as well.

The Layer 3 Security policy will need to be configured for web authentication, as shown in Figure 5-54. The
preauthentication ACL previously created will need to be added to allow access to the WebAuth portal (this is not
required if using the WLC internal portal).
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Figure 5-54 LWA Layer 3 WLAN Settings

The WLAN settings of LWA layer 3 is shown from the WLANs menu, selected from the top horizontal menu
options. The left pane reads the navigation WLANs selected by expanding the WLANs. The right pane
displays the navigation at the top, Edit LWA selected from WLANs. The security tab is selected from the five
given tabs; the Layer 3 sub-tab is selected from the three given subtabs. In the content pane, from the drop-
down, the Web Policy is selected for the Layer 3 security; the authentication radio button is selected. From
the drop-down, the ACL_Redirect is selected for the IPv4 pre-authentication ACL. The enable checkbox is
selected for the over-ride global config. From the drop-down, the external (redirect to external server) is
selected for the Web Auth type and the portal URL is entered in the URL field. All the above are highlighted.

Finally, if using an external portal, the URL to redirect the user will need to be specified (can be also configured
globally). To find out the correct URL for the portal in ISE, navigate to Work Centers > Guest Access > Portal and
Components > Guest Portals Configure and select the specific portal that will be used. From there you can right-
click the link Portal Test URL, as shown in Figure 5-55, and choose Copy Link Location.

Figure 5-55 ISE LWA Portal URL

The LWA portal URL window shows the work centers selected from the menu at the top; the submenu guest
access is selected; and the tab portals and components are selected. The guest portal of the left pane shows the
portals settings and customization in the right pane. The field for portal name and description are entered; and
at the end of the description field, the link Portal test URL is highlighted.

Note
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One variation of this configuration is to configure MAC Filtering for Layer 2 Security and On MAC Filter Failure for
Layer 3. This can be useful in bypassing the web authentication portal if the device has already been learned/registered
on ISE for scenarios such as when dealing with headless devices (such as printers or other devices with limited
capabilities).

The rest of the settings will be configured in accordance with the recommendations mentioned previously for
integrating with ISE.

After completing the configuration on the WLC, we can now move to ISE and configure the authentication rule shown in
Figure 5-56 to support LWA.

Figure 5-56 LWA Authentication Policy

The authentication policy of LWA shows the Policy tab selected from the menu at the top; and the submenu
authentication is selected. The authentication policy in the content pane displays the text, define the authentication
policy by selecting the protocols that ISE should use to communicate with the network devices. For policy export
navigate to the link Administration, system, backup and restore, and policy export page. The radio button for
policy type shows simple and rule-based (selected). The checkboxes Wireless_LWA and Default are checked and
its details are shown on the right.

This rule is configured to use the WLC_Web_Authentication compound condition from the library. This condition matches
on web authentication requests from the WLC by using these expressions:

Radius:Service-Type Equals Login (1)

Radius:NAS-Port-Type Equals Wireless—IEEE 802.11 (19)

Looking at the output from the WLC in Example 5-6, we can see the AVPs (3 and 10 for this scenario) that accompany
the access request sent after the user submits its credentials for validation via ISE.

Example 5-6 debug aaa events enable—LWA Authentication Request

Click here to view code image

*aaaQueueReader: Aug 28 23:46:53.144: AuthenticationRequest: 0xffebffc418
*aaaQueueReader: Aug 28 23:46:53.144:  
Callback.....................................0x11904570
*aaaQueueReader: Aug 28 23:46:53.144:  
protocolType.................................0x00000001
*aaaQueueReader: Aug 28 23:46:53.144:  
proxyState...................................68:7F:74:FC:8C:0F-00:00
*aaaQueueReader: Aug 28 23:46:53.144:   Packet contains 14 AVPs:
*aaaQueueReader: Aug 28 23:46:53.144:       AVP[01] User-
  Name................................guestuser (9 bytes)
*aaaQueueReader: Aug 28 23:46:53.144:       AVP[02] User-
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  Password............................[...]
*aaaQueueReader: Aug 28 23:46:53.144:       AVP[03] Service-
  Type.............................0x00000001 (1) (4 bytes)
*aaaQueueReader: Aug 28 23:46:53.144:       AVP[04] Nas-Ip-
  Address...........................0x647f640a (1686070282) (4 bytes)
*aaaQueueReader: Aug 28 23:46:53.144:       AVP[05] Nas-
  Port.................................0x00000001 (1) (4 bytes)
*aaaQueueReader: Aug 28 23:46:53.144:       AVP[06] Cisco / Audit-Session-
  Id.................647f640a0000002a5b8624b5 (24 bytes)
*aaaQueueReader: Aug 28 23:46:53.144:       AVP[07] Framed-IP-
  Address........................0x647f640d (1686070285) (4 bytes)
*aaaQueueReader: Aug 28 23:46:53.144:       AVP[08] Acct-Session-
  Id..........................5b8624b5/68:7f:74:fc:8c:0f/1654 (31 bytes)
*aaaQueueReader: Aug 28 23:46:53.144:       AVP[09] NAS-
  Identifier...........................0x574c4331 (1464615729) (4 bytes)
*aaaQueueReader: Aug 28 23:46:53.144:       AVP[10] Nas-Port-
  Type............................0x00000013 (19) (4 bytes)
*aaaQueueReader: Aug 28 23:46:53.144:       AVP[11] Airespace / WLAN-
  Identifier..............0x00000003 (3) (4 bytes)
*aaaQueueReader: Aug 28 23:46:53.144:       AVP[12] Calling-Station-
  Id.......................68-7f-74-fc-8c-0f (17 bytes)
*aaaQueueReader: Aug 28 23:46:53.144:       AVP[13] Called-Station-
  Id........................f4-0f-1b-36-13-a0:LWAssid (25 bytes)

For this example, we have selected the preconfigured Guest_Portal_Sequence identity source sequence, which can be
customized, but by default, it will allow all internal, guest, and AD users to log in, as displayed in Figure 5-57.
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Figure 5-57 Guest Identity Source Sequence

The guest portal sequence identity shows the administration tab selected from the menu at the top; the submenu
identity management is selected; and below, the tab identity source sequence is selected. The content pane
displays the navigation at the top, Guest_Portal_Sequence selected from the identity source sequence list;
followed by the header reads identity source sequence with four sections, identity source sequence, certificate
based authentication, authentication search list, and advanced search list settings. The first section identity source
sequence includes two fields, name (mandatory) and description. The certificate based authentication section
includes an unchecked checkbox select certificate authentication profile. The authentication search list includes
two boxes, available and selected with the text entered in it. The advanced search list settings display one of the
two radio buttons treat as if the user was not found and proceed to the next store in the sequence is selected.

Finally, because LWA is used typically to provide basic guest services, its associated authorization policy will be fairly
simple, as illustrated in Figure 5-58. The rule conditions will match for web authentication requests and will send back an
access-accept to signal the WLC to allow access to authenticated users.
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Figure 5-58 LWA Authorization Policy

The authorization policy of LWA shows the Policy tab selected from the menu at the top; and the submenu
authorization is selected. The authorization policy in the content pane displays the text, define the authorization
policy by configuring rules based on identity groups and/or other conditions. For policy export navigate to the link
Administration, system, backup and restore, and policy export page. The first matched rule applies drop-down is
selected. Under Exceptions, the standard two checkboxes Wireless_LWA and Default are checked and its
conditions and permissions are shown.

Central Web Authentication

Guest services using Central Web Authentication (CWA) would be the preferred deployment model due to the flexibility it
provides. It builds on top of MAB, and it can provide additional capabilities that go beyond guest network access.

In CWA, the configuration for redirecting the user, the web authentication portal and the responsibility of directly
processing the user credentials, resides “centrally” in ISE. When a user connects to a CWA-enabled network, it will go
through the flow shown in Figure 5-59.

1. The user will connect to an open SSID. Transparent to the user, the WLAN is configured to perform MAC
authentication.

2. The WLC handles the MAC authentication process and sends the request to ISE.

3. ISE is configured to perform MAB and will send back to the WLC the redirection attributes.

4. The user acquires an IP address and will open a browser trying to fetch a web page (on modern operating systems, a
pop-up might even show up when the system detected the portal page automatically by sending HTTP test probes). At
this point the WLC will intercept the HTTP request and redirect the user to the WebAuth page that resides on ISE.

5. The user is presented with the guest login page where it will enter the username and password. These credentials get
submitted directly to ISE through the portal.

6. ISE will authenticate the user, and if successful, it will send a CoA back to the WLC.

7. When the user reconnects, the WLC will start the MAC authentication process all over again, but this time ISE is
aware that the user has authenticated, and it will grant it access to the network, possibly returning specific
authorization attributes such as an ACL.
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Figure 5-59 Central Web Authentication

The central web authentication displays the User laptop is connected wirelessly to the AP/WLCs WLAN
controller and access point followed by a file server DHCP, DNS is placed and finally the ISE. Step 1 shows
the user open SSID with Macauth to the AP/WLC. Step 2 shows the user sends the first authentication session
to the ISE. Step 3 shows the ISE respond to the user by authentication success, authorization for MAB
returned with ACL and URL. Step 4 shows the request and response of DHCP DNS and user that, the user
acquires IP Address, moves to WebAuth state. Step 5 shows the user opens the browser, WLC redirects user
to ISE CWA page, then login into the page by and sending the credentials to the ISE. Step 6 shows the
WebAuth success results in CoA and the final step, step 7 shows the user sends MAC reauthentication to the
ISE and ISE respond the ISE server and the return policy.

Because this flow builds on top of MAB, the WLAN configuration on the WLC will be the same as previously reviewed in
the MAB section. In this scenario, however, make sure that AAA Override and ISE NAC are enabled as shown in Figure
5-60.
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Figure 5-60 CWA WLAN Settings

The CWA WLAN setting is shown by the WLANs menu, selected from the top horizontal menu options. The left
pane reads the navigations. The right pane displays the navigation at the top, Edit CWA is selected from W LANs.
Two screenshots are shown that selects two different tabs, the security and advanced. The Security tab selected
shows the Layer 2 subtab selected; the Layer 2 security drop-down reads none and the MAC filtering checkbox is
selected and highlighted. The Advanced tab selected shows the checkbox enable is selected for Allow AAA
override. Under the NAC section, the NAC state is selected ISE NAC from the drop-down are highlighted.

Although not statically applied to the WLAN as in LWA, the WLC needs to have an ACL configured similar to the one
shown in Figure 5-61 that will be used to redirect the traffic. This ACL must comply with the following requirements:

The ACL needs to permit traffic to ISE on the port configured for the web portal (default 8443).

If deploying FlexConnect, a FlexConnect ACL will need to be configured instead of a regular controller ACL. This is
configured as a Policy ACL on the AP or at the FlexConnect group level (it must be provisioned on the AP
beforehand).

As previously mentioned, by default, DHCP and DNS are allowed on an ACL. If configuring an explicit deny
statement in the ACL, make sure that you add the required rules to permit DNS traffic.
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Figure 5-61 CWA Redirect ACL

The ACL defined for CWA configuration shows the Security menu selected from the top horizontal menu
options. The left pane displays various options with navigations. The general option is selected by expanding
the A A A option on the left pane. The right pane displays the navigation at the top, Edit is selected from the
access control list. The general tab in content pane shows the values for access list name and deny counters.
The table below reads the column headers, sequence, action, source IP/mask, destination IP/mask, protocol,
source port, destination port, DSCP, direction, and number of hits in table wise data.

On ISE, the Authentication Policy will leverage the MAB rule previously discussed. It is worth highlighting again the
importance of making sure that the If User Not Found option for the identity source is changed to Continue, as shown in
Figure 5-62. Users just initiating the CWA flow will not be known by ISE, but they will still need to move to the
authorization policy to get the redirect URL and ACL applied to their session.

Figure 5-62 CWA/MAB Authentication Policy

The authentication policy of CWA or MAB shows the Policy tab selected from the menu at the top; and the sub-

Chapter 5 Wireless Security and Identity Management with ISE

317

||||||||||||||||||||

||||||||||||||||||||

file:///C:/Users/MERRELL/Documents/eBook Converter/Oreilly Downloader/tmp/9780135162095/ch05.xhtml#ch05fig62
https://technet24.ir
https://technet24.ir


menu authentication is selected. The authentication policy in the content pane displays the text, define the
authentication policy by selecting the protocols that ISE should use to communicate with the network devices. For
policy export navigate to the link Administration, system, backup and restore, and policy export page. The radio
button for policy type shows simple and rule-based (selected). The checkboxes MAB, Default (uneditable),
Dot1X, and Default are checked. The options under the uneditable default checkbox display the constraint If
authentication failed - if user not found (highlighted); a drop-down displays three options, reject, continue
(selected), and drop.

One important thing to note is that the Authentication Policy doesn’t require a rule to process the credentials provided via
the portal. The reason for this is that the CWA username and password validation is handled separately, and the identity
source that is to be used is configured directly under the portal settings, as shown in Figure 5-63.

Figure 5-63 CWA Portal Authentication

The CWA portal authentication window shows the work centers selected from the menu at the top; the submenu
guest access is selected; and the tab portals and components are selected. The guest portals of the left pane show
the portals settings and customization in the right pane. The field for portal name and description are entered; and
at the end of the description field, the link Portal test URL is shown. Under the portal settings section, the two
checkboxes Gigabit Ethernet 0 and Bond 0 are selected. The Guest_Portal_Sequence is selected from the drop-
down list for the authentication method (mandatory) and it is highlighted.

Because CWA is a multistep process, the Authorization Policy will include the two rules that can be seen in Figure 5-64.
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Figure 5-64 CWA Authorization Policy

The authorization policy of CWA shows the Policy tab selected from the menu at the top; and the sub-menu
authorization is selected. The authorization policy in the content pane displays the text, define the authorization
policy by configuring rules based on identity groups and/or other conditions. For policy export navigate to the link
Administration, system, backup and restore, and policy export page. The first matched rule applies drop-down is
selected. Under Exceptions, the standard three checkboxes Wireless_CWA_Authenticated,
Wireless_CWA_Redirect, and Default are checked and its conditions and permissions are shown.

The first rule that will be used in the CWA flow (a more generic rule thus listed at a lower position in the policy) just looks
for the first MAC authentication request in the CWA request. As part of the Authorization Profile that is shown in Figure
5-65 and that is mapped to this rule, ISE will send the redirect attributes (URL and redirect ACL) that will be enforced by
the WLC.
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Figure 5-65 CWA Authorization Profile

The CWA authorization profile shows the navigation Cisco_WebAuth, selected from the authorization profiles.
The name (mandatory field) and the description are entered. The access type (mandatory) drop-down selects
ACCESS_ACCEPT. The network device profile drop-down selects CISCO with its logo; three checkboxes,
service templates, track movement, and passive identity tracking are left unchecked. The common tasks section
includes four checkboxes and the web redirection checkbox is selected. The Advanced attributes settings show a
pair of drop-down that equals each other. A decrement and increment buttons are placed to its right. The attributes
details are shown at the bottom.

Example 5-7 shows the output of the WLC debug showing how the URL and ACL are being received via AVPs as part of
the authorization response. One thing to notice is that the PSN node that processed the request will use its FQDN to craft
the URL to redirect the user.

Example 5-7 debug aaa events enable—CWA Authorization Response

Click here to view code image
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*radiusTransportThread: Aug 29 17:35:00.432: 68:7f:74:fc:8c:0f Access-Accept
  received from RADIUS server 192.168.100.6 (qid:15) with port:1812, pktId:188
*radiusTransportThread: Aug 29 17:35:00.432: AuthorizationResponse: 0x169505b0
*radiusTransportThread: Aug 29 17:35:00.432:    structureSize...................564
*radiusTransportThread: Aug 29 17:35:00.432:    resultCode........................0
*radiusTransportThread: Aug 29 17:35:00.432:
  protocolUsed.................................0x00000001
*radiusTransportThread: Aug 29 17:35:00.432:
  proxyState...................................68:7F:74:FC:8C:0F-00:00
*radiusTransportThread: Aug 29 17:35:00.432:    Packet contains 5 AVPs:
*radiusTransportThread: Aug 29 17:35:00.432:        AVP[01] User-
  Name................................68-7F-74-FC-8C-0F (17 bytes)
*radiusTransportThread: Aug 29 17:35:00.432:        AVP[02]
  State............................ReauthSession:647f640a0000006d5b871f94 (38 bytes)
*radiusTransportThread: Aug 29 17:35:00.432:        AVP[03] Class...................
  .................CACS:647f640a0000006d5b871f94:ise/323248099/1400 (48 bytes)
*radiusTransportThread: Aug 29 17:35:00.432:        AVP[04] Cisco / Url-Redirect-
  Acl.................ACL_Restricted (14 bytes)
*radiusTransportThread: Aug 29 17:35:00.432:        AVP[05] Cisco / Url-
  Redirect.....................DATA (175 bytes)
*radiusTransportThread: Aug 29 17:35:00.432: 68:7f:74:fc:8c:0f processing avps[0]:
  attribute 1
*radiusTransportThread: Aug 29 17:35:00.432: 68:7f:74:fc:8c:0f username = 68-7F-74-
  FC-8C-0F
*radiusTransportThread: Aug 29 17:35:00.432: 68:7f:74:fc:8c:0f processing avps[1]:
  attribute 24
*radiusTransportThread: Aug 29 17:35:00.432: 68:7f:74:fc:8c:0f processing avps[2]:
  attribute 25
*radiusTransportThread: Aug 29 17:35:00.432: 68:7f:74:fc:8c:0f processing avps[3]:
  attribute 6
*radiusTransportThread: Aug 29 17:35:00.432: 68:7f:74:fc:8c:0f processing avps[4]:
  attribute 5
*apfReceiveTask: Aug 29 17:35:00.432: 68:7f:74:fc:8c:0f Setting client ReasonCode
  from (0) to (126)
*apfReceiveTask: Aug 29 17:35:00.432: 68:7f:74:fc:8c:0f Received SGT for this Client.
*apfReceiveTask: Aug 29 17:35:00.432: 68:7f:74:fc:8c:0f SGT is not applied, sgtLen 0,
  sgt_stringp 0xffebe6198b
*apfReceiveTask: Aug 29 17:35:00.432: 68:7f:74:fc:8c:0f AAA Override Url-Redirect
  'https://ise.wireless.local:8443/portal/gateway?sessionId=647f640a0000006d5b871f94
  &portal=4bd88730-e371-11e6-92ce-005056873bd0&action=cwa&token=
*apfReceiveTask: Aug 29 17:35:00.432: 68:7f:74:fc:8c:0f Redirect URL received for
  client from RADIUS. Client will be moved to WebAuth_Reqd state to facilitate
  redirection. Skip web-auth Flag = 0
*apfReceiveTask: Aug 29 17:35:00.432: 68:7f:74:fc:8c:0f Resetting web IPv4 acl from
  255 to 255
*apfReceiveTask: Aug 29 17:35:00.432: 68:7f:74:fc:8c:0f Resetting web IPv4 Flex acl
  from 65535 to 65535
*apfReceiveTask: Aug 29 17:35:00.432: 68:7f:74:fc:8c:0f AAA Override Url-Redirect-
  Acl 'ACL_Redirect' mapped to ACL ID 0 and Flexconnect ACL ID 65535

The more specific rule (listed at a higher position on the policy) will focus on the second authentication/authorization
request. This rule condition will look for wireless MAC authentication requests that also contain the Guest Flow flag set in
ISE to indicate that the user was previously authenticated via the portal. This rule is responsible for allowing network
access to the guest user and can include additional attributes that can be sent as part of the access accept message to
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further customize the type of service that will be granted.

As noted before, a client going through the CWA flow will step through a series of authentication/authorization steps. In
Figure 5-66 we can see in the live log from ISE how a user moves through this process. For this reason, being able to
dynamically change the session authorization via CoA messages is critical.

Figure 5-66 CWA Live Logs

The CWA live logs are shown by the operations menu, selected from the top horizontal menu options; the sub-
menu RADIUS and the tab Live logs are selected. The value for misconfigured supplicants, misconfigured network
devices, RADIUS drops, client stopped responding, and repeat counter is displayed. The live logs are displayed in
a table wise data having column headers, time, status, details, repeat, identity, endpoint ID, authentication policy,
authorization policy, and authorization profiles.

After the user enters his or her credentials in the web portal, ISE will issue a CoA to the WLC to modify the previous state
achieved after the first MAB process. The message received by the WLC from ISE can been seen in Example 5-8, and
because it is an unsolicited request, it contains attributes to identify the client whose status needs to be changed.

Example 5-8 debug aaa events enable—CoA

Click here to view code image

*radiusCoASupportTransportThread: Aug 29 19:52:43.858: Received a 'CoA-Request' from
  192.168.100.6 port 62926
*radiusCoASupportTransportThread: Aug 29 19:52:43.858: Packet contains 9 AVPs:
*radiusCoASupportTransportThread: Aug 29 19:52:43.858:     AVP[01] Nas-Ip-Address..
  .........................0x647f640a (1686070282) (4 bytes)
*radiusCoASupportTransportThread: Aug 29 19:52:43.858:     AVP[02] Calling-Station-
  Id.......................68-7f-74-fc-8c-0f (17 bytes)
*radiusCoASupportTransportThread: Aug 29 19:52:43.858:     AVP[03] Acct-Event-
  Time..........................0x5b873ffe (1535590398) (4 bytes)
*radiusCoASupportTransportThread: Aug 29 19:52:43.858:     AVP[04] Message-
  Authenticator....................DATA (16 bytes)
*radiusCoASupportTransportThread: Aug 29 19:52:43.858:     AVP[05] Message-
  Authenticator....................DATA (16 bytes)
*radiusCoASupportTransportThread: Aug 29 19:52:43.858:     AVP[06] Unknown
  Attribute 0......................NULL (0 bytes)
*radiusCoASupportTransportThread: Aug 29 19:52:43.858:     AVP[07] Unknown
  Attribute 0......................NULL (0 bytes)
*radiusCoASupportTransportThread: Aug 29 19:52:43.858:     AVP[08] Unknown
  Attribute 0......................NULL (0 bytes)
*radiusCoASupportTransportThread: Aug 29 19:52:43.858:     AVP[09] Unknown
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  Attribute 0......................NULL (0 bytes)

Profiling

The WLC is enabled with device profiler capabilities that allow it to collect client information that can be sent to ISE via
RADIUS accounting messages. Based on this information, administrators can then apply a policy to the device after its
type is known.

The WLC acts as the collector for two types of packets:

DHCP: The WLC receives a copy of the DHCP_REQUEST packet and parses the information to obtain the
HostName (Option 12) and the Vendor Class Identifier (Option 60). This information is then conveyed to ISE via the
cisco-av-pair: dhcp-option=<DHCP option> RADIUS Vendor Specific Attribute.

HTTP: The first HTTP packet sent from the client will be detected, and the WLC will use the user-agent attribute
from the HTTP header. This information will then be sent to ISE via the cisco-av-pair: http-tlv=User-Agent=<user-
agent> attribute.

To configure this feature, go to WLANs, click the target WLAN ID, go to the Advanced tab, and from there check both
DHCP and HTTP profiling under the Radius Client Profiling section, as shown in Figure 5-67.

Figure 5-67 WLC RADIUS Client Profiling

The WLC RADIUS client profiling shows the WLANs, selected from the top horizontal menu options; the left
pane reads the navigation WLANs, selected by expanding the WLANs. The right pane displays the navigation at
the top, Edit test selected from W LANs. The advanced tab is selected from the five given tabs; under the radius
client profiling, the two checkboxes, DHCP profiling and HTTP profiling are checked.

From Example 5-9, we can see the profiling information from an iPhone device being sent to ISE via an Accounting
message.

Example 5-9 debug aaa events enable—Accounting Message

Click here to view code image

*aaaQueueReader: Jun 02 16:23:14.910: AccountingMessage Accounting Interim:
  0x2c869140
*aaaQueueReader: Jun 02 16:23:14.910: Packet contains 36 AVPs:
*aaaQueueReader: Jun 02 16:23:14.910:     AVP[01] User-
  Name................................user1@wireless.local (18 bytes)
*aaaQueueReader: Jun 02 16:23:14.910:     AVP[02] Nas-
  Port.................................0x0000000d (13) (4 bytes)
*aaaQueueReader: Jun 02 16:23:14.910:     AVP[03] Nas-Ip-
  Address...........................0xac15220a (-1407901174) (4 bytes)
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*aaaQueueReader: Jun 02 16:23:14.910:     AVP[04] Nas-Ipv6-
  Address.........................DATA (16 bytes)
*aaaQueueReader: Jun 02 16:23:14.910:     AVP[05] Framed-IP-
  Address........................0xac15211b (-1407901413) (4 bytes)
*aaaQueueReader: Jun 02 16:23:14.910:     AVP[06] Framed-IPv6-
  Prefix.......................DATA (18 bytes)
*aaaQueueReader: Jun 02 16:23:14.910:     AVP[07] Framed-IPv6-
  Prefix.......................DATA (18 bytes)
*aaaQueueReader: Jun 02 16:23:14.910:     AVP[08] Framed-IPv6-
  Prefix.......................DATA (18 bytes)
*aaaQueueReader: Jun 02 16:23:14.910:     AVP[09] Framed-IPv6-
  Prefix.......................DATA (18 bytes)
*aaaQueueReader: Jun 02 16:23:14.910:     AVP[10] Framed-IPv6-
  Prefix.......................DATA (18 bytes)
*aaaQueueReader: Jun 02 16:23:14.910:     AVP[11] Framed-IPv6-
  Prefix.......................DATA (18 bytes)
*aaaQueueReader: Jun 02 16:23:14.910:     AVP[12] Framed-IPv6-
  Prefix.......................DATA (18 bytes)
*aaaQueueReader: Jun 02 16:23:14.910:     AVP[13]
  Class....................................CACS:ac15220a00000e0b556da83b:
  ise01/222106059/91676 (51 bytes)
*aaaQueueReader: Jun 02 16:23:14.910:     AVP[14] NAS-
  Identifier...........................WLC1 (17 bytes)
*aaaQueueReader: Jun 02 16:23:14.910:     AVP[15] Airespace / WLAN-
  Identifier..............0x00000005 (5) (4 bytes)
*aaaQueueReader: Jun 02 16:23:14.910:     AVP[16] Acct-Session-
  Id..........................556da83e/54:e4:3a:6b:de:ad/3171 (31 bytes)
*aaaQueueReader: Jun 02 16:23:14.910:     AVP[17] Nas-Port-
  Type............................0x00000013 (19) (4 bytes)
*aaaQueueReader: Jun 02 16:23:14.910:     AVP[18] Cisco / Audit-Session-
  Id.................ac15220a00000e0b556da83b (24 bytes)
*aaaQueueReader: Jun 02 16:23:14.910:     AVP[19] Acct-
  Authentic...........................0x00000001 (1) (4 bytes)
*aaaQueueReader: Jun 02 16:23:14.910:     AVP[20] Tunnel-
  Type..............................0x0000000d (13) (4 bytes)
*aaaQueueReader: Jun 02 16:23:14.910:     AVP[21] Tunnel-Medium-
  Type.......................0x00000006 (6) (4 bytes)
*aaaQueueReader: Jun 02 16:23:14.910:     AVP[22] Tunnel-Group-
  Id..........................711 (3 bytes)
*aaaQueueReader: Jun 02 16:23:14.910:     AVP[23] Acct-Event-
  Time..........................0x556dbc52 (1433254994) (4 bytes)
*aaaQueueReader: Jun 02 16:23:14.910:     AVP[24] Unknown Cisco / Attribute
  199............ge-iPhone (9 bytes)
*aaaQueueReader: Jun 02 16:23:14.911:     AVP[25] Unknown Cisco / Attribute
  197............iPhone6,2/8.3 (12F70) (21 bytes)
*aaaQueueReader: Jun 02 16:23:14.911:     AVP[26] Acct-Status-
  Type.........................0x00000003 (3) (4 bytes)
*aaaQueueReader: Jun 02 16:23:14.911:     AVP[27] Acct-Input-
  Octets........................0x001dd836 (1955894) (4 bytes)
*aaaQueueReader: Jun 02 16:23:14.911:     AVP[28] Acct-Input-
  GigaWords.....................0x00000000 (0) (4 bytes)
*aaaQueueReader: Jun 02 16:23:14.911:     AVP[29] Acct-Output-
  Octets.......................0x00212820 (2172960) (4 bytes)
*aaaQueueReader: Jun 02 16:23:14.911:     AVP[30] Acct-Output-
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  GigaWords....................0x00000000 (0) (4 bytes)
*aaaQueueReader: Jun 02 16:23:14.911:     AVP[31] Acct-Input-
  Packets.......................0x000033b8 (13240) (4 bytes)
*aaaQueueReader: Jun 02 16:23:14.911:     AVP[32] Acct-Output-
  Packets......................0x00003196 (12694) (4 bytes)
*aaaQueueReader: Jun 02 16:23:14.911:     AVP[33] Acct-Session-
  Time........................0x00001414 (5140) (4 bytes)
*aaaQueueReader: Jun 02 16:23:14.911:     AVP[34] Acct-Delay-
  Time..........................0x00000000 (0) (4 bytes)
*aaaQueueReader: Jun 02 16:23:14.911:     AVP[35] Calling-Station-
  Id.......................54-e4-3a-6b-de-ad (17 bytes)
*aaaQueueReader: Jun 02 16:23:14.911:     AVP[36] Called-Station-
  Id........................3c-ce-73-d7-28-12 (17 bytes)

ISE will be processing the data and determining the device type based on the profiling policies. In Figure 5-68, we can see
that the rules in the Apple-iPhone Cisco provided policy contain conditions that match the attribute values that were sent
by the WLC, and thus the device will be assigned this profile.

Figure 5-68 Profiling Policy—Apple-iPhone

The Apple iPhone profiling policy is shown by the policy menu selected from the top horizontal menu options; and
the sub-menu profiling is selected. The left pane displays the set of devices android, apple, etc. The Apple iPhone
under the apple device is selected. The right pane shows the navigation at the top, Apple iPhone selected from the
profiler policy list. Under the section profiler policy (all fields are mandatory), the name Apple iPhone is entered in
the field, the checkbox policy enable is selected, the radio button, yes, create matching identity is selected for
identity group for the policy. Under Rules section, the field for If condition reads, Apple-iPhoneRule2Check1 and
Apple-iPhoneRule1Check1. Pointing to both the rule 1 and rule 2, two separate snippets are displayed for the
profiler condition list. Both include the name, description, type, attribute name, operator, attribute value, and
system type. The attribute name of rule 2 and rule 1 shows hostname and user-agent respectively.
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After the device is profiled, its assigned identity group or logical profile can be matched against the conditions in the
Authorization Policy. In Figure 5-69 you can see how the device, now that it’s profiled, will match on the iPhone_Devices
rule and get assigned the iPhone_RestrictedAccess permissions.

Figure 5-69 Authorization Rule—Apple-iPhone

Wireless Device Administration via ISE

We can use the Device Administration service in ISE to authenticate administrators wanting to gain management access to
WLCs and Cisco Prime Infrastructure.

The first step is to navigate to Work Centers > Device Administration > Network Resources to add the WLCs and PI as
network devices in ISE providing the TACACS+ settings, as shown in Figure 5-70. It’s important to note that each type of
platform requires different attributes back from ISE when performing authentication; thus it is recommended to group
devices together at minimum by type. (In this example we would use two: WLCs and Prime Infrastructure [PI].)
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Figure 5-70 Adding WLC and PI as ISE Network Devices

The settings to add WLC and PI as the ISE network device is shown by the policy menu selected from the top
horizontal menu options; the sub-menu device administration is selected; and below the tab network resources is
selected. The network devices of the left pane show the settings of it in the right pane. It includes various fields
like name, description, IP Address etc and the following are highlighted. Under the network device group, the
device type is selected WLCs from the drop-down and under the TACACS authentication settings, the shared
secret field is entered and a show button is shown on the right.

Next, we need to navigate to Work Centers > Device Administration > Policy Results > TACACS Profiles and define
the TACACS+ profiles that will be used in the Authorization Policies.

WLCs use custom attributes that need to be defined as roles. The available roles are MONITOR, WLAN,
CONTROLLER, WIRELESS, SECURITY, MANAGEMENT, COMMAND, ALL, and LOBBY. As shown in Figure
5-71, these roles are already available as common tasks in ISE, so you just need to enter one or more roles that you
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want to give access to.

Figure 5-71 TACACS+ Profile for WLCs

The WLCs TACACS plus profile shows the main menu work centers, selected from the menus at the top; the
sub-menu device administration is selected; and below, the tab policy elements is selected. The TACACS
profile is selected by expanding the results in the left pane. The right pane shows the navigation at the top,
WLC ALL selected from the TACACS profiles. It includes two sections TACACS profile and common tasks.
The TACACS profile shows the name and description that are to be entered; followed by two views are
shown, task attribute view (selected) and raw view. The common task section displays a drop-down for
common task type and the all radio button is selected.

PI uses the concept of role and task attributes that are specific per user group. These attributes, which are available on
PI at Administration > Users > Users, Roles & AAA > User Groups would need to be exported and imported into
the TACACS Profiles within ISE, as shown in Figure 5-72.
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Figure 5-72 TACACS+ Profile for PI

The PI TACACS plus profile shows the main menu work centers selected from the menus at the top; the sub-
menu device administration is selected; and below, the tab policy elements is selected. The TACACS profile is
selected by expanding the results in the left pane. The right pane shows the navigation at the top, PI root
selected from the TACACS profiles. It includes two sections TACACS profile and profile attributes. The
TACACS profile shows the name and description that are to be entered; followed by two views are shown,
task attribute view and raw view (selected). The profile attributes section displays a list of tasks with its
attributes. This task area points to a CISCO prime infrastructure window that has a title
administration/users/users, roles and AAA. The left pane of this window selects the option user groups and its
respective tasks lists are given on the right pane of it.

At this point we can start creating our Device Admin Policy like the one shown in Figure 5-73. By default, Policy Sets are
enabled to allow organizing policies more easily. In this example the policy set Wireless will be used for devices belonging
to the WLCs or PI device groups, as defined by the policy set rules. Inside this set, we can see that authentication is
configured to use Active Directory exclusively (it could have been any of the supported identity sources). Finally, the
Authorization Policy is set up in a way that users belonging to Active Directory Group1 will have full access to both PI and
WLCs, and users belonging to Group2 will have only monitoring access to the WLCs.
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Figure 5-73 Wireless Admin Policy

The wireless admin policy shows the main menu 'work centers' selected from the menus at the top; the sub-menu
device administration is selected; and below, the tab device admin policy sets is selected. The content pane reads
the policy sets at the left pane that contains the summary of policies and global exceptions. The right pane shows
the wireless status with a tick mark followed by four sections, proxy server sequence, authentication policy,
authorization policy, and exceptions. The status of the default rule is ticked in authentication policy and the rule
name WLC ALL, WLC monitor, PI root, and Tacacs_default are ticked in standard section of exceptions.

Although this scenario was simple, the policies could be configured to leverage many more attributes in the rule conditions
to meet the security policy of the organization with regard to who gets access to manage the different infrastructure
devices.

Summary

Because the Cisco Identity Service Engine is such a flexible and feature-rich platform, trying to cover every little feature
and detail within the boundaries of a single section of book is impossible. As such, the purpose of this chapter was to
provide you with sufficient understanding of how things interact, common flows, and how policies get structured. Having
this base knowledge, along with sufficient hands-on practice, will allow you not only to increase your experience but to
also develop the creativity required to come up with solutions that meet different use case requirements that you might
encounter during your CCIE studies or as part of your day-to-day job responsibilities.
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Chapter 6

Prime Infrastructure and MSE/CMX
Management tools are becoming more and more important for installing and maintaining any type of network. Although you may get personal
satisfaction from configuring SSIDs, RF parameters, and debugging logs through convoluted AP and WLC command lines, a proper
management system can perform all those tasks faster, and at a large scale. On top of standard configuration tasks, management tools also have
the advantage of centralizing data from different sources and providing common features to troubleshoot, alert, and log information from
heterogeneous systems.

Listing every feature of the Cisco Prime Infrastructure management system would probably require a book of its own. Nevertheless, this chapter
should provide you with all the information about its major capabilities, as well as its complementary solution for specific WLAN services, like
location and analytics, which is Cisco Connected Mobile Experiences (CMX).

Managing the Management

Accessing the graphical user interface (GUI) is the first task you need to complete to start using Cisco Prime Infrastructure, and differentiated
access for administrator groups and privilege levels assignment are among the first requirements of a management tool. A more common
definition for this type of feature also goes under the name of multitenancy. As you will see in the next paragraphs, Cisco Prime Infrastructure
can provide some kind of user control capabilities through authentication and authorization services, as well as separated access to network
device groups and sites through the notion of virtual domains, although not quite full multitenancy options.

Authentication and authorization define the menus and tasks that an administrator can access, and a virtual domain defines the group of network
devices on which the administrator can run those tasks.

You may have already guessed that the most basic form of administrative authentication and authorization is through local accounts. A local
account is simply a sequence of username and a password, stored in Prime Infrastructure’s local database, which you can map to a group. A
group, or role, defines the privileges of an administrator account, hence determining menus that an administrator with that specific role can
access. In Prime Infrastructure you can find the full list of predefined groups under Administration > Users > Users, Roles & AAA > User
Groups, which is shown in Figure 6-1.

Figure 6-1 User Roles

The predefined groups of user roles read the navigation administration, users, users roles and A A A at the top. The left panes show the
option user group selected and the right pane reads the title user groups having a table like data with the column headers group name,
members, audit trail, and view task.

On top of predefined groups with their preconfigured tasks privileges, you can also customize up to four user-defined groups.

Cisco Prime Infrastructure supports authentication of administrator accounts through external RADIUS or TACACS+ servers. The goal of such
servers is not just to validate logins and passwords against external databases but also to assign groups and privilege levels for accessing specific
tasks. An authentication server achieves this by including additional attributes in the RADIUS and TACACS+ response. It is those attributes that
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contain the values that tell Prime Infrastructure to what group the authenticated user belongs, as well as the tasks that the user has access to for
TACACS+.

All this may sound similar to what you can implement with authorization commands and TACACS+ on switches, for example. However, menus
and features that you access through the GUI in Prime Infrastructure do not have their equivalents through the command line. For that reason,
we cannot literally refer to “command” authorization on Prime Infrastructure, but rather to menus and tasks authorization.

When authenticating administrators via RADIUS, Prime Infrastructure uses the value [1] Login in the RADIUS attribute [6] Service-Type. This
attribute allows you to identify RADIUS requests from Prime Infrastructure and to configure your authentication policies on the RADIUS server
accordingly.

The attribute used to assign a group in the RADIUS response is the Cisco Attribute Value Pair (AVP), using the following format: cisco-av-
pair=NCS:role0=[GROUP_NAME].

For TACACS+, the authentication server should return a shell profile containing all the attributes for authorizing the corresponding group and
privileges.

To understand which value(s) to use in RADIUS and TACACS+ attributes, you can browse to Administration > Users > Users, Roles & AAA
> User Groups and click the Task List option under the column View Task for the corresponding user group, similarly to what is shown in
Figure 6-2.

Figure 6-2 Attribute Values for User Groups

The user groups attribute value window reads the navigation administration, users, users roles and A A A at the top. The left pane shows
the option user group selected and the right pane reads the title task list and two boxes for TACACS plus custom attributes and RADIUS
custom attributes are shown.

For RADIUS, the attribute NCS:role0 is enough in the final response for Prime Infrastructure to assign the corresponding group, whereas for
TACACS+ you need to copy and paste all the attributes in the authentication server’s shell profile.

You can find all the steps to configure user authentication through an external server in the official administration guide:

https://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/infrastructure/3-
2/admin/guide/bk_CiscoPrimeInfastructure_3_2_AdminGuide/bk_CiscoPrimeInfastructure_3_2_AdminGuide_chapter_0110.html#concept_0D963A6D507940C7B4E6534950F490A1

Note

When enabling authentication through an external RADIUS or TACACS+ server, a general recommendation is to also enable fallback to local
accounts in case of no response from the server or even authentication failure. This could help prevent locking yourself out, at least during an
initial testing phase.

You can configure such a feature under the menu Administration > Users > Users, Roles & AAA by activating the option Enable Fallback to
Local and setting it to On Authentication Failure or No Server Response. This option still allows a user to be authenticated to the internal Prime
Infrastructure’s database, even if the RADIUS/TACACS+ server sends back a reject. The other option, ONLY on No Server Response, causes
the authentication to fail and the user to be locked out if the RADIUS/TACACS+ server rejects the authentication.

If groups and roles provide privilege levels for performing specific administrative tasks, virtual domains allow restricting those monitoring and
configuration tasks to groups of specific network devices.
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When you create a new virtual domain, Prime Infrastructure presents you with the option to configure which site maps, groups of network
devices, access points, and so on belong to it. Independently of how you choose to call a group of network devices, all those options in the end
refer to the set of switches, access points, and the like that a user assigned to that particular virtual domain will be able to operate.

You can configure virtual domains under the menu Administration > Users > Virtual Domains.

One of the first conceptual associations we tend to do is that virtual domains can provide multitenancy capabilities end customers often ask for,
which in some ways is true. On the other side, specifically for wireless deployments, you may have already encountered a common question:
How can we differentiate administrative access so that, for example, some users can configure SSIDs and RF parameters only for a particular
subset of access points? The short answer is that we cannot. Virtual domains can provide access to a restricted subset of access points, this is
true. However, as long as an access point managed by a WLC is in the virtual domain, users from that virtual domain (with the right
configuration privileges) will also be able to create any type of SSIDs on the corresponding WLC, which could then be pushed to any other
access points attached to that very same WLC.

A good use of virtual domains for wireless deployments is usually to provide differentiated visibility of access points by building or floors, for
example. Users of a specific office can then access a dedicated view of their office’s access points only (please note again the term view here).

As for administrative authentication and authorization, you can assign a virtual domain to users either by specifying the virtual domain they
belong to when creating a local account or by dynamically assigning that virtual domain using RADIUS or TACACS+ attributes.

When creating a local account, it is mandatory to specify its corresponding virtual domain, and when authenticating a user through an external
RADIUS or TACACS+ server, it is also mandatory to send back a RADIUS or a TACACS+ attribute specifying a valid virtual domain. Failing to
do so will cause an authorization failure on Prime Infrastructure.

You can find the corresponding virtual domain attributes for RADIUS and TACACS+ under the menu Administration > Users > Virtual
Domains by clicking on the option Export Custom Attributes on the top right of the page. Figure 6-3 shows an example of a virtual domain’s
custom attributes.

Figure 6-3 RADIUS and TACACS+ Custom Attributes for Virtual Domains

Putting authentication, group assignment, and virtual domains together, if you had to authorize users belonging to the group System Monitoring
and push the virtual domain Office1, the following would be an example of the two RADIUS attributes you would need to send back to Prime
Infrastructure in the final Access-Accept response:

Click here to view code image

cisco-av-pair = NCS:role0=System Monitoring
cisco-av-pair = NCS:virtual-domain1=Office1

Basic Operations

Although the features and operations described in the following paragraphs are introduced as “basic,” they still represent the foundation for
properly working with Cisco Prime Infrastructure. CCIE Wireless candidates may find them crucial to speed up workflows during the lab exam
too.

Working with Devices, Templates, and Audits

After having established how to manage administrative access to the management tool, one of the next steps is to use it for managing network
devices. In Prime Infrastructure, you can configure a WLC through pages with a similar look and feel as the WLC’s GUI. However, one of
Prime Infrastructure’s main advantages is to push multiple configuration changes at once to multiple WLCs; such a task can be achieved
through the configuration templates.

Prime Infrastructure communicates with the WLC through SNMP. A WLC can send SNMP traps to Prime Infrastructure, or NetFlow records
too for Application Visibility and Control (AVC) statistics. Even though Prime Infrastructure optionally asks for credentials to access a WLC via
telnet/SSH/HTTPS when adding the WLC to the list of managed devices, these credentials are not needed: all monitoring operations,
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configuration changes, and even traps from the WLC take place via SNMP.

Common best practices when configuring SNMP communication between a WLC and Prime Infrastructure include the following:

Use SNMPv3 whenever possible, disable SNMPv1/v2c, and remove all communities on the WLC.

If SNMPv3 is not an option, use SNMPv2c, disable SNMPv1, and change the default communities with strong keywords and very selective
subnet filtering.

Keep unused SNMP trap controls disabled on the WLC.

Use CPU ACLs on the WLC to restrict traffic from unneeded sources, which are not Prime Infrastructure or other network resources (more
on this on Chapter 4, “AireOS Appliance, Virtual, and Mobility Express Controllers”).

To accelerate the process of importing multiple network devices sharing the same SNMP configuration and credentials, Prime Infrastructure
supports credential profiles. You can create a credential profile under Inventory > Device Management > Credential Profiles and specify just
once the SNMP parameters, as well as telnet/SSH and HTTP/HTTPS credentials if needed; when adding a network device to Prime
Infrastructure, you can then select a previously configured credential profile instead of retyping the parameters every time.

On top of using credential profiles, you can also import multiple network devices in parallel, through a CSV file containing the same values (IP
address, SNMP parameters, CLI credentials, and so on) that you would use to add those devices through the GUI.

After having added a WLC, you can apply configuration changes either through the view of the WLC itself in Prime Infrastructure or through
templates. The latter is usually one of the main reasons to use Prime Infrastructure instead of going directly through the WLC’s GUI. Templates
are a set of configuration tasks for specific features, which can be applied to one or more WLCs in parallel. You can create configuration
templates for the WLC under the menu Configuration > Templates > Features & Technologies by browsing to the different categories under
Features and Technologies > Controller in the Templates list. On top of WLC templates, you can also push templates for autonomous and
lightweight access points, under the menus Configuration > Templates > Autonomous Access Points and Configuration > Templates >
Lightweight Access Points, respectively.

You can deploy templates right away or schedule them for predetermined times and dates. This option enables you to address requests, such as
enabling specific AP radios only during certain times of the day, through a Lightweight Access Points template, for example. You can find back
scheduled AP templates and other tasks under the menu Configuration > Templates > Scheduled Configuration Task.

Note

You can schedule AP templates to enable or disable specific AP settings; however, WLC configuration templates might cause a full
reconfiguration of elements (WLANs, ACLs, RADIUS servers, and so on) that already exist. For specific needs, such as scheduling the
activation or deactivation of a WLAN during certain times of the day, you can rely on scheduled tasks. You can access this through the WLC’s
configuration directly, under Configuration > Network > Network Devices and then by clicking your WLC. Under Configuration > WLANs
> WLAN Configuration you can check the box for the WLAN you want to schedule and click the Schedule Status option. To plan the
activation of an SSID during specific times of the day, for example, you will have to schedule the status twice: one for the activation and one for
the deactivation.

Aside from manually creating new templates, if you already configured any objects or features on the WLC before adding it to Prime
Infrastructure, you can also automatically create a template for each already configured element (WLANs, RF profiles, ACLs, and so on). This
process goes under the name of templates discovery, and you can launch it from the menu Monitor > Managed Elements > Network Devices
by selecting the category Wireless Controller in the left panel for Device Groups, then selecting your WLC in the list and clicking Configure >
Discover Templates from Controller through the option on the top right of the menu. Figure 6-4 shows an example of templates discovery in
Prime Infrastructure.

Figure 6-4 Templates Discovery Option from a WLC

Chapter 6 Prime Infrastructure and MSE/CMX

334

Technet24
||||||||||||||||||||

||||||||||||||||||||

file:///C:/Users/MERRELL/Documents/eBook Converter/Oreilly Downloader/tmp/9780135162095/ch04.xhtml#ch04
file:///C:/Users/MERRELL/Documents/eBook Converter/Oreilly Downloader/tmp/9780135162095/ch04.xhtml#ch04
file:///C:/Users/MERRELL/Documents/eBook Converter/Oreilly Downloader/tmp/9780135162095/ch06.xhtml#ch06fig04
https://technet24.ir
https://technet24.ir
https://technet24.ir


The discover templates from controller option in WLC shows the navigation monitor, managed elements, network devices at the top.
The left pane contains all the devices, types and location. The right pane reads the title device groups or device type  wireless controller
with various options followed by, it displays a forward button (selected and highlighted) is clicked, displays a popup with three options,
one of the options configure is selected and clicking on that another popup is displayed and the discover templates from controller is
selected.

After you have discovered configuration templates from a WLC, you will be able to reapply those templates and features to other WLCs, either
one by one or by groups, through the Wireless Configuration Groups. You can create configuration groups under Configuration > Wireless
Technologies > Wireless Configuration Groups and specify either manually created or discovered templates.

After configurations have been deployed, you can keep track of potential changes through auditing options. Under the menu Inventory >
Device Management > Network Audit you can retrieve almost real-time logs on network changes, or you can also find them through the
Reports > Report Launch Pad, under Compliance > Change Audit. For more proactive auditing, you can also enable notifications via syslog
as changes occur; such an option is available under Administration > Settings > System Settings > Mail and Notification > Change Audit
Notification.

Operating Maps

Another major interest of operating your Cisco wireless deployment through Prime Infrastructure is the additional visibility into your RF
environment, rogue APs, clients, and so on when using maps.

Fundamentally, a map is a floor plan where you can place your APs. In Prime Infrastructure’s internal hierarchy and configuration, a floor needs
to be part of a building, which can optionally be part of a campus. You do not need to import images for campuses and buildings, but you should
import background images for floor plans before starting to place APs. When configuring dimensions for campuses, buildings, and floors, the
default scale unit is in feet. You can change this to meters under the menu Maps > Wireless Maps > Site Maps ( New! ) by selecting your
campus and then the option Units of Measure through the Map Properties gear icon on the top right of the page.

Note

No matter whether you scale maps in Prime Infrastructure in feet or meters, when importing them in Cisco CMX (more on this in the next
sections) CMX will initially scale them in feet.

Among the final steps of a map creation, Prime Infrastructure asks you to launch the map editor to rescale the map with a ruler tool, define
obstacles, zones, GPS markers, and other properties. The following are best practices for most deployments: scaling maps is key for location
calculations in CMX, and although obstacles do not affect calculations for location services, they do improve the accuracy of RF heatmaps.

On top of obstacles, you might also want to add at least three GPS markers from the beginning, even before starting to place APs on the map.
These GPS coordinates are exported with the map properties when working with CMX and will be available in the CMX APIs. When
development teams retrieve GPS markers from a map and the client’s location coordinates on that map, they are therefore indirectly able to
calculate the GPS position of the client too.

After having configured all the necessary maps, placing and orienting APs may be considered one of the most boring and repetitive tasks in the
daily job of a wireless expert. Nevertheless, the precision and commitment you apply in such a task will determine the accuracy level of RF
predictions, clients’ location, rogue APs location, and so on. APs can be placed on a map only if they have registered to a WLC managed by
Cisco Prime Infrastructure at least once, even if for a short period of time, and even if the APs were taken offline right after the registration.
Prime Infrastructure needs to “see” them once. This can facilitate deployments where you need to send APs to site relatively quickly while
carrying on working proactively on their placement before the team on site installs them. You can, for example, register APs to your WLC in the
lab, or other prestaging facility, get them “seen” by Prime Infrastructure, and then unplug them to send them to site. While APs are on their way
to the final deployment site, you can keep working on their placements on the maps. Placing and orienting APs on maps does not affect any
configuration or Radio Resource Management (RRM) calculations on the WLC. An APs’ placement is used by Prime Infrastructure to predict
RF heatmaps, and by CMX to calculate location coordinates.

When positioning an AP on a map in Prime Infrastructure, one setting can be changed and pushed to the WLC’s configuration for that AP: the
antenna model selection. If you specify the antenna model from the AP’s positioning options (see Figure 6-5), Prime Infrastructure will
automatically push the antenna to gain configuration to the WLC. This particular behavior is present with what we will refer to as the “old”
generation of maps under Maps > Wireless Maps > Site Maps (Deprecated), and you can see a quick example of it in Figure 6-5.
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Figure 6-5 Antenna Model Selection for Old Generation Maps

The old generation map antenna type is shown AIR-ANT2566P4W-R-5GH from the drop-down; the antenna or AP image is shown; the
antenna orientation shown in azimuth angle is 90 degrees; and the elevation angle is 0 degree up.

Version 3.2 of Prime Infrastructure introduced a “new” generation of maps, as shown in Figure 6-6, which do not push the antenna gain to the
WLC when the antenna model is configured, while placing an AP on a map. You can access new generation maps under Maps > Wireless
Maps > Site Maps (New!).

Figure 6-6 Antenna Model Selection for New Generation Maps

The new generation map shows the path maps/wireless maps/site maps at the top. The antenna type is shown AIR-ANT2566P4W-R-
5GHz with a dual band 2.4 or 5 gigahertz dipole and the dipole of gain 6 decibels relative to isotropic radiator. The azimuth angle reads
90 degrees and elevation 0.

However, if you still use the old generation of maps, also available in version 3.2 (or any previous version up to 3.1.x), modifying the antenna
model when placing the AP on a map also pushes that configuration to the WLC. Another common technique for configuring an antenna model,
both on Prime Infrastructure’s maps and on the WLC, is to create a Lightweight Access Points configuration template, where you can configure
the antenna models under the 802.11a/n/ac and 802.11b/g/n tabs.

Along with AP placement, antenna orientation is the other essential operation for obtaining realistic heatmaps and accurate clients, interferers,
and rogue APs location on maps.
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When orienting an antenna, keep in mind some rules to help you:

For the vast majority of installations, you might need to configure the orientation of both antennas, on the 2.4 GHz and on the 5 GHz radios.
If one radio is disabled, you might want to ignore its orientation; however, it is recommended that you orient all antennas, even those that
are disabled, just in case you enable them in the future.

There are two orientations for each antenna: azimuth and elevation. Azimuth is the antenna orientation viewed from above, and elevation is
the antenna orientation viewed from the side. You can visualize the orientation of an antenna as an arrow, which you can represent in
different ways, depending on the type of antenna.

When configuring orientations, you should first position the azimuth and then the elevation; such an order is logically easier to follow.
Therefore, you can first imagine orienting the antenna’s arrow as viewed from above and then as viewed from the side.

For APs with internal antennas, the orientation is represented by an arrow beaming from the middle of the AP (where you can often see the
Cisco logo or the LED) and pointing toward the upper side of the AP, and toward where all the Ethernet ports are for the vast majority of
indoor AP models up to the 1800/2800/3800 series, as shown in Figure 6-7, for example.

Figure 6-7 Antenna Orientation for APs with Internal Antennas

By default, Prime Infrastructure orients an AP with internal antennas with an azimuth of 90 degrees and an elevation of 0 degrees. This
corresponds to an AP mounted with the upper side of the Cisco logo pointing south (toward the lower part of the floor map) and the Cisco logo
facing down to the ground. It’s the typical installation of an AP on the ceiling, and Figure 6-8 shows an example of such an orientation in Prime
Infrastructure.

Figure 6-8 Antenna Orientation for a 3700 Series AP on the Ceiling with the Upper Side of the Cisco Logo Pointing South and Its
Ethernet Ports Facing South Too

The antenna orientation in the application shows the navigation maps/wireless maps/site maps. The orientation on the ceiling with the
upper side of the CISCO logo pointing south and its ethernet ports facing south. The antenna type is shown Internal-3700-5GHz;
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integrated 3700i Omni antenna with a dipole gain of 6 decibels relative to an isotropic radiator. The azimuth angle reads 90 degrees and
elevation 0.

Omnidirectional antennas, as their name suggests, radiate in all directions. Therefore, suppose the real azimuth of an AP with internal
omnidirectional antennas is different from what you configured on the map. For example, you may have wrongly configured an azimuth of 180
degrees (the Ethernet ports show as facing west, while actually mounted facing south). Despite this difference, the heatmap prediction or
location services should still be accurate, precisely because of the omnidirectional nature of the antennas. Nevertheless, we recommend making
the extra effort of configuring both azimuth and elevation to reflect the real antennas’ orientations.

This care in antenna orientation is especially important for APs and antennas mounted on walls. For example, suppose that an AP with
omnidirectional antennas is vertically mounted on an east wall, with the Cisco logo facing west and the Ethernet port(s) facing up to the ceiling.
You should configure an azimuth of 180 degrees (that is, first the arrow pointing left, as viewed from above) and an elevation of 90 degrees (that
is, the arrow pointing up as viewed from the side), as shown in Figure 6-9.

Figure 6-9 Antenna Orientation for an AP on an East Wall with the Cisco Logo Facing West

The antenna orientation in the application shows the navigation maps/wireless maps/site maps. The orientation for an AP on an east wall
with the CISCO logo facing west. The antenna type is shown Internal-3700-5GHz; integrated 3700i Omni antenna with a dipole gain of
6 decibels relative to an isotropic radiator. The azimuth angle reads 180 degrees and elevation angle reads 90.

For external dipole omnidirectional antennas (AIR-ANT2524DB-R, AIR-ANT2524DG-R, and AIR-ANT2524DW-R), you should think of
the arrow as perpendicular to the longitudinal axis of the antenna and to either of its “flat” sides. By default, Prime Infrastructure orients
external dipole antennas with an azimuth of 90 degrees and an elevation of 0 degrees. This corresponds to the antenna’s tip pointing down
to the ground and either of its “flat” sides parallel to the X axis of the map. When using external antennas, the AP orientation does not
matter, because only the external antenna’s installation and orientation determines the coverage area.

As an example, a dipole antenna with an azimuth of 0 degrees and an elevation of 45 degrees corresponds to the “donut” shape coverage
area tilted down to the left, when looking at it from the south side of the map. You can see an example of this configuration in Figure 6-10.
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Figure 6-10 Dipole Antenna Orientation with an Azimuth of 0 Degrees and an Elevation of 45 Degrees

The antenna type shown in the screenshot is "AIR-ANT2524DB-R-5GHz" and dual-band of frequency 2.4 to 5 GigaHertz, and
dipole of gain 4 dbi. A map shows the coverage area tilted down to the left facing from the south side.

Another example, as shown in Figure 6-11, could be a dipole antenna with an azimuth of 0 degrees and an elevation of −45 degrees, which
corresponds to the “donut” shape coverage area tilted down to the right when looking at it from the south side of the map.

Figure 6-11 Dipole Antenna Orientation with an Azimuth of 0 Degrees and  an Elevation of −45 Degrees

The antenna type shown in the screenshot is "AIR-ANT2524DB-R-5GHz" and dual-band of frequency 2.4 to 5 GigaHertz, and
dipole of gain 4 dbi. A map shows the coverage area tilted down to the right facing from the south side.

In the previous examples, to get an elevation of −45 or 45 degrees in the actual installation, you will have to turn the dipole in such a way
that the antenna’s bolt will allow you to tilt it. The arrow orientation does not change between one side and the other, because you are
dealing with an omnidirectional antenna.

External patch-like antennas (AIR-ANT2524V4C-R, AIR-ANT2566P4W-R, AIR-ANT2566D4M-R, and AIR-ANT2513P4M-N) have an
orientation arrow originating from the center of the antenna’s plate, perpendicular to the plate (pointing away). By default, Prime
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Infrastructure orients such antennas with an azimuth of 90 degrees and an elevation of 0 degrees, as shown in Figure 6-12. This means that
the antenna is vertically mounted, with the plate facing south and its cables (for example, for an AIR-ANT2566P4W-R) pointing down to
the ground (the orientation arrow points south as well).

Figure 6-12 Patch Antenna Orientation with an Azimuth of 90 Degrees and an Elevation of 0 Degrees

The vertically mounted antenna type shown in the screenshot is "AIR-ANT2566P4W-R-5GHz" and dual-band of frequency 2.4 to
5 GigaHertz, and dipole of gain 6 dbi. The plate of the antenna is facing south, and its cables are facing to the ground, and a map
beside shows the coverage area of the antenna.

Similarly, an AIR-ANT2566P4W-R with an azimuth of 90 degrees and an elevation of −90 degrees, as in Figure 6-13, would be mounted
with its plate facing down to the ground and the cables’ side pointing north: the orientation arrow in such a case would point down to the
ground too. This would correspond to an antenna horizontally mounted, on the ceiling for example, with its cable connectors pointing north
on the map.

Figure 6-13 Patch Antenna Orientation with an Azimuth of 90 Degrees and an Elevation of −90 Degrees

The horizontally mounted antenna type shown in the screenshot is "AIR-ANT2566P4W-R-5GHz" and dual-band of frequency 2.4
to 5 GigaHertz, and dipole of gain 6 dbi. The plate of the antenna is facing to the ground, and its cables are facing to the north, and
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a map besides shows the coverage area of the antenna.

Even though antenna orientations may not sound very intuitive at the beginning, one of the best ways to get a consistent grasp on them is to try
out different combinations in Prime Infrastructure and check how the predicted heatmap varies accordingly.

Note

With the old generation of maps, elevation values could go from 0 to 90 degrees, with an extra orientation of UP or DOWN. With the new
generation of maps, elevation values range from −90 to 90 degrees. The supported orientations are the same: 0 to 90 degrees DOWN in the old
generation maps correspond to 0 to −90 degrees with the new generation and, in a similar way, 0 to 90 degrees UP in the old generation maps
correspond to 0 to 90 degrees with the new generation maps.

High Availability

For additional redundancy and availability, you can deploy Prime Infrastructure servers as HA pairs: the high availability model is always with
two servers, one active and one standby. The monitoring and synchronization services between primary and secondary servers are SSL based
and run on TCP ports 1522 (Oracle/JDBC database connections) and 8082 (health monitoring via HTTPS). The two servers need IP
reachability, of course, and if you choose to deploy them on the same VLAN, you have the option of configuring a Virtual IP for the HA pair.
This option usually has the advantage of letting you point your network devices to one single management IP for SNMP traps and syslog, for
example. Each Prime Infrastructure server will keep using its real management IP to source all other traffic to those network devices.

If you choose to deploy Prime Infrastructure servers on different subnets or not to configure a Virtual IP, you need to make sure that network
devices are sending SNMP traps and syslog messages to the IPs of both servers, not to lose data in case of failover.

You have the option of two failover modes, manual or automatic, both having their pros and cons. Manual failover, as the word says, does not
have the advantage of automatic recovery if the active server fails. However, this mode could also avoid “split brain” scenarios where each
server automatically promotes itself to active because of a network reachability failure. Manual mode also avoids the issue of continuous
failover because of potential network latency issues between both nodes.

The high availability configuration is relatively straightforward and can be followed through the official administrator’s guide:

https://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/infrastructure/3-
2/admin/guide/bk_CiscoPrimeInfastructure_3_2_AdminGuide/bk_CiscoPrimeInfastructure_3_2_AdminGuide_chapter_01010.html#con_1104574

On top of the official guide, as a quick review of the requirements to keep in mind when setting up high availability for Prime Infrastructure,
here are the main steps you should consider:

Plan the high availability deployment model by choosing between having a Virtual IP for your pair of Prime Infrastructure servers or
keeping your servers reachable on their respective IP addresses if they cannot be deployed on the same subnet.

Verify that both your primary and secondary servers will be installed with the very same software versions, patches, and packages.

After the primary server’s installation, while installing the secondary server, verify that you specify the option for this server to be used as a
secondary for HA, and note down the authentication key that you will be asked right after this step: you will be asked for this key on the
primary server when activating HA.

After installing the secondary server and updating it, if needed, to the same version/patch/device bundle as the primary, on the primary
itself, you can activate high availability through the HA Configuration tab under Administration > Settings > High Availability. You will
be asked for the secondary server’s information, such as FQDN/IP and authentication key, as well as for options such as the Virtual IP or
the failover mode (for example, manual versus automatic).

The high availability setup itself might take some minutes, after which you will be able to connect to your Prime Infrastructure pair either
through the Virtual IP, if you chose to enable such an option, or through the primary or secondary server’s IP, depending on which one is active
at a given time.

Monitoring Tools: Troubleshooting Clients and Working with Reports, Alarms and Events, and Notifications

Along with managing network devices and configurations, another main goal of Prime Infrastructure is to provide network administrators with
troubleshooting and reporting tools. Although CCIE-level experts will prefer debugs on the WLC or AP, in daily network operations having a
centralized tool with data from different sources could be an easier starting point to isolate issues.

Comparing troubleshooting methodologies is not the primary goal of this book, but as a general guideline, one of the fastest and easiest options
for looking up a client’s details (or any other device’s details) in Prime Infrastructure is through the contextual search field on the top right of
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the GUI, as shown in Figure 6-14. As soon as you start typing a username, a MAC address, an IP address, and the like, Prime Infrastructure
suggests any elements that are possibly related to what you are typing. This is an easy way to immediately jump to a client’s details, instead of
having to navigate through a list of clients under Monitor > Monitoring Tools > Clients and Users and then filtering through specific values.

Figure 6-14 Contextual Search Field

A screenshot shows the "Contextual Search Field" window. It displays the list: Alarm (22), Clients (4), Config Archives (15), Devices
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(2), and Menus (40). At the top, it shows a search box, and at the bottom, it shows Advanced Search (option), and View All (button).

Client details are organized in different tabs, to also provide additional logs and tools from other resources on top of Prime Infrastructure. The
Overview tab consolidates information mainly from the WLC, with some details from Cisco ISE and CMX if you have integrated such solutions
to Prime Infrastructure. Although these details are not in real time (as compared to WLC or AP CLI debugs), they are still a good starting point
for a high-level view of policies applied to the client, for example, and in particular, to understand through which APs the client associated and
disassociated (thanks to the Association History widget). Even though this is technically not a location feature, the association history might in
some cases indirectly help you trace a client’s path at some levels, or even isolate whether clients are “jumping” between APs too far from one
another. Complementary to these types of data, the Statistics widget, showing the client’s RSSI and SNR history, could provide useful
information if your clients were experiencing radio or coverage issues, for example.

The Location tab integrates data retrieved through the former location solution Mobility Services Engine (MSE). Prime Infrastructure also
supports integration with CMX 10.3 to locate wireless clients and interferences on the maps. However, location information in the client’s
details (page) is available only with MSE 8.0. On top of displaying the specific portion of the floor plan, where a client is located, this page also
allows you to replay the client’s location history.

Right next to location data, Prime Infrastructure also hosts a dedicated tab for reporting authentication successes and failures from ISE. From
this page, you can directly monitor failure reasons and, although Prime Infrastructure displays only the main reason for the failure, you can also
cross-launch the monitoring page on ISE directly to look at all the failure’s details. When adding ISE to Prime Infrastructure, you should keep in
mind the following prerequisites:

Prime Infrastructure communicates with the ISE server(s) persona running the Monitoring services.

In case of a standalone ISE server, you can add that single ISE server to Prime Infrastructure.

In case of a distributed ISE deployment, you should add the primary monitoring node, and the secondary too, if you want to keep collecting
authentication logs in case of a failover of the primary monitoring node.

The ISE account required by Prime Infrastructure needs to have access to the Operations tab in ISE and be part of the MnT Admin group or
higher, such as the Super Admin group.

Aside from authentication logs in a dedicated tab, Prime Infrastructure also displays the policies applied by ISE during the authentication
process in the client’s Overview tab. These could provide you with very useful information, such as the Authorization Profile, the Posture
Status, the TrustSec Security Group, and others. Figure 6-15 shows some additional examples of tabs for client troubleshooting.

Figure 6-15 Client Details, Overview, Troubleshooting, and Other Tabs

The screenshot displays tabs such as Overview (selected), Location, ISE, Troubleshoot and Debug, Syslog, Clean Air, Events, RTTS,
and more. Under the "Overview" tab it shows a connection below the "Attributes" option. At the bottom, it displays General, Session,
and Security details.

Other tabs providing more hints on the overall client’s connection status are those for Clean Air and Events, but note that these are not
necessarily in the same order as in the (WLC’s) GUI. These pages contain information about potential interferences affecting the AP where the
client is connected, as well as the most recent SNMP traps (that is, events) from the WLC concerning that AP and the client.

Prime Infrastructure also has dedicated tabs for collecting and reading logs and debugs from the WLC for a specific client that you are
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monitoring. These are the Troubleshoot and Debug, Syslog, and RTTS (Real Time Troubleshooting) tabs. As a CCIE candidate, you will
probably prefer to use CLI debugs and commands on the WLC and AP directly. Nevertheless, these tabs find their purpose for network
operations teams, who can collect some initial data and open a technical support case from a single interface.

If, instead of almost real-time troubleshooting and data, you need to access historical information about clients but also networks, devices, and
the like, you can rely on the reporting options under Reports > Report Launch Pad. Here you can create reports for several categories,
schedule them to run periodically, and also have the report(s) sent via email after each run.

Depending on the specific category, a report includes different types of information that you can filter by customizing which columns to include
in the report itself, as shown in Figure 6-16. If one of the default reports seems to have roughly the information that you are looking for, you
may want to verify whether there are additional columns that you should include, through the Customize option. Under the same customization
parameters, you also find the settings to sort the report’s data by specific fields.

Figure 6-16 Example of Report and Customization Options

The screenshot displays "Create Custom Report" dialog box. At the top, "Custom Report Name" drop-down with an input "Client
Session Summary" is shown. Below it has two options: Available data fields and Data fields to include. The "Data field sorting" has four
dropdowns: Sort by with Ascending radio button selected beside, Then by, Then by, and Then by drop-down with Ascending and
Descending radio buttons are shown beside. The three buttons: Apply, Reset (inactive), and Cancel are shown at the bottom right.

Note

Reports for Identity Services Engine do not run on Prime Infrastructure natively. When clicking an ISE reporting category, you will cross-launch
the ISE monitoring interface.

In addition to the preconfigured reports, Prime Infrastructure supports options to composite them or create customized reports.

Under the Report Launch Pad, on the left menu, among different categories is one called Composite, with a suboption for Composite Report.
Here you can select some reporting categories from different report types that should be included within a single report.

In a similar way, the Custom Reports page enables you to select some other common categories and run their data collection in the same report,
instead of, for example, having to generate two or more separate preconfigured reports for each one of those. Composite and custom reports are
in the end two similar options for achieving the same goal of including different categories in the same report.

If you choose to schedule reports and let Prime Infrastructure store files locally, their folder path is /localdisk/ftp/reports. You can change this,
along with the files retention period, under Administration > Settings > System Settings > General > Report.

You can find even more tools for supervising network operations under the Monitor menu. On top of the preconfigured pages to monitor
specific features, such as Radio Resource Management (RRM), access point radios, or even clients and network devices, through this menu you
can configure events, alarms, and notifications.

Events are SNMP traps and syslog messages received by Prime Infrastructure from network devices. They are logged as events on the GUI.
Alarms are alerts raised following from the correlation of one or more events.
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You can configure new events to be reported, following from a specific SNMP trap under Monitor > Monitoring Tools > Alarms and Events,
by clicking the Custom Trap Events button under the Events tab. Here you can either choose from some of the predefined MIBs or upload new
MIBs.

Alarms are preconfigured, and you cannot create new ones. However, through specific triggers, you can change the severity of an alarm through
Alarm Policies. Another option is to change the default severity of an alarm under Administration > Settings > System Settings > Alarms and
Events > Alarm Severity and Auto Clear.

An alarm can have its status set to one of these three types: Not Acknowledged, Acknowledged, and Cleared. Alarms are not acknowledged by
default, which means that they stay in the Alarms and Events table until some other action is taken. When you acknowledge an alarm, you
remove it from the Alarms and Events table and, even if the events that generated the alarm recur again within the next 7 days, Prime
Infrastructure will not trigger the alarm again. When you clear an alarm, you also remove it from the Alarms and Events table. However, Prime
Infrastructure regenerates the alarm as soon as the associated events reoccur.

When working with alarms, events, and monitoring options, you may also want to configure notifications for specific events. Prime
Infrastructure supports sending notifications either via email or SNMP traps. You can configure receivers under Administration > Settings >
System Settings > Mail and Notification > Notification Destination. If you decide to configure notifications via email, you should also
specify the Mail Server Configuration right above the previous menu.

The next step in configuring notifications are the Notification Policies themselves, either under Monitor > Monitoring Tools > Notification
Policies or under Administration > Settings > System Settings > Alarms and Events.

A notification policy defines for which alarms, on which network device categories, Prime Infrastructure should send an email or SNMP trap to
the configured destination email address or SNMP trap receiver. An example is sending an SNMP trap when a rogue AP event triggers the
corresponding alarm.

Configuring Jobs

Prime Infrastructure keeps collecting information from the network and the resources it interacts with through automatic or manual tasks,
referred to as jobs. You can find the full list of available jobs under Administration > Dashboards > Job Dashboard. The main goal of such
jobs is to keep refreshing the status of the network devices, their services, configurations, and so on without the administrator’s manual
intervention. For this reason, the vast majority of these jobs are scheduled to run automatically.

As an example, under the System Jobs > Status group, you can find the Wireless Configuration Audit job for synchronizing Prime
Infrastructure with the latest configuration on the WLC itself. It is usually scheduled to run once a day every day, but you can edit the
frequency.

Although usually not needed because by default all necessary jobs run automatically, you may, for example, want to check a specific job’s
schedule and collection status in case you cannot see data or statistics being updated for certain devices or services.

Security Operations

Security operations for wireless in Prime Infrastructure include three main functions: configuration auditing, rogue access points monitoring, and
wireless intrusion prevention systems (wIPS). The latter is tightly related to the Mobility Services Engine, and we delve more into it in the next
sections of this chapter.

Through configuration auditing, Prime Infrastructure performs different checks against a predefined list of settings and assigns a so-called
Security Index to the wireless deployment. These predefined settings include options such as Telnet/SSH configuration, client exclusion
measures, Management Frame Protection (MFP) parameters for WLANs, and so on. You can access the Security Index under Dashboard >
Wireless > Security. Whenever you configure an option in a way that it is deemed as “optimal” (in terms of security best practice compliance),
Prime Infrastructure raises the overall Security Index score, where a score of 100 represents the maximum value. However, not reaching a
Security Index of 100 does not mean that your wireless network is not secure. You should consider such an index as a general indicator for all
the security-related elements that you could configure in all the WLCs managed by Prime Infrastructure. Some of these elements are well-
known best practices, such as making sure that the default SNMP communities are not enabled, but not reaching the maximum score does not
necessarily mean that your networks are unsecure or unprotected.

Note

The Security Index that is evaluated against the WLCs’ configurations is updated by Prime Infrastructure after each run of the Wireless
Configuration Audit job (mentioned in the previous section).

Under the same Security dashboard, you can see a preview of wIPS attacks and rogue access points detection. From here, by clicking the
different counters, you can directly access the specific alarms and events raised for those categories.
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We described rogue access points detection, classification, and mitigation on the WLC previously in this book. Prime Infrastructure receives
SNMP traps from the WLC about rogue access points and consolidates them into alarms, which you can find under Monitor > Monitoring
Tools > Alarms and Events and the Rogue AP tab. By default, Prime Infrastructure assigns an Information severity to friendly rogue APs
detection, a Minor severity for unclassified rogue APs detection, a Major severity for malicious rogue APs, and a Major or Critical severity for
custom rogue APs. This classification depends on the severity score of the custom rogue classification rule on the WLC.

A common requirement in today’s wireless networks is to be able to locate and manage rogue access points on a map. If you don’t need to
locate more than one rogue access point at a time, Prime Infrastructure natively supports such an option without the need for additional
components, such as the Mobility Services Engine (MSE). You can find such an option called Ondemand Location Map under the rogue AP
alarm details, as shown in Figure 6-17.

Figure 6-17 Ondemand Rogue AP Location Option Without MSE

The screenshot displays a home tab with a path: Monitor / Monitoring Tools / Alarms, and Events / Alarms. Below that it shows, "
Searched By - Category : Rogue AP and Severity : minor - Reset." The body of the window shows various options in the righthand side
in which "Orientation Location: On-demand Location Map" is selected that opens the "On-demand Location Map" window with
various pointing locations in it. The top left of the map shows a magnifier with zoom-in and zoom-out, and at the top left corner, it
shows a contrast scale from most likely to least likely.

Although without an MSE you cannot display a rogue AP location in the alarm’s details or locate multiple rogue APs at once on a map, you can
still trigger an on-demand location. However, note that this feature works with old generation maps only. We keep referring to MSE when
talking about rogue access points’ location. This is because, at the time of this book’s writing, the current version (10.3) of the more recent
Cisco location solution, Connected Mobile Experiences (CMX), does not support such a feature, which is expected for a future version.

On top of rogue policies, contention, and techniques on the WLC to detect whether rogue access points might be on your wired network, Prime
Infrastructure also supports an additional option to determine whether a rogue AP may be connected to one of the Cisco switches managed by
Prime Infrastructure. This feature is called Switch Port Tracing (SPT), and you can launch it directly from the rogue AP alarm’s details. You can
configure SPT to be launched automatically or manually, with a series of additional options that you can find under Administration > Settings
> System Settings > Network and Device > Switch Port Trace (SPT) > SPT Configuration. Following a rogue AP detection and an SNMP
trap event from the WLC, after the correlated alarm is generated, Prime Infrastructure can determine via the Cisco Discovery Protocol (CDP) to
which Cisco switch the Cisco access point that is detecting the rogue AP is connected. However, you must enable CDP on your Cisco access
points and switches for SPT to work. Cisco switches should also be managed by Prime Infrastructure via SNMP, because after having found
where the detecting Cisco access point is connected, Prime Infrastructure queries the content addressable memory (CAM) table of the switch
via SNMP. By doing so, it tries to find out if one of the rogue access point clients’ MAC addresses is present, or if the MAC address of the rogue
AP itself is present in the CAM table (plus or minus 1 and 2 to the right-most significant byte). For example, if the rogue AP’s detected radio
MAC is FC:5B:39:94:AD:31, in addition to that specific MAC, Prime Infrastructure will search for FC:5B:39:94:AD:30, FC:5B:39:94:AD:32
(minus and plus 1 to the right-most significant byte), and FC:5B:39:94:AD:2F, FC:5B:39:94:AD:33 (minus and plus 2 to the right-most
significant byte). This technique will increase the chances of finding the rogue AP’s Ethernet MAC in the switch CAM table, because usually
the radio MAC is derived from the Ethernet MAC by adding or subtracting 1 or 2 to the right-most significant byte (sometimes even more than
just 1 or 2, but in that case, the SPT search could demand too many resources). If Prime Infrastructure does not find the rogue AP on the first
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switch, it queries that switch for its neighbor switches via CDP, and then starts analyzing those neighbors’ CAM tables, provided that it is
managing them, and so on. If Prime Infrastructure finds the rogue AP connected to one of the switches’ ports, you then have the option to
disable that port. Figure 6-18 shows a quick example of SPT.

Figure 6-18 Switch Port Tracing Example

Depending on the network size, SPT could take some time and resources to complete. For such a reason, you can find options to configure how
many rogue APs and switches Prime Infrastructure should query in parallel when SPT is launched. You can also configure the maximum number
of CDP hops, which represents how many CDP neighbor searches Prime Infrastructure should use when querying switches starting from the
Cisco access point that detected the rogue AP. You can access these settings under the aforementioned SPT Configuration menu.

For the sake of simplicity, so far we have mentioned that switches used for SPT should be managed by Prime Infrastructure, but this is not
entirely accurate. You can add a switch to Prime Infrastructure, manage it from there, and of course run SPT. In such a managed scenario, that
switch consumes one or more license tokens in Prime Infrastructure, depending on the switch model and configuration. However, you can also
add switches in Prime Infrastructure with the option Switch Port Trace for the license level, in which case the switch does not consume any
licenses.

To manually launch SPT, you do not even need to add switches in Prime Infrastructure, as long as you enter the correct SNMP parameters for
the switches in your network under the Manual SPT configuration, and don’t forget that enabling CDP on all Cisco APs and switches is always a
prerequisite.

Mobility Services Engine and Connected Mobile Experiences

Location services have been a major component of Cisco wireless networks since the first days of controller-based architectures. The very first
location solution was called Location Appliance, which in turn evolved to Mobility Services Engine (MSE). The main changes included new
hardware platforms, performances, and the introduction of wIPS, along with other improvements in software features and fixes. Nevertheless,
the basics of the original location algorithms are still used nowadays, even in the most recent code, of course with the necessary adjustments for
more up-to-date wireless clients and environments. The location service itself has always been referred to as Context Aware Services (CAS),
which is still used in some menus and previous license models. Both the Location Appliance and MSE solutions supported APIs for external
resources to collect location data and take advantage of them for third-party solutions, such as RFID tags, analytics engines, way finding
applications, and so on.

In 2012 Cisco Systems completed the acquisition of a company called ThinkSmart, whose primary business was an analytic engine integrating
via APIs to MSE and which provided tools to display statistics such as visitors count, dwell times, most commonly used paths, and the like.
Cisco integrated ThinkSmart’s tools in the location solution starting with MSE 7.4 and called that subset of menus Connected Mobile
Experiences. Within a few months the market responded positively to such an offer, and the whole solution has been readapted for new business
needs, while leaving the former network location and management features to MSE. CMX became a new standalone solution, with its own GUI
and services, with MSE still available to keep supporting all the previous use cases. To better differentiate the two, MSE kept using the former
version numbering, whose latest one is 8.0 at the time of this book’s writing; CMX started from version 10, and the current one chosen for the
Wireless CCIE exam is 10.3.

MSE and CMX are not 100% equivalent for the time being, but the plan is for CMX to eventually replace MSE for all the location options and
for MSE to keep supporting wIPS services. The following are some of the major common options and differences between MSE and CMX:
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The acronym MSE is still used to indicate the hardware appliance AIR-MSE-3365-K9, on top of which the code for either MSE or CMX
could run. CMX is generally always used to indicate the new software solution for location and other services. So you could find examples
in the configurations guides stating that CMX runs either on the MSE appliance or as a virtual machine. Throughout this book we refer to
CMX and MSE respectively as the new and former software solutions.

CMX supports three types of virtual machine installations (high-end, standard, and low-end) and a physical appliance installation, depending
on the scale and services you would like to support. Although it could technically run for lab purposes, hyperlocation is officially supported
on high-end virtual machines and the 3365 physical appliance only. The official “Cisco Connected Mobile Experiences (CMX) 10 Ordering
and Licensing Guide,” at https://www.cisco.com/c/en/us/solutions/collateral/enterprise-networks/connected-mobile-experiences/guide-c07-
734430.html, and “Cisco Connected Mobile Experiences Data Sheet,” at https://www.cisco.com/c/en/us/solutions/collateral/enterprise-
networks/connected-mobile-experiences/datasheet-c78-734648.html, contain all the numbers for scalability and virtual machine
specifications.

Both MSE and CMX use Probe RSSI as the most commonly deployed location technique (more on this in the next sections) to achieve an
accuracy of around 5–10 meters for wireless clients.

MSE can locate wireless clients, interferers, RFID tags, and rogue APs and rogue clients. CMX can locate wireless clients, interferers, RFID
tags, and Bluetooth Low Energy (BLE) beacons.

Prime Infrastructure supports data from MSE to display located devices (wireless clients, interferers, RFID tags, and rogue APs and clients)
on maps and uses those data for client troubleshooting, interferences-related widgets, and reports. CMX 10.3 is supported with Prime
Infrastructure 3.2 for clients and interferers location on maps only.

MSE is the only solution supporting wIPS.

CMX is the only solution supporting FastLocate and Hyperlocation.

Location Technologies and Techniques

Tracking and positioning systems have been around for decades now, but more recently the market started asking for additional accuracy and
real-time location to address new needs related to how networks could interact with end users through mobile devices and applications. Such
new needs might include visitors’ flows analytics, campaigns advertisements, wayfinding applications, and so on.

Although outdoor location technologies such as GPS could still be a good complement, indoor location can usually better be achieved through
radio standards such as Wi-Fi or even the more recent Bluetooth Low Energy (BLE). Throughout the next paragraphs we present some of the
most common indoor location techniques, while leaving some special notes for BLE at the end: even if not all these techniques are directly
included in the Wireless CCIE blueprint, you may still benefit from some additional details in your daily job as a wireless expert.

Indoor tracking technologies are often also referred to as Real-Time Location Systems (RTLS) and can adopt different approaches.

Cell of Origin and Presence

This is the most basic location technique, which consists in determining the closest antenna to which the client is associated or simply passing
by, by using the strongest Received Signal Strength Indicator (RSSI) value, as shown in Figure 6-19.
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Figure 6-19 Cell of Origin Location Technique

Although we could still graphically represent a cell of origin on a map, through a big circle for example, this would still be inaccurate. For such a
reason, cell of origin is more commonly related to the notion of presence, which in CMX allows collection of statistics such as visitor counts and
frequency, dwell times, and so on, but not to place a specific client on a map.

A common misconception is to use the notion of presence and wireless in general to count visitors of a venue, a shopping mall, a museum, or an
office. Although such a technique does count visitors in terms of wireless clients, it cannot be fully representative for all the visitors flowing
through a certain location. Many visitors could have Wi-Fi turned off on their mobile devices, and many others could have no mobile devices at
all. A better use of presence would be as an indicator of how crowded a specific location can get during a certain time of the day, month, or
year, and such information could generally be a complement for other big data sources and calculations.

The CMX installation process initially asks you to choose whether to configure CMX for Location or Presence. If you choose Presence, CMX
will activate a dedicated GUI, called Presence Analytics, with graphs for visitor counts, dwell times, frequency of visits, and so on, but without
any concept of location on plans, as shown in Figure 6-20. Counters are based on APs from specific groups, or sites, that you declare on CMX
directly, so not to be confused with AP Groups on the WLC for example. All the options for Presence, as well as Connect and Engage (more on
this in the next sections) that you activate through the Presence installation choice are available with the CMX Cloud offer too: CMX Cloud is
literally a CMX Presence instance hosted on the Cisco cloud.

Figure 6-20 Example of CMX’s Dashboard for Presence

The menu bar of the dashboard shows: Presence Analytics (selected), Connect and Engage, Manage, and System. It is followed by
"Weekly Insights" and "Monthly Insights." Below displays a vertical triple bar graph under "Proximity" and a concentric pie chart under
"Proximity Distribution."
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An advantage of the CMX Presence installation, because it is not providing any form of location on maps, is that it is completely independent
from Prime Infrastructure and its plans. To deploy presence services and analytics, you technically need one single access point, without any
need for placing it on a map and orienting its antennas. On the other side, many customers quickly find new needs and use cases on top of basic
presence statistics, which make them move quickly to a full CMX Location installation.

You can obtain almost similar presence statistics with the CMX Location installation and its corresponding Analytics dashboard. Although not
applicable to all deployments because it could set wrong expectations, a location deployment not respecting all the prerequisites for precise
location calculations (see the next section) could still be used to obtain presence data only, in terms of devices’ counts and dwell times on a
specific site, or map. However, in this case the end customer should thoroughly accept not to trust other location type data obtainable through
CMX, precisely because the deployment did not respect all the prerequisites for location in the first place. A reason to “hijack” a CMX Location
installation for presence use cases could be to concentrate on just one server data for some sites needing presence statistics only, on top of real
location coordinates for other sites needing more precise tracking techniques. One of the main differences in terms of requirements, as compared
to the CMX Presence installation, is that the CMX Location installation needs floor plans from Prime Infrastructure to start locating clients and
even to perform the most basic counting operations. In such a case, you would have to place access points on maps in Prime Infrastructure to
then export those maps to CMX.

One more option to obtain presence statistics would be to use the CMX Location installation to send standard location coordinates through
Northbound Notifications to a third-party analytics engine. Such an external application should not rely on coordinates’ accuracy, of course, but
could still use those notifications to determine visitor counts, how often clients are being seen, and with which frequency over a specific period.
An additional cost for the third-party application’s development should be taken into account here, but this is a common option for presence use
cases through big data analytics engines.

Trilateration with Probe RSSI or FastLocate

Lateration is a technique that calculates distance from well-known reference points on a map (for example, access points) by using data based
on the RSSI or Time Difference of Arrival (TDOA).

To achieve some better degree of accuracy of coordinates on a map, location solutions rely on distances calculated from at least three reference
points, as shown in Figure 6-21, at whose intersection you find the position of a wireless client calculated with the highest probability of success.
Because of that requirement for at least three reference points, we often use the term trilateration.

Figure 6-21 Trilateration Location Technique

The figure shows three Cisco CMXs is encircled by three intersecting circles, and a wireless client at the intersection point. The
distances calculated from each CMX in a clock-wise direction reads: negative 15 milliwatt Decibel, negative 10 milliwatt Decibel, and
negative 25 milliwatt Decibel.

Note

You might also often hear trilateration referred to as triangulation; however, this is not entirely accurate because triangulation is a technique in
trigonometry to calculate a location through triangles originating from known reference points. Triangulation uses angle measurements, whereas
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trilateration uses distance measurements, so they do not technically correspond to the same approach.

Trilateration is the most commonly deployed option for wireless location with Cisco CMX, and it is usually based on RSSI values from probe
request frames. Configuration and deployment guides often refer to this technique as Probe RSSI.

In optimal conditions (for example, after a thorough site survey, a precise installation, and a proper configuration) CMX with Probe RSSI
generally allows an accuracy of 5 meters 50% of the time to 10 meters 90% of the time. This means that, with respect to the client’s (X,Y)
coordinate on the map as calculated by CMX, there is a 50% probability that the client is really located within 5 meters from that coordinate and
a 90% probability that the client’s real location is within 10 meters from that coordinate. Real-life scenarios sometime prove that you can
achieve even higher levels of accuracy, such as 3 meters with 50% probability or better, for example, but officially Probe RSSI cannot be
suggested or supported for such results.

Recommendations for location with Probe RSSI and other options are vastly detailed in the “Cisco Connected Mobile Experiences (CMX)
CVD” design guide:

https://www.cisco.com/c/en/us/td/docs/solutions/Enterprise/Borderless_Networks/Unified_Access/CMX.html

Some of those best practices include the following:

A client should be heard at any point on the map by at least three access points with an RSSI of −75 dBm or higher. We generally
recommend planning for an RSSI of −67 dBm, to take into account potential attenuations from obstacles and human bodies.

Distances between access points should vary between 40 and 70 feet, and access points should not be mounted higher than 20 feet. Along
with the aforementioned recommendation, such distances should allow measurements from multiple access points in parallel to provide
enough RSSI separation.

Access points should be positioned all along the perimeter of the zone where you want to locate clients. For example, to locate clients inside
a rectangular conference room, you must deploy at least four access points at the four corners of the room. For such a reason, even though
the technical need is to have at least three access points for trilateration, we often tend to plan for at least four, also to increase the number
of measurements and the probability of more precise calculations.

For corridors, you should stagger access points along the walking path to form some kind of imaginary triangles between them, and not
install them on a straight line.

Location deployments usually require a higher number of access points than more “standard” installations for data or voice coverage. To
reuse frequencies and avoid co-channel interference, you can configure those extra access points in Monitor mode.

A common dilemma that appeared with more recent mobile devices and operating systems is the frequency with which you can track positions
of the same device.

Probe requests solely depend on the client’s wireless interface behavior because an access point cannot force a client to send those frames: the
client decides when to probe, and different operating systems may implement different probing algorithms. As a consequence, there is no precise
science to determine how often probe requests are sent, and hence how often CMX can refresh location coordinates for a specific client. A
common assumption could be a refresh period of 60 seconds: many devices usually probe a bit more often, but others could take some minutes.
The latter situation is also accentuated when a device is already successfully associated to an SSID: in such a case, for battery saving purposes,
the algorithms for the wireless interface might send probe requests even more occasionally.

On top of probe requests’ frequency, smartphone and tablet vendors introduced additional MAC address anonymization options. Mobile devices
and their operating systems sometime tend to use a random locally administered MAC address when sending probe requests. MAC addresses
with the second least significant bit of the first byte set to 1 are called locally administered: the Organizationally Unique Identifier (OUI) is
therefore not an officially assigned one, and such a MAC address completely differs from the one assigned to the wireless interface. If a device
keeps using a different locally administered MAC every time it sends a probe request, you lose the notion of traceability. As of today, however,
traceability is still a priority for many mobile device vendors, so algorithms for using random locally administered MACs apply only under
certain conditions, and even when they apply, the wireless interface still keeps using the original real MAC address from time to time. Some
conditions under which a mobile device may not use a randomly generated locally administered MAC, include when the device is already
successfully associated to an SSID or when applications running location and GPS services are active.

The overall effect of the two aforementioned challenges for mobile devices is not necessarily that you lose complete visibility and traceability on
them when implementing Probe RSSI location, but that you may experience less frequent updates on a client’s positions. To improve such a
situation, Cisco introduced an improvement on Probe RSSI called FastLocate. Instead of basing RSSI measurements on probe requests only,
FastLocate uses trilateration with RSSIs from data packets too. Data packets have two main advantages over probe requests: most of the time
clients use their real MAC addresses when sending data packets, and an access point can influence the transmission of some data packets. For
example, an access point at any time can send a block acknowledgement request (Block ACK Request, or BAR) to which the client must reply,
even if with just an acknowledgement, but which still represents a data packet. The main requirement on the other side would be for clients to be
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successfully associated to the Wi-Fi, to take advantage of data packets.

Although it does not increase the location accuracy, this technique still allows keeping tracking devices with a more regular frequency, generally
every 6–8 seconds, and with potentially all their real MAC addresses.

To support “hearing” the same data packet from the same client through multiple access points, FastLocate requires an additional radio. This is
expected, because when a client sends a data packet to an access point, it does so for a specific channel and frequency. Another neighboring
access point, next to the one the client is communicating with, most likely has its radios on different channels to avoid co-channel interference.
So the only option left is to dedicate a third radio to keep monitoring all channels and detect data packets from clients associated to other access
points. For such a reason, at the time of this book’s writing and for the CCIE exam blueprint, FastLocate is supported on 3600 and 3700 series
access points only, with the addition of the so-called Wireless Security Module (WSM), whose ordering part is AIR-RM3010L-X-K9 (X being
the corresponding radio domain code). Such a module is also sometimes called “HyperLocation Module” or “HyperLocation Module with
Advanced Security” in some configuration guides, because it is used for hyperlocation too (more on this in the next section). Figure 6-22 shows
a preview of the WSM.

Figure 6-22 Wireless Security Module (WSM)

Access points tracking clients through FastLocate with this additional radio module need to monitor channels in a synchronized fashion.
Monitoring radios from neighboring access points have therefore to synchronize themselves together on the same channel, at the same time, to
hear data packets from the same clients. Security modules from different neighboring access points cycle through the same channels at the same
time and Network Time Protocol (NTP), already needed for all other location techniques, starts playing an even more fundamental role with
FastLocate.

Some further general recommendations include not mixing access points with Probe RSSI and FastLocate, at least not on the same floor, for
example, as well as using FastLocate with 3600 and 3700 series access points with internal antennas only. The additional module has
omnidirectional antennas, and using it on an access point with external antennas could create incongruences between the coverage area and the
location tracking zone.

802.11 Active RFID Tags

Radio frequency identification (RFID) tags are not exactly a technique to calculate location coordinates but rather an alternative to standard
wireless clients for assets tracking. In contrast to passive tags, which emit when stimulated by a dedicated tag reader, active RFID tags are
battery powered devices of relatively contained dimensions, which can be attached to objects or persons and which keep emitting frames at a
specific, regular frequency and optionally with additional information, such as battery level, temperature, emergency button push, and so on.
These tags act as kind of wireless clients, in the sense that they actively send frames that are captured by access points and used for trilateration
with Probe RSSI: for such a reason we specifically talk about 802.11 active RFID tags as the only type of RFID tags supported for location
services with both MSE and CMX. Some tags do send probe requests too, but the most common frame type for location with 802.11 active
RFID tags is a Layer 2 multicast frame identifying the tag and containing the aforementioned additional options.

Assets tracking with RFID tags requires you to attach specific devices on objects or persons and configure them. Nevertheless, because of the
additional configuration and control you can apply to those tags, such a solution answers the need for actively tracking with a guaranteed
frequency and other services. By having more control on the wireless devices’ behavior, you can influence how often they are tracked. The
following are some common options you can find among the most popular RFID tags’ solutions:

Choice of channels, where to send multicast frames, so as to reduce the list of radio frequencies in use as the same configured for access
points. RFID tags can also send the same frame on all channels of the list at each beaconing period, to make sure all nearby access points
hear it on their corresponding frequencies.

Possibility to send frames more frequently only when in motion, to have the best of both power saving and tracking frequency.

Chapter 6 Prime Infrastructure and MSE/CMX

352

Technet24
||||||||||||||||||||

||||||||||||||||||||

file:///C:/Users/MERRELL/Documents/eBook Converter/Oreilly Downloader/tmp/9780135162095/ch06.xhtml#ch06fig22
https://technet24.ir
https://technet24.ir
https://technet24.ir


Message repetition parameters, not to risk to lose frames, as multicast frames are not acknowledged.

Cisco Compatible eXtensions (CCX) options, to include extra data such as battery level, temperature, emergency button alerting, and so on.

Transmit power and data rates configuration for additional power-saving optimization.

Typical use cases for RFID tags include, for example, carts tracking for medical equipment in hospitals, personnel tracking and rescue for
specific industry sectors, and repair parts location for manufacturing customers. These types of deployments often take advantage of the extra
data that RFID tags can send through CCX options, such as battery life information or emergency panic button push, to send API northbound
notifications from CMX toward external applications.

When deploying RFID tags, you may also be confronted with additional components, called chokepoints or exciters by some vendors. These are
devices dedicated to “wake up” RFID tags as they pass nearby and sometime even to reconfigure them. You may encounter scenarios where,
when entering a specific zone, the RFID tag parameters need to be changed on-the-fly, maybe to send messages more often, for example, or
with a higher transmit power. A dedicated chokepoint could achieve this when RFID tags approach within its range.

Although it dates back to some years ago, a very good and comprehensive reference to have a deep dive on all the RFID tags configuration
options is still the “Wi-Fi Location-Based Services 4.1 Design Guide”:

https://www.cisco.com/c/en/us/td/docs/solutions/Enterprise/Mobility/WiFiLBS-DG/wifich6.html

Angle of Arrival (AoA) and Hyperlocation

Sometimes also referred to as Direction of Arrival (DoA), this technique calculates a client’s location by determining the angle of incidence with
which the client’s signal arrives at the receiving sensor. This does not necessarily imply that one single access point instead of three or four
would be enough to achieve the same location results as with Probe RSSI. The major benefit of AoA, if implemented on all the same access
points as if planning for Probe RSSI, would be to increase the location accuracy up to one to three meters for the 50% probability and up to
around five meters for the 90% probability. Hyperlocation is the Cisco trademark for angle of arrival, and (always at the time of this book’s
writing and for the CCIE exam blueprint) it is a solution based on 3600 or 3700 series access points, with the WSM module, plus an additional
circular antenna mounted around the access points, as shown in Figure 6-23.

Figure 6-23 Angle of Arrival Technique and Hyperlocation Components

Hyperlocation reuses the principle of tracking clients based on data packets, hence the need for the same WSM module as for FastLocate, but
also supports extra calculations for the angle of arrival thanks to the circular antenna, which uses up to 32 internal receiving elements to
determine the angle of incidence of a client’s signal. As for FastLocate, Hyperlocation requires clients to be successfully associated to the Wi-Fi
for taking advantage of data packets. A common practice for best results would also be to make sure that access points with their circular
antennas have line of sight with clients whenever possible and, to minimize interferences, to privilege SSIDs on 5 GHz frequencies only.

The improvement in accuracy with hyperlocation requires on the other side a higher precision and discipline in configuring the solution, placing
the access points on maps, orienting them, and so on. Although you are always dealing with omnidirectional internal antennas, the orientation of
the additional circular antenna does play a fundamental role in how precisely you can track clients: its configuration in Prime Infrastructure
should reflect the exact physical installation. All such details for configuring hyperlocation are available in the official best practices and
troubleshooting guide:

https://www.cisco.com/c/en/us/td/docs/wireless/controller/technotes/8-2/b_hyperLocation_best_practices_and_troubleshooting_guide.html

As mentioned, the goal of the Hyperlocation solution is not to deploy fewer access points than with Probe RSSI or FastLocate, but rather to
achieve better accuracy. For such a reason, a deployment or a site survey optimized for Probe RSSI is a good starting point to add Hyperlocation
on top, by installing the additional WSM modules and circular antennas. However, as opposed to planning for Probe RSSI, where some access
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points can be in Monitor mode if redundant for coverage, with Hyperlocation access points need to be either in Local or in FlexConnect mode
(for centrally switched WLANs only, at the time of this book’s writing). This requirement could lead to co-channel interference, but you can
easily avoid such a situation through AP Groups. You can assign access points that shouldn’t serve any SSID to a specific AP Group with no
SSID configured, while making sure to configure the wanted SSIDs with a WLAN ID of 17 and higher, and in an AP Group containing all other
access points supposed to serve those SSIDs.

Bluetooth Low Energy

All the aforementioned tracking techniques are based on a wireless infrastructure, where the access points, the wireless LAN controller, and the
location engine of CMX are collecting data, aggregating them, and calculating location coordinates. Clients are playing a more “passive” role,
while the infrastructure does all the math to calculate (X,Y) coordinates and potentially feed them to third-party applications via APIs. From
here, those applications can use (X,Y) coordinates for analytic purposes, or even to offer location services back to those same wireless clients,
for wayfinding solutions through mobile apps or websites, for example. A quick visual representation of such a workflow is displayed in Figure
6-24.

Figure 6-24 Client and Infrastructure Interactions for Wireless Location

Three Wi-Fi modules named, "Client RSSI 1," "Client RSSI 2," and "Client RSSI 3" are connected to a wireless LAN controller (WLC)
named "Client RSSI 1, 2, 3 (Consolidated)." The data from WLC is given to "CMX" to calculate the location coordinates X and Y. The
output from CMX is sent through a cloud "XML/JSON API" to the "Third Party Mobile App Server." Finally, the location coordinates
are given to the mobile applications to find ways.

Bluetooth Low Energy (BLE) solutions take the opposite approach, with the client now playing a more active role. BLE emitters, sometimes
also referred to as beacons (from Apple’s proprietary BLE messages, called iBeacons) or even tags, originally are standalone transmitters that
do not interact with one another or with a centralized control system. The main purpose of a BLE emitter is to keep sending the same signal with
the same information, more or less like a lighthouse in the middle of the sea. It is the client’s role, through a dedicated mobile application, to
hear and collect those messages, like a boat in the sea receiving the beam from the lighthouse. As a consequence, the most important
prerequisite for BLE location solutions probably is the fact that clients must have a dedicated application installed to capture and interpret those
beacons from BLE emitters.

BLE emitters transmit beacons, or announcements, including the following main fields, as shown in Figure 6-25:

A prefix, usually dedicated to the company’s identifier having manufactured the BLE tag

A universally unique identifier (UUID) that you can configure to reflect a main location, or even your company’s name, for example

A major value, which you can use to indicate a first level of location (campus, building, floor, etc.)

A minor value, which you can use to indicate a second level of location (floor area, zone, room, etc.)

A field for the transmit power that can be used to determine the distance of the client from the BLE emitter
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Figure 6-25 BLE Announcement Format

The format is of data size from 0 to 31 bytes divided into the following fields: Prefix (9 Bytes): Identifies Type, Proximity UUID (16
Bytes): BLE Device Unique ID (Close Range Tag Isolation), Major (2 Bytes): Group, Minor (2 Bytes): Subgroup, and TX Power (2
Bytes): For Range Estimation. At the bottom shows five fields: Apple iBeacon, Museum Tag 0E5427, Museum, Gaudi Expo, and
negative 59 milliwatt Decibel.

Mobile devices with a dedicated application (integrating the SDK from the company having manufactured the BLE emitters, to correctly
interpret BLE announcements) capture those BLE messages and then usually relay their information upstream, to an application server or
similar having the necessary horsepower for additional calculations. The application server, based on the information from all the messages
captured by and received from the mobile device, can then implement algorithms to determine the mobile device’s location or to derive other
services. At the stage where the beacons’ information arrived from the client to the application server, we are in a similar situation as with CMX
and wireless location, where the (X,Y) coordinate can be calculated by the location server and reused for additional services too. The main
difference with respect to wireless location techniques is that the mobile device plays the role of collecting the information and then relaying it
to an application (or location) server upstream that takes advantage of those data. This kind of workflow is represented in Figure 6-26.

Figure 6-26 Client and Infrastructure Interactions for Bluetooth Low Energy (BLE) Location

The input from three transmitters named "UUID Acme, Major 10, Minor 1, Tx 1," "UUID Acme, Major 10, Minor 2, Tx 2," and "UUID
Acme, Major 10, Minor 3, Tx 3" are captured using a mobile device in turn it is connected to a "Third-Party Mobile App Server" to
calculate distance. This information is again forwarded to the mobile device through a cloud and a Wi-Fi module.

Technically, you could support location services purely through BLE beacons while providing basic data connectivity to mobile devices even
through 4G, for example, so not necessarily Wi-Fi. However, BLE emitters are usually powered by batteries, which you would need to change
every 3–5 years. By their nature of “beacons,” the vast majority of BLE emitters on the market, even if from the same vendor and part of the
same solution, do not synchronize among them and do not communicate with a centralized management system either: to configure them, you
usually need to use a dedicated management application running on a mobile device and to approach each emitter one by one. Despite the lower
cost of a BLE emitter compared to a wireless access point, all these additional requirements might cause the overall cost of the location solution
to rise higher with BLE than with Wi-Fi. As shown in Figure 6-27, one common approach is to mix Wi-Fi and BLE location: you could use the
WLAN infrastructure to locate clients with a higher error margin in those areas, where just a few meters of precision are enough for the end
customer’s needs; in other zones with less than one meter proximity needs, you could then deploy BLE to fine tune the accuracy. A typical
example of such a mix could be wayfinding services inside an office or reservation options when approaching or entering meeting rooms.
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Figure 6-27 Coexistence of WLAN and BLE Location Infrastructures

Three Wi-Fi modules labeled "Client RSSI 1, Client RSSI 2, and Client RSSI 3" are connected to a wireless LAN controller (WLC)
labeled "Client RSSI 1, 2, 3 (Consolidated)." The data from WLC is given to "CMX" to calculate the location coordinates X and Y. The
output from CMX is sent through a cloud "XML/JSON API" to the "Third Party Mobile App Server" which also receives an input from
a mobile device connected to a BLE. Thus the third party server outputs the mixed location of both Wi-Fi and BLE that is given back to
the mobile applications to find ways.

With a mix of wireless location services provided by CMX and BLE location supported through an external third-party server, you should be
aware that there will be two distinct data sources for (X,Y) coordinates: CMX and the third-party server for BLE. CMX does not support
location through BLE emitters. Thanks to CleanAir and interferers location, CMX can display the position of BLE emitters on a map, where you
can flag them as active, missing, rogue, and so on, and even configure API notifications if their state changes (for example, if they are not heard
through CleanAir anymore or if they get misplaced). However, CMX supports wireless location techniques only, and even if we theoretically
could make people wear BLE emitters and try to track them as we would do for RFID tags, this is neither a recommended nor a supported
scenario as of today.

Management Access

When installing CMX, you need to configure at least two accounts: cmxadmin for command line and upgrade operations, and admin for
accessing the graphical user interface with full rights for any operation. You can create more accounts in the local database with differentiated
privileges for accessing the different GUI’s tabs, as shown in Figure 6-28. Under the menu MANAGE > Users you can add new users and
define whether they will have full read and write access to one or more tabs of the GUI, or just general read access. If you configure a user with
the Read Only role, that account cannot be assigned with any other role; otherwise, it would start having write privileges too.

Figure 6-28 Users and Roles Configuration for Management Access of CMX
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It is important to note that access to a specific tab also determines access to the corresponding APIs for features under that tab. For example, an
account with the Location role, having read and write access to the DETECT & LOCATE tab, will have access to the APIs for location, too,
and for location only (that is, under the /api/location calls).

On top of GUI access, configuring different users is commonly used to provide differentiated access to external applications, which should query
different services of CMX via APIs.

Besides different user roles that you can configure through the GUI, you should be aware of command-line options to reset the main admin
account for the GUI. By connecting via console/SSH to CMX through the cmxadmin account (configured during the installation process), you
can use the command cmxctl users passwd admin to reset the admin account’s password. Through the same command, but for the monitor
account, you can also reset the password for the default read-only user role. The full details on the use of these commands and others are
available in the “Cisco CMX Command Reference Guide, Release 10.3 and Later”:

https://www.cisco.com/c/en/us/td/docs/wireless/mse/10-3/cmx_command/cmxcli103/cmxcli103_chapter_010.html#wp3787199760

Network Services

CMX provides three main services, through which others could be derived too. The main and most deployed one is the location services that
have been inherited from the former MSE and Location Appliance solutions. By working with the calculated location data, CMX also provides
the analytics service for additional statistics. Connect and engage on the other side designates an additional set of options for guest portals.

Some configuration guides or release notes might also often refer to CMX services as Detect, Connect, and Engage. Detect designates the
presence and location tracking capabilities, Connect indicates the guest portal services, and Engage represents the API options to feed external
third-party solutions, such as mobile application servers to engage with end users. It should be clear that CMX does not support features to
“wake up” mobile applications or send SMS and interact with end users. CMX provides a database that other applications can take advantage of
via APIs, to then communicate with mobile devices and end users according to data retrieved through those APIs. APIs for location services in
particular also support the so-called northbound notifications: these are push messages, in either JSON or XML format, sent on-the-fly as soon
as the event for which they are configured is triggered.

Note

The full specifications on all the supported API calls are available through any CMX installation by browsing to https://CMX_IP/apidocs/ and
selecting the corresponding service (for example, Location, Analytics, Presence). To try out API calls directly from these CMX menus you will
need to enter a username and password with the right API access privileges.

Different services in CMX 10.3 consume different levels of licenses. Location and Connect services, with all the corresponding APIs, consume
a Base license for every access point, from where clients are located or authenticated through guest portals. The Analytics service and its APIs
require an Advanced license per access point contributing to location calculations, whose data is then used for the analytics reports.

Location

We described different location techniques throughout the previous paragraphs: their level of accuracy will determine the precision of
coordinates calculated by CMX. One major distinction you may need to make about location is the difference between presence (that is, cell of
origin) and all other techniques.

Presence supports statistics based on whether a client’s MAC address is seen or not, with which RSSI, for how long, how often, and so on.
During the initial installation, CMX asks you to choose between a Location and a Presence mode. As also shown in Figure 6-29, the CMX
Presence installation primarily gives access to one main tab called PRESENCE ANALYTICS, which displays three types of statistics: counters
for the number of visitors, passerby and connected users, their dwell times, and their distribution with respect to repeated visits. A single access
point registered to a WLC (in the Mobility Express model too) is technically enough for presence to work; because there is no notion of placing
clients on a map, Prime Infrastructure is not part of this workflow. Controllers in CMX Presence can be added through the SYSTEM tab by
clicking the Settings button and by specifying the controller’s SNMP credentials.
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Figure 6-29 Example of the PRESENCE ANALYTICS Tab in the CMX Presence Installation

The window displays the widgets such as total visitors, average dwell time, peak hour, conversion time, and top device maker. The
"Insights" option at the bottom shows the detailed Weekly and Monthly insights.

Presence supports grouping access points into sites: this is a local option on CMX itself that does not affect potential AP Groups or FlexConnect
Groups already configured on the WLC, if any.

You can think of graphs and numbers reported by CMX Presence as trends of how crowded a specific site could get: they do not expose
information on specific MAC addresses and cannot be used as precise counters for visitors, for example, because there is not necessarily a one-
to-one mapping in real life between a wireless device and a person. If needed, through APIs you can still access raw data of MAC addresses
from active clients, for example.

As for a typical CMX Location installation, CMX Presence also supports the same CONNECT & ENGAGE services (more on this later).

The CMX Location installation type is the one you need to be most familiar with for the Wireless CCIE exam and probably the one end
customers will need to deploy more often. This installation mode provides access to a dedicated tab for DETECT & LOCATE, where wireless
clients can be displayed on maps, as well as to an ANALYTICS tab displaying statistics derived from location coordinates.

For location services to work, you must import maps in CMX. These maps come directly from Prime Infrastructure, and correct AP placements
and orientations become fundamental for location accuracy. For importing maps to CMX you have several options:

Through the CMX graphical interface, under the SYSTEM tab, click the Settings button and browsing to Controllers and Maps Setup >
Import. From here you can specify credentials for CMX to connect to Prime Infrastructure directly and pull all the maps and WLC
coordinates.

This option will import all maps and all controllers from Prime Infrastructure to CMX. Although you can still delete unneeded plans and
WLCs afterward, you may probably want to import only specific ones.

Prime Infrastructure 3.2 supports an option to push maps to CMX after having added CMX itself to Prime Infrastructure. You can find this
under Services > Mobility Services > Connected Mobile Experiences by selecting an already added CMX server from the list and
clicking Import Map to CMX. This method allows selecting specific maps only.

The third option, which is also the one preferred by the authors of this book, is to manually export maps from Prime Infrastructure in a
.tar.gz compressed file and then import that very same file in CMX.

You can export maps from Prime Infrastructure under Maps > Wireless Maps > Site Maps (New!) by clicking Export > Map Archive on
the top-right option of the page. From the right side panel you can select the exact floors you would like to export, and then click Generate
Map Archive to download the needed file, as shown in Figure 6-30.
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Figure 6-30 Example of Maps Exporting from Prime Infrastructure

Back in CMX, you can import the map file under the SYSTEM tab by clicking the Settings button and browsing to Controllers and Maps
Setup > Advanced: here you’ll find an option to import maps through the file generated from Prime Infrastructure.

Although it could take a few more seconds than the other two options, adding controllers and maps in a manual fashion in CMX usually
allows a bit more visibility on exactly which maps to import and also allows some easier troubleshooting if something accidentally fails in
the process.

Under the same Advanced settings for importing the maps file in CMX, you can also find all the fields to point CMX to the controller(s). Along
with the manual maps import process, this should be the preferred approach to declare controllers too.

A WLC is added in CMX by specifying its SNMP credentials. These are needed for CMX to go and configure the WLC directly, with all the
required settings for the Self-Signed Certificate (SSC) key hash (more on this later in the NMSP section).

Note

When a controller is configured to send data to CMX, it does so for all its access points; however, this does not mean that CMX is consuming
licenses for all those access points. License consumption for location and other services is based on the access points on the maps, through
which CMX is supposed to track clients, interferers, and so on.

For example, if a WLC has 100 access points registered but CMX has a map with only 50 of those access points positioned, the CMX license
consumption will be of 50 access points, despite the fact that the WLC is sending data for all 100 access points. As of today there is no direct
option to select which access points contribute to location calculations and consume licenses: the main technique to filter out access points is to
import a map with just the wanted access points in it.

After configuring maps and controllers in CMX, you should start seeing clients, interferers (BLE emitters included), and RFID tags being
tracked. You can select exactly which categories among these three to track under the SYSTEM tab, by clicking the Settings button and the
Tracking option.

Under the same Settings menu, the Filtering options let you modify some general parameters to include or exclude specific data.

The Duty Cycle Cutoff specifies the duty cycle percentage, for which CMX should not track interferers: the default value of 0 means that CMX
will track all interferers.

The RSSI Cutoff for probing clients determines with which dBm value CMX starts discarding RSSI values if three or more values with a higher
RSSI are already available for location calculations. For example, if you configure the RSSI Cutoff at −85 dBm and CMX receives
measurements of −47 dBm, −68 dBm, and −93 dBm for the same client from three different access points, it still uses the one at −93 dBm. For
the same RSSI Cutoff configuration, if CMX receives measurements of −47 dBm, −68 dBm, −76 dBm, −89 dBm, and −93 dBm for the same
client, it discards those at −89 dBm and −93 dBm because it already has three usable ones above the configured cutoff limit of −85 dBm. Other
Filtering parameters are probably self-explanatory, but it is worth mentioning the option Enable Locally Administered MAC Filtering, which is
checked by default. Thanks to this setting, CMX discards all random and temporary MAC addresses self-assigned by some client vendors while
probing, using the specific bit set to identify them as locally administered, which we discussed in the previous section when describing Probe
RSSI and FastLocate tracking techniques.

Among other settings, you should probably be aware of options in the Location Setup menu. Although you should usually leave these configured
as is by default, it might help knowing some of their main behaviors and goals:

Enable OW (Outer Walls) Location is an ancient inheritance from the former MSE and Location Appliance solutions, which is not being
used by CMX anymore but was left there for some backward compatibility corner cases. Its purpose was to take into account walls with
attenuations higher than 13 dB, if configured on maps.

Location calculations do not take into account obstacles and their attenuations as configured through the map editor in Prime Infrastructure.
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Enable Location Filtering, checked by default, is used to take into account previous location calculations to determine the next one. The
direct effect of such an option is to avoid a client “jumping” too far apart between one coordinate and the next.

Use Default Heatmaps for Non Cisco Antennas is rarely checked and has the effect of letting CMX use best effort location calculation
models even when not using Cisco antennas on your access points, which is not recommended anyway.

Chokepoint Usage, also enabled by default, lets CMX accept information on the closest chokepoint, as communicated through CCX
options, if supported, by RFID tags.

Enable Hyperlocation is an option checked by default that stays hidden for standard and low-end virtual machine installations. Only if
CMX is running as a high-end virtual machine or on a physical 3365 appliance is this setting exposed in the GUI.

Optimize Latency causes CMX to use less data for location calculations and speed up computations. This is achieved, for example, by
setting relative discard RSSI and AoA times (more on these in the next bullet points) to 30 minutes. Because accuracy might decrease, you
should consider this setting only if recommended by the Cisco technical support.

Use Chokepoints for Interfloor Conflicts gives you the choice of when to use a chokepoint’s information in CCX options from RFID tags
to locate CCX compatible RFID tags. NEVER means that chokepoint’s information is never used if similar locations are calculated between
different floors. ALWAYS lets CMX always use a chokepoint’s information in location calculations, independently on whether there could
be an inter floor conflict. FLOOR AMBIGUITY causes CMX to give higher priority to chokepoint’s information to resolve conflicts if
similar locations are calculated between different floors.

Chokepoint Out of Range Timeout determines the time in seconds after which the latest chokepoint’s information is not considered
anymore when an RFID tag leaves that chokepoint’s coverage zone (for example, the chokepoint’s information is not reported anymore
through CCX options). When a chokepoint’s information is not used anymore, CMX goes back to using trilateration based on multicast
Layer 2 frames’ RSSI.

Relative discard RSSI time is the timeout in minutes from the latest RSSI measurement after which older RSSI measurements should be
discarded. For example, if this time is set to 3 minutes, CMX discards measurements that are more than 3 minutes older than the latest RSSI
measurement.

Relative discard AoA time is the same timeout as the previous one, but for AoA measurements instead of RSSI ones.

Absolute discard RSSI time is the timeout in minutes from the current time on the CMX clock after which older RSSI measurements
should be discarded. For example, if this time is set to 3 minutes, CMX discards measurements that are older than 3 minutes compared to
CMX’s current time.

RSSI Cutoff has the same effect as of the RSSI cutoff under the Filtering menu, but this one in particular is dedicated to the RSSI of data
packets.

Individual RSSI change threshold is a parameter that, along with the next three in this list, allows CMX to determine whether a significant
wireless client’s movement took place, so that previous sets of RSSI measurements should be discarded to recalculate location with new
ones. If any value between individual or aggregated RSSI changes is met, CMX will discard previous sets of RSSI measurements and use
only new ones for location recalculations. Individual is for a single RSSI measurement change.

You should never change this option or any of the three following ones except under guidance from the Cisco technical support.

Aggregated RSSI change threshold is for RSSI changes within a fixed aggregation window, internal to CMX, and its purpose is very close
to the previous threshold.

Many new RSSI change percentage threshold also triggers a location recalculation by discarding older RSSI measurements, but only if
one of the previous two parameters didn’t trigger it already, and only if the missing RSSI percentage is met too. This threshold indicates the
percentage of new RSSI changes in the aggregated location data from the WLC.

Many missing RSSI percentage threshold triggers a location recalculation after the specified percentage of missing RSSI information only
if the new RSSI change percentage is also met.

History Pruning Interval specifies the number of days during which to retain location data in CMX’s database.

Although not mandatory for CMX to start calculating (X,Y) coordinates, as a further step for your location setup you may want to configure
inclusion and exclusion regions on maps, as well as zones.

You can also create inclusion and exclusion regions from Prime Infrastructure through the map editing options. If you import a map from Prime
Infrastructure into CMX without any inclusion region, CMX automatically creates one global inclusion region corresponding to the whole floor
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area. An inclusion region defines the area of a floor within which all wireless clients should be located. If without an inclusion region, wireless
clients are supposed to be located outside of such an area, with the inclusion region they will be “snapped” inside or at its boundaries. An
exclusion region works the opposite of an inclusion one: it is an area where wireless clients should not physically be located in real life. Devices
that without an exclusion region are supposed to be located within its specific area, with an exclusion region will be “snapped” on its
boundaries. When creating inclusion or exclusion regions, you may need to wait a few location calculation cycles before seeing clients
respectively outside or inside those regions starting to be “snapped” on their boundaries or further away. In CMX you can configure exclusion,
inclusion regions, and zones under MANAGE > Locations. From the left side panel you can browse to the needed floor and then click the
arrow on the top-right corner of the icon from the list, saying Go to Map View: from here, you can access a dedicated editor to add, delete, and
modify those areas, as shown in Figure 6-31.

Figure 6-31 Zone Editor in CMX

Locations tab in the menu bar is selected and displays "Zone Editor" in the content pane that shows a home design with various labels:
Lobby, EN team, Inclusion, and DC team. The left pane shows: "Back" option, "System Campus" that extends to "ILM-Cisco," and
"ILM-4 (3 Zones)." At the right side, the zoom-in option is selected.

Zones are also areas that you can draw on maps in CMX from the same editor, but they have very different roles from inclusion and exclusion
regions. Zones do not contribute to location calculations; their names are included in API notifications, and this could be useful information for
external applications working with statistics on general areas rather than precise coordinates. The other main utility for zones is for analytics
reports.

When location services are up and running, a common use case is to export coordinates to external applications through APIs and northbound
notifications. You can configure notifications in particular under MANAGE > Notifications; by setting the type of notification and its
conditions you specify the event triggering CMX to send JSON or XML messages to external solutions. A typical example is for CMX to send a
notification every time the location of a device changes further away than X feet: triggering messages after a movement of a specific distance is
a less overwhelming option for external applications than sending notifications for every single location update.

Analytics

The CMX name and services originated from the acquisition of the ThinkSmart company taking advantage of location coordinates via APIs to
provide analytics statistics and reports, and today we could say that the Analytics features in CMX are the strongest legacy from that specific
acquisition. By working with raw (X,Y) coordinates and correlating them based on time, number, and frequency of visits, as well as other
criteria, CMX provides reports with widgets spanning from basic wireless client counters to more advanced path analysis. A report is technically
a page with widgets that you can choose from a list; you can create multiple reports with different widgets, or even with the same widgets but
different time ranges, for example. As anticipated in the previous section, zones can be used in reports and widgets to compare data between
different areas on floor plans: these could be simple visitor count distributions between areas or, for example, users’ paths analysis starting from
a specific zone and ending in different ones.

CMX supports the following widgets to include in an Analytics report, some of which are also shown in Figure 6-32:

Visitors provides you with device counters, which you can organize by time of the day, areas, or by displaying overall daily counters. For
this last type of statistics, a visit is defined as the appearance of a device in a single area and on a single day, from 00:00 to 23:59.

If you try to edit a Visitors widget through the icon on its top-right corner, you can display what is called a Summary view. On top of the
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overall counter for total daily visits, CMX also shows the percentage of new versus repeated visits. A repeat visit is defined as a device
having already been in that area within the last six months.

Wi-Fi Adoption, although it is a separate widget, goes along with the previous one for showing associated versus probing visitors and gives
a useful indicator of how many clients are actually connecting to and using the wireless network. This widget won’t have too much sense if
in the System’s Filtering settings you check the option Exclude Probing Only Clients.

Dwell Time widgets show the duration of visits over the time period that you specify. The dwell time for a specific device is calculated as
the sum of all of that device’s visit durations to a specific area.

Dwell Time Breakdown is another widget end users often tend to include in reports with other Dwell Time graphs and displays the
distributions of number of visits based on different durations.

Correlation enables you to visualize, starting from a so-called focus area, how many devices seen in that area were seen in other areas too.
Focus areas can be campuses, buildings, floors, or zones. Configuring zones through the map editor is therefore needed for Correlation
widgets, which take advantage of such areas defined on maps to calculate and display counters for Wi-Fi devices in a specific zone and to
then correlate them to other zones.

Path is kind of an evolution of the Correlation widget. As for Correlation, you start by choosing a focus area, and CMX automatically
generates a graph displaying how many visitors from that area came from other areas and went to other areas too.

Figure 6-32 Example of Widgets in Analytics Reports

The window displays the widgets such as total visitors, total zone visits, and total visits in the body of the window under "Count"
with their corresponding information. Below which shows a line graph represents "Daily trend" for "Devices Count" and a bar graph
for "Devices Count by Floor." The left pane displays: Count, Path, and Dwell Time under the option "Reports."

You can find well-detailed explanations of all the Analytics parameters and their uses directly on your CMX by browsing to the following URL:

https://CMX_IP/docs/pdf/analytics-doc.pdf

The shortest period of time supported by reports from the main analytics dashboard is for the current day. However, you also have access to a
dedicated real-time report under the Realtime option of the same ANALYTICS tab, from where you have access to a Wi-Fi Adoption and a
Device Counts widget that are continuously updated.

Other features of the analytics engine include a Heatmap menu, which shows concentration of wireless clients on floors, either real-time or by
playing it back in history. Colors of a heatmap here are not directly related to specific counters but simply display higher or lower concentrations
of wireless devices.

Although all these analytics options are available with the CMX Location installation mode, you could still take advantage of them for presence
use cases too. For example, if you generate visitors’ counts or dwell times for entire buildings, you don’t necessarily need precise location
coordinates on floors for those statistics to still provide realistic trends. The first four widget types from the aforementioned list are probably
more intuitive to use for this kind of presence analytics, but you can use Correlation and Path too by configuring buildings or campuses as focus
areas, in which case accurate location again might not play a fundamental role.
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Note

You may need to use extra caution with your potential end customers when setting expectations about using CMX Location for presence use
cases. Because of maps and the interface to locate clients, end users and business teams might start using the DETECT & LOCATE options,
even if with inaccurate (X,Y) coordinates, or generate analytics reports based on zones on floors instead of whole buildings and campuses.

Another common technique for implementing analytics is through an external third-party solution. In such a case you could, for example,
configure API northbound notifications for location, as described at the end of the previous section, toward an external database, which will
store (X,Y) coordinates and any other additional data. A dedicated external solution could then reuse that data to compute analytics reports on
client counts, dwell times, correlations, and so on. The advantage of such an option is that reports can be completely customized, even though
you might need to take into account some additional costs for the external solution.

The approach we just described is something you may encounter more often than expected: many third-party solutions on the market provide
analytics services and support integration with Cisco CMX. The technical secret sauce used in the background is precisely to configure location
northbound notifications, and then let the third-party solution implement custom analytics and other tasks.

Connect and Engage

Guest portal options on CMX are not dependent on location or analytics services or vice versa, but they provide additional tools to connect end
users and potentially increase location accuracy if using more advanced techniques such as FastLocate or Hyperlocation. In your daily job as a
wireless expert you may be confronted with the decision of which guest solution to deploy between portals on the WLC, CMX Connect, and
Identity Services Engine (ISE). Although not strictly related to the Wireless CCIE exam, it might be useful to clarify the main advantages and
use cases for each of the three:

The WLC’s internal portal is usually ideal for so-called hotspot scenarios, meaning when visitors should need to validate an Acceptable Use
Policy (AUP), for example, by checking a box for terms and conditions on the landing portal to then get directly authorized on the guest
network.

CMX Connect is generally recommended for the very same hotspot use case as the previous solution. However, with respect to the WLC’s
internal portal, CMX offers much easier and more advanced customization features for portals, along with options for redirecting to
different pages based on the client’s location and for integrating with social networks.

ISE is probably the most complete solution, allowing support for the same hotspot needs as the other two, as well as other use cases, such as
sponsored portals (for example, where visitors are asked for credentials generated by a “sponsor”) or self-registration (for example, visitors
generating their own credentials from the guest portal).

Figure 6-33 shows a quick positioning of the three main Cisco guest solutions (WLC, CMX, and ISE).

Figure 6-33 Guest Solutions Positioning

The WLC displays "Connect" page that prompts the welcome notes with an "Accept" button and the text below reads: Free, embedded;
and Ideal for pass through with AUP pages. The CMX displays a dialog box called "Cisco Live!" that prompts the welcome notes with
three inputs (Your Name, Your Company Name, and Your Country Name) and a "Connect" button at the bottom. The text below reads:
Very easy/powerful to customize and assign portals based on sites; and Ideal for pass through with AUP pages. The ISE displays a
dialog box called "Hotspot Portal" that prompts the Acceptable Use Policy with two buttons: Accept (selected) and Decline at the
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bottom. The text below reads: Most versatile solution; Ideal both for login and AUP portals; and It requires an additional learning curve.

CMX Connect is based on the Local Web Authentication (LWA) technique, as shown in Figure 6-34. The term “local” comes from the fact that
a guest portal’s URL (for example, CMX’s guest services’ URL) for redirection is locally configured on the WLC, under the Layer 3 security
settings of the WLAN. More specifically, the WLAN on the WLC needs to be configured with the Passthrough option. The full web
authentication process is detailed as follows:

1. The WLAN is configured for an open or PSK-based SSID, with a Layer 3 web policy security for passthrough, a preauthentication ACL,
and an external web redirection to the CMX URL: https://<CMX_IP>/visitor/login.

The preauthentication ACL should permit HTTPS traffic from wireless clients to CMX and vice versa. Also, although DHCP and DNS are
now implicitly allowed in WLANs with web authentication configured, we generally recommend explicitly defining permit rules for these
services in the preauthentication ACL. Doing so allows better visibility for troubleshooting, because you could verify through the ACL’s
counters whether DHCP and DNS traffic are correctly allowed. Other HTTP resources, except probably some specific ones for internal
needs or advertisements, should usually not be allowed in the preauthentication ACL and should be denied by the default deny statement.

2. When a client connects, it obtains an IP address via DHCP, as permitted by the preauthentication ACL. When the end user then opens a
web browser to access an HTTP resource denied by the preauthentication ACL, the WLC will redirect the user to the CMX URL
configured locally under the Layer 3 security options of the WLAN. The CMX URL should not cause any further redirection because it is
permitted in the preauthentication ACL.

Mobile devices nowadays often implement web portal discovery techniques and pop up a web browser automatically to get the end user
redirected to the guest portal without the need for manually accessing a specific HTTP resource over a typical web browser. With Apple
devices, for example, such a technique is called Captive Network Assistant (CNA): the device automatically tries to reach external URLs,
such as http://www.apple.com/library/test/success.html, and, in case of redirection, it automatically pops up an embedded browser to
prevent the end user from having to launch a browser and trying to explicitly access an HTTP destination. The WLC supports an option to
bypass such an automatic redirection, which is called Captive Portal Bypass, disabled by default, which can be activated through the
following command line (on a global level, for all WLANs, and needing a WLC’s reboot to be applied):

Click here to view code image

config network web-auth captive-bypass enable

With this option enabled, the WLC replies with an HTTP OK to devices’ requests for external URLs on apple.com, hence not triggering the
minibrowser automatic pop-up. For a better end user’s experience, you may want to leave such an option disabled by default.

Another default option we tend to recommend leaving disabled is the support for HTTPS redirection. With such a feature the WLC could
redirect end users even when the initially requested external website is via HTTPS. Because of the nature of SSL, it is not possible to avoid
a certificate warning (the HTTPS session is kind of “hijacked” by the WLC to achieve this), and activating such a function is not optimal for
the WLC’s performance either. As a further note, you should keep in mind that because the CMX URL for the guest portal services is in
HTTPS, end users will see a certificate acceptance warning, because by default the CMX’s certificate is a self-signed one. To upload a
certificate signed by an external authority, refer to the “Getting Started” chapter in the official “Cisco CMX Configuration Guide, Release
10.3 and Later”:

https://www.cisco.com/c/en/us/td/docs/wireless/mse/10-3/cmx_config/b_cg_cmx103/getting_started_with_cisco_cmx.html

Alternatively, you might also disable the SSL mode on CMX through the following command, to support redirection via HTTP (and modify
the WLC’s preauthentication ACL and redirect URL accordingly):

cmxctl node sslmode disable

3. The WLC redirects the end user to the CMX URL by postponing additional information regarding the client’s MAC, the AP’s MAC, the
SSID name, and so on. It also includes a “switch_url” variable containing an HTTPS pointer to the virtual interface of the WLC itself. This
is an instruction to tell CMX to redirect the client back to the virtual interface at the end of the process. The full redirection URL from the
WLC looks like the following:

https://<CMX_IP>/visitor/login?switch_url=https://<VIRTUAL_IF>/login.html&ap_mac=<AP_MAC>&client_mac=
<CLIENT_MAC>&wlan=<SSID_NAME>

4. The end user at this point lands on the CMX Connect guest portal and needs to complete some tasks. These could range from a basic
acceptance of terms and conditions, to an authentication through a code received by SMS, to a login through social networks, and so on.
After completing tasks on the portal, CMX redirects the user back to the WLC’s virtual interface to signal the WLC that the client should
be successfully authorized on the WLAN. The redirection URL from CMX is similar to the following:

Chapter 6 Prime Infrastructure and MSE/CMX

364

Technet24
||||||||||||||||||||

||||||||||||||||||||

file:///C:/Users/MERRELL/Documents/eBook Converter/Oreilly Downloader/tmp/9780135162095/ch06.xhtml#ch06fig34
http://www.apple.com/library/test/success.html
file:///C:/Users/MERRELL/Documents/eBook Converter/Oreilly Downloader/tmp/9780135162095/ch06_images.xhtml#p0371-01a
https://www.cisco.com/c/en/us/td/docs/wireless/mse/10-3/cmx_config/b_cg_cmx103/getting_started_with_cisco_cmx.html
https://technet24.ir
https://technet24.ir
https://technet24.ir


https://<VIRTUAL_IF>/login.html?button-Clicked=4&err_flag=0&redirect_url= http://www.cisco.com

The client here requests a page on the WLC’s virtual interface via HTTPS, so you might need to anticipate a second SSL certificate warning
if the virtual interface’s certificate is a self-signed one or is signed by an unknown authority. The most common option would be to generate
and install a virtual interface’s certificate signed by a known authority or, even if less recommended, you could also disable HTTPS for
Layer 3 Web policies on the WLC itself with the option WebAuth SecureWeb under MANAGEMENT > HTTP-HTTPS.

It is important to note that CMX redirects the client to the WLC’s virtual interface by postponing the option button-Clicked=4: this is what
tells the WLC that everything is fine for passthrough and that the client should be authorized. No further authentication is needed from the
WLC to the local guest database or an external RADIUS server, for example, as we would implement for a WLAN configured with standard
web authentication (for example, a guest portal asking for login and password).

5. Because the WLAN on the WLC is configured for web passthrough, the WLC does not perform any kind of validation on the client. It just
waits for CMX to redirect the client with the option button-Clicked=4 postponed. CMX’s redirection to the WLC’s virtual interface is
triggered by CMX when the client completes whatever actions you require on the guest portal on CMX. For example, if you configure a
portal with a terms and conditions box to check before connecting, then checking that box and clicking Continue triggers the CMX’s
redirection to the WLC’s virtual interface with the button-Clicked=4 option. If you configure a portal with an SMS code to enter, after
entering that code and clicking Continue, CMX triggers the final redirection to the WLC’s virtual interface.

Because the WLC does not perform any authentication for the client, there is no notion of dynamic policies assignment either, as we could
have for web authentications, where a RADIUS server could send back attributes for ACLs, QoS policies, AVC profiles, and so on. It is
important to remember that guest access with CMX Connect does not support per-user policies (very few exceptions discussed later in this
section may apply).

6. After receiving the final HTTP(S) request for its virtual interface with the button-Clicked=4 option postponed, the WLC moves the client to
the RUN state and, if configured, applies locally configured static WLAN policies, such as ACLs, QoS profiles, AVC profiles, and so on.

Figure 6-34 LWA for Web Passthrough with CMX Connect

A figure depicts the concept of LWA with CMX Connect. A tablet device, an Access Point, a WLAN Controller, and an MSE 3365
with Cisco CMX are shown along with the communications happening around them. 1. Association between the tablet and the
AP/WLC. 2. Redirection from AP/WLC to the tablet device with "https://<SERVER_IP>/visitor/Iogin?
switch_url=https://<VIRTUAL_IF>/login.html&ap_mac=<AP _MAC>&client_mac=<CLIENT_MAC>&wlan=<SSID_NAME>"
3. The tablet passes through the AP/WLC to reach the Web Portal, Cisco Live. The screen of the web portal has three text fields
for entering Name, Company Name, and Country. 4. Tablet Submits data to the portal. 5. Portal redirects to the WLC's virtual IF
with "https://<VIRTUAL_IF>/login.html?buttonClicked=4&err_flag=0&redirect_url=http://www.cisco.com." Tablet connects to
the Virtual interface where the following are true: No RADIUS Authentication, No RADIUS Attributes, No Per-User Policy, and All
Guests Have the Same Policies.

When creating a new portal in CMX under CONNECT & ENGAGE > Library > Portals, you can choose between some templates already
proposing different connection techniques, or you can customize your own portal with your preferred elements and connection options. Among
the connection and authentication approaches, we can distinguish the following:

Acceptance of terms and conditions and then a Submit button. This is probably the easiest and most effective option, and it should also be
the preferred one to deploy CMX Connect.

Registration form, whose fields (for example, Name, Email, Country) can be flagged as mandatory. This option adds some statistical
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possibilities from data that users enter in the registration form: those data cannot be verified against specific sources or databases, so they
may be prone to random content injection.

SMS form by asking to fill in a phone number for sending an authentication code. This technique provides an additional level of security
compared to the previous two and is supported with the Twilio SMS platform.

Social login or Facebook Wi-Fi allows administrators to “delegate” login credentials to social networks, as well as to integrate additional
marketing tools. For the example of Facebook Wi-Fi, after the end user is redirected by the WLC to CMX, CMX itself redirects to the
Facebook login page by postponing the instruction to switch back to CMX after completing the needed login steps through Facebook. The
Facebook portal then redirects the user back to CMX by including a token, which CMX verifies against Facebook. If the token is valid, only
at that point does CMX redirect back to the WLC’s virtual interface. Even though almost all is transparent to the end user, we could count
three redirections running in the background with such an approach, as shown in Figure 6-35.

Figure 6-35 CMX Connect Workflow for Facebook Wi-Fi

A figure portrays establishing a connection to Facebook WiFi through CMX Connect. A tablet device, a AP/WLC, a CMX, and the
Facebook WiFi are shown as icons and the communication between these network components is as follows. 1. Association
between the tablet and AP/WLC. 2. AP/WLC redirects the client to CMX. 3. The client device connects to CMX and the CMX
redirects the client to Facebook. 4. The client device tries to connect to Facebook. The Facebook WiFi screen has an option to
Checkin for free internet. After a successful attempt, the WiFi portal redirects the client to CMX with token XYZ. 5. The client
requests the CMX with the token XYZ. The CMX checks with Facebook for authenticating the token and receives a confirmation
from Facebook. 6. The CMX redirects the client to virtual interface. The client's HTTPS connection request is established.

Even if outside the scope of the Wireless CCIE exam, it is worth mentioning that the CMX Cloud supports two additional options for
authenticating guest users: vouchers and email delivery. Vouchers are codes that can be generated through the CMX interface and delivered
via email or printed directly. Similar to the SMS form, CMX Cloud also supports a field for end users to ask directly a voucher from the
guest portal, for it to be delivered via email.

While on the WLC you always configure the same local URL for redirecting to CMX, end users are actually presented (by CMX) with one
portal or another based on their location. Under CONNECT & ENGAGE > Connect Experiences you can assign portals to different locations,
at a campus, building, floor or even zone level.

One further option you should be aware of in CMX Connect is the support for Property Management System (PMS) solutions and policy plans.
Under certain assumptions, this could be the one exception to the previous statement in this section about the fact that with CMX Connect you
cannot implement per-user dynamic policies. PMS solutions are often used in hospitality environments, for example, to manage rooms and
services associated with their guests. CMX supports a connector to these external solutions allowing embedding PMS options in guest portals. It
also integrates so-called policy plans, which are rate limiting policies.

For policy plans to be supported, the configuration on the WLC should be slightly different than what we saw so far for web passthrough.
Instead of web passthrough, you should configure the Layer 2 security option for MAC Filtering and the Layer 3 security option for web policy
On MAC Filter Failure. Also, under the AAA Servers tab, you should point the WLAN to CMX as a RADIUS server. The behavior now is for
the WLC to attempt authenticating clients through their MAC addresses first, then to fall back to web authentication if that fails. When a
client’s MAC is authenticated against CMX during the initial connection, CMX is still not aware of that MAC address, so that authentication
fails and the WLC redirects the client to the guest portal on CMX. On the portal the client completes the needed actions, CMX redirects it to the
WLC’s virtual interface to be put into the RUN state. At this point the requirement would be for the client to manually reconnect, so that the
WLC can trigger a new MAC address authentication against CMX, which succeeds because CMX now already saw that MAC address. We
should clarify at this stage that a configuration step on CMX requires activating a FreeRadius server integrated into CMX itself, precisely to
authenticate MAC addresses. As a final result of the MAC address authentication, CMX acting as a RADIUS server passes back to the WLC the
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corresponding attributes to affect rate limiting for that client’s session.

Although this could be seen as some kind of technique to dynamically assign bandwidth contracts, it might reveal itself not fully usable in the
most common use cases because it requires the client to manually reconnect so that a second MAC address authentication can trigger dynamic
bandwidth contracts assignment via RADIUS attributes from CMX.

If needed, the full configuration details for such a specific use case can be found in the dedicated chapter for CMX Connect and Engage of the
official “Cisco CMX Configuration Guide, Release 10.3 and Later”:

https://www.cisco.com/c/en/us/td/docs/wireless/mse/10-3/cmx_config/b_cg_cmx103/the_cisco_cmx_connect_and_engage_service.html

CleanAir

You can implement interferences detection and mitigation through the WLC and access points supporting the Cisco CleanAir technology. MSE
and CMX add on top location tracking, statistics, and history reports for such interferences. The location technique is based on trilateration for
interferers’ signal strength, similar to Probe RSSI in terms of accuracy levels. We mentioned both MSE and CMX because at the moment of this
book’s writing there still are some functional differences in interferences tracking between MSE 8.0 and CMX 10:

Both MSE and CMX support locating interferers on maps, and both solutions report (X,Y) coordinates to Prime Infrastructure for
interferences and zones of impact to be displayed on maps.

With MSE 8.0 you can integrate interferers information in Prime Infrastructure for client reports and troubleshooting, as well as for
CleanAir widgets under Dashboard > Wireless > CleanAir, for example. Figure 6-36 shows an example of these widgets with Air Quality
data already available without the need for MSE or CMX.

Figure 6-36 Example of CleanAir Widgets in Prime Infrastructure Without Any MSE or CMX

A screenshot shows the CleanAir Widget open in the Prime Infrastructure. Under Dashboard, Wireless is displayed in the window.
It has four tabs: Security, Mesh, CleanAir, and Contact Aware. The CleanAir tab is selected. The content area shows data related to
an 802.11b/g/n wireless connection. The start and end dates can be chosen from drop-down menus with the Zoom (time period) set
to 1 year. The result is in the form of a graph. At the bottom, another data related to an 802.11a/n wireless connection. On the right,
four more sections are listed and they are Worst 802.11a/n Interferers, Worst 802.11b/g/n Interferers, 802.11a/n Interferer Count,
and 802.11b/g/n Interferer Count.

With CMX 10.3 or earlier you cannot integrate interferers information in client reports and troubleshooting, and not in CleanAir widgets
either. However, you can still view CleanAir widgets in Prime Infrastructure for air quality statistics, because those data do not require MSE
or CMX to be displayed. It is not unlikely that future versions of Prime Infrastructure and CMX could support these types of information, as
with MSE 8.0 today.

Interferences detection plays an important role for BLE beacons location and management too. Although CMX has dedicated options and
menus to manage BLE emitters on maps, information on beacons are based on the whole CleanAir solution. Access points classify BLE beacons
as such, and pass data to the WLC always as part of “standard” CleanAir operations, which in turn push the information to CMX. It is CMX
that uses these specific data from CleanAir for dedicated features, separating BLE beacons from typical interferers.
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Wireless Intrusion Prevention System

Wireless Intrusion Prevention System (WIPS) generally refers to the set of features for detecting and, when possible, mitigating attacks on
wireless networks. The acronym is sometimes used to designate different solutions, depending on the available components. For the sake of
precision, we should first clarify the real terminology in Cisco Unified Wireless Networks:

Intrusion Detection System (IDS) represents the native set of options on a WLC, which allows detecting attacks based on a list of 17 pre-
canned signatures. Custom signatures are supported too, although they are very rarely implemented. On top of being already included in the
WLC’s features, the main advantage of IDS is that it enables an already good level of security by supporting detection for the most common
types of attacks. For these attacks you can configure SNMP traps on the WLC, as well as the corresponding alarms on Prime Infrastructure;
IDS does not support any prevention or mitigation feature.

It is important to keep in mind that the WLC alone supports some prevention and mitigation techniques using specific features, such as
Rogue AP containment (manual or autocontainment with rules) or Management Frame Protection (MFP), for example.

Adaptive WIPS (aWIPS) is the proper solution for advanced signatures and mitigation techniques, through the integration with MSE 8.0.
This is the solution that enables additional signatures detection and some prevention options, which we discuss in this section.

You may find some documentation still referring to IDS as WIPS, sometimes even including rogue access points detection under this acronym.
However, because only aWIPS supports some true prevention features, this is technically the solution we can also refer to as WIPS (or wIPS, in
some menus and guides).

MSE 8.0 is the software solution supporting aWIPS. When you integrate MSE in Prime Infrastructure for aWIPS and synchronize it with the
corresponding WLC, additional detection options are enabled on the access points, and the WLC will report such information to MSE for
further analysis and signature categorization. As a general approach, you could think of aWIPS as an even more advanced set of IDS signatures
and reporting tools. For some attacks, however, you can enable some containment techniques. You can enable WIPS signature detection on
access points through either of the following deployment options:

You can install access points in Monitor mode next to access points dedicated to serving clients, as shown in Figure 6-37. This is the oldest
and most effective technique, although it could be more expensive because of the higher number of access points to deploy. Its
effectiveness comes from the fact that a dedicated access point with both its radios monitoring the spectrum can scan both 2.4 GHz and 5
GHz frequency bands in parallel. An initial, general guideline is to plan for at least one access point in Monitor mode for every five access
points serving clients, but this may vary depending on other deployment requirements and physical structure of the environment. When
configuring the access point on the WLC, you need to set its AP Mode to Monitor and its AP Sub Mode to WIPS. Changing the AP Mode
to Monitor requires the access point to reboot, but changing the AP Sub Mode does not require any reboot.

Figure 6-37 WIPS Deployment Option with Data Serving and Monitor Mode APs
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The antenna type shown in the screenshot is "AIR-ANT2524DB-R-5GHz" and dual-band of frequency 2.4 to 5 GigaHertz, and
dipole of gain 4 dbi. A map shows the coverage area in which it is tilted down to the left facing from the south side.

3600 and 3700 series access points supporting the WSM module can use WSM radios for monitoring, while continuing to serve clients
through their “standard” integrated 2.4 GHz and 5 GHz radios, as shown in Figure 6-38. One of the main advantages here is cost reduction
for the physical installation, because you would not need to plan for additional access points, cables, mounting kits, and the like. The WSM
module keeps scanning all channels sequentially, first on the 2.4 GHz and then on the 5 GHz band. It is slightly different from an access
point in Monitor mode, which scans both bands in parallel, but technically this option supports the detection for the same attacks.

Figure 6-38 WIPS Deployment Option with 3600/3700 APs and the WSM Module

In the figure, the WiFi module with AP 3600/3700 with WSSI/WSM, configured for data, wIPS, and CleanAir is shown. The data is
on both standard bandwidths: 2.4 gigahertz and 5 gigahertz. The server is open for access through both 2.4 and 5 gigahertz. The
client accesses through either of the bandwidths.

To configure the WSM module for WIPS, you set the AP Sub Mode to WIPS while keeping the AP Mode set to local or FlexConnect mode,
for example, for client serving purposes.

The 2800 and 3800 series access points, apart from the standard 5 GHz radio, integrate a Flexible Radio Assignment (FRA) radio, which
could serve clients either on the 2.4 GHz (default behavior) or on the 5 GHz band. On top of that, the FRA radio also supports the same
monitoring capabilities as a WSM module for the 3600 and 3700 series access points. If you assign the monitor role to the FRA radio, as
shown in Figure 6-39, the standard 5 GHz radio can keep serving clients on that band and you can support the same WIPS options as with
the previous technique. When configuring the FRA radio for the monitor role on 2800/3800 access points, clients on the 2.4 GHz band will
not be supported anymore.
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Figure 6-39 WIPS Deployment Option with 2800/3800 APs and the FRA Radio

In the figure, the WiFi module with AP 2800/3800, configured for data on 5 gigahertz, wIPS, and CleanAir on 2.4 and 5 gigahertz is
shown. The data is on both standard bandwidths: 2.4 gigahertz and 5 gigahertz. The server is open for access through both 2.4 and 5
gigahertz. The client accesses through either of the bandwidths. The server serves through 5 gigahertz. The bandwidths 2.5 and 5
gigahertz are open with channels from 1 to 161.

Even without WSM modules or access points supporting the FRA radio, one more option consists in keeping your access points configured
for serving clients (that is, in local or FlexConnect mode) and to set their AP Sub Mode to WIPS. As shown in Figure 6-40, this
configuration is called Enhanced Local Mode (ELM) and could be a good compromise for cost-sensitive deployments that still need some
WIPS capabilities. With this technique, the main purpose for the access points stays serving clients and, on a best-effort basis, it can go off-
channel to scan for attacks. Because of the best-effort nature of this option, ELM does not support the same full list of attacks as with the
previous techniques. The full lists of supported and unsupported attacks can be found in the official “Cisco Adaptive wIPS Deployment
Guide”:

https://www.cisco.com/c/en/us/td/docs/wireless/technology/wips/deployment/guide/WiPS_deployment_guide.html

Figure 6-40 WIPS Deployment Option with Enhanced Local Mode (ELM)
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In the figure, a WiFi module configured with Enhanced Local Mode (Supported on FlexConnect too) for Data, wIPS, and CleanAir
is shown. The data is on 2.4 and 5 gigahertz and the wIPS is on all channels (Best Effort). In both bandwidths (2.4 and 5 gigahertz),
there is a break in the serving channels, marked as off-channels.

After having deployed your access points with any of the aforementioned WIPS detection techniques, you can start configuring MSE 8.0
directly from Prime Infrastructure. Prime Infrastructure pushes WIPS profiles (more on this in the next paragraphs) to MSE 8.0 via SOAP/XML
(on TCP port 443 on MSE), which in turn communicates with the WLC via NMSP, sharing the WIPS profile with all its access points through
CAPWAP. Figure 6-41 shows a brief workflow of such interactions. When access points detect an attack, the WLC forwards the alarm to MSE,
still via NMSP, for MSE to then generate an SNMP trap to Prime Infrastructure for reporting purposes.

Figure 6-41 Interactions Between Prime Infrastructure, MSE, and the WLC for WIPS

In the figure, the Prime infrastructure is connected to two WLCs through SNMP (represented using dashed, double-headed arrows). It is
also connected to an MSE through SOAP/XML Over HTTP/HTTPS (solid, double-headed arrows). The MSE is connected to the two
WLCs, through NMSP Over SSL. Four Access Points are connected to the WLCs, two each, established through CAPWAP. Four
devices are connected wirelessly to the four access points, one each.

Apart from the MSE 8.0 installation itself, the entire configuration for MSE, WIPS profiles, and alarms is done through Prime Infrastructure. A
key concept to note is that aWIPS usually allows reporting, analyzing, and sometimes mitigating wireless attacks. It also supports location of
attackers on maps, although the accuracy depends on the deployment of access points with WIPS detection capabilities enabled. Location of
attackers is available if MSE 8.0 is configured for Context Aware Services (CAS) too, with the corresponding licenses.

For the purpose of the written Wireless CCIE exam, we will focus on the main theory behind deploying WIPS profiles and their options, leaving
all the details on the configuration steps to the official “Cisco Adaptive wIPS Deployment Guide”:

https://www.cisco.com/c/en/us/td/docs/wireless/technology/wips/deployment/guide/WiPS_deployment_guide.html

After you have installed MSE 8.0 and synchronized it with your WLC(s), a default WIPS profile is already applied to monitor attacks against
access points and SSIDs managed by your WLC(s). You can add new profiles, either by copying the default one and modifying it, for example,
or by starting from other available templates, which are predefined in Prime Infrastructure based on most common use cases (for example,
education, financial, retail). WIPS profiles in Prime Infrastructure are available under Services > Mobility Services > wIPS Profiles. After
having added a new profile, Prime Infrastructure asks you for an optional SSID Group to apply that profile to. If you don’t choose any SSID
Group, the WIPS profile by default monitors attacks launched against access points and WLANs in your infrastructure. From the SSID Group
List menu you can optionally specify whether attacks should be monitored against specific internal/external SSIDs, as shown in Figure 6-42.
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Figure 6-42 Example of SSID Groups of wIPS Profiles in Prime Infrastructure

In the screenshot, the SSID Group List is shown on the screen inside the path: Services/Mobility Services/wIPS Profiles. A table with
the first column containing checkboxes in each row and the rest of the columns with headers Name and SSID List is displayed. The
fields under Name, in this screenshot, are Any, Guest, MyWLAN, Neighbor, and Other. The screen has Next, Save, and Cancel buttons
at the bottom left.

Note

Even if configuring an SSID Group is optional, several attacks and their policy rules are already preconfigured for some SSID Groups, such as
MyWLAN, Guest, and Neighbor, for example. You may therefore want to specify your own organization’s SSIDs under one of those groups,
according to specific attacks and policy rules that should be applied.

The next steps in a WIPS profile’s configuration are attacks and their policy rules. Even though modifying these settings is not common, policy
rules under each attack let you fine tune severities for notifications and other actions. Actions under policy rules are not all the same for each
attack, and they can include the generation of a forensic file, or even containment, for example. A typical example of an attack that you can
optionally modify for containment is the Honeypot AP, meaning an external AP serving an open SSID with the same name as one of those
specified in your organization (by default, SSIDs configured under the MyWLAN group), as shown in Figure 6-43. Policy rules for a Honeypot
AP attack can be modified to include a containment action: access points from your infrastructure can attempt to send deauthentication frames
to clients trying to associate to the Honeypot AP by spoofing the Honeypot AP’s radio MAC, to “contain” its impact. The other typical option
for policy rules is to configure notifications in the form of a forensic file. This does not generate a typical notification like a syslog or an SNMP
trap, but rather enables wireless traces on the access points for packets that trigger the alarm of an attack. Forensic files are available for
download under the WIPS alarm details in Prime Infrastructure, but they create additional traffic between the WLC and MSE, so it is generally
not recommended to activate them for all attacks.
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Figure 6-43 Example of a Honeypot AP

In the diagram, a WLC is connected to two access points through CAPWAP. Two devices are connected to the two access points, one
each, with their SSIDs named CCIE-SSID. A malicious access point with the same CCIE-SSID (Non-secured, or secured, through a
malicious RADIUS Server etc) tries to transmit and attack.

After applying a new WIPS profile to a selected controller, MSE pushes the corresponding attacks and policy rules configuration to that WLC,
which applies them to its access points with WIPS monitoring capabilities enabled.

As you have seen so far, WIPS profiles enable you to apply different sets of signatures and action policies from a predefined database of
attacks. This database usually covers almost any customer’s need for WIPS, but for even more attack detection capabilities the WLC supports
custom IDS signatures. As the term says, these are IDS signatures for reporting purposes only and can be implemented from the WLC directly,
by downloading a custom signature file to the controller under COMMANDS > Download File with the option Signature File for the file type.
A signature file is a text file, where each line specifies the rules for generating an attack detection, and actions if needed. A typical custom IDS
rule looks like the following:

Click here to view code image

Name = "Custom EAPOL flood", Ver = 0, Preced= 12, FrmType = data, Pattern =
0:0x0108:0x03FF, Pattern = 30:0x888E:0xFFFF, Freq=50, Quiet = 300, Action =
report, Desc="Custom EAPOL Flood Attack"

All the details on these variables and how to configure custom IDS signatures are available in the official “Wireless LAN Controller IDS
Signature Parameters”:

https://www.cisco.com/c/en/us/support/docs/wireless-mobility/wireless-lan-wlan/69366-controller-ids-sig.html

Let’s quickly focus on the most significant parameters from the aforementioned example. As shown in Figure 6-44, apart from the self-
explaining name, version, and precedence parameters, FrmType specifies the type of wireless frame for which patterns need to be checked, and
this can be either for management (mgmt) or data frame types. A pattern is defined in the form of <offset>:<result>:<mask> and is considered
a match if, by applying the specified mask at the offset starting from the beginning of the frame payload, you obtain the configured result. Freq
tells the access point how many times patterns have to be matched in a specific interval (1 second by default, if not otherwise specified) to
trigger the attack detection and action. The Quiet period in seconds is used to clear the alarm if not detected anymore within that duration.
Figure 6-44 might help visualize how all the different custom IDS signature’s parameters are applied to a wireless frame displayed over
Wireshark.
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Figure 6-44 Custom IDS Signature Example

In the screenshot, the custom IDS signature is as follows: Name = "EAPOL flood" Ver = 0, Preced = 12, FrmType = data. Pattern = 0 0
cross 0108 0 cross 03FF Pattern = 30:0x888EL0xFFFF Freq = 50, Quiet = 300, Action = report, Desc = "EAPOL Flood Attack."
Below, the parameters of the IDS signature are mapped to a wireless frame. FrmType denots the Frame Type, in the parameter Pattern,
the first 0 represents the Offset from the beginning of the frame; 0 cross 0108 represents Result to Obtain; 0 cross 03FF indicates Mask
to Apply. The second set of Pattern denotes the Additional Pattern. Freq is the Number of Frames per interval (if not configured, 1 sec
by default). Quiet denotes the Period of Time (in secs) during which the pattern must not occur, for the alarm to stop.

Note

When aWIPS is deployed, IDS signatures are automatically disabled on the WLC because standard IDS detectable attacks are already supported
with aWIPS. If you need to support custom IDS signatures, you should reenable IDS detection on the WLC under SECURITY > Wireless
Protection Policies > Custom Signatures.

NMSP

Network Mobility Service Protocol (NMSP) is the Cisco proprietary protocol for all communications between the WLC and MSE or CMX. It is
TLS based on TCP port 16113 on the WLC, with CMX itself initiating the TLS tunnel, and requires a certificate’s hash validation between the
WLC and MSE/CMX. For such validation, when you point CMX to a WLC by specifying the controller’s SNMP credentials, CMX uses SNMP
to configure the WLC with the key hash from its own Self-Signed Certificate (SSC).

On the WLC you can see the key hash entry added by CMX under SECURITY > AAA > AP Policies > AP Authorization List, or through
the command show auth-list. An entry for CMX will show up with the value LBS-SSC-SHA256 (LBS, Location Based Services) under the
Certificate Type column. Usually you should not need to change this entry manually on the WLC, but if required you can find the key hash
value that CMX should have pushed to the WLC by directly typing the following command from the CMX’s CLI, through the cmxadmin
account: cmxctl config controllers show. The CMX’s certificate key hash used for the WLC is the one for SHA2 Key.

Another main requirement for NMSP to work is time synchronization between the WLC and CMX. The recommended best practice is to
configure NTP, for both the WLC and CMX toward the same NTP server (for Prime Infrastructure too). If NTP is not available, you should
configure the WLC’s clock to be the same or slightly ahead of the CMX’s one.

The easiest and quickest way to verify the NMSP connectivity between the WLC and CMX is through the commands show nmsp status on the
WLC and cmxctl config controllers show on CMX.

Note

Although not specifically part of the Wireless CCIE exam, you should be aware that the NMSP communication between the WLC and CMX
Cloud is based on HTTPS. This was introduced with AireOS 8.2, through a proxy HTTPS option and as a native HTTPS connection option on
the WLC as of AireOS 8.3.

Summary

As you may have noticed, as a CCIE Wireless candidate, you should be aware of the different roles played by MSE 8.0 and CMX 10, the
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former for location use cases, aWIPS and integration with Prime Infrastructure, the latter as an evolution of those location use cases and
sometime more targeted to integrating with third-party ecosystems and business applications.
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Chapter 7

WLAN Media and Application Services
Introduction

Providing differentiated treatment for different types of applications is a difficult challenge for Wi-
Fi networks (and CCIE candidates). Wi-Fi networks are inherently unstable. Speeds are half
duplex, overhead renders the links less deterministic, devices move, and users tend to bring old
devices that disrupt the performance of your latest shiny fast phone or laptop.

In this context, providing a good application experience for your users requires a combination of
sound RF design, a good understanding of your client database, and a solid background in QoS
foundations and QoS configuration. This last aspect is difficult to acquire because you will find that,
in AireOS, QoS features that saw light in the early days of Wi-Fi QoS (and are now nearly obsolete)
stand next to QoS features that just appeared in the 802.11 standard. This chapter will help you
triage all these elements and give you the basis you need to provide a good quality experience to
your users. You should also be able to face the exam in confidence. This chapter is organized into
two sections. The first section gives you the technical background you need to understand
application differentiated services over Wi-Fi. The second section shows you how these elements
are configured on the various platforms, AireOS, switches, and Autonomous APs. More
specifically, the two sections are organized as follows:

Section 1 provides the survival concepts needed to understand QoS over 802.11. This section
first introduces the notion of differentiated services to help you understand DSCP markings and
IP Precedence. These notions are then related to QoS design and the concept of traffic classes.
Operating QoS classes implies recognizing traffic, and the following subsections explain how
traffic is identified and marked, with Layer 3 techniques for IPv4 and IPv6, and with Layer 2
techniques, with 802.11e and also 802.1Q, 802.1D, and 802.1p, to which 802.11e often gets
compared. This first section then examines different techniques to handle congestion.

Section 2 covers the configuration of differentiated treatment for application services over the
various architectures. The first architecture to be covered is AireOS, and you will see how QoS
profiles, bandwidth contracts, QoS mappings, and trust elements are configured. You also learn
how to configure congestion management techniques, including EDCA parameters, CAC, and
AVC. You then see how Fastlane creates specific additions for iOS and MacOS devices. You
then learn how application services are configured for autonomous APs. Quite a few items
available on AireOS are also configured on autonomous APs; however, autonomous APs are
Layer 2 objects. Therefore, they present some variations that you need to understand and
master. Finally, you will see how QoS is configured on switches. Your goal is not to become a
QoS expert but to be able to autonomously configure a switch to provide a basic support for the
QoS policies you configured on your WLAN infrastructure.

Chapter 7 WLAN Media and Application Services

376

Technet24
||||||||||||||||||||

||||||||||||||||||||

https://technet24.ir
https://technet24.ir
https://technet24.ir


At the end of this chapter, you should have a good understanding of real-time application support
for wireless clients.

QoS Survival Concepts for Wireless Experts

QoS is not a static set of configuration commands designed long ago by a circle of wise network
gurus and that are valid forever. In fact, QoS models, traffic definitions, and recommendations have
evolved over the years as common traffic mixes in enterprise networks have changed. With new
objects (such as IoT), new protocols, and new traffic types, QoS continues to evolve. However, you
do not need to be a QoS expert to pass the CCIE Wireless exam, you just need to understand the
logic of QoS and survive by your own, configuring standard QoS parameters that will affect your
Wi-Fi network’s most sensitive traffic (typically Voice). In short, your task is to understand QoS
well enough to make Voice over Wi-Fi work.

The Notion of Differentiated Treatment

Let’s start with a quiz question: What is the second most configured feature in Cisco networking
devices? If you read the title of this chapter, then you probably guessed: QoS (the first one is
routing).

QoS is therefore a fundamental concept. However, to help you survive the complexities of the
CCIE lab exam, but also to help you face real deployment use cases, we need to dispel a few
legends. The first legend is that QoS is about lack of bandwidth and that adding bandwidth solves
the problem and removes the need for QoS. This is deeply untrue. QoS is about balance between
the incoming quantity of bits per second and the practical limitations of the link where these bits
must be sent.

Let’s look at a nonwireless example to help clarify this concept. Suppose that you need to send a
video flow over a 1 Gbps switch interface. The communicated bandwidth, 1 Gbps, is only an
approximation over time of the capacity of the link. One gigabit per second is the measure of the
transmission capability of the Ethernet port and its associated cable (over 1 second, this port can
transmit one billion bits). But behind the port resides a buffer (in fact probably more than one, each
buffer being allocated to a type of traffic), whose job is to store the incoming bits until they can be
sent on the line, and a scheduler, whose job is to send blocks of bits to the cable.

A high-end switch buffer can store 5.4 MB. If the switch port is built around the notion of four
queues, that’s 1.35 MB per queue. Now, your port can send 1 gigabit per second, which translates
to about 125 kilobytes per microseconds. If you map the buffer to the link speed, you see that the
buffer can store up to 10.8 ms of data before being filled up.

Suppose that your switch receives a flow of video packets, representing a modest 2 MB burst
intended to draw a full 32-color 1080p video frame. You can immediately see that, even if the port
is completely idle before the burst arrives from within the switch bus (let’s assume that the internal
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bus is faster than 1 Gbps; a common speed for a good switch can be around 480 Gbps), the buffer
can saturate long before the entire flow is stored and then transmitted on the line, as shown in
Figure 7-1.

Figure 7-1 QoS Design Considerations

In the figure, a graph depicts the QoS Design for an example GE Linecard. The question
with respect to the context of the graph is, How long can queue buffers accommodate line-
rate bursts. The horizontal axis represents time in milliseconds ranging from 10 to 970, in
increments of 10. The entire horizontal axis represents one second. The vertical axis
represents KB per milliseconds ranging from 0 to 140, in increments of 20. The Gbps line
rate is representing using a horizontal line drawn where KB Perms equals 125. The line-rate
denotes the GE Linecard example (WS-X6148) and is described "Begin dropping at 11
milliseconds but overall utilization is only 1 percent!" Further, the rest of the information
furnished in the figure are as follows. Total Per-port Buffer: 5.4 MB; Total Per-queue
Buffer (Assuming (4) Equal-sized Queues): 1.35 MB; Gbps Line Rate: 1 Gbps = 125 MBps
or 125 KB per milliseconds; Total Per-queue Buffering Capacity: 10.8 ms.

From the outside, you see a modest 2 MB burst of packets, a very low link utilization (less than
1%), and yet several bytes are dropped. The issue is that 2 MB should never have been sent to that
queue in less than 11 ms, and this is where QoS comes into play. Here, more bandwidth does not
solve the problem (you already have enough bandwidth, and your link utilization is overall less than
1%). What solves the problem is making sure that the right quantity of packets gets through the
interface buffer in a reasonable amount of time, so as not to saturate the interface beyond capacity.

The same issue can be seen in the wireless world. Suppose that you send voice packets, using no
QoS (best effort) from a smartphone to an access point. These packets are very small (one audio
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payload can typically represent 160 bytes), so bandwidth is typically a non-issue. Yet, oblivious to
the presence of voice traffic (as you use best effort), the AP suddenly jumps to another channel to
scan (RRM). The AP is likely to be gone for about 80 ms, during which your phone will fail to
receive an ACK for the last voice packet, will retry many times while rate shifting down, then drop
the packet and attempt to send the next one, and so on. When the AP returns to the channel, you
will have lost three consecutive packets, which is enough for the user to detect a short drop in the
audio flow and complain about Wi-Fi. Yet, troubleshooting the issue will show no oversubscription
of the link. The issue is not bandwidth. The issue is that proper priority was not given to this real-
time traffic over other tasks. Typically, 30 ms in the cell is the maximum time interval allowed for a
Wi-Fi driver to send a real-time voice frame (UP 6). After that delay, this type of frame is dropped
from the queue. Here again, the solution is not more bandwidth but proper servicing over time of
packets based on their specific category. In other words, ensure that voice packets are not delayed
for more than 30 ms in the cell, regardless of the available bandwidth. This is again what QoS does.

Another lasting legend about QoS is that it should be configured on weak links (typically, WAN and
Wi-Fi). However, QoS is not a Wi-Fi or a WAN problem—it is an end-to-end problem. Each
medium has unique characteristics, and the complexity of configuring QoS is to make sure to
translate the requirements of each traffic type into configurations adapted to the local medium.
Therefore, you need a mix of global configurations and local particulars to express a global QoS
intent for each traffic and translate this intent to each local medium specific constraints. As you
saw from the bandwidth urban legend, your Wi-Fi could be configured for QoS and yet traffic
could be dropped on the switch side, if you neglected the LAN side because of its large bandwidth.

This end-to-end concern, and also the fact that Wi-Fi is one of the weakest links, are the reasons
why the CCIE Wireless exam expects from you the ability to configure QoS for Wi-Fi but also have
reasonable knowledge on how the intent you expressed through your Wi-Fi QoS configuration
would translate on the switch port to your access point or your WLC. You do not need to be a QoS
expert, but you must be able to verify that QoS will not stop at the AP or WLC port. This ability
translates into the knowledge of the different families of traffic and the various possibilities brought
by QoS to offer a different treatment for different types of traffic: prioritize urgent business-
relevant traffic and delay or drop traffic of lower urgency or importance depending on the link
capacity.

Traditionally, these requirements translate into different possible types of actions and mechanisms:

QoS Design: Your first task is to determine which traffic matters for your network. Most of the
time, this determination will bring you to create different categories of traffic.

Classification and marking: After traffic starts flowing and enters your network, you must
identify it; when identification is completed, you may want to put a tag on each identified
traffic packet so as not to have to run the identification task at every node.

Congestion management tools: When congestion occurs, multiple tools can help manage the
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available bandwidth for the best. In traditional QoS books, this section would cover many
subsections, such as Call Admission Control mechanisms, policing, shaping, queue
management, and a few others. In the context of the CCIE Wireless exam, you need to
understand the main principles, and we will group under this category topics that matter for
you.

Link efficiency mechanisms: On some links, you can compress or simplify packets to send the
same amount of information using less bandwidth. This is especially important on WAN
connections but is completely absent from Wi-Fi links. You will find efficiency mechanisms for
Wi-Fi, such as MIMO, blocks, and a few others, and they do improve transmissions. However,
this is not efficiency in the sense of transmission compression or simplification. The term link
efficiency is important to know in the context of QoS, but you will not need to implement such
a mechanism, with a QoS approach, for Wi-Fi.

The listed actions and mechanisms have different relative importance for the CCIE Wireless exam.
The following sections cover what you need to know, and we refer to the category names along the
way to help your learning.

QoS Design

Just as you do not start building a house without a blueprint, you also do not start configuring QoS
without a QoS blueprint. This blueprint lists the types of traffic that you expect in your network and
organizes these types into categories. As a Wireless CCIE, your job is not to build an enterprise
QoS blueprint. However, a basic understanding of what this blueprint covers will help you reconcile
the apparent inconsistencies between 802.11e QoS marking and DSCP/802.1p marking, and will
also show you why some vendors get it right and others do not.

The main concern behind this QoS blueprint, often called a QoS model, is about arbitration between
packets. Suppose you have two packets that get onto an interface (toward any type of medium).
Suppose that you have to decide which packet to send first (because your outgoing medium has a
slower data rate than wherever these two packets came from), or you have to decide to pick one to
send and drop the other (because your interface buffer cannot store the second packet, and because
the second packet will not be useful anymore if it is delayed, or for any other reason). If you have
built a QoS model, and if you know which packet belongs to which class in that model, you can
make a reasonable choice for each packet.

A very basic QoS model runs around four classes: real-time traffic (voice or real-time
conferencing), control traffic for these real-time flows (but this category also includes your network
control traffic, such as RIP updates), data, and everything else. Data is often called transactional
data, and it matches specific data traffic that you identified as business relevant and that you care
about, such as database traffic, email, FTP, backups, and the like. Everything else represents all
other traffic that may or may not be business relevant. If it is business relevant, it is not important
enough that it needed to be identified in the transactional data category.
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The four-queue model is simple and matches the switching queuing structure available in old
switches (and vice versa; the switches queues were built to match the common QoS model
implemented by most networks). This model was common 15 years ago, but it proved a bit too
simple and over the years was replaced by a more complex 8-class model. Keep in mind that this
was during the 2000s (you will see in a few pages why this is important).

The 8-class model separates real-time voice from real-time video. One main reason is that video
conferencing increased in importance during these years. If you happen to use video conferencing,
you probably notice that the sound is more important than the image. If your boss tells you that you
are “…ired,” you want to know if the word was hired or fired. Sound is critical. However, if your
boss’s face appears to pixilate for a second, the impact on the call is lower. Also, real-time video is
video conferencing, and the 4-class model did not have a space for streaming video. It is different
from transactional data because it is almost real-time, but you can buffer a bit of it. By contrast,
video conferencing cannot be buffered because it is real-time.

Similarly, network control updates (like RIP or EIGRP updates) are not the same as real-time
application signaling. As you will see in the next section, real-time application signaling provides
statistical information about the call. It is useful to know if, and how, the call should be maintained.
You can drop a few of these statistical packets without many consequences. Of course, if you drop
too many of these packets, the call will suffer (but only one call will suffer). By contrast, if you
drop EIGRP updates, your entire network collapses. The impact is very different, and putting both
in the same control category was too simplistic.

Finally, there is clearly all the rest of the traffic, but there is also a category of traffic that you know
does not matter. A typical example is peer-to-peer downloads (such as BitTorrent). In most
networks, you want to either drop that traffic or make sure that it is sent only if nothing else is in
the pipe. This traffic is called scavenger and should not compete with any other form of traffic,
even the “Everything else” traffic that may or may not be business relevant.

The result is that the 8-class model implements the following categories: Voice, Interactive Video,
Streaming Video, Network Control, (real-time traffic) Signaling, Transactional Data, Best Effort,
and Scavenger.

The 8-class model is implemented in many networks. In the past decade, another subtler model
started to gain traction, which further breaks down these eight classes. For example, the Network
Control class is divided in two, with the idea that you may have some network control traffic that is
relevant only locally, whereas some other network control traffic is valid across multiple sections of
your network. Similarly, real-time video can be one way (broadcast video of your CEO’s quarterly
update) or two ways (video conferencing). Usually, the broadcast is seen as more sensitive to delay
and losses than the two-way video because the broadcast impacts multiple receivers (whereas an
issue in a video-conference packet usually impacts only one receiver). Also, some traffic may be
real time but not video (such as gaming). With the same splitting logic, a single Transactional Data
category came to be seen as too simple. There is indeed the transactional data traffic, but if there is

Chapter 7 WLAN Media and Application Services

381

||||||||||||||||||||

||||||||||||||||||||

https://technet24.ir
https://technet24.ir


a transaction, traffic like FTP or TFTP does not fit well in that logic. Transactional should be a type
of traffic where a user requests something from a server and the server sends it (ERP applications
or credit card transactions, for example). By contrast, traffic such as file transfers or emails is
different. This type of traffic can be delayed more than the real transactional data traffic and can
send more traffic too, so it should have its own category. In fact, it should be named bulk data. In
the middle (between the transactional data and the bulk data classes), there is all the rest, which is
business-relevant data that implies data transfer but is neither transactional nor bulk. Typically, this
would be your management traffic, where you upload configs, code updates, your telnet to
machines, and the like. This class is rightly called Network Management (or Operations,
Administration and Maintenance, or OAM).

This further split results in a 12-class model, with the following categories:

1. Network Control and Internetwork Control

2. VoIP

3. Broadcast Video

4. Multimedia Conferencing

5. Real-time Interactive

6. Multimedia Streaming

7. Signaling

8. Transactional Data

9. Network Management (OAM)

10. Bulk Data

11. Best Effort

12. Scavenger

A great document to learn more about these categories (and, as you will see in the DSCP part, their
recommended marking) is the IETF RFC 4594 (https://www.ietf.org/rfc/rfc4594.txt).

Keep in mind that there is not a “right” QoS model. It all depends on what traffic you expect in
your network, how granular you want your categorization to be, and of course, what you can do
with these classes. If your switches and routers have only four queues (we’ll talk about your WLC
and APs soon), having a 12-class model is great, but probably not very useful. You may be able to
use your 12 classes in a PowerPoint but not in your real network.
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In most networks, though, starting from a 12-class model allows the QoS designers to have fine-
grained categories that match most types of traffic expected in a modern network. When some
network devices cannot accommodate 12 categories, it is always possible to group categories into
common buckets.

Application Visibility and Identification

Although QoS design should be your first action, it implies a knowledge of QoS mechanisms and
categories. It is therefore useful to dwell on classification fundamentals, especially because Wi-Fi
has a heavy history in the classification field.

Classifying packets implies that you can identify the passing traffic. The highest classification level
resides at the application layer. Each application opens a certain number of sockets in the client
operating system to send traffic through the network. These sockets have different relative
importance for the performances of the application itself.

An example will help you grasp the principles. Take a voice application like Jabber. When the
application runs, your smartphone microphone records the room audio, including (hopefully) the
sound of your voice. Typically, such an application splits the audio into small chunks, for example,
of 20 milliseconds each.

Note

You will find that there can be a lot of complexity behind this process, and that the process
described here is not strictly valid for all applications. For example, some applications may slice
time in chunks of 20 ms but record only a 10-millisecond sample over that interval, and consider it
a good-enough representation of the overall 20 millisecond sound. Other applications will use 8 or
10 millisecond slices, for example.

Each 20-millisecond audio sample is converted into bits. The conversion process uses what is called
a codec (to “code” and “decode”). Each codec results in different quantities of bits for the same
audio sample. In general, codecs that generate more bits also render a sound with more nuances
than codecs with a smaller bit encoding. A well-known reference codec is G.711, which generates
about 160 bytes (1280 bits) of payload for each 20 ms sound sample. With 50 samples per second,
this codec consumes 64 kbps, to which you must add the overhead of all the headers (L2, L3, L4)
for the payload transmission. Other codecs, like PDC-EFR, consume only 8 kbps, at the price of a
less-nuanced representation of the captured audio. It is said to be more “compressed” than G.711.
Some codecs are also called elastic, in that they react to congestion by increasing the compression
temporarily. The art of compressing as much as possible, while still rendering a sound with a lot of
nuances, is a very active field of research, but you do not need to be a codec expert to pass the
CCIE Wireless exam.

As you use Jabber, the application opens a network socket to send the flow of audio to the network.
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Keep in mind that the audio side of the application is different from the transmission side of your
smartphone. Your network buffer receives from the application 160 bytes every 20 ms. However,
transmitting one audio frame over an 802.11n or 802.11ac network can take as little as a few
hundred microseconds. The function of the network stack is to empty the buffer, regardless of the
number of packets present. When your Wi-Fi card gains access to the medium, it sends one block
or multiple frames, depending on the operating system’s internal network transmission algorithm,
until the buffer is empty. As soon as a new packet gets into the network buffer, the driver
reattempts to access the medium, and will continue transmitting until the buffer is empty again.

Therefore, there is no direct relationship between the voice part of the application and the network
part. Your smartphone does not need 1 second to send 1 second worth of audio, and your
smartphone also does not need to access the medium strictly every 20 milliseconds. The application
will apply a timestamp on every packet. On the receiver side, the application will make sure that
packets are decoded back into a sound and played in order at the right time and pace (based on
each packet timestamp).

The receiver will also send, at intervals, statistics back to the sender to inform it about which
packets were lost, which were delayed, and so on. These statistic messages are less important than
the audio itself but are still useful for the sender to determine, for example, whether the call can
continue or whether the transmission has degraded beyond repair (in which case the call is
automatically terminated). Sending such statistics implies opening another socket through the
operating system. It is common to see real-time voice sent over UDP while the statistics part would
be sent over a TCP socket. In a normal audio call, both sides exchange sounds, and therefore both
sides run the previous processes.

Note

Some codecs use Voice Activity Detection, or VAD. When the microphone captures silence, or
audio below a target volume threshold, the application decides that there is nothing to send and
does not generate any packet for that sampling interval. However, this mechanism sometimes gives
the uncomfortable impression of “dead air” to the listener. Many codecs prefer to send the faint
sound instead. Others send a simplified (shorter) message that instructs the application on the
listener’s end to play instead a preconfigured “reassuring white noise” for that time interval.

Many well-known applications can be recognized by the ports they use. For example, TCP 80 is the
signature of web traffic. This identification is more complex for real-time applications because they
commonly use a random port in a range. For example, Jabber Audio, like many other real-time
voice applications, uses a random UDP port between 16384 and 32766. The port can change from
one call to the next. This randomness helps ensure that two calls on the same site would not use the
same port (which can lead to confusion when devices renew or change their IP addresses) and
improves the privacy of the calls by making port prediction more difficult for an eavesdropper.

Processes like Network Based Application Recognition (NBAR, which is now implementing its
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second generation and is therefore often called NBAR2) can use the ports to identify applications.
When the port is not usable, the process can look at the packet pattern (packet size, frequency, and
the like) to identify the application. Looking beyond the port is called Deep Packet Inspection
(DPI). NBAR2 can identify close to 1,400 different applications. Identification can rely on specific
markers. For example, a client opening a specific (random) port to query a Cisco Spark server in
the cloud then receives an answer containing an IP address, and then exchanges packets over the
same port with that IP address, is likely to have just opened a Spark call to that address. NBAR2
can easily identify this pattern. When the whole exchange is encrypted, NBAR2 can rely on the
packet flow (how many packets, of what size, at what interval) to fingerprint specific applications.
NBAR2 can recognize more than 170 encrypted applications with this mechanism.

Therefore, deploying NBAR2 at the edge of your network can help you identify which application
is sending traffic. However, running DPI can be CPU intensive. After you have identified the type
of traffic carried by each packet, you may want to mark this packet with a traffic identifier so as
not to have to rerun the same DPI task on the next networking device but apply prioritization rules
instead. In some cases, you can also trust the endpoint (your wireless client for example) to mark
each packet directly.

This notion of “trust” will come back in the “trust boundary” discussion, where you will decide
whether you want to trust (or not) your clients’ marking.

Layer 3, Layer 2 QoS

Each packet can be marked with a label that identifies the type of traffic that it carries. Both Layer
3 headers (IPv4 and IPv6) and most media Layer 2 headers (including Ethernet and 802.11) allow
for such a label. However, Layer 2 headers get removed when a packet transits from one medium
to the other. This is true when a packet goes through a router. The router strips Layer 2 off, looks
up the destination IP address, finds the best interface to forward this packet, then builds the Layer
2 header that matches that next interface medium type before sending (serializing) the packet onto
the medium.

This Layer 2 removal also happens without a router. When your autonomous AP receives an
802.11 frame, it strips off the 802.11 header and replaces it with an 802.3 header before sending it
to the Ethernet interface. When the AP is managed by a controller, the AP encapsulates the entire
802.11 frame into CAPWAP and sends it to the WLC. The WLC looks at the interface where the
packet should be sent and then removes the 802.11 header to replace it (most likely) with an 802.3
header before sending it out.

In all cases, the original Layer 2 header is removed. For this reason, we say that the Layer 2 header
is only locally significant (it is valid only for the local medium, with its specific characteristics and
constraints). By contrast, the Layer 3 part of the packet is globally significant (it exists throughout
the entire packet journey). This is true for the entire header, but is also true for the QoS part of that
header. As a consequence, the QoS label positioned in the Layer 3 section of the packet expresses
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the global QoS intent—that is to say a view, valid across the entire journey, on what this packet
represents (from a QoS standpoint). The label expresses a classification (what type of traffic this
packet carries). Because your network carries multiple types of traffic (organized in categories, as
detailed in the next section), each label represents a type of traffic but also expresses the relative
importance of this traffic compared to the others. For example, if your network includes five traffic
categories labeled 1 to 5, and if 5 is the most important category, any packet labeled 5 will be seen
as not just “category 5” but also “most important traffic.” However, keep in mind that the label you
see is “5,” and nothing else. You need a mapping mechanism to translate this (quantitative) number
into a qualitative meaning (“most important traffic”).

The way Layer 3 QoS is expressed depends on the IP system you use (IPv4 or IPv6) and the
tagging system you use (for example, IP Precedence or DSCP). Luckily, they are similar and
inclusive of one another.

IPv4 QoS Marking

The IPv4 header has a field called Type of Service (ToS).

Note

Do not confuse Layer 3 Type of Service (ToS) and Layer 2 (e.g. 802.1) Class of Service (CoS). CoS
is Layer 2, ToS is Layer 3. A way to remember it is to say that ToS is on Top, while CoS is Closer
to the cable.

Using ToS, QoS can be expressed in two ways:

Three bits can be used to mark the QoS value. This is the IP Precedence system. You must be
aware of its existence, but the next system (DSCP) incorporates IP Precedence. In most
networks, IP Precedence is used only to express a QoS label compatible with other systems that
also only allow 3 bits to express QoS (for example, 802.1 or 802.11). The IPv4 ToS field
contains 8 bits. When IP Precedence is used, only the most significant bits (MSB, the bits on
the left side) are used, resulting in a labeling scale from 000 to 111 (0 to 7 in decimal). The
other bits (on the right) are usually left to be 0, although they can in theory be used to express
other information, such as reliability or delay.

Another system, differentiated services code point (DSCP), extends the number of possibilities.
DSCP uses the 6 bits on the left, thus creating 64 different QoS values. The other last 2 bits (on
the right side) mark explicit congestion notification (ECN), thus informing the destination point
about congestion on the link. For our purpose, these 2 rightmost bits are always 0 (because they
do not express a QoS category), and we’ll ignore them in this section. Figure 7-2 shows the
location of the QoS field in an Ethernet frame.
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Figure 7-2 DSCP and CoS Fields

In the figure, the location of the QoS field is presented. The parameters of the Layer 3
IPv4 is as follows: Version Length, ToS 1 Byte, Len, ID, Offset, TTL, Proto, FCS, IP-
SA, IP-DA, and Data. A zoomed-in view of the ToS 1 Byte is given as a set of 8
blocks, numbered 0 through 7, each representing one bit. The bits 0, 1, and 2 are
named the Precedence 3 Bits and the bits 3, 4, 5, 6, and 7 are named the Unused 5
Bits. Further, another set of 8 bits is given in a similar way, where the first 6 bits are
named the DSCP 6 bits and the last two bits are named the Unused for QoS 2 Bits.

Both DSCP and IP Precedence keep the rightmost bit at 0 (this bit is called MBZ, “must be zero”).
This means, among other things, that you should never find in a standard network an odd DSCP
value. All DSCP values are expected to be even numbers (again, unless the network is nonstandard
and the admin uses experimental QoS marking).

DSCP is more complex than IP Precedence because it further divides the 6 left bits into three
sections. As a CCIE Wireless, you do not need to be a QoS expert. In fact, you can probably
survive the exam with no clear knowledge of DSCP internals, but gaining some awareness will
undoubtedly help you design your networks’ QoS policies properly.

Within the DSCP 6-bit label, the three leftmost bits (the 3 MSBs) express the general importance of
the traffic, here again on scale from 000 to 111 (0 to 7 in decimal). “Importance” is a relative term.
In theory, you could decide that 101 would mean “super important,” while 110 would mean “don’t
care.” If you were to do so, you would be using experimental QoS. Experimental, because
translating this importance beyond your own network (into the WAN, for example) would become
pretty challenging, as any other network could mean anything they wanted with the same bits. To
simplify the label structure and help ensure end-to-end compatibility of packet markings between
networks, the IETF has worked on multiple RFCs that organize possible traffic types in various
categories, and other RFCs that suggest a standardized (that is, common for all) marking for these
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different categories of traffic. A great RFC to start from is RFC 4594. Reading it will give you a
deeper understanding of what types of traffic categories are expected in various types of networks,
and what relative importance and marking they should receive. Cisco (and the CCIEW exam) tend
to follow the IETF recommendations.

Note

There is in fact only one exception, voice signaling, that the IETF suggests labeling CS5, while
Cisco recommends using CS3. The IETF rationale is that signaling belongs to the Voice category
and should therefore be right below the audio flows in terms of priority. The Cisco rationale is that
this is signaling (statistical exchanges about the voice flow, and not real-time data itself), and that
therefore it should come after other types of real-time traffic, such as real-time video.

In most systems, a higher value (for example, 110 vs. 010) represents a type of traffic that is more
sensitive to losses or additional delays. This does not mean that the traffic is more important, but
simply that delaying or losing packets for that traffic category has more impact on the network user
quality of experience. A typical case is real-time voice and FTP. If you drop a voice packet, it
typically cannot be re-sent later (the receiving end has only a short window of opportunity to
receive this packet on time and play it in the flow of the other received audio packets). By contrast,
an FTP packet can be dropped and re-sent without major impact, especially because FTP uses TCP
(which will make sure that the lost packet is identified as such and re-sent properly).

Because the three leftmost bits express the general importance of the traffic, and because you have
more bits to play with, each set of leftmost bits represent what is called a class of traffic. For
example, you could follow the IETF recommendations and label all your real-time video traffic
with the leftmost bits 100. But within that category, that class of traffic, you may have different
types of flows. For example, your network may carry the business-relevant Spark real-time video
traffic and personal traffic (for example, Viber or Facetime). If congestion occurs, and you have no
choice but to drop or delay one video packet, which one should you choose? Because you want to
keep your job as a network admin, you will probably choose to forward that Spark video packet
where your boss is discussing a million-dollar contract and delay or drop that Facetime video
packet where your colleague tells his aunt how great her coffee tastes. This wise choice means that
you have to further label your video traffic, and this is exactly what the next two bits in DSCP do.
They are called drop probability bits. Remember that the last bit on the right is called MBZ (must
be zero) and will therefore always be zero in normal networks, and under normal circumstances.
Figure 7-3 shows the structure of how DSCP values translate to per-hop behavior (PHB) classes.
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Figure 7-3 The DSCP Values

In the figure, a block of 6 bits: 0 0 1 0 1 0, named AF11 equals DSCP 10 is given. A table
below with column headers Class and Value infer the following data. The column Value is
sub-divided into three more columns. Therefore, the data is as follows. Row 1 AF1, 001,
dp, 0; Row 2 AF2, 010, dp, 0; Row 3 AF3, 011, dp, 0; Row 4 AF4, 100, dp, 0; EF (46),
101, 11, 0; Row 5 CS3 (24), 011, 00, 0. The field dp from the first row is highlighted and
shown using a detailed-view. The detail is comprised as a table with three columns: Drop
Probability (dp), Value, and AF value. The table infers the following data. Row 1 Low, 01,
AF11; Row 2 Medium, 10, AF12; Row 3 High, 11, AF13.

The slight complexity of DSCP is that the class bits and the drop probability work in reverse logic.

The three leftmost bits represent the general traffic class, and the convention is that a higher
number means a traffic more sensitive to delay and loss (a traffic that you should delay, or drop
less, if possible). So you would delay or drop 010 before you delay or drop 100.

By contrast, the drop probability bits represent, within a class, which traffic should be dropped or
delayed first. This means that a drop probability of 11 is higher than a drop probability of 10, and
the traffic marked 11 will be dropped before the traffic marked 10.

Let’s take a few examples. Suppose that you have a packet marked 101 00 0. Class is 101, drop
probability is 00 (and MBZ is, of course, 0).
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Suppose that you have a congestion issue and have to delay a packet marked 101 00 0 or a packet
marked 100 00 0. Because 101 is higher than 100, you will probably delay 100 00 0. (We suppose
here and later that you follow the IETF reasonable and common rules.)

Now suppose that you have to choose between a packet marked 100 10 0 and a packet marked 100
11 0. Because the class is the same, you cannot use the class to make a choice. But because one
packet has a drop probability of 11, higher than the other (10), you will choose to delay the packet
marked 100 11 0 (because it belongs to the same class as the other but its drop probability is
higher). This difference between the class and the drop probability confuses a lot of people, so
don’t feel sad if you feel that it is uselessly complicated. In the end, you just get used to it.

Now, if you have to choose between a packet marked 101 11 0 and a packet marked 100 01 0, you
will delay or drop the packet marked 100 01 0 because its class is lower than the other one. You see
that the class is the first criterion. It is only when the class is the same that you will look at the drop
probability. When the class is enough to make a decision, you do not look at the drop probability.

Per Hop Behavior

These DSCP numbers can be difficult to read and remember. Most of the time, the binary value is
converted to decimal. For example, 100 01 0 in binary is 34 in decimal. 34 is easier to remember,
but it does not show you the binary value that would help you check the class and drop probability
values.

The good news is that this general QoS architecture, called Diffserv (for Differentiated Services,
because different packets with different marking may receive different levels of service, from
“send first” to “delay or drop”), also includes a naming convention for the classes. This naming
convention is called the Per Hop Behavior (PHB). The convention works the following way:

When the general priority group (3 bits on the left) is set to 000, the group is called best-effort
service; no specific priority is marked.

When the general priority group contains values but the other bits (Drop Probability and MBZ)
are all set to 0, the QoS label is in fact contained in 3 bits. As such, it is equivalent to the IP
Precedence system mentioned earlier. It is also easily translated into other QoS systems
(802.11e or 802.1D) that use only 3 bits for QoS. That specific marking (only 3 bits of QoS) is
called a Class Selector (CS), because it represents the class itself, without any drop probability.

When the general priority group ranges from 001 to 100 (001, 010, 011, and 100) and contains
a drop probability value, the traffic is said to belong to the Assured Forwarding (AF) class.
Transmission will be assured, as long as there is a possibility to transmit.

When the general priority group is set to 101, traffic belongs to the Expedited Forwarding (EF)
class. This value is decimal 5, the same as the value used for voice with IP Precedence. In the
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EF class, for voice traffic, the drop probability bits are set to 11, which gives a resulting tag of
101110, or 46. “EF” and “46” represent the same priority value with DSCP. This is a value you
should remember (Voice = 101110 = EF = DSCP 46), but you should also know that 44 is
another value found for some other voice traffic, called Voice Admit (but it’s less common).
The EF name is usually an equivalent to DSCP 46 (101110). EF is in reality the name of the
entire class. Voice Admit (DSCP 44) also belongs to the EF category, but it is handled specially
(with Call Admission Control), so you will always see it mentioned with a special note to
express that the target traffic is not your regular EF = DSCP 46.

With the exception of EF, all the other classes are usually indicated with a number that shows
which level they represent. For example, AF1 will represent all traffic starting with 001. AF4 will
represent all traffic starting with 100. Then, when applicable, a second number will show the drop
probability. For example, the PHB AF41 represents the DSCP value 100 01 0 (DSCP 34 in
decimal).

Table 7-1 summarizes the AF values.

Table 7-1 AF Values

AF Class Drop Probability DSCP Value
AF Class 1 Low 001 01 0
 Medium 001 10 0
 High 001 11 0
AF Class 2 Low 010 01 0
 Medium 010 10 0
 High 010 11 0
AF Class 3 Low 011 01 0
 Medium 011 10 0
 High 011 11 0
AF Class 4 Low 100 01 0
 Medium 100 10 0
 High 100 11 0

When there is no drop probability, the class is called CS and a single number indicates the level. For
example, the PHB CS4 represents the DSCP value 100 00 0.

Figure 7-4 will help you visualize the different values. Notice that AF stops at AF4 (there is no
AF5, which would overlap with EF anyway, but there is also no AF6 or AF7). Beyond Voice, the
upper classes (CS6 and CS7) belong to a category that RFC 4594 (and others) call the Network
Control traffic. This is your EIGRP update or your CAPWAP control traffic. You are not expected
to have plenty of these, so a common class is enough. Also, you should never have to arbitrate
between packets in this class. In short, if you drop your CS6 traffic your network collapses, so you

Chapter 7 WLAN Media and Application Services

391

||||||||||||||||||||

||||||||||||||||||||

file:///C:/Users/MERRELL/Documents/eBook Converter/Oreilly Downloader/tmp/9780135162095/ch07.xhtml#ch07tab01
file:///C:/Users/MERRELL/Documents/eBook Converter/Oreilly Downloader/tmp/9780135162095/ch07.xhtml#ch07fig04
https://technet24.ir
https://technet24.ir


should never have to drop anything there (RFC 4594 sees CS7 as “reserved for future use,” so your
network control traffic likely only contains CS6 packets).

Figure 7-4 DSCP to CoS Conversation Chart

In the table, the column headers are DSCP class, DSCP (bin), DSCP (hex), and DSCP
(dec). The table infers the following data. Row 1 reads none, 000000, 0x00, 0; Row 2 reads
cs1, 001000, 0x08, 8; Row 3 reads af11, 001010, 0x0A, 10; Row 4 reads af12, 001100,
0x0C, 12; Row 5 reads af13, 001110, 0x0E, 14; Row 6 reads af21, 010000, 0x10, 16; Row
7 reads af22, 010010, 0x12, 18; Row 8 reads af23, 010100, 0x14, 20; Row 9 reads cs3,
010110, 0x16, 22; Row 10 reads af31, 011000, 0x18, 24; Row 11 reads af32, 011010,
0x1A, 26; Row 12 reads af33, 011100, 0x1C, 28; Row 13 reads af41, 011110, 0x1E, 30;
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Row 14 reads af42, 100000, 0x20, 32; Row 15 reads af43, 100010, 0x22, 34; Row 16
reads cs5, 100100, 0x34, 36; Row 17 reads cs6, 100110, 0x26 38; Row 18 reads cs7,
101000, 0x28, 40; Row 19 reads cs2, 101110, 0x2E 46; Row 20 reads cs4, 110000, 0x30,
48; Row 21 reads ef, 111000, 0x38, 56.

You do not need to learn all the values in this table, but you should at least know DSCP 46 (EF) for
Voice, AF 41 (DSCP 34), which are used for most real-time video flows, and CS3 (voice signaling
in Cisco networks).

You may wonder how this table maps to the various 12 classes, and this is an important question.
Figure 7-5 provides a structured view:
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Figure 7-5 Traffic Classes to DSCP Mapping

In the figure, the structured view of the traffic classes is given in the form of a table with
two columns. The classes are as follows. RFC 4594-Based Model DSCP; Network Control
(CS7); Internetwork Control CS6; Voice plus DSCP-Admit EF plus 44; Broadcast Video
CS5; Multimedia Conferencing AF4; Real-time Interactive CS4; Multimedia Streaming
AF3; Signaling CS3; Transactional Data AF2; OAM CS2; Bulk Data AF1; Scavenger CS1;
Best Effort DF.
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Notice that traffic higher in the list is not “more important.” It is usually more sensitive to delay and
loss (as you learned earlier). The reason why this is fundamental to the understanding of QoS is
“marking bargaining.” Throughout your QoS career, you will often encounter customers with
requirements like this:

Customer: I want to prioritize my business-relevant traffic. I use Spark audio.

You: I see with AVC that you also have Facetime audio traffic. We’ll remark this one as Best
Effort and will keep Spark audio as EF.

Customer: Wait, Facetime is not business relevant but it is still Voice, so it is delay sensitive.

You: Yes, but if we mark Facetime EF, it will compete with your business-relevant Spark audio
traffic.

Customer: Okay, but can’t you give it something higher than BE that shows that we care for our
employees’ personal calls, even if they are not business relevant? Something, like, say 38 or 42?

You: Dear customer, you have absolutely no understanding of QoS.

Your answer to the customer is very reasonable (at least technically). Each class will correspond to
specific configuration on switches, routers (and you will see soon, WLCs and APs). Facetime is
either in the same bucket as Spark and should be treated the same way (making sure that 50
packets per seconds can be forwarded with low delay, and so on), or it is not business relevant and
is sent as best effort (which means “We’ll do our best to forward these packets as fast as we can,
unless something more important slows us down”). There is no QoS bargaining, for multiple
reasons. One of them is that you probably do not have a QoS configuration for DSCP 42, as your
customer suggests. Another reason is that if you create a configuration for DSCP 42, you will have
to borrow buffers and queues that are now used for something else, and your Facetime packets will
compete with other traffic (for example, with the CEO daily broadcast). If you mark Facetime
“something else,” like CS4 or CS5, it will again conflict with other traffic.

These are the reasons why Table 7-1 represents a series of classes, each of which will correspond to
a specific set of configured parameters to service that class to best match its requirements and
needs. It does not mean that voice is more important than broadcast video, for example. The table
just lists typical traffic types and a label that can be applied to each traffic type. In turn, this label
will be used on each internetworking device to recognize the associated traffic. With the knowledge
of what this traffic type needs, each networking device will forward the packets in conditions that
will provide the best possible service, taking into account the current conditions of the network
links.

This understanding is also important to realize that Scavenger (CS1) is not “higher” than Best Effort
(CS0, 000 00 0), even if it is listed above BE. In fact, all your configurations will purposely send
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CS1 traffic only if there is nothing else in the queue. If a BE packet comes in, it will go first, and
CS1 will only be sent at times when it does not conflict with something else.

IPv6 Layer 3 Marking

DSCP may sound a bit complicated, but it is very efficient. We covered the IPv4 case; now let’s
spend a few minutes on IPv6. The good news is that IPv6 QoS marking follows the logic and
mechanics of IPv4. The IPv6 header also has an 8-bit field called the Traffic Class field, where you
can mark QoS. Just like for IPv4 QoS, we ignore the rightmost 2 bits. They are also called Explicit
Congestion Notice bits and are used on some media to inform the other end about a congestion on
the line. Because we do not use them in Wi-Fi and because they do not express a QoS category, we
ignore them.

The other 6 bits are the same as in the IPv4 header, so you can put your DSCP value there. This
makes DSCP easy to use. The same value and categories are expressed in the IPv4 and the IPv6
header, as shown in Figure 7-6.

Figure 7-6 IPv6 Header

In the figure, the parts of the header are given as a stacked structure. From top to bottom,
the parameters are as follows. The first layer: version, traffic class, and flow label. The
second layer: payload length, next header, hop limit. The third layer is source address and
the fourth layer is the destination address.

IPv6 adds another section in the header called the Flow Label. This field is not present in IPv4. It is
useful for QoS in general because it allows the sender to put a label on a traffic flow. This helps
identify all packets in a given flow, and helps classification. With labels, your intermediate
networking device can check the label and identify the traffic without having to look at ports or run
a deep packet inspection. This is useful in general, but you will not be tested on IPv6 Flow Labels
on the CCIE Wireless exam.
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Layer 2 802.1 QoS Marking

Remember that Layer 3 QoS marks the global QoS intent for your packet, the general category to
which this packet should belong. Your packet is then transported across different media. Each
medium has specific characteristics and constraints, and they cannot all categorize QoS families
over 6 bits. You saw that DSCP used 6 bits, which translated into (in theory) 64 possible categories.
In fact, a count from CS7 to CS0 shows that we are only using 21 values, not 64. However, the
DSCP scale is open to 64 possibilities, and your network can decide to implement some
experimental values if needed.

Many Layer 2 mediums do not have the possibility of expressing 64 levels of categorization
because of physical limitations. Switches, for example, build transmission buffers. You may
remember from the section “The Notion of Differentiated Treatment” that the general buffer is split
into subbuffers for each type of traffic category. If you had to build 64 subbuffers, each of them
would be too small to practically be useful or your general buffer would have to be enormous. In
both cases, prioritizing 64 categories over a single line does not make much processing sense when
you are expected to switch packets at line rate (1 Gbps or 10 Gbps). However, most switches can
use DSCP but they use an 8- or 12-queue model.

The Ethernet world was the first to implement a QoS labeling system. It was built around 3 bits (8
categories, with values ranging from 0 to 7). The initial IP Precedence system at the IP layer was
founded on the idea that there would be an equivalence between the Layer 2 and the Layer 3 QoS
categories. But as you know, DSCP expanded the model. Today, the Ethernet world is aware that
using L3 QoS is reasonable and that Layer 2 should translate the DSCP value, when needed, into
the (older) Ethernet 3-bit model. You will find many switches that understand the Ethernet 3-bit
QoS model but only use the DSCP value for their traffic classification and prioritization.

You are not taking a Routing and Switching CCIE, so you do not need to be an expert in Layer 2
QoS. However, 802.11 got its inspiration from 802.1 QoS, so it may be useful for you to see the
background picture.

That picture may be confusing for non-Switching people, because 802.1 QoS appeared historically
in several protocols, and you may have heard of 802.1p, 802.1D, and 802.1Q. In fact, it is just a
question of historic perspective. 802.1p is the name of an IEEE task group that designed QoS
marking at the MAC layer. Being an 802.1 branch, the target was primarily Ethernet. They worked
between 1995 and 1998. The result of their work was published in the 802.1D standard.

Note

In the 802.1 world, lower cases are task groups, like 802.1p, and capital letters are full standards,
like 802.1D. This is different from 802.11, where there is only one standard and the standard itself
has no added letter. Lower cases are amended to the standard (like 802.11ac), and capital letters
indicate deprecated amendments, usually politely named “recommended practices,” like 802.11F.
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802.1D incorporates the 802.1p description of MAC Layer QoS but also includes other provisions,
like interbridging or Spanning Tree. A revision of 802.1D was published in 2004; however, the
802.1Q standard, first published in 2003 and revised in 2005 and 2011, leverages the 802.1D
standard for part of the frame header while adding other parameters (like the VLAN ID). In
summary, 802.1p is the original task group, for which results were published in 802.1D and whose
elements appear in the 802.1Q section of the 802.1 and 802.3 headers. Very simple.

More critical than history is the resulting QoS marking logic. 802.1p allows for 3 bits to be used to
mark QoS, with values ranging from 0 to 7 (8 values total). Each value is called a Class of Service
(CoS). They are named as shown in Table 7-2, in 802.1Q-2005.

Table 7-2 Classes of Service Names and Values

Class Name Value (Binary/Decimal)
Best Effort 0 / 000
Background 1 / 001
Excellent Effort 2 / 010
Critical Applications 3 / 011
Video 4 / 100
Voice 5 / 101
Internetwork control 6 / 110
Network Control 7 / 111

Caution

Table 7-2 is not what the original 802.1p-1998 or 802.1D said. We’ll come back to this point soon.
However, this is the current practice today, based on 802.1Q.

You see that there is a natural mapping from DSCP CS classes to these 8 values. CS7 and CS6 map
to CoS 7 and 6, respectively. Voice (EF) maps to CoS 5, Video (AF4 family) to CoS 4, the critical
Signaling (CS3) and Multimedia Streaming (AF3) map to CoS 3, all data (AF2 and CS2) maps to
CoS 2, BE is still 0, and Background (CS1) is CoS 1. You need to squeeze several classes into one,
and there are a few uncomfortable spots (like CS5), but overall, the DSCP to CoS mapping works.

It would be much more difficult to map the other way around, from CoS to DSCP, because you
would not be able to use the 21 values (not to mention 64); you would use only 8. This will come
back to us soon.

802.11 QoS Marking

It is now time to look at 802.11 L2 QoS marking. It looks like we took the scenic route to get there,
but all you learned will help you make sense of what will look strange in the way 802.11 opposes
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802.1 or DSCP. You undoubtedly remember from your CCNA or CCNP studies that the 802.11e
amendment, published in 2005 and incorporated in 802.11-2007, lists the labels displayed in Figure
7-7.

Figure 7-7 UP and 802.1D Table

In the table, the column headers are User Priority (Binary), User Priority (Decimal),
802.1D Designation, Access Category, and Designation. For every two rows under the first
three columns, there is a single row under the last two columns. The data is as follows: Row
1 and Row 2 read: 111, 7, NC and 110, 6, VO, AC_VO Voice; Row 3 and Row 4 read:
101, 5, VI and 100, 4, CL AC_VI, Video; Row 5 and Row 6 read: 011, 3, EE, and 000, 0,
BE, AC_BE, Best Effort; Row 7 and Row 8 read: 010, 2, blank, and 001, 1, BK, AC_BK,
Background.

This table is an approximation of the table that appears as 20.i in 802.11e (and Table 10.1 in
802.11-2016). We added the binary value. A few elements are striking, in light of the previous
pages:

The labels are called priorities (User Priorities, UP). This is because there is not a lot of
buffering play available in a half-duplex medium. We will come back to this point very soon.

UPs are grouped two by two into access categories. Each access category has an intended
purpose (voice, and so on).

The values differ notably from the 802.1Q table. This is something a wireless expert must
understand.

Table 7-2 was 802.1Q. Table 7-3 is the original 802.1p table that was translated into 802.1D-2004:

Table 7-3 802.1p / 802.1D-2004 Classes

Class Name Value (Binary/Decimal)Best Effort 0 / 000
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Best Effort 0 / 000
Background 1 / 001
Spare 2 / 010
Excellent Effort 3 / 011
Controlled Load 4 / 100
Video 5 / 101
Voice 6 / 110
Network Control 7 / 111

You can immediately see that there is a disconnect between 802.1p/802.1D and 802.1Q-2005.
Voice is 6 in 802.1p/802.1d-2004 but 5 in 802.1Q-2005. Similarly, Video gets 5 versus 4, not to
mention Excellent Effort downgraded from 4 to 3. At the same time, it looks like 802.11 is
following 802.1p/802.1D instead of following 802.1Q. What gives?

It all comes back to this notion of the QoS model. Back at the end of the 1990s, when the 802.1p
group was working, a standard model was around four queues, and a new trend was to add more
queues. The most urgent traffic was seen as Network Control, and the most urgent client data
traffic was seen as Voice. This is what gave birth to the 802.1p model.

When the 802.11e work started in 2000, it built on the work of a consortium, Wireless Multimedia
Extensions (WME), led by Microsoft, that was already trying to implement QoS markings among
Wi-Fi vendors. They (of course) followed the IEEE recommended values of the days (802.1p). The
802.11e draft was finished in 2003, and the 2003 to 2005 period was about finalizing details and
publishing the document.

In between, the IETF recognized that Network Control Traffic should be split into two categories:
level 6, which is the standard internetwork control traffic, and an additional category of even higher
level that should in fact be reserved for future use or for emergencies (label 7). In such a model,
Voice is not 6 anymore but 5, and Video moves from 5 to 4. This change was brought into the
inclusion of 802.1D into the revised 802.1Q-2005, but 802.11e was already finalized.

The result is a discrepancy between the standard 802.1Q marking for Voice and Video (5 and 4,
respectively), and the standard 802.11e marking for these same traffic types (6 and 5, respectively).
A common question you will face as an expert is: Why did 802.11 keep this old marking? Why did
they not update like 802.1Q did?

There are multiple answers to this question, but one key factor to keep in mind is that the 802.11e
marking is neither old, wrong, obsolete, nor anything along that line. Ethernet is a general medium
that can be found at the Access, Distribution, and Core layers. You expect any type of traffic on
such a medium, including routing updates. By contrast, Wi-Fi is commonly an access medium. You
do not expect EIGRP route updates to commonly fly between a wireless access point and a wireless
client (wireless backbones are different and are not access mediums). As such, there is no reason to
include an Internetwork Control category for 802.11 QoS. We already lose UP 7 if we keep it for
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future use as recommended by IETF; it would be a waste to also lose UP 6 and be left with only 5
values (plus 0). Therefore, the choice made by the IEEE 802.11 group, to keep the initial 802.1D
map, is perfectly logical, and is not laziness (and yes, the 802.11 folks also know that 802.1Q
changed the queues). In the future, it may happen more that 802.11 becomes a transition medium
toward other networks (for example, toward your ZigBee network of smart home devices). If this
happens, it may make sense to change the 802.11e queues to include an additional Internetwork
Control queue. Until that day comes, a simple translation mechanism happens at the boundary
between the 802.11 and the 802.1 medium (UP 6 is changed to CoS 5, UP 5 to CoS 4, while the rest
of the header is converted too). As a CCIE Wireless, you need to know that these are the right
markings and resist the calls to unify the markings. Current best practices are to use UP6/PHB
EF/DSCP 46/CoS 5 for Voice and UP 5/PHB AF41/DSCP 34/CoS 4 for real-time video. The only
exception is that CoS tends to be ignored more and more, as DSCP is used instead (more on this in
the upcoming section). Any request to use UP 5 for Voice is a trap into which you should not fall.

DSCP to UP and UP to DSCP Marking

In most scenarios, you should try to use DSCP to express your QoS intent (because DSCP is
independent from the local medium). However, there are cases where you need to work from UP
and decide the best DSCP, or when you need to decide which UP is best for a given DSCP value.
These requirements mean that you need to know what the recommended practices are for this
mapping. Fear not, there is a macro that we will examine in the “Configurations” section that will
help you configure the right numbers.

Downstream

Downstream traffic will come from the wire and will have a DSCP value. You need to decide
which UP to use. Table 7-4 shows the Cisco recommended mapping for a 12-class QoS model. You
will see each of 12 categories, their associated recommended DSCP marking (as per RFC 4594),
and the associated recommended UP marking. This mapping, shown in Figure 7-8, is not just
recommended by Cisco but is also an IETF standard (RFC 8325,
https://tools.ietf.org/html/rfc8325).

Table 7-4 UP to DSCP Recommended Mapping

Incoming UP Value Recommended DSCP Value to Map To
0 - 000 0 (CS0) – 000 00 0
1 - 001 8 (CS1) – 001 00 0
2 - 010 16 (CS2) – 010 00 0
3 - 011 24 (CS3) – 011 00 0
4 - 100 32 (CS4) – 100 00 0
5 - 101 34 (AF41) – 100 01 0
6 - 110 46 (EF) – 101 11 0
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6 - 110 46 (EF) – 101 11 0
7 - 111 56 (CS7) – 111 00 0

Figure 7-8 Standard DSCP to UP Model

In the figure, on the left, the layers of standard DSCP are given and on the right, the layers
of IEEE 802.11 Model are given. The 802.11 model has four layers comprised as follows,
from top to bottom: UP 7 and UP 6: Voice, Access, and Category; UP 5 and UP 6: Video,
Access, and Category; UP 3 and UP 0: Best Effort, Access, and Category; UP 2 and UP 1:
Background, Access, and Category. The mapping between the layers of these two models
is as follows. The last three layers of DSCP are mapped to UP 1, UP 2, and UP 0. The
fourth layer from the bottom of DSCP is also mapped to UP 0. Transactional Data is
mapped to UP 3. Signaling, Multimedia Streaming, and Multimedia Conferencing are
mapped to UP4. Real-time Interactive and Broadcast video are mapped to UP 5. Voice plus
DSCP-Admit is mapped to UP 6. Network Control and Internetwork Control point toward
UP 7, with a note that reads, Remark or Drop if not in use.

Notice that this model uses all UPs (except 7, still reserved “for future use”). This rich mapping
implies that some traffic, within the same access category (AC), will have different UPs. You will
see in the “Congestion Management” section that the access method (AIFSN, TXOP) is defined on
a per access category basis. This implies that both UPs in the same AC should have the same
priority level over the air. However, Cisco APs (and most professional devices) have an internal
buffering system that prioritizes higher UPs. In other words, although there is no difference
between UP 4 and UP 5 as far as serialization goes (the action of effectively sending the frame to
the air), the internal buffering mechanisms in Cisco APs will process the UP 5 frame in the buffer
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before the UP 4 frame, thus providing an internal QoS advantage to UP 5 over UP 4, even if you do
not see this advantage in the IEEE 802.11 numbers.

Upstream

Upstream traffic should come with DSCP marking (see the next section). In that case, you should
use DSCP and ignore UP. However, you may have networks and cases where UP is all you have to
work from, and you need to derive the DSCP value from the UP value. This is a very limiting case
because you have only 8 UP values to work from, and this does not fit a 12-class model. It also
makes it impossible to map to potentially 64 DSCP values. Even if you keep in mind that only 21
DSCP values are really used (counting all the AF, CS, and EF values in the DSCP table in the
previous pages), 8 UPs definitely is not enough. So you should avoid using UP to derive DSCP
whenever possible, but if you have to make this mapping, the recommended structure is shown in
Table 7-4.

Note that the mapping structure is very basic: For most UP values, simply map to the generic Class
Selector (CS). Then, map Video and Voice to their recommended DSCP value (AF41 and EF,
respectively).

Note

There is an important semantic exception to make for this table. You will see that UP 7 is
recommended to be mapped to CS 7. This is the mapping recommendation. This mapping
recommendation does not mean that you should have UP 7 or CS7 traffic in your network. It just
says that if you have UP 7 traffic in your network, the only logical DSCP value to which UP 7
could be mapped is CS 7.

However, you should not have any UP 7 (or DSCP CS 7) traffic in your network, first because
there is typically no network control traffic that would flow through your Wi-Fi access network
(unless your Wi-Fi link bridges to other networks, in which case it is not “access” anymore but has
become “infrastructure”), but also because CS7 is reserved for future use. So the actual
recommendation is to remap any incoming CS 7 traffic (or UP 7 traffic) to 0, because such marking
is not normal and would be the sign of something strange happening in your network (unless you
are consciously using this marking for some experimental purpose). You will see in the
“Configurations” section how this remarking is done.

Even if you have network control traffic flowing through your Wi-Fi network, the IETF
recommendation is in fact to use CS 6 and map it to UP 6. It will be in the same queue as your
voice traffic, which is not great. But UP 6 is better than UP 7 (which should stay reserved for future
use). The expectation is that you should not have a large volume of network control traffic anyway.
Therefore, positioning that traffic in the same queue as voice is acceptable because of the criticality
of such traffic and the expected low volume. If you have a large volume of network control traffic
over your Wi-Fi link, and you plan to also send real-time voice traffic on that link, you have a basic
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design issue. A given link should not be heavily used for voice traffic and be at the same time a
network control exchange highway.

Trust Boundary and Congestion Mechanisms

Marking packets correctly is critical, and understanding how to translate one marking system into
another when packets are routed or switched between mediums is necessary. However, marking
only expresses the sensitivity of a packet to delay, jitter, loss, and bandwidth constraints. After this
sensitivity is expressed, you need to look at it and do something with it.

Trust Boundary

At this point, you should understand that traffic can be identified (using various techniques,
including Deep Packet Inspection, or simple IP and port identification). After identification is
performed, you can apply a label to that traffic to express its category. This label can be applied at
Layer 2, at Layer 3, or both. Layer 3 expresses the general intent of the traffic, while Layer 2
expresses the local translation of that general intent. After a packet is labeled, you do not need to
perform classification again (you already know the traffic category)—that is, if you can trust that
label. This brings the notion of trust boundary. The trust boundary represents the point where you
start trusting the QoS label on a frame or packet. At that point, you examine each packet and
decide its classification and associated marking. Beyond that point, you know that packets have
been inspected and that their marking truly reflects their classification. Therefore, all you have to
do is act upon the packet QoS label (to prioritize, delay, or drop packets based on various
requirements examined in the next section).

But where should the trust boundary be located? Suppose that you receive a packet from a wireless
client and this packet is marked EF (DSCP 46). Should you automatically assume that this packet
carries voice traffic and should be prioritized accordingly, or should you examine the packet with
Deep Packet Inspection (DPI) and confirm what type of traffic is carried? You may then discover
that the packet is effectively voice, or that it is BitTorrent.

There is no right and wrong answer for this trust question, and Figure 7-9 illustrates the various
options. In a corporate environment, where you expect only corporate devices and corporate
activity, you may decide to fully trust your endpoints and clients. From an efficiency standpoint,
this scenario is optimal because you should classify and recognize traffic as close as possible to the
traffic source. If classification is done at the endpoint level, and all you have to do is act upon the
marking displayed in the endpoint packets, your network QoS tasks are all around prioritization and
congestion management. Classifying at the endpoint level removes the need for the network to
perform DPI. DPI is CPU-intensive, so there is a great advantage in trusting the client marking. In
that case, your trust boundary is right at the client level (points labeled 1 on the left).
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Figure 7-9 Trust Boundary Locations

In the figure, the following topology is portrayed and the devices are numbered 1 through 3
representing the markings. A modem, a router (numbered 2), two layer-three switches (first
one numbered 3), and a virtual router (numbered 1) are connected linearly. Similarly, a
switch (numbered 2), two layer-three switches (first one numbered 3), a virtual router
(numbered 1) are connected linearly just below the first linear topology. The router and the
switch numbered 2 are in the Access layer, the switches numbered 3 are in the Distribution
layer, the other set of switches are in the Core layer, and the virtual routers are in the
WAN aggregation layer. Both the virtual routers are connected to the internet. The router
in the access layer is connected to the switch of the bottom topology in the distribution
layer. Similarly, the switch in the access layer is connected to the switch in the top
topology in the distribution layer. Further, the switches in the distribution layer are cross-
connected to the switches in the Core layer. The switches in the core layer are cross-
connected to the virtual routers in the aggregation layer. A laptop, numbered 1, is
connected wirelessly while another laptop, also numbered 1, is wired to the switch in the
access layer.

However, in most networks, you cannot trust the client marking. This lack of trust in the client QoS
marking is not necessarily a lack of trust in the users (although this component is definitely present
in networks open to the general public) but is often a consequence of differences in QoS
implementations among platforms (in other words, your Windows clients will not mark a given
application the same way as your MacOS, iOS, or Android clients). Therefore, you either have to
document each operating system behavior for each application and create individual mappings and
trust rules accordingly, or run DPI at the access layer (on the access switch for wired clients and on
the AP or the WLC for wireless clients). In that case, your trust boundary moves from the client
location to the access layer. This location of the trust boundary is also acceptable. This is the reason
why you will see NBAR2/AVC be configured commonly on supporting access switches, and on
APs/WLCs. They are the access layer (labeled 2 in the illustration). On the other side of the
network, the first incoming router is the location where AVC rules will also be configured, because
the router is the incoming location for external traffic. (It is the point under your control that is
located as close as possible to the traffic source when traffic comes from the outside of your
network, and is therefore also labeled 1 in the illustration.)
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If you cannot perform packet classification at the access layer, you can use the aggregation layer
(labeled 3 in the illustration). However, traffic from all your access network transits through
aggregation. Therefore, performing classification at this point is likely to be highly CPU intensive
and should therefore be avoided, if possible, especially if classification means DPI.

One point where you should never perform classification is at the core layer. At this layer, all you
want to do is to switch packets as fast as possible from one location to another. This is not the place
where traffic inspection should happen.

As a wireless expert, you should know that the point of entry to your network (the WAN
aggregation router) is one location where classification should occur. You should also decide
whether you can trust your wireless clients’ marking. As you will see later in this chapter, in most
cases you cannot trust the client marking. The reason is not so much that you cannot trust your
users but rather that different operating systems have different rules for application QoS marking.
Therefore, unless your network is exclusively composed of iOS and MacOS devices, with a very
small set of applications, running AVC on the WLC will be required if you want to have precise
QoS rules in your network. This is a common rule in the CCIE Wireless exam. In the real world,
running AVC consumes CPU resources, and you will want to examine the impact of AVC on your
WLCs CPU before freezing your configuration to AVC Enabled and leaving for a 3-month
vacation.

Congestion Management

The trust boundary determines the location where you start trusting that the QoS label present on a
packet truly reflects the packet classification. Regardless of where the trust boundary lies, there will
be locations in the network (before or after the trust boundary) where you will have to act upon
packets to limit the effect of congestion. It is better if your trust boundary is before that congestion
location (otherwise you will act upon packets based on their QoS label without being sure that the
QoS label is really representing the packet class).

Multiple techniques are available to address existing or potential congestion. In QoS books, you will
see many sections on this topic because this is one of the main objectives of QoS. However, as a
wireless expert, you do not need deep insight into switching and routing techniques to address
observed or potential congestion. In the context of CCIE Wireless, this section is limited to the
techniques that are relevant to your field.

802.11 Congestion Avoidance

One key method to limit the effect of congestion is to avoid congestion in the first place. This
avoidance action is grouped under the general name of congestion avoidance.

In your CCNA studies, you heard about the 802.11 access method, Carrier Sense Multiple Access
with Collision Avoidance (CSMA/CA). This is one implementation of congestion avoidance, where
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any 802.11 transmitter listens to the medium until the medium is free for the duration of a
Distributed Interframe Space (DIFS).

Note

Remember that there are two time units in a cell, the slot time and the short interframe space
(SIFS). With 802.11g/a/n/ac, the slot time is 9 μs and the SIFS 16 μs. The DIFS is calculated as 1
DIFS = 1 SIFS + 2 slot times. The slot time is the speed at which stations count time (especially
during countdown operations).

This “wait and listen” behavior is already a form of congestion avoidance. Then, to avoid the case
where more than one station is waiting to transmit (in which case both stations would wait for a
silent DIFS, then transmit at the end of the silent DISF, and thus collide), each station picks up a
random number within a range, then counts down from that number (at the speed of one number
per slot time) before transmitting. At each point of the countdown, each station is listening to the
medium. If another station is transmitting, the countdown stops, and resumes only after the medium
has been idle for a DIFS. This random number pick, followed by countdown, is also a form of
congestion avoidance because it spreads the transmissions over a period of time (thus limiting the
number of occurrences where two stations access the medium at the same time).

If your network is 802.11n or 802.11ac, it must implement WMM, which is a Wi-Fi Alliance
certification that validates a partial implementation of 802.11e. WMM validates that devices
implement access categories (AC). It tests that a device has four ACs but does not mandate a
specific DSCP to UP mapping, and within each AC does not verify which of the two possible UPs is
used. As 802.11n was published in 2009, it is likely that your networks will implement the WMM
access method rather than the legacy access method.

WMM also implements the part of 802.11e called Enhanced Distributed Channel Access (EDCA).
With WMM and EDCA, your application classifies traffic into one of the four ACs, and the
corresponding traffic is sent down the network stack with this categorization. In reality, this
classification can be done through a socket call at the application layer that will either directly
specify the AC or, more commonly, will specify another QoS value (typically DSCP, but sometimes
UP), that will in turn be translated at the Wi-Fi driver level into the corresponding AC.

Each AC has a different initial wait time (the DIFS for non-WMM traffic). Because that initial
duration is arbitrated depending on which AC the traffic belongs to, the initial wait time is called
the Arbitrated Interframe Space (AIFS). Because it is calculated in reference to the DIFS, it is also
often called the Arbitrated Interframe Space Number (AIFSN). The AIFSN is smaller for ACs
intended for traffic that is more sensitive to loss and delay. This difference means that the driver
will start counting down sooner for voice traffic than, for example, best effort or background
traffic.

For each packet, the driver also picks up a random number. After the medium has been idle for the
duration of the AIFSN matching the AC within which the packet is waiting, the driver will count
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down from that random number. The range of numbers from where the random number is picked is
called the Contention Window (CW). You will see CW as a number, but keep in mind that a
random number is picked within a range. So if you see CW = 15, do not think that the device
should wait 15 slot times. A random number will be picked within 0 and 15, and the device would
count down from that number.

The same logic applies here as for the AIFSN. ACs more sensitive to loss and delay will pick a
number within a smaller range. Although the number is random (and therefore any of the ACs may
pick, for example, 1 or 2), ACs with a small range have more statistical chances of picking smaller
numbers more often than ACs with larger ranges.

When the countdown ends (at 0), the matching packet is sent. All four ACs are counting down in
parallel. This means that it may (and does) happen that two ACs get to 0 at the same time. This is a
virtual collision. 802.11 states that, in that case, the driver should consider that a collision really
occurred and should apply the collision rules (below). However, some vendors implement a virtual
bypass and send the packet with the highest AC, and either only reset the counter of the packet
with the lower AC or send that packet with the lower AC right after the packet with the higher AC.
It is difficult to know whether your client vendor implements these shortcuts unless you have
visibility into the driver. Cisco does not implement these shortcuts because they violate the rules of
802.11, and because they result in weird imbalances between applications. However, Cisco
implements 8 queues (per client), which means that packets with UP 5 and packets with UP 4,
although belonging to the same AC, will be counting down in parallel (whereas a simpler driver
would count down for one, then count down for the other, because the packet would be one after
the other in the same queue). When two packets of the same AC but with different UPs end up at 0
at the same time, this is the only case where the packet with larger UP is sent first, then (after the
matching AIFSN) the packet with the lower UP is also sent. This allows for a differentiated
treatment between packets of the same AC but different UPs while not violating the 802.11 rules
(that treats inter-AC collisions as virtual collisions, not intra-AC collisions).

Collisions can occur virtually, but also physically (when two stations send at the same time). In this
case, a collision will be detected for unicast frames because no acknowledgement is received (but
note that a collision will not be detected by the sender of broadcast or multicast traffic). In that
case, the contention window doubles. Most drivers double the random number they picked initially,
although 802.11 states that the window itself should double, and a random number can be picked
from this new, twice-as-large, window. The reason for doubling the number itself is another form of
congestion avoidance. If a collision happened, too many stations had too much traffic to send
within too short a time interval. Because you cannot reduce the number of transmitters (you have
no control over the number of stations having traffic to send at this point in time), your only
solution is to work on the time dimension and extend the time interval across which that same
number of stations is going to send.

This doubling of time is logical from a protocol design standpoint but not very efficient for time-
sensitive traffic. Therefore, an upper limit is also put on this extension of the contention window.
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The contention window can only grow up to a maximum value that is smaller for voice than for
video, smaller for video than for best effort, and smaller for best effort than for background traffic.
Therefore, the contention window can span between an initial value, called the minimum
contention window value (CWmin), and a max number, called the maximum contention window
value (CWmax).

The different AIFSN and CW values are represented in Figure 7-10. You will note that the AIFSN
for voice has the same value as the DIFS. However, the CWmin provides enough statistical
advantage to voice that a smaller AIFSN would not have been useful. As a matter of fact, early
experiments (while 802.11e was designed) showed that any smaller AIFSN for voice or video
would give such a dramatic advantage to these queues over non-WMM traffic that non-WMM
stations would almost never have a chance to access the medium.

Figure 7-10 EDCA Backoff Timers

In the table, the column headers are EDCA/WMM AC, AIFS Number, CWmin, and
CWmax. The data inferred is as follows. Row 1 reads Legacy DCF, DIFS = 2, 15
superscript asterisk, 1023; Row 2 reads Voice, 2, 3, 7; Row 3 reads Video, 2, 7, 15; Row 4
reads Best Effort, 3, 15, 1023. Row 5 reads Background, 7, 15, 1023.

Also, it is the combined effect of the AIFS and the CW that provides a statistical differentiation for
each queue. As illustrated in Figure 7-11, you can see that voice has an obvious advantage over
best effort. Non-WMM traffic would have the same AIFS/DIFS as the voice queue, but the CW is
so much larger for best effort that voice gets access to the medium much more often than best
effort.
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Figure 7-11 EDCA Slots

In the figure, the slots are in the order: Minimum Wait (AIFSN) and Random Backoff
Wait. They are as follows. Voice: SIFS, 2 slots, 0 to 3 slots; Video: SIFS, 2 slots, 0 to 7
slots; Best Effort: SIFS, 3 slots, 0 to 15 slots; Background: SIFS, 7 slots, 0 to 15 slots.

Note that if you capture traffic and look at the CW values, you may not see the right numbers. This
is because 802.11 defines them as exponents, as shown in Figure 7-12.

Figure 7-12 EDCA Slot Calculation

In the figure, a table denotes the slot calculation workaround. Above the table, a set of four
points conveys the AC Parameters. They are as follows. AC Parameters ACI 0 (Best
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effort), ACM no, AIFSN 3, ECWmin 4, ECWmax 10, TXOP 0; AC Parameters ACI 1
(Background), ACM no, AIFSN 7, ECWmin 4, ECWmax 10, TXOP 0; AC Parameters
ACI 2 (Video), ACM no, AIFSN 2, ECWmin 3, ECWmax 4, TXOP 94; AC Parameters
ACI 3 (Voice), ACM no, AIFSN 2, ECWmin 2, ECWmax 3, TXOP 47. The table has three
column headers EDCA/WMM AC, CWmin, and CWmax. The CWmin and CWmax have
two sub-columns each, under the same column headers: Exponent and Actual Slot times.
The data inferred is as follows. Row 1 reads, Voice, 2, 2 squared minus 1 equals 3, 3, 2
cubed minus 1 equals 7. Row 2 reads, Video, 3, 2 cubed minus 1 equals 7, 4, 2 to the power
4 minus 1 equals 15. Row 3 reads, Best Effort, 4, 2 to the power 4 minus 1 equals 15, 10, 2
to the power 10 minus 1 equals 1023. Row 4 reads, Background, 4, 2 to the power 3 minus
1 equals 15, 10, 2 to the power 10 minus 1 equals 1023.

A value of 3 (0011) would in fact mean (23 − 1), which is 7. This exponent view provides a
compact way to express numbers with the least number of consumed bits.

TXOP

Another technique to avoid congestion is to regulate the access to the medium. Wi-Fi is particular
in its medium access logic, where each packet requires an individual contention with its associated
random backoff timer. This logic is reasonably well adapted for data packets but can be detrimental
for real-time packets because the time counter does not get reset between packets. Let’s take a
worst-case scenario and suppose that your voice application samples audio every 10 milliseconds.
We saw before that the wireless card does not need 10 milliseconds to send 10 milliseconds worth
of audio, which translates to a few hundred bytes at most. However, keep in mind that each voice
packet carries a timestamp in its RTP header. Suppose that you have two audio frames in your
buffer. You send the first one, and at the end of the transmission the medium is still free. Yet, you
need to wait for a DIFS (or an AIFS), then count down from a random backoff number before
sending the next frame. Bad luck, the cell is congested, and other stations send before you get down
to 0. If you look back at Figure 7-10, you will see that voice and video have the same AIFS. You
will also see that voice can pick up to three slots for its backoff timer. By contrast, best effort AIFS
is 3 slots long, and the random backoff is picked in a contention window ranging from 0 to 15 slots.
This means that your voice packet may very well compete against a video or best effort packet, or
both, and lose both races (if these packets picked a low random backoff timer).

You may think that this is not a big issue because your countdown will resume (not restart), and
you will get to 0 eventually; you are right, at least on paper. One difficulty is that the original
802.11 said how long you should wait but did not say how long your transmission should be. 802.11
defined only a max MTU (an 802.11 frame is max 12,246 bits long, with the MAC and PHY
headers). If your competing stations sent that max MTU at 6 Mbps, the transmission time is about 2
milliseconds.

Note
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You can play with transmission numbers using this tool: https://sarwiki.informatik.hu-
berlin.de/Packet_transmission_time_in_802.11.

If your phone operates in the 2.4 GHz band (remember, 802.11e was designed in 2005), you may
compete against a 1 Mbps transmission, and this would represent more than 12 milliseconds of
airtime. If your voice packet picked three slots, you may lose the race against three video frames,
or one video frame and one best effort frame. Suppose that, in this partly congested environment,
you also collide once or twice. You see that you may soon face a scenario where voice packets
start piling up in your stack. Yet, if we could let you send a few more voice frames in sequence,
you could catch up on this increasing delay without impacting the other transmissions too much,
especially because voice packets are very small (that is, they do not consume a lot of airtime, even
at low data rates). At the scale of your voice call, 30 milliseconds make a difference. At the scale of
an FTP transmission, 30 milliseconds are irrelevant.

Because 802.11 could not control the max transmission time of a single frame, the 802.11e group
decided to control the overall transmission time of several frames by also playing with the real-time
nature of the voice and video queue. So 802.11e creates the notion of Transmit Opportunity
(TXOP). In each beacon, the AP advertises TXOP values for each of the four ACs. Each TXOP is
a duration, in units of 32 microseconds. Without TXOP, each station can send only one frame at a
time. With TXOP, each station can transmit one frame, then continue transmitting in a burst as long
as the transmission is smaller than the TXOP for that queue.

Figure 7-13 shows the 802.11e TXOP values for all ACs.

Figure 7-13 WMM TXOP Values

In the table, the column headers are EDCA/WMM AC, TXOP (microseconds), and TXOP
(units). The data is as follows. Row 1 reads, Voice, 1504, 47; Row 2 reads Video, 3008, 94;
Row 3 reads Best Effort, 0, 0; Background, 0, 0.

Those values mean that, if you are transmitting traffic from the voice AC, after you gain access to
the medium with the AIFS/Random backoff mechanism, you can keep transmitting for up to 1504
microseconds. Because each voice packet is small, this maximizes your chances of emptying your
buffer. If you are transmitting a video flow, you can transmit even longer, up to 3 milliseconds. This
is because video packets are typically much larger than voice packets, so you will need more time
to empty your buffer. However, you should not use so much time that you would starve voice
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transmitters, and this is why the ratio 1 to 2 (video gets twice as long a TXOP as voice) was
designed.

Best effort and background get 0 TXOP. This means that these ACs cannot extend beyond the
regular transmission mechanisms. In other words, no transmission burst for these ACs. Each frame
has to go through the individual countdown, without the possibility of bursting after medium access
is granted. Also, keep in mind that each queue is addressed individually. So you cannot, for
instance, send one best effort queue and then continue with a burst of voice packets. Countdown
and medium access are parallel (independent) for each queue buffer. If you get access to the
medium at the end of a best effort packet countdown, this is the packet you send; while your voice
or video queues are virtually contending with this best effort packet, each AC is counting down in
parallel, individually.

This TXOP mechanism, implemented as part of the original 802.11e in 2005 and the corresponding
Wi-Fi Alliance WMM certification, saved a lot of time for the voice and video ACs, at least until
802.11n and then 802.11ac came into play. These two amendments allow a new form of
transmission: the block. In fact, block transmissions were described in 802.11e, but their
acknowledgement mechanism (each frame in the block must be acknowledged individually) made
them somewhat impractical. 802.11n and 802.11ac allow a transmitter and a receiver to agree on a
block transmission and acknowledge individual components of the block in a coded single ACK
message. This efficiency allowed 802.11n and 802.11ac transmitters to use blocks extensively.
Why are we mentioning this? Because a block is technically a single frame. With a max block size
of more than 65,535 bytes for 802.11n and 4,692,480 bytes for 802.11ac, the maximum
transmission duration of a single block can reach 5.484 ms. This is a major problem. With WMM,
your AP announces TXOPs in its beacons and states that the voice queue can send at most 1.5 ms
worth of data, video at most 3 milliseconds worth of data, and best effort and background as long as
they want, as long as it is a single frame each time. If it is a block, that “single frame” gets up to 5.5
ms worth of airtime, much better than voice or video. So, in short, blocks create a disadvantage for
your high-priority queues.

The 802.11 working group realized this issue and modified the TXOP values in the revised version
of the 802.11 standard published in 2016, as displayed in Figure 7-14.
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Figure 7-14 Fastlane and 802.11-2016 EDCA Values

In the table, the column headers are AC, CWmin, CWmax, AIFSN, and TXOP Limit. The
TXOP Limit has four sub-columns: For PHYs Defined in Clause 15 and Clause 16, For
PHYs Defined in Clause 17, Clause 19, and Clause 21, For PHYs Defined in Clause 22,
and Other PHYs. The column For PHYs Defined in Clause 15 and Clause 16 is for
802.11/802.11b, the column For PHYs Defined in Clause 22 is for 802.11af (TV
Whitespace), and the column For PHYs Defined in Clause 17, Clause 19, and Clause 21 is
for 802.11g/a/n/ac. This column is highlighted. The data inferred is as follows. Row 1
reads, AC_BK, aCWmin, aCWmax, 7, 3.264 milliseconds, 2.528 milliseconds, 0, and 0.
Row 2 reads AC_BE, aCWmin, aCWmax, 3, 3.264 milliseconds, 2.528 milliseconds, 0, 0.
Row 3 reads AC_VI, (aCWmin plus 1) over 2 minus 1, aCWmin, 2, 6.016 milliseconds,
4.096 milliseconds, 22.56 milliseconds (BCU: 6 or 7 MHz), 16.92 milliseconds (BCU: 8
MHz), and 0. Row 4 reads, AC_VO, (aCWmin plus 1) over 4 minus 1, (aCWmin plus 1)
over 2 minus 1, 2, 3.264 milliseconds, 2.080 milliseconds, 11.28 milliseconds, (BCU: 6 or 7
MHz), 8.46 milliseconds (BCU: 8 MHz), 0.

From this table, you can see that two major changes were made:

Now each AC has its own TXOP. This allows the AP to provide limits to all queues, regardless
of whether a station is using blocks. BE and BK TXOPs values are close to those of voice,
because tests showed that this approximate equality was enough to provide a statistical
advantage to voice without starving the BE or BK queues. Video has a longer TXOP because it
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is both real-time and bursty.

The TXOP limits are different depending on the protocol you use (802.11e had a single set of
TXOP, regardless of what protocols you would enable in your cell). 802.11b is much slower
than 802.11g/a/n/ac, so it makes sense to have larger values for this protocol to give more time
to the voice or video queue to empty their buffer within each TXOP. 802.11af sets “0” for BE
and BK because this TV whitespace protocol does not use blocks.

This revision of the TXOPs is much more efficient than the previous 802.11e TXOP system. In
fact, the old system is considered as a source of performance issues in any cell where voice traffic
is mixed with data traffic and stations that use blocks. In a Cisco WLC, as we will see in the
“Configurations” section, this revision of the TXOP values is called Fastlane, and you should
always use them. The values in the table above are expressed in milliseconds. A detail on the
802.11g/a/n/ac values, with both the values in milliseconds and the values in 32 microsecond slots,
is shown in Figure 7-15.

Figure 7-15 802.11-2016 TXOP Values

In the table, the column headers are EDCA/WMM, AC TXOP (microseconds), and TXOP
(Units). The data is as follows. Row 1 reads Voice, 2080, 65. Row 2 reads Video, 4096,
128. Row 3 reads Best Effort, 2528, 79. Row 4 reads Background, 2528, 79.

CAC

TXOP is a way to provide more transmit opportunities to selected traffic categories, but also to
control and limit the amount of consecutive transmissions. 802.11e also implemented another
technique, directly derived from Unified Communications: Call Admission Control (CAC).

Caution

CAC is used in the Unified Communication (UC) world and the Wi-Fi world, but they are very
different features. UC CAC is typically implemented on a voice control server (like Cisco Unified
Communications Manager, CUCM) and tests end-to-end bandwidth and links performance. Based
on these measurements, the voice control server would allow or disallow specific calls. For
example, the server would block (busy tone) your call to number 1234 if it found that the end-to-
end link to the phone serving this number does not provide enough performances to allow a
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workable call. But the server could allow your call to 4422 if it found that the end-to-end link to the
phone serving this number does provide enough performances to allow a workable call. Therefore,
allowing or disallowing calls is based on partial or end-to-end link analysis on a per-call basis.

By contrast, the CAC implemented in Wi-Fi is solely about the RF link and is not related to any
voice control server. Wireless CAC is managed only by the Wi-Fi infrastructure, independently of
the rest of the infrastructure. You will in fact encounter two names for this feature: Wireless CAC
and ACM (Admission Control Mandatory). ACM is the term used in 802.11 and WMM. Wireless
CAC is the common name used among many vendors.

The principle of ACM is to restrict access to target ACs, specifically the voice or video AC. When
ACM is enabled for an SSID, ACM = 1 is advertised in the AP beacons and probe responses for the
matching AC. An example is provided in Figure 7-16.
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Figure 7-16 Capture of the WMM Section of a Beacon

In the screenshot, the WMM section of a beacon is displayed. Three access categories
based on Best Effort, Background, and Voice are shown. Under Access category - Voice,
three sub-sections are listed: ACI/AIFSN, ECW Min or Max, and TXOP Limit. In
ACI/AIFSN, two statements read ACM: Admission control not mandatory and AIFSN : 2.
In EXW Min or Max, two statements read, ECW Max: 3 (CW Max: 7) and ECW Min: 2
(CW Min: 3). TXOP Limit is 65. The mentioned data are highlighted and shown in the
screenshot.

802.11e states, and the WMM certification verifies, that a station should not send traffic in the
voice AC when ACM is enabled, without initially requesting service. This service request takes the
form of an Add Traffic Stream Request (ADDTS) sent by the client side. In this action frame, the
station describes the candidate’s traffic intended to be exchanged in the restricted AC. This
description is done in two fields: Traffic Specification (TSPEC), a mandatory field, and Traffic
Class (TCLAS), another, but optional, field.

Note

For this section, just like for the others, we only focus on 802.11e EDCA, the part of 802.11e that
describes distributed access function to the cell and that is implemented by vendors today. 802.11e
also describes a coordination function where the AP takes over the cell and distributes the right to
send (HCCA, Hybrid Coordinated Function Controlled Channel Access), but this mode is not
implemented widely (if at all), not implemented by Cisco, not tested by the Wi-Fi Alliance, and
therefore nonessential for your expertise in the real world and on the CCIE Wireless exam.

TSPEC describes what the intended traffic would look like and is the most important field for this
ADDTS exchange. You will find more details on this field in 802.11-2016 section 9.4.2.30. The key
elements of the TSPEC field are displayed in Figure 7-17.
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Figure 7-17 TSPEC IE and TS Info Field Formats

In the figure, the field and the corresponding octets are as follows. Element ID 1, Length
(55) 1, TS Info 3, Nominal MSDU Size 2, Maximum MSDU Size 4, Minimum Service
Interval 4, Maximum Service Interval 4, Inactivity Internal 4, Suspension Interval 4,
Service Start Time 4, Minimum Data Rate 4, Mean Data Rate 4, Peak Data Rate 4, Burst
Size 4, Delay Bound 4, Minimum PHY Rate 4, Surplus Bandwidth Allowance 2, Medium
Time 2, DMG Attributes 0 or 2. The structure of the TS Info field is defined in the
following table. The bit start and end numbers, the element, and the number of bits are as
follows. B0, Traffic type, 1; B1 to B4, TSID, 4; B5 to B6, Direction, 2; B7 to B8, Access
Policy, 2; B9, Aggregation, 1; B10, APSD, 1; B11 to B13, User Priority, 3; B14 to B15, TS
Info Ack Policy, 2; B16, Schedule, 1; B17 to B23, Reserved, 7.

You do not need to know these fields by heart, but it is useful to understand them, to determine
why some stations support TSPEC whereas most others do not. TSPEC provides information about
the traffic, not only in terms of target UP but also in terms of minimum and maximum expected
frame sizes for this traffic, including possible bursts, possible silences between frames, the minimum
and maximum data rates needed to make the flow sustainable, and the airtime consumption for the
flow. Deep knowledge of both 802.11 and the traffic flow (codec) are needed to provide
information in the TSPEC field. This is the main reason why TSPEC support is common for hard
phones (for example, Cisco 8821 or 7926) but very uncommon for software applications on
smartphones. In this last case, app developers typically understand the software part (codec and so
on) but have no idea about Wi-Fi, and would have no clue on the max MSDU or the aggregation
support, because these parameters not only require Wi-Fi expertise (that they typically lack) but
also depend on the Wi-Fi driver characteristics. App developers have no information about the
possible platforms of Wi-Fi drivers. On their side, Wi-Fi driver developers have no information
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about all the possible real-time apps that will be running on the smartphone. Such coordination
between these two unrelated and disconnected worlds is very difficult, and TSPEC is therefore very
uncommon on smartphones.

Note

Please note that there are some exceptions; for example, when the real-time application is
developed by the smartphone manufacturer, or when the smartphone gets “specialized” (that is,
optimized for a specific application). An example is Vocera, a voice company making badges
primarily for the healthcare market. Vocera developed a specific version of a Motorola smartphone
in which the driver was optimized for the Vocera application. This smartphone supports TSPEC.
Such examples are uncommon.

The ADDTS request can also include an optional field called the Traffic Class (TCLAS). This field
includes the target AC, and also a Traffic Classifier (TC) field. TC is intended to provide more
information about the flow upper layers, such as Layer 3 source and destination addresses (IPv4 or
IPv6), Layer 4 ports and protocol, VLAN details, and so on. In most cases, this information is not
relevant to the AP and is available in the payload part of the frame anyway, so the TCLAS element
is optional and often skipped.

The AP receives the ADDTS request and examines the TSPEC field. Based on the traffic
description, the AP estimates whether there is enough bandwidth available to add the requested
flow to the cell. The determination method is proprietary. In Cisco WLCs, you can configure the
bandwidth limit for this determination. Some solutions also look at the traffic description to figure
out whether the described pattern matches the expectations of such a traffic class. For example, an
ADDTS for AC_VO that describes large bursty frames would look suspicious, especially if the
payload indicates a well-known BitTorrent port. Such a flow might be declined regardless of the
available bandwidth.

After the AP has made the determination of whether to accept or decline the traffic, it will return
an ADDTS response to the client that includes the decision (accept or reject). If the decision is to
accept, then the client can start sending the flow (the ADDTS response includes a validity period
during which the flow should start). If the decision is reject, the station cannot use that AC at that
time for that flow. The station can ask again (with the same or different codec), ask for another AC,
or revert to sending the traffic directly into an AC that does not have ACM enabled. Most hard
phones would display a Network Busy message on the screen when this rejection happens. (It is a
visual Network Busy sign, not an audio sign, as this rejection has nothing to do with the
audio/Unified Communications part of your phone.) In most cases you would try again, which
would trigger a new ADDTS request from your phone (with the hope that the network has more
space for your call as you retry).

In all cases, the station cannot send into the target AC, if ACM is enabled, without going through
the ADDTS request first, and it cannot send into that AC if the AP responds with a reject. The Wi-

Chapter 7 WLAN Media and Application Services

419

||||||||||||||||||||

||||||||||||||||||||

https://technet24.ir
https://technet24.ir


Fi Alliance validates this behavior through the WMM certification. This means that any WMM
certified device would obey these rules. Because the WMM certification is mandatory to obtain the
Wi-Fi-n or Wi-Fi-ac certification, you can be confident that any 802.11n/ac device would obey
these rules.

BW Contracts

A last way to control congestion in Wi-Fi networks lies in bandwidth contracts. This is your
standard bandwidth limitation logic. In the wired world, you find two forms of this bandwidth
control, called policing and shaping, as shown in Figure 7-18.

Figure 7-18 The Effect of Traffic Shaping

A figure resembles a graph to capture the effect of traffic shaping. Two dashed, horizontal
lines are drawn at two different points of the vertical axis. The line at the top is Line Rate
and the line below it is Service Rate. Two curves represent Without Traffic Shaping and
With Traffic Shaping. The curve of Without traffic shaping peaks narrowly to reach the
line rate value, whenever there is an increase in traffic. The curve of with traffic shaping
smoothes down at the service rate level, evenly distributed instead of narrow peaks, in
places where the traffic is high.

Policing admits traffic up to a configured bandwidth and deletes the rest. In the figure, any traffic
above the service rate would be deleted. Shaping defines notions of buckets, where you can store
that excess traffic temporarily, then send it over time. In other words, shaping also limits the
bandwidth and delays the excess traffic to send it over a longer period of time. However, if the
temporary storage bucket gets full, the extra traffic will be deleted.

Wi-Fi also offers such options. You can control the bandwidth with a maximum traffic rate to
which you can also add a burst rate. This burst rate determines how much more than the target
bandwidth you will accept in your buffer. This additional traffic will be stored temporarily and sent
over time. However, even if the system displays values in kilobits per second, for example, you
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should not expect the Wi-Fi scheduler to act like a switch scheduler. In a Catalyst 6500, for
example, transmissions over a link can be evaluated every 0.25 milliseconds. This means that the
consumed bandwidth, along with the additional incoming traffic (your burst), can be compared
4,000 times per second. As a result, the throughput impression, when seen from the outside, may
appear very linear and close to the configured intended rate.

Note

The fact that the rate is calculated every 0.25 ms should not obfuscate the limited lengths of the
queues and buffers. If you get more data than the queue can hold, recalculating the throughput at
the next 0.25 ms interval will not prevent some packets from being removed because they did not
fit in the buffer, thus resulting in the loss issue described at the beginning of this chapter.

Such recalculation is not so frequent in an access point for several reasons:

The AP must face the fact that some transmissions will fail (ACK not received); the
retransmission should not be considered as additional consumed bandwidth but as the
realization of the same bandwidth intent. Therefore, a software process is needed to deduce the
retries from the effective bandwidth consumption. This need is much more uncommon on an
Ethernet link.

The AP must face the fact that your rate will change (different MCS at different locations) and
that random silences (backoff timers) are disrupting the transmission rate. By contrast, Ethernet
links use a fixed rate (for example, 1 Gbps), and transmission always occurs at that line rate
and typically in a full duplex mode. This difference means that the AP needs a software
function to calculate the effective consumed bandwidth based on the amount and sizes of
packets transmitted over a sampled period of time.

As a result, and although you will configure bandwidth limitations (called Bandwidth Contracts
in Cisco WLCs) in kbps, you should be aware that this bandwidth is an average over time, not a
precise limit at milliseconds scales.

Bandwidth contracts are very popular in Wi-Fi circles. They come from the times when WLANs
(typically guest networks) were shared with contractors, and there was a need to ensure that these
contractors would not abuse that available (and “free”) bandwidth. Bandwidth contracts started as
downstream constructs only, but then the pressure from multiple types of customers (often with
limited understanding of Wi-Fi and QoS) brought the need to allow for upstream bandwidth control
as well. Then, the multiplicity of implementations and scenarios brought the configuration of these
contracts in multiple areas of the AP or WLC interfaces. As we’ll see in the “Configurations”
section, you can configure BW limitations in QoS profiles, WLANs, and device profiles, and you
can override each of those with AAA VSAs. You can also configure different limitations for TCP
and UDP traffic, each with intended limitations and accepted bursts (shaping logic).

In a different implementation, bandwidth control can be enabled with a feature called Airtime
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Fairness (ATF). ATF is very different from bandwidth contracts because it has the possible support
of flexible boundaries, as you will see later in this section.

Despite the popularity of Wi-Fi bandwidth contracts, the expert in you should carefully weigh the
benefits from such strategies. Bandwidth contracts are solid boundaries (although they are not
calculated in real time, so they are somewhat bursty). A direct objective is to prevent some traffic
from consuming all available bandwidth. Although the intent is understandable, the result is that
valid traffic volume is limited, including in times where the bandwidth is available (there is nothing
competing against that contractor file upload, yet bandwidth for that user and its upload is
restricted). In most QoS models, this type of blind restriction is considered inefficient. If the
bandwidth is available, why not allow the traffic? In most scenarios, a preferred approach is to use
AVC and QoS marking. If the contractor traffic can be identified and associated to a specific set of
QoS classes, that traffic will go through smoothly as long as there is no competing traffic. As soon
as traffic from higher classes start competing, that lower class traffic will get lower QoS treatment
with a direct lower bandwidth as a consequence. This is the general recommendation: as much as
possible, use marking to discriminate between various classes of traffic, whether the discrimination
comes from the application type or from the user type. Use bandwidth contract only when traffic
marking and classification is not possible.

Beyond this recommendation, an additional consideration needs to be made for upstream
bandwidth contract, because this aspect will wake up your customers in the middle of the night
every time they think about it. The objective of bandwidth contract is to limit the consumed
bandwidth over the bottleneck formed by the Wi-Fi link. However, bandwidth contract is applied at
the infrastructure level (the AP in the case of upstream traffic). This location means that the client
will send a frame, the AP will receive it, then decide based on the contract whether the frame is
within or in excess of the allowed bandwidth. If the traffic is in excess, the frame is dropped
(deleted). This is a peculiar way of solving the issue, because the frame has already been sent
through the bottleneck (when the frame reached the AP, the issue is already not relevant anymore).
Dropping the frame is likely to result in the client resending that frame later (especially if the flow is
TCP-based). Therefore, upstream bandwidth contract sounds in essence a strange idea.

But you should know that the intent is not to directly control the flow but to influence the client
behavior. More and more applications use elastic bandwidth control, where the application reacts to
loss of bandwidth by reducing its network resource consumption. This is well known for TCP
traffic, which reduces its window to slow down and reduce the link resource consumption. Rea-
time and near real-time applications also have more and more often elastic mechanisms. Video
calls, but even Netflix and YouTube flows (streaming multimedia), analyze the link consumption
over time intervals (for example, 10 seconds) and evaluate the losses or other parameters, such as
the amounts of bytes received, and deduce the variation of bandwidth. Based on this estimation,
they can change their behavior, changing codecs for example (real-time video or audio call) or
changing the frame resolution (from the 1080p version of your movie to the 720p version, for
example). This ensures a better user experience in changing network conditions. Lowering the
frame resolution is better than stopping the flow. The resolution can increase if network conditions

Chapter 7 WLAN Media and Application Services

422

Technet24
||||||||||||||||||||

||||||||||||||||||||

https://technet24.ir
https://technet24.ir
https://technet24.ir


improve.

Note

There is a difference between FlexConnect and Local mode APs for bandwidth contracts.
Bandwidth contract is enforced at the AP level for FlexConnect APs and WLANs with local
switching. BW contract is enforced at the WLC level for any other downstream traffic and at the
AP level for any other upstream traffic.

This vision of the goals of upstream bandwidth contract should not distract from the fact that
marking is a more elegant way of controlling traffic. However, it may help you answer customers’
questions.

Bandwidth contracts are configured for individual users or SSIDs. Although they include a burst
value, they ignore the other elements on the same radio. For example, if your AP radio offers a 1
Gbps total throughput, and you configure a 100 Mbps per user bandwidth contract for all SSIDs,
the system loses its logic if you have 2 SSIDs with 10 users each on that radio. Your per-user
bandwidth contract cannot take into account the effective resources that are shared. In other
words, in an ideal scenario where all users would use a similar chunk of bandwidth, no user would
see any bandwidth restriction due to the contract (20 users × 100 Mbps each = 2 Gbps). Bandwidth
restriction would only be an effect of the radio limited resources. In other words, limits are static
bandwidth values, not percentages of available resources.

Bandwidth contract also does not differentiate between the user that sits close to the AP (excellent
throughput) from the user that sits far from the AP, in the 6 Mbps area. Those two users may be
restricted to 100 Mbps of throughput, but that bandwidth is going to represent different quantities
of consumed airtime. In effect, the impact of the user at the edge of the cell on the other user’s
ability to access the medium is much higher than the impact of the user close to the AP. The user
close to the AP may represent 0.2% of the cell airtime, whereas the user at the edge of the cell may
represent 40% of the cell airtime, both consuming the same bandwidth.

To allow for such differentiation, Cisco implements a specific variation from the bandwidth
contract, called Airtime Fairness (ATF).

ATF allows bandwidth contracts to be assigned on a per SSID basis, with granularity targeting AP
groups or individual APs, but based on airtime (percentage of time allocated to each SSID traffic on
a given radio) instead of throughput (kbps). Another difference with standard bandwidth contract is
that ATF allows for permeability. In other words, you can decide that a given SSID A should
always receive 40% of the airtime, and SSID B 60%. No other SSID can encroach on that number.
However, if your SSID A is underused (its users consume only 2% of airtime for now), SSID B can
borrow bandwidth from the unused part allocated to SSID A. If this flexibility is configured, SSID B
airtime consumption can increase up to 98%. However, as soon as traffic increases on SSID A, the
airtime allocated to SSID A increases while the airtime allocated to SSID B decreases, allowing
SSID A to consume up to its configured share (40%). You may also configure SSIDs never to
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exceed their share, even when airtime is available. In that scenario, SSID B would never increase
its airtime consumption beyond 60%, even if SSID A was entirely idle.

ATF is therefore a very different bandwidth control mechanism than bandwidth contracts. It is still
in the same family of congestion control mechanism through bandwidth restrictions. The use case
for ATF is very different from the use cases driving the need for bandwidth contracts. ATF is
targeted in deployments where there is a need to ensure that a target SSID maintains specific
airtime availability (for example, an IT SSID in a public environment). The allocation of airtimes
between SSIDs is typically driven by SLAs and availability contracts. As such, the drivers behind
ATF are usually far from QoS configurations. Therefore, there is no specific best practices in terms
of ATF vs QoS, because these two domains are typically orthogonal. The choices you make for
ATF configurations are (and should be) unrelated to QoS considerations, and vice versa. Your QoS
configurations will apply to each ATF SSID, and ATF is not used as a QoS tool. By contrast,
bandwidth contracts are often implemented as a form of congestion control, and therefore as an
imperfect QoS tool.

Configurations

The previous part provided the tools needed to understand and articulate the various QoS design
and strategies. This second part will guide you through the Cisco-specific configuration options.
Although this second part addresses content that you may face in the lab exam, we suggest you not
skip the first part of this chapter. Configuring without knowing why you click here and there is a
very deterministic way of falling into most of the traps in the lab exam!

AireOS

AireOS is the primary configuration interface that you will be expected to use in the exam. Make
sure you understand each configuration element, how it relates to the others, and what effect each
parameter will have on your critical traffic.

QoS Profiles and Bandwidth Contracts

You have several tasks at hand to configure AireOS to support real-time applications. The first is to
decide on the QoS ceiling for your target WLANs (that is, the QoS profile). In most real-world
scenarios, the profile associated to a corporate SSID, where voice traffic is expected, should be
Platinum.

For guest WLANs, the QoS profile would typically be Best Effort or Bronze. Best Effort is
common, but Bronze is often recommended as best practice in networks where you want to ensure
that guest traffic will never compete with corporate traffic. If such a competition is not a concern,
then Best Effort is enough. When Bronze is chosen, all guest traffic gets marked down to AF11/UP
1. Therefore, no bandwidth contract is necessary in that case, because down-marking traffic is
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already enough to ensure that any other traffic will have statistical precedence, as explained in the
previous section. When the guest profile is set to Best Effort, you may be asked to associate
bandwidth contracts. It is, however, better practice to attempt to down-mark key guest traffic
instead. If you have to create bandwidth contract, a few elements need to be considered:

Data means TCP traffic, and real-time means UDP. These terms are clearly misleading. The system
has no awareness of the traffic intent and will classify everything UDP as real-time irrespective of
the real-time intent of that traffic. Similarly, all TCP traffic (including real-time packets like Skype
Init) will be labeled data, not real-time.

You can configure “average rate” and “burst rate” for both UDP and TCP, upstream and
downstream, for individual users or for the entire SSID. The contract is configured in kbps. The
burst rate is inclusive of the average rate. In other words, the burst rate must be equal or superior to
the average rate. Suppose you configure an average contract of 100 kbps and burst of 200 kbps.
This configuration means that your user will receive on average 100 kbps (if you calculate the user
bandwidth, for example, over 10 minutes), but the user is allowed to send or receive bursts of 200
kbps (then will be temporarily stopped so as to average 100 kbps). Bursts are useful for bursty
traffic (for example, video, where you expect a burst of frames to draw a new image, then small
packets as the next frames are small updates to the existing image).

However, you should keep in mind that, in central switching (traffic going through WLC), the WLC
calculates each user bandwidth consumption every 90 seconds as the AP sends back statistics about
the cell events. In FlexConnect mode, the AP performs that calculation at the same interval. This
means that the bandwidth contract will result in consumption spikes, with or without bursts.
Suppose you configure 100 kbps average and burst. Your user may consume 100 kbps within a few
milliseconds. At the next calculation cycle (90 seconds), your user will have a budget allocated of
100 kbps for the next cycle (90 seconds -> 150 kb), may consume this budget in a few millisecond
bursts, then be stopped for the rest of the cycle, and so on.

The bandwidth contract can be configured in multiple places: in the QoS profile associated to the
WLAN, per user, or for the entire SSID (CLI family config qos); in the SSID itself (QoS tab, and
CLI config wlan override-rate-limit); in the context of roles (Wireless > QoS > Roles), where
you configure a role, then set a Local Net User to Guest and associate the role as Guest User Role;
in the AAA server, by defining an authorization profile that either contains the role, the local policy
name, or directly the bandwidth contract for that user. Figure 7-19 shows these various locations.
You should be familiar with the various ways of creating the bandwidth contracts.
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Figure 7-19 Bandwidth Contract Configuration Options

In the left side of the window, "Edit QoS profile, Edit QoS role data rates, and Edit
'ShowmeQoS" screens are displayed. The "Edit QoS profile" shows the sections "QoS
profile name, description, Per-User Bandwidth Contracts (Kbps) and Per-SSID Bandwidth
Contracts (Kbps)." In the second screenshot "Wireless" tab is selected that displays the
"Edit QoS role data rates" window with the sections "QoS role name and Per-User
bandwidth Contracts (Kbps)." In the "ShowmeQoS" window, "QoS" tab is selected. "Net
flow monitor and Fastlane" are set to "None and Enable" from spin boxes. In the "Override
Per-User Bandwidth contracts (Kbps) four fields are shown with Downstream and
Upstream values. "Override Per-SSID Bandwidth contracts (Kbps) four fields are shown
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with Downstream and Upstream values. On the right, Cisco window is shown where,
"Security" tab is selected that displays a list in the navigation pane. In the content pane
"Edit" is selected under Policy with the sections "Match criteria, device list, and Action."
In the bottom right window, "Policy" tab is selected. Below, "Policy elements" subtab is
selected with Results tab selected. The results tab shows a list in the navigation pane,
where "Authorization Profiles" is selected. The "New Authorization Profile" in the content
pane displays the sections "Authorization profile" with the fields: Name, description, access
type, network device profile, service template, track movement, and passive identity
tracking." The common tasks show a list under "Airespace." Under "Advanced attributes
settings" section is displayed at the bottom.

When several contracts are possible for a given user, the most targeted and most restrictive
configuration applies. Configurations are looked at in this order: AAA user-specific configuration
first; then device local policy; then guest role if applicable; then WLAN contract; and last, QoS
profile contract. The QoS profile contract is applied only if no other contract was defined.

If one or multiple QoS contracts were defined outside the QoS profile and are applicable for a given
user (in the WLAN, local policy, guest role, or AAA), the QoS profile contract is ignored for the
user for which these non-QoS-profile contracts apply. In other words, if your QoS profile contract
is 10 kbps, but the user matches a local policy restricting to 50 kbps, that user will receive 50 kbps.

Also, AAA always overrides local configs. If your WLAN BW contract is 10 kbps but AAA applies
50 kbps for a given user, that user receives 50 kbps.

Finally, local policies override roles.

These combinations may look complex. You should understand the various ways of creating
bandwidth contracts, in case the CCIE Wireless exam asks you to configure such a contract.
However, it is clear to all that bandwidth contracts are not best practices. Although there may be an
ask and a need to configure a contract for specific users, no reasonable design would mandate
contradicting contracts for various user types with the requirements to map the various possible
overlaps in order to decide which contract a user eventually receives. If this scenario occurs, you
should suggest to your customer a better network design. If you still have to face this unfortunate
scenario, you can always verify which bandwidth contract is being applied to a given user with the
show client detail command. There, you will be able to see which contract overrode the others and
was applied to your test client.

For corporate WLANs, where voice is expected, Platinum is the recommended QoS profile. After
you pick a QoS profile, you associate it to the WLAN from the QoS tab (CLI config wlan qos). For
corporate WLANs and Platinum profiles, as much as possible, bandwidth contracts should not be
used. Maximum priority should be set to voice. Unicast default priority and multicast default
priority should be set to best effort, and Wired QoS protocol should be set to none, as represented
in Figure 7-20. In the CLI, all these elements are configured with the family of command config
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qos.

Figure 7-20 QoS Profile Options and Values

A cisco window is shown where "Wireless" tab is selected that displays a list in the
navigation pane. In the Content pane titled, "Edit QoS profile" the following sections are
shown. QoS profile name, description, Per-User bandwidth contracts, Per-SSID bandwidth
contracts, WLAN QoS parameters, and Wired QoS protocol. On the right, a table is shown
with the column headers reading "Profile name, Max downstream DSCP value, and
Maximum Upstream DSCP value."

The reason for not using bandwidth contract was explained in the previous section: as much as
possible, it is better to use QoS marking to create differentiated treatment for applications. Using
bandwidth contracts creates artificial static limits that do not take into account the traffic type, the
user location (close or far from the AP), and the general available airtime in the cell.

The maximum priority is the effective ceiling of the profile. You should remember that this ceiling
is expressed as an 802.11e AC (voice, video, best effort, and background). This means that the
maximum priority is intended for the wireless space, not the wired space (although it has an effect
on the wire, as we’ll see later). This ceiling means that no traffic will be marked higher than voice
downstream from the AP (for any SSID to which this QoS profile is associated).
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Unicast Default priority represents the QoS marking for non-WMM stations. In other words, when
traffic arrives from the wire for a station that does not support WMM (and therefore does not
support 802.11e QoS), how should you treat that traffic on the AP? The legacy recommendation
was to treat the traffic as representative of the QoS profile category. In other words, if you
associated a Platinum profile to an SSID, the assumption was that most traffic for that SSID was
likely to be Platinum (that is, voice). Therefore, treating all traffic by default as voice was the rule.
This was back in the days when admins used to configure specialized SSIDs (for example, Voice
SSID, Data SSID), and when devices were also specialized (your voice devices would all be hard
phones). Times have changed. Today, you configure general SSIDs (corporate, with all sorts of
traffic, voice and others), and devices are generic (BYODs run voice applications and data
applications). As a consequence, you do not expect anymore that an unknown device that does not
support QoS would primarily be a voice device in such a generic SSID. As WMM support is
mandatory for 802.11n/ac, no WMM support is equivalent to “old legacy device.” This is unlikely
to be your choice for voice traffic. It is probably an old laptop, a barcode scanner, or some other
non-voice device. As a consequence, traffic to this non-WMM device should be best effort.

Multicast can be any type of traffic; however, it is a problematic type of traffic because it is
addressed to multiple recipients. This means that the targets may be on a given AP radio but in
different WLANs. It is therefore difficult to decide whether a particular priority should be given to
multicast (over the air, but also between the WLC and the AP). A general rule is to treat this traffic
as “generic” (best effort). However, if you know of a particular multicast traffic that critically
needs specific QoS treatment, an exception can be made (and the multicast default priority can be
changed accordingly).

The Wired QoS protocol relates to the CAPWAP encapsulation between the WLC and the AP. The
QoS profile acts as a ceiling. This notion is not visible with Platinum because the ceiling is at the
highest QoS marking. So let’s take Gold as an example, to better visualize the consequences of that
ceiling concept. Please note that in most real-world environments (and the CCIE lab is not a real-
world environment), you will not use Gold anymore, but this profile serves as a useful intermediary
between the highest ceiling (voice) and best effort.

When a packet comes into the WLC, coming from the wired side and destined for a wireless client,
in a WLAN associated to a specific QoS profile (in this case Gold), the WLC will first look up the
client. We suppose here that AVC is not configured. The WLC will then look at the QoS profile
associated with that client (Gold). Suppose that the incoming packet has a DSCP marking of 46
(EF), as represented in Figure 7-21.
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Figure 7-21 Effect of the Gold Profile on Voice Traffic

The devices laptop, mobile phone, and a tab are connected to an "Access point" through
the wireless connectivity in various orientations that is further connected to the "Layer 3
switch" labeled CAPWAP. To the right of the "Layer 3 switch," an "802.11Q trunk" is
shown with a "WLAN Controller" at the center and a "Stop" icon over it. At the top, a
leftward arrow is shown and at the bottom, a rightward arrow is shown. The devices and
the lines are connected by dotted lines. To the top of this, blocks are shown with the
CAPWAP packet numbers. The first block is divided into three "UP: 5, DSCP: 46, and
Payload." The second block is divided into two "DCSP: 34 and CAPWAP Encapsulated:
802.11, DCSP: 46, and Payload." The third block is divided into three "802.1p, DSCP,
CAPWAP Encapsulated: 802.11, DSCP: 46, and Payload." The fourth block is divided into
"802.1p, DSCP: 46, and Payload." The same set is shown at the bottom with the change in
the packet number of "UP" in the first block is labeled "6." At the top, the "DCSP: 34"
points to "UP: 5." The "DSCP: 46" points to the "CAPWAP Encapsulated DSCP: 46" and
"DSCP: 34." At the bottom, "UP: 6" points to "DSCP: 34" and the "CAPWAP
Encapsulated DSCP: 46" points to the DSCP: 46."

The WLC is going to convert the 802.3 header into an 802.11 header, then encapsulate the 802.11
frame into a CAPWAP header. The DSCP value, inside the encapsulated CAPWAP packet, is
unchanged (46); however, the Gold profile creates a QoS ceiling of AF 41 (DSCP 34). Therefore,
the WLC is going to cap the CAPWAP outer IP header to DSCP 34. In this example, because the
Wired QoS profile is set to none, the 802.1p (Layer 2 QoS over the Ethernet link) is ignored and
left at 0. Using DSCP is the recommended practice. Therefore, Wired QoS is expected to be left to
None.

Note

In older codes (before 7.x), the outer DSCP header would be left untouched (DSCP 46), and only
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the 802.1p value would be capped (802.1p 4 in the case of Gold/video). In those days, you needed
to enable Wired QoS profile and set it to the proper ceiling, 4. This task was made complex by the
fact that some codes actually displayed the 802.11e equivalent (i.e., “5” for video, because this is
the UP for video) instead of displaying directly the 802.1p value. This complexity was removed
since, and what you see in AireOS 8.x and later is indeed the 802.1p direct value.

However, AireOS 8.x and later also cap the outer DSCP value, which is required in a world where
using DSCP is recommended. Therefore, the 802.1p and Wired QoS protocol configuration has
become obsolete, and you would only use it in older networks where DSCP is not supported on the
switching infrastructure.

The CAPWAP encapsulated packet is then going to transit toward the AP. The AP is likely to be
on an access port (not a trunk port), so there is no 802.1p value on that last hop. (Remember that
the 802.1p field is in the 802.1Q section of the header, and therefore is present only on trunk links.)
Upon receiving the packet, the AP is going to look at the outer DSCP value and compare it to the
QoS ceiling (Gold) associated to the target client WLAN. This two-step process is important
because it has two consequences:

The AP never looks at the inner DSCP value.

If you change the outer DSCP on the way between the WLC and the AP (by using remarking
on one switch), you are going to change the treatment of that packet over the air, regardless of
what initial QoS value was set by the wired client or the WLC.

If the CAPWAP outer DSCP value is equal to or lower than the QoS ceiling, the AP sends the
packet with the requested QoS value. If the outer DSCP value is higher than the ceiling, the AP
sends at the ceiling level. Let’s take a few examples. Suppose the outer DSCP is AF11
(background). This is lower than the Gold ceiling, therefore the AP sends the packet in the
background queue (AC_BK, UP1), as requested by the outer DSCP value (AF 11). Suppose now
that the outer DSCP is AF41. This is right at the ceiling level and still allowed. The AP sends the
packet in the video queue (AC_VI, UP5), as requested by the outer DSCP value (DSCP 34, AF 41).
Suppose now that the packet outer DSCP was remarked on the way to EF (DSCP 46). Remarking
on the path is the only possible explanation, as the WLC already capped the outer header to DSCP
34 (AF 41), so the packet should not get a DSCP 34 without some equipment changing the marking
on the path. In any case, the AP sees that DSCP 46 is higher than the ceiling (34), and therefore
positions the packet in the ceiling queue, AC_VI, UP 5. This UP treatment decides the frame
priority between the AP and the client. Inside the frame, the payload DSCP is still 46.

The same logic applies for upstream traffic. Suppose that the wireless station sends a frame marked
UP6 (AC_VO) and DSCP 46. This is possible, even if the QoS ceiling is Video. The QoS ceiling is
an infrastructure configuration, not a behavior dictated by the AP to its clients. Upon receiving the
frame, the AP is going to encapsulate the 802.11 frame into CAPWAP and look at the UP value.
This occurs if you use the default behavior of using the UP upstream. As we’ll see shortly, you
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should change the defaults and use Trust DSCP instead. In that case, the AP would look at the
DSCP value and ignore the UP value. The process logic is the same, only the field considered
changes. As the value exceeds the Gold ceiling, the AP caps the CAPWAP outer DSCP header to
Gold (AF 41) and sends the packet to the WLC. The WLC then decapsulates the packet, converts
the 802.11 frame into an 802.3 frame, then sends it to the wire without changing the requested
DSCP value (46).

This process may look complex, and it may seem that the treatment by the WLC is not the same
upstream and downstream. This appearance is an illusion. An easy rule to remember is that the
WLC or the AP never touch the requested inner DSCP value. If you give the system, in any
direction, a packet with a given DSCP value, you will receive a packet with that DSCP value
unchanged on the other side of the system. The WLC-AP pair only controls the CAPWAP header
value and the L2 QoS treatment over the air, downstream. However, you should keep in mind that
intermediate devices between your APs and WLCs (switches, routers) will prioritize the packets
based on the outer CAPWAP header QoS tag. These devices may also rewrite this tag based on
their local QoS policies. This behavior means that the QoS tag initially written on the outer
CAPWAP header by one end (WLC or AP) may be different when the packet reaches the other
end (AP or WLC). Upstream, this possible change affects only the priority of the packet between
the AP and the WLC (the WLC looks at the inner QoS tag to decide the packet fate). Downstream,
this possible change affects both the priority of the packet between the WLC and the AP and the
priority of the packet over the air (because the AP uses the outer CAPWAP QoS value to decide
the downstream UP queue and value). The logic of this asymmetry is that you control the WLC-
AP-client space. If a switch is between the WLC and the AP, it is under your administrative
control. If that switch rewrites the outer CAPWAP QoS, it is because you have decided a particular
mapping policy for that QoS value. That policy should be enforced. However, the space beyond the
WLC (upstream) is not your domain anymore; you should return to that space the QoS tags
unchanged, leaving the decision to keep or rewrite these tags to the LAN admin.

The QoS control mechanism becomes a bit more complex when your incoming wired packet has an
unexpected QoS value (something that is not a clear voice or video marking). On the wire, the rule
is simple. If the requested DSCP marking is below the ceiling, it is translated unchanged to the
CAPWAP outer DSCP value. But what happens over the air, where there are at most only eight
values? QoS mapping recommendations have been evolving over time (as you may remember from
the first section of this chapter), and the AireOS code that you will get at the CCIE exam does not
always reflect the latest recommendations. This is not an issue, as a macro will help you to
configure the right mapping, but you may want to be aware of AireOS defaults, in case you decide
to not configure anything.

The logic of the internal mapping is to select key DSCP values that have a special significance
(voice, and so on) and create a special mapping for these values. These are the values we took as
examples earlier. Then, any other value is a simple mapping between the three MSB (the IP
Precedence bits) to UP, and vice versa.

Chapter 7 WLAN Media and Application Services

432

Technet24
||||||||||||||||||||

||||||||||||||||||||

https://technet24.ir
https://technet24.ir
https://technet24.ir


Default QoS Mapping

Note

You will find online multiple documents that show you the QoS mapping for AireOS. Depending on
when this document was written, it can be pretty close to the current (on AireOS 8.3 and later)
mapping, or very far. Do not waste time trying to decide who is right and who is wrong. Most of the
time, the difference is when the document was written, not so much about whether the author knew
how to measure QoS.

Table 7-5 shows the current (AireOS 8.3 and later) default mapping:

Table 7-5 AireOS Default DSCP-UP Mapping

Downstream Wired DSCP PHB Binary Air UP 3mb Notes
0 000000 0 0
1 000001 0 0
2 000010 1 0
3 000011 0 0
4 000100 1 0
5 000101 0 0
6 000110 1 0
7 000111 0 0
8 cs1 001000 1 1
9 001001 1 1
10 af11 001010 2 1
11 001011 1 1
12 af12 001100 2 1
13 001101 1 1
14 af13 001110 2 1
15 001111 1 1
16 cs2 010000 2 2
17 010001 2 2

18 af21 010010 3 2
19 010011 2 2
20 af22 010100 3 2
21 010101 2 2
22 af23 010110 3 2

23 010111 2 2
24 cs3 011000 3 3 Should be UP 4
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24 cs3 011000 3 3 Should be UP 4
25 011001 3 3
26 af31 011010 4 3
27 011011 3 3
28 af32 011100 3 3 Should be UP 4
29 011101 3 3
30 af33 011110 3 3 Should be UP 4
31 011111 3 3
32 cs4 100000 4 4
33 100001 4 4
34 af41 100010 5 4
35 100011 4 4
36 af42 100100 4 4 Should be UP 5
37 100101 4 4
38 af43 100110 4 4 Should be UP 5
39 100111 4 4
40 cs5 101000 5 5
41 101001 5 5
42 101010 5 5
43 101011 5 5
44 voice admit 101100 5 5 Should be UP 6
45 101101 5 5
46 ef 101110 6 5
47 101111 6 5 Should be UP 5
48 cs6 110000 6 6
49 110001 6 6
50 110010 6 6
51 110011 6 6

52 110100 6 6
53 110101 6 6
54 110110 6 6
55 110111 6 6
56 cs7 111000 6 7
57 111001 6 7
58 111010 6 7
59 111011 6 7

60 111100 6 761 111101 6 7
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61 111101 6 7
62 111110 6 7
63 111111 6 7

You see that a few values are highlighted, because the defaults do not match the best practices.
They are legacy recommendations. However, using defaults is also not the best practice, because
the defaults are based on the idea that you would use UP to DSCP mapping upstream, which you
should not do in most cases. So there is an expectation that you are going to override these defaults
anyway (even if you use UP upstream). Therefore, there is not a strong incentive to change the
AireOS code to hard code different default values (because you won’t use these defaults anyway,
whatever they are, because they assume “trust UP” to comply with backward compatibility rules).

DSCP Trust and 802.11u QoS Maps

Since AireOS 8.1MR1, you can create a custom DSCP to UP and UP to DSCP map. An optimized
version of this custom map can be created with a simple macro (Fastlane, examined later in this
section). However, you may want to understand the custom map command and structure, in case
you need to customize it by hand. The customization page is a global setting (applies to all SSIDs
and all bands) and is configured from Wireless > QOS > QoS map, as shown in Figure 7-22.

Chapter 7 WLAN Media and Application Services

435

||||||||||||||||||||

||||||||||||||||||||

file:///C:/Users/MERRELL/Documents/eBook Converter/Oreilly Downloader/tmp/9780135162095/ch07.xhtml#ch07fig22
https://technet24.ir
https://technet24.ir


Figure 7-22 QoS Map Configuration

In the Cisco window, "Wireless" tab is selected that displays the Wireless list in the
navigation pane. The content pane titled "QoS Map Config" shows the "QoS map set to
enable (selected from a spin box)." A radio button "Trust: Trust DSCP Upstream" is
selected under "Up Stream" with Apply button. Downstream consists of the sections
"DSCP to UP map, Add DSCP exception, DSCP to UP map list, and DSCP Exception list."
DCSP TO UP map list shows a table with the headers Up, start DSCP, and End DSCP.
DSCP exception list shows a table with headers DSCP and UP.

From this page, you can set three configuration items:

Enable DSCP trust from the client

Configure a custom DSCP to UP map (called exceptions)

Configure a custom UP to DSCP map
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The recommended practice is to trust DSCP upstream. When this function is activated, the AP
looks at the DSCP field in the frames coming from wireless clients (instead of looking at the UP).
As detailed in the first part of this chapter, and shown in Figure 7-23, using DSCP instead of UP
allows for a richer translation of QoS intents between mediums.

Figure 7-23 Effect of Trust UP vs. Trust DSCP

The 802.11 frame consists of DSCP and UP, CAPWAP Packet consists of DSCP and
DSCP, and the IP Packet consists of DSCP. The DSCP and UP of the 802.11 frame points
to the two DSCP of the CAPWAP Packet. The first DSCP of the CAPWAP packet points
to the DSCP of the IP Packet. The Trust DSCP consists of two 6-Bit DSCP on both sides.
All the 6-Bits from the left DSCP are copied to the right DSCP. Trust UP is shown at the
top copies the first 3-Bits to the 6-Bit, where the last three bits are zeroed out. At the top,
an access point and a WLAN controller are shown that are connected by a cloud network.
Access point points between the 802.11 frames and CAPWAP packet and the WLAN
Controller points between the CAPWAP Packet and IP Packet. A laptop is connected to
the Access point through WI-Fi.

You can directly use the end-to-end intent for that packet, instead of using a 3-bit local L2 Wi-Fi
QoS intent to express intent across another medium (Ethernet) and possible routing hops, where
DSCP is more meaningful than Layer 2 values. Keep in mind that the action of the AP does not
change. Whether you trust DSCP or trust UP upstream, the AP still looks at the incoming value
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(DSCP or UP), compares it to the WLAN QoS ceiling expressed through the associated QoS
profile, and uses this comparison to either copy the requested DSCP value (or UP value) to the
CAPWAP outer header DSCP section (using direct copy in case of DSCP trust, or using a UP to
DSCP map in case of UP trust).

Therefore, the recommended practice is to enable DSCP trust upstream by checking the
corresponding check box on the QoS map configuration page. From the CLI, the equivalent is
config qos qosmap trust-dscp-upstream enable. You would trust UP only if the majority of your
wireless clients are unable to mark DSCP but would mark UP. However, this would be an
uncommon scenario.

You can also configure customized DSCP to UP and UP to DSCP maps. In the CLI, the structure of
the command is confusing, and shown in Figure 7-24.

Figure 7-24 QoS Map Configuration Command

The QoS configuration command reads (Cisco Controller) less than config qos qosmap up-
to-dscp-map 6 45 40 48. Text pointing the value 6 reads, This DSCP value range will
translate by default to this UP value (downstream) and this UP value will be default
CAPWAP outer header DSCP value (upstream)." "40 and 48" are encircled pointing to the
text "This DSCP value range will translate by default to this UP value (downstream)." "46"
points to a text reading "This UP value will be this default CAPWAP outer header DSCP
value (upstream)."

This complexity is reflected in the UI in AireOS 8.3 code as shown in Figure 7-22. In AireOS 8.4
and later, this direct translation of the CLI was replaced by an intent-oriented display, and DSCP to
UP was separated from UP to DSCP. The reason for the complexity comes from the fact that the
command is a direct translation from 802.11u. This amendment, published in 2011, contains
multiple provisions for HotSpot 2.0. In a context where Trusting UP was the norm (with all the
limitations expressed earlier that were well known to QoS experts working on 802.11u), 802.11u
allowed the AP to send to the client station an UP to DSCP map. This could be used by the station
to set the best UP for the upstream transmission, knowing the intended DSCP for a given traffic. In
other words, if you want to send a video packet, if you know that video receives AF 41 in your
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internal client operating system, and if you want to make sure that the AP, trusting UP, assigns AF
41 to your packet, you have to look at the UP to DSCP map, find which UP receives AF 41, and
“simply” assign that UP to your upstream video packet.

However, there was a need to also express a DSCP to UP map. The intent was to tell the station “if
your operating system can only generate DSCP, and you are not sure about the best UP for each
DSCP, here is the DSCP to UP map recommended for this network.” A natural push in the 802.11u
group was to argue that such a map was unnecessary, because the station could use the UP to
DSCP map in reverse: if UP 5 is AF 41, then AF 41 should be UP 5. Of course, this approach was
seen as too simplistic by many because this logic works only for 8 DSCP values (those that match
each of the 8 UP values in the UP to DSCP map). For example, if the UP to DSCP maps states that
AF 41 (DSCP 34) is 5, and EF (DSCP 46) is 6, what is the UP value of DSCP 36? Some proponents
of simplification suggested to use an UP to DSCP range. In other words, instead of just stating “UP
6 is DSCP 46,” the map would state “UP 6 is DSCP 44 to 46.” Creating such a range also implies
creating defaults. If I have UP 6 for my frame, which DSCP should I put—DSCP 44, 45, or DSCP
46? As a result of these discussions, the UP to DSCP map transformed into a UP to DSCP range,
with a default UP to DSCP map, if you only have UP to start from. This already makes the
command a bit complicated, but these arrangements still did not satisfy all the requirements, for the
simple reasons explained in the first section of this chapter. For most UP values, a simple 3 MSB
translation works (CS 3 is 011 00 0, which can be simply translated as UP 3, also 011). But quite a
few UPs and DSCP require special mapping (like Voice 101 11 0, which would be UP 5 but should
in fact be UP 6). As a consequence, 802.11u also allowed a series of “exceptions” to be defined
(DSCP values that would translate to special UP values, without using the standard UP to DSCP
range map). Because there are really 21 DSCP values in use (as per RFC 4594), the exception list
can contain up to 21 entries.

This complexity in 802.11u is directly translated into the CLI command, which is built in two parts:
an UP to DSCP range and a DSCP to UP exception.

The UP to DSCP range section is configured on the left side of the QoS map UI screen, and with
the command shown in Figure 7-24: config qos qosmap up-to-dscp-map. With this command, you
start by calling the target UP value (for example, config qos qosmap up-to-dscp-map 1, to
configure the map for UP 1). You then configure the default DSCP value for this UP (config qos
qosmap up-to-dscp-map 1 8, to express that DSCP 8, or CS1, should be the DSCP to which UP 8
should map, if we have only UP to work from). You then add the range for which this UP is valid
(for example, config qos qosmap up-to-dscp-map 1 8 8 15, to express that if we have a DSCP
value and we are looking for the UP, then UP 1 should be chosen for any DSCP value between 8
[CS1] and 15 [15 is unused, but includes DSCP 14, or AF 13]).

Sounds complicated? Yes, it is. The matter is made worse by the fact that you must configure each
UP (you cannot configure a map for UPs 1 to 6 and skip 7), and also by the fact that the ranges
cannot overlap (you cannot map UP 1 to DSCP 8 to 24, and map UP 2 to DSCP 24 to 32, because
the system would not know the right UP for DSCP 24). Also, this mapping is very logical in the
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case of 802.11u, but in an AireOS controller, you are not trying to tell the wireless station what to
do (at the time of writing of this section, no client makes use of the 802.11u QoS map); you are
trying to tell your AP how to translate between UP and DSCP, and vice versa. And if you trust
DSCP upstream, why would you care about an UP to DSCP map (you are using DSCP, not UP)?
Yet the command mandates that you tell the system about the map (because the map will be
advertised by the AP, as per 802.11u).

The real part of the command you care about is the DSCP to UP “exception” section. This is useful
downstream. When you receive wired packets with a DSCP value, the QoS profile will still
determine the ceiling, as usual. However, if your DSCP value is below the max value (QoS profile
ceiling), should you use the default DSCP to UP 3 MSB map or a special DSCP to UP translation?
The right part of the QoS map configuration screen and the config qos qosmap dscp-to-up-
exception allow you to configure up to 21 DSCP to UP special mappings. This is something you
should configure if you trust DSCP upstream.

Luckily (see the “Fastlane Configuration and Client Behavior” section later in this chapter), there is
a macro to configure all the right “recommended” values in one single command shown later in
Figure 7-36. However, you should understand the values that this macro sets and what these
recommended values are:

Click here to view code image

config qos qosmap up-to-dscp-map 0 0 0 7
config qos qosmap up-to-dscp-map 1 8 8 15
config qos qosmap up-to-dscp-map 2 16 16 23
config qos qosmap up-to-dscp-map 3 24 24 31
config qos qosmap up-to-dscp-map 4 32 32 39
config qos qosmap up-to-dscp-map 5 34 40 47
config qos qosmap up-to-dscp-map 6 46 48 62
config qos qosmap up-to-dscp-map 7 56 63 63
config qos qosmap dscp-to-up-exception 48 0
config qos qosmap dscp-to-up-exception 56 0
config qos qosmap dscp-to-up-exception 46 6
config qos qosmap dscp-to-up-exception 44 6
config qos qosmap dscp-to-up-exception 40 5
config qos qosmap dscp-to-up-exception 38 4
config qos qosmap dscp-to-up-exception 36 4
config qos qosmap dscp-to-up-exception 34 4
config qos qosmap dscp-to-up-exception 32 5
config qos qosmap dscp-to-up-exception 30 4
config qos qosmap dscp-to-up-exception 28 4
config qos qosmap dscp-to-up-exception 26 4
config qos qosmap dscp-to-up-exception 24 4
config qos qosmap dscp-to-up-exception 22 3
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config qos qosmap dscp-to-up-exception 20 3
config qos qosmap dscp-to-up-exception 18 3
config qos qosmap dscp-to-up-exception 16 0
config qos qosmap dscp-to-up-exception 14 2
config qos qosmap dscp-to-up-exception 12 2
config qos qosmap dscp-to-up-exception 10 2
config qos qosmap dscp-to-up-exception 8 1
config qos qosmap trust-dscp-upstream enable
config qos qosmap enable

The UP to DSCP part sets UP 0, 1, 2, 3, 4, 5, 6, and 7 to default DSCP 0, 8 (CS1), 16 (CS2), 24
(CS3), 32 (CS4), 34 (AF41), 46 (EF), and CS7, respectively. In other words, the defaults are to use
the 3 MSBs, translating each up to the corresponding CS value, with the exception of video (UP 5,
AF 41) and voice (UP 6, EF). The corresponding ranges are also set the same way, with the same
exception. For example, UP 1 covers all DSCPs between CS 1 (001 00 0) and the CS 2 lower
boundary (001 11 0, which is DSCP 14, a possible value, but also 001 11 1, DSCP 15, which should
not be present in a network but is in theory possible). The same logic applies for the other UPs. UP
4 covers the same way all DSCPs from 100 00 0 (DSCP 32, CS4) to 100 11 1 (unlikely DSCP 39,
but also includes AF 43, DSCP 38). However, a special exception is made for AF 41, which is the
default map for UP 5. This exception means that AF41 somewhat “jumps one range up” (AF 41 is
100 01 0 but translates to a 101 UP binary). However, AF 41 is an exception, and UP 5 maps
otherwise to the other 101 DSCP values (101 00 0, CS 5 or DSCP 40, to 101 11 1, which includes
101 11 0, DSCP 46 or EF, still in the 101 range).

Because voice is special, an exception is made again, where UP 6 maps by default to EF, thus
overriding again the general range. Anything above 101 11 0 (EF) is network control and should not
be present in an access network. However, as explained in the first part of this chapter, you may
find contexts where such values are permitted. In this case, they should map to UP 6. This is what
the 6 46 48 62 expresses. The only exception is the reserved value CS 7/UP 7. This value would
exist only by itself, and if a special “highest override” experimental value of 111 11 1 was seen.

The DSCP to UP exception command then lists all the well-known and expected DSCP values and
maps them to their recommended UP value, as shown earlier in Figure 7-8. Notice that these
recommendations span most of the UP values. You will find that most systems (outside of Cisco)
use only four ACs, and therefore only four UPs. By contrast, AireOS uses the full span of UP
possibilities.

EDCA Parameters

Another best practice set of parameters that you may want to change are the EDCA parameters, in
Wireless > 802.11a/n/ac (or 802.11b/g/n) > EDCA Parameters (CLI config advanced 802.11a /
802.11b edca-parameter). The default value is WMM, which matches the 802.11e standard
recommendations for EDCA. You may have some cases where the band is primarily designed for a
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specific traffic type. Several other types of EDCA values are possible, as shown in Figure 7-25.

Figure 7-25 AireOS Standard EDCA Parameters

In the snapshot, "Wireless" tab is selected with "EDCA Profile" encircled under the
General section. A list for the "EDCA Profile" is displayed on the right reading "WMM,
Spectralink voice priority, Voice Optimized, and Voice and Video Optimized." WMM
points to a table with the column headers "AC, AIFSN, CWmin, CWmax, and TXOP" and
row headers "VO, VI, BE, and BK." Row 1 reads: 2, 2, 3, and 47. Row 2 reads: 2, 3, 4, and
94. Row 3 reads: Voice Optimized points to another table with the same headers. The
following values are changed in the following rows "AIFSN and VI: 5, AIFSN and BE: 5,
AIFSN and BK: 12, CWmin and BE: 5, CWmin and BK: 8, CWmax and VO: 4, CWmax
and VI: 5, TXOP and VO: 0, TXOP and VI: 0." The Voice and Video Optimized points
toward a table with the change of value in AIFSN and BE marked 12.

The blue color shows the changes from the standard WMM profile. Voice Optimized increases the
AIFSN for all queues except voice, and also increases some CWmin and CWmax values. Note that
Voice Optimized also sets the TXOP for voice and video to 0. This change fulfills two purposes:

As explained at the beginning of this chapter, a TXOP value offers transmit opportunities but
also limits the transmit duration. A value of 0 allows only one frame per service period but also
allows that frame to be the max duration allowed by the protocol. With 0, voice and video can
send large blocks, just like the other queues.

Some drivers (especially on hard phones) queue frames in a peculiar way. The software part of
the phone decides whether the packet needs to be sent to the queue, then subcontracts the
transmit part to the driver. The driver then looks at the TXOP and decides on the number of
frames that should be sent in the next service period. The frame burst is built, and the phone
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waits to get medium access. When the access is granted, the entire burst is sent. But this logic
does not account for losses and delays. If delays appear, the software part of the phone may
decide to skip a packet and send the next one instead, privileging real-time over audio quality
(a slightly metallic texture of the sound, due to a packet missing here and there, is better than
no audio at all because the buffer is empty). However, with the mechanism previously
described, when a frame is in the next burst in the drive, it is too late. The software can’t drop a
packet here and there to put later packets instead. The result is a higher risk of empty buffer
and dead air. Setting the TXOP to 0 compensates for these hard phone behaviors, making sure
that only one packet at a time gets sent to the driver.

In most cases, you would not choose the default WMM value but the Fastlane value instead, for
which AIFSN and CW values are shown in Figure 7-14. However, there may be cases where you
are given very specific requirements that would push your choice to another set of optimized
EDCA parameters.

WLAN and WMM Configurations

At this point, you have configured your QoS profiles, you likely have chosen to trust DSCP
upstream, and you have set your DSCP to UP and UP to DSCP maps. You have also chosen the
best EDCA parameter set. All this configuration relates to QoS, which means that your clients are
expected to have some support of QoS. In Wi-Fi terms, this means that they support WMM. If they
are 802.11n or 802.11ac compliant, they must support WMM, so it is likely that most of your
enterprise clients will be in this category.

Your next step is to go to the WLAN QoS tab and associate the right QoS profile: Platinum for an
enterprise hybrid BYOD WLAN, where voice is expected, as shown in Figure 7-26, and Best Effort
or Background for a guest WLAN.
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Figure 7-26 WLAN QoS Tab

In the Class window of the WLANs, QoS tab is selected that displays the fields where
Quality of Service (QoS) is set to platinum (voice) selected from a spin box and the
following fields are entered Application visibility, AVC profile, Flex AVC profile, NetFlow
monitor, and Fastlane. The bottom section Override Per-User Bandwidth Contracts (kbps)
shows four fields with downstream and upstream values. In the right screenshot, QoS tab is
selected in the class window. Under Override Per-SSID Bandwidth Contracts section, four
fields are shown with Downstream and Upstream values entered. In the WMM section,
WMM policy field shows a sublist where allowed is selected. Lync policy section shows
the fields audio, video, and application-sharing with Silver selected for all the fields from a
drop-down button.

Lower down the QoS tab, set WMM to Allowed or Required. If your stations support 802.11n or
802.11ac, they support WMM, and setting WMM to Required is the right choice. The Required
option was especially useful for smartphones. Many of them would prefer Best Effort and would
enable WMM only if the cell mandates it. In other words, set WMM to Allowed (allowing both
WMM and non-WMM devices and behavior), and these smartphones would not activate WMM.
Set WMM to Required, and these smartphones would activate WMM (because they have no
choice). Because WMM also activates QoS, WMM is much preferred over best effort. Using
WMM Required was a way to enforce this support.

However, using WMM Required means that non-WMM devices cannot join the WLAN (the
devices that do not support WMM, not the devices that would support it but are too lazy to activate
it by themselves). If you have such devices in your network, and you cannot upgrade them to
newer devices, you may have to set WMM to Allowed.
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CAC Configuration

The next parameter to consider is Call Admission Control. Recall that this is Wireless CAC, not
Unified Communications CAC. It is configured per band in Wireless > 802.11a/n/ac | 802.11b/g/n
> Media as shown in Figure 7-27 (CLI config 802.11b|802.11a cac).

Figure 7-27 Voice CAC Configuration

In the Wireless window, the radio frequency 802.11a (5GHZ) is selected in the navigation
pane. In the content pane under media Video tab is selected that shows three sections Call
Admission Control (CAC), Per-Call SIP Bandwidth and Traffic Stream Metrics. The Call
Admission Control (CAC) section shows the fields where Admission control (ACM)
checkbox is selected. The sublist overlaps the checkbox where Load based is selected and
that points toward a text reading Use Load-based for TSPEC but static for SIP, Non -
WMM and another checkbox is selected for Expedited bandwidth. The reserved roaming
bandwidth (0 to 25) percent text box is marked 50, pointing to a text box reading up to 90
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percent (Static) or 85 percent (Load-based) BW.

Voice CAC, protecting UP 6, is enabled by checking the ACM Enabled check box on the Voice
tab. The choice to check this option depends on your voice client population. Most hard phones will
support TSPEC (as described in the first part of this chapter). iOS 10 and later are “immune” to
Voice ACM (see the “FastLane Configuration and Client Behavior” section). However, the vast
majority of the other smartphones will not support TSPEC and will therefore be unable to send
traffic in the UP 6 queue. This will force your smartphones to revert to either UP 5 or UP 0. This
reversion scheme is mandated and tested by the WMM certification (if the Voice ACM bit is on,
phones must send voice traffic in either UP 5 or UP 0). You need to test your phone population to
validate their behavior and choose the configuration most advantageous to clients:

If your phones support TSPEC, Voice ACM is a good feature in your network.

If your phones and tablets are iOS 10 and later, and laptops Mac OS 10.13 or later, Voice ACM
is a good feature in your network.

If your phones, tablets, and laptops do not mark UP 6 for voice in the first place (because the
apps do not mark QoS, or because the app marks a DSCP value that does not translate to UP 6
when the phone sends), ACM is neutral for these clients.

If your phones, tablets, and laptops do mark UP 6 when sending voice app traffic, ACM is a
limitation for these clients.

The fact that clients have to revert to UP 5 or UP 0 only represents the upstream part of the
constraint. When the AP receives the frame, it uses the UP or DSCP value for the upstream part of
the journey. If the AP uses UP, the UP 5 or UP 0 would result in worse treatment than expected for
that voice packet. This is another reason why trusting DSCP is better if the upstream packet also
includes the correct DSCP value for voice. Although WMM mandates that the UP would be lower,
the DSCP would be unchanged by the ACM configuration.

As for the return traffic, and as shown in Figure 7-28, the infrastructure is aware that ACM is
enabled. Although your profile may be Platinum, therefore allowing up to voice (EF) traffic, the
ACM bit will limit this ceiling over the air. If the return traffic (from the wire, toward the client) is
also voice, with a DSCP 46 marking, the WLC to AP segment of the network will carry the DSCP
46 value, but the AP will check whether the target client did undergo the ADDTS choreography. If
the client is not in the ACM-allowed list, the AP will send the frame over the air as Best Effort.
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Figure 7-28 Effect of CAC on Non-TSPEC Clients

The Non-Tspec clients like a laptop and a tab are connected to an "Access point" through
the wireless connectivity in various orientations that is further connected to the "Layer 3
switch" labeled "CAPWAP." To the right of the "Layer 3 switch," an "802.11Q trunk" is
shown with a "WLAN Controller" labeled "Platinum." At the top, a leftward arrow is
shown and at the bottom, a rightward arrow is shown. The devices and the lines are
connected by dotted lines. To the top of this, blocks are shown with the CAPWAP packet
numbers. The first block is divided into three "UP: 5, DSCP: 46, and Payload." The second
block is divided into two "DCSP: 34 and CAPWAP Encapsulated: 802.11, DCSP: 46, and
Payload." The third block is divided into three "802.1p, DSCP, CAPWAP Encapsulated:
802.11, DSCP: 46, and Payload." The fourth block is divided into "802.1p, DSCP: 46, and
Payload." The same set is shown at the bottom with the change in the packet number of
"UP" in the first block is labeled "6." At the top, the "UP: 5" points to "DSCP: 35." The
"CAPWAP Encapsulated DSCP: 46" points to "DSCP: 46." At the bottom, "DSCP: 46"
points to "UP: 0" of the first block labeled "Best Effort (BE)." The "DSCP" of the fourth
block points to "CAPWAP Encapsulated DSCP: 46" and DSCP: 46."

You should be aware that this feature works exactly as intended. Its purpose is to limit the voice
queue only to clients that are actually sending voice. They should describe their traffic first. The
exceptions are iOS and MacOS devices (see the “FastLane Configuration and Client Behavior”
section), because there is high certainty that traffic sent from these devices in UP 6 queue is indeed
going to be voice. The ACM feature limits the ability of, say, Linux BitTorrent users, from using the
highest priority queue for traffic that has nothing to do with voice. However, in a controlled
environment where you trust your client population and some devices may need access to this
queue without the possibility of TSPEC, this feature may be a limiting factor and should therefore
not be enabled.

Note
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These recommendations apply to Voice ACM. Video ACM is altogether different. Although WMM
allows the same ACM principles for the video queue, there is in fact no client on the market that
supports Video ACM. Although there is a Video tab where ACM for UP 5 can be configured, you
should always keep Video ACM disabled in real life. The only case where Video ACM should be
enabled is if you have experimental clients that support Video ACM, or if you are in a lab
environment where your knowledge of Video ACM is tested.

If you enable Voice ACM, you can choose the static or load-based method of evaluating the
available bandwidth on each AP radio where a WLAN with WMM is configured, and with clients
trying to send traffic in the Voice AC. Static is the old method, where only the AP clients traffic
was considered. Load based is the newer method that accounts not only for the AP clients but also
for the general activity on the channel (neighboring APs and clients on the same channel that also
consume airtime, even if they are not clients of the local AP radio). You should always choose load
based. You will find some old documentation that states that static is still needed when SIP CAC is
configured (details following), but this is old documentation that needs updating. SIP CAC also
leverages load-based CAC today, so there is no reason to use the static method anymore.

Regardless of the CAC method you choose, you can then configure the Max RF Bandwidth
allocated to this reserved voice traffic. When performing ACM, the AP will calculate the current
channel load, then evaluate the added load described in the ADDTS request. If the requested flow
brings the channel load above the value configured in Max RF Bandwidth, the ADDTS request
receives a reject response.

The default value for Max RF Bandwidth is 75%, which matches a large cell dedicated to voice
traffic. In most enterprise environments, cells are small. A consequence of this size reduction is that
the airtime consumed by a voice call will be less. Also, most enterprise environments have hybrid
WLANs, where voice traffic coexists with data traffic. It is unusual to see voice traffic representing
75 % of the activity on the AP channel.

Therefore, in most enterprise networks, a recommended value for Max RF Bandwidth is 50%. In a
standard 802.11a/n/ac cell of medium size (AP power at 14 dBm, 12 Mbps as the minimum data
rate), 50% represents up to 25 voice calls, which is already a high number.

Note

This is per cell, so you would have 25 people close to one another, all of them on phone calls. This
may be common in call centers but is quite uncommon in general cells outside locations where
people are waiting in a line. A Cisco AP can enable up to 27 voice sockets, which means that an
AP can allow up to 27 ACM-enabled calls, for both radios.

Because people may be pacing and therefore roaming between APs, you can keep a percentage of
this value for users coming from other cells. This avoids roaming users getting their calls cut
because they get into a cell where the channel utilization for UP 6 is already close to 50%. This
roaming bandwidth is configured in the Reserved Roaming Bandwidth field. Default is 6%, which is
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a reasonable value in most networks.

Note

Keep in mind that the Reserved Roaming Bandwidth is taken from the Max RF Bandwidth. If the
Max RF Bandwidth is 50% and the Reserved Roaming Bandwidth is 6%, you allow in fact 44% of
the bandwidth for new calls, keeping 6% for roaming users.

A special consideration must be made for emergency calls (911 and equivalent). What happens if
such a call needs to be placed but would bring the channel utilization for UP 6 above the 50%
barrier? A restriction for such scenario is that the AP would know that the call is intended to be an
emergency call. This is possible only if the phone is CCX v5. When configured from a CUCM
server, the phone is provisioned with emergency numbers values. Then, when the user dials such a
number, the phone software identifies the emergency label and forwards this information to the
CCX part of the Wi-Fi driver, which in turn puts an emergency flag in the CCX portion of the
ADDTS Request frame header. The AP then recognizes the emergency nature of the call. In any
other scenario, the dialed number is part of the payload, and the AP has no idea about where you
are calling.

If your phone is CCXv5, you can check the Expedited Bandwidth check box. This configuration
allows emergency number calls to expand beyond the 50% (or any other configured) Max RF
Bandwidth to reach up to 85% (with load-based CAC method) or 90% (with static CAC method) of
the available channel utilization for UP 6 traffic. This configuration is simple, but is often
misunderstood.

The excess applies only to emergency calls. If your CU for UP 6 is 49.9% and you place an
emergency call identified through CCX, the AP allows that call to go through UP 6, even if the CU
for UP 6 now exceeds 50%. Suppose that this added call brings the CU for UP 6 to 62%. At that
point, no additional standard (non-emergency) call will be allowed, but a second emergency call
could be allowed. In other words, the presence of an emergency call does not break the 50% barrier
for all, but just for emergency calls.

The high barrier for emergency calls is based on observed people’s “behavior exception” in case of
emergency. In other words, when a major issue strikes, and one or more calls are made from a
single given Wi-Fi cell, the event typically drives most people’s attention. You are unlikely to find
two people calling the emergency services from the same cell, while the other people (in the same
cell, a space of a few thousand square feet) continue watching cat videos, oblivious to the
emergency. Therefore, a common observed change in traffic patterns in cases of emergency is that
people’s manual traffic drops, while only automated traffic remains. This change typically
dramatically reduces the overall cell RF activity, leaving more space for the calls. Allowing the
calls to break the 50% limit in that case is reasonable and does not necessarily mean a drop in the
call quality (less traffic is competing for these calls).

Similarly, 90% with static versus 85% with load-based CAC methods does mean that you have
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more space for emergency calls with the static method. The static method ignores the other cells’
traffic. In case of emergency, AP beacons do not stop, but neighboring cell traffic should reduce
itself. However, neighboring cell users may be less aware than local cell users about the issue
triggering the emergency calls, which is why the load-based value is lower than the static value
(which only takes into account the local cell clients’ traffic, which is expected to drop
dramatically).

At the bottom of the Voice tab, you can enable SIP CAC support. This feature is useful for SIP-
based calls on devices that do not support TSPEC. If you know that most of your clients use SIP,
you can describe what a typical SIP call looks like (codec, bandwidth, voice sample interval). Then,
by enabling SIP CAC, the AP will identify requests made to the standard SIP port (UDP 5060, SIP
Invites), and will identify these requests with the start of a new call. The AP will then use the per-
call SIP bandwidth value to estimate the bandwidth consumed by the call and add it to its UP 6 CU
calculation. This feature is not used for bandwidth control, except with Facetime on iOS devices.
However, it allows the AP to have a better estimation of the UP 6 CU, to admit or reject additional
TSPEC calls. If you enable SIP CAC support, you also need to activate the feature on target SSIDs.
Otherwise, your AP would waste CPU cycles looking for SIP Invites on SSIDs where none are
expected. So, you need to tell your system which SSIDs need to be monitored. This is done in each
SSID Advanced tab (WLANs > Edit WLAN > Advanced), by checking the Media Session
Snooping option.

Note

Just below Media Session Snooping, you will see the Re-anchor Roamed Voice Clients option. This
option is solely for TSPEC and SIP-CAC calls (that is, only active for calls admitted through
ACM). Its purpose is to terminate the call anchor on the best WLC (the one closest to the client),
even during roaming events. There is no best practices around this option. Its activation depends on
the network topology and user behaviors (multiple roams expected between WLCs => activate the
option). In the lab, activate the option if you are specifically asked to; leave it at its default
(unchecked) state otherwise.

Data Rate Configuration

A good part of QoS configuration aims at providing efficient cell conditions for voice users. Part of
this effort resides in efficient cell design. RF design and site survey are out of scope of this section;
however, you should be aware that an assumption of cell design for real-time applications is that
the cell would be small (AP power similar to that of your clients, typically around 11 dBm to 14
dBm if your clients are smartphones). Additionally, low data rates would be disabled. In a typical
configuration, rates below 12 Mbps would be disabled, as shown in Figure 7-29. 12 Mbps would be
the first allowed rate, and set to Mandatory. The other higher rates would be set to Supported. 24
Mbps can also be set to Mandatory to allow for better multicast transmission. In higher density
cells, it is also common to set 24 Mbps as the first allowed (and Mandatory) rate, disabling any
lower rate. The choice depends on the cell density, and therefore the location. You should test
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roaming between using rates to change the cell span.

Figure 7-29 Data Rate Configurations

The Wireless tab is selected in the Cisco window that displays a list of options in the
navigation pane. In the content pane the general and CCX Location Measurement sections
of 802.11b/g global parameters are shown. The General section shows the following fields
entered. 802.11b/g network status, 802.11g support short permeable, and DTPC Support
check boxes are selected for Enabled. Beacon Period (milliseconds), Fragmentation
threshold, Maximum allowed clients, and RSSI Threshold (negative 60 to negative 90dBm)
sections are labeled. Data rates are displayed on the right where, 11Mbps and 12Mbps are
set to Mandatory and Supported selected from a spin box and are encircled.
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Note

Disabled rates are not supported by the AP, so the AP announces Basic or Mandatory rates that all
clients must support in their drive, then Supported rates that clients may or may not support while
still being allowed to join the cell. Today, all clients support all rates in their driver, but this feature
is still a way to position a lower boundary to the cell, a distance beyond which messages cannot be
demodulated, thus effectively reducing the efficiency footprint of the cell. Also, as per 802.11,
multicast is always set at a Mandatory rate. Cisco APs send multicast at the highest mandatory rate
supported by all intended recipients. Setting 24 Mbps as Mandatory allows the AP to switch to 24
Mbps if all recipients are close enough. By contrast, broadcasts are sent at the lowest mandatory
rate.

These recommendations apply to the legacy rates (802.11b/g/a). For these rates, the Wi-Fi Alliance
tests that rates set to Disabled on the AP are effectively not used by the clients of that AP.
However, no such test exists for 802.11n or 802.11ac rates. As a result, disabling 802.11n or
802.11ac rates is not useful. (Clients would still use them; you would just prevent your AP from
responding at a similar rate.) However, disabling low legacy rates is enough to limit the cell edge,
because the AP sends beacons at the lowest mandatory rate. (Stations that stop hearing the AP
beacons typically determine that the AP is out of range and roam.)

AVC Configuration

Another element of your QoS configuration includes Application Visibility and Control (AVC).
AVC performs deep packet inspection (DPI) to recognize close to 1,400 different applications,
including about 170 encrypted applications. AVC is therefore a central element of an end-to-end
QoS strategy. AVC can run on multiple platforms (WLCs, routers, and so on). However, there is a
CPU and memory load cost associated with application recognition. That cost may be negligible or
heavy, depending on the application mix transiting through your systems. In the real world, you
would carefully weigh that cost to decide the best locations to run DPI. You may decide to run
AVC on all routers, supporting switches, and on your WLC and APs, or just at selected locations.
Only testing could decide the impact of running AVC at a given device location. (None of this is a
consideration for the CCIE lab, where you can expect only a few clients.)

On FlexConnect APs running in local switching mode, AVC runs at the AP. In that case, AVC is a
subset of the full AVC. On local-mode APs and FlexConnect APs running in central switching
mode, AVC runs at the WLC. The location of the AVC task has practical consequences on QoS.
AVC allows you to rate-limit traffic, drop traffic, or change the QoS marking of target traffic. In
this last case, you should keep in mind that the AVC task runs inside the WLC and before the QoS
downstream profiling task, as illustrated in Figure 7-30.
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Figure 7-30 Effect of AVC Configuration

A laptop on the left is connected to an Access point that is connected to a Multilayered
switch in access mode. To the right of the multilayered switch, 802.1Q Trunk is shown with
a WLAN Controller at the center that is further connected to a Wired network. Two text
box pointing the WLAN Controller reads, AVC modifies the inner DSCP value, thus
influencing the CAPWAP DSCP and wireless UP values. AVC policy operates here in
centralized mode and An AVC policy supports a maximum of 32 entries (rules). Text box
pointing the access point reads, AVC policy functions here in FlexConnect (AireOS 8.1)
local switching. A text box below the WLAN Controller reads, In AireOS 8.0, AVC can be
applied in a specific direction (upstream or downstream).

As an example, suppose that you receive a packet with DSCP CS3, and that your WLAN QoS
profile is set to Gold (ceiling set to video, AF 41, UP 5). AVC runs first. Suppose that AVC
recognizes that this traffic is in fact voice, and that your AVC policy dictates that this application
should be marked EF (DSCP 46). AVC will perform this task first, remarking CS3 to EF, and will
then pass the packet to the WLAN routine, where the QoS ceiling is examined. Because the new
marking is above the ceiling, the CAPWAP outer header will be capped to AF41 (while the inner
DSCP shows DSCP 46, as remarked by AVC).

The reverse logic can be seen upstream. Suppose that your WLAN ceiling is now Platinum (max
DSCP 46, UP 6). A client sends DSCP 46 traffic upstream. This traffic will be forwarded to the
WLC by the local AP. All along, the CAPWAP outer header shows DSCP 46, as you are within the
ceiling limit. Yet, at the WLC, AVC determines that this traffic is in fact BitTorrent that should be
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remarked CS1. Traffic is remarked, then sent to the wire. The correct marking only occurred at the
WLC, while the AP to WLC link was not affected.

These two cases are not gotchas that should be source of headaches for you. You should simply be
aware of the way AVC works.

AVC for the WLC is configured in the GUI from Wireless > Application Visibility and Control >
AVC Profile. Create a new profile, then edit the profile. You can then add rules that will target
traffic and decide whether that target traffic should be marked, dropped, or rate limited, as shown
in Figure 7-31 (CLI config avc profile).

Figure 7-31 AVC Remarking Policies

In the Cisco window, "Wireless" tab is selected that displays a list in the navigation pane.
In the content pane "Enterprise mobility" of a rule in the AVC profile shows the fields
"application group, application name, action that is set to Mark (selected from a spin box)
and Dscp (O to 63) where "Platinum (Voice)" is selected. Another section is shown with
the fields "Application group, application group, and action" where "Action" is set to
"drop." Another box is shown at the bottom with the same fields where "Action" is set to
"Rate-Limit (selected from a drop-down button)."

Dropping is a simple action, taken at the WLC for both upstream and downstream mode and local
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APs.

Rate limiting is also performed at the WLC (both for upstream and downstream) and adds to the
other, more generic, bandwidth contract rules that you may have for the user or the WLAN. Two
examples will make the logic clear. Suppose that your user has a general BW contract of 500 kbps
and that HTTP traffic has a bandwidth contract of 50 kbps. Upstream, up to 550 kbps of traffic can
come from this user. Inside the WLC, traffic will be examined, and any HTTP flow over 50 kbps
(coming from that user or any other user) will be dropped. Downstream, incoming traffic will be
examined, and any HTTP traffic in excess of 50 kbps will be dropped. Note that the bandwidth can
be different for upstream and downstream.

Now suppose that your user has a general BW contract of 50 kbps and that HTTP traffic has a
bandwidth contract of 500 kbps. That user can receive HTTP up to the user BW limit, 50 kbps,
supposing that no other traffic for that user needs to share the bandwidth.

If you choose to remark, the AireOS 8.3 interface offers the interesting text “Dscp” but offers in
fact one of the four Wi-Fi ACs. What is meant is that the remarking is static and will apply for both
the DSCP and the UP value, based on the AC default values shown earlier in this chapter. The
remarking can be bidirectional or applied only for downstream or upstream traffic. Figure 7-32
shows an example of AVC policy.

Figure 7-32 Example of AVC Policy

In the window, Wireless tab is selected. The left pane displays a list of the wireless
medium. AUTOQOS-AVC-PROFILE of the AVC profile displays a table in the content
pane with the column headers reading Application name, application group name, Action,
DSCP, Direction, and Rate Limit (average and burst rate) Kbps.
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After you have created an AVC profile, you can enable AVC and apply the profile to a WLAN
from the WLAN QoS tab (CLI config wlan avc). You can also apply a specific profile to class of
devices (from Security > Local Policy > Edit Policy > Action, CLI config policy). The AVC
profile can also be configured on the WLC, then called from within an Authorization profile on the
AAA server with AAA override (see Figure 7-19 for an example of an Authorization profile).

Note

Only three applications can be rate limited on AireOS 8.3. You should not try to configure more
than three rate limits.

AireOS supports only 32 applications per AVC profile.

If you configure AVC in a Foreign-Anchor scenario, you should configure the same policy on both
sides. However, the key location where the policy will be enforced is the Anchor.

AVC for WLANs applied to FlexConnect APs in central switching mode follow the same rules as
above. However, if you configure AVC for FlexConnect APs in local switching mode, the process
is different. The flow is shown in Figure 7-33.

Figure 7-33 AVC Flow for FlexConnect Local Switching WLANs

In the screenshot, the Cisco window is shown on the right side with the WLANs tab
selected. In the Content pane, Scan Defer Time (msecs) is set to 100. Under FlexConnect
section, Enabled checkbox is selected for FlexConnect local Switching. In the bottom
section, AVC Profiles is selected under Application Visibility And Control. The Edit
Mygroup, window under FlexConnect Groups is shown on the right. WLAN AVC Mapping
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section shows the fields WLAN Id, Application visibility, Flex AVC Profile: VC (Selected
from a spin box) with an Add button at the bottom.

As soon as you enable FlexConnect Local switching on a WLAN, and plan to support AVC for
FlexConnect on that WLAN, you need to configure a standard AVC profile for the Local Mode
APs that will support it, and another AVC profile, from the Wireless > Application Visibility And
Control > FlexConnect AVC Profiles submenu (CLI config flexconnect avc) for the APs in
FlexConnect mode that will support this WLAN. The FlexConnect AVC profile uses a subset of the
WLC AVC database with a different NBAR engine version, so you may not find the exact match to
your Local mode AVC application.

After the profile is created, you need to apply it to the flexgroup to which the target FlexConnect
APs belong, from Wireless > FlexConnect Groups > Edit > WLAN AVC mapping (CLI config
flexconnect group <groupName> avc). In this screen, you can target specific WLANs and map a
specific Flex AVC, or map a Flex AVC profile to all local switching WLANs supported by the APs
in that FlexConnect group.

Note

AAA override for AVC is not supported for FlexConnect groups.

Configuring AVC enables you to monitor and control application traffic going through your system.
You can view the application mix from the WLC GUI and CLI. However, there may be cases
where you would want to export this view to another monitoring station. When Cisco Prime
Infrastructure adds a WLC to its database, it also configures itself as a NetFlow destination. This
allows you to monitor the WLC AVC traffic from the PI interface. If you want to export AVC data
to other monitoring stations, configure a new NetFlow Exporter from Wireless > NetFlow >
Exporter. The Exporter is the confusing way of saying “the server where you will send NetFlow
data from this WLC.” Enter the target server name, IP address, and port (CLI config flow).
Typically, NetFlow is sent to port 9995.

You can then configure the WLC to send data to this server. From Wireless >NetFlow > Monitor,
create a new monitor profile. Click the profile and pick the server you want to send traffic to (it is
likely to be the exporter you just created). You can choose to send None or Client App Record data
(both options are acceptable, but read the question carefully, if you are in a lab environment). In all
likelihood, you will want to send Client App Records.

You can then activate this profile on a per SSID-basis, from the WLAN > Edit > QoS tab. From
the NetFlow Monitor drop-down list, choose the Monitor profile and click Apply (CLI config wlan
flow <WLAN-ID> monitor <profile name> enable).

FastLane Configuration and Client Behavior
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The strategy for your QoS configuration on AireOS depends a lot on what QoS features your clients
support. In this field, there is a large variety of clients and behaviors, and feature scope changes
fast. At the time of writing this book, clients could be separated into three categories:

Windows 7 and later devices: QoS can be pushed as a GPO policy; therefore, DSCP marking
depends on the administrator’s QoS skills. However, these markings appear only as DSCP
values. Microsoft has maintained the view that L2 marking should be the same, regardless of
the medium type. As a result, the UP marking derived from the DSCP marking maps the 3
MSBs. With this scheme, voice is UP 5 and video UP 4, causing UP 6 and UP 7 to be unused,
and causing voice and video to conflict with the 802.11 protocol and intent.

Android devices: These clients have an open operating system, which allows QoS marking
support. However, marking depends on the app developer, the phone vendor, and the service
provider. Both service provider and phone vendor may introduce OS modifications that could
block app QoS marking. The purpose is generally to avoid QoS marking on devices that are
intended to be low end. These devices are not expected on enterprise networks, and QoS is
therefore not useful (in your home, competition with other traffic is limited). Additionally,
some home service providers do not expect QoS traffic coming from home networks and either
remark or drop QoS packets coming from home networks. This policy is old and is less frequent
than it was in the years 2000s, but the side effect is still felt in the modifications made by some
Android phone vendors. The consequence is that QoS marking is difficult to predict for
Android devices. You may see UP and no DSCP, both DSCP and UP, or no QoS. Testing your
network’s common devices is recommended. Also, keep in mind that the industry trends
toward QoS adoption, and that new OS or vendor/SP software updates may unblock QoS
marking in a phone that was only displaying best effort in the previous software version.

iOS and MacOS 10.13 and later: These devices support QoS as per best practices. Apple has
been working with Cisco and the IETF for years. iOS 10 and Mac OS 10.13 adopt the QoS
scheme shown in Figure 7-34.
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Figure 7-34 Apple iOS and MacOS QoS Sockets and Mapping

The RFC 4594- Based model with DSCP are listed as follows. Network control: CS7,
Internetwork Control: CS7, Voice: EF, Broadcast Video: CS5, Multimedia
Conferencing: AF4, Real-time interactive: CS4, Multimedia Streaming: AF3, Signaling:
CS3, Low-Latency data: AF2, OAM: CS2, High throughput data: AF1, Scavenger:
CS1, and Best Effort: empty. The RFC shortcuts for the net service are
NET_SERVICE_TYPE_VO: Voice, NET_SERVICE_TYPE_VI: Multimedia
Conferencing, NET_SERVICE_TYPE_RV: Real-Time Interactive,
NET_SERVICE_TYPE_AV: Multimedia Streaming, NET_SERVICE_TYPE_SIG:
Signaling, NET_SERVICE_TYPE_RD: Low-Latency Data,
NET_SERVICE_TYPE_OAM: OAM, NET_SERVICE_TYPE_BK: High Throughput
Data, and NET_SERVICE_TYPE_BE: Best Effort. The IEEE 802.11 Model is shown
on the right. The DSCP points to the IEEE 802. Model. EF: UP6, Voice Access
Category (AC_VO); CS4 and CS3 points to UP5, Video Access Category (AC_VI);
CS2 and best effort: UP0, Best effort Access category (AC_BE) by solid lines. The
imaginary line connects the following, Multimedia conferencing and multimedia
streaming: UP5, Video Access category (AC_VI); AF2: UP0, Best effort Access
Category (AC_BE); and AF1: UP1, Background Access Category (AC_BK).

The operating system offers nine QoS classes available to app developers (as socket calls), and each
class receives a DSCP marking that follows IETF RFCs (e.g., RFC 4594). Each DSCP translates to
an UP marking that follows best practices, with a few minor exceptions. One exception worth
noting is that Apple chose to limit the current span of the mapping logic to four ACs, but only one
UP per AC, thus following the tradition of most other client and infrastructure vendors.

Cisco has worked extensively with Apple, also providing technical support to help app developers
understand the differences between the various classes and choose the best class for each of their
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app calls. As a result, traffic coming from iOS (10 and above) and Mac OS (10.13 and above)
applications is trusted. UP 6 traffic really represents voice traffic. As such, an exception was made
in the ACM rules for iOS and Mac OS devices. You need to make sure that you understand this
exception, because it applies on both sides. It starts from the fact that iOS and Mac OS devices
recognize the signature present in Cisco AP beacons or probe responses. Similarly, the Cisco APs
recognize Apple in the messages coming from iOS and Mac OS devices.

As a consequence of recognizing Cisco APs (and knowing that a trust relationship is formed), iOS
and Mac OS devices ignore the ACM bit for UP 6 traffic. This means that these clients will send UP
6 traffic without TSPEC (iOS and Mac OS do not implement ADDTS/TSPEC), even if ACM is
enabled for the voice queue in the SSID beacons. This is a vendor-to-vendor specific agreement.
On other networks, iOS and Mac OS will revert to UP 5.

As a consequence of recognizing iOS and Mac OS, the Cisco AP honors the UP 6 traffic, even with
ACM enabled and in the absence of ADDTS/TSPEC. As a result, traffic is forwarded as if ADDTS
had happened and been successful. DSCP 46 is honored upstream and downstream, and DSCP 46
traffic is forwarded with UP 6 marking from the AP to the client.

Another particularity of iOS (10 and later) and Mac OS (10.13 and later) clients is their support of
Fastlane. This feature is also the result of a partnership between Apple and Cisco. The logic of this
joint development is that your network QoS configuration does not extend to the client device.
Your AVC and QoS policies may start at the AP, extend to the entire network under your control,
and also extend downstream to traffic sent to the client. However, you have no control over the
client-to-AP traffic.

You also have no way to tell the client what your network QoS configuration looks like. This last
element is important because each network has different requirements. For example, in a car
dealership, a video game featuring the latest car may be business relevant (keep the customers
happy while they wait), while the same car game may be seen as non-business relevant in a
carpeted office. The network QoS configuration may be different, but the client is not aware of this
difference.

To solve this issue, Apple leverages the Configuration Profile feature that has been present in iOS
and Mac OS from the early days of the operating systems. The Configuration Profile defines
parameters for your device (look and feel, security, and so on). Profiles have a Wi-Fi component
that defines credentials and limitations for multiple SSIDs. Profiles are commonly leveraged by
MDM (Mobile Device Management) solutions that create profiles for employees’ devices and
deploy these profiles to the end devices based on the employee profile. This makes device
management easier for large companies.

iOS 10 and Mac OS 10.13 allow a new component of the Wi-Fi section of the profile, called
Restrict QoS marking. Figure 7-35 shows such a screen, using Apple Configurator. You can create
such a profile in any tool that enables the creation of an iOS or a Mac OS profile. MDM solutions
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typically offer such an interface, but Apple Configurator is another solution as a program available
on Mac OS.

Figure 7-35 Apple iOS and Mac OS Profiling for QoS
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In the window, Wi-Fi section is selected in the navigation pane that displays the Wi-Fi
sections in the content pane. Auto Join, enable QoS marking, and Whitelist Apple
audio/video calling checkboxes are selected. The "Proxy setup and the Security type"
sections are set to "None." "Network type" is set to Standard and the "Fast Lane QoS
Marking" is set to Restrict QoS Marking from spin boxes. At the bottom, Cisco WebEx
Meetings is selected under "Whitelist specific apps."

For each SSID, you can choose to control QoS marking. When this feature is selected, you can
choose which applications should be in a whitelist (on Figure 7-35, applications are called by
clicking the + sign; you then type the application name, and the tool retrieves the application
identity details from the Apple applications databases in the cloud). Any application known to
Apple can this way be added to the whitelist. Please note two important details:

The whitelist is created on a per-SSID basis. Two different SSIDs may have different whitelists,
even on the same machine. This means that your iPhone policy may change as you change
networks and location, based on the local network QoS policy requirements.

Facetime and Wi-Fi calling are special because they use the phone dialer. They are called
Apple Audio/Video calling. Checking the associated check box puts these two applications in
the whitelist, which is the default.

The profile is then installed on the Apple client device. Apple describes multiple ways of
provisioning such a profile (MDM is one solution, but there are many others, such as web
onboarding, emails, and the like). The expectation is that the policy installed on the client device,
for a given SSID, matches the QoS policy configured on the infrastructure for that same SSID. This
is an assumption, but by no means a guarantee. The client manager creates and pushes the device,
while you configure the WLC QoS policy. Hopefully, you work with the device manager and with
the Switch and Routing teams, so that the QoS policy is end to end, and everyone has the same
understanding of what applications are business relevant and what classes of traffic are configured
with what associated marking and QoS strategy.

On the wireless infrastructure side, you need to configure QoS in general. To support Fastlane, you
also need to activate Fastlane in the SSID QoS tab, as shown in Figure 7-36.
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Figure 7-36 Effect of Fastlane Macro

In the Edit Class window of the WLANs, QoS tab is selected that displays the fields
Quality of Service, Application visibility, AVC profile, flex VC profile, Netflow monitor,
and Fastlane. Fastlane is set to Enable (from a spin box). In the bottom section Override
Per-user Bandwidth Contracts (kbps) four fields Average data rate, burst data rate, average
real-time rate, and burst real-time rate with downstream and Upstream textboxes. "Clear"
button is displayed at the bottom. The steps involved are, 1: Configure Platinum Profile for
Voice -> UP6, Multicast and non-WMM Unicast -> BE; 2: Remove Bandwidth Limitation
for UDP on Platinum Profile; 3: Apply Platinum Profile to Your WLAN; 4: Apply EDCA
802.11revmc TXOP Values to Both Bands; 5: Enable Voice CAC, with 50 percent BW/
percent Roaming Limits; 6: Trust DSCP Upstream; 7: Create an Optimized UP-DSCP map,
Applied Downstream; 8: Create an Optimized AVC Profile for Well-known Applications
(AUTOQOS-AVC-PROFILE)."

Enabling this feature has two effects:

In the exchanges with Apple devices, a special handshake allows Apple devices to recognize
that Fastlane support is enabled on the SSID (the handshake format is proprietary).

Because enabling Fastlane indicates the will to support QoS, the Fastlane macro also configures
your WLC for best practices, as shown in Figure 7-36. In short, all the best practices described
in this chapter for QoS are configured. (The macro does not configure data rates, only QoS
features.)

After the iOS or Mac OS client device gets in range of a Cisco AP Meraki or AireOS 8.3 and later,
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both sides recognize each other. At that time, the client checks whether there is a profile for that
SSID, and whether the profile includes a whitelist component.

If there is no QoS component, all apps can mark QoS (as the developer configured them).

If there is a QoS component, only the apps in the whitelist are allowed to mark QoS. The apps that
are not listed in the whitelist are considered nonbusiness relevant and will be sent without QoS
marking (best effort). This allows the network QoS strategists to put in the whitelist the apps that
are important for the local network and make sure that both the client and the network sides have
the same understanding of which applications are business relevant, and QoS-worthy, and which
are just personal applications that will receive best effort.

As a wireless expert, you should make sure that you understand Fastlane properly to face any
question wording. This understanding includes dispelling silly rumors that you will read here and
there.

Fastlane does not define the app QoS marking on the client device. All Fastlane does is define
which apps are in the whitelist and which are not. Apps in the whitelist will use whichever QoS
marking their developer designed for each socket call type. The fact that Cisco worked with Apple
to define which type of traffic should get what type of marking as per IETF recommendations is
only indirectly related to Fastlane and does not result in your AP sending QoS marking values to the
client for app calls.

Apps that are not in the whitelist are separated into two categories. Most apps have been developed
with best effort or higher marking (or no QoS). These applications are then sent by the client in the
best effort queue. However, some apps have been developed to send traffic as background (for
example, backups and other slow file uploads). Because these were already set to use a lower
priority queue, Fastlane keeps them in the background. In other words, these applications do not get
promoted to best effort, they stay background, regardless of their position within the whitelist.

If Fastlane is not enabled in the WLAN, or if you are in a non-Cisco network, the apps mark only
UP, but DSCP stays at CS0 for all applications (regardless of your whitelist configuration). The
reason is that in such configuration, the network is not seen as end-to-end QoS enabled (it could be
your home), and QoS is not deemed as important beyond the wireless link.

In AireOS, enabling Fastlane on any WLAN creates an AUTOQOS-AVC-PROFILE that contains
the 32 most common network applications and their recommended QoS markings. However,
Fastlane does not activate Application Visibility on the WLAN. The profile is created in the
background, ready to be used.

If you activate AVC on a Fastlane-enabled WLAN, AUTOQOS-AVC-PROFILE is the only AVC
profile that you can use on AireOS 8.3. AireOS 8.4 removes this limitation. In any AireOS version
where this AUTOQOS-AVC-PROFILE is created, you can edit the profile, change the marking for
any application, and remove any application to add another one instead. Although AireOS 8.3
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mandates that you use this auto profile, you can customize the profile.

Be careful: In some AireOS 8.3 releases, the AUTOQOS-AVC-PROFILE is created every time you
activate Fastlane on a WLAN. If you need to modify the auto profile, make sure to do so only after
activating Fastlane on all WLANs where you need it.

Fastlane also configures the WLC for QoS best practices. You can individually edit and change any
of these configurations. Fastlane is a simple macro.

When you disable Fastlane on a WLAN, the WLAN is returned to the default states, not the
previous states. In other words, when you create a WLAN, the default QoS policy is Silver. If you
change the QoS policy to Gold, and then enable Fastlane, the WLAN QOS policy changes to
Platinum. If you then disable Fastlane, the WLAN QoS policy returns to Silver (the default).

The same default logic applies to any other QoS feature. When you remove Fastlane from a WLAN
but other WLANs have Fastlane configured on the same WLC, only the target WLAN returns to its
defaults. However, when you disable Fastlane on the last WLAN where Fastlane is enabled, the
WLC QoS configuration returns to its defaults. For example, CAC is disabled and the Max RF
Bandwidth value is reverted to 75%; the Unicast Default Priority and Multicast Default Priority in
the Platinum profile are returned to their defaults, voice.

Enhanced Roaming

Fastlane is often associated with another feature jointly supported by Apple and Cisco, this time
solely for iOS devices: enhanced roaming.

Enhanced roaming is only indirectly related to QoS and is about faster roaming. In this context, two
elements appear:

802.11k and 802.11v are enabled by default on any new WLAN. iOS devices support these
two protocols in the same way that Cisco implemented them. 802.11k provides a list of the
closest neighboring APs (up to 6) to the client joining the cell. This allows the client to have a
shortlist of channels to scan (up to 6, instead of more than 20) when later getting close to the
edge of the cell. 802.11v allows for a directed exchange when a client gets to the edge of the
cell and is in urgent need of a candidate channel and AP to roam to. The AP can provide such
next-best AP information based on the client location. Figure 7-37 contrasts 802.11k and
802.11v.
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Figure 7-37 802.11k Versus 802.11v

The "802.11k neighbor list" on the left shows a circle that displays the icons of an
Android mobile and an access point. Text near the android mobile reads, "What could
my next AP be?" and the text near the access point reads, "Here are the best 6 for
you." on the right, "802.11v solicited request" shows the same at the top and bottom
with text near the android mobile reading, "need to roam, what AP do you
recommend? and try this one" at the top and "Want to join your cell and Nah, load too
high, go there instead" at the bottom. The 802.11v Unsolicited request shows the
android in the outer circle and the access point reads "Your RSSI/rates are too low;
roam to there instead."

A new mode, Adaptive 802.11r, is created. iOS clients support 802.11r, an amendment
facilitating the fast exchange of WPA2 keying material during roaming events. However, many
networks do not implement 802.11r (even in combination with standard WPA2) because some
old clients, incompatible with 802.11r, may fail to associate if 802.11r is mentioned in the
WLAN parameters (even if, in hybrid mode, the client can use either 802.11r or regular
WPA2). As a consequence, a useful feature is widely underdeployed. Adaptive 11r leverages
the secret handshake that iOS and Cisco APs run, recognizing each other, to dynamically
enable 802.11r for individual iOS (iOS 10 and later) clients, while support for 802.11r is not
advertised in the cell.

Note

Adaptive 802.11r is the default security mechanism for new WLANs in AireOS 8.3 and later. It is
considered a best practice, unless you do not have any iOS clients in your network or unless you
enable 802.11r openly in the WLAN.

802.11k and 802.11v do not require specific configuration, because both are enabled by default in
the Advanced tab of the new WLANs you create in 8.3 and later, as shown in Figure 7-38.
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Figure 7-38 802.11k and 802.11v Configuration

In the edit class window, Advanced tab is selected. The Lync server under Lync is
disabled. The checkbox of neighbor list under 11k is selected. In the right side of the
window, the following sections are shown: Universal AP admin support, 11v BSS transition
support, tunneling, mDNS, TrustSec, and OpenDNS. Under 11v BSS transition support BSS
transition, BSS Max idle services, and directed multicast service checkboxes are selected
with Optimized roaming disassociation timer (0 to 40 TBTT) set to 40. Tunnel profile under
Tunneling is set to None. Open DNS mode and OpenDNS profile under OpenDNS are set
to Ignore and None (selected from a spin box).

However, you should be aware of the available options.

802.11k is enabled by checking the Neighbor List check box. This box should be checked by
default on new WLANs.

802.11k includes several modes. The mode activated by the Neighbor list option (and on iOS
devices) is the AP neighbor report. The client associates to the WLAN, and right after association
sends an Action frame of Category Radio Measurement, with a Neighbor Report Request. The AP
responds with another Action frame in the Radio Measurement family, which type is Neighbor
Report Response, as shown in Figure 7-39. 802.11k also allows the AP to ask the station for similar
reports, but that mode is not implemented in 8.3 or iOS. Also, the neighbor report could be asked at
any time, but iOS asks for the report only at association time. Other vendors also support 802.11k
and may make the request at other times (for example, some Intel enterprise chipsets make the
request when the AP RSSI falls below a target threshold). There is not really a mode that is better
than the other; the neighborhood is unlikely to dramatically change between the time the client
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associates and the time the client needs to roam away.

Figure 7-39 802.11k Neighbor Report

The 802.11k neighbor list is represented in a circle with an android mobile and a LAN. The
Android mobile represents What could my next AP be? pointing a code. The LAN
represents the Here are the best six for you that points toward another code.

By default, the Neighbor List includes neighboring APs and channel information only for the client
current band, which is best practice. You can check the Neighbor List Dual Band option to also
send information about neighbor information in the other band (for example, 2.4 GHz radios for a
client currently associated to a 5 GHz radio). Keep in mind that 5 GHz is usually considered better
than 2.4 GHz. In most cases, the cell coverage in 5 GHz should be sufficient to maintain the client
in that band across the entire floor, and iOS clients prefer the 5 GHz band anyway (this band is
scanned first, and preferred if at least one of the discovered APs signal in that band is above −65
dBm). Therefore, single-band (with the expectation of that band being 5 GHz) messaging is
preferred over dual-band messaging.

AireOS 8.3 also includes an Assisted Roaming Prediction Optimization option. This option is for
non-802.11k clients. Its logic is to construct the same neighbor list that 802.11k would build (best
neighboring APs) and force non-802.11k clients to prefer these neighbors. When the non-802.11k
client associates, a neighbor list is generated based on the client pre-association probes (which APs
heard the client best) and stored in the mobile station software data structure. Clients at different
locations have different lists because the client probes are seen with different RSSI values by
different neighbors. Because clients usually probe before any association or reassociation, this list is
constructed with the most updated probe data and predicts the next AP that the client is likely to
roam to. Then, when the client roams, association is denied to the APs not in that neighbor list. This
mode is a bit aggressive, because the client does not know the neighbor list. Therefore, it may have
undesirable side effects (such as the client temporarily dropping off Wi-Fi because the client is
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denied on several APs). This option is in fact removed from the GUI (CLI only) in later AireOS
codes to avoid “let’s check everything on that page” syndromes. Enable it carefully. Most of the
time, keeping it disabled is better for real-time applications (let the client roam where it needs). If
you enable it, you can also tune the assisted roaming options (these only apply to non-802.11k
assisted roaming, not to 802.11k):

Denial count: Maximum number of times a client is refused association.

Prediction threshold: Minimum number of entries required in the prediction list for the
assisted roaming feature to be activated.

802.11v is activated by checking the BSS Transition option (should be enabled by default on new
WLANs).

In the 802.11v Solicited Request and 802.11v Unsolicited Optimized Roaming Request modes, the
AP suggests a better AP to an associated client. At that time, the AP can even be more directive,
and say “go to that AP, AND if you are not gone after delay X, I ‘may’ disconnect you”
(disassociation imminent bit). This bit is set if you check the Disassociation Imminent check box.
The delay is also advertised in the 802.11v message and configured in the Disassociation Timer
field. Note that the time unit is TBTT (Target Beacon Transmission Time), or beacon intervals.

The AP will not in fact disconnect the client unless you also configure Aggressive Load Balancing
(which needs to be enabled at the WLAN level in the Advanced tab, and can be edited in Wireless
> Advanced > RF Management > Load Balancing). Aggressive Load Balancing is not
recommended for networks with real-time applications. In these networks, you want to let your
client roam fast, even if the next AP is not the best, rather than be picky and force the client to
drop voice packets while you try to convince it to get to a better AP.

You can also disconnect the client after a number of TBTTs when also configuring Optimized
Roaming (in Wireless > Advanced > RF Management > Optimized Roaming). In that case, the
Optimized Roaming Disassociation Timer at the WLAN level will be used.

Note

Aggressive load balancing works based on the client probes, denying the client association requests
to APs that are not “the best” for that client.

Optimized roaming works based on signals, sending a deauthentication message to associated
clients when these clients’ signal fall below a configurable threshold. The expectation is that the
disconnected client will then try a better AP.

In the 802.11v section of the Advanced tab, you will see two items unrelated to roaming but related
to 802.11v. (802.11v is a 400-page long amendment, with multiple features around network
management to make the life of clients in the cell better.)
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BSS Max Idle Service allows the AP to send to the client the idle timeout for the cell. This timeout
is about idle (sleeping) clients that do not send or receive traffic for a while. All cells have one, and
this is the interval beyond which the AP will consider that a silent client is in fact gone (and the AP
will remove the client from the list of active clients in the cell). The client will have to start from
scratch (authentication request, and so on) to rejoin the cell. Strangely enough, 802.11 did not have
a way for the AP to communicate that timer to its clients before 802.11v, forcing the clients to
wake up often and send a frame (even a null frame) to tell the AP about their presence in the cell.
With the BSS Max Idle Service, the AP tells the clients about the idle timeout. Clients supporting
this feature (for example, iOS clients) can then sleep for a longer time and stay passive or silent for
up to that idle timeout period without being removed from the cell.

An effect of the BSS Max Idle Service is that the client may sleep for more than one beacon
interval, and more than one DTIM interval. (Recall from your CCNA that the DTIM is the beacon
interval at which the AP will send broadcasts and multicast messages to the cell. Clients should
wake up at each DTIM to get those messages. If they sleep beyond a DTIM, they may miss
broadcasts or multicasts messages.)

In that case, the AP can advertise the Directed Multicast Service (DMS) option, allowing clients to
register for specific flows. When DMS is activated, a client going to sleep can request the AP to
keep target multicast or broadcast traffic (for example, “Please keep for me any multicast message
sent to 224.0.0.251 while I sleep”). The AP will send the broadcast or multicast message for the
other clients at the DTIM interval, but will also keep a copy. When the client wakes up (any frame
from the client where the Power Management bit is set to 0), the AP will unicast to the client a
copy of the saved multicast/broadcast messages. iOS devices support both BSS Max Idle Service
and DMS, and these options are enabled by default. Keeping them enabled is best practice, because
they improve the life of supporting devices in the cell and do not impact the others.

Adaptive 802.11r is the default security mode on new WLANs in AireOS 8.3 and later. Adaptive
802.11r is one of three fast roaming (Fast Transition, FT) options:

Adaptive 802.11r (Fast Transition set to Adaptive, as shown in Figure 7-40): 802.11r (FT)
is not advertised in beacons and probe responses. iOS devices are recognized (and they
recognize Cisco WLANs); FT is enabled individually for these devices when they associate.
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Figure 7-40 Adaptive 802.11r Configuration

In the WLAN window, edit Mynet is selected. Security tab is selected within Layer 2
tab. The layer 2 security is set to none. Under Fast transition section, Over the DS
checkbox is selected that displays a list where adaptive is selected. In the right
window, the Security tab is selected. In the WPA+WPA2 parameters checkboxes are
selected for WPA2 policy and AES of WPA2 encryption. Under Authentication key
management, 'enable' checkbox is selected for PSK and FT 802.1X and FT PASK
checkbox are shown and highlighted.

Fast Transition Disable: 802.11r is disabled, not advertised, and not enabled, for any client.

Fast Transition Enable: FT is enabled and advertised in beacons and probe responses.

If you enable FT for your WLAN, you can choose a strict 802.11r key management mode, or a
hybrid mode:

If you set FT to Enable and choose key management to be either FT PSK or FT 802.1X, the
WLAN is strictly FT. Only 802.11r-compliant clients can associate to the cell.

If you set FT to Enable and choose key management to be a combination of FT and non-FT,
choosing either FT PSK and PSK, or FT 802.1X and 802.1X, the WLAN is hybrid. Both
802.11r and WPA2 are advertised in the beacons and probe responses. 802.11r clients are
expected to associate using 802.11r, whereas non-802.11r clients “should” associate using
standard WPA2.

If you set Fast Transition to Adaptive, your key management must be either 802.1X or PSK
(CCKM is a neutral option; you can enable it or not), as shown in Figure 7-40.
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You should not enable any FT key management option. If you enable an 802.11r key management
option (FT PSK or FT 802.1X alone, or the hybrid combination FT PSK/PSK or FT
802.1X/802.1X), you enable 802.11r openly. As a result, 802.11r is advertised in your SSID
beacons. This contradicts the purpose of Adaptive 802.11r, because Adaptive 802.11r is designed
for networks where you do not want to, or cannot, advertise 802.11r openly. Enabling Adaptive
802.11r in a network where 802.11r is advertised openly does not make sense. If 802.11r is
advertised openly, the iOS devices will use it directly, no need for any adaptive mode or secret
handshake.

Note

Not all iOS devices support Adaptive 802.11r. iPhones 6S and later and iPad Pros support 802.11r,
but older devices do not.

Managing Video Flows

Video conferencing falls into the realm of real-time applications, and the recommendations in the
previous section apply. However, you may have other type of video traffic in the Multimedia
Streaming category (for example, your beloved CEO daily broadcast). In many networks, this one-
way flow is sent over multicast. Multicast is great for wired networks but has a major drawback for
Wi-Fi networks: it is sent per 802.11 requirements at one of the Basic (mandatory) rates. Only
legacy rates (802.11, 802.11b, 802.11g, or 802.11a) can be set to Basic. The result is that these
multicast flows will be sent at a suboptimal rate (instead of 802.11n or 802.11ac wherever
possible).

In most networks, you would set 12 Mbps and 24 Mbps as mandatory rates, and multicast flows
will be sent at the highest mandatory rate supported by all receiving stations. In an 802.11n or
802.11ac network, it is far more efficient to send 10 individual frames at 300 Mbps than a single
multicast frame at 24 Mbps (that all stations in the cell will receive, because the destination address
is multicast, even if they do not need it).

To work around this issue, you can configure media streams, also called VideoStreams. With media
streams, the WLC will keep track of wireless clients subscribing to targeted multicast flows using
IGMP membership reports. When such messages are transmitted by wireless clients, the WLC will
record the flow address that the client is subscribing to. Then, when such flows will be forwarded to
the client through the WLC, the WLC will unicast the flow to the client. This is the general
principle; the flow details are as follows:

Note

Please note that this section focuses on video flows, but media streams are in fact about multicast
streams, regardless of the payload they carry. You can configure media stream even if your
multicast flow carries something else than video, like multicast paging messages for voice badges
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for example, or any other multicast traffic where there is a subscription mechanism for the clients.

1. The WLC intercepts the IGMP reports from each multicast client.

2. The WLC sends a Radio Resource Control (RRC) request to the AP. This request aims at
checking whether there is enough space for a unicast stream in that cell. This verification acts
as a filter, which allows you to decide which flows should be forwarded to the cell if the
channel utilization is high (and which flows are of lesser importance and should be dropped or
sent as best effort).

3. The AP returns an RRC response for the client and the radio, providing a view of the channel
utilization.

4. The WLC determines whether the media stream flow that the client requested can be admitted
for that AP and that radio.

5. The WLC creates a new multicast group ID (MGID) if the request flow is new, or adds the
client to an existing MGID if other clients on that same WLC have already subscribed to that
same multicast flow.

6. The WLC forwards the client join report upstream (to the wire).

7. If RRC revealed that enough bandwidth was available, the WLC informs the AP that the
stream is admitted and that bandwidth must be reserved.

8. The WLC also sends to the AP the MGID and WLAN mapping.

9. The AP keeps track of MGID, WLAN, and client association.

Then, when multicast traffic flows from the source toward the client:

1. The WLC checks whether media stream was set with RRC for that flow.

If media stream was not configured for that flow, the flow is dropped or sent as best effort,
depending on configuration.

2. If a media stream exists, the WLC forwards to all APs allowing that flow, using Unicast or
Multicast.

DSCP AF41 is used by default for the CAPWAP outer header by default. Traffic is sent
without DTLS encryption if multicast is used between the WLC and the APs (even if you
checked the data encryption option in the AP Advanced tab; encryption is used if you use
unicast between the WLC and the APs).

3. The AP changes the Layer 2 destination address to unicast and forwards to each client.
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Sent at optimal rate for each client, WMM Video (AC_VI) queue.

This choreography means that your WLC must not only be configured for media streams but also
for multicast.

The first item to configure is the WLC to AP traffic mode for multicast. This mode determines
whether a multicast flow received by the WLC should be sent individually to each AP or if it
should be sent once to a multicast address to which the APs subscribe.

Note

Don’t fall into the traps around this point. If your WLC is receiving multicast traffic destined for
wireless clients, it is likely that your wired infrastructure supports multicast (otherwise that
multicast traffic would not have reached the WLC). Therefore, it may be beneficial to leverage this
infrastructure multicast support. If the WLC has a message that needs to be sent to all APs, it is
more economical to send one multicast message to an address to which all APs subscribe rather
than sending a unicast message to each AP. The APs joining the WLC will get in their config this
multicast address membership and will send IGMP membership reports for that address, letting the
wired multicast infrastructure know that packets sent to that multicast address should be forwarded
to each subscribed AP. As a result, the WLC sends one message to a multicast address, and that
message is forwarded to each subnet where there are APs. This is better than sending 1000 unicast
messages (if the WLC has 1000 APs).

However, the AP Multicast mode has nothing to do with the multicast messages sent to the wireless
clients. There is a reasoning that if the WLC receives multicast traffic for the wireless clients, then
the infrastructure supports multicast, so why not leverage this fact for the WLC to AP forwarding
part.

In Controller > General, you can set the AP multicast mode to unicast or multicast:

With unicast multicast mode, each multicast packet received by the WLC for wireless clients will
be encapsulated into a unicast packet and sent to each AP individually. If you have 1000 APs, the
WLC sends 1000 messages (regardless of which AP has clients for this traffic).

With multicast multicast mode, each multicast packet received by the WLC for wireless clients will
be encapsulated into another multicast packet and sent once to the wire. As the APs subscribe to
that outer multicast address, the multicast infrastructure will forward that one packet to each
segment where there is a subscribed AP, and all APs will receive the packet. If you choose
multicast multicast mode, configure a multicast address for your APs.

Note

The multicast multicast address has nothing to do with the multicast packet sent for your wireless
clients. It is the common address that the APs subscribe to. An address in the multicast
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Organization Local Scope range (any address between 239.0.0.0 and 239.255.255.255) is a
reasonable choice for IPv4 and, for example, the equivalent in IPv6 (ff1e::239.x.x.x).

Suppose that your multicast multicast address is 239.1.1.1, and suppose that your WLC receives
traffic sent to the mDNS/Bonjour address 224.0.0.251. The WLC will convert the 802.3 frame into
802.11 (the destination IP is still 224.0.0.251), then encapsulate that frame into a CAPWAP
packet. The CAPWAP outer header destination IP will be 239.1.1.1 (the source will be your WLC
management interface IP address). The multicast infrastructure will forward the packet to all
segments where clients are subscribed to the 239.1.1.1 address (that is, all the APs on that WLC).

Each AP will receive the multicast CAPWAP packet, will remove the CAPWAP header, look at
the internal destination IP address (224.0.0.251), check which radios and SSIDs have clients for
that flow (clients that subscribed to 224.0.0.251 flow), and will either forward the 802.11 frame to
each matching SSID and radio or drop the packet if no client was found for that 224.0.0.251
address. (If IGMP/MLD snooping are disabled—see below for more details on snooping—then all
the APs will transmit the original 224.0.0.251 multicast packet over the air, even if no clients are
interested in this multicast service. This is obviously less efficient and consumes airtime in vain.)

The AP multicast mode configuration is only about WLC-to-AP traffic and is irrelevant for your
client multicast forwarding (you can forward multicast traffic to clients with AP unicast mode or
multicast mode).

If you want to allow multicast traffic to be forwarded to wireless clients, you need to go to
Controller > Multicast and enable Global Multicast Mode, as shown in Figure 7-41 (CLI family
config network multicast).
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Figure 7-41 Global Multicast Configuration

In the Cisco window, Controller tab is selected that displays a list in the navigation pane
where Multicast is selected. In the content pane, the fields of the multicast window are
displayed. The fields are as follows Enable global multitask mode, enable IGMP snooping,
enable MLD snooping checkboxes are selected, IGMP timeout (30 to 7200 seconds) and
MLD timeout (30 to 7200 seconds) is set to 20; IGMP query Interval (15 to 2400 seconds)
and MLD Query Interval (15 to 2400 seconds) are set to 20."

When Global Multicast Mode is disabled, incoming multicast traffic is not forwarded to clients and
is dropped at the WLC. Clients may try to subscribe to multicast flows by sending IGMP
membership reports, but the WLC will also drop these messages.

After Global Multicast Mode is enabled, multicast traffic can be forwarded to clients. The WLC
can then also forward the client’s membership reports to the wired infrastructure. Two modes are
possible:

Without IGMP (IPv4) or MLD (IPv6) snooping, the WLC forwards each membership report
message to the wired infrastructure. This mode is chatty. If 500 clients subscribe to the same
flow within a minute, the WLC will transparently relay each of these 500 messages upstream.
The upstream infrastructure directly sees the clients as the requesters (called the multicast
listeners).

With IGMP (IPv4) or MLD (IPv6) snooping, the WLC acts as a buffer. The WLC receives all
the membership reports from the wireless clients but only forwards upstream one membership
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report per multicast address, at regular intervals. The upstream infrastructure does not see the
clients, but the WLC as the multicast listener.

Each client will maintain its membership for each multicast address by sending membership reports
at regular intervals. The interval is often semi-random (within a range) to avoid collisions between
members’ packets. The WLC keeps track of these reports and associates each client and each
multicast address to a multicast group identifier (MGID).

At regular intervals (configured with IGMP Query interval for IPv4 and MLD query interval for
IPv6), the WLC will query the wireless clients for membership, to verify which clients still want to
belong to which MGID. Default values for these queries (20 seconds) is fine in most cases. The
IGMP query will be sent to all APs (unicast or multicast), then forwarded to all radios/SSIDs where
multicast clients are reported.

Each client should respond to the query. If a client does not respond for a specific group for more
than the interval configured in IGMP timeout (IPv4) or MLD timeout (IPv6), that client is removed
from the matching MGID. Default values for this timeout function are fine in most cases. When the
last client is removed from an MGID, the WLC stops forwarding upstream membership reports for
that multicast address.

Enabling Global Multicast Mode on the WLC allows the WLC to forward multicast traffic to the
wireless clients. You then need to decide whether that traffic should be sent over the air to all
requesting clients as a slow common multicast packet or as faster individual unicast packets.
Default is multicast. If you want to send unicast frames, navigate to Wireless > Media Stream >
Streams (CLI config media-stream) and add a new stream as shown in Figure 7-42.
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Figure 7-42 Media Stream Creation

In the window, "Wireless" tab is selected that displays a list in the navigation pane where,
"media stream" is selected. In the content pane, the following fields are displayed. Stream
name: stream 1, multicast destination start IP Address, multicast destination end IP
address: 224.2.0.200 (selected), and maximum expected bandwidth (1 to 3500 kilobytes
per second)." Under "Resource Reservation Control (RRC) parameters" section the
following fields are displayed. Select from predefined templates, average packet size (100
to 1500 bytes), RRC periodic update checkbox is selected, RRC priority (1 to 8) is set to 1,
and Traffic profile violation is set to "best-effort" selected from a spin box.

Most streams are sent to a single IP address, but some streams are sent to a range of addresses.
Enter the range or the IP addresses in the Multicast Destination Start IP Address and Multicast
Destination End IP Address fields. You also need to know the expected multicast stream bandwidth
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consumption. In the real world, this information should be provided by the flow emitter (based on
the codec used for the video flow, for example). You can also measure the consumed bandwidth if
needed.

The bandwidth is useful for RRC, to determine how much bandwidth should be reserved. However,
video is bursty, so you may have periods of heavy traffic followed by quieter periods (different
flow characteristics all resulting in the same average bandwidth). In the RRC section, you can use a
predetermined template or define yourself the expected average packet size. In most cases, using a
template is easier if you are not sure about the right values.

You can also decide whether RRC should be refreshed periodically to reevaluate the bandwidth
available on the AP radio at regular intervals. This periodic reevaluation is the recommended
setting, especially if you expect the channel utilization to reach critical levels or if you allow several
multicast flows to your cell.

You can then specify the priority of this media stream. The priority can be any number between 1
and 8. A larger value means a higher priority. The default priority is 4. The low priority stream may
be denied in the RRC periodic update, if there is not enough bandwidth for all streams on a given
AP radio.

This “not enough bandwidth for all” condition forces the WLC to send first the flows with higher
priority, then decide what to do with the flows of lower priority. This is the Traffic Profile Violation
value. It specifies the action to perform in case of a violation after a re-RRC (not enough space,
and this stream is not among those of higher priority; sending it would bring the AP radio to go
beyond a utilization threshold that you will configure in the next page). Choose an action from the
drop-down list. You can choose to drop the stream or to fallback, which means that the stream will
be sent but demoted to best effort (instead of AF 41).

This way, you can create several media streams.

Creating these streams will allow you to send them as unicast wireless frames whenever possible.
However, creating the stream alone does not enable this type of forwarding. You also need two
additional steps: enabling media stream in general, and enabling media stream for your target
WLANs.

In Wireless > Media Stream > General, check the Multicast Direct feature check box. This check
box acts as a general on/off switch for multicast direct. Lower in the page, you can choose to
enable Session Announcement State. This feature is useful in theory, to send messages to multicast
receivers when their stream has to be stopped. This happens after a RRC reevaluation for streams
of lower priority that have to be dropped because they consume too much bandwidth. The Session
Announcement State allows you to send a note (for example, “Dear user, your video does not
matter to the business, we dropped it. Sorry, now go back to work”), along with a phone number,
email address, or URL that the user can reach to get more information (or complain).
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After the Multicast Direct feature has been enabled, you can also activate multicast direct on the
SSIDs where you would want multicast streams to be sent as unicast frames. This is done with the
CLI config wlan media-stream multicast-direct <WLAN ID> command.

At this point, you are allowing media stream unicast in general and for selected WLANs, but you
are not controlling the maximum bandwidth yet (the threshold that will help RRC determine when
to deny or accept a flow). This is done from Wireless > 802.11a/n/ac | 802.11b/g/n > Media >
Media. In this page, you can enable or disable bandwidth monitoring and control for media stream
with the Unicast Video Redirect check box (CLI config 802.11a media-stream video-redirect).
When this feature is enabled, you can also control how much bandwidth should be used on each
radio for all media traffic with the Maximum Media Bandwidth option (CLI config 802.11a media-
stream multicast-direct family).

Note

Be careful, this field represents the maximum bandwidth for media that is video traffic. Maximum
is 85%. However, the bandwidth allocated for all types of media traffic also cannot exceed 85%.
This total also includes the voice bandwidth. This has two consequences:

If you configure 50% bandwidth for Voice CAC and 65% for maximum media bandwidth, you
are telling the system that it should stop admitting TSPEC voice calls when voice calls
represent 50% of the bandwidth on the radio. But you are also saying that RRC should start
dropping (or sending as best effort) multicast flows representing more than 65% of the
bandwidth. The system will check each parameter individually. Because your total is more than
85% (it is actually more than 100%), you may face cases where media streams and voice suffer
from poor quality. As much as possible, make sure that Maximum Media Bandwidth and Voice
CAC Max RF Bandwidth (when configured) do not exceed 85%.

As you will see in the next section, you can also configure Video CAC. Voice CAC bandwidth
and Video CAC bandwidth together cannot exceed 85%. (The system throws an error if your
configuration exceeds this threshold.) You can consider the video admitted under Video CAC
as part of your multicast media flow, if that video is sent over multicast. In that case, it does not
make sense to have Video CAC different from Maximum Media Bandwidth. However, CAC
video can also be unicast. In this case, the numbers in Video CAC bandwidth and Maximum
Media Bandwidth are unrelated.

Sending unicast frames to an 802.11n/ac client is likely to be efficient. However, if the client is at
the cell edge at 6 Mbps, one multicast packet is likely better than many unicast slow packets.
Therefore, you can also configure the minimum PHY rate at which each multicast client should be
for the system to attempt unicast transmission instead of multicast (CLI config 802.11a cac media-
stream multicast-direct min-client-rate).

Efficiency (that is, speed of transmission) is one parameter. However, another advantage of unicast
frames is that they are acknowledged. This is a reason why you may want to keep the client PHY
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rate to 6 Mbps, to increase the transmission quality (by resending frames that were not
acknowledged). When the client is at the edge of the cell or in poor RF conditions, this requirement
to use unicast may result in high retry rates. You can configure the maximum retry percentage of
the transmissions. Beyond the configured number, the AP drops the frames when they are not
acknowledged and sends the next ones (restarting to retry whenever needed, when the retry rate
falls back below the threshold).

Lower down in the page, you can also configure how many streams should be allowed per AP radio
and per client. You can also configure whether flows in excess of the configured bandwidth should
be dropped or sent as best effort. These parameters are activated together with the Multicast Direct
Enable option (CLI config 802.11a media-stream multicast-direct).

You can optionally configure Video CAC from the Video tab. The logic here is similar to the Voice
CAC detailed earlier in this chapter, with a few additional considerations:

The bandwidth for Voice CAC and Video CAC together cannot exceed 85%.

You do not have to configure Video CAC for configuring Media Stream. It is an optional
addition, even if it appears in all media stream configuration guides. In the exam, double check
to verify whether this element is requested.

In real life, no client (at the time of publication) supports Video CAC; therefore, this feature is
not useful.

Bonjour/mDNS

If you use Apple iOS or macOS devices, you also have to manage another type of traffic, Bonjour.
In most cases, this traffic will not represent a large volume, but its structure has consequences on
your network efficiency.

Bonjour/mDNS Principles

Apple Bonjour is part of the larger multicast DNS (mDNS) family. Subscription and traffic for this
protocol are sent to the IPv4 address 224.0.0.251 and IPv6 address FF02::FB. These addresses are
part of the nonroutable family. They are well suited in a small home network where the Bonjour
traffic is expected to stay in the local subnet; however, this nonroutability is an issue for enterprise
networks. The WLC has multiple functions to help Bonjour traffic delivery, beyond simple
multicast forwarding. (Multicast forwarding may address the issue of letting clients receive Bonjour
traffic, but does not address the issue of Bonjour devices in different subnets needed to
communicate, and it is less efficient because it forwards all mDNS traffic without filtering for
specific services, or VLAN, or WLAN, or other options as you will see later.)

mDNS gateway: The WLC can act as a proxy to let mDNS wireless devices communicate with
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mDNS devices in other subnets (whether they are wireless or wired).

mDNS policing: The WLC can generate conditions for this communication, based on group
membership, profiles, or other criteria.

mDNS AP: An AP can report to the WLC the mDNS traffic heard on the AP switch. This is
useful, for example, in classrooms, where the mDNS wired devices are close to the AP (and the
students) but far from the WLC (the WLC is in another building and another VLAN, and
would have no knowledge of these remote wired mDNS flows).

Location Specific Services (LSS): Wireless mDNS queries and advertisements are tagged with
the AP MAC. Exchanges are allowed only for devices that have the same AP MAC tag (clients
of the same AP, regardless of the band or the SSID) and devices on neighboring APs (devices
for which the AP MAC tag match APs in the local AP AP-NEIGHBOR-LIST in the WLC
RRM database, and that therefore are in the same RF neighborhood as the local AP). Note that
this tagging does not apply to wired messages, only to wireless messages. (Wired messages are
considered non-location-specific and are forwarded to all when allowed.)

Origin Based Service Discovery: This feature allows the WLC to tag an mDNS service to
specify whether it comes from a wired or a wireless source. You can then decide to allow only
wired or wireless services. Again, LSS would apply only to wireless services. You can use
Origin Based Service Discovery to admit only wired mDNS, but you cannot add LSS in that
case.

Priority MAC: To avoid overloading of the WLC mDNS database, you can configure up to 50
MAC addresses (each corresponding to a MAC address and an mDNS service) that are always
on top and always discovered (if present). This is useful if you have a large number of mDNS
devices advertising multiple services. The WLC can take up to 1000 (5508), 2000 (WiSM2),
and 16,000 (5520, 7500, 8500, vWLC) services/MAC addresses (depending on the platform).

Service groups: A group name can be associated with a set of MAC addresses. This grouping
makes policy configuration easier, because you can call the group name in the policy, instead
of having to call individual MAC addresses.

Bonjour/mDNS Configuration

mDNS configuration may be challenging if you have a large number of devices, services, and
limited information about which device advertises (or needs) which type of service. It is common
for a single device (for example, Apple TV) to advertise multiple services, each with its own
associated code. Luckily, the CCIE exam is not about Apple services but about Wi-Fi
configurations. You should be able to select the services discovered automatically or the mDNS
browser to select the services you are asked to configure.
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mDNS Gateway

To enable mDNS gateway and relay mDNS messages between subnets known by the WLC, check
the mDNS Global Snooping check box in the Controller > mDNS > general page (CLI config
mdns snooping), shown in Figure 7-43.

Figure 7-43 mDNS Global Configuration

In the Cisco window, "Controller window" is selected that displays a list in the navigation
pane where mDNS is selected. In the content pane, "Global configuration" section shows
fields "mDNS global snooping checkbox is selected, mDNS policy, and Query Interval (10
to 120): 15 (mins)." The "Master service database" shows the fields: Select service, query
status, LSS status, and Origin." Below, a table is shown with the headers "Service name,
service string, query status, LSS status, and origin." Three Query status checkbox is
selected for the service name "HP_Photosmart_Printer_1, HP_Photosmart_Printer_2, and
HomeSharing. Origin shows spinboxes where ALL is selected.
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After mDNS gateway is enabled, the WLC will check the availability of supported services in each
subnet, at intervals configured in the Query Interval field (CLI config mdns query interval).
Default values are acceptable in the exam and in the real world, because they match the iOS and
macOS timer behaviors. It may happen that Apple would change the default timers and that new
values would be recommended, but such a change is unlikely to happen without the AireOS default
timers being adjusted accordingly.

You also need to select which services you want to be supported (and relayed) by this WLC. A
default list exists at the bottom of the page. You can delete services, or add services with Select
Service (Select Service and click add; CLI config mdns service). You can also check or uncheck
Query status (when adding a service, in the Master Services Database section, or after the service is
added, in the list of services at the bottom of the page) if you do not want the WLC to send
availability queries for specific services.

There may be WLANs where you do not want mDNS, which is a form of multicast, to be
forwarded. For this reason, you also need to activate mDNS selectively on the WLANs where
mDNS matters. You can activate mDNS forwarding from the WLAN Advanced tab by checking
the mDNS Snooping option (CLI config wlan mdns enable).

Note

The WLC advertises the services from the wired devices (such as Apple TVs) learned over VLANs,
when

mDNS snooping is enabled in the WLAN Advanced options.

An mDNS profile is enabled either at interface group (if available), interface, or in the WLAN
(see below).

You do not need to enable Multicast or IGMP snooping to activate support for mDNS. mDNS
is treated as a special service outside the Multicast configuration scope, even if mDNS uses
multicast.

These commands configure the mDNS gateway function on the AireOS WLC. On switches, you
can also enable the same type of gateway functions for wired mDNS devices that are not in the
same VLAN. This type of configuration is independent from your AireOS WLC configuration, but
they nicely complement each other to allow for an end-to-end mDNS support strategy. You can
find more information in the IOS Service Discovery Gateway (SDG) configuration document:
https://www.cisco.com/c/en/us/td/docs/ios-xml/ios/ipaddr_dns/configuration/15-sy/dns-15-sy-
book/Service-Discovery-Gateway.html.

mDNS Profiles
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The general configuration just described means that all services will be potentially advertised to all
interfaces or WLANs. In many cases, you will want to restrict the list of services supported on
some interfaces (for example, to avoid those TV services from being advertised in a classroom
WLAN). To create such a shorter list of services, you create a profile. After creating a profile, you
map the profile to an interface group, an interface, or a WLAN. Clients receive service
advertisements only for the services associated with the profile.

Profiles are created from Controller > mDNS > Profiles. You cannot delete the default profile,
but you can create a new one. Edit the new profile and add services to that profile (CLI config
mdns profile).

After the profile is created, you can map it to an interface group (from Controller > Interface
Groups > Edit group > pick a profile name for the mDNS Profile drop-down list; CLI config
interface group mdns-profile), an interface (from Controller > Interfaces > Edit interface >
pick a profile name for the mDNS Profile drop-down list; CLI config interface mdns-profile), or
a WLAN (from WLANs > Edit WLAN > Advanced > pick a profile name for the mDNS Profile
drop-down list; CLI config wlan mdns profile).

You may end up with a WLAN with a profile and an interface or interface group with a different
profile. What happens to a client in that WLAN where traffic is sent to that interface? The highest
priority is given to the profiles associated with interface groups, followed by the interface profiles,
and then the WLAN profiles. Each client is mapped to a profile based on the order of priority. So in
this case, the client will receive the profile associated with the interface.

mDNS AP

At this point, your WLC learns services from wireless devices and from wired devices; however,
mDNS is not routable. Therefore, your WLC will learn only about wired services that are in the
same subnet as your WLC’s interfaces; that is, VLANs that are “visible” to the WLC (and likely
close to your WLC, as the trend is to limit the scope of VLANs to a single or limited set of
switches). Your WLC will not learn about wired services on switches to which your APs connect, if
they are in different subnets/VLANs (and different switches) that are not Layer 2 visible to the
WLC. To enable the AP to encapsulate into CAPWAP and send to the WLC the services it detects
on its switch, enable mDNS AP.

Note

The AP will detect only wired services in its VLAN. If you want the AP to detect services in more
than one VLAN, set the AP port to trunk, with the AP intended VLAN as the native VLAN.

The AP can snoop up to 10 VLANs, so you may have to limit the number of VLANs on the AP
trunk (with the switchport trunk allowed vlan interface command), and those VLANs should also
be configured at the mDNS AP feature level, because the WLC has to understand the VLAN tags
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forwarded by the AP along with the service information.

To enable mDNS AP, navigate to the target AP (in Wireless) Advanced tab and check mDNS
Snooping. After mDNS snooping is enabled, you can also configure the list of VLANs to snoop
(CLI config mdns ap enable/disable <APName/all> vlan <vlan-id>).

mDNS Filtering Options: Priority MAC, Origin, and LSS

At this point, your WLC may start to be overloaded with service announcements from wireless and
wired locations. There are a few ways to limit the amount of traffic. The first mechanism is to
ensure that the most important services are always on top (always present in the list of services,
even if the list exceeds the max number of entries on your WLC platform). This feature is called
Priority MAC. From the Controller > mDNS General page, select a service at the bottom of the
page or add a service. In the Service Detail page, at the bottom, you can associate the priority MAC
to that service, as shown in Figure 7-44.

Figure 7-44 mDNS Service Page
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In the cisco window, "Controller" tab is selected that displays a list where "general,
profiles, domain name, mDNS browser, and mDNS policies" are selected under mDNS. The
content pane displays the fields of the mDNS service. Service name, service string, service
ID, service query status, LSS status, origin, profile count, and service provider count. The
"Profile Information" section displays the profile name. The "priority MAC information"
displays the fields "Priority MAC and AP group" where "default group" is selected from
the spin box for AP group with an add button.

This will ensure that the device (whose MAC address you entered) advertising this service will
always be on top of the list (CLI config mdns service priority-mac). Notice that you can limit this
priority to a specific AP group. This may be useful, for example, if you want the local printer to be
always the one advertised in a given building or floor to which an AP group is associated, but
another printer would be prioritized for another floor and another AP group.

Origin-Based Service Discovery

After a service is configured, it will be learned from wired/wireless. However, you can decide
whether a given service should be learned only from Wired or Wireless (or both). This is done
simply from the Controller > mDNS > General page. For each service listed, you can set the
Origin to All, Wired, or Wireless.

Note

Keep in mind that Origin works inbound. You filter if the service should be discovered from wired
sources, wireless sources, or both. Origin does not say that a service should not be advertised to
wireless, for example. To configure outbound policies, use Profiles (or policies) and associate them
to a WLAN or an interface.

If you configure a service for LSS, you apply a restriction that is wireless only (LSS does not work
for wired services). Therefore, if a service is set for LSS, you cannot configure it to be “wired
only.”

LSS

In some cases, you may want to limit mDNS exchanges to devices on a given AP (regardless of the
SSID) or a set of neighboring APs. A typical example is a large (or densely populated) classroom
with two or three APs, where iPads communicate with the local wireless Apple TV, and the like,
but should not communicate with an Apple TV on the other side of the school (typically because
there would be potentially tens of Apple TVs to choose from every time, and this would not be
practical). This type of filtering is called Location Specific Services (LSS).

LSS is also simply configured on a per service level, in Controller > mDNS > General. You can
check LSS for any service already present or that you add. When you click Apply, each service for
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which LSS is enabled will add the MAC addresses of the APs from which it is learned. Wireless
clients requesting that service will receive responses only for the services that have the same AP
MAC address mapping as the requesting client, or whose AP MAC address tag is one AP in the
local AP list of RF neighbors. This way, your clients will see local services and services available
through neighboring APs, but not beyond. This helps reduce the scope of visible services. With this
feature, you see only services around you (for example, a printer), instead of seeing all the services
in the building. (If you want a printer near you, you do not want to have to browse through all
printers in all buildings and all floors of your campus every time.)

Note

Keep in mind that the LSS filter works only for wireless clients and wireless services, not for wired
services. The client requesting a service will also receive responses from the snooped services that
the WLC knows about, regardless of their location, unless you configure further filters (policies
follow).

mDNS Policies

Filtering per location or origin is efficient in smaller networks. In larger networks, stricter policies
are required. Bonjour policies allow per service instance (MAC address) configuration that
mandates how the service instance is shared:

Service instance is shared with whom (user-id)?

Service instance is shared with which role(s) (client-role)?

What is the location allowed to access the service instance (client location)?

This configuration can be applied to wired and wireless service instances, and the response to any
query will solely be based on the policy configured for each service instance. This allows selective
sharing of service instances based on the location, user-id, or role. Because most service publishing
devices are wired, this allows filtering of wired services at par with wireless service instances.
While an mDNS profile associated with the client checks for service type being queried before
responding to the query, the access policy further allows filtering of specific service instances based
on querying client location, role, or user-id.

To configure this type of filtering, you start by creating service groups. A service group is a name
associated with a set of MAC addresses. Each MAC address is configured with a unique name,
which can be the service instance name, and the location of the MAC address for both wired and or
wireless. The location can be an AP, an AP group, or an AP location. An AP location is particularly
useful if you expect users to roam (and if no AP group matches the roaming domain). You can use
the location name (setting the same location name on multiple APs) to determine the set of APs
among which the service instance can be supported. This configuration implies that only clients
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from the same location as that of the device publishing the service can access the service.

Navigate to Controller > mDNS > mDNS Policies. Edit an existing mDNS Service group or create
a new one. In the group configuration page shown in Figure 7-45, you can add instances and
associate a name and a location (CLI config mdns policy service-group).

Figure 7-45 Service Instance Configuration

In the Cisco window, "Controller" tab is selected that displays a list in the navigation pane
where "general, profiles, domain names, mDNS Browser" under mDNS are selected. The
"Service Instance list" of the "mDNS service group name" displays the following fields:
MAC address, name with the add button, location type, and location 1." Below, four tabs
"MAC address, name, location-type, and location" tabs are displayed. The "Policy and
Rule" displays two text boxes for "role names and user names." Three footnotes are
displayed at the bottom.
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The service group also determines which users or groups should be allowed to access the instance
in the group. This determination is based on a set of conditions. At the bottom of the service group
page, you can configure Role Names and/or User Names. When a wireless client tries to access an
mDNS service and global mDNS policy is enabled, the WLC will compare the client set of
attributes to the attributes defined in each mDNS service group. If it matches the attributes defined
in a service group, the client will be allowed to access only the instances that have been configured
in that service group.

Your service group already has instances that match a location type and name. If these are the only
attributes that you need, you can set the role and user names to Any, or leave the fields empty.

Alternatively, you can set a role name (for example, students), and even a username if you want to
restrict the service to a single user (CLI config mdns policy service-group user-role | user-
name).

If you configure a role or a username, the authenticating user will need to receive such an attribute.
This is done with AAA override enabled in the WLAN and an authorization profile in ISE that will
associate the user with the role name. Your ISE authorization profile can also point directly to an
mDNS profile name.

Note

For a sample configuration, see
https://www.cisco.com/c/en/us/td/docs/wireless/controller/technotes/8-0/WLAN-Bonjour-DG.html.

If you do not use AAA override, you can also use local policies (in Security > Local Policies) to
identify a device type and associate an mDNS profile to that local policy. The local policy can also
target a role string obtained via AAA override.

AireOS Configuration Summary

Most of the best practice configurations are enabled by applying the Fastlane macro on an SSID.
Study what this macro configures and you will know most of the best practices for AireOS QoS.
The only exception is ACM, which should be enabled only on a case-by-case basis. In 8.3, Fastlane
enables CAC automatically (later codes do not), but you can disable ACM if needed (or asked).
Keep CAC if most of your clients are Apple and/or hard phones. Disable CAC if most of your
clients are of different categories (Windows, Android).

There is no best practice configuration for AVC or for Bonjour/mDNS. The lab questions will
dictate what should be configured and how. In the real world, AVC may have some impact on your
WLC CPU (or not!), so you should test your AVC configuration before deploying it widely.

Autonomous APs
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AireOS configuration for application services support is extensive, and that’s because AireOS needs
to support large and small networks in any vertical. By contrast, autonomous APs have a much
smaller configuration span for QoS and real-time applications. There are two main reasons for this
smaller feature scope:

Autonomous APs are primarily intended for locations with a small number of APs. In such
locations, you expect a simpler client structure and less roaming concerns. In other words, you
do not expect a heavy traffic competition with high user density and intense roaming.

Autonomous APs are primarily Layer 2 bridges. Their main purpose is to translate between two
Layer 2 mediums (802.11 and 802.1). The management of application priority is expected to be
done upstream (Layer 3 devices or applications).

This does not mean that there is no awareness of Layer 3 QoS (DSCP) in autonomous APs. It
means that autonomous APs do not perform DPI. Autonomous APs simply look at frames and
packet headers and apply translation rules between mediums based on the header values. This
translation results in the following domains:

DSCP to UP: Decide which wired QoS value (802.1p, or DSCP) should translate into which
802.11 User Priority.

Retry options: Customize the rates and retries allowed for each UP.

EDCA Parameters: Customize each UP parameter (AIFSN, TXOP, CW).

“Advanced features”: Apply customization parameters designed for autonomous APs and
voice traffic optimization.

DSCP to UP Mapping

The autonomous AP GUI includes a Services > QoS page, shown in Figure 7-46. You should know
its content well.
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Figure 7-46 QoS Policies Page

In the Cisco window, "services" tab is selected that displays the Services list in the
navigation pane. In the Content pane "QoS policies" is selected that displays the sections
"Create and Edit policy, policy name, and classifications." Under "Match Classification"
section "IP DSCP" radio button is selected for "Best Effort (selected from the spin box)."
"Apply class of service" section is shown with "Add" buttons. "IP protocol" section is
shown with "Filter" field. "Rate limiting section" shows the fields "Bits per second,
conform action, burst rate, and exceed action." "Apply policies to Interface/VLANs"
shows a table with the headers "VLAN 1, Radio0 to 802.11N to the power 2.4 GHz,
Radio1 to 11.N to the power 5 GHz, and GigabitEthernet."

On the QoS policies tab, you can create a customized mapping between wired QoS and 802.11 QoS
values. You can also associate this mapping to a rate limiting configuration.

In the GUI, create a new policy name. In the match classification area, select which DSCP value

Chapter 7 WLAN Media and Application Services

492

Technet24
||||||||||||||||||||

||||||||||||||||||||

https://technet24.ir
https://technet24.ir
https://technet24.ir


should translate to which UP.

Notice that the UPs are named after the original 802.1p-1998 table examined at the beginning of
this chapter. To help the Wi-Fi administrator unfamiliar with the 1998 802.1p nomenclature, the
intent of voice (<10 ms latency [6]) and video (<100 ms latency [5]) are expressed. In a typical
setup, you would at least create a policy for voice. Creating a policy that includes both voice and
video traffic mapping is acceptable, too, but the video part is often left aside (because the primary
concern is the audio experience). In any case, make sure to respect the recommended mapping:

Expedited Forwarding (EF) -> UP 6

Assured Forwarding Class 4 Low (AF41) -> UP 5

From the GUI, create your policy, add a voice mapping rule, then click Apply, as shown in Figure
7-47. You can also add a video rule if needed.

Figure 7-47 QoS Policy Creation

In the Cisco window, "services" tab is selected that displays the Services list in the
navigation pane. In the Content pane "QoS policies" is selected that displays the sections
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"Create and Edit policy, policy name, and classifications." Under "Match Classification"
section "IP DSCP" radio button is selected for "Expedited forwarding (selected from the
spin box)." "Apply class of service section" is shown with "Add" buttons. "IP protocol
119" is shown with Filter field. "Rate limiting" section shows the fields "Bits per second,
conform action, burst rate, and exceed action." "Apply, delete, and Cancel" buttons are
displayed at the bottom.

From the CLI, you will use the class-map command. The GUI forces the class-map creation to the
“match-all” argument. This forces you to create one class map per traffic marking type (your
incoming packet cannot have AF41 AND EF marking at the same time, on the same packet). This is
acceptable and common. However, the CLI allows you to mimic the GUI (match-all) or to use
match-any, which allows you to target voice or video marking in a single class map. This last option
is not the most elegant, but is also acceptable on an AP where the QoS rule set is very simple and
static:

Click here to view code image

class-map match-all _class_RealTime1
 match ip dscp ef
class-map match-all _class_RealTime0
 match ip dscp af41
!
policy-map RealTime
 class _class_RealTime0
  set cos 5
 class _class_RealTime1
  set cos 6

Each class map targeting specific traffic (identified by its DSCP value) is created first. Then a
policy map is created. Inside this policy map, you call each class, one at a time, and determine what
marking this class should receive. The link between the class map DSCP and the marking policy for
that class in the policy map creates the marking mapping.

Notice that the QoS mapping set is CoS, not UP. This is consistent with the GUI, and with the logic
where the UP maps to 802.1p-1998. One advantage of this simplified map is that it can be applied
in any direction, on any interface.

In most autonomous networks, it would still be common to create a voice SSID and a data SSID on
the same radios (or voice in 5 GHz and data in 2.4 GHz), but sent to different VLANs.

You would therefore create a second policy mapping Best Effort to Best Effort 0.

You then need to apply the policies to interfaces. They can be physical interfaces (2.4 GHz, 5 GHz
radios or Ethernet interface) or subinterfaces (VLAN values on physical interfaces). In most cases,
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applying the policy everywhere is the simplest course of action. In Figure 7-48, VLAN 1 exists on
the 2.4 GHz radio and VLAN 12 on the 5 GHz radio. Data traffic is sent to the SSID on the 2.4
GHz radio and VLAN 1, and voice traffic is sent to the 5 GHz radio SSID and VLAN 12.

Figure 7-48 Policy to Interface Mapping

The table for Apply policies to Interface or VLANs shows the column headers: VLAN 1,
Radio0 to 802.11 N to the power 2.4 Gigahertz, Radio1 to 802.11N to the power 5
Gigahertz, and GigabitEthernet0. Under VLAN 1, the data for the incoming signals are as
follows: data (spin box), empty, and data (spin box); Outgoing: data (spin box), empty, and
data (spin box). Under VLAN 12 the table infers the following data "Incoming, empty, real-
time (spin box), and Real-time (spin box); Outgoing, empty, real-time (spin box), and real-
time (spin box) (selected)." Apply and Cancel buttons are displayed at the bottom.

Applying the Data policy to everything VLAN 1 and the Voice policy to everything VLAN 12 is
simple and efficient.

In the context of the CCIE Wireless exam, you also need to carefully examine what you are
attempting to achieve (and what the question states). If your policy only does remarking, an
Ethernet incoming policy will ensure the correct mapping as the wired packet transits through the
AP toward any radio interface. Therefore, there is no reason to apply the policy both on the
incoming direction of the Ethernet interface and on the outgoing direction of a VLAN or radio (you
make the AP do the work twice).

The preceding holds true if your expected traffic flows with a simple structure (from wired to
wireless). However, if you expect traffic to flow from one radio to the other, then positioning the
policy at the radio outgoing direction makes more sense.

The same logic applies for the reverse direction.

In summary:

Apply the policy to both wired and wireless incoming direction if the traffic is expected to flow
between a given SSID and the wired network. Do not apply the policy to the outbound
direction on any interface.
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Apply the policy to both wired and wireless outgoing directions if the traffic is expected to flow
between a given SSID and another SSID, as well as between a given SSID and the wired
network. Also, applying the policy to the incoming direction is then optional (but acceptable).

The CLI command to apply the policy follows a particular logic.

The policy is applied to either the interface level or the subinterface level (if VLANs were created).
The following example shows subinterfaces for VLAN 1 and VLAN 12 (following the GUI example
structure).

The policy is called at the subinterface level with the command service-policy and the direction:

Click here to view code image

interface Dot11Radio0.1
 service-policy input Data
 service-policy output Data
 interface Dot11Radio1.12
 service-policy input RealT
 service-policy output RealT
interface GigabitEthernet0.1
 service-policy input Data
 service-policy output Data
interface GigabitEthernet0.12
 service-policy input RealT
 service-policy output RealT

You can add bandwidth control along with the remarking policy. The GUI does not let you create
both (bandwidth options with class of service mapping), but you can create a new policy that
provides bandwidth selection. You then have the option to define a rate limit value and a burst rate.

Be careful, the rate limit is in bits (binary 0 or 1) per second, burst is in bytes (octets).

In the CLI, the rate limit can be added to a marking policy or be an independent policy. Inside the
policy map, you still call the class, and then decide the rate limit with the policy command. For
example:

Click here to view code image

Class Map match-all _class_BW0
Match any
Policy-map ratelimit
Class _class_BW0
police 30000 50000 conform-action transmit exceed-action drop
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The CLI offers more options (bandwidth, and so on). However, configuring such bandwidth control
on a Layer 2 bridge is uncommon.

In a standard QoS logic, such policy is applied to the outgoing direction of an interface. (In the
incoming direction, the packet is already there. You do not need to control what comes, you just
need to receive it.)

Such bandwidth limitation is possible on the GUI. You would apply it in the outgoing direction of a
subinterface (with the standard service=policy command). You can also apply it to a WLAN, as
shown in Figure 7-49. In that case, the rate limit is configured in the GUI from the SSID itself
(Security > SSID Manager > Edit SSID > Rate Limit Parameters).

Figure 7-49 Rate Limiting

In the Cisco window, "Security" tab is selected that displays a list in the navigation pane
where "SSID manager" is selected. The content pane lists the "Rate limit parameters" with
Limit TCP and Limit UDP sections. In the "Limit TCP" section Input check box is selected
with the rate: 4000, burst-size: 5000 (0 to 500000). In the "Limit UDP" output checkbox is
selected with the rate: 3000 and burst-size: 6000 (0 to 500000).

The CLI equivalent is done under the SSID configuration in global mode, for example:

Click here to view code image

dot11 ssid Test1
   vlan 12
   rate-limit tcp input data-rate 4000 burst-size 5000
   rate-limit udp output data-rate 3000 burst-size 6000
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In real life, you are more likely to need a WLAN-specific rate limit than an interface policing. In
both cases, you would prefer working with marking than creating bandwidth limits, as explained at
the beginning of this chapter. In the exam, read carefully to verify where the bandwidth is expected
to be controlled.

Retry Options

Having different types of traffic mapped to different UPs is critical. However, you also know that
voice traffic is time sensitive. Getting statistical advantage in the medium access with UP 6 is great,
but IOS also allows you to configure two more options (that are not present in AireOS): the retry
count for each UP and the rate shifting options for these UPs. AireOS uses an internal timer logic
for voice that can be configured in the EDCA parameter page (Low Latency MAC—this feature
enables a 30 ms timer that drops voice frames that stay in the AP buffer for more than that
duration).

This option was not covered in the AireOS section because it is not best practice. (Do not use it
unless you are in a lab and someone asks you to turn it on.) In most cases, it is better to let the end
device manage its buffer than to decide at the AP level whether the device buffer is about to get
empty.

In the IOS world, an equivalent parameter exists and is called Low Latency Queue (LLQ). This is
not something you would activate in the real world unless you are addressing a very specific use
case. The lab is of course a different environment in that it always asks you to solve a very specific
use case.

LLQ means that whenever a packet gets in the AP buffer, it will always be sent first (before
packets in other queues are dequeued), giving delay-sensitive data preferential treatment over other
traffic.

This means that you can prioritize traffic on an IOS AP with three methods:

1. With the policy map method, you may just tag, which says “this packet is urgent” but does not
apply any priority per se.

2. There is a QoS Elements for Wireless phones option (discussed next) that prioritizes any voice
packet regardless of any other consideration. This is an LLQ “by nature,” without any upper
limit.

3. With the LLQ option queue configured here, you define how many times the AP should try to
send each voice packet, and at what speed, before giving up and trying the next packet.

LLQ is configured in Services > Stream > Radio0 or Radio1.

Set Cos 6 (Voice) to Low Latency Queue, as shown in Figure 7-50.
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Figure 7-50 LLQ Configuration

In the Cisco window, "Services" tab is selected that displays a list of services in the
navigation pane where "Stream" is selected. In the content pane "Radio0 to 802.11N to the
power 2.4 Gigahertz" is selected that displays a list titled "Packet handling per User
Priority." The headers of the packet handling read: User priority, packet handling with spin
boxes, and Maximum retries for packet discard. The User priorities reads as follows, "CoS
0 (Best Effort), reliable, and 8; CoS 1(background), reliable, and 8; CoS 2 (Spare), reliable,
and 8; CoS 3 (Excellent), reliable, and 8; CoS 4 (Controlled load), reliable, and 8; CoS 5
(Video), reliable, and 3; CoS 6, low latency, and 3; CoS 7 (network control), reliable, and
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8. Under "Low latency packet rules," the speed of the internet is shown with radio buttons;
6.0Mb per seconds: nominal; 9.0Mb per second: disable; 12.0Mb per second: nominal;
18.0Mb per second: disable; 24.0Mb per second: nominal; 36.0Mb per second: disable;
48.0 Mb per second: disable; 54.0Mb per second: disable.

This configuration enables you to configure how many times the AP radio should attempt to send a
voice packet before dropping that unsuccessful packet and sending the next one. This is the Max
retries for Packet Discard value. The default value is 3. Keep in mind that this means that after
three attempts, the AP will drop an unsuccessful voice packet. By contrast, all other queues seem
to retry “forever” (as the configuration is “reliable,” which seems to mean “retry until ACK is
received”). In reality, the AP max retry can also be configured from its default maximum (see the
“Autonomous APs” section of this chapter).

Notice that the low latency does not create any prioritization per se. It simply says “As this queue is
otherwise configured as a priority queue, allow me to configure how many times the AP should try
to send each packet of that type before dropping it if the packet cannot be sent successfully.” You
can set several user priorities to low latency, and set the max retries for each of them.

After you have defined the retry level, you can also configure at which speed those frames should
be sent. This is done at the bottom of the page, in the Low Latency Packet Rates section. You can
set each rate to the following:

Nominal: The AP will try to use this rate to send the low latency packets (using the faster rate
first, and of course depending on the client signal level).

Non-nominal: The AP will try not to use that rate but will revert to it if no nominal rate is
possible.

Disabled: The AP will not try to use that rate.

For example, in Figure 7-50, if your AP to client RSSI level is good enough to try 36 Mbps, the AP
will try 24 Mbps (first nominal rate at or below the client possible rate), then revert to 12 Mbps if
24 Mbps fails.

Suppose that 24 Mbps and 6 Mbps are set to Nominal, and 12 Mbps is set to Non-nominal (other
rates are disabled). The AP would try 24 Mbps first, then 6 Mbps, then 12 Mbps if none of the
nominal rate attempts were successful.

So good practices are to set the rates you want to use as Nominal, then set one low rate as Non-
nominal, so that the AP has a plan B in case all possible nominal rates fail. Disable all other slow
rates.

In the CLI, these elements are configured at radio level. For example:
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Click here to view code image

Int do 1
traffic-stream priority 6 sta-rates nom-6.0 nom-12.0 nom-24.0
 packet max-retries 3 0 fail-threshold 100 500 priority 6 drop-packet
 packet speed  6.0 12.0 24.0 priority 6

The CLI version is obviously more complex. The traffic-stream command determines the nominal
and non-nominal rates for each configured UP set to LLQ.

The packet speed command seems to repeat the traffic-stream command. In fact, the traffic-
stream command defines the nominal and non-nominal rates, whereas the packet speed command
lists all the allowed rates for that same UP. The rates not listed in packet speed are disabled rates
(while traffic-stream does not define disabled rates). In a properly configured AP, the rates listed
on both lines should be the same, packet speed defining the allowed rates and traffic-stream
defining which of these rates are nominal and which are non-nominal.

The packet max-retries command sets the LLQ, stating that the AP will try three times. This
command structure is complex because it uses four numbers (3, 0, 100, and 500). Its logic is as
follows (starting from the first packet the AP sends to a given client): The AP will try each UP 6
packet to a given client three times. If the packet fails three times, the AP drops that packet and
attempts to send the next one.

How many failed consecutive packets would the AP try this way? In this configuration, 100. If 100
consecutive packets fail (try three times, drop and try next), then the command considers that a
threshold is reached and allows for a different logic to be tried (for example, try eight times instead
of three).

In the default version of this command the new logic is to stop trying three times (the reasoning is
that this client is obviously unreachable, if the AP failed 100 consecutive packets, each with three
attempts). The AP sends each packet only once (retry is 0) and attempts 500 more packets.

If these 500 more packets failed (no ACK), the AP drops the packets for that client (this is the drop
packet option at the end; without that option, the AP disconnects the client). With drop packet, the
AP kindly restarts its counters without disconnecting the client.

EDCA Parameters

Configuring bandwidth control is uncommon because the queuing mechanisms on the radio
interface use 802.11e parallel queuing with CW and other 802.11-specific parameters. Attempting
to use wired-type bandwidth control with policing or shaping is often seen as an attempt to square
circles, using tools that are not adapted to the constraints of 802.11 transmission mechanisms.

It is, however, more common to tune the 802.11 parameters for transmission control for each QoS
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category, with CW, slot time (that is, AIFSN), and TXOP durations.

These parameters are configured in the Radio [2.4 | 5] GHz Access categories page as shown in
Figure 7-51. In most cases, you want to check the Optimized Voice or the WFA Default check box
and apply. You could be asked to customize the values, which implies the skill to copy numbers
into fields.

Figure 7-51 EDCA Parameters Tweaking

In the Cisco window, "Services" tab is selected that displays the list of services in the
navigation pane where "QoS" is selected. In the content pane, "Radio0 to 802. 11N to the
power 5 GigaHertz access categories" is selected. Below, a table is shown for the Access
category definition with the column headers "Access category, Background (CoS 1 to 2),
best effort (CoS 0, 3), Video (CoS 4 to 5), and Video (CoS 6 to 7)." The Access Categories
"Minimum Contention window (2 to the power X; X can be 0 to 10), Maximum contention
window (2 to the power X; X can be 0 to 10), fixed slot (0 to 20), and transmit opportunity
(0 to 65535 microseconds) displaying the AP value and Client value for the columns. The
bottom section titled "Admission Control for video and voice" shows "Video (CoS 4 to 5)"

Chapter 7 WLAN Media and Application Services

502

Technet24
||||||||||||||||||||

||||||||||||||||||||

file:///C:/Users/MERRELL/Documents/eBook Converter/Oreilly Downloader/tmp/9780135162095/ch07.xhtml#ch07fig51
https://technet24.ir
https://technet24.ir
https://technet24.ir


with "Admission control" checkbox and Voice (CoS 6 to 7)" with "Admission control"
checkbox displaying the Maximum channel capacity and roam channel capacity."

If you prefer to use the CLI, you would go to the target radio interface and configure the values for
each class where you want special treatment. You would then apply these values both for the
WLANs (“cell”) and the radio (“local”). For example:

Interface do 1
dot11 qos class video both
    cw-min 5
    cw-max 6
    fixed-slot 8
    transmit-op 2

Note

Please do not take these semi-random numbers as best practices. The correct numbers are the ones
defined for Fastlane EDCA values as explained at the beginning of this chapter, or the values
expressed in the Optimized Voice and WFA Default options.

The preceding is simple because you create the rules once and apply them for both cell and local.
However, there may be cases where you need to create both the local and the cell rules. You may
want to get into the habit of creating two identical sets of rules, one for cell and one for local:

Interface do 1
dot11 qos class video cell
    cw-min 5
    cw-max 6
    fixed-slot 8
    transmit-op 2
dot11 qos class video local
    cw-min 5
    cw-max 6
    fixed-slot 8
    transmit-op 2

As you control the transmission counting mechanism, you may also be asked to control access to
the UP 6 queue. This is the same CAC as on the AireOS controller. In the GUI, CAC is configured
in the Same Access Category page. The recommended values are the same as in AireOS:

Voice CAC: Max Channel capacity: 50%, roam channel capacity: 6%

Video CAC: Unconfigured

In the CLI, CAC is also applied at the radio interface for local and cell usage. For example:
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Click here to view code image

Interface do 1
dot11 qos class voice local
    admission-control
    admit-traffic narrowband max-channel 50 roam-channel 6
dot11 qos class voice cell
    admission-control

Notice that the values are set in the local rule, not the cell rule; however, the cell rule activates
admission control, picking the CAC rule values from the local section.

In old IOS, you will also see an option to call CAC from the SSID (in the general Settings area of
the WLAN). This option is not needed in recent IOS (and the one in the exam).

Advanced Features

IOS also includes customizations intended to improve the performance of voice traffic. Most of
them are located in the Services > QoS > Advanced tab.

Prioritizing voice traffic over a wireless link on autonomous APs can be done in three ways. The
first one is to create a class map, a policy map, and a service policy, then set a higher bandwidth or
priority level to voice traffic. This is what the previous Policy section was about. But in an
autonomous AP (remember, a Layer 2 bridge), applying a QoS tag (DSCP, CoS, or 802.11e) only
partially solves the problem. The DSCP or CoS tag will simply label the frame as urgent or not.
Putting the frame in an 802.11e category based on its tag (EF in CoS 6, for example) helps, because
each queue is treated differently in the AP buffer, and the voice queue is statically prioritized over
the other queues. If there are too many voice packets, using CAC can also prevent having voice
packets starve the other queues.

But if there are many “other types” of packets, and few voice packets in between, putting the voice
frame in UP6 may not be enough. Your voice packets may be delayed because other larger packets
are filling up the AP queues. To enhance the prioritization, you may need to add another feature
that would always prioritize voice packets. This feature is called QoS Element for Wireless Phones
and can be found in Services > QoS > Advanced, as shown in Figure 7-52.
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Figure 7-52 Advanced Configurations

In the Cisco window, "services" tab is selected that displays the list of services in the
navigation pane where "QoS" is selected. In the content pane "Advanced" tab is selected
that displays the sections IP phone, IGMP snooping, AVVID priority mapping, and WIFI
Multimedia. Under IP Phone section, "QoS element for wireless phones" field is shown
with a radio button selected for "Enable" and a checkbox selected for "Dot11e." Under
"ICMP snooping" field, "Enable" radio button is selected for Snooping helper. Under
"AVVID Priority mapping," "No" radio button is selected for "map ethernet packets with
Cos 5 to Cos 6." Under "Wifi Multimedia (WMM)" the radio buttons "Radio0 to 802.11N
to the power 2.4 Gigahertz and Radio1 to 802.11N to the power 5Gigahertz" are selected
under Enable radio interfaces.

Enabling QoS Element for Wireless phones generates two behaviors:

The AP prioritizes voice packets over the wireless links, regardless of any QoS configuration.

The AP sends in its beacon an additional information element called QoS Basic Service Set
Load Information Element, or QBSS Load IE. This information element mentions how many
clients are associated to the SSID, and what the AP utilization percentage is. Roaming devices
can use this information to decide which AP is the best candidate to join (having more space
and fewer clients). This information can be sent in a Cisco-proprietary and pre-802.11e way
(by just checking QoS Element for Wireless Phones), or using the IEEE 802.11e format (by
also checking the Dot11e check box).
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Both policy map (when bandwidth is reserved for the voice stream) and QoS Element for Wireless
Phones can prioritize voice packets. It all depends on whether you want to use a policy map, for
which the configuration method would be the same on most IOS devices, or use configuration
commands specific to autonomous IOS APs.

Notice that if you use the Dot11e method, you need to have WMM enabled on the corresponding
interface. This is configured at the bottom of the same page, and WMM is enabled on both
interfaces by default.

If you disable WMM, you may still be able to use QoS Element for Wireless Phones, but the AP
will not broadcast the QBSS Load Information Element using the 802.11e format; it will use the
Cisco CCX format.

The QoS Element for Wireless Phones can be configured with the following command:

Click here to view code image

ap(config)# dot11 phone dot11e
Remove the dot11e if you want to use the CCX QBSS Load element instead of the 802.11e format.

Another option that is part of the good practices and located in the same page is to set the AVVID
Policy mapping to Yes. In wireless, voice is CoS 6. Cisco follows the IETF recommendations on the
wired side and 802.1p tag 5. Checking AVVID priority mapping allows a transparent translation
from 5 to 6 and back when packets transit through the AP. In most networks, you will use DSCP,
but this option ensures that 802.1p markings are correctly interpreted. This is also a global CLI
command:

Click here to view code image

ap(config)# dot11 priority-map avvid
Another element of good practice when configuring a voice WLAN is ARP caching. Because you
do not want your wireless phone to fail due to an ARP request delay, enable ARP caching on the
AP and check the Forward ARP Request to Radio Interfaces option to make sure that the AP
knows all MAC addresses of all IP clients. In the GUI, this option is configured in Services > ARP
Caching, as shown in Figure 7-53.
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Figure 7-53 ARP Caching

In the Cisco window, "Services" tab is selected that displays a list of services in the
navigation pane where "ARP Caching" is selected. The content pane shows the services of
the "Client ARP Caching" with the radio button selected for "Enable" and a checkbox
selected for "Forward ARP requests to radio interfaces when not all client IP addresses are
known." "Apply and Cancel" buttons are displayed at the bottom.

In the CLI, this is also a global command:

Click here to view code image

Ap(config)# dot11 arp-cache optional
The optional keyword is the forwarding to radio interface optional part.

Autonomous Application Service Configuration Summary

IOS AP configuration for supporting application services sometimes looks like a disconnected
collection of items, without clear flow. The reason may be that autonomous APs are Layer 2
bridges. They are not intended to collect, store, examine traffic, and then decide the best fate and
path based on the traffic type. They are intended to convert 802.11 headers into 802.1 headers and
back. Anything above is optional. In a lab, the “above” will match the question you are asked. In
the real world, there are a few items that are considered as best practices:

Keep WWM to enabled (in Services > QoS > Advanced).

Set the AVVID mapping policy (same location).

Enable ARP caching (in Services > ARP Caching).

If you use voice, set the Access Categories for the matching radio to voice optimized of
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Fastlane values (in Services > QoS > radio > Access Categories).

Use marking map policies to ensure that DSCPs mark to the right CoS and UPs. Rate limiting is
not preferred (use marking and the natural prioritization of marking instead, as explained in the
first part of this chapter).

CAC is optional (turn it on if most of your clients are TSPEC enabled). Notice that IOS has no
trust-exceptions for Apple iOS or Mac OS clients. With CAC enabled, these clients won’t
access the UP 6 queue (because they do not support TSPEC).

LLQ configuration is uncommon and optional (let the clients manage their buffer; don’t think
that the AP can know whether a packet is “late”).

Wired Configuration

The CCIE Wireless exam tests your knowledge of Wi-Fi. However, it would be an illusion to think
that the network you care about (and therefore your skills) stop at the AP or WLC level. Clearly,
there would be, in any network, a large number of other specialists to take over where you left off
and configure routing, wired QoS, Unified Communications, deep Security, and so on. However,
you should not think that there is no reason for you to know anything about these fields. In fact,
you should aspire to be independent, face any network on your own, and survive any configuration
request, even if the request has an impact on the wired infrastructure and no campus LAN
Switching specialist is there to help you.

In the application services field, this autonomy implies being able to configure basic QoS on a
switch. Such an ability covers two fields:

The ability to use DSCP or 802.1p when making a switching decision

The ability to create marking and queueing policies on a switch

Trusting DSCP or CoS

Most switches receive traffic on access ports and trunk ports. On access ports, QoS is expressed
only in the Layer 3 DSCP field. Trunk ports can receive traffic that includes an 802.1Q header,
which includes an 802.1D/802.1p Layer 2 QoS value. You can configure the switch to use the
Layer 3 DSCP value or the Layer 2 CoS value, to decide the fate of the incoming packet. The best
practice, in the context of wireless, is to use DSCP, because it expresses the end-to-end intent of
the packet (refer to the first part of this chapter). Although a switch is a Layer 2 device, most
switches can work with Layer 3 and recognize DSCP. The value you use (DSCP or CoS) is set by
the trust value:

Click here to view code image
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SwitchA(config-if)# interface f0/2
SwitchA(config-if)# mls qos trust dscp
Notice that in IOS XE switches, DSCP is trusted by default. Some other, older switch platforms (for
example, 3750s) require you to use the mls qos global command to activate QoS (and therefore the
trust mechanism). You are unlikely to face such an older switch in the exam. In real life, on an
older switch, you are expected to enter mls qos before any trust command.

Trusting DSCP means that the switch will look at the DSCP field of the incoming traffic on the
configured port to decide the packet remarking. The outbound buffers will still be built using Layer
2 queues. The trust function is to decide the field that will be used to direct the incoming packet to
the right queue.

Note

This Layer 2–based outgoing queuing logic is the reason why some “experts” will tell you that
switches can only work with Layer 2 QoS. This is a basic misunderstanding of the problem that
trust is solving. Its purpose is not to work on the outgoing queuing but to decide which field should
be used on the incoming packet to decide the outbound, Layer 2–based queue. Using DSCP for that
purpose is best.

Your port may be a trunk (in which case both DSCP and CoS will be available) or an access port
(in which case no CoS is available, and trust DSCP is the only option). In that case, the port may
connect a phone behind which a laptop connects. This port will then have both a data and a voice
VLAN configured per the following example structure:

Click here to view code image

SwitchC(config)# interface g0/21
SwitchC(config-if)# power inline auto
SwitchC(config-if)# cdp enable
SwitchC(config-if)# switchport mode access
SwitchC(config-if)# switchport access vlan 10
SwitchC(config-if)# switchport voice vlan 20
SwitchC(config-if)# trust device cisco-phone
SwitchC(config-if)# trust cos
Two key elements are to be examined from this configuration. You set a data VLAN and a voice
VLAN. CDP will be used to recognize a Cisco phone, and QoS marking from this phone will be
trusted. Cisco phones are an exception to the DSCP rule because they mark only CoS.

The mls qos trust command has different options depending on the platform. Using the “?” after
the trust keyword, you will recognize which option states that you would trust the marking coming
from a Cisco phone.
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On all ports connecting an AP (in local mode or FlexConnect mode) or a WLC, you will trust
DSCP (trust dscp is the default and only option on most IOS-XE switches):

Click here to view code image

SwitchC(config)# interface g0/21
SwitchC(config-if)# description  *** to WLC ***
SwitchC(config-if)# switchport mode trunk
SwitchC(config-if)# mls qos trust dscp
SwitchC(config)# interface g0/21
SwitchC(config-if)# description  *** to local mode AP ***
SwitchC(config-if)# switchport mode access
SwitchC(config-if)# mls qos trust dscp
SwitchC(config)# interface g0/21
SwitchC(config-if)# description  *** to FlexConnect AP ***
SwitchC(config-if)# switchport mode trunk
SwitchC(config-if)# mls qos trust dscp
Your WLC typically connects to a trunk, and its management interface should be tagged (that is,
not “0,” or untagged, as you configure the interface in the WLC initial setup) for security purposes.
In older codes, you used to trust CoS. In 8.x codes, you trust DSCP, as explained at the beginning
of this chapter.

The local mode AP case is obvious because it is on an access port. (There is no CoS, only DSCP.)

The FlexConnect AP has its management IP address (the address used to communicate with the
WLC) on the native VLAN (which has no 802.1Q field). Therefore, you must trust DSCP in order
to catch management tagging (CAPWAP control for example, tagged as CS6). If you were to trust
CoS, the management traffic (on the native VLAN, without 802.1Q field) would appear as
“untagged” and would be treated as best effort, even if its DSCP marking is CS6.

QoS Policies

Making sure that you trust DSCP is the first QoS task on your switches. The other task is setting
rules and policies, just like you did on the autonomous AP.

The logic is similar to that of the autonomous AP CLI. You create class maps that target specific
traffic (based in existing marking or source/destination pairs, for example), the policy maps that
decide what should happen to the targeted traffic. You then apply these policies to interfaces.

Class Maps
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Class maps can target a wide range of ways of recognizing traffic type. You do not need to know all
possible ways, but the most common are as follows.

Start by creating an access list for voice traffic. Voice uses UDP ports between 16384 and 32767.

Click here to view code image

sw(config)# access-list 101 permit udp any any range 16384 32767
Next, create a class map matching this access list:

Click here to view code image

sw(config)# class-map voice_ports
sw(config-cmap)# match access-group 101
Repeat the same operation for signaling or other traffic that you can recognize based on their port:

Click here to view code image

sw(config)# access-list 102 permit tcp any any eq 2000
sw(config)# access-list 102 permit udp any any eq 1720
sw(config)# class-map signaling_ports
sw(config-cmap)# match access-group 102
sw(config-cmap)# exit
Creating class maps by recognizing traffic targeted with an access list is very common, and you
should be familiar with this technique. You can also target a specific DSCP or CoS value (just like
in the autonomous section):

Click here to view code image

sw(config)# class-map Voice
sw(config-cmap)# match dscp ef
sw(config-cmap)# exit

Policy Maps

After you have class maps, you can create policy maps that call each class map in turn and decide
the QoS marking for traffic in that class. For example:

Click here to view code image

sw(config)# policy-map VOIP3
sw(config-pmap)# class voice_ports
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sw(config-pmap-c)# set dscp ef
sw(config-pmap-c)# exit
sw(config-pmap)# class signaling_ports
sw(config-pmap-c)# set dscp CS3
sw(config-pmap)# exit
sw(config-cmap)# exit

Service Policy

After the various policy maps are created, you apply them to the interfaces of your choice. For
example:

Click here to view code image

sw(config)# interface g1/0/1
sw(config-if)# service-policy output VOIP3
Notice that the span of possibilities will depend on your switch platform. In general, you can create
remarking policies inbound or outbound, although it makes more sense to remark traffic as you
receive it (inbound), instead of keeping the wrong marking as the traffic traverses your switch, and
only caring about making the marking right when traffic leaves your switch. This is a general
recommendation, but the CLI will allow you to remark wherever you want (on most platforms).

You can also set bandwidth limitations with police, bandwidth, shaping, and many other commands.
The details of which option is best, based on the intent of your configuration, is more in the realm
of QoS and voice specialist than in that of a wireless expert. However, you should keep in mind that
bandwidth control usually makes sense only outbound. When traffic reaches your switch you want
to receive it and mark it properly, but it is too late to decide how much of that traffic you should
accept (you are on the passive, receiving side of the link). It is only when you send traffic outbound
that you should decide how much should be sent, and this is where bandwidth limiting
configurations make sense.

Summary

The first part of this chapter is key to understanding the multiple concepts behind application
services configuration. Keep in mind that QoS can be expressed at Layer 2 or Layer 3. Layer 3
QoS, with DSCP and PHB, expresses the end-to-end QoS intent for the target traffic, whereas
Layer 2 QoS expresses the local QoS intent, based on the local medium constraints and
characteristics. A higher QoS label value typically reflects a higher sensitivity to delay, jitter, and
losses. RFC 4594 (and a few others) define the common basis to classify various types of traffic
and express their sensitivity to loss, jitter, and delay. On a WLC, traditional marking relied on Wi-
Fi Layer 2 marking translated to (and from) Ethernet Layer 2 marking. However, the current
recommendation is to use DSCP instead.
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After you have defined your QoS marking policy, you can use several techniques to limit the effect
of congestion: TXOP, CAC, Bandwidth contract, and QoS remarking.

You should take the time to master these concepts and train to configure them separately or
together on your wireless infrastructure and neighboring switches by using the second part of this
chapter. Make sure to configure multiple options and to understand what happens (make heavy use
of show and debug commands). Also, configure a voice client, and use the various markings to
experiment. For iOS clients, you can use a Mac OS device and Apple Configurator to create and
deploy a profile that includes a whitelist. You should be able to see the marking appear or disappear
while capturing whitelisted or nonwhitelisted traffic over the air (Wireshark or other). You can use
a cloud application (for example, Spark or Facetime) for this test. If you test on Windows, you
might need a voice application like Jabber.
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Code Snippets
Many titles include programming code or configuration examples. To optimize the
presentation of these elements, view the eBook in single-column, landscape mode and
adjust the font size to the smallest setting. In addition to presenting code and
configurations in the reflowable text format, we have included images of the code that
mimic the presentation found in the print book; therefore, where the reflowable format
may compromise the presentation of the code listing, you will see a “Click here to view
code image” link. Click the link to view the print-fidelity code image. To return to the
previous page viewed, click the Back button on your device or app.
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